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Basics 

About ZENworks 7.5 Asset Management Manager 
ZENworks 7.5 Asset Management 
Documentation version 7.5.06-061026 
October 2006 

ZENworks® Asset Management Manager is an application that lets you customize and 
manage your ® enterprise. For example, you can set up collection schedules that 
determine when inventory data is collected from workstations and customize many 
aspects of the inventory process itself.  

The Manager also lets you control how (especially in a large enterprise) inventory data is 
organized and grouped by Collection Domains and Collection Servers. In addition, by 
letting you assign different roles to ZENworks Asset Management users, the Manager 
gives you control over who can work with inventory data and what kinds of changes they 
can make. 

The Manager also lets you analyze the inventory data through queries and reports and 
edit the data when necessary. 

Below are some topics of interest to help get you acquainted with the Manager. See the 
the Manager Help’s Table of Contents for a deeper look at ZENworks Asset 
Management. 

ZENworks Asset Management Manager Environment 
ZENworks Asset Management Main Window  

Using the Shortcut Menus  

The Locator Window  

The Workspace  

The Process Control Panel  

Changing ZENworks Asset Management Manager Options  

  

Overview Topics 
About Security 

About License Compliance  

About the ZENworks Asset Management Usage Monitor  

About the ZENworks Asset Management Network Discovery Engine  
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Basic Operations 
Installing ZENworks Asset Management Collection Client Software  

Setting Up a Collection Schedule  

Setting Up a Collection Option Set  

About Collection Domains  

About Collection Servers  

About Task Servers  

About ZENworks Asset Management Users  

About Queries  

Running a Report  

  

Reference Topics 
Error Logs and Files  

Menus and Commands  

Toolbars  

Reports  

Database Tables  
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The Main Window 

ZENworks Asset Management Main Window 

 

The locator window displays lists of schedules, collection option sets, Collection Domains, Collection Servers, queries, 
or reports on locator tabs. The locator window helps you find these items as well as manage them in a logical fashion. 

 The locator tab lets you select the contents of the locator window. Each locator tab displays related items. 
For example, the Management locator tab lists schedules, collection option sets, Collection Domains, 
Collection Servers, and Task Servers. 

 The title bar identifies the product you are using. 
 Three toolbars give you quick access to frequently performed ZENworks Asset Management Manager 

activities. The standard toolbar is for general activities, the process control panel toolbar is for working in 
the process control panel (see below), and the query toolbar is for working in the query tool. (See "Query 
Tool" on page 13-12.) To see a description of what a button on a toolbar does, position the mouse pointer 
over it; to use a button, click on it.  

 The menu bar gives you access to the Manager menus. To display the commands on a menu, click on it. 
Depending on what you are doing and the type of ZENworks Asset Management user you are, not all the 
menus will be available all the time. 

 The process control panel is a window in which you can view and manage data associated with your 
Collection Servers and tasks such as reports. For example, you can check the status of your reports, view 
errors reported on workstations during a collection, or see which users are currently using the Manager. 
 
The process control panel initially appears at the bottom of the main Manager window, but you can drag it to 
another edge of the window. You can also hide the process control panel by clicking on the Process Control 
Panel button on the toolbar. (You will not need to refer to the process control panel all the time, and hiding 
it will give you more room for the locator window and workspace.) 

 The status bar shows general messages, the name of the database, the name of the currently logged on user, 
and the status of the inventory process by means of the traffic light in the far right corner. If you do not 
want to see the status bar, click on the View menu and click on Status Bar. To display it again, repeat this 
procedure. 

 The workspace is an area where you can display one or more windows containing the details about an item 
selected on a locator tab, for example, schedule settings. The workspace may be empty at times. 
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The Locator Window 

The locator window in the main ZENworks Asset Management Manager window can 
display organized lists of schedules, collection option sets, Collection Domains, 
Collection Servers, Task Servers, queries, or reports. Because of their appearance and the 
way they help you manage and find items, these lists are sometimes called locator trees. 
The lists are organized on three different locator tabs: Management, Query, and Report.  

ZENworks Asset Management Manager always displays the locator window to the left of 
the workspace, but you can move the window to another edge of the main the Manager 
window. You can also change the width of the locator window to display more or less 
information horizontally. In addition, you can hide the locator window altogether and 
increase the workspace. 

You can do the following with the locator window: 

 Move it. 
 Change its width. 
 Hide it altogether. 

You can do the following in the locator window: 

 Display different kinds of items by switching to a different locator tab.  
 Work with containers and folders.  
 Change the sort order of items. 
 Synchronize the item highlighted on the locator tab with that displayed in a window in the workspace. 
 Update information on a locator tab. 

Moving the Locator Window 
ZENworks Asset Management Manager automatically displays the locator window on 
the left side of the main window. If you prefer, you can move the locator window to 
another edge of the main window. 

To move the locator window 

 Drag the locator window to another edge of the main the Manager window. 

Changing the Width of the Locator Window 
You may want to make the locator window wider or narrower depending on how much 
data you need to see in it. 

To change width of the locator window 

 Drag the right edge of the locator window to the left or right depending whether you want to make the 
window narrower or wider. 
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Hiding the Locator Window 
ZENworks Asset Management Manager automatically displays the locator window. You 
have the option, however, of hiding the locator window and increasing the workspace for 
windows. You may find this useful when working with queries, for example, so you can 
display more data. 

To hide the locator window 

Do one of the following: 

 Click on   on the toolbar. 
 Click on the View menu and clear the Locator option. 

To display the locator window again 

Do one of the following: 

 Click on   on the toolbar. 
 Click on the View menu and select the Locator option. 

Displaying a Different Tab in the Locator Window 
ZENworks Asset Management Manager lists items on three different tabs in the locator 
window: 

 The Management locator tab includes schedules, collection option sets, Collection Domains, Collection 
Servers, and Task Servers. (This tab is visible only if you are an administrator.) 

 The Query locator tab includes queries for locating information in the inventory database so you can review 
and edit it. 

 The Report locator tab includes many reports for analyzing your inventory data. 

To display a different locator tab 

Do one of the following: 

 Click on the Management, Query, or Report tab at the top of the locator window. 
 Click on the View menu and click on Management, Query, or Report. 
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Containers and Folders 
The items on locator tabs are organized in containers and folders. 

A container is a special type of folder included in ZENworks Asset Management 
Manager. For example, the Query locator tab includes three containers: Public Queries, 
Personal Queries, and ZENworks Asset Management Queries. Some containers contain 
additional containers. Containers are fixed; you cannot delete or change them in any way. 
They are identified by a special icon on a locator tab. 

Within some containers, you can create folders as well as items in the folders. 

See Also 

Displaying the Contents of Containers or Folders  

Creating a Folder  

Renaming a Folder  

Deleting a Folder  

Creating a Folder 

Folders give you a way of organizing items on a locator tab by grouping together related 
items. You can create folders, rename them, and delete them. 

NOTE: You cannot rename or delete the report folders supplied by Novell in the ZENworks Asset Management Reports 
container on the Report locator tab or the query folders in the ZENworks Asset Management Queries container on the 
Query locator tab. 

You can create folders within some of the containers supplied by Novell. You can create 
as many folders as you like, but they can go only one level deep. (A folder cannot exist 
within another folder.) The name of a folder must be unique within its container. 

To create a folder 

1. Do one of the following to create a folder in a container:  

 Select (highlight) the container, click on   on the toolbar, and then click on Folder. 

 Right-click on the container, click on New on the shortcut menu, and then click on Folder. 

 Select the container, click on the File menu, click on New, and then click on Folder. 

2. Enter a name for the folder in the Folder and click on the OK button. ZENworks Asset 
Management Manager will suggest a default name for the type of folder you are creating, 
for example, Collection Schedule Folder1. The name of the folder must be unique within 
the container. 
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Renaming a Folder 

Except for some folders supplied by Novell, you can change the name of a folder any 
time you want to. 

To rename a folder: 

1. Do one of the following on a locator tab to rename a folder:  
 On a locator tab, right-click on the folder name and click on Rename on the shortcut menu. 
 Select the folder, click on the File menu, and click on Rename. 

2. Enter a new name for the folder in the Rename Folder dialog and click on the OK button. 

Deleting a Folder 

Except for some folders supplied by Novell, you can delete a folder if it no longer serves 
a purpose. If, however, a folder contains any items, you will first need to move them to 
another folder or delete them. 

To delete a folder 

1. Check whether the folder you want to delete includes any items, If it does, either move 
them to another folder or delete them. 

2. Do one of the following on a locator tab to delete a folder:  

 Select the folder and click on   on the toolbar. 

 Right-click on the folder and click on Delete on the shortcut menu. 

 Select the folder, click on the File menu, and click on Delete. 

Displaying the Contents of Containers and Folders 

Whenever you display a different locator tab in the locator window, ZENworks Asset 
Management Manager always displays its contents by top-level container only. A 
container has a + (plus sign) next to it to indicate it includes containers, folders and/or 
items that are not listed. You will also see a + next to a folder that includes items that are 
not listed. 

To display the contents of a container or folder 

Do one of the following: 

 Double-click on the container or folder name. 
 Click on the + (plus sign).  

The Manager will now display the contents of the container or folder and put a - (minus 
sign) next to the name. 

To hide the contents of a container or folder 

Do one of the following: 
 Double-click on the container or folder name. 
 Click on the - (minus sign). 
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Changing the Sort Order on a Locator Tab 

On all locator tabs except the Report locator tab, the Manager automatically lists items in 
folders alphanumerically in ascending order. You have the option of changing the sort 
order to descending. (On the Report locator tab the reports supplied by Novell appear in a 
fixed order.) 

To change the sort order on a locator tab 

Do one of the following: 

 Click on   or   on the toolbar. 
 Click on the View menu, click on Sort, and click on Ascending or Descending. 

Synchronizing the Locator Window with the Window in the Workspace 

If you have several windows open in the workspace, the item selected on a locator tab 
may not match the item displayed in the active window. You can synchronize the two so 
that ZENworks Asset Management Manager highlights the item on the locator tab that 
matches what is displayed in the active window.  

To synchronize the locator window with the window in the workspace 

Do one of the following: 

 Click on   on the toolbar. 
 Click on the View menu and click on Synchronize. 

Updating Information on a Locator Tab 

In an Enterprise Deployment of ZENworks Asset Management, several people may be 
using the Manager at the same time and may make changes that affect the contents of a 
locator tab. For example, since you displayed a locator tab, an enterprise administrator 
may have created some new public queries or may have deleted or moved a schedule. 
Your locator tab will look unchanged, however, until you update it by refreshing it.  

When you are creating, renaming, deleting, or moving items yourself, the changes you 
make will be automatically reflected on a locator tab. Only changes by other ZENworks 
Asset Management users are not displayed automatically (for performance reasons). 

When updating a locator tab you have the choice of refreshing the contents of the entire 
locator tab or of refreshing the currently selected "branch" of the locator tab. For 
example, if you just want to see the latest queries in the Public Queries container you can 
refresh the contents of this container without affecting the other containers on the locator 
tab. 
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To update information on a locator tab 

To refresh an entire locator tab, do one of the following: 

 Click on   on the toolbar. 
 Right-click on the locator tab and then click on Refresh. 
 Click on the View menu and click on Refresh. 

To refresh a branch of a locator tab, do one of the following: 

 Right-click on the branch and then click on Refresh Branch. 
 Select the branch, click on the View menu, and click Refresh Branch. 

The Workspace 

The workspace in the ZENworks Asset Management Manager window is the area to the 
right of the locator window. The workspace may be empty at times, but most of the time 
it is used to display a window showing the details of a particular item such as a schedule 
or collection option set. Whereas the locator window lists the names of your items, the 
workspace lets you view, create, and edit the items. The type of window you see in the 
workspace depends on the type of item you are working with. The title bar of the window 
will indicate the window’s type, for example, Collection Schedule or Collection Option 
Set. 

See Also 

Displaying a Window in the Workspace  

Working with Windows in the Workspace  

Displaying a Window in the Workspace 
You can have several windows open in the workspace at the same time, and the windows 
can be of any type.  

To display a window in the workspace 

To display a window so you can view or change an item that already exists, find the item 
on a locator tab and do one of the following: 

 Double-click on the item. 

 Select the item and click on   on the toolbar. 
 Right-click on the item and then click on Open on the shortcut menu. 
 Select the item, click on the File menu, and click on Open. 
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To display a window so you can create an item, select the container or folder in which 
you want to create the item. The type of container or folder you select will determine the 
type of item that will be created. For example, to create a query for your own use, on the 
Query locator tab, select the Personal Queries container or a folder in this container. Then 
do one of the following: 

 Click on   on the toolbar and click on the item you want to create, for example, Workstation Query. 
 Right-click, click on New on the shortcut menu, and click on the item you want to create. 
 Click on the File menu, click on New, and click on the item you want to create. 

NOTE: The selection that is available after you click on the New button or command is determined by the container or 
folder that is selected at the time. 

TIP 

 If an item is currently displayed in a window in the workspace, you cannot make changes to that item on a 
locator tab. For example, you cannot rename, copy, or delete a collection schedule that is open in a window; 
you must close it first. 

Working with Windows in the Workspace 
If you have several windows open in the workspace, you can use standard Windows 
commands to manage them. For example, to arrange the windows so they fit next to one 
another, click on the Window menu and click on Tile; to cause the windows to overlap so 
that their title bars are visible, click on the Window menu and click on Cascade. 

When you enter or edit information in a window in the workspace, you will lose your 
changes unless you save the information in the window. An * (asterisk) in the window’s 
title bar reminds you that you have made changes but not saved them. Also, if you try to 
close the window without saving your changes, the Manager will give you the choice of 
doing so before it closes the window. 

You can save your data in a number of ways: 

 If you have a number of open windows, click on   on the toolbar or click on the File menu and click on 
Save All. 

 If you want to save the information in the active window, click on   on the toolbar OR click on the File 
menu and click on Save. If asked, provide a name for the item in the dialog that appears. 

 If you want to save the information in the active window under a different name, click on the File menu, 
click on Save As, and provide a name for the item in the dialog that appears. 
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The Process Control Panel 

The process control panel is a window in ZENworks Asset Management Manager in 
which you can view and manage data related to the inventory process and to tasks. The 
process control panel has the following tabs: 

 Collection Servers tab for managing Collection Servers and seeing their status (administrators only). 
 Option Sets tab for viewing collection option set assignments (administrators only). 
 Tasks Servers tab for managing Task Servers and seeing their status (administrators only). 
 Tasks tab for managing tasks and seeing their status. (Only an enterprise administrator can manage purge 

and PRU tasks.) 
 History tab for checking historical data about tasks. 
 Check Outs tab for seeing which workstations are currently checked out (administrators only). 
 Current Users tab for seeing who is currently using the Manager. 

The Manager automatically displays the process control panel at the bottom of the main 
window. You can do the following with the process control panel: 

 You can drag it to any edge of the main window that suits your purposes. 
 You can resize it to show more or less information. 

 You can hide it altogether. Either click on the   on the toolbar or click on the View menu and click on 
Process Control Panel. To display the process control panel again, repeat this process. 

The process control panel has a related menu, the Control menu, as well as a toolbar at 
the top of the main Manager window. When you are working in the process control panel 
this menu and toolbar are available to you. 

TIP 

 The Manager updates the information on the process control panel periodically, but you can make sure you 

are looking at the most up-to-date information by refreshing a tab. Either click on   on the toolbar or 
click on the View menu and click on Refresh. (You can also press F5.) Note that the Manager does not update 
the information on the tabs when you switch from one tab to another. 

Pausing and Resuming a Task 
If a task is waiting to run, but you want to hold off running it, you can pause it. For 
example, if you have a report that is scheduled to run every two weeks, and you do not 
want it to run this time around, you can pause it. When you are ready for the task to take 
its place in the queue again, you must resume it. 

NOTE: You cannot pause a task that is already running.  

To pause a task 
1. Click on the Tasks tab in the process control panel. 
2. Do one of the following to pause a task:  

 Select the task and click on   on the process control panel toolbar. 
 Right-click on the task and then click on Pause on the shortcut menu. 
 Select the task, click on the Control menu, and click on Pause Task. 

The Status column on the Tasks tab will now read Paused. 
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To resume a paused task 

1. Click on the Tasks tab in the process control panel. 
2. Do one of the following to resume a paused task:  

 Select the task and click on   on the process control panel toolbar. 
 Right-click on the task and then click on Resume on the shortcut menu. 
 Select the task, click on the Control menu, and click on Resume Task. 

The Status column on the Tasks tab will now read Running or Waiting depending on 
whether the task starts running right away. 

Collection Servers Tab 
The Collection Servers tab of the process control panel lets you do the following: 

 Look at information about your Collection Servers. 
 Stop or start a Collection Server. 
 Review and edit Collection Server settings. 
 Edit the Collection Domain with which the Collection Server is associated. 
 Examine errors that occurred on a Collection Server or on any of its associated workstations. 

Only ZENworks Asset Management administrators can see the Collection Servers tab. 
The Manager does not display it if you are an assistant or analyst. Enterprise 
administrators can see the data for all Collection Domains and their associated Collection 
Servers. Domain administrators can see the data only for the Collection Domains for 
which they are responsible. 

Information is shown in the columns as follows: 

 Domain - the name of the Collection Domain to which the Collection Server belongs. 
 Collection Server - the name of the Collection Server. 
 Host Name - the name of the machine on which the Collection Server is running. 
 Server Status - The Server Status column shows the current status of the Collection Server: 

Starting - The Collection Server is in the process of starting. 
Started - The Collection Server is in its normal state (running). 
Stopping - The Collection Server is in the process of stopping. 
Stopped - The Collection Server has been stopped by an administrator. 
Unavailable - Either the service is currently stopped or a serious condition (such as a problem with a network 
cable or card) is preventing the Collection Server from communicating with the inventory database. This 
status appears in red to warn you the Collection Server is not running. 
Inventory Stopped - The Collection Server has been stopped because the entire inventory process has been 
stopped. 

 Last Cycle - summarizes how many workstations were scanned successfully during each option set's last 
inventory cycle.  

 This Cycle - indicates how many workstations have been scanned so far as a result of the option sets and 
schedules currently in effect. 

 Errors This Cycle - the number of failed attempts to perform a collection during the current inventory cycle 
(including unloads, scans, and loads). 

 TCP/IP Address - the TCP/IP address of the Collection Server. 

 Port - the port number of the Collection Server. 
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Stopping or Starting a Collection Server 

ZENworks Asset Management gives you the option of stopping a Collection Server. For 
example, you may want to stop a Collection Server if you need to perform maintenance 
on the machine on which it resides, or if the machine is having problems. When you stop 
a Collection Server, ZENworks Asset Management cancels any collections that are in 
progress on its associated workstations and discards any workstation inventory files (.wif) 
that were waiting to be loaded. In addition, ZENworks Asset Management prevents any 
further collections from occurring until you start the Collection Server again. 

To stop a Collection Server 

1. Click on the Collection Servers tab in the process control panel. (You can also stop a 
Collection Server from the Option Sets tab.) 

2. Select the Collection Server(s) you want to stop. 
3. Stop the Collection Server in one of the following ways:  

 Click on   on the process control panel toolbar. 
 Right-click and click on Stop Server on the shortcut menu. 
 Click on the Control menu and click on Stop/Start Server. 

After ZENworks Asset Management has stopped the Collection Server(s), the Server Status 
column on the Collection Servers tab of the process control panel will read Stopped. 

TIPS 

 If you want to stop all the Collection Servers in the enterprise, you can stop the entire inventory process.  
 When you are ready to resume collections on the workstations associated with a stopped Collection Server, 

be sure to start it again.  

To start a Collection Server again 

1. Click on the Collection Servers tab in the process control panel. 
2. Select the Collection Server(s) you want to start again. 
3. Start the Collection Server(s) in one of the following ways:  

 Click on   on the process control panel toolbar. 
 Right-click and then click on Start Server on the shortcut menu. 
 Click on the Control menu and click on Stop/Start Server. 

After ZENworks Asset Management has started the Collection Server(s), the Server Status 
column on the Collection Servers tab of the process control panel will read Started. 

Examining Collection Server Data 

The Collection Servers tab in the process control panel provides information about each 
of your Collection Servers.  
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To examine Collection Server data 

1. In the process control panel, click on the Collection Servers tab. 

2. Update the information on the tab either by clicking on  on the toolbar or by clicking 
on the View menu and clicking on Refresh. (You can also press F5.) 

3. Review the data on the tab. Click on the figure below for information about the columns 
on this tab. 
For information on the data in the columns, see Collection Servers Tab. 

4. After reviewing the status of your servers, do any of the following:  

 Print the information on the tab either by clicking on  on the toolbar or by clicking on the File 
menu and clicking on Print. 

 Sort the data differently by clicking on a column heading. 
 Stop or start a Collection Server. 
 Edit Collection Domain or Collection Server settings.  
 Look at the errors associated with a Collection Server or its workstations. 
 See detailed status information about all the workstations currently connected to a Collection Server. 

Editing Collection Domains or Servers 

While you are examining information on the Collection Servers tab in the process control 
panel, you may decide you want to review or edit Collection Domain settings or 
Collection Server settings. You can do so directly from the Collection Servers tab. 

To edit domain or server settings 

On the Collection Servers tab or the Option Sets tab of the process control panel, do one 
of the following: 

 To edit Collection Domain settings, select the Collection Server's row, right-click, and click on Edit Domain on 
the shortcut menu. 

 To edit Collection Server settings, select the Collection Server's row, right-click, and click on Edit Collection 
Server on the shortcut menu. 

After you finish reviewing and/or editing settings, ZENworks Asset Management will 
return you to the process control panel. 

See Also 

Editing Domain Settings  

Editing Collection Server Settings  
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Viewing Collection Server or Workstation Errors 

If you suspect a Collection Server is not working properly, you can see if any errors have 
been reported for it. Also, if the Collection Servers tab of the process control panel 
indicates that some workstations associated with a Collection Server have reported errors, 
you can obtain more details about these errors. Remember that you can refresh the 

process control panel (by clicking on  on the toolbar or by pressing F5) to see the 
most current errors. 

To view Collection Server or workstation errors 

1. On the Collection Servers tab of the process control panel, select a Collection Server for 
which errors are listed. (You can also do this on the Option Sets tab.) 

2. Do one of the following to obtain error information:  

 Click on   on the process control panel toolbar. 
 Right-click and then click on View Errors on the shortcut menu. 
 Click on the Control menu and click on View Errors. 

3. In the View Errors dialog, select Collection Server or Workstations depending on which kind 
of errors you want to see. Then click on the OK button. 

4. If you selected Collection Server in the View Errors dialog, ZENworks Asset Management 
displays the View Collection Server Errors dialog. Review the errors listed. By default, 
ZENworks Asset Management lists severe errors only, but you have the option of viewing 
warning or informational errors. You can also filter errors by date or description.  
 
a) To see an updated list of Collection Server errors, click on the Refresh button. 
b) To view different errors, edit the filter above the error list by selecting Level, Date, or 
Description; selecting an operator; specifying the value that you want to match; and 
clicking on the Filter button. For example, to see informational errors you would select 
Level and the = operator and then type info. (The possible values you can enter for the 
error level are severe, warning, or info.) 
c) To display the errors in a different order, click on the Date, Level, or Description 
column heading. 
d) To obtain more details about an error, select it. ZENworks Asset Management will 
display the additional information in the Detailed Description box. 
e) To obtain even more details (if available) about an error, double-click on it.  
f) Click on the Close button after you have finished investigating the errors. 

5. If you selected Workstations in the View Errors dialog, ZENworks Asset Management 
displays the View Workstation Errors dialog. Review the list of workstations in the 
Available Workstations box. By default, ZENworks Asset Management lists severe errors 
only, but you have the option of viewing warning or informational errors. You can also 
filter errors by workstation or primary user.  
 
a) To see an updated list of workstations with errors, click on the Refresh button. 
b) To view different errors, edit the filter in the Available Workstations section by 
selecting Error Level, Workstation, or Primary User; selecting an operator; specifying the 
value that you want to match; and clicking on the Filter button. For example, to see 
informational errors you would select Error Level and the = operator and then type info. 
(The possible values you can enter for the error level are severe, warning, or info.) 
c) To display the errors in a different order, click on the Workstation, Primary User, or 
Error Level column heading. 
d) To see a complete list of errors for a particular workstation, select the workstation in 
the Available Workstations box. ZENworks Asset Management will then display all the 
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errors for the workstation in the Errors for Selected Workstation section of the dialog. To 
display the workstation errors in a different order, click on the Date, Module, Level, or 
Description column heading. 
e) To obtain more details about a particular error, select it. ZENworks Asset Management 
will display the additional information in the Detailed Description box. 
f) To obtain even more details (if available) about an error, double-click on it.  
g) Click on the Close button after you have finished investigating the errors. 

Option Sets Tab 
The Option Sets tab of the process control panel lets you do the following: 

 See which collection option sets are assigned to a Collection Server and which collection schedule is 
associated with an option set. 

 Review and edit a collection option set or collection schedule. 
 Review and edit Collection Server settings. 
 Edit the Collection Domain with which the Collection Server is associated. 
 Examine errors that occurred on a Collection Server or its associated workstations.  
 Stop or start a Collection Server. 

Only ZENworks Asset Management administrators can see the Option Sets tab. 
ZENworks Asset Management Manager does not display the tab if you are an assistant or 
analyst. Enterprise administrators can see the option data for all Collection Domains. 
Domain administrators can see the data only for the Collection Domains for which they 
are responsible. 

Information is shown in the columns as follows: 

 Domain - the name of the Collection Domain to which the Collection Server belongs. 
 Collection Server - the name of the Collection Server. This is the same name that ZENworks Asset 

Managment Manager displays on the Collection locator tab. 
 Host Name - the name of the machine on which the Collection Server is running. 
 Server Status - the current status of the Collection Server: 

Starting - The Collection Server is in the process of starting. 
Started - The Collection Server is in its normal state (running). 
Stopping - The Collection Server is in the process of stopping. 
Stopped - The Collection Server has been stopped by an administrator. 
Unavailable - Either the service is currently stopped or a serious condition (such as a problem with a network 
cable or card) is preventing the Collection Server from communicating with the inventory database. This 
status appears in red to warn you the Collection Server is not running. 
Inventory Stopped - The Collection Server has been stopped because the entire inventory process has been 
stopped. 

 Schedule - the name of the schedule that is assigned to the collection option set. When the name appears in 
green, the schedule is active, and collections may be currently taking place on the workstations associated 
with the Collection Server. For scan now option sets, no schedule is listed because it is ignored for this type 
of scan. 

 Option set - the name of the collection option set that is assigned to the Collection Server. 
 Option Set Type - identifies the type of option set that is assigned: Standard, New Workstations, or Scan 

Now. 
 Last Cycle - summarizes how many workstations were scanned successfully with the option set during the last 

inventory cycle. (This column does not apply to scan now option sets.) 
 This Cycle - indicates how many workstations have been scanned with the option set so far during the 

current inventory cycle. 
 Errors This Cycle - shows the number of failed attempts to perform a collection cycle (including unloads, 

scans, and loads) with the option set during the current inventory cycle. 
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Editing Collection Option Sets or Schedules 

While you are examining information on the Option Sets tab of the process control panel, 
you may decide you want to review or edit a collection option set or schedule. For 
example, you may want to change some schedule settings. You can do so directly from 
the Option Sets tab. 

To edit a collection option set or schedule 

On the Option Sets tab of the process control panel, do one of the following: 

 To edit a collection option set, select the option set’s row, right-click, and click on Edit Option Set on the 
shortcut menu.  

 To edit a collection schedule, select the schedule’s row, right-click, and click on Edit Schedule on the 
shortcut menu.  

After you finish reviewing and/or editing settings, ZENworks Asset Management will 
return you to the process control panel. 

Examining Collection Option Set Data 

The Option Sets tab provides information about the collection option sets you have 
assigned to Collection Servers. 

To examine collection option set data 

1. In the process control panel, click on the Option Sets tab. 

2. Update the information on the tab either by clicking on  on the toolbar or by clicking 
on the View menu and clicking on Refresh. (You can also press F5.) 

3. Review the data on the tab. Click on the figure below for information about the columns 
on this tab.  
For more information see Option Sets Tab. 

4. Do any of the following on the Option Sets tab:  

 Print the information on the tab either by clicking on  on the toolbar or by clicking on the File 
menu and clicking on Print. 

 Sort the data on the tab by clicking on a column heading. 
 Edit a collection option set or schedule.  
 Just as on the Collection Servers tab, review and edit Collection Server settings and domain settings, 

examine errors that occurred on a Collection Server or its associated workstations, or stop and start a 
Collection Server .  
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Task Servers Tab 
The Task Servers tab of the process control panel lets you do the following: 

 Look at information about your Task Servers. 
 Stop or start a Task Server. 
 Examine errors that occurred on a Task Server. 

Only ZENworks Asset Management administrators can see the Tasks Servers tab. 
ZENworks Asset Management Manager does not display it if you are an assistant or an 
analyst. 

Information is shown in the columns as follows: 

 Host Name - the name of the machine on which the Task Server is running. 
 Server Status - The Server Status column shows the current status of the Task Server:  

Starting - The Task Server is in the process of starting. 
Started - The Task Server is in its normal state (running). 
Stopping - The Task Server is in the process of stopping. 
Stopped - The Task Server has been stopped by an administrator. 
Unavailable - Either the service is currently stopped or a serious condition (such as a problem with a network 
cable or card) is preventing the Task Server from communicating with the inventory database. This status 
appears in red to warn you the Task Server is not working. 
Inventory Stopped - The Task Server has been stopped because the entire inventory process has been 
stopped. 

 Current Task -   the name of the task currently running on the Task Server. (To see more details about the 
task, click on the Tasks tab in the process control panel.) 

 Task Type - indicates what kind of task is running: report, purge, or PRU. 
 Errors - indicates if any errors have occurred. 
 TCP/IP Address - the TCP/IP address of the Task Server. 
 Port - the port number of the Task Server. 

Stopping or Starting a Task Server 

ZENworks Asset Management gives you the option of stopping a Task Server. For 
example, you may want to stop a Task Server if you need to perform maintenance on the 
machine on which it resides, or if the machine is having problems. When you stop a Task 
Server, ZENworks Asset Management cancels any tasks that are currently running on the 
Task Server and prevents any further tasks from running on this Task Server until you 
start it again. 

To stop a Task Server 

1. Click on the Task Servers tab in the process control panel. 
2. Select the Task Server(s) you want to stop. 
3. Stop the Task Server in one of the following ways:  

 Click on   on the process control panel toolbar. 
 Right-click and click on Stop Server on the shortcut menu. 
 Click on the Control menu and click on Stop/Start Server. 

After ZENworks Asset Management has stopped the Task Server(s), the Server Status 
column on the Tasks Servers tab of the process control panel will read Stopped. 

TIP 
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 When you are ready to resume tasks on a stopped Task Server, be sure to start it again. 

To start a Task Server again 

1. Click on the Task Servers tab in the process control panel. 
2. Select the Task Server(s) you want to start again. 
3. Start the Task Server(s) in one of the following ways:  

 Click on   on the process control panel toolbar. 
 Right-click and then click on Start Server on the shortcut menu. 
 Click on the Control menu and click on Stop/Start Server. 

After ZENworks Asset Management has started the Task Server(s), the Server Status column 
on the Task Servers tab of the process control panel will read Started. 

Examining Task Server Data 

The Task Servers tab in the process control panel provides information about all your 
Task Servers. 

To examine Task Server data 

1. In the process control panel, click on the Task Servers tab. 

2. Update the information on the tab either by clicking on  on the toolbar or by clicking 
on the View menu and clicking on Refresh. (You can also press F5.) 

3. Review the data on the tab. Click on the figure below for information about the columns 
on this tab. For more information, see Task Servers Tab. 

4. After reviewing the status of your servers, do any of the following:  

 Print the information on the tab either by clicking on  on the toolbar or by clicking on the File 
menu and clicking on Print. 

 Stop or start a Task Server. 
 Look at the errors associated with a Task Server.  

Viewing Task Server Errors 

If the Errors column on the Task Servers tab indicates that an error has occurred, you can 
display some details about the error.  

To view Task Server errors 

1. On the Task Servers tab of the process control panel, select a Task Server for which errors 
have been reported. 

2. Do one of the following to check the errors:  

 Click on   on the process control panel toolbar. 
 Right-click and then click on View Errors on the shortcut menu. 
 Click on the Control menu and click on View Errors. 

3. ZENworks Asset Management will display the View Task Server Errors dialog. Review the 
errors listed. By default, ZENworks Asset Management lists severe errors only, but you have 
the option of viewing warning errors. You can also filter errors by date or description. 

4. To see an updated list of Task Server errors, click on the Refresh button. 
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5. To view different errors, edit the filter above the error list by selecting Level, Date, or 
Description; selecting an operator; specifying the value that you want to match; and 
clicking on the Filter button. For example, to see informational errors you would select 
Level and the = operator and then type info. (The possible values you can enter for the 
error level are severe, warning, or info.) 

6. To display the errors in a different order, click on the Date, Level, or Description column 
heading. 

7. To obtain more details about an error, select it. ZENworks Asset Management will display 
the additional information in the Detailed Description box. 

8. To display even more details (if available) about the error, double-click on it. 
9. Click on the Close button after you have finished investigating the errors. 

Tasks Tab 
A task in ZENworks Asset Management can be a scheduled report, a purge of the 
inventory database, network discovery, or a Product Recognition Update (PRU). All tasks 
are handled by a Task Server and are placed in a task queue so they get processed in an 
orderly fashion. The Task Server ensures the task gets run as scheduled. 

The Tasks tab of the process control panel lets you track and manage your tasks. 
Whenever you start a task, ZENworks Asset Management places it in a queue to wait its 
turn. The task runs when it is time for it to run according to its schedule or priority. On 
the Tasks tab you can: 

 Check the status of tasks that are currently in the queue. 
 Change the schedule or priority of a task. 
 Pause a task that is waiting to run and resume a paused task. 
 Remove a task from the queue. 

NOTE: Network Discovery tasks can be paused or removed, but you cannot pause or remove a Report or Purge task that 
has started to run; it will run to completion. 

Information is shown in the columns as follows: 

 Task - the name of the task. 
 Type - indicates whether the task is a report, purge, PRU (Product Recognition Update), or network 

discovery. 
 ZENworks Asset Manager User -  
 Status - shows the current status of the task: 

Running - The task is currently running. 
Paused - The task has been paused by a user. 
Waiting - The task is waiting to run. 

 Priority - indicates the task’s priority: 
High - The task will run as soon as system resources become available. 
Normal - The task will run as scheduled, after any high priority tasks but before any low priority ones. 
Low - The task will run after all higher priority tasks have run. 

 Scheduled - the date and time the task is scheduled to start. 
 Started   - the date and time the task started to run. 
 Task Server - the name of the Task Server that is handling the task. (To see more information about the 

server, click the Task Servers tab.) 

About Tasks and User Roles 

 All ZENworks Asset Management users can run report tasks, but only enterprise administrators can run purge 
and PRU tasks.  
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 All ZENworks Asset Management users can see which tasks are in the queue so they know how many tasks are 
ahead of theirs. A user's role determines what the user can change, however.  

 Enterprise administrators can act on any task in the queue; all other ZENworks Asset Management users can 
act only on reports they submitted themselves, not reports submitted by another user. 

History Tab 
The History tab of the process control panel provides information about completed tasks. 
All ZENworks Asset Management users can view this tab. 

By default, ZENworks Asset Management keeps historical data about tasks for two 
weeks before it is considered outdated and a candidate for a purge. An enterprise 
administrator can change this length of time with a setting in the Enterprise Options 
dialog. The amount of data you see on the History tab therefore depends on the enterprise 
option that is in effect as well as the number of tasks that have been run. 

Any task data that is older than the time specified in the Enterprise Options dialog is 
considered outdated but is not deleted until an enterprise administrator runs a purge. 

Information is shown in the columns as follows: 

 Task - the name of the completed task. 
 Type - indicates whether the task was a report, purge, PRU (Product Recognition Update), or network 

discovery. 
 ZENworks Asset Manager User - the name of the user who ran the task. 
 Status - The Status column shows the completion status of the task: 

Completed - The task ran successfully. 
Late Skipped - The scheduled task was late, and you had ZENworks Asset Management skip it this time and 
place it back in the queue to run at its next scheduled time. 
Late Canceled - The scheduled task was late, and you had ZENworks Asset Management cancel it. 
Failed - The task failed.  
For more information, see Scheduling a Task. 

 Priority - indicates the task's priority: 
High - The task ran as soon as system resources became available. 
Normal - The task ran as scheduled, after any high priority tasks but before any low priority ones. 
Low - The task ran after all higher priority tasks had finished. 

 Started - the date and time the task started to run. 
 Finished - the date and time the task was completed. 

You can do the following on the History tab: 

 Update the information on the tab either by clicking on  on the toolbar or by clicking on the View menu 
and clicking on Refresh. (You can also press F5.) 

 Print the information on the tab either by clicking on  on the toolbar or by clicking on the File menu and 
clicking on Print. 

TIPS 

 You can remove outdated historical data about tasks with a purge. 
 A report that you viewed on the screen will not appear on the History tab. 
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Check Outs Tab 
The Check Outs tab of the process control panel lets you see which workstations are 
currently "checked out" because they are being scanned. When a workstation is checked 
out you cannot edit its associated data with ZENworks Asset Management Manager. 

Occasionally, the checkout time shown in the process control panel may be so far back in 
the past that it suggests a problem. For example, the Collection Editor may be waiting for 
user input at the workstation, but the user is out on extended medical leave. In this case, 
you can check in the workstation so that it is accounted for during the next inventory 
cycle. 

NOTE: You can also run a Workstation Scan History report to see unusually long scan times. On the Grouping tab, set 
Count By to Machine Name. 

Only ZENworks Asset Management administrators can see the Check Outs tab. The 
Manager does not display it if you are an assistant or analyst. Enterprise administrators 
can see the checked-out workstations for the whole enterprise. Domain administrators can 
see the workstations only for the Collection Domains for which they are responsible. 

The information is shows in the columns as follows: 

 Domain - the name of the Collection Domain to which the workstation belongs.  
 Collection Server - the name of the Collection Server with which the workstation is associated.  
 Workstation - the workstation's machine name.  
 Primary User Name - the name of the primary workstation user.  
 Checkout Time - the date and time the workstation was checked out.  
 Type - the inventory type: stockroom, workstation, manually-entered workstation, server, portable, 

NetCensus, or not-yet-scanned workstation.  

You can do the following on the Check Outs tab: 

 Update the information on the tab either by clicking on  on the toolbar or by clicking on the View menu 
and clicking on Refresh. (You can also press F5.) 

 Print the information on the tab either by clicking on  on the toolbar or by clicking on the File menu and 
clicking on Print. 

 Check in a workstation. 

TIP 

 You can also check in a workstation while examining the results of a workstation query.  
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Checking in Workstations from the Process Control Panel 

If the Check Outs tab of the process control panel indicates that a workstation has been 
checked out for a long time, you can check in the workstation or stockroom. 

To check in a workstation or stockroom 

1. Click on the Check Outs tab of the process control panel. 
2. Do one of the following:  

 Select the workstation and click on   on the process control panel toolbar. 
 Right-click on the workstation and then click on Check In on the shortcut menu. 
 Select the workstation, click on the Control menu, and click on Check In Workstation. 

TIP 

 You can also check in workstations after running a workstation query. 

Current Users Tab 
The Current Users tab of the process control panel lets you see who is currently running 
ZENworks Asset Management Manager. Occasionally, you may need to know who else 
is running the application so you can ask them to exit; the Current Users tab lets you 
identify those users quickly. It also indicates if there is a problem with a copy of the 
Manager. 

The Current Users tab is available to all ZENworks Asset Management users. 

The columns contain information as follows: 

 ZENworks Asset Management User - the user's name. 
 Host Name - the name of the machine on which the copy of ZENworks Asset Management Manager is running. 
 Logon Time - the date and time the user logged onto ZENworks Asset Management Manager. 
 Last Update - the date and time ZENworks Asset Management last "heard from" ZENworks Asset Management 

Manager. (This is an internal check.) A time longer than 10 minutes may suggest a problem with that copy of 
ZENworks Asset Management Manager or perhaps with the machine on which it is running. 

 Host Type - indicates that the host application is Manager (ZENworks Asset 
Managment Manager).  

 TCP/IP Address - the TCP/IP address. 
 Port - the port number. 

TIP 

 If you are trying to get other users to exit the Manager, you can see if they are still using the application by 

updating the information on the tab. Either click on  on the toolbar or click on the View menu and 
clicking on Refresh. (You can also press F5.) As users exit, their names will not be listed on the Current Users 
tab. 
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Using the Shortcut Menus 

While using the Manager you can often right-click to display a shortcut menu. This type 
of menu pops up on the screen and displays the most-frequently used commands for your 
current context. For example, on a locator tab a shortcut menu gives you a quick way to 
rename or delete an item. 

Shortcut menus are available primarily on the locator tabs, in the process control panel, 
and when viewing inventory data. You can always try right-clicking to see if a shortcut 
menu is available. The documentation will also remind you of the availability of a 
shortcut menu in a particular context. 

Note: For your convenience, many Manager commands are available on a shortcut menu, 
a standard menu, a button on the toolbar, a shortcut key, or some combination of these. 
When a choice exists, use whichever feels fastest and most natural to you. (Any shortcut 
keys are listed on the Manager menus.) 

Changing Your Password 

If you are logging onto ZENworks Asset Management Manager for the first time using 
the EntAdmin account, you should change the password after you have logged on. If you 
do not, other users will be able to log onto the Manager using this account, which gives 
them the highest level of privileges. 

Other ZENworks Asset Management users may want to change their password if they do 
not like the one they were assigned. 

To change your password 

1. Click on the Tools menu and click on Change Password. 
2. Enter your current password. 
3. Enter your new password and enter it again in the Confirm New Password box. 
4. Click on the OK button. 

Changing ZENworks Asset Management Manager Options 
You can customize two aspects of ZENworks Asset Management Manager: 

You can set preferences on an enterprise level:  

 You can control how long historical data is kept in the inventory database before it becomes a candidate for 
a purge.  

 You can specify whether ZENworks Asset Management tracks hardware and software as they move around 
your network.  

 You can specify how often distributed servers (in an Enterprise Deployment) check with ZENworks Asset 
Management to see if any upgraded software or data files are available. 

See Changing Enterprise Options for more information. 

You can set preferences for the ZENworks Asset Management Manager 
application: 
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 You can choose how user names are displayed. 
 You can choose whether confirmation dialogs appear when you delete objects on Locator tabs and when you 

choose to scan a workstation manually. 

See Changing User Preferences for more information. 

Changing User Preferences 

You can customize some aspects of ZENworks Asset Management Manager's behavior in 
the Preferences dialog. For example, you can control how the Manager displays the 
names of workstation users, whether it asks you to confirm the deletion of items on 
locator tabs, and whether it asks you to confirm a scan on demand.  

NOTE: The user preferences affect just what you see or experience; any changes to these settings have no effect on 
other ZENworks Asset Management users. 

To change user preferences 

1. Click on the Tools menu and click on Preferences. 
2. To display the names of workstation users in a format other than last name followed by 

first name, select a different option in the Display Workstation User Names As section. 
3. If you do not want to be asked to confirm deletions on locator tabs, clear the Display 

Delete Confirmation on Locator tabs check box. 
4. If you want to confirm that a scan on demand has taken place, select the Confirm Scan on 

Demand check box. 
5. Click on the OK button. 

Contacting Novell Technical Support 

Before you contact Novell Technical Support, please do the following: 

 Check Troubleshooting Tips. 
 Check the Release Notes by clicking on the Release Notes icon in the ZENworks Asset Management program 

folder. 
 Use the Contents and Index tabs in this Help system to check on the procedure you are trying to use. 

Then contact Novell Technical Support at: 

  

http://support.novell.com 
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Exiting ZENworks Asset Management Manager 

It is a good idea to save your work as you go. If you try to exit the Manager without 
having done so, however, it will warn you that you have unsaved changes and give you 
the option of saving them. 

To exit the Manager 

1. If you have left any windows open with unsaved work, click on   on the toolbar or click 
on the File menu and click on Save All. 

2. Either close the the Manager main window or click on the File menu and click on Exit. 
3. If you did not perform step 1 and have left any windows open with unsaved work, the 

Manager will warn you. Click on the Yes button to save your changes or on the No button to 
discard the changes. 
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Inventory Preparations 

ZENworks Asset Management Users 

A ZENworks Asset Management user is anyone who is given the right to run ZENworks 
Asset Management Manager and work with the inventory database in one of six possible 
roles. Each role determines the type of activities the user can perform with this Manager. 
A ZENworks Asset Management user can be an administrator, assistant, or analyst, either 
on the enterprise level or the domain level, for example, an enterprise assistant or domain 
administrator. A ZENworks Asset Management user can have only one role. 

NOTE: Only an enterprise administrator can create and otherwise manage ZENworks Asset Management users. 

In an enterprise role, a ZENworks Asset Management user can perform activities across 
the entire organization in a global fashion. In a domain role, a ZENworks Asset 
Management user is restricted to one or more Collection Domains and has no access to 
information in another Collection Domain.  

The six ZENworks Asset Management user roles are: 

 Enterprise administrator  
 Enterprise assistant  
 Enterprise analyst  
 Domain administrator  
 Domain assistant  
 Domain analyst 

For detailed information on which users have access to which activities, see ZENworks 
Asset Management User Roles. 

Unless you are planning to manage ZENworks Asset Management by yourself, you will 
need to give some other users permission to run the Manager in one of the six roles listed 
above. Even if you are planning to do the bulk of the administration yourself, there may 
be people in your organization who need to use parts of the product, for example, run 
reports periodically to analyze inventory data. If you assign such users an analyst role, 
they will be able to run their own reports without always having to request them from 
you. They also will not be able to perform any administrative or maintenance activities so 
you will not have to worry about any settings or inventory data being changed 
inadvertently. 

See Also 

Creating a ZENworks Asset Management User  

Editing Information About a ZENworks Asset Management User  

Deleting a ZENworks Asset Management User  
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ZENworks Asset Management User Roles 
The tables in the sections that follow show in detail what a particular ZENworks Asset 
Management user role allows. 

 An M in the tables stands for management. For example, the user can create, edit, save, or delete 
something. 

 An R in the tables stands for read-only. For example, the user can view something on the screen or use it, 
but cannot change it permanently, create it, or delete it. 

 A blank in the tables means the user cannot do anything with this part of the product. 

The tables are organized by activity: 

 Database administration. 
 Management of the inventory process. 
 Inventory viewing and maintenance. 
 Analysis through reports and queries. 

Database Administration 

As you can see in the table that follows, only enterprise administrators can perform 
database administrative activities that affect the entire inventory process and enterprise.  

Activity  Enterprise 
Admin.  

Enterprise 
Assistant  

Enterprise 
Analyst  

Domain 
Admin.  

Domain 
Assistant  

Domain 
Analyst  

ZENworks Asset 
Management 
Users  

M        M  M     

Product 
Categories  

M                 

User-Defined 
Fields  

M                 

Database Purges  M                 
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Management of Inventory Process 

Both enterprise administrators and domain administrators can manage the inventory 
process, but domain administrators are restricted to their assigned Collection Domains. 
They cannot perform activities on an enterprise level and cannot perform activities in 
someone else’s Collection Domain. For example, domain administrators can create 
schedules for collections that occur in their own Collection Domains and can use a public 
collection schedule created by an enterprise administrator. They cannot, however, create 
a public schedule that can be used throughout the enterprise and cannot even look at a 
schedule in a Collection Domain to which they are not assigned. An enterprise 
administrator on the other hand, can do anything in any Collection Domain. 

Activity  Enterprise 
Admin.  

Enterprise 
Assistant  

Enterprise 
Analyst  

Domain 
Admin.  

Domain 
Assistant  

Domain 
Analyst  

Collection 
Domains  

M        M *        

Collection 
Servers  

M        M        

Collection 
Schedules  

M        M        

Collection 
Option Sets  

M        M        

Enterprise 
Options  

M                 

Portable 
Collections  

M        M        

Manual 
Inventory 
Activities  

M        M        

Task Servers  M        M        

* A domain administrator cannot create, merge, or delete domains, but can edit them 
(except for ZENworks Asset Management user assignments) and rename them. 
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Inventory Viewing and Maintenance 

As the table that follows shows, all ZENworks Asset Management users can view 
inventory data (using queries), but only administrators and assistants can change the data. 
Domain-level users are restricted to viewing and maintaining data in their assigned 
Collection Domains. 

Type of Data  Enterprise 
Admin.  

Enterprise 
Assistant  

Enterprise 
Analyst  

Domain 
Admin.  

Domain 
Assistant  

Domain 
Analyst  

Products  M *  R  R  R  R  R  

Local Products  M  R  R  R  R  R  

Workstations  M  M  R  M  M  R  

Components  M  M  R  M  M  R  

User Data  M  M  R  M  M  R  

FNI Data  M  R  R  R  R  R  

* An enterprise administrator can re-classify products that are defined by Novell, but 
cannot change them in any other way, nor delete them. 

Analysis 

All ZENworks Asset Management users can analyze inventory data through queries and 
reports, but domain-level users can analyze data only for their assigned Collection 
Domains. In addition, all users except for enterprise administrators are restricted to 
managing their personal queries and reports; only an enterprise administrator can manage 
public queries and reports that are available to all ZENworks Asset Management users.  

Activity  Enterprise 
Admin.  

Enterprise 
Assistant  

Enterprise 
Analyst  

Domain 
Admin.  

Domain 
Assistant  

Domain 
Analyst  

Queries *  M  M  M  M  M  M  

Reports *  M  M  M  M  M  M  

* Queries and reports that are shipped with ZENworks Asset Management cannot be 
changed or deleted by any ZENworks Asset Management user. 
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About Enterprise Administrators 

An enterprise administrator is the ZENworks Asset Management user with the highest 
level of privileges. This type of user can manage all aspects of the inventory process for 
the entire enterprise (across all Collection Domains), including creating other ZENworks 
Asset Management users. A number of activities can be done only by an enterprise 
administrator because of their potential effect on the whole enterprise. You can, however, 
have more than one enterprise administrator if you want to share the administrative 
responsibilities. 

When you install ZENworks Asset Management, a special user named EntAdmin is 
automatically created and assigned the role of enterprise administrator. To start using 
ZENworks Asset Management Manager, you must log on as EntAdmin. You can then 
create additional ZENworks Asset Management users so they can also use the product. It 
is completely up to you how many additional ZENworks Asset Management users you 
create and what kind of roles you assign to them. It is, however, a good idea to create a 
new user for yourself with an enterprise administrator role and leave the EntAdmin 
account as a back-up account. (Be sure to change the password of this account, however.) 

About Enterprise Analysts 

An enterprise analyst is a ZENworks Asset Management user with read-only privileges 
for the inventory data for the entire enterprise. An enterprise analyst can run reports and 
queries, but cannot perform administrative or maintenance activities. 

About Enterprise Assistants 

An enterprise assistant is a ZENworks Asset Management user with editing privileges for 
the inventory data for the entire enterprise. An enterprise assistant can analyze and 
change inventory data, but cannot perform administrative activities related to the 
inventory process. 

About Domain Administrators 

A domain administrator is a ZENworks Asset Management user with the privileges to 
manage one or more Collection Domains by setting up collection schedules and options 
and by analyzing and maintaining inventory data associated with the domain(s). A 
domain administrator cannot perform administrative or maintenance activities that affect 
the entire enterprise. For example, a domain administrator cannot create Collection 
Domains or other ZENworks Asset Management users, define product categories, or 
purge the database. 

About Domain Analysts 

A domain analyst is a ZENworks Asset Management user with read-only privileges for 
the inventory data for one or more Collection Domains. A domain analyst can run reports 
and queries, but cannot perform administrative or maintenance activities. 
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About Domain Assistants 

A domain assistant is a ZENworks Asset Management user with editing privileges for the 
inventory data associated with one or more Collection Domains. A domain assistant can 
analyze and change inventory data, but cannot perform administrative activities related to 
the inventory process.  

Creating a ZENworks Asset Management User 
NOTE: Only an enterprise administrator can create ZENworks Asset Management users. 

The number of ZENworks Asset Management users you create is completely up to you, 
as are the roles you assign to them. To centralize control, you might have an enterprise 
administrator and some domain assistants and analysts, but no domain administrators. To 
allow for regional autonomy, you might have a number of domain administrators, 
assistants, and analysts, as well as users with enterprise roles who can oversee the entire 
enterprise. You can also create additional enterprise administrators to help you manage 
your ZENworks Asset Management installation. A great deal of flexibility is available 
when it comes to assigning different user roles. 

NOTE: Although a Standalone Deployment of ZENworks Asset Management is on a single machine, you can still have 
multiple ZENworks Asset Management users for it. 

When you create a ZENworks Asset Management user, you specify a name and password 
for the user and select a role. You can also assign domain-level users to one or more 
domains at this point. Alternatively, you can assign ZENworks Asset Management users 
to Collection Domains when you create the domains. The order in which you do this does 
not matter. You can assign the same user to more than one Collection Domain. 

The first time you create a ZENworks Asset Management user, you must log onto 
ZENworks Asset Management Manager as EntAdmin. It is then a good idea to do the 
following: 

 Right away change the password to prevent other users from logging onto ZENworks Asset Management 
Manager using the EntAdmin account. (This account gives the highest level of privileges when running the 
Manager.) 

 Create a new user for yourself with an enterprise administrator role and leave the EntAdmin account as a 
back-up account. 

To create a ZENworks Asset Management user 

1. If this is the first time you are creating a ZENworks Asset Management user: 
 
a) Log onto the Manager as EntAdmin. The user name is "EntAdmin" and the password is 
"enterprise." 
b) Change the password to prevent anyone else from using the EntAdmin account.  

2. If you have created some ZENworks Asset Management users already, log on as an 
enterprise administrator. 

3. Either click on   on the toolbar or click on the Administration Menu and click on 
ZENworks Asset Management Users. 

4. In the Manage ZENworks Asset Management Users dialog, click on the New button. 
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5. In the Logon Information section of the Create ZENworks Asset Management User dialog, 
enter information about the user: 
 
a) Enter the unique name that you want the user to provide when logging onto the 
Manager.  
b) Enter and confirm the password that you want the user to provide.  
c) Select a role for this user, for example, Domain Administrator. 

6. If the role you selected is on the domain level, assign the user to one or more domains: 
 
a) Click on the Add button in the Assigned Collection Domains section. 
b) In the Select Collection Domain dialog, select the domain(s) to which you want to assign 
this user and click on the OK button to return to the Create ZENworks Asset Management 
User dialog. You can also double-click on a domain to assign the user to it. 

7. Click on the OK button to return to the Manage ZENworks Asset Management Users dialog 
and then click on the Close button.  

TIPS 

 If users do not like the password you have assigned, they can change it after they log onto the Manager with 
the password you provided them. 

 All enterprise-level ZENworks Asset Management users have access to all Collection Domains so you do not 
need to assign them to domains. 

 You can also assign ZENworks Asset Management users to a Collection Domain when you create it. 

See Also 

About ZENworks Asset Management Users  

Editing Information About a ZENworks Asset Management User 
If you need to change any information about a ZENworks Asset Management user, you 
can edit it. For example, you may want to correct the spelling of a user’s name, change 
the user’s role, or change the Collection Domains to which a user is assigned.  

NOTE: Only an enterprise administrator can edit information about a ZENworks Asset Management user. 

To edit information about a ZENworks Asset Management user 

1. Either click on   on the toolbar or click on the Administration Menu and click on 
ZENworks Asset Management Users. 

2. In the Manage ZENworks Asset Management Users dialog, display the contents of the 
container that includes the user you want to edit. The containers are named by role. 

3. Do one of the following: 
 
a) Double-click on the user you want to edit. 
b) Select the user and click on the Edit button. 
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4. In the Edit ZENworks Asset Management User dialog, make the changes you want. For 
example, select a different role for the user or change the domain assignments by using 
the Add and Remove buttons in the Assigned Collection Domains section. 
 
NOTE: If you change a user’s role from the domain level to the enterprise level, ZENworks 
Asset Management Manager will warn you that the user will no longer be associated with 
specific Collection Domains. 

5. Click on the OK button to return to the Manage ZENworks Asset Management Users dialog 
and then click on the Close button. 

Deleting a ZENworks Asset Management User 
If you no longer want a user to have access to ZENworks Asset Management, you can 
delete that ZENworks Asset Management user. 

NOTE: Only an enterprise administrator can delete a ZENworks Asset Management user. 

To delete a ZENworks Asset Management user 

CAUTION: When you delete a ZENworks Asset Management user, any personal queries or reports that the user created 
will also be deleted.  

1. Either click on   on the toolbar or click on the Administration Menu and click on 
ZENworks Asset Management Users. 

2. In the Manage ZENworks Asset Management Users dialog, display the contents of the 
container that includes the user you want to delete. The containers are named by role. 

3. Select the user and click on the Delete button. 
4. Confirm the deletion. 
5. Click on the Close button in the Manage ZENworks Asset Management Users dialog. 

Collection Schedules 

A collection schedule controls the timing and frequency of your inventories. It ensures 
that the inventory process takes place on workstations during a particular period. What 
happens during the inventory process depends on the collection option set you are using.  

You have a great deal of flexibility in setting up collection schedules. For example, you 
can establish a monthly cycle with collections taking place every seventh day of the 
month or an annual cycle with collections taking place the first Monday of April. You 
can also specify the "window" during which the inventory process should take place. For 
example, even if the inventory is scheduled to take place on the seventh day of the month, 
you may want to allow three days for all the workstation scans to occur. You can even 
specify the hours during which you want scans to take place, for example, only from 9:00 
A.M. to 11:00 A.M. 

NOTE: Only ZENworks Asset Management enterprise administrators and domain administrators can work with collection 
schedules. 
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Once you have defined a schedule, you may assign it to a collection option set, which 
controls what happens during the inventory process. For example, a collection option set 
can specify that just software data is collected or that workstation users have to provide 
some information about themselves after their workstations are scanned. Each collection 
option set always has one collection schedule associated with it. 

Collection option sets, in turn, may be assigned to Collection Domains or Collection 
Servers. The assigned collection option sets (and their associated schedules) are then 
responsible for the nature and timing of the inventory of the workstations associated with 
a Collection Server. (Collection Servers can either inherit collection option sets from 
their Collection Domain or have specific collection option sets assigned to them.)  

One collection schedule and option set may suit your purposes very well. You have the 
option, however, of assigning more than one collection option set to a Collection Domain 
or Collection Server. Suppose that in your midwestern Collection Domain you want an 
annual collection of FNI data over a two-week period and a mid-week collection of 
hardware and software every three months. First, you would set up your two schedules 
(one annual and the other every three months). Second, you would set up your two 
collection option sets (one for software and FNI data and the other for hardware and 
software data but no FNI data), each associated with the correct schedule. Third, you 
would assign both collection option sets to your midwestern Collection Domain. This 
would ensure that all the workstations in the domain would be scanned for FNI data 
annually and for software and hardware data every three months. 

NOTE: You do not have to assign a collection option set to a Collection Server if you want it to use the same collection 
option sets as its Collection Domain. By default, a Collection Server inherits its collection option sets (and their 
associated schedules) from its parent domain. 

ZENworks Asset Management comes with a default schedule that is assigned to all 
collection option sets in the enterprise automatically. You can also create public 
schedules that are available throughout the enterprise or domain schedules that are 
available within a particular Collection Domain. 

See Also 

Setting Up a Collection Schedule  

Default Schedule 
When you install ZENworks Asset Management, a default collection schedule is 
automatically created for you. The default schedule has two purposes: 

1. It can serve as the standard collection schedule throughout your enterprise. The default 
schedule is assigned to all collection option sets automatically unless you assign a different 
schedule to them. 

2. It lets you get started with ZENworks Asset Management as soon as you want to perform 
inventories. The default schedule is initially inactive to prevent inventories from taking 
place before you are ready. Simply edit some settings in the default schedule, and the 
inventory process will start. 
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The default schedule has the following initial settings:  

 The collection cycle is by the month. 
 The beginning date is 1/1/2000 and the ending date is the current date. (As soon as you are ready to start 

inventories, edit the schedule to change these dates.) 
 Collection starts on the first day of each month, and occurs each month. 
 Each collection cycle lasts 28 days. 
 Collections can take place at any time of day. 

An enterprise administrator can change the default schedule, but cannot rename it or 
delete it. The default schedule is therefore always available and is assigned to collection 
option sets automatically unless you assign a different collection schedule to them.  

TIP 

 Be sure to edit the default schedule to "activate" it and to meet the needs of your organization in any other 
ways. Remember that this collection schedule is used by default until you assign a different schedule to a 
collection option set. 

See Also 

Public Schedules  

Domain Schedules  

Setting Up a Collection Schedule 
If you want to use one collection schedule throughout the enterprise to synchronize the 
inventory process, edit the default schedule provided by Novell both to "activate" it and 
to meet the needs of your organization. The default schedule is assigned automatically to 
all collection option sets and is the simplest means of using the same schedule throughout 
the enterprise.  

Alternatively, you may want several collection schedules customized for particular 
situations or parts of your organization. For example, the workstations associated with the 
Sales Collection Server may require a very different schedule from that required by the 
Engineering Collection Server. You can therefore set up two different schedules and 
assign them to two different collection option sets, each of which specifies a different 
department to be scanned. How you combine schedules and option sets is completely up 
to you.  

When you set up a schedule you need to select a cycle and a duration for it.  

The cycle determines the frequency at which your collections will take place. For 
example, a cycle might be every six weeks, the second Friday of every third month, or 
once a year. The cycle you select may be completely up to you or be tied to corporate 
requirements such as the need for accurate reports about hardware and software assets 
every quarter.  
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The duration determines the length of the period during which collections can take 
place. The duration should be long enough to allow as many workstations as possible (if 
not all) to be scanned. For example, if your workstation users are highly mobile and 
rarely call in, you should factor that in when coming up with a duration. In general, the 
less frequent your cycle, the longer the duration should be. For example, if you scan 
workstations only once a year, you may want a duration of a few weeks; if you scan 
workstations monthly, you may want a duration of a few days. If you want a continuous 
schedule, make the cycle and duration the same length. 

To set up a collection schedule 

1. Either click on the Management locator tab or click on the View menu and click on 
Management. 

2. Do one of the following: 

 Click on   on the toolbar when the Public Collection Schedules container, a domain Collection 
Schedules container, or a folder in one of these containers is selected. Then click on Collection 
Schedule.  

 Right-click on the Public Collection Schedules container, a domain Collection Schedules container, or a 
folder in one of these containers; click on New on the shortcut menu, and then click on Collection 
Schedule. 

 With the Public Collection Schedules container, a domain Collection Schedules container, or a folder in 
one of these containers selected, click on the File menu, click on New, and then click on Collection 
Schedule. 

 
The Manager will now display a Collection Schedule window in the workspace alongside the 
Management locator tab.  

3. In the Cycle section select Yearly, By the Month, By the Week, By the Day, or Once from 
the Collect drop-down list. The default is By the Month. Your selection here will affect 
other choices you can make in the Cycle section.  

4. (Optional) To define the overall dates within which collections should take place, enter 
the dates in the Beginning and Ending boxes. By default, the beginning date is the current 
date, and there is no ending date. To provide an ending date, you must first select the 
check box.  
Either type a date in the Beginning or Ending box or click on the down-arrow in the box to 
select a date from a calendar. On the calendar, click on the arrows to go forward or 
backward by a month at a time or click on the month or year to select another. To select a 
specific date, click on it. To select today's date, click on where it reads "Today." 
NOTE: Make sure the beginning date is synchronized with the other details of your cycle. 
For example, if you want to collect inventory data every first Monday of the month, and 
the beginning date is October 15th, your next inventory will not take place until the first 
Monday of November. 

5. If you selected Yearly, either indicate a particular day in a month, for example, every 
December 15, or, indicate a specific day of a specific week of a month, for example, the 
first Monday of December. The default is the first Monday of the current month. 

6. If you selected By the Month, either indicate a specific day every x number of months, for 
example, the seventh day of every third month, or, indicate a specific day of the week of 
a specific week every x number of months, for example, the second Friday of every third 
month. The default is the first Monday of every month.  

7. If you selected By the Week, select a day of the week for the inventory to take place and 
specify every x number of weeks. For example, you may want collections to take place 
every three weeks on Mondays. The default is every week on a Monday. 
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8. If you selected By the Day, either select a specific day of the week for the inventory to 
take place (you can select more than one day), or, specify every x number of days, for 
example, every five days. The default is every day. 

9. In the Duration section, indicate how long you want the inventory process to last. You 
want to allow enough time for all workstations to be scanned.  

 If you selected Once, select a number of days (the default is seven days). 
 If you selected By the Day or By the Week, select a number of days (the default is one day).  
 If you selected By the Month, select a number of days or weeks (the default is seven days).  
 If you selected Yearly, select a number of days, weeks, or months (the default is seven days). 

10. (Optional) If you want to restrict scans of workstations to a particular time of day, select 
the Only Scan Between check box and then select a range of times. By default, scans can 
take place at any time.  
NOTE: In an Enterprise Deployment of ZENworks Asset Management, Collection Servers 
may be in different time zones. Any times that you specify here will be interpreted as 
times local to the Collection Server. For example, if you are in California and specify a 
time range of 9:00 A.M. to 12:00 P.M., a Collection Server in Boston that uses this schedule 
will run collections between 9:00 A.M. and 12:00 P.M. EST. 

11. Save the collection schedule by clicking on   on the toolbar, by clicking on the File 
menu and clicking on Save, or by clicking on the File menu and clicking on Save As. If 
necessary, complete the Save Schedule As dialog. 

12. Close the Collection Schedule window.  

See Also 

About Collection Schedules  

Assigning a Collection Schedule  

Assigning a Collection Schedule 
After you have set up and saved a schedule, it is ready to be used by being assigned to a 
collection option set. (In turn, the collection option set needs to be assigned to a 
Collection Domain or Collection Server.) 
NOTE: When you assign a public collection schedule to a domain-level collection option set, the schedule itself is not 
copied to the domain’s Collection Schedules container. 

To assign a schedule 

Do any of the following to assign a schedule:  
 If you want to use one collection schedule throughout the enterprise, use the default schedule provided by 

Novell. You must edit this schedule so it is active and accomplishes what you need. You do not need to assign 
this schedule; it is used automatically by all collection option sets unless you assign a different schedule to 
them.  

 If you want to assign a schedule to an existing collection option set, edit the option set to assign the 
schedule.  

 If you want to assign a schedule to a collection option set that does not exist yet, create the option set and 
assign the schedule during the creation process. (You do this on the General tab in the Collection Option Set 
window.)  

TIPS 
 To see which schedule is currently assigned to a collection option set, look at the Option Sets tab in the 

process control panel.  

 If you are the domain administrator of more than one Collection Domain, you can assign a schedule to a 
collection option set in a domain only if the schedule is a public schedule or is available in that domain. You 
cannot assign a schedule from one of your other Collection Domains. If you want to use the same schedule in 
more than one domain, copy it to the other domains. 
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Reviewing and Editing a Collection Schedule 
You can review and change a schedule's settings. If you edit a schedule that is associated 
with a collection option set, and the option set is assigned to a Collection Domain or 
Collection Server, ZENworks Asset Management will automatically ensure that the 
updated schedule goes into effect after you save your changes.  

Enterprise administrators can review and edit any collection schedule; domain 
administrators can review any public schedule and any schedule in their domains, but can 
edit a schedule in their domains only. 

An enterprise administrator can edit the default schedule thus changing the default 
settings for the entire enterprise. The default collection schedule is named Default 
Schedule and is in the Public Collection Schedules container. 

NOTE: To prevent inventories from occurring before you are ready for them, the default schedule is initially inactive. 
When you are ready to start collecting data, you must activate the default schedule by editing it. Be sure to remove or 
change the ending date.  

To review and edit a collection schedule 

1. Do one of the following on the Management locator tab to display a schedule: 
 Double-click on the schedule. 

 Select the schedule and click on   on the toolbar. 
 Right-click on the schedule and then click on Open on the shortcut menu. 
 Select the schedule, click on the File menu, and click on Open. 

2. Review the current settings. 
3. Change the schedule the same way you set it up.  
4. To save the changed schedule, do one of the following:  

 Click on   on the toolbar. 
 Click on the File menu and click on Save. 

To save the schedule under a different name, click on the File menu, click on Save As, and 
complete the Save Schedule As dialog.  

5. Close the Collection Schedule window. 

TIP 

 You can also edit a collection schedule from the Option Sets tab in the process control panel. 
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Renaming a Collection Schedule 
You can change the name of a schedule to be more self-explanatory. An enterprise 
administrator can rename any schedule except for the default schedule; a domain 
administrator can rename schedules only in his or her own Collection Domains. 

NOTE: You cannot rename a schedule if it is open in a window in the workspace. Close the window first. 

To rename a collection schedule 

1. On the Management locator tab, do one of the following to rename a schedule:  
 Right-click on the schedule and click on Rename on the shortcut menu. 
 Select a schedule, click on the File menu, and click on Rename. 

2. Enter the new name in the Rename Schedule dialog and click on the OK button. 

Copying a Collection Schedule 
An enterprise administrator can copy collection schedules from domain Collection 
Schedules containers to the Public Collection Schedules container and vice versa.  

Domain administrators can copy a collection schedule from the Public Collection 
Schedules container to a Collection Schedules container in one of their own Collection 
Domains (but not vice versa). They can also copy schedules among the Collection 
Schedules containers in their own Collection Domains if they are managing more than 
one. For example, if they want all their domains to follow the same collection schedule, 
they can create the schedule in one domain and then copy it to the others. The schedule 
will then be available for assignment in each domain. 

NOTE: You cannot copy a schedule if it is open in a window in the workspace. Close the window first. 

To copy a collection schedule 

On the Management locator tab, do one of the following to copy a schedule: 

 Use the right mouse button to drag the schedule to another Collection Schedules container and then click on 
Copy Here on the menu that appears. 

 Select the schedule and click on   on the toolbar. Then select another Collection Schedules container 

and click on . 
 Right-click on the schedule and click on Copy on the shortcut menu. Then right-click on another Collection 

Schedules container and click on Paste on the shortcut menu. 
 Select the schedule, click on the Edit menu, and click on Copy. Then select another Collection Schedules 

container, click on the Edit menu, and click on Paste. 
 Press and hold the Ctrl key and drag the schedule to another Collection Schedules container. 
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Moving a Collection Schedule 
An enterprise administrator can move schedules among domain Collection Schedules 
containers and the Public Collection Schedules container.  

Domain administrators can move schedules among their own Collection Domains if they 
are managing more than one domain. 

NOTE: Moving a collection schedule is not the same as assigning it. By moving a schedule you make it available in a 
particular Collection Domain. It can then be assigned to a collection option set in that domain. 

When you move a schedule from a Collection Domain, you essentially remove it from 
the domain. If the schedule you moved was assigned to a collection option set, it will now 
use the default schedule instead. On the other hand, when an enterprise administrator 
moves (promotes) a domain schedule to the Public Collection Schedules container, the 
collection option set that was assigned this schedule will continue to have it assigned. 

NOTE: You cannot move a schedule if it is open in a window in the workspace. Close the window first. 

To move a collection schedule 

On the Management locator tab, do one of the following to move a schedule: 

 Use the right mouse button to drag the schedule to another Collection Schedules container and then click on 
Move Here on the menu that appears. 

 Select the schedule and click on   on the toolbar. Then select another Collection Schedules container 

and click on .  
 Right-click on the schedule and click on Cut on the shortcut menu. Then right-click on another Collection 

Schedules container and click on Paste on the shortcut menu. 
 Select the schedule, click on the Edit menu, and click on Cut. Then select a Collection Schedules container in 

a different Collection Domain, click on the Edit menu, and click on Paste. 
 Drag the schedule to another Collection Schedules container. 

Promoting or Demoting a Collection Schedule 
An enterprise administrator can make a domain schedule available to everyone by 
promoting it to the Public Collection Schedules container. Conversely, an enterprise 
administrator can demote a schedule by moving it from the Public Collection Schedules 
container to a Collection Schedules container in a specific Collection Domain. 

NOTE: You cannot promote or demote a schedule if it is open in a window in the workspace. Close the window first. 

To promote a domain collection schedule 

In a Collection Schedules container in a Collection Domain, do one of the following: 

 Use the right mouse button to drag the schedule to the Public Schedules container and then click on Move 
Here on the menu that appears. 

 Right-click on the schedule and click on Promote on the shortcut menu. 
 Select the schedule, click on the File menu, and click on Promote. 
 Drag the schedule to the Public Collection Schedules container.  
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To demote a public collection schedule 

When you demote a public schedule, it may become unavailable to a collection option 
set. For example, if a collection option set in the Collection Domain named New York is 
using a public schedule, and you demote it to the London domain, the collection schedule 
will no longer be available to the New York domain. In this case, ZENworks Asset 
Management Manager would assign the default schedule to the option set in the New 
York domain. Similarly, if a Collection Server was using a collection option set with an 
associated public collection schedule, and you demoted this schedule to another 
Collection Domain, the option set is assigned the default schedule.  

In the Public Collection Schedules container, do one of the following to demote a public 
schedule: 

 Use the right mouse button to drag the schedule to a Collection Schedules container in a specific domain and 
then click on Move Here on the menu that appears. 

 Drag the schedule to a Collection Schedules container in a specific domain.  

TIP 

 If the promotion or demotion results in two schedules with the same name in the same container, the 
Manager will add a number to the name of the promoted or demoted schedule. You can then rename it if you 
want. 

Deleting a Collection Schedule 
If you no longer have a use for a particular schedule, you can delete it. When you try to 
delete a schedule that is assigned to a collection option set, you will be asked to confirm. 
Any collection option set that was using the deleted schedule will then use the default 
schedule. 

An enterprise administrator can delete any collection schedule; a domain administrator 
can delete a schedule only in his or her own Collection Domains. 

NOTE: You cannot delete a schedule if it is open in a window in the workspace. Close the window first. 

To delete a schedule 

1. On the Management locator tab, do one of the following to delete a schedule:  

 Select the schedule and click on   on the toolbar. 
 Right-click on the schedule and click on Delete on the shortcut menu. 
 Select the schedule, click on the File menu, and click on Delete. 

2. Confirm the deletion if asked. 
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About Collection Schedule Windows 
In a Collection Schedule window you set up or edit a collection schedule. When you set 
up a schedule you need to select a cycle and a duration for it.  

The cycle determines the frequency at which your collections will take place. For 
example, a cycle might be every six weeks, the second Friday of every third month, or 
once a year. The cycle you select may be completely up to you or be tied to corporate 
requirements such as the need for accurate reports about computer assets every quarter.  

The duration determines the length of the period during which collections can take 
place. The duration should be long enough to allow as many workstations as possible (if 
not all) to be scanned. For example, if your workstation users are highly mobile and 
rarely call in, you should factor that in when coming up with a duration. In general, the 
less frequent your cycle, the longer the duration should be. For example, if you scan 
workstations only once a year, you may want a duration of a few weeks; if you scan 
workstations monthly, you may want a duration of a few days. If you want a continuous 
schedule, make the cycle and duration the same length. 

1.  In the Cycle section select Yearly, By the Month, By the Week, By the Day, or Once from 
the Collect drop-down list. The default for new schedules is By the Month. Your selection 
here will affect other choices you can make in the Cycle section. 

2. (Optional) To define the overall dates within which collections should take place, enter 
the dates in the Beginning and Ending boxes. Except in the default schedule, the default 
beginning date is the current date, and there is no ending date. (In the default schedule, 
the beginning date is 1/1/2000 and the ending date is 1/8/2000. Remove the ending date 
to get started.) 
 
Either type a date in the Beginning or Ending box or click on the down-arrow in the box to 
select a date from a calendar. (To provide an ending date, you must first select the check 
box.) On the calendar, click on the arrows to go forward or backward by a month at a time 
or click on the month or year to select another. To select a specific date, click on it. To 
select today's date, click on Today. 
 
NOTE: Make sure the beginning date is synchronized with the other details of your cycle. 
For example, if you want to collect inventory data every first Monday of the month, and 
the beginning date is October 15th, your next inventory will not take place until the first 
Monday of November. 

3. If you selected Yearly, either indicate a particular day in a month, for example, every 
December 15, or, indicate a specific day of a specific week of a month, for example, the 
first Monday of December. The default is the first Monday of the current month. 

4. If you selected By the Month, either indicate a specific day every x number of months, for 
example, the seventh day of every third month, or, indicate a specific day of the week of 
a specific week every x number of months, for example, the second Friday of every third 
month. The default is the first Monday of every month.  

5. If you selected By the Week, select a day of the week for the inventory to take place and 
specify every x number of weeks. For example, you may want collections to take place 
every three weeks on Mondays. The default is every week on a Monday. 

6. If you selected By the Day, either select a specific day of the week for the inventory to 
take place (you can select more than one day), or, specify every x number of days, for 
example, every five days. The default is every day. 
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7. In the Duration section, indicate how long you want the inventory process to last. You 
want to allow enough time for all workstations to be scanned.  

 If you selected Once, select a number of days (the default is seven days). 
 If you selected By the Day or By the Week, select a number of days (the default is one day).  
 If you selected By the Month, select a number of days or weeks (the default is seven days).  
 If you selected Yearly, select a number of days, weeks, or months (the default is seven days). 

8. (Optional) If you want to restrict scans of workstations to a particular time of day, select 
the Only Scan Between check box and then select a range of times. By default, scans can 
take place at any time. 
 
NOTE: In an Enterprise Deployment of ZENworks Asset Management, Collection Servers 
may be in different time zones. Any times that you specify here will be interpreted as 
times local to the Collection Server. For example, if you are in California and specify a 
time range of 9:00 A.M. to 12:00 P.M., a Collection Server in Boston that uses this schedule 
will run collections between 9:00 A.M. and 12:00 P.M. EST. 

9. Save the collection schedule by clicking on   on the toolbar, by clicking on the File 
menu and clicking on Save, or by clicking on the File menu and clicking on Save As. If 
necessary, complete the Save Schedule As dialog. 

10. Close the Collection Schedule window. 

See Also 

About Collection Schedules  

Domain Schedules 
Collection schedules can be available either on a public level or a domain level. Domain 
collection schedules are available for use within the Collection Domain in which they 
were created. Only an enterprise administrator and the domain administrator for the 
Collection Domain can manage the schedules available in that domain. Domain 
administrators can create, use, edit, copy, move, delete, and rename collection schedules 
in their own domains and assign the schedules to collection option sets in their own 
domains.  

Domain administrators will never even see the collection schedules belonging to a 
Collection Domain to which they are not assigned. 
NOTE: The domain administrator of more than one Collection Domain can assign a collection schedule to a collection 
option set only if it is a public schedule or if it is available in that domain. The administrator cannot assign a collection 
schedule from another domain. To use the same schedule in more than one domain, the administrator must copy it to 
the other domains. Alternatively, the domain administrator can ask an enterprise administrator to make the schedule 
public. 

If an enterprise administrator wants to make a domain collection schedule available to 
everyone, the administrator can promote the schedule so it is public. Conversely, a public 
collection schedule can be demoted to the domain level. 

Each domain on the Management locator tab has a Collection Schedules container for its 
schedules. An administrator has the option of creating folders in the Collection Schedules 
container to organize the domain schedules. 

See Also 
Default Schedule  
Public Schedules  
Setting Up a Collection Schedule  
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Creating a Schedule Folder 
On the Management locator tab, the Public Collection Schedules container and the 
Collection Schedules container for a domain initially have no folders. It is up to you to 
create folders for organizing any collection schedules you define. You can create as many 
folders as you like and name them as you like, but you cannot create folders inside other 
folders. If you choose not to create any folders, your collection schedules will be stored 
in the container 

An enterprise administrator can create folders in any Collection Schedules container 
(public or domain); a domain administrator can create folders only in the Collection 
Schedules container(s) for his or her Collection Domain(s). 

To create a schedule folder 

1. Either click on the Management locator tab or click on the View menu and click on 
Management. 

2. With the Public Collection Schedules container selected or a Collection Schedules 
container selected in a domain, do one of the following:  

 Click on   on the toolbar and click on Folder. 
 Right-click on the container name, click on New on the shortcut menu, and then click on Folder. 
 Click on the File menu, click on New, and then click on Folder. 

3. Enter a name for the folder in the Folder dialog and click on the OK button. ZENworks 
Asset Management Manager will suggest a name, for example, Collection Schedule Folder1. 
The name must be unique within the container. 

Public Schedules 
Collection schedules can be available either on a public level or a domain level. Public 
collection schedules are available to all ZENworks Asset Management administrators. 
All administrators can review public schedules, assign them to collection option sets, or 
copy them. Only an enterprise administrator can create, edit, delete, rename, or move a 
public collection schedule. An enterprise administrator can also assign a public collection 
schedule to any collection option set, whereas a domain administrator can assign public 
collection schedules only to the collection option sets in his or her domain.  

The Management locator tab includes a Public Collection Schedules container for storing 
public schedules. An enterprise administrator has the option of creating folders in the 
Public Collection Schedules container to organize the public schedules. 

See Also 

Default Schedule  

Domain Schedules  

Setting Up a Collection Schedule  

Save Schedule As 

1. Enter a name for the collection schedule. The name must by unique within a folder. 
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2. (Optional) Select a folder for the schedule if you want a folder other than the one listed in 
the Folder box. If no folders exist, ZENworks Asset Management will store the schedule in 
the container you selected when you began creating the schedule. 

3. Click on the OK button. 

Collection Option Sets 

About Collection Option Sets 
A collection option set is a group of settings that controls many aspects of the inventory 
process on workstations. For example, with a collection option set you can: 

 Specify what kind of data the Collector should gather from workstations, for example, hardware, software, 
or FNI.  

 Control whether the Collection Editor should run automatically on workstations after the Collector is finished 
to let workstation users view and modify information about their workstations.  

 Specify which collection schedule is in effect with the collection option set. (Each collection option set has 
an associated schedule.) 

 Control whether after each scan ZENworks Asset Management converts the inventory data for a workstation 
to another file format. For example, you can convert the data to an .xml file so you can use it with another 
application. You can also convert inventory data to Management Information Format (MIF) files so the data is 
available in Microsoft's Systems Management Server (SMS). 

NOTE: The file conversion options do not apply to portable collections or scans of network servers. 

 Customize what kind of data workstation users can view and edit with the Collection Editor and how they can 
edit the data.  

 Specify which workstations should be affected by the collection option set. By default, all the workstations 
associated with a Collection Server are affected by a collection option set, but you can specify criteria to 
select particular workstations, for example, all those on one floor of a building. 

NOTE: Only enterprise administrators and domain administrators can work with collection option sets. 

To put a collection option set in effect, you must assign it to a Collection Domain or 
Collection Server. The option set then affects the collection process on all the 
workstations associated with a Collection Server unless the collection option set specifies 
particular workstations for scanning.  

NOTE: You do not have to assign collection option sets to a Collection Server if you want it to use the same ones as its 
Collection Domain. By default, a Collection Server inherits its option sets from its parent domain. 

A single collection option set for all your workstations may be quite sufficient for your 
purposes. ZENworks Asset Management gives you the flexibility, however, of assigning 
multiple collection option sets to a Collection Domain or Collection Server. Since each 
collection option set has an associated schedule, multiple option sets make it possible to 
stagger your inventory process by: 

 Performing different kinds of scans of all your workstations at different times. For example, you could scan 
software and hardware on alternating months and collect FNI data every six months. 

 Fully scanning different groups of workstations at different times.  
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You can create multiple collection option sets to be used for different functions. You can 
see all your collection option sets listed on the Management locator tab. ZENworks Asset 
Management automatically comes with a Public Collection Option Sets container which 
includes the default option set. In addition, each domain has its own Collection Option 
Sets container. 

Collection Domains and Collection Servers can have multiple standard option sets. In 
addition, you can earmark a collection option set for scanning new workstations or for 
scanning workstations on demand. New workstation option sets are used for scanning 
new workstations in your organization; scan now option sets are used for scanning 
workstations on demand, including portable collections and server scans. In both 
situations you may want a different collection option set (and associated schedule) than 
you want for your regular inventory cycles. 

ZENworks Asset Management comes with a default option set that is in effect 
automatically. You can also create public option sets that are available throughout the 
enterprise or domain option sets that are available within a particular Collection Domain. 

See Also 

Setting Up a Collection Option Set  

Assigning a Collection Option Set  

Default Option Set 
When you install ZENworks Asset Management, a default collection option set is 
automatically created. The default option set has two purposes: 

1. It lets you get started right away with ZENworks Asset Management without having to 
create a collection option set. The initial settings provided by Novell ensure that: 

 The Collector gathers hardware and software inventory data. 
 The default collection schedule is assigned to the collection option set. 
 By default, the Collection Editor is not enabled. If it is set to run, the Collection Editor lets workstation 

users review and modify the collected data. Users can add components and delete any manually-
entered ones, but cannot create local products.  

 ZENworks Asset Management does not convert inventory data after each scan of a workstation either to 
.xml files or to SMS Management Information Format (MIF) files.  

 All workstations are included in the scan. 
2. It can serve as the standard collection option set throughout your enterprise. The default 

option set is automatically used by all Collection Domains and Collection Servers unless you 
assign a different collection option set to them. (The default option set is also used 
automatically as the new workstation option set and scan now option set unless you assign 
a different option set.) 

An enterprise administrator can change the settings that make up the default collection 
option set, but cannot rename or delete it. The default option set is therefore always 
available and is used by Collection Domains automatically unless you assign a different 
collection option set to them. In turn, the Collection Servers associated with the 
Collection Domain automatically inherit the collection option sets assigned to the 
domain. You have the option, however, of assigning different collection option sets to 
each Collection Server. 
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See Also 

Public Collection Option Sets  

Domain Collection Option Sets  

Setting Up a Collection Option Set 
If you want to use one collection option set throughout your enterprise to standardize 
which data is gathered, edit the default collection option set to meet the needs of your 
organization. The default option set is used automatically by all Collection Domains so is 
the simplest means of using the same collection option set throughout the enterprise.  

Alternatively, you may want several collection option sets that are customized for 
particular situations or parts of your organization, or that address particular scheduling 
issues. For example, the workstations of users in a technically-oriented department may 
require a very different collection option set from that required in an administrative 
department. In one case you may want to allow workstation users a great deal of latitude 
in what they enter with the Collection Editor during the inventory cycle and in the other 
very little latitude. You can therefore set up two different collection option sets targeted 
at certain workstations in a Collection Domain. You can also set up collection option sets 
that collect different kinds of data according to different schedules. The many possible 
combinations are completely up to you. 

The collection option sets that control your regular inventory cycles are standard option 
sets. You can also define two types of collection option set to account for exceptions to 
your regular inventory cycles. New workstation option sets are used for scanning new 
workstations in your organization; scan now option sets are used for scanning 
workstations on demand (including portable collections and server scans). In both 
situations you may want a different collection option set than you want for your regular 
inventory cycles. 

TIP 

 To see both your collection option set assignments and the settings in a particular option set, run a 
Collection Option Set Summary report. This report is in the Maintenance folder of the ZENworks Asset 
Management Reports container.  

An enterprise administrator can create collection option sets in any Collection Option 
Sets container (public or domain); a domain administrator can create collection option 
sets in a domain Collection Option Sets container only. 

To set up a collection option set 

1. Either click on the Management locator tab or click on the View menu and click on 
Management. 

2. Do one of the following: 

 With a Collection Option Sets container or a folder in such a container selected, click on   on the 
toolbar and click on Collection Option Set. 

 Right-click on a Collection Option Sets container or a folder in such a container, click on New on the 
shortcut menu, and then click on Collection Option Set. 
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 With a Collection Option Sets container or a folder in such a container selected, click on the File menu, 
click on New, and then click on Collection Option Set. 

ZENworks Asset Management Manager will now display a Collection Option Set window in 
the workspace alongside the Management locator tab.  

3. In the Collection Option Set window, review the current settings and make changes as 
follows:  

 On the General tab, control which applications run as part of the inventory process, assign a collection 
schedule, and control whether data is translated into different file formats. 

 On the Collector tab, control what kind of data the Collector gathers from workstations. 
 On the Collection Editor tab, customize which data workstation users can see and edit with the 

Collection Editor.  
 On the Workstations tab, specify filter criteria for scanning particular workstations. 

4. After you have made your changes, save the collection option set: 
 
a) Either click on the Save button on the toolbar or click on the File menu and click on 
Save or on Save As. 
b) In the Save Collection Option Set As dialog, enter a name for the collection option set. 
c) (Optional) Select a folder for the collection option set if you want a folder other than 
the one listed in Folder box. If no folders exist, ZENworks Asset Management will store the 
collection option set in the container you selected in step 2. 
d) Click on the OK button. 

5. Close the Collection Option Set window. 

See Also 

About Collection Option Sets  

Assigning a Collection Option Set  
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Assigning a Collection Option Set 
After you define and save a new collection option set, it is ready to be put into use by 
being assigned to a Collection Domain or Collection Server. Until you assign a collection 
option set, it has no effect on your inventory process.  

Multiple standard collection option sets can be assigned to the same Collection Domain 
or Collection Server, depending on your needs. Furthermore, you can earmark a 
collection option set for scanning new workstations that are added to your organization or 
for scanning workstations on demand (outside their regular inventory cycle). 

If you are the domain administrator of more than one Collection Domain, you can assign 
a collection option set to a domain only if the option set is a public option set or if it is 
available in that domain. You cannot assign a collection option set from another of your 
Collection Domains. If you want to use the same option set in more than one domain, 
copy it to the other domains. 

NOTE: When you assign a public option set to a Collection Domain or Collection Server, the option set itself is not 
copied to the domain's Collection Option Sets container. 

To assign a collection option set 

Do any of the following to assign an option set:  

 If you want to use one collection option set throughout the enterprise, use the default option set provided by 
Novell. You can edit this option set so it accomplishes what you need. You do not need to assign this option 
set; it is used automatically by all Collection Domains and Collection Servers unless you assign a different 
option set to them. By default, Collection Servers inherit their option sets from their parent Collection 
Domains. 

 If you want to assign an option set to an existing Collection Domain, edit the Collection Domain's settings to 
assign the collection option set. By default, all the Collection Servers associated with the Collection Domain 
will use this option set. 

 If you want to assign an option set to a Collection Domain that does not exist yet, create the Collection 
domain and assign the collection option set during the creation process. By default, all the Collection Servers 
associated with the Collection Domain will use this option set. 

 If you want to assign an option set to a specific Collection Server, edit the Collection Server's settings to 
assign the collection option set. In this case, the Collection Server will no longer be inheriting the collection 
option sets of its parent Collection Domain. 

TIPS 

 To see which option set is currently assigned to a Collection Domain or Collection 
Server, look at the Option Sets tab in the process control panel. You can also see 
which option sets are assigned by displaying the settings for the domain or server.  

 To see both your collection option set assignments and the settings in a particular 
option set, run a Collection Option Set Summary report. This report is in the 
Maintenance folder of the ZENworks Asset Management Reports container.. 

Reviewing and Editing a Collection Option Set 
You can review and change collection option sets. After you make (and save) your 
changes, ZENworks Asset Management automatically ensures that the affected 
Collection Server(s) use the updated collection option set. This in turn ensures that if, for 
example, you have changed Collection Editor settings, the Collection Editor will run with 
the changed settings on the workstations associated with the Collection Server(s). 
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An enterprise administrator can review and edit any collection option set; a domain 
administrator can review any option set, but can edit option sets only in his or her 
Collection Domain(s). 

An enterprise administrator can edit the default option set thus changing the default 
settings for the entire enterprise. The default collection option set is named Default 
Option Set and is in the Public Collection Option Sets container. 

To review and edit a collection option set 

1. Do one of the following on the Management locator tab to display a collection option set:  
 Double-click on the collection option set. 

 Select the collection option set and click on   on the toolbar. 
 Right-click on the collection option set and click on Open on the shortcut menu. 
 Select the collection option set, click on the File menu, and click on Open. 

2. Review the current settings in the collection option set. 
3. Make changes to the collection option set.  
4. To save the changed collection option set, do one of the following:  

 Click on   on the toolbar. 
 Click on the File menu and click on Save. 

To save the collection option set under a different name, click on the File menu, click on 
Save As, and enter a name in the Save Collection Option Set As dialog. 

5. Close the Collection Option Set window. 

See Also 

Setting Up a Collection Option Set  

Renaming a Collection Option Set 
You can change the name of a collection option set to be more self-explanatory. An 
enterprise administrator can rename any collection option set except for the default option 
set; a domain administrator can rename collection option sets only in his or her own 
Collection Domains. 

NOTE: You cannot rename a collection option set if it is open in a window in the workspace. Close the window first. 
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To rename a collection option set 

1. On the Management locator tab, do one of the following to rename a collection option set:  
 Right-click on the collection option set and click on Rename.  
 Select a collection option set, click on the File menu, and click on Rename. 

2. Enter the new name in the Rename Collection Option Set dialog and click on the OK 
button. 

Copying a Collection Option Set 
An enterprise administrator can copy collection option sets from domain Collection 
Option Sets containers to the Public Collection Option Sets container, and vice versa. 

Domain administrators can copy a collection option set from the Public Collection Option 
Sets container to a Collection Option Sets container in one of their own Collection 
Domains (but not vice versa). They can also copy collection option sets among the 
Collection Option Sets containers in their own Collection Domains if they are managing 
more than one. For example, if they want all their domains to use the same collection 
option set, they can create the option set in one domain and then copy it to the others. It 
will then be available for assignment in each domain. 

NOTE: You cannot copy a collection option set if it is open in a window in the workspace. Close the window first. 

To copy a collection option set 

On the Management locator tab, do one of the following to copy a collection option set: 

 Use the right mouse button to drag the option set to another Collection Option Sets container and then click 
on Copy Here on the menu that appears. 

 Select the collection option set and click on   on the toolbar. Then select another Collection Option Sets 

container and click on . 
 Right-click on the collection option set and click on Copy on the shortcut menu. Then right-click on another 

Collection Option Sets container and click on Paste on the shortcut menu. 
 Select the collection option set, click on the Edit menu, and click on Copy. Then select another Collection 

Option Sets container, click on the Edit menu, and click on Paste. 
 Press and hold the Ctrl key and drag the collection option set to another Collection Option Sets container. 
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Moving a Collection Option Set 
An enterprise administrator can move collection option sets among domain Collection 
Option Sets containers and the Public Collection Option Sets container. 

Domain administrators can move collection option sets among their own Collection 
Domains if they are managing more than one. 

NOTE: Moving a collection option set is not the same as assigning it. By moving an option set you make it available in a 
particular Collection Domain. It can then be assigned to the domain or to a Collection Server in that domain. 

When you move a collection option set from a Collection Domain, you essentially 
remove it from the domain. The result of the move depends on the kind of collection 
option set you move: 

 If the collection option set you moved was assigned as a new workstation or scan now option set on the 
domain level, the domain will now use the default option set. If a Collection Server in the domain was using 
the moved option set, it will now inherit its domain’s option set. 

 If the collection option set you moved was assigned as a standard option set on the domain level, the domain 
will no longer use it, but will use any remaining standard option sets that are assigned. If you moved the last 
assigned standard option set, the domain will use the default option set. If a Collection Server was using the 
moved standard option set, it will continue to use any remaining standard option sets or, if none are left, it 
will inherit the standard option sets from its domain. 

On the other hand, when an enterprise administrator moves (promotes) a domain option 
set to the Public Collection Option Sets container, the domain that was assigned this 
option set will continue to have it assigned. 

NOTE: You cannot move a collection option set if it is open in a window in the workspace. Close the window first. 

To move a collection option set 

On the Management locator tab, do one of the following to move a collection option set: 

 Use the right mouse button to drag the option set to another Collection Option Sets container and then click 
on Move Here on the menu that appears. 

 Select the collection option set and click on   on the toolbar. Then select another Collection Option Sets 

container and click on .  
 Right-click on the collection option set and click on Cut on the shortcut menu. Then right-click on another 

Collection Option Sets container and click on Paste on the shortcut menu. 
 Select the collection option set, click on the Edit menu, and click on Cut. Then select another Collection 

Option Sets container, click on the Edit menu, and click on Paste. 
 Drag the collection option set to another Collection Option Sets container. 
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Promoting or Demoting a Collection Option Set 
An enterprise administrator can make a domain collection option set available to all 
ZENworks Asset Management administrators by promoting it to the Public Collection 
Option Sets container. Conversely, an enterprise administrator can demote a collection 
option set by moving it from the Public Collection Option Sets container to a Collection 
Option Sets container in a specific Collection Domain. 

NOTE: You cannot promote or demote a collection option set if it is open in a window in the workspace. Close the 
window first. 

To promote a collection option set 

In a Collection Option Sets container in a Collection Domain, do one of the following to 
promote a collection option set: 

 Use the right mouse button to drag the option set to the Public Collection Option Sets container and then 
click on Move Here on the menu that appears. 

 Right-click on the collection option set and click on Promote on the shortcut menu. 
 Select the collection option set, click on the File menu, and click on Promote. 
 Drag the collection option set to the Public Collection Option Sets container. 

To demote a collection option set 

When you demote a public collection option set, it may become unavailable to a 
Collection Domain or Collection Server, depending on where you demote it. For 
example, if a Collection Domain named New York is using a public option set, and you 
demote it to the London domain, the collection option set will no longer be available to 
the New York domain. In this case, ZENworks Asset Management Manager would 
assign the default option set to the New York domain. If a Collection Server was using a 
collection option set you demoted to another domain, the server would then inherit the 
option set of its parent Collection Domain. 

In the Public Collection Option Sets container, do one of the following to demote a public 
collection option set: 

 Use the right mouse button to drag the schedule to a Collection Schedules container in a specific domain and 
then click on Move Here on the menu that appears. 

 Drag the collection option set to a Collection Option Sets container in a specific domain.  

TIP 

 If the promotion or demotion results in two collection option sets with the same name in the same container 
or folder, the Manager displays the Rename Collection Option Set dialog so you can specify a unique name.  

Deleting a Collection Option Set 
If you no longer have a use for a particular collection option set, you can delete it. When 
you try to delete a collection option set that is currently assigned to a Collection Domain 
or Collection Server, you will be asked to confirm. Any Collection Domain that was 
using the deleted collection option set will then use the default option set; any Collection 
Server will use the collection option set assigned to its parent Collection Domain. 
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An enterprise administrator can delete any collection option set; a domain administrator 
can delete an option set only in his or her own Collection Domains. 
NOTE: You cannot delete a collection option set if it is open in a window in the workspace. Close the window first. 

To delete a collection option set 
1. On the Management locator tab, do one of the following to delete a collection option set:  

 Select the collection option set and click on   on the toolbar. 
 Right-click on the collection option set and click on Delete on the shortcut menu. 
 Select the collection option set, click on the File menu, and click on Delete. 

2. Confirm the deletion if asked. 

Changing General Options 
The General tab in the Collection Option set window lets you control which applications 
runs as part of the inventory process. By default,  

 The Collection Client runs in resident mode on workstations, always ready to receive instructions from the 
Collection Server. 

 The Collector gathers data from the workstations when instructed by the Collection Client. 
 The default collection schedule is assigned to the collection option set. 
 The Collection Editor always runs on workstations after the Collector has finished so that users can review 

and modify the collected data. 
 The Collection Editor does not time out. The workstation user must exit from the Collection Editor. 
 ZENworks Asset Management does not translate inventory data to MIF files so the data can be incorporated 

into Microsoft's Systems Management Server (SMS) nor does it translate the data to .xml files. 
NOTE: The translation options do not apply to portable collections or scans of network servers. 

You may want to change these default settings if, for example, you want the Collection 
Editor to run just the first time a workstation is scanned.  

To change general options 

1. In the Collection Option Set window, click on the General tab. 
2. Review the settings on the General tab and make any necessary changes. For information 

about the options on this tab, see General Tab. 

3. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 

See Also 
About Collection Option Sets  

Changing Collector Options  

Changing Collection Editor Options  

Selecting Workstations for Scanning  

The General Tab 
The General tab in the Collection Option set window lets you control which applications 
run as part of the inventory process, which collection schedule is in effect, and whether 
inventory data is translated into other file formats. By default,  

 The Collection Client runs in resident mode on workstations, always ready to receive instructions from the 
Collection Server. 

 The Collector gathers data from the workstations when instructed by the Collection Client. 
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 The default collection schedule is assigned to the collection option set. 
 The Collection Editor always runs on workstations after the Collector has finished so that users can review 

and modify the collected data. 
 The Collection Editor does not time out. The workstation user must exit the Collection Editor. 
 ZENworks Asset Management does not translate inventory data to Management Information Format (MIF) files 

so the data can be incorporated into Microsoft's Systems Management Server (SMS) nor does it translate the 
data to .xml files. 

You may want to change these default settings if, for example, you want the Collection 
Editor to run just the first time a workstation is scanned.  

Run Collection Client in Resident Mode 

The Run Collection Client in Resident Mode check box controls whether the Collection 
Client runs in resident mode on workstations, always ready to receive instructions from 
the Collection Server. Novell recommends that you leave this check box selected. 

Run Collector Always 

If you do not want the Collector to gather data from workstations, clear the Run Collector 
check box. Generally you will want the Collector to run so you can collect hardware and 
software data (plus any auxiliary data), but occasionally you may want to collect only 
user information by running the Collection Editor alone. 

NOTE: Even if you clear the Run Collector check box, the Collector will always run the first time a workstation is due 
to be scanned, for example, when a new workstation is added to a Collection Server. 

Schedule 

The Schedule box controls which schedule is assigned to the collection option set. When 
you create an option set, ZENworks Asset Management Manager automatically assigns it 
the default schedule. You have the option of assigning a different schedule.  

Do one of the following to assign a different schedule to the collection option set:  

 To select an existing schedule, click on the browse button at the end of the Schedule box. Then, in the 
Select Collection Schedule dialog, select the schedule you want and click on the OK button to return to the 
Collection Option Set window.  

 To create and assign a schedule, click on the browse button at the end of the Collection box in the Collection 
Option Set window. Then, in the Select Collection Schedule dialog, click on the New button and set up the 
schedule. After you have saved the schedule, you will return to the Select Collection Schedule dialog and the 
newly-created schedule will be highlighted. Click on the OK button to return to the General tab of the 
Collection Option Set window.  

Run Collection Editor 

To control when the Collection Editor runs on workstations during the inventory process, 
select one of the following in the Run Collection Editor section: 

 Always (the default). 
 Only on New Workstations (the Collection Editor will run only the first time a workstation is scanned). 
 Never. 
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Time-out Mode 

To control whether the Collection Editor "times out" if there is no user activity, do one of 
the following: 

 To always require user input in the Collection Editor, select Never in the Time-out Mode box. 
 To have the Collection Editor exit and save the inventory data even if there is no user input, select Exit and 

Load in the Time-out Mode box and indicate the number of minutes after which the Collection Editor will 
time out. 

 To have the Collection Editor exit without saving the inventory data if there is no user input, select Quit (No 
Load) in the Time-out Mode box and indicate the number of minutes after which the Collection Editor will 
time out. 

Run Translator 

Use this section to control whether inventory data is translated into other file formats: 

1. If you want to convert inventory data to SMS Management Information Format (MIF) files, 
select click to select the version of SMS you are running in the Run Translator section. By 
default, no translation occurs. ZENworks Asset Management will translate the data to a MIF 
file after each scan of a workstation, and the SMS agent will pick up the resulting MIF files 
according to its own schedule. 

2. If you want to convert inventory data to .xml file format, select the Generate XML File 
check box in the Run Translator section. The .xml file is saved in the \Bin folder of your 
ZENworks Asset Management installation folder. 

TIPS 

 The MIF files are placed in the default folder where the SMS 1.2 or 2.0 Agent expects to find the files. 
Workstations must be clients of SMS for MIF files to be picked up from them. See the Systems Management 
Server Administrator’s Guide for details. 

 For information about MIF file formats, see ZENworks Asset Management .MIF File Formats. 
 The Run Translator settings do not apply to portable collections or scans of network servers. 

Changing General Options 

The General tab in the Collection Option set window lets you control which applications 
runs as part of the inventory process. By default,  

 The Collection Client runs in resident mode on workstations, always ready to receive instructions from the 
Collection Server. 

 The Collector gathers data from the workstations when instructed by the Collection Client. 
 The default collection schedule is assigned to the collection option set. 
 The Collection Editor always runs on workstations after the Collector has finished so that users can review 

and modify the collected data. 
 The Collection Editor does not time out. The workstation user must exit from the Collection Editor. 
 ZENworks Asset Management does not translate inventory data to MIF files so the data can be incorporated 

into Microsoft's Systems Management Server (SMS) nor does it translate the data to .xml files. 
NOTE: The translation options do not apply to portable collections or scans of network servers. 

You may want to change these default settings if, for example, you want the Collection 
Editor to run just the first time a workstation is scanned.  
To change general options 

1. In the Collection Option Set window, click on the General tab. 
2. Review the settings on the General tab and make any necessary changes. For information 

about the options on this tab, see General Tab. 
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3. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 

See Also 
About Collection Option Sets  
Changing Collector Options  
Changing Collection Editor Options  
Selecting Workstations for Scanning  

Changing Collector Options 
The Collector tab in the Collection Option Set window lets you control what kind of data 
the Collector should gather from workstations. By default, the Collector: 

 Gathers hardware and software data. 
 Does not gather auxiliary data such as IRQ or DMA information or configuration files, for example, 

autoexec.bat or Config.sys. 
 Does not gather FNI data (software product files not used in the recognition process by the Collector). 

NOTE: A new collection option set has FNI data collection turned off by default, but the default option set supplied by 
Novell collects FNI data by default. 

The Collector tab also lets you specify any small viewable ASCII files such as 
initialization (.ini) files that you want gathered. 

CAUTION: The more data you gather in addition to hardware and software inventory data, the greater the overhead on 
the inventory process. 

To change Collector options 

NOTE: If you cleared the Run Collector check box on the General tab, you will not be able to change any options on 
this tab. 

1. In the Collection Option Set window, click on the Collector tab.  
2. Review the settings on the Collector tab and make any necessary changes. For information 

about the Collector options, see Collector Options.  

3. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 

See Also 
About Collection Option Sets  
Changing General Options  
Changing Collection Editor Options  
Selecting Workstations for Scanning  

The Collection Editor Tab 
The Collection Editor tab lets you customize the Collection Editor. By default, the 
Collection Editor: 

 Displays information on four tabs: User, Workstation, Inventory, and Process. (The Process tab shows the 
details of the current collection cycle. This tab can never be edited.)  
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 Displays all components on the Inventory tab. 
 Lets workstation users add components (or delete ones they have added), but not create local products. 
 Does not require a password to override restrictions. 

You can choose to display only some of the tabs to workstation users. If you decide to 
display the Inventory tab, you can also select which components you want displayed and 
control to what extent users can modify them and how they can do so. 

To customize the Collection Editor 

NOTE: If you selected the Never option button in the Run Collection Editor section on the General tab, you will not be 
able to change any options on the Collection Editor tab. 

1. If you do not want the Collection Editor to display a tab, clear its check box in the 
Collection Editor Will Display section. 

2. To customize the User, Workstation, or Inventory tabs, click on a Configure button.  
3. If you do not want the Collection Editor to display all components on the Inventory tab, in 

the Inventory Displayed Components box, clear the check box next to the component you 
do not want. (This affects which components are displayed, not which components are 
gathered during a scan.) 
 
NOTE: Choices made on the Collector tab may affect what you can control in the Inventory 
Displayed Components box. For example, if you indicated you do not want to gather 
hardware, there will be no hardware components to display.  

4. If you do not want workstation users to add components (or delete ones they have added), 
clear the Add/Delete User Entered Components check box. Note that if the check box is 
selected, users will not be able to delete any components identified by the Collector, just 
those they previously added. 

5. To give workstation users the ability to add a local product like a system, select the Create 
Local Products check box.  

6. To require users to enter a password to override any restrictions you have set, select the 
Require Password check box, enter a password in the Password box, and confirm it in the 
Confirm Password box. (The password is case-sensitive.) You can then give this password to 
users of your choice. 
 
CAUTION: If you do not require a password, but impose some restrictions on Collection 
Editor use, workstation users will be able to by-pass the restrictions by removing them 
without providing a password. 

7. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 
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TIPS 

 If you want to maintain tight control over how and when local products are created, do not give workstation 
users permission to create them. If the need arises to define a local product for an unknown system, you 
always have the option of giving a workstation user the password to let him or her do so.  

 Even if you decide that you do not want workstation users defining local products, you may want them to add 
components to a workstation’s inventory by selecting products defined by Novell. That way workstation users 
can provide you with more complete data about workstations without the possibility of introducing 
inconsistencies or incorrect data into the inventory database. 

 When users provide the password while running the Collection Editor, they will be able to see any data you 
hid, edit fields that you specified as read-only, add components, and create local products. Users will not, 
however, be able to circumvent how data is to be entered in a specific field. For example, if you specified 
that a value is required, it will still be required after the password is provided. 

See Also 

About Local Products  

Customizing the User, Workstation, and Inventory Tabs 

The information that the Collection Editor displays on the User, Workstation, and 
Inventory tabs and the way users can work with this information can be customized in 
many ways. The process of customizing is identical for all three tabs, but the actual 
changes you can make to particular fields or columns on the tabs differ. 

For example, you can customize the tabs in the following ways: 

 By deciding whether to display a field in the Collection Editor. 
 By indicating whether and when you want data entered in a field automatically if the data is available (for 

example, from the registry or network). 
 By specifying whether users can edit a field and how they can edit it if you choose to allow editing. 
 By providing default values through environment variables or registry keys, or by typing them. You have the 

option of letting users change the default, of making it read-only (by preventing users from editing it), or of 
hiding it altogether. 

 By providing a list of values from which the user can choose. 
 By creating an edit mask to control how users enter data. 

To customize the User, Workstation, or Inventory tab 

NOTE: Any field that appears in gray cannot be modified. For example, you cannot move the field or change its label. 

1. On the Collection Editor tab in the Collection Option Set window, click on the Configure 
button next to User Tab, Workstation Tab, or Inventory Tab. ZENworks Asset Management 
Manager will display the Configure User Tab Fields, Configure Workstation Tab Fields, or 
Configure Inventory Tab dialog. 

2. To re-arrange the order in which fields will appear on the tab, click on the row number 
and drag it to a different position. 
 
 NOTE: You cannot re-arrange the first six rows on the Inventory tab. 
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3. Make your selections in the dialog.  

 

4. Click on the OK button when done. 
 
CAUTION: Be careful which fields you require. For example, if you indicate that a serial 
number is required, it will be required for all the components which you have chosen to 
display in the Collection Editor. Make sure you are requiring data that workstation users 
can provide, or they will not be able to exit the Collection Editor. 

TIP 

 Any changes you make to a user-defined field apply only when this collection option set is in effect. For 
example, if a user-defined field has the label "Purchase Date," but you change this in a collection option set 
to "Date Bought," only those workstations associated with the Collection Servers that have this option set 
assigned will see "Date Bought" in the Collection Editor; the field will still be "Purchase Date" for other 
Collection Servers. 

Default Value 

If you want a value to appear in a field automatically, you can supply a default value for 
any field (including user-defined fields) except for the Product Type, Manufacturer, 
Product, Model/Version, Serial Number, and Asset Tag columns on the Inventory tab.  

NOTE: If a user-defined field includes a default value that was set when the field was defined, and you want to change 
the default, you must edit the user-defined field. If you set a default for a user-defined field in a collection option set, 
it will not affect existing inventory data, but will be available to users in the future. 

Do one of the following: 

 Type the value. 
 Specify an environment variable in the format %VariableName%. (Do not include any quotes.) For example, 

%USERNAME% would obtain data from the USERNAME environment variable.  

NOTE: To see which variables are set in your environment, look at the Environment tab of the System Properties dialog 
in the control panel (Windows NT), look at the Advanced tab of the System Properties dialog in the control panel 
(Windows 2000/XP), or use the SET command in a DOS box.  

 Specify a registry key in the format %HKEY:<FullRegistryKeyName>, for example, 
%HKEY:HKEY_CURRENT_USER\Software\MyCompany\Dept. Do not use quotes in a registry key, even if it 
includes spaces. 
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TIPS 

 You have the option of letting users change the default value (by selecting the Editable check box), of 
making it read-only (by clearing the Editable check box), or of hiding it altogether (by clearing the Display on 
Grid check box). 

 If a registry key is not a string value, the Collector will convert a binary value to a hexadecimal value and 
convert a DWORD value to a string value. 

AutoFill 

By default, if you have specified a default value (through an environment variable or 
registry key) data will be entered automatically in a field if the field is empty, and the 
data is available. If you do not want data entered automatically, select Never in the 
AutoFill column; if you want data always to be entered (whether the field is empty or 
not), select Always. 

Display on Grid 

The Display on Grid column controls whether the Collection Editor displays a field on a 
tab. The Collection Editor always displays the Product Type, Category, Manufacturer, 
and Model/Version fields on the Inventory tab. You cannot hide these fields, but you can 
make them read-only by clearing the Editable check box.  

 Select or clear the check box in the Display on Grid column. 
 
NOTE: Because of the large number of component fields, only some of them can be displayed on the 
Inventory tab. Workstation users, however, will still be able to see these other fields with the Collection 
Editor in the Edit Component dialog.  

Editable 

The Editable column controls whether a workstation user can edit a field, or whether the 
field is read-only. 

 Select or clear the check box in the Editable column.  

Edit Type 

The Edit Type column controls how a workstation user can provide data for a field: by 
typing, by selecting it from a list (no typing allowed), or by typing or selecting it from a 
list. The Product Type column on the Inventory tab is always set to List and workstation 
users must select values for this field from a list pre-defined by Novell. The Technical 
Contact field on the Workstation tab is also always set to List, but here you must define a 
choice list for users. 

Select one of the following: 

 Edit - To provide data by typing. 
 List - To provide data by selecting a value from a pre-defined list.  
 Combo - To provide data either by typing or by selecting a value from a list. 

NOTE: If you select List or Combo, you must then set up a list for users by clicking on 
the Choice List button.  
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Edit Mask 

Edit masks can save you time by reducing, if not eliminating, the need to edit certain 
fields in the inventory database. When you allow workstation users to enter data during 
the inventory process, you run the risk of inconsistent data entry. For example, some 
users may choose to spell out the names of their states (New Hampshire) while others 
may prefer to use the standard postal abbreviation (NH). By setting up edit masks for 
selected fields you can establish a preferred data-entry format to which all users must 
conform.  

You can set up an edit mask for any field for which the edit type is Edit. For example, the 
edit mask for a phone number field might be (###) ###-####; the edit mask for a 
purchase date might be ##-##-####.  

 Enter an edit mask. 

See Also 

Edit Mask Syntax and Examples  

Edit Mask Syntax and Examples 

Edit masks can save you time by reducing, if not eliminating, the need to edit certain 
fields in the inventory database. When you allow workstation users to enter data during 
the inventory process, you run the risk of inconsistent data entry. For example, some 
users may choose to spell out the names of their states (New Hampshire) while others 
may prefer to use the standard postal abbreviation (NH). By setting up edit masks when 
configuring fields you can establish a preferred data-entry format to which all users must 
conform. If users enter information incorrectly in a field with an edit mask, they will have 
to correct the entry before continuing. 
NOTE: An edit mask does not force workstation users to enter as many characters as the mask specifies, but it does 
prevent them from entering additional characters. 

Use any of the following characters to set up your edit masks: 

Mask 
Character 

Description 

# Numeric data (0-9) 
A Alphanumeric data (0-9 and a-Z) 
& Any ASCII character 
? Alphabetic data (a-Z) 
U Alphabetic data (a-Z) is accepted, but is displayed in 

uppercase (A-Z) 
L Alphabetic data (a-Z) is accepted, but is displayed in 

lowercase (a-z) 
\ Escape character used to precede another mask 

character so it is interpreted as a literal character 
Some examples of edit masks follow.  
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Phone Numbers 

A phone number is prime candidate for an edit mask because a number of ways exist for 
entering phone numbers. For example, if you want users to enter a phone number in the 
format (802) 555-1234, set up an edit mask as follows: 

(###) ###-#### 

Fields with a Mix of Letters and Numbers 

Suppose your organization uses employee ID numbers consisting of three letters followed 
by two numbers, for example, ENG21. If you decided to track these with ZENworks 
Asset Management by creating a user-defined field, you could also set up an edit mask as 
follows: 

???## 

Forcing Case in a Field 

You can use an edit mask to make a field entry all uppercase or all lowercase characters, 
regardless of how the user enters the characters. For example, suppose you have added a 
user-defined field to track states using the standard two-character codes such as VT or 
NH. To ensure that no matter how the user entered the code it would appear in all 
uppercase letters, you would set up an edit mask as follows: 

UU 

Allowing Any Character in a Field 

If you want to allow users to enter any character in a field, including letters, numbers, 
symbols, or spaces, use &: 

&&&&&&&&&& 

Using the Escape Character 

If you need to define an edit mask that includes a literal character that happens to be one 
of the characters used for defining masks, you must precede that character with \. For 
example, suppose you define an account number field and want the literal text "Account 
#" to be part of the edit mask. "A" and "#" are both mask characters so you would need to 
precede them by \ as follows: 

\Account \#: ######## 

TIP 

 Suppose that you change an edit mask, and a value that a workstation user provided no longer "fits" the edit 
mask. The next time the Collection Editor runs on that user's workstation, the field will be blank and have a 
yellow border around it to signify the previous value did not match the current edit mask. Unless the field is 
required, however, the workstation user will not be forced to provide another value. 
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Configure Choice List 

The Configure Choice List dialog lets you set up or change a list of selections for a field. 
You set up the selections by completing a "Browse for," dialog, for example, Browse for 
User. 

To set up a choice list 

1. Click on the Add button. 
2. Complete the "Browse for" dialog to locate and select the items you want. 
3. To remove an item from the choice list, select it and click on the Remove button. To clear 

the list completely, click on the Remove All button. 
4. Click on the OK button when done. 

Required 

The Required column lets you control whether a field entry is optional or not. If a field is 
required, workstation users will not be able to exit the Collection Editor until they enter 
the data. 

 Select the check box to make the field required; clear it to make it optional. 

CAUTION: Be careful which fields you require. For example, if you indicate that a serial number is required, it will be 
required for all the components which you have chosen to display in the Collection Editor. Make sure you are requiring 
data that workstation users can provide, or they will not be able to exit the Collection Editor. 

Unique 

(Inventory tab, and Serial Number and Asset Tag fields only) The Unique column lets 
you control whether the user must enter a unique value in a field. Unless the field is 
required, however, the user will be able to leave it blank even if you indicated the field 
must be unique. 

 Select the check box to require a unique value; otherwise, clear the check box. 

Workstations Tab 
The Workstations tab in the Collection Option Set window lets you specify filter criteria 
for selecting the workstations to be scanned. 

If you are using multiple collection option sets, you may want some collection option sets 
to apply only to certain workstations associated with a Collection Domain or Collection 
Server. For example, you could specify a department or building as your criterion. If you 
do not specify any workstation filter criteria, all the workstations associated with a 
Collection Domain or Collection Server are scanned. 

Specifying the filter criteria for workstations is very similar to setting up a filter for a 
query in ZENworks Asset Management. Just as in a query, each workstation criterion 
includes a field, an operator, and a value, for example, Department = Marketing.  
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To select workstations for scanning 

1.  If you are planning to group some criteria by using parentheses, select ( in the column 
labeled (. 

2. Select the field on which you want to filter by doing the following:  
 Click on a cell in the Field column. 
 Click on the right arrow in the cell to display a menu of available fields. 
 Select a field, for example, Department. 

3. In the Operator column, select an operator. 
4. Click on the Value column and then enter or select a value, for example, Marketing.  
5. If you selected an open parenthesis in step 2, and the criterion in this row represents the 

end of your group of criteria, select ) in the column labeled ). 
6. Unless this is the last or only criterion you want to specify, select AND or OR in the 

Combine column to indicate the relationship between the criterion you have just defined 
and the one that will follow in the next row. 

7. Continue defining criteria as described in steps1 to 6. When done, check the criteria to 
make sure you have set them up and combined them the way you want. Do any of the 
following to make changes:  

 To insert a blank row before the current row, click on the Insert Row button.  
 To delete the current row, click on the Clear Row button. 
 To clear all the rows in the Define Filter Criteria section, click on the Clear All button. 

8. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 

Creating a Collection Option Set Folder 
The Public Collection Option Sets container and the Collection Option Sets container for 
a domain initially have no folders. It is up to you to create folders for organizing any 
collection option sets you define. You can create as many folders as you like and name 
them as you like, but you cannot create folders inside other folders. If you choose not to 
create any folders, your collection option sets will be stored in the container. 

An enterprise administrator can create folders in any Collection Option Sets container 
(public or domain); a domain administrator can create folders in a domain Collection 
Option Sets container only.  

To create a collection options set folder 

1. Either click on the Management locator tab or click on the View menu and click on 
Management. 

2. Do one of the following:  

 Select a Collection Option Sets container, click on   on the toolbar, and click on Folder. 
 Right-click on a Collection Option Sets container, click on New on the shortcut menu, and then click on 

Folder. 
 Select a Collection Option Sets container, click on the File menu, click on New, and then click on 

Folder. 
3. In the Folder dialog, enter a name for the folder and click on the OK button. ZENworks 

Asset Management Manager will suggest a default name, for example, Collection Option 
Set Folder1. The name must be unique within the container. 
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Domain Collection Option Sets 
When you create collection option sets, they can be available either on a public level or a 
domain level. Domain collection option sets are available for use within the Collection 
Domain where they were created. Only an enterprise administrator and the domain 
administrator for the Collection Domain can manage the option sets available in that 
domain. Domain administrators can create, use, edit, copy, move, delete, and rename 
collection option sets in their own domains and assign the collection option sets to their 
Collection Domains or to Collection Servers associated with their domains.  

NOTE: The domain administrator of more than one Collection Domain can assign a collection option set to a domain 
only if it is a public option set or if it is available in that domain. The administrator cannot assign a collection option 
set from another domain. To use the same collection option set in more than one domain, the administrator must copy 
it to the other domains. Alternatively, the domain administrator can ask an enterprise administrator to make the 
option set public. 

If an enterprise administrator wants to make a domain collection option set available to 
all administrators, the enterprise administrator can promote the collection option set so it 
is public. Conversely, a public collection option set can be demoted to the domain level. 

Each domain on the Management locator tab has a Collection Option Sets container for 
its option sets. An administrator has the option of creating folders in the Collection 
Option Sets container to organize the domain option sets. 

See Also 

Public Collection Option Sets  

Default Option Set  

Setting Up a Collection Option Set  

Public Collection Option Sets 
When you create collection option sets, they can be available either on a public level or a 
domain level. Public collection option sets are available to all administrators. All 
administrators can review public option sets, assign them to domains or servers, or copy 
them. Only an enterprise administrator, however, can create, edit, delete, rename, or 
move a public collection option set. An enterprise administrator can also assign a public 
collection option set to any Collection Domain or Collection Server, whereas a domain 
administrator can assign public option sets only to the Collection Domain (and Collection 
Servers) for which he or she is responsible. 

See Also 

Domain Collection Option Sets  

Default Option Set  

Setting Up a Collection Option Set  
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Selecting Workstations for Scanning 
If you are using multiple collection option sets, you may want some collection option sets 
to apply only to certain workstations associated with a Collection Domain or Collection 
Server. As part of an option set, you can specify the filter criteria for selecting the 
workstations to be scanned. For example, you could specify a department or building as 
your criterion. If you do not specify any workstation filter criteria, all the workstations 
associated with a Collection Domain or Collection Server are scanned. 

Specifying the filter criteria for workstations is very similar to setting up a filter for a 
query in ZENworks Asset Management. Just as in a query, each workstation criterion 
includes a field, an operator, and a value, for example, Department = Marketing.  

To select workstations for scanning 

1. In the Collection Option Set window, click on the Workstations tab. 
2. If you are planning to group some criteria by using parentheses, select ( in the column 

labeled (. 
3. Select the field on which you want to filter by doing the following:  

 Click on a cell in the Field column. 
 Click on the right arrow in the cell to display a menu of available fields. 
 Select a field, for example, Department. 

4. In the Operator column, select an operator. 
5. Click on the Value column and then enter or select a value, for example, Marketing.  
6. If you selected an open parenthesis in step 2, and the criterion in this row represents the 

end of your group of criteria, select ) in the column labeled ). 
7. Unless this is the last or only criterion you want to specify, select AND or OR in the 

Combine column to indicate the relationship between the criterion you have just defined 
and the one that will follow in the next row. 

8. Continue defining criteria as described in steps 2 to 7. When done, check the criteria to 
make sure you have set them up and combined them the way you want. Do any of the 
following to make changes:  

 To insert a blank row before the current row, click on the Insert Row button.  
 To delete the current row, click on the Clear Row button. 
 To clear all the rows in the Define Filter Criteria section, click on the Clear All button. 

See Also 

About Collection Option Sets  

Changing General Options  

Changing Collector Options  

Changing Collection Editor Options  
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Setting Up a List of Choices 
If you selected List or Combo as the edit type when configuring a Collection Editor field, 
you must provide a list of possible values for the field. Workstation users can then select 
one of these values. 

When you set up a list of choices, the way you specify the choices depends on the field 
you are configuring. In most cases, you can enter the values in one of two ways, in any 
combination you like: 

 By typing the values. 
 By importing the values from a text file. The text file must exist when you start the procedure below. The 

file should include one value per line in any order; the Collection Editor will display the values in 
alphanumeric order to the workstation user. 

NOTE: If you want to import values from the inventory database, run a query to obtain the data you want and then 
export this data to a file. You can then import the contents of this file to your choice list. 

In some cases, you must specify your list of choices by completing a "Browse for" 
dialog, for example, Browse for User. 

To set up a choice list for a field 

1. In the Configure User Tab Fields, Configure Workstation Tab Fields, or Configure Inventory 
Tab Columns dialog, click on the Select button in the Choice List column for the field for 
which you need to set up a choice list. 

2. If the Configure Choice List dialog includes a text box and a File Import button, do one or 
both of the following:  

 To supply a value by typing, enter it in the text box and click on the Add button. 
 To import values from a text file, click on the File Import button and then select your text file. 

3. If the Configure Choice List dialog includes an Add button only, click on the button and 
complete the "Browse for" dialog to find the value you want. 

4. To remove an item from the choice list, select it and click on the Remove button. To clear 
the list completely, click on the Remove All button. 

5. Click on the OK button when done.  

TIPS 

 You can make changes to a choice list at any time; just follow the above procedure again and make the 
necessary changes. If you remove a choice list value, it will not affect any existing values in the inventory 
database. 

 To change the case of an entry, add the value with the changed case; ZENworks Asset Management Manager 
will update the original value automatically. 
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Collection Servers 

A Collection Server has two primary functions: 

1.  It provides instructions to the Collection Clients on its associated workstations based on 
the collection schedule and collection option set that you have specified for the Collection 
Server. (The communication occurs via TCP/IP). A Collection Server also receives inventory 
files from a group of workstations and loads the data into the inventory database. 

2. It lets you group workstations into organizational units to help you manage the inventory 
process. Collection Servers are often geographically based; for example, they may 
correspond to buildings. They may also correspond to work groups such as departments or 
divisions. Which workstations a Collection Server manages is up to you. 

Each Collection Server is associated with a Collection Domain. A domain should always 
include at least one Collection Server, or it will not be associated with any workstations. 
A domain can include several Collection Servers, however. You can also have multiple 
Collection Domains. 

If you want to set up more than one Collection Server in an Enterprise Deployment of 
ZENworks Asset Management, you do so by running the Setup program (from the 
ZENworks Asset Management CD or File Store) at the machine where you want the 
Collection Server software to reside. 

NOTE: A Standalone Deployment of ZENworks Asset Management can have only one Collection Server. 

Like a Collection Domain, a Collection Server has collection option sets associated with 
it. These determine when and how the collection process takes place on the workstations 
associated with the Collection Server. A Collection Server can either inherit the 
collection option sets from its parent domain or can have different option sets. If the 
Collection Server inherits its settings from the Collection Domain, and you make changes 
to an option set (or its associated schedule) that the Collection Domain is using, the 
Collection Server will inherit the changes automatically. 

See Also 

Creating a Collection Server  

Reviewing and Editing Collection Server Settings  

Renaming a Collection Server  

Moving a Collection Server  

Deleting a Collection Server  
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Creating a Collection Server 
To create a Collection Server, you must run the Setup program either from the ZENworks 
Asset Management CD or File Store. While installing the Collection Server you have the 
option of selecting a Collection Domain for it, but you do not need to have your 
Collection Domains defined in advance. You can always assign a Collection Server to a 
domain temporarily and then use ZENworks Asset Management Manager later to re-
assign it to another domain. After you have run Setup, the new Collection Server will be 
listed on the Management locator tab in the Collection Servers container of the Collection 
Domain that you selected during Setup. 

NOTE: To install a Collection Server you must be at the machine where you want the Collection Server to reside. For 
additional requirements and details of Collection Server setup, see the ZENworks Asset Management Installation 
Guide. 

Workstations are associated with a particular Collection Server when the client 
applications are installed on each workstation. To assign a workstation to a different 
Collection Server, see Re-Assigning a Workstation to a Different Collection Server. 

General Tab 
Changing General Collection Server Settings 

The General tab in the Collection Server window provides some information about the 
server and lets you assign different collection option sets to the server. When you create a 
Collection Server, it initially inherits the option sets from its parent Collection Domain. 
By default, a Collection Domain is assigned the default option set provided by Novell, 
but you can change that. Just as in a domain, three types of option sets are assigned to a 
Collection Server: general purpose, new workstation, and scan now. 
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To change general Collection Server settings 

1. Review the settings on the General tab and make any necessary changes.  

   

2. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save.  

3. Either click on another tab and continue making changes or close the Collection Server 
window. 

Collection Server Information 

This section of the Collection Server window provides information about the server. The 
section is purely informational; you cannot change it in ZENworks Asset Management 
Manager. 



ZENworks Asset Management User's Guide 

78 

Standard 

The Standard box controls which standard option sets are assigned to the domain. When 
you create a Collection Server, it automatically inherits the standard option sets from its 
parent Collection Domain. 

If you do not want the Collection Server to use the standard collection option sets 
assigned to its domain, assign it one or more different option sets: 

1. Clear the Inherit check box to the right of the Standard box. 
2. To assign an existing collection option set to the Collection Server, click on the Add 

button. Then, in the Select Collection Option Set dialog, select the option set you want 
and click on the OK button. You will then return to the Collection Server window.  

3. To create and assign a new collection option set, click on the Add button. Then, in the 
Select Collection Option Set dialog, click on the New button and create the option set. 
After you have saved the option set, you will return to the Select Collection Option Set 
dialog and the newly-created option set will be highlighted. Click on the OK button to 
return to the Collection Server window. (The option set will be saved in the domain to 
which the server belongs.) 

4. Repeat steps 2 and 3 for all the standard collection option sets you want to assign to the 
Collection Server. 

5. To remove a collection option set from the list of standard option sets assigned to the 
Collection Server, select the option set in the Standard box and click on the Remove 
button. 

New 

The New box controls which option set serves as the new workstation option set for the 
Collection Server. When you create a Collection Server, it automatically inherits the new 
workstation option set that is assigned to its parent Collection Domain.  

If you do not want the Collection Server to use its domain’s new workstation option set , 
assign it a different option set: 

1. Clear the Inherit check box to the right of the New Workstations box.  
2. Click on the browse button. 
3. In the Select Collection Option Set dialog, either select an option set or click on the New 

button to create an option set.  

Scan Now 

The Scan Now box controls which option set serves as the scan now option set for the 
Collection Server. When you create a Collection Server, it automatically inherits the scan 
now option set that is assigned to its parent Collection Domain. 

If you do not want the Collection Server to use its domain's scan now option set, assign it 
a different option set:  

1. Clear the Inherit check box to the right of the Scan Now box.  
2. Click on the browse button. 
3. In the Select Collection Option Set dialog, either select an option set or click on the New 

button to create a option set. 
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Usage Tab 
Changing Usage Collection Server Settings 

The Usage tab of the Collection Server window lets you turn software usage monitoring 
off or on for all the workstations associated with the Collection Server. The settings on 
the Usage tab in the Collection Server window are active only if you purchased the 
ZENworks Asset Management Usage Monitor.  

To change usage Collection Server settings 

1. Review the settings on the Usage tab and make any necessary changes.  

   

2. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

3. Either click on another tab and continue making changes or close the Collection Server 
window. 
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Enable Usage Monitor 

Select this check box to turn on the ZENworks Asset Management Usage Monitor for all 
the workstations associated with the Collection Server. 

Delete Usage Log Files on Client After 

To change the number of days you want to keep log files on each client workstation, 
select a different number of days. The default is 180 days. The log files will be deleted 
either after the specified number of days has passed or after the usage data has been 
loaded successfully into the database. 

NOTE: Be sure the number of days you keep log files exceeds the interval at which scans occur (as determined by your 
collection schedule), or usage data may be incomplete. 

Reconciliation Tab 
Changing Reconciliation Collection Server Settings 

The Reconciliation tab of the Collection Server window lets you control whether and 
how new workstations are reconciled to avoid the possibility of duplicates in the 
database. When ZENworks Asset Management scans a workstation, it checks for a 
special ZENworks Asset Management identifier (which is stored in the registry). If it 
does not find an identifier, ZENworks Asset Management assumes the workstation is 
new and assigns it an identifier. If it finds an identifier, ZENworks Asset Management 
knows the workstation is already part of the inventory database.  

In some situations, such as a hard disk crash or a re-installation of the operating system, 
the workstation’s identifier is lost so that during the next scan ZENworks Asset 
Management treats the workstation as new and assigns it a new identifier. If, however, 
you want ZENworks Asset Management to check whether the workstation is already in 
the database, you can use one or more of the following to do so (in order of priority): 

 Serial number 
 NIC (Network Interface Card) address (sometimes known as the MAC address of the NIC) 
 NetCensus configuration ID 
 Machine name 

When ZENworks Asset Management cannot find a workstation identifier while scanning 
a workstation it will check the database for the workstation’s serial number, NIC address, 
NetCensus configuration ID, and/or machine name. If it finds one of these items in the 
database, ZENworks Asset Management will then change the identifier in the database to 
match the one that it has just assigned to the workstation. 

By default, a Collection Server will try to reconcile new workstations by serial number, 
NIC address, and NetCensus configuration ID, but not by machine name.  
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In some cases, more than one machine can end up with the same ZENworks Asset 
Management identifier so you will need the Collection Server to differentiate between 
them. For example, if one machine breaks and you re-image it from another machine, the 
two machines will have the same identifier. A Collection Server setting lets you 
differentiate the machines by serial number and thus match them with the correct records 
in the database. 

To change reconciliation Collection Server settings 

1. Review the settings on the Reconciliation tab and make any necessary changes.  

   

2. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

3. Either click on another tab and continue making changes or close the Collection Server 
window. 
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Reconcile on 

If you do not want the Collection Server to reconcile new workstations by serial number, 
NIC address, NetCensus configuration ID, or Machine name, clear the check box of the 
data you do not want to use for reconciliation. In general, if one of the reconciliation 
items may not be unique in the database, you should clear its check box. For example, if 
your organization uses a single NIC card for installation purposes in its receiving area or 
re-uses NIC cards on multiple laptops, you should turn off the NIC address setting 
because the NIC address will not be unique. 
Differentiate by 

If you do not want the Collection Server to use serial numbers to differentiate among 
workstations with the same ZENworks Asset Management identifier, clear the Serial 
Number check box in the Differentiate by section. For example, you should clear this 
setting if you think you have bad serial numbers in the database. 

Logging Tab 
The Logging tab of the Collection Server window lets you control how frequently log 
files are purged and whether more detailed logging of Collection Server and database 
activities takes place. 
To change logging Collection Server settings 
1. Review the settings on Logging the tab and make any necessary changes.  
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2. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

3. Either click on another tab and continue making changes or close the Collection Server 
window. 

Collection Server 

The Collection Server section controls server error logging. 

 By default, a Collection Server logs every type of possible error (informational, warning, and severe). If you 
do not want to log every type of error, clear the Enable maximum diagnostic logging check box. 

 By default, the error log files are purged after 14 days. To increase or decrease the number of days, select a 
different number in the Purge logs after box. 

Database 

The Database section controls database logging. 

To turn on detailed database logging (so that all database server errors are logged), select 
the Enable detailed database logging check box.  

Caution: Detailed database logging can be very useful if you are troubleshooting, but results in large amounts of data 
being logged. This will affect database performance noticeably. 

Advanced Tab 
Changing Advanced Collection Server Settings 

The Advanced tab of the Collection Server window lets you control how frequently the 
Collection Server checks in to the database and whether you take advantage of the 
Collection Server’s "helper service" to assist with installation issues such as permissions. 
The advanced settings also let you change the number of database connections and 
threads to dedicate to various processes, as well as the priority for loading and unloading 
data during an inventory cycle and let you control how frequently Collection Clients 
check in with the Collection Server. 

In general, you will not need to change the settings on the Advanced tab. 
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To change advanced Collection Server settings 

1. Review the settings on Advanced the tab and make any necessary changes.  

   

2. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

3. Either click on another tab and continue making changes or close the Collection Server 
window. 

Check in every 

By default, a Collection Server updates its connection status in the database every 15 
minutes. To increase or decrease the interval at which the Collection Server checks in, 
select a different number of minutes in the Check in every box. 

Use Helper Service 

By default, if you have a domain administrator account on the machine where the 
Collection Server is installed, and the Collection Client on a workstation either needs 
some drivers or needs to be installed as a service, the Collection Server will automatically 
try to perform these activities. If you do not want to use this "helper service," clear the 
Use Helper Service check box. 
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NOTE: The helper service requires a domain administrator account, but the account does not need login permissions. 
(By withholding login permissions you can prevent users from logging in and having access to features or data that you 
do not want them to have.)  

Loader and Unloader Connections 

If you want to increase the number of database connections and threads that are dedicated 
to loading or unloading workstation inventory files (.wif), enter a different number in the 
Loader Connections or Unloader Connections box. This allows the Collection Server to 
spawn additional threads if they are needed for loading or unloading. Each thread is 
responsible for loading one workstation inventory file, and each thread requires an 
additional database connection. The Collection Server allocates the database connection 
when it requires it and releases it when it is no longer needed. A thread is not allocated 
unless it is required. 

Loader and Unloader Priority 

The Collection Server can become a CPU-intensive process during an inventory cycle. 
You may want to change the priority of the loader and unloader if you want to reduce 
their impact on other applications on the Collection Server machine. For example, if the 
Collection Server is on a print server machine, you could make print jobs more 
responsive by lowering the priority of the loading and unloading processes. By default, 
these processes run at Normal priority. If necessary, change their priority to Below 
Normal, Lower, or Lowest.  

Note: If you reduce the priority of the Loader and Unloader, you may affect the timeliness of inventory data. 

Client Connection Threads 

If you want to increase the number of database connections and threads that are dedicated 
to handling Collection Client connection, check-in, and disconnection, enter a different 
number in the Client Connection Threads box. A higher number in this box results in a 
higher number of database connections being allocated, but unlike the connections for 
loading and unloading, the database connections are not dynamically allocated and 
released. 

Updater Threads 

To increase the number of threads dedicated to handling Collection Client updates, enter 
a higher number in the Updater Threads box. Generally, the higher the number, the 
sooner workstations will be in a Ready state. No database connections are required for 
this setting. 

Collection Client 

A Collection Client can check in with its Collection Server every 5 to 7200 minutes. (The 
default is 180 minutes.) To increase or decrease this interval, select a different number of 
minutes in the Check in every box. For example, if you have a large number of client 
workstations associated with a Collection Server (the recommended maximum is 10,000 
workstations), you may want to decrease the check-in interval. 
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Reviewing and Editing Collection Server Settings 
A Collection Server has numerous settings associated with it. These settings appear on 
five tabs in the Collection Server window.  

All ZENworks Asset Management administrators can review and change Collection 
Server settings, but domain administrators are restricted to Collection Servers associated 
with their Collection Domains.  

After you change (and save) Collection Server settings, ZENworks Asset Management 
automatically ensures that the Collection Server uses the changed settings. 

To review and edit Collection Server settings 

1. On the Management locator tab, display Collection Server settings in one of these ways:  
 Double-click on the Collection Server. 

 Select the Collection Server and click on   on the toolbar. 
 Right-click on the Collection Server and then click on Open on the shortcut menu. 
 Select the Collection Server, click on the File menu, and click on Open. 

2. In the Collection Server window, review the current settings and make changes as follows:  
 Use the General tab to review and change collection option set assignments.  
 Use the Usage tab to control whether the ZENworks Asset Management Usage Monitor runs on all the 

workstations associated with the Collection Server.  
 Use the Reconciliation tab to specify how new workstations should be reconciled to avoid the possibility 

of duplicate workstations in the database. 
 Use the Logging tab to control the level of server and database logging that occurs and the frequency of 

server log files purges. 
 Use the Advanced tab to change some advanced settings, for example, how frequently the Collection 

Server checks into the database or how frequently client workstations check in.  

3. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

4. Close the Collection Server window. 

Renaming a Collection Server 
Any ZENworks Asset Management administrator can rename a Collection Server on the 
Management locator tab. The name in question here is the one that appears on the 
Management locator tab; a Collection Server also has a host name that you can see (but 
not change) on the Collection Servers tab in the process control panel. 

NOTE: You cannot rename a Collection Server if it is open in a window in the workspace. Close the window first. 

To rename a Collection Server 

1. On the Management locator tab, do one of the following to rename a Collection Server:  
 Right-click on the Collection Server and then click on Rename on the shortcut menu.  
 Select the Collection Server, click on the File menu, and click on Rename. 

2. Enter the new name in the Rename Collection Server dialog and click on the OK button. 
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Moving a Collection Server 
If you need to change which Collection Servers are associated with a particular 
Collection Domain, you can move a Collection Server to a different domain. Remember 
that the grouping of Collection Servers into a Collection Domain is completely up to you 
- a Collection Domain is simply an organizational tool. 

You may also need to move a Collection Server to another Collection Domain if you are 
planning to delete its current domain. A Collection Domain cannot include any 
Collection Servers when you delete it. 

When you move a Collection Server that was set up to inherit the settings of its parent 
Collection Domain, it will then inherit the settings of its new Collection Domain. If the 
Collection Server was using specific collection option sets, you will be given the choice 
of keeping them or inheriting the option sets from the new Collection Domain. If you 
choose to keep the collection option sets, they will be copied to the new domain. 

NOTE: You cannot move a Collection Server if it is open in a window in the workspace. Close the window first. 

To move a Collection Server to another Collection Domain 

1. On the Management locator tab, drag the Collection Server to the Collection Servers 
container in its new domain and drop it there. 

2. If asked whether you want the currently assigned collection option sets copied to the new 
Collection Domain, click on the Yes button if you want them copied. If, on the other hand, 
you want the moved Collection Server to inherit the settings from its new Collection 
Domain, click on the No button. 

Deleting a Collection Server 
A Collection Server is the communications link between ZENworks Asset Management 
Manager and a group of workstations. If you remove a Collection Server you break that 
link. As a result, the workstations will no longer be part of the inventory process in that 
they will have no way to get information to and from the Manager.  

If you decide you do need to remove a Collection Server, you must first re-assign each of 
its workstations to another Collection Server. If you do not do this, the workstations will 
no longer be part of your inventory "loop."  

The deletion of the Collection Server then requires stopping the Collection Server service 
and using the Manager to delete the Collection Server from ZENworks Asset 
Management. You can then uninstall the Collection Server with the Add/Remove 
Programs feature in Windows. 

To delete a Collection Server 

1. To find out which workstations need to be moved, run a workstation query that filters by 
the Collection Server you plan to remove. For an example of such a query, see Sample 
Queries. 

2. Once you have located the workstations with the query, assign them to another Collection 
Server.  
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3. On the machine where the Collection Server is installed, stop the Collection Server 
service: 
 
a) In the Windows NT 4.0 Control Panel, double-click on Services; in the Windows 2000/XP 
Control Panel, double-click on Administrative Tools and then on Services. 
b) Select ZENworks Asset Management Collection Server and click on the Stop button. 

4. In the Manager do one of the following on the Management locator tab to delete the 
Collection Server:  

 Select the Collection Server and click on   on the toolbar. 
 Right-click on the Collection Server and then click on Delete on the shortcut menu. 
 Select the Collection Server, click on the File menu, and click on Delete. 

5. Click on the Yes button to confirm the deletion. 
6. To remove the Collection Server completely, uninstall it: 

 
a) In the Windows Control panel, double-click on Add/Remove Programs. 
b) Select ZENworks Asset Management Collection Server and click on the Add/Remove 
button.  

Collection Domains 

Your enterprise may track inventory data on large numbers of workstations, sometimes in 
different locations. To help you organize this data into logical groups, ZENworks Asset 
Management lets you set up Collection Servers and Collection Domains. Your enterprise 
must always include one Collection Server and one Collection Domain. In an Enterprise 
Deployment, you can set up additional servers and domains; in a Standalone Deployment 
you have just the one Collection Server and Collection Domain. 

A Collection Domain gives you a way of organizing your enterprise into logical groups to 
help you manage the inventory process. Each Collection Domain has one or more 
Collection Servers associated with it so they are treated as a logical unit. A domain is 
purely an organizational tool; it does not correspond to a physical machine. For example, 
you may want your Collection Domains to correspond to organizational units managed 
by your Information Technology (IT) group or to geographical units such as Pacific Rim 
or Europe. 

Collection Domains make it possible to view and manage inventory data regionally, even 
though all the data resides in a central inventory database. For example, you could set up 
ZENworks Asset Management so that users associated with your Pacific Rim Collection 
Domain see and work with inventory just for their domain, not for that of your European 
domain. At the same time, you could allow other users to analyze and manage inventory 
data on an enterprise level - across all Collection Domains. 

In addition to having Collection Servers associated with it, each Collection Domain has 
collection option sets assigned to it. In turn, each collection option set has a collection 
schedule assigned to it so the option set controls when and how collections occur on the 
workstations associated with the Collection Servers in the domain. A Collection Server 
can either inherit collection option sets from its parent domain or have different ones 
assigned to it. 
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Each Collection Domain can also have ZENworks Asset Management users associated 
with it. These users are given permission to work with the domain-related data as domain 
administrators, assistants, or analysts. (An enterprise-level user can automatically work 
with data in any Collection Domain.) 

Collection Domains can also help you manage your Task Servers. In an Enterprise 
Deployment of ZENworks Asset Management, you can set up several Tasks Servers that 
are either public (available to the entire enterprise) or associated with a specific 
Collection Domain. By associating Task Servers with specific Collection Domains, you 
can optimize how tasks are run in the enterprise. 

When you install ZENworks Asset Management, an initial Collection Domain is 
automatically created for you. The domain has the default collection option set assigned 
to it so you can get started with ZENworks Asset Management as soon as you are ready 
to collect inventory data.  

Depending on the needs and size of your organization, you may find you need only one 
Collection Domain or you may need several. The number of Collection Domains you 
establish is up to you, but you will always have at least one. In addition, you may choose 
to manage all the domains yourself or choose to have them managed by different 
administrators. As an enterprise administrator you can create additional Collection 
Domains and decide which ZENworks Asset Management users can manage them. 

NOTE: A Standalone Deployment of ZENworks Asset Management has only one Collection Domain, one Collection 
Server, and one Task Server. 

See Also 

Creating a Collection Domain  

Reviewing and Editing Collection Domain Settings  

Renaming a Collection Domain  

Deleting a Collection Domain  

Merging Collection Domains  
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Types of Collection Option Sets 
Each Collection Domain has three types of collection option sets assigned to it: 

 A standard option set is for regular inventory cycles. You always have one standard option set assigned, but 
you can have more than one. For example, you could have different option sets for scanning hardware, 
software, and FNI data according to different schedules. You could also have option sets that scan different 
groups of workstations at different times. 

 A new workstation option set is for handling new workstations in your organization. You may, for example, 
want a thorough scan of each new workstation as soon as possible. You have one new workstation option set 
assigned to a Collection Domain. 

 A scan now option set is for scanning workstations on demand (outside their regular inventory cycle), often 
for diagnostic purposes. A scan now option set is also used for portable collections and network server scans. 
You have one scan now option set assigned to a Collection Domain. 

Each Collection Server also has these three types of collection option sets assigned to it. 
A Collection Server can either inherit the option sets from its parent domain or can have 
different collection option sets. 

Creating a Collection Domain 
The Collection Domain that was created when you installed ZENworks Asset 
Management may be all you need, but if you need additional Collection Domains to 
organize your enterprise, you can create them with ZENworks Asset Management 
Manager.  

NOTE: A Standalone Deployment of ZENworks Asset Management should have only one Collection Domain because it 
has only one Collection Server. If you create additional domains, they will not be associated with any Collection Servers 
and therefore will not be associated with any workstations. 

When you create a Collection Domain, you can assign different types of collection option 
sets and ZENworks Asset Management users to it. By default, ZENworks Asset 
Management assigns the default option set to a domain, but you can change this 
assignment. When you create a Collection Domain, only enterprise-level ZENworks 
Asset Management users can automatically work with the domain. To give other 
ZENworks Asset Management users the right to work with the domain (as domain 
administrators, assistants, or analysts), you must assign them to the domain.  

To create a Collection Domain 

1. Either click on the Management locator tab or click on the View menu and click on 
Management. 

2. Do one of the following to start the creation process:  

 Select the Enterprise container, click on   on the toolbar, and click on Domain. 
 Right-click on the Enterprise container, click on New on the shortcut menu, and then click on Domain. 
 Select the Enterprise container, click on the File menu, click on New, and click on Domain. 

The Manager will now display a Domain window in the workspace alongside the 
Management locator tab. 
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3. Make your collection option set and/or ZENworks Asset Management user assignments.  

 

4. After you have made your assignments in the Domain window, save the Collection Domain: 
 

a) Either click on   on the toolbar or click on the File menu and click on Save or on Save 
As. 
b) If the Manager displays the Save Domain As dialog, enter a name for the domain and 
click on the OK button. 

5. Close the Domain window. 

TIP: Once you have created a domain you can associate Collection Servers with it. You can do so while setting up a 
Collection Server. See Creating a Collection Server. 

See Also 

About Collection Domains 

Assigning a Collection Option Set  
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Standard 

The Standard box controls which standard option sets are assigned to the domain. When 
you create a Collection Domain, ZENworks Asset Management Manager automatically 
assigns the default option set as the standard option set. You have the option of replacing 
the default option set with a different collection option set and/or of assigning additional 
standard option sets to the domain. 

1. To assign an existing collection option set to the domain, click on the Add button. Then, in 
the Select Collection Option Set dialog, select the option set you want and click on the OK 
button. You will return to the Domain window.  

2. To create and assign a new collection option set, click on the Add button. Then, in the 
Select Collection Option Set dialog, click on the New button and set up a collection option 
set. After you have saved the option set, you will return to the Select Collection Option 
Set dialog and the newly-created option set will be highlighted. Click on the OK button to 
return to the Domain window. 

3. Repeat steps 1 and/or 2 for all the standard collection option sets you want to assign to 
the domain. 

4. To remove a collection option set from the list of standard option sets assigned to the 
domain, select the option set and click on the Remove button. 

Select Collection Option Set 

The Select Collection Option Set dialog lets you choose the option set you want to assign 
to a Collection Domain or Collection Server. If the option set does not exist yet, you can 
create it.  

To select a collection option set 

Do one of the following: 

 If the option set you want is listed in the Available Collection Option Sets box, select the option set and click 
on the OK button to return to the Domain or Collection Server window. 

 To create a new option set, click on the New button, complete the Collection Option Set window, and save 
the option set. You will then return to this dialog. Click on the OK button to return to the Domain or 
Collection Server window. 

New Workstations 

The New Workstations box controls which option set serves as the new workstation 
option set for the domain. When you create a Collection Domain, it automatically uses 
the default option set as the new workstation option set.  

If you do not want to use the default option set as the new workstation option set: 

1. Click on the browse button. 
2. In the Select Collection Option Set dialog, either select an option set or click on the New 

button to create a new option set. 
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Scan Now 

The Scan Now box controls which option set serves as the scan now option set for the 
Collection Domain. When you create a Collection Domain, it automatically uses the 
default option set as the scan now option set. 

If you do not want to use the default option set as the scan now options set:  

1. Click on the browse button. 
2. In the Select Collection Option Set dialog, either select an option set or click on the New 

button to create a new option set. 

Assigned ZENworks Asset Management Users 

In the Assigned ZENworks Asset Management Users section you can specify which users 
will have the right to work with the Collection Domain. 

Do any of the following: 

 To select an existing user, click on the Add button. Then, in the Select ZENworks Asset Management User 
dialog, select the user(s) you want to assign to the domain and click on the OK button to return to the 
Domain window. 

 To create and assign a ZENworks Asset Management user, click on the Add button. Then, in the Select 
ZENworks Asset Management User dialog, click on the New button and create the user. After you save the 
new user, you will return to the Select ZENworks Asset Management User dialog and the newly-created user 
will be highlighted. Click on the OK button to return to the Domain window. 

 To remove a ZENworks Asset Management user from the list of users assigned to the domain, select the user 
and click on the Remove button. 

Select ZENworks Asset Management User 

The Select ZENworks Asset Management User dialog lets you choose the user you want 
to assign to a Collection Domain. If the user does not exist yet, you have the option of 
creating him or her. 

To select a ZENworks Asset Management user 

Do one of the following: 

 If the user you want is listed in the Available ZENworks Asset Management Users box, select the user and 
click on the OK button to return to the Domain window. 

 To create a new user, click on the New button and complete the Create ZENworks Asset Management User 
dialog. After you are done, you will return to this dialog. Then click on the OK button to return to the 
Domain window. 

Save Domain As 

1. Enter a name for the Collection Domain. The name must be unique within the enterprise. 
2. Click on the OK button. 
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Reviewing and Editing Collection Domain Settings 
The settings associated with a Collection Domain (collection option sets and ZENworks 
Asset Management users) can be reviewed and changed. An enterprise administrator can 
change all the settings associated with a domain; a domain administrator can assign 
different collection option sets to the domain, but cannot change the ZENworks Asset 
Management user assignments. 

After you make changes to the Collection Domain settings (and save them), ZENworks 
Asset Management will automatically update any Collection Servers belonging to the 
domain that are configured to inherit its settings. 

To review and edit Collection Domain settings 

1. On the Management locator tab, do one of the following to display a domain’s settings:  
 Double-click on the domain. 

 Select the domain and click on   on the toolbar. 
 Right-click on the domain and then click on Open on the shortcut menu. 
 Select the domain, click on the File menu, and click on Open. 

2. Review the current settings in the Domain window. 
3. Make the changes you want. Only enterprise administrators can change the ZENworks Asset 

Management user assignments, however. 

4. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

5. Close the Domain window. 

Renaming a Collection Domain 
Any ZENworks Asset Management administrator can change the name of a Collection 
Domain on the Management locator tab. 
NOTE: You cannot rename a Collection Domain if it is open in a window in the workspace. Close the window first. 

To rename a Collection Domain 

1. On the Management locator tab, do one of the following to rename a domain:  
 Right-click on the Collection Domain and then click on Rename on the shortcut menu.  
 Select the Collection Domain, click on the File menu, and click on Rename. 

2. Enter the new name in the Rename Collection Domain dialog and click on the OK button. 

Merging Collection Domains 
Occasionally you may want to merge two Collection Domains together. After you merge 
two Collection Domains, one of them will no longer exist. Its Collection Servers and 
collection option sets will be moved to the remaining (target) Collection Domain, but the 
collection option sets that are currently assigned to the target domain will stay the same. 
The ZENworks Asset Management users, however, that were assigned to the source 
domain (the one that was merged and no longer exists) are not moved to the other 
Collection Domain. You will need to re-assign these users to the merged domain if you 
want them to remain active. 

Only an enterprise administrator can merge Collection Domains.  
NOTE: You cannot merge Collection Domains if they are open in windows in the workspace. Close the windows first. 
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To merge Collection Domains 

1. Decide which Collection Domain you want to remain (the target) and which one you want 
to merge with it (the source, which will be deleted).  
 
CAUTION: You cannot undo a merger once you have performed it. 

2. On the Management locator tab, use the right mouse button to drag the Collection Domain 
you want merged onto the Collection Domain you want to remain.  

3. Release the right mouse button and click on Merge Domains on the menu that appears. 
(Or, click on Cancel to prevent the merger from taking place.) 

4. If necessary, change the ZENworks Asset Management user assignments for the remaining 
Collection Domain.  

TIP 

 If the merger results in any name conflicts, for example two option sets with the same name, the Manager 
will append a number to the name from the source Collection Domain. You can then rename the item. 

Deleting a Collection Domain 
In certain situations you may no longer need a particular Collection Domain to help 
organize your collection process. You can delete a Collection Domain, but only if it no 
longer has any Collection Servers associated with it. You can either move Collection 
Servers to another domain or delete them altogether.  

Only an enterprise administrator can delete Collection Domains. 

NOTE: You cannot delete a Collection Domain if it is open in a window in the workspace. Close the window first. 

To delete a Collection Domain 

1. Make sure no Collection Servers are associated with the domain. If necessary, move them 
to another domain.  

2. On the Management locator tab, do one of the following to delete the Collection Domain:  

 Select the domain and click on   on the toolbar.  
 Right-click on the domain and click on Delete the shortcut menu. 
 Select the domain, click on the File menu, and click on Delete. 

3. Click on the Yes button to confirm the deletion. 
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Task Servers 

A Task Server is a ZENworks Asset Management application that manages tasks. In an 
Enterprise Deployment of ZENworks Asset Management, you can set up several Task 
Servers that are either public (available to the entire enterprise) or associated with a 
specific Collection Domain. You can also specify what kind of tasks a Task Server can 
manage. This type of control over Task Servers lets you optimize how tasks are run in the 
enterprise. 

A common use of a task is a Network Discovery task, which scans a subnet. 

When you install a Standalone Deployment of ZENworks Asset Management, a Task 
Server is created for you automatically. When you install an Enterprise Deployment of 
ZENworks Asset Management, you can also create a Task Server during the initial 
installation. If you want to set up more than one Task Server with an Enterprise 
Deployment of ZENworks Asset Management, you do so by running the Setup program 
(from the ZENworks Asset Management CD or the File Store) at the machine where you 
want the Task Server to reside. 
NOTE: A Standalone Deployment of ZENworks Asset Management can have only one Task Server. 

Creating a Task Server 
To create a Task Server, you must run the Setup program (either from the ZENworks 
Asset Management CD or the File Store). After you have run Setup, the new Task Server 
will be listed in the Public Task Servers container on the Management locator tab. The 
Task Server will have the name of the machine on which you installed it; you can change 
this name. You also have the option of moving the Task Server to a Collection Domain 
so that it is available exclusively to that domain instead of the entire enterprise. 
NOTE: To install a Task Server you must be at the machine where you want the Task Server to reside. For additional 
requirements and details of the installation process, "Installing Task Servers" in the Enterprise Deployment Installation 
section of the Getting Started Guide. 

Reviewing & Editing Task Server Settings 
A Task Server is responsible for processing database purges, scheduled reports, Product 
Recognition Updates (PRUs), and network discovery. By default, a Task Server will 
process all types of tasks, but you can specify that it processes only specific types of 
tasks. For example, you may want one Task Server dedicated to database purges. 

Each Task Server can have printers associated with it. The printers available to the Task 
Server are the printers that are set up for the machine on which you installed the Task 
Server, and which are part of the profile of the user account that runs the Task Server 
service. (This is the user account that was specified when the Task Server was installed.) 
You can see a list of these printers when you review the Task Server settings, but you 
cannot change them in any way. (To set up additional printers for the Task Server 
machine, refer to your Windows documentation.) 
NOTE: If you add or delete a printer on a Task Server, you must stop and re-start the Task Server service before the 
change is reflected in ZENworks Asset Management. If you rename a printer, you must also stop and re-start the 
service, or a print task will fail. (To stop the service, in the Control Panel in Windows NT, double-click on Services; in 
Windows 2000/XP, double-click on Administrative Tools and then Services. Select ZENworks Asset Management Task 
Server and click on the Stop button. To re-start the service, select it and click on the Start button.) 
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A Task Server also includes some advanced settings. For example, you can control how 
frequently the Task Server checks in and log files are purged and whether more detailed 
logging of Task Server and database activities takes place. (In general, you will not need 
to change these settings.) 

As an administrator you can review and change Task Server settings. For example, you 
can add a description of the Task Server or change what kind of tasks it can process. 

After you change (and save) Task Server settings, ZENworks Asset Management 
automatically ensures that the Task Server uses the changed settings. 

To review and edit Task Server settings 

1. On the Management locator tab, display Task Server settings in one of these ways:  
 Double-click on the Task Server. 

 Select the Task Server and click on .  

 Right-click on the Task Server and then click on Open on the shortcut menu. 

 Select the Task Server, click on the File menu, and click on Open. 

2. Review the current settings in the Task Server window and make any necessary changes.  

   

3. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

4. Close the Task Server window. 

Task Server Information 

This section of the Task Server window provides information about the server. The 
section is purely informational; you cannot change it in ZENworks Asset Management 
Manager. 
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Tasks to be Processed 

By default, a Task Server processes all types of tasks: scheduled reports, purges, 
scheduled Product Recognition Updates (PRUs), and network discovery. To change 
which tasks the Task Server can process, select or clear the Reports, Purges, Product 
Update, Network Discovery, or Active Directory Import check boxes. 

Available Printers 

This section of the Task Server window lists the printers available with the Task Server. 
These are the printers that are set up for the machine on which you installed the Task 
Server, and which are part of the profile of the user account that runs the Task Server 
service. (This is the account that was specified when the Task Server was installed.) You 
cannot change this list of printers from ZENworks Asset Management Manager. (To set 
up additional printers for the Task Server machine, refer to your Windows 
documentation.) 

Advanced Task Server Options 

In the Advanced Task Server Options dialog you can control settings pertaining to error 
logging and to the frequency of server check-in. In general, you will not need to change 
these settings. 

To change advanced Task Server options 

1. By default, a Task Server updates its connection status in the database every 15 minutes. 
To increase or decrease the interval at which the Task Server checks in, select a different 
number of minutes. 

2. By default, a Task Server logs every type of possible error (informational, warning, and 
severe). If you do not want to log every type of error, clear the Enable maximum 
diagnostic logging check box. 

3. By default, the error log files are purged after 14 days. To increase or decrease the 
number of days, select a different number. 

4. To turn on detailed database logging (so that all database server errors are logged), select 
the Enable detailed database logging check box. 
 
CAUTION: Detailed database logging can be very useful if you are troubleshooting, but 
results in large amounts of data being logged. This will affect database performance 
noticeably. 

5. Click on the OK button when done. 
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Renaming a Task Server 
Any ZENworks Asset Management administrator can rename a Task Server on the 
Management locator tab. A Task Server is automatically given the name of the machine 
on which you are installing it. You may want to give it a more descriptive name.  

NOTE: You cannot rename a Task Server if it is open in a window in the workspace. Close the window first. 

To rename a Task Server 

1. On the Management locator tab, do one of the following to rename a Task Server:  
 Right-click on the Task Server and then click on Rename on the shortcut menu.  
 Select the Task Server, click on the File menu, and click on Rename. 

2. Enter the new name in the Rename Task Server dialog and click on the OK button. 

Deleting a Task Server 
The deletion of a Task Server involves stopping the Task Server service and using 
ZENworks Asset Management Manager to delete the Task Server from ZENworks Asset 
Management. You can then uninstall the Task Server with the Add/Remove Programs 
feature in Windows.  

To delete a Task Server 

1. On the machine where the Task Server is installed, stop the Task Server service: 
 
a) In the Windows NT 4.0 Control Panel, double-click on Services; in the Windows 2000/XP 
Control Panel, double-click on Administrative Tools and then on Services. 
b) Select ZENworks Asset Management Task Server and click on the Stop button. 

2. In the Manager, do one of the following on the Management locator tab to delete the Task 
Server:  

 Select the Task Server and click on . 
 Right-click on the Task Server and click on Delete on the shortcut menu. 
 Select the Task Server, click on the File menu, and click on Delete. 
 Click on the Yes button to confirm the deletion. 

3. To remove the Task Server completely from the machine, uninstall it: 
 
a) In the Windows Control Panel, double-click on Add/Remove Programs. 
b) Select ZENworks Asset Management Task Server and click on the Add/Remove button. 

Moving a Task Server 
When you create Task Servers with the Setup program, they are placed automatically in 
the Public Task Servers container on the Management locator tab. As a result, the Task 
Servers are available to the entire enterprise. If you want a Task Server to be available to 
a specific Collection Domain only, you can move the Task Server to that domain. How 
you associate Task Servers with Collection Domains is completely up to you and the 
needs of your organization. For example, if one Collection Domain tends to print long 
reports frequently, you may want to assign it enough Task Servers to handle the printing 
load. In a smaller organization, on the other hand, you may want most of your Task 
Servers to be public so they are available to everyone. 
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To move a Task Server between the Public Task Servers container and a domain Task 
Servers container, you must be an enterprise administrator. Once a Task Server is 
associated with a Collection Domain, the domain administrator can move it to another 
Collection Domain if he or she is managing more than one. 

NOTE: You cannot move a Task Server if it is open in a window in the workspace. Close the window first. 

To move a Task Server  

 On the Management locator tab, drag the Task Server to the Task Servers container in its new domain and 
drop it there. (You can also move a Task Server from a Collection Domain back to the Public Task Servers 
container.) 
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Network Discovery 

About the ZENworks Asset Management Network Discovery Engine 
The ZENworks Asset Management Network Discovery Engine collects data about 
devices on your network, for example, hubs, routers, printers, or switches. The engine 
uses Internet Protocol (IP), Simple Network Management Protocol (SNMP), and 
Windows Management Interface (WMI) standards to identify any networked device with 
an IP address.  

The ZENworks Asset Management Network Discovery Engine offers the following 
features: 

 Automatically locates, identifies, and reports on IP-based network devices. 
 Lets you specify subnets or IP address ranges you want scanned. 
 Collects SNMP and WMI data from enabled devices. 
 Reconciles discovered devices based on serial number, MAC address, or client ID. 
 Offers Web-based analysis and editing of collected data. 

Using the ZENworks Asset Management Network Discovery Engine you can answer 
questions such as: 

 How many routers, switches, and network printers do I have and where are they located? 
 What are the IOS levels of my routers? Do I need to upgrade them for security reasons? 
 Which printers have been used the most? 
 Which printers do I need to replace next year? 
 Have I installed the ZENworks Asset Management Collection Client on all my workstations? 
 Which leased network devices are expiring next month and where are they located? 
 Which devices and software need to be brought up to "standard"? For example, are there some non-Cisco 

devices in a supposedly "all-Cisco" environment? 
 Which devices need support or version upgrades? 

Before you can collect data about network devices, you must set up a network discovery 
task, which you can execute immediately or schedule. When you set up the task, you can 
choose which types of devices you want to load into the database. (The ZENworks Asset 
Management Network Discovery Engine always identifies all types of network devices, 
but you can control which data is loaded into the database.) You can also specify which 
subnets or IP addresses you want to scan. After you submit a task, you can track it 
through the process control panel, just like any other task. 

The data collected about network devices is available through the ZENworks Asset 
Management Web Console. You can view the data grouped in different ways, for 
example, by device type, manufacturer, location, or subnet. You can also edit or enter 
certain kinds of data, for example, asset tag or location.  

Note: Certain Linux platforms are discovered and differentiated exclusively with SNMP. 
By default, these platforms are not configured to allow discovery by the Network 
Discovery Engine. Before these platforms can be differentiated, each machine must have 
SNMP enabled and configured correctly. For information on configuring a Linux 
machine for discovery by the Network Discovery Engine, see TID #10100611. 
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Data Collected from Devices During Network Discovery 
The ZENworks Asset Management Network Discovery Engine automatically detects the 
following information from devices: 

  Device type (for example, printer, router, or switch) 
  Manufacturer 
  Name 
  Description 
  Serial number 
  SysLocation (SNMP) * 
  Contact 
  IP address 
  MAC address 
  DNS name 
  Subnet 
  Object ID (SNMP) * 
  Uptime (SNMP) * 
  Services (SNMP) * 
  ZENworks Asset Management Collection Client version (if present) 
  ZENworks Asset Management Collection Client installed/not installed 
  ZENworks Asset Management Collection Client install type 
  Number of pages printed 
  Firmware version 
  Number of ports 
 Domain name (Windows PCs only) * 
 User’s Login Name (Windows PCs only) * 

* To gather this information you must run the Network Discovery Engine from a Task Server with proper administrator 
privileges, and SNMP and WMI must be enabled on the target PCs. 

In addition, you can edit or enter data in the following fields: 

  Asset tag 
  Location 
  Is leased/not leased 
  Lease contract ID 
  Lease expire date 

About Network Discovery Tasks 
Network discovery is handled as a task. Just like any other task in ZENworks Asset 
Management, you can schedule a network discovery task and assign it to a particular 
Task Server. When you set up a task, you can specify which types of devices you want to 
load into the database. (The ZENworks Asset Management Network Discovery Engine 
always identifies all types of network devices, but you can control which data is loaded 
into the database.) You can also specify which subnets or IP addresses you want to scan.  

To work with network discovery tasks you must be an enterprise administrator.  
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Setting Up a Network Discovery Task 
If you just want to use one network discovery task throughout the enterprise, edit the 
default network discovery task provided by Novell and schedule the task. It will then 
regularly scan your network according to the schedule you have defined. If, however, you 
want to scan different parts of the network at different times, set up multiple network 
discovery tasks. 

Notes 

 To get useful information about workstations such as operating system version, or machine make and model, 
SNMP and WMI services must be installed and enabled on the machines you are scanning.  

 For SNMP, you must provide a valid community name. By default, ZENworks Asset Management uses "public" 
as a community name. To add other names, click Network Discovery menu item in the Manager and add 
additional names to the list at the bottom of the screen. 

 For WMI, the evaluation machine’s login must have Administrator permissions for the machine you are 
scanning and Windows PCs must have WMI enabled in order to collect certain details. 

To set up a network discovery task 

1. Review the global options that apply to all network discovery tasks and change them if 
necessary.  

2. Either click on the Management locator tab or click on the View menu and click on 
Management. 

3. Do one of the following:  
 Select the Public Network Discovery Tasks container or a folder in the container, click on the New 

button on the toolbar, and click on Network Discovery Task.  
 Right-click on the Public Network Discovery Tasks container or a folder in the container, click on New 

on the shortcut menu, and then click on Network Discovery Task. 
 Select the Public Network Discovery Tasks container or a folder in the container, click on the File 

menu, click on New, and then click on Network Discovery Task. 

The Manager will now display a Network Discovery Task window. This window has 
two tabs: General and Subnet.  

4. On the General tab, do the following:  
 By default, the network discovery task will be handled by any available Task Server. To select a specific 

Task Server or group of Task Servers, click on the browse button in the Target Task Server(s) box. Then, 
in the Select Task Server dialog, either select a specific Task Server or select a group of Task Servers so 
that any of the Task Servers in that group can handle the network discovery task. (Only those Task 
Servers that allow network discovery will be available choices.) 

 By default, the ZENworks Asset Management Network Discovery Engine loads data for all types of 
identified network devices into the database. If you want to load data for certain network devices only, 
clear the check boxes of the types of devices you do not want to include in the database. 

 To schedule the network discovery task, click on the Schedule button. If you do not set up a schedule, 
the network discovery task will run on a one-time basis immediately after you submit it. 

5. Click on the Subnet tab. By default, the ZENworks Asset Management Network Discovery 
Engine scans the local subnet only. You also have the choice of specifying a range of IP 
addresses or selecting the subnets you want to scan. 

6. If you want to specify a range of IP addresses you want to scan, select the Specify a Range 
of Addresses option and enter the beginning and ending addresses. 

7. If you want to select specific subnets to scan,  
 Select the Select Subnets option. 
 Use the Add and Add All buttons to move subnets from the Available Subnets to the Selected Subnets 

box; use the Remove and Remove All buttons to remove subnets from the Selected Subnets box. 
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 To specify a new subnet, click on the Add New button and specify an address range and subnet mask in 
the Add a Subnet dialog. If necessary, you can add or exclude specific addresses. Click on OK when 
done. 

8. When the task is set up as you want, save it by clicking on the Save button or the Save As 
button. If necessary, complete the Save Network Discovery Task As dialog. 

9. Click on the Submit button. The task now enters the task queue and can be tracked on the 
Tasks tab of the process control panel.  

10. Close the Network Discovery window. 

Network Discovery Options 
When you set up network discovery tasks you can customize each task for a particular 
purpose. In addition, however, you can specify some global options that apply to all 
network discovery tasks.  

To set network discovery options 

1. Click on the Network Discovery menu and click on Options. 
2. Review the settings and change them if necessary.  

   

3. Click on OK to save your settings. 
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Default Network Discovery Task 

The ZENworks Asset Management Network Discovery Engine comes with a default 
network discovery task. The initial settings for the default task ensure that: 

 Only the local subnet is scanned. 
 Any available Task Server is used. 
 Data for all network devices is loaded into the database. 
 The task runs immediately after being submitted. 

An enterprise administrator can change the settings that make up the default network 
discovery task, but cannot rename it or delete it. The default network discovery task is 
therefore always available. 

Task Delay 

In the Task Delay box, specify the time in milliseconds that the ZENworks Asset 
Management Network Discovery Engine should wait before sending a request to a device 
or IP address. (The default is 0 milliseconds.) You can use this setting to slow down 
network discovery tasks, which may be helpful on slower networks. 

Initial Ping Timeout 

In the Initial Ping Timeout box, specify the number of milliseconds to wait for a response 
to an ICMP query (Ping) before assuming that the IP address is not responding. The 
default is 200 milliseconds. 

Maximum Number of Ping Retries 

In the Maximum Number of Ping Retries box, specify the number of times a Ping should 
be tried again before giving up. The default is 3. 

Increment SNMP Timeout on Retries by 

In the Increment SNMP Timeout on Retries by box, specify the incremental time in 
milliseconds to wait for a response for each retry of an SNMP query before sending 
another. The default is 500 milliseconds. 

Perform Name Lookups 

By default, the ZENworks Asset Management Network Discovery Engine performs a 
reverse lookup for the DNS/WINS name of each IP address. If you do not want this done, 
clear the Perform Name Lookup check box. 

Initial SNMP Timeout 

In the Initial SNMP Timeout box, specify the number of milliseconds to wait for a 
response to an SNMP query before assuming that the packet is lost. The default is 500 
milliseconds. 
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Maximum Number of SNMP Retries 

In the Maximum Number of SNMP Retries box, specify the number of times to try an 
SNMP query again before giving up. The default is 3. 

Increment Ping Timeout on Retries by 

In the Increment Ping Timeout on Retries by box, specify the incremental time in 
milliseconds to wait for a response for each retry of an ICMP ping before sending 
another. The default is 500 milliseconds. 

Community Name List 

In the Community Name List box, add or remove the SNMP community names that grant 
read access to your network devices. (To add a community name, click on the Add button 
and complete the Add Community dialog; to remove a community name, select it in the 
Community Name List box and click on Remove.) By default, the ZENworks Asset 
Management Network Discovery Engine will use the password "public" to request 
SNMP data from devices. If the SNMP query does not return a response with this 
password, ZENworks Asset Management will retry the SNMP query with each password 
listed here until a response is obtained. To minimize the amount of time it takes to scan 
your network, place the most commonly-used names on your network at the top of the 
list. 

General Tab 

The General tab in the Network Discovery Task window lets you review and change 
general network discovery task settings. For example, you can select a Task Server to 
handle the task, indicate what kind of device data you want loaded, and schedule the task. 

1. By default, the network discovery task will be handled by any available Task Server. To 
select a specific Task Server or group of Task Servers, click on the browse button in the 
Target Task Server(s) box. Then, in the Select Task Server dialog, either select a specific 
Task Server or select a group of Task Servers so that any of the Task Servers in that group 
can handle the network discovery task. (Only those Task Servers that allow network 
discovery will be available choices.) 

2. By default, the ZENworks Asset Management Network Discovery Engine loads data for all 
types of identified network devices into the database. If you want to load data for certain 
network devices only, clear the check boxes of the types of devices you do not want to 
include in the database. 

3. To schedule the network discovery task, click on the Schedule button. If you do not set up 
a schedule, the network discovery task will run on a one-time basis immediately after you 
submit it. 

4. To review or change subnet settings, click on the Subnet tab. 
5. Save the network discovery task by clicking on the Save button or the Save As button. If 

necessary, complete the Save Network Discovery Task As dialog. 
6. Click on the Submit button. The task now enters the task queue and can be tracked on the 

Tasks tab of the process control panel.  
7. Close the Network Discovery window. 
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Subnet Tab 

The Subnet tab in the Network Discovery Task window lets you review and change 
settings that control what is scanned. 

1. If you want the ZENworks Asset Management Network Discovery Engine to scan the local 
subnet only, leave the Local Subnet Only option selected.  

2. If you want to specify a range of IP addresses you want to scan, select the Specify a Range 
of Addresses option and enter the beginning and ending addresses. 

3. If you want to select specific subnets to scan,  
 Choose the Select Subnets option. 
 Use the Add and Add All buttons to move subnets from the Available Subnets to the Selected Subnets 

box; use the Remove and Remove All buttons to remove subnets from the Selected Subnets box. 
 To specify a new subnet, click on the Add New button and specify an address range and subnet mask in 

the Add a Subnet dialog. If necessary, you can add or exclude specific addresses. Click on OK when 
done. 

 To edit a subnet, double-click on it or select it and click on the Edit button. Then make your changes in 
the Edit a Subnet dialog. 

4. To review and change other network discovery task settings, click on the General tab. 
5. Save the network discovery task by clicking on the Save button or Save As button. If 

necessary, complete the Save Network Discovery Task As dialog. 
6. Click on the Submit button. The task now enters the task queue and can be tracked on the 

Tasks tab of the process control panel.  
7. Close the Network Discovery window. 

Add or Edit a Subnet 

The Add a Subnet dialog lets you adds a new subnet to be scanned and the Edit a Subnet 
dialog lets you edit an existing subnet. 

1. In the Address Range boxes, enter the range of IP addresses you want scanned. 
2. In the Subnet Mask box, specify a subnet mask. 
3. In the Specific Addresses to Exclude section, either add or remove IP addresses that are 

part of your address range, but that you do not want scanned. 
4. Click on OK when done. 

Checking the Status of Tasks 
The Tasks tab in the process control panel provides information about all the tasks that 
are currently in the queue.  

To check the status of a task 

1. Click on the Tasks tab in the process control panel. 

2. Update the information on the tab either by clicking on  on the toolbar or by clicking 
on the View menu and clicking on Refresh. (You can also press F5.) 

3. Review the data on the tab. Click on the figure below for information about the columns 
on this tab. For more information, see Tasks Tab. 

4. After reviewing the status of your servers, do any of the following: 

 Print the information on the tab either by clicking on  on the toolbar or by clicking on the File menu and 
clicking on Print. 

 Change the schedule or priority of a task that is waiting to run. 
 Pause a task that is waiting in the task queue. 
 Remove a task from the queue altogether. 
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TIPS 

 A report that you display on the screen will not appear on the Tasks tab.  
 To check on completed tasks, click on the History tab in the process control panel. (A report that you 

displayed on the screen will not be listed on the History tab.) 

Reviewing and Editing Network Discovery Tasks 
You can review and change the settings (including the schedule) for a network discovery 
task. 

To review and edit a network discovery task 

1. Do one of the following on the Management locator tab to display a network discovery 
task:  

 Double-click on the network discovery task. 
 Select the network discovery task and click on the Open button on the toolbar. 
 Right-click on the network discovery task and then click on Open on the shortcut menu. 
 Select the network discovery task, click on the File menu, and click on Open. 

2. Review the current settings.  
3. Make changes to the task on the General and Subnet tabs.  

 
NOTE: If you want to edit a subnet, choose the Select Subnets optioin on the Subnets tab 
and either double-click on the subnet or select it and click on the Edit button. Then make 
your changes in the Edit a Subnet dialog. 

4. To save the changed network discovery task, click on either the Save or the Save As 
button. If prompted, enter a name for the task. 

5. Close the Network Discovery Task window. 

TIP 

 You can also edit the schedule for a network discovery task from the Tasks tab in the process control panel. 
Right-click on the task and then click on Edit Schedule.  

Renaming a Network Discovery Task 
You can change the name of a network discovery task to be more self-explanatory. You 
can rename any network discovery task except for the default network discovery task. 

NOTE: You cannot rename a network discovery task if it is open in a window in the workspace. Close the window first. 

To rename a network discovery task 

1. On the Management locator tab, do one of the following to rename a network discovery 
task:  

 Right-click on the network discovery task and then click on Rename on the shortcut menu. 
 Select a network discovery task, click on the File menu, and click on Rename. 

2. Enter the new name in the Rename Network Discovery Task dialog and click on the OK 
button. 
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Copying or Moving a Network Discovery Task 
You can copy and move network discovery tasks among folders if necessary. 

NOTE: You cannot copy or move a network discovery task if it is open in a window in the workspace. Close the window 
first. 

To copy or move a network discovery task 

On the Management locator tab, do one of the following to copy or move a network 
discovery task: 

 Drag the network discovery task to another folder. 
 Select a network discovery task and click on the Copy or Cut button on the toolbar. Then select another 

folder and click on the Paste button. 
 Right-click on the network discovery task and then click on Copy or Cut on the shortcut menu. Then right-

click another folder and click on Paste. 
 Select a network discovery task, click on the Edit menu, and click on Copy or Cut. Then select another 

folder, click on the Edit menu, and click on Paste. 

Deleting a Network Discovery Task 
If you no longer have a use for a particular network discovery task, you can delete it. 

NOTE: You cannot delete a network discovery task if it is open in a window in the workspace. Close the window first. 

To delete a network discovery task 

1. On the Management locator tab, do one of the following to delete a network discovery 
task:  

 Select the network discovery task and click on the Delete button on the toolbar. 
 Right-click on the network discovery task and then click on Delete on the shortcut menu. 
 Select the network discovery task, click on the File menu, and click on Delete. 

2. Confirm the deletion if asked. 

Creating Network Discovery Task Folders 
The Public Network Discovery Tasks container initially has no folders. It is up to you to 
create folders for organizing any network discovery tasks you create. You can create as 
many folders as you like and name them as you like, but you cannot create folders inside 
other folders. If you choose not to create any folders, your network discovery tasks will 
be stored in the Public Network Discovery Tasks container. 

To create a network discovery task folder 

1. Either click on the Management locator tab or click on the View menu and click on 
Management. 

2. With the Public Network Discovery Tasks container selected, do one of the following:  
 Click on the New button on the toolbar and click on Folder. 
 Right-click on the container name, click on New on the shortcut menu, and then click on Folder. 
 Click on the File menu, click on New, and then click on Folder. 

3. In the Folder dialog, enter a name for the folder and click on the OK button. The Manager 
will suggest a name, for example, Network Discovery Task Folder1. The name must be 
unique within the container. 
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Accessing Network Discovery Data 
Once you have performed a scan with a network discovery task, you can look at the 
results and edit them in the ZENworks Asset Management Web Console. The Web 
Console gives you access to the results of your network discoveries, Web-based reports, 
and ZENworks Asset Management Software Compliance. You can access the Web 
Console directly from Internet Explorer or from ZENworks Asset Management Manager. 

Anyone who needs to look at the results of network discovery needs to be set up as an 
enterprise-level ZENworks Asset Management user. A ZENworks Asset Management 
user name and password are required. Enterprise administrators and assistants can both 
view and edit network discovery inventory data; enterprise analysts can only view the 
data.  

You can access the ZENworks Asset Management Web Console directly from Internet 
Explorer or from the Manager. 

From Internet Explorer 

If you are a ZENworks Asset Management user, you can start the ZENworks Asset 
Management Web Console directly from Internet Explorer. You will need to enter a URL 
to access your Web Console installation and then provide your login name and password 
when you want to access the network discovery inventory data. (Your login consists of 
your ZENworks Asset Management user name and password.) 

To use Internet Explorer to access the ZENworks Asset Management Web Console 

1. Start Internet Explorer. 
2. Enter the following address: 

 
  http://<server name>:8080/rtrlet/rtr?act=network.Login&rtyp=login 
 
where server name is the name of the machine where you installed the Web Console. 

3. When asked for login information, enter your ZENworks Asset Management user name and 
password. 

4. Select the Network Discovery tab. A device list tree will now appear, and you can view the 
network discovery data.  

From the Manager 

If you are already using ZENworks Asset Management Manager you can access the 
ZENworks Asset Management Web Console directly. Before you can use the Web 
Console for the first time in an Enterprise Deployment of ZENworks Asset Management, 
you need to specify the name of your Web server. After that, you just need to start the 
Web Console. (If you have a Standalone Deployment of ZENworks Asset Management, 
you do not need to specify the Web server name.) 
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To specify your Web server name 

1. In the Manager, click on the Tools menu and click on Web Console Management. 
2. In the Web Console Management dialog, specify the name of the server where you installed 

the ZENworks Asset Management Web Console. 
3. Click on the OK button. 

To access the ZENworks Asset Management Web Console from the Manager 

1. Either click on on the toolbar or click on the Report locator tab, open the Web Console 
container, and double-click on Start Web Console. The Manager will start Internet Explorer 
and display the Web Console. 

2. Select the Network Discovery tab. A device list tree will now appear, and you can view the 
network discovery data.  

Viewing and Editing Network Discovery Data 
The Network Discovery tab of the ZENworks Asset Management Web Console displays 
a Device List tree in the left-hand frame. By default, devices are grouped by device type 
and sub-grouped by subnet, but you can configure the Device List tree to group and 
subgroup by any combination of the following: 

 Type (for example, printer, hub, or router) 
 Subnet 
 Location 
 Manufacturer 

The report that appears in the right-hand frame depends on the node of the Device List 
tree that you selected. Each report lets you drill down to the details of a particular 
network node or device. You can export any report to Excel by clicking on the Excel 
button. 

For more information about viewing and editing network discovery data, use the Help 
system available with the ZENworks Asset Management Web Console. 

Enterprise administrators and assistants have the option of editing, adding, or deleting a 
particular network device of device grouping. Click on the Edit, Add, or Delete buttons to 
display a new window with the appropriate Web form. 
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User-Defined Fields 

A user-defined field is a field that you can create in the ZENworks Asset Management 
inventory database to track additional information about a component, product, 
workstation user, or workstation, for example, a purchase date or home telephone 
number. Once you have defined your own fields, information can be entered in them 
either with the Collection Editor during the inventory process or with ZENworks Asset 
Management Manager as part of inventory maintenance. 

Some examples of user-defined fields include: 

 For components, a purchase date, a purchase price, or warranty length. When you define your own field for a 
component, it is available for all components, but you do not need to provide data in this field in all cases. 

 For products, an indication that this is an approved product or one that makes up a standard configuration. 
You can then check individual workstations for compliance. 

 For workstation users, an employee number or home telephone number. 
 For workstations, purchasing or warranty information.  

User-defined fields affect the entire organization so you must be an enterprise 
administrator to create, edit, or delete them. In addition, to prevent inconsistencies in the 
inventory database, the inventory process has to be stopped while you are working with 
user-defined fields. After you finish, you must re-start the inventory process.  

TIPS 

 Novell strongly suggests you spend some time thinking about what additional data you need before you 
create your own database fields. When you create your own fields, the consequences are far-reaching 
because you change the structure of the database. In addition, if you are using Microsoft SQL Server 7.0 or 
2000 with 6.5 compatibility mode enabled, you will not be able to remove any user-defined fields after you 
create them. 

 You may find it helpful to identify and create the fields you want before you start using ZENworks Asset 
Management on a large scale. That way you can obtain the additional data you want right from the start. 

See Also 

Creating a User-Defined Field  

Editing a User-Defined Field  

Deleting a User-Defined Field  



Inventory Preparations 

113 

Creating a User-Defined Field 
You can create additional fields in the inventory database for components, products, 
workstation users, and workstations. These fields – known as user-defined fields - can 
include any kind of text data, numeric data, or dates that your company finds a useful 
addition to the inventory data automatically supplied by ZENworks Asset Management.  

To create a field, you must be an enterprise administrator, and the inventory process must 
be stopped. 

When you create a field, you specify the following: 

 A name for the field. 
 All the field’s characteristics in terms of the type of data it should include (character, integer, decimal, or 

date). 
 (Optional) A value you want to serve as a default value for the field. This value will be entered in the new 

field for all existing workstations in the inventory database as well as be available for workstations that are 
scanned and added later. 
 
NOTE: If you plan to have different defaults for the field for different collection option sets, set the defaults 
in the collection option sets. Otherwise, you will need to edit the user-defined field each time you want a 
different default; you will not be able to change the default in the collection option set itself. 

 The way users should enter data in the field, for example, by selecting an item or typing. 
 Whether this field should be displayed by the Collection Editor , whether users can edit it with the Collection 

Editor, and whether the information is required or needs to be unique.  
 
NOTE: You can always override these Collection Editor settings with a collection option set. 

TIPS 

 Any character field you define can have an edit mask associated with it. An edit mask lets you control the 
format of what the user enters in the field. Keep in mind that fields such as phone numbers or employee ID 
numbers may seem "numeric," but they can be set up equally well as character fields, thus allowing you to 
create edit masks for them.  

 If you create a date field, it automatically has an initial value of 01/01/1980. When you later create items 
that include this field, the date will be set to the current date. For example, if you create a workstation date 
field, it initially has the value 01/01/1980 for all existing workstations. Therefore, you can run a query to 
locate all the workstations with this date field set to 01/01/1980 and change the date to another date. When 
you create a new workstation, however, the date in your user-defined date field will be the current date. If 
you would prefer date fields to default to a blank, make them character fields. Also consider creating an edit 
mask to enforce the way you want users to enter the date. 

 A decimal field that you create has the default value of 0.0 and an integer field has the default value of 0. If 
you would prefer such fields to default to a blank, make them character fields. Also consider creating an edit 
mask to enforce the way you want users to enter the data. 
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To create your own field 

1. Shut down the inventory process from the Control menu.  
2. Click on the Administration menu and click on User Defined Fields. If you have not yet 

stopped the inventory process, ZENworks Asset Management Manager will remind you to do 
so.  
 
NOTE: If other users are logged onto the Manager, you will need to ask them to exit before 
you will be able to work with user defined fields. You can see who is running the Manager 
on the Current Users tab of the process control panel.  

3. In the Manage User Defined Fields dialog, click to select the container for the type of field 
you want to define, for example, User. If any User-defined Fields are defined, a plus (+) 
appears before the field type. Click the plus to expand the field type and view the 
currently defined User-defined Fields. 

4. Click on the New button. The Manager will display the Add User Defined Field dialog. 
5. Complete the dialog 

 

 

6. After you finish defining the field, click on the OK button in the Add User Defined Field 
dialog and then click on the Close button in the Manage User Defined Fields dialog. 

7. Start the inventory process again from the Control menu. 

The new field you have defined will now be available in the inventory database so you 
can query it and edit its contents. It will also be available in the Collection Editor during 
the inventory process if you chose to display it. 

See Also 

Editing a User-Defined Field  

Deleting a User-Defined Field  
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Editing a User-Defined Field 
If you want to change some information about a field that you have defined, you can edit 
the field. For example, you may want to edit the choice list associated with the field or 
change the way it is handled by the Collection Editor. Any changes you make to a field 
affect only new data. For example, if you remove a value from a choice list, it will not 
change any existing data in the inventory database, but will change the selections 
available to users in the future. 

To edit a user-defined field, you must be an enterprise administrator, and the inventory 
process must be stopped. 

NOTE: To prevent the loss of data in the inventory database, you cannot change a field’s type or data length. 

To edit a user-defined field 

1. Shut down the inventory process from the Control menu.  
2. Click on the Administration menu and click on User Defined Fields.  
3. ZENworks Asset Management Manager will warn you that while you are working with user-

defined fields, no other user will be able to log onto the Manager, and that the changes 
you make will affect the entire enterprise. Click on the Yes button to continue. 

4. In the Manage User Defined Fields dialog, display the contents of the container that 
includes the field you want to edit, for example, the User container. 

5. Do one of the following:  
 Double-click on the field you want to edit. 

 Select the field and click on the Edit button. 

6. In the Edit User Defined Field dialog make the changes you want and click on the OK 
button. 

7. Click on the Close button in the Manage User Defined Fields dialog. 
8. Start the inventory process again from the Control menu. 

See Also 

Creating a User-Defined Field  

Deleting a User-Defined Field  

Deleting a User-Defined Field 
If you no longer need a field that you defined, you can delete it. Some databases, 
however, do not let you delete fields so this feature will not be available to you. For 
example, if you are using Microsoft SQL Server 7.0 or 2000 with 6.5 compatibility mode 
enabled, you will not be able to delete any user-defined fields. 

To delete a user-defined field, you must be an enterprise administrator, and the inventory 
process must be stopped. 

CAUTION: If the field that you delete is used in a query, ZENworks Asset Management Manager will remove it 
automatically from the query filter. If the field was used in a Crystal Reports custom report template, the template 
will no longer work. You will need to edit the report template to account for the missing field. 
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To delete a user-defined field 

1. Shut down the inventory process from the Control menu.  
2. Click on the Administration menu and click on User Defined Fields.  
3. The Manager will warn you that while you are working with user-defined fields, no other 

user will be able to log onto the Manager, and that the changes you make will affect the 
entire enterprise. Click on the Yes button to continue. 

4. In the Manage User Defined Fields dialog, display the contents of the container that 
includes the field you want to delete, for example, the User container. 

5. Select the field, click on the Delete button, and confirm the deletion. 
 
 NOTE: If the field was being used in a query, the Manager will remove it automatically 
from the query filter and inform you. 

6. Click on the Close button.  
7. Start the inventory process again from the Control menu. 
8. Edit any Crystal Reports custom report templates that referred to the field you deleted. 

User-defined Field dialogs 
Manage User Defined Fields 

The Manage User Defined Fields dialog lets you create your own fields, rename them, 
and delete them. The dialog includes containers for the four types of fields you can 
create: component, product, user, and workstation. 

To create your own field 

1. Select the container for the type of field you want to define, for example, User. 
2. Click on the New button and complete the Add User Defined Field dialog. 
3. When done, close the Manage User Defined Fields dialog. 

To edit a user-defined field 

1. Display the contents of the container that includes the field you want to edit, for example, 
the Component container. 

2. Do one of the following:  
 Double-click on the field you want to edit. 

 Select the field and click on the Edit button. 

3. Make your changes in the Edit User Defined Field dialog. 
4. When done, close the Manage User Defined Fields dialog. 

To delete a user-defined field 

NOTE: Some databases do not let you delete fields so this feature will not be available to you. For example, if you are 
using Microsoft SQL Server 7.0 or 2000 with 6.5 compatibility mode enabled, you will not be able to delete any user-
defined fields. 

1. Display the contents of the container that includes the field you want to edit, for example, 
the Component container. 

2. Select the field, click on the Delete button, and confirm the deletion. 
3. When done, close the Manage User Defined Fields dialog. 
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Add/Edit User Defined Field 

The Add User Defined Field dialog lets you create your own workstation, component, 
product, or workstation user field. The title of the dialog will reflect what kind of field 
you are adding. The Edit User Defined Field dialog lets you change information about a 
field you created. 

To add or edit a user-defined field 

1. Enter or change information in the dialog. 
 

 
2. After you finish defining the field, click on the OK button in the Add User Defined Field 

dialog and then click on the Close button in the Manage User Defined Fields dialog. 
 
Any new field you have defined will now be available in the inventory database so you can 
query it and edit its contents. It will also be available in the Collection Editor during the 
inventory process if you chose to display it.  

See Also 

About User-Defined Fields  
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Field Definition 

In the Field Definition section, identify the type and length of the field (these cannot be 
edited later):  

1. Select Character, Date, Decimal, or Integer in the Type box. Character is the default. 
2. If you selected Character as the data type, specify the number of characters for the field 

in the Data Length box. This should be the largest number of characters you anticipate 
users entering in this field. The default is 20 characters. 
 
NOTE: The Field Name box will be filled in automatically by ZENworks Asset Management 
Manager after you click on the OK button in the Add User Defined Field dialog. 

TIP 

 Although the data length should be long enough to accommodate the data you want to collect, keep in mind 
that short fields will save on database space. For example, if you are looking for a yes/no value in the field 
you are creating, set the field length to 1 and then set up a choice list of Y and N. 

Label 

Enter a name for the field in the label box. This is how the field will be identified to 
users. The name must be unique to a type of field, for example, workstation or user field. 

Default Value 

You have the option of specifying a default value for all fields except for dates. 

NOTE: If you plan to have different defaults for the field for different collection option sets, set the defaults in the 
collection option sets. Otherwise, you will need to edit the user-defined field each time you want a different defaults; 
you will not be able to change the default in the collection option set itself. 

Do one of the following: 

 Type the value. 
 If you want the value taken from a workstation’s environment variable during the collection process, specify 

the variable in the format %EnvVarName%. (Do not include any quotes.) For example, %USERNAME% would 
obtain the data from the USERNAME environment variable. 
 
NOTE: To see which variables are set in your environment, look at the Environment tab of the System 
Properties dialog in the control panel (Windows NT), look at the Advanced tab of the System Properties 
dialog in the control panel (Windows 2000/XP), or use the SET command in a DOS box.  

 If you want the value taken from a workstation’s Windows registry during the collection process, specify a 
registry key in the format %HKEY:<RegistryKeyName>, for example, 
 
   %HKEY:HKEY_CURRENT_USER\Software\MyCompany\Dept 
 
Do not use quotes in a registry key, even if it includes spaces. 
 
 NOTE: If a registry key is not a string value, the Collector will convert a binary value to a hexadecimal value 
and convert a DWORD value to a string value. 
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Edit Type 

The Edit Type box lets you control how data should be entered in the field. 

 Select one of the following:  

Edit To provide data by typing (the default). 

List To provide data by selecting it from a pre-defined list. 
(Typing is not allowed.) 

Combo To provide data by typing or by selecting it from a list. 

NOTE: The Edit Type box does not apply to dates. Dates are entered using standard 
date controls. 

Choice List 

If you selected List or Combo as the Edit Type, click on the Choice List button to set up a 
list of selections in the Configure Choice List dialog. 

Edit Mask 

If this is a character field, and you selected Edit as the Edit Type, you have the option of 
specifying an edit mask to control the format of the value a user enters in the field. For 
example, the edit mask for a phone number might be (###) ###-####.  

See Also 

Edit Mask Syntax and Examples  

Collection Editor Defaults 

To control how this field is handled by the Collection Editor, select or clear the following 
check boxes:  

Check Box Controls whether… 

Display The Collection Editor displays this field. 

Editable Users can edit this field or just view it while running the 
Collection Editor. 

Require Users are forced to provide data in the field before exiting 
the Collection Editor. 

Unique Users must provide data that is unique. 

NOTE: You can override any selections you make here with the Collection Editor settings in a collection option set.  
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Importing Active Directory Data 

Importing Active Directory Data – Overview 
You can import data from Active Directory databases automatically. Through this 
method, you can populate ZENworks Asset Management database fields with existing 
Active Directory data associated with users, workstations, or other entities within your 
organization. As the data changes, it is automatically updated in ZENworks Asset 
Management. 

You can set up tasks to different Active Directory databases, and can schedule each task 
individually. 

What do you want to do? 

Enable a Task Server for Active Directory Import  

Create a new Active Directory Import task  

Map Active Directory fields to ZENworks Asset Management fields  

Remove a field mapping  

Enabling a Task Server for Active Directory Import 
Within an enterprise, you can designate any Task Server for importing Active Directory 
data. If your enterprise has more than one Task Server, you need to choose one or more 
Task Servers to handle Active Directory Imports. 

Note: Because you can create an Active Directory Import task on any Task Server, it is 
possible to create conflicting import tasks. Be aware of this when created Active 
Directory Import tasks. 

To designate a task server for importing Active Directory data: 

1. In the ZENworks Asset Management Manager’s Management tab, expand Public Task 
Servers. A list of task servers appears. 

2. Open the task server you want to use. You can double-click it, right-click and choose 
Open, or you can click it and type Ctrl-O. The Task Server Information window for the 
selected Task Server appears. 

3. In the Tasks to be Processed area, to select Active Directory Import. The selected Task 
Server is designated as an Active Directory Import server. When you choose a Task Server 
in the Active Directory Import dialog, only those Task Servers enabled for performing 
Active Directory Import tasks appear. 

4. If you have additional Task Servers, open each Task server as described in step 2, then 
clear the Active Directory Import check box for that server. Continue this until you have 
configured all Task Servers. 
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Creating a new Active Directory Import Task 
When you create a new Active Directory Import task, you specify the Task Server, the 
Active Directory Server and login. Once ZENworks Asset Management has connected 
successfully to the Active Directory Server, you can map the fields in the Active 
Directory database to equivalent fields in the ZENworks Asset Management database. 

Note: Only enterprise-level administrators can create Active Directory Import tasks. 

To create a new Active Directory Import task: 

1. In the ZENworks Asset Management Manager’s Management tab, right-click Public Active 
Directory Import Tasks, and choose Active Directory Import Task from the New 
submenu. The Active Directory Import Task dialog appears. 

2. If you want to specify a specific Task Server, click   and choose one. 
3. If you want to schedule the task to run periodically, click Schedule… For more information 

on scheduling tasks, see Scheduling a Task. 
4. In the AD Server box, enter the name of the Active Directory server from which you want 

to import data. 
5. In the Username and Password boxe, enter the Active Directory username and password 

you want the task to use for connecting to the Active Directory database. 
6. If you want to use a port number that is different from the default port number (389), 

enter it in the Port box. 
7. Once you have entered the a server name, username, and password, click Connect. 

ZENworks Asset Management attempts to connect to the specified Active Directory server. 
When the connection is successful, the AD Connection Status box changes to "Connected". 

8. Click Save. If you have not saved the task previously, a dialog appears, allowing you to 
give the task a name and folder. 

Mapping Active Directory fields to ZENworks Asset Management fields 
Once you have connected an Active Directory Import task to an Active Directory server 

To map Active Directory fields to ZENworks Asset Management fields: 

1. In the Active Directory Import dialog, click the Mapping tab. The Mapping tab appears, 
showing Active Directory fields on the left and ZENworks Asset Management fields on the 
right. Each list contains a tree structure. 

2. Expand the tree structures in both field lists until you see the fields you want to map to 
each other. 

3. In both lists, click to select the fields you want to use as the key fields. 
4. Click Key. The selected Active Directory Field changes to bold. The selected ZENworks 

Asset Management Field changes to bold, and "= [Active Directory class]/[Active 
directory field name]" is added to the ZENworks Asset Management field. For example, 
when you map the Active Directory User "name" field to the ZENworks Asset Management 
workstation’s "Primary User" field as key fields, the ZENworks Asset Management 
Workstation’s Primary User field changes to: 
 
Primary User = user/name 
 
You are now ready to create the rest of the field mappings. 

5. In both lists, click to select the fields you want to map to each other. 
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6. Click Map. The selected Active Directory Field changes to bold. The selected field in the 
ZENworks Asset Management Field list changes to bold, and "<-[Active Directory 
class]/[Active directory field name]" is added to the ZENworks Asset Management field. 
For example, when you map the Active directory User "info" field to the ZENworks Asset 
Management workstation’s "Building" field, the ZENworks Asset Management 
Workstation’s Building field changes to: 
 
Building <- user/info 
 
The fields are now mapped to each other, and data from the specified Active Directory 
field will be imported specified ZENworks Asset Management field when the task runs. 

7. Continue using steps 5 and 6 to map Active Directory fields to ZENworks Asset 
Management fields until you have mapped all of the Active Directory fields you want to 
import. 

8. When finished, click Submit. The task is submitted to the specified task server, and 
imports data from the specified Active Directory server according to the specified 
schedule. 

Note: Normally, ZENworks Asset Management displays only a small subset of possibly 
hundreds of classes defined in your Active Directory database, showing only those most 
likely to be relevant to ZENworks Asset Management. If you have created custom Active 
Directory classes and want to use the contents of some of the fields in those classes with 
ZENworks Asset Management, contact Novell Technical Support. 

Removing a Field Mapping 
You can remove an existing field mapping. 

To remove a field mapping: 

1. Click a mapped field in the ZENworks Asset Management Field list. 
2. Click Remove. The mapping is removed, and the selected field is no longer mapped to an 

Active Directory field. 
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Inventory Process 

About the Inventory Process 

ZENworks Asset Management is designed to collect inventory data automatically from 
Windows 95/98, Windows NT, and Windows 2000/XP workstations that are connected 
by TCP/IP. A ZENworks Asset Management enterprise will have one or more Collection 
Servers, each of which is associated with a group of workstations. In turn, each 
workstation can run the three ZENworks Asset Management client applications: the 
Collection Client, Collector, and Collection Editor. 

Here is a overview of the inventory process: 

1. The Collection Client communicates with its Collection Server to find out if it is time to 
collect inventory data from the workstation.  

2. If it is time, the Collection Client starts the Collector and/or Collection Editor. The 
timing of the inventories is determined by the collection schedule assigned to the 
Collection Server. Which application runs on the workstation (Collector and/or Collection 
Editor) and what kind of data is gathered are determined by the collection option set 
assigned to the Collection Server. 

3. Once the inventory of a workstation is done, the collected data is saved in a workstation 
inventory (.wif) file.  

4. The Collection Server automatically loads this file into the inventory database. 

Although ZENworks Asset Management is designed to perform automated inventories of 
Windows 95/98, Windows NT, and Windows 2000/XP workstations, it also supports the 
following activities: 

 Using the ZENworks Asset Management Network Discovery Engine, you can automatically collect data about 
your network devices, for example, hubs, routers, printers, or switches.  

 If you have any Windows 95/98, Windows NT, and Windows 2000/XP workstations that cannot be scanned 
automatically, you can perform a portable collection. 

 If you have any Novell NetWare servers, you can scan them from ZENworks Asset Management Manager.  
 If you have other workstations that are in the list of supported platforms, you can install client applications 

on them and scan them. For more information, see the System Requirements sections of the Installation 
Guide. 

 If you have any workstations that do not fall into any of the above categories, you can add the workstation 
data manually. 

Why Perform an Inventory Manually? 
In a number of situations you may need or want to collect data manually, rather than 
through the automatic-inventory process automatic-inventory process described in 
Performing Automated Inventories. For example: 

 You want to scan a particular workstation right away without waiting for its next 
scheduled scan. See Scanning a Workstation on Demand. 

 You have some workstations that you can scan only by walking up to them and scanning 
them from a removable medium such as a Zip disk, CD, or diskette. See Performing 
Portable Collections. 
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Performing Automated Inventories 

To automate the inventory process in ZENworks Asset Management, you must install the 
client applications on workstations and make sure the Collection Client runs 
automatically on the workstations. The Collection Client serves as the go-between a 
workstation and its associated Collection Server. The Collection Client checks with its 
Collection Server to see whether it is time to start the Collector and/or Collection Editor 
and perform a collection. During a collection, in addition to collecting inventory 
information, Collection Client also automatically updates files, such as the Novell 
Product Knowledgebase, as necessary. 

Several methods exist for installing the client applications on workstations and then 
starting the Collection Client. Which methods you choose depends on the operating 
systems at your site, as well as your preference for, or familiarity with, a particular 
method. Novell strongly recommends that you do some planning before using any of 
these methods. See New Installation Considerations for more information. 

Here is a summary of installation and startup methods: 

 System Policies - you can use System Policies to ensure that certain applications run when the user logs on. 
Through System Policies you can install the client applications if they are not already installed and then 
ensure the Collection Client starts running each time the user logs on. System Policies are available on 
Windows 95/98 and Windows NT workstations. In addition, Windows 2000/XP workstations that are connected 
to Windows NT servers can use the System Policies set in an NT system policy file (NTconfig.pol). 

 Group Policies - on Windows 2000/XP workstations connected to a Windows 2000/XP server, you can use 
Group Policies to ensure that certain applications run when the user logs on. Through Group Policies you can 
install the client applications if they are not already installed and then ensure the Collection Client starts 
running each time the user logs on. 

 Internet - you can set up a Web page on your intranet. Workstation users can then access this page via a Web 
browser to install the client applications on their workstations. The installation will change a registry setting 
on each workstation to ensure the Collection Client runs each time the user starts up the workstation. A 
workstation user just needs a TCP/IP connection to use this method of installation. 

 Logon script - you can modify your centralized network logon script to make sure the client applications are 
installed on each workstation and then to start up the Collection Client each time a user logs onto the 
network. This method is available on all Windows workstations. 
 
NOTE: If users can connect to the network without using the logon script, consider using a different method.  

 ZENworks Asset Management CD - you can install the client applications on workstations from the ZENworks 
Asset Management CD. This, however, requires a visit to each workstation, so may not be practical for large 
numbers of workstations. 

See Also 

Shutting Down the Collection Client  

ZENworks Asset Management Collection Client 
The ZENworks Asset Management Collection Client is an application installed on each 
workstation from which you want to collect inventory data. It manages the inventory 
process on the workstation according to instructions received from the Collection Server 
with which the workstation is associated. For example, the Collection Client ensures that 
the Collector runs as scheduled and that files are updated as necessary. 
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Note: A client checks its ZENworks Asset Management Collection Server’s DNS name every 24 hours (assuming the 
workstation is running) to make sure it hasn’t changed. If the name changes, the collection client reconnects to the 
updated collection server. 

For information about the ways you can install the Collection Client on your 
workstations, see Installing ZENworks Asset Management Collection Client Software. 

Installing ZENworks Asset Management Collection Client Software 

Before ZENworks Asset Management can begin collecting information about the 
software installed on your workstations, you need to install collection client software on 
each workstation from which you want to collect inventory data. 

There are a number of ways you can install the collection client: 

 Remote Client Install utility – Use the Remote Client Install command, available from the Tools menu, to 
launch the Remote Client Install utility. This utility allows you to browse a network, select a group of 
workstations, and install collection client software directly onto those machines.  
 
For detailed information about the operation of the Remote Client Install utility, launch the utility, then 
choose Help on Remote Client Install from the utility’s Help menu.  

 Logon Scripts – If your organization uses a centralized network logon script, you can use it to install and 
launch the collection client. 
 
For more information, see Logon Scripts. 

 Group Policies – If you have Windows 2000/XP workstations connected to a Windows 2000/XP server, you can 
use Group Policies to install and launch the collection client. 
 
For more information, see Group Policies  

 System Policies – System Policies make it possible to ensure that certain applications start running whenever 
a user logs onto the network. 
 
For more information, see System Policies. 

 Web Install - You can install collection client software from a web server on Windows systems. 
 
For more information, see Installing Client Applications from the Web. 

 Manual Install – You can install collection client software directly from the ZENworks Asset Management 
installer CD, or from a downloaded copy. 
 
For more information, see the ZENworks Asset Management Installation Guide. 
 
Note: You can use any of these methods to install client software on installations of virtual machines, such as 
VMware and Virtual PC. From an installation point of view, these installations are appear and are treated in 
the same way as real workstations. 

See Also 

New Installation Considerations  

Logon Scripts 

Logon Scripts and Novell NetWare  

Logon Scripts and Windows NT Server  

Group Policies 
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New Installation Considerations 

Novell strongly recommends that you do some planning before you start using any of the 
installation and startup methods listed in Performing Automated Inventories. 

Below are some issues you need to consider ahead of time. 

Timing the Installation of the Client Applications 

No matter which method you choose, you should perform the client application 
installation gradually. Start with one group of workstations and then go on to another 
group. Do not try to install the client applications on all the workstations in the entire 
enterprise at once. If the schedule is active, and the Collection Client starts running on 
hundreds of workstations at the same time, it will start a scan of those workstations and 
create a very heavy load on the Collection Server. 

Default Installation Settings 

When you install the client applications, workstations are always associated with a 
Collection Server. You have several options for specifying the Collection Server, as well 
as other installation options. 

 If you are installing the client applications from the ZENworks Asset Management CD, you have the option of 
specifying a particular Collection Server during installation. See Setup from ZENworks Asset Management CD.  

 If you are not installing from the CD, you have the option of editing the InstallShield silent response file 
(Setup.iss) to specify a particular Collection Server. The Setup.iss file also controls where the client 
applications are installed, the name of the program folder, and whether the Collection Client is installed as a 
service or as an application. 

 You always have the option of changing the workstation assignments with ZENworks Asset Management 
Manager later. See Re-Assigning a Workstation to a Different Collection Server  

Command Line for starting Setup 

Unless you are installing the client applications from the ZENworks Asset Management 
CD, you will need to provide a command to start the Setup program (Setup.exe). See 
Setup Command Line. 

Schedule Settings 

If you plan to use the default schedule for any of your Collection Servers, you must 
change the initial settings to activate the schedule. Specifically, clear the ending date (or 
set it to a future date). If you are using a different schedule, be sure it is associated with a 
collection option set assigned to the Collection Server. 

For information about setting up a schedule, see Setting Up a Collection Schedule  

Remote User Considerations 

If you have many remote users who do not call in frequently, you may want to maintain 
an open schedule for them (one with a long duration). Also consider associating all the 
remote users with one Collection Server. You can then tailor the schedule and collection 
option set assigned to this server to meet the needs of the remote users. 
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System Policies 

System Policies 

System Policies make it possible to ensure that certain applications start running 
whenever users log onto the network. You can therefore use System Policies both to 
install the client applications on workstations and to start up the Collection Client at 
logon. The client applications will be installed on a workstation only if they are not 
already installed. 

You can use System Policies on Windows 95/98 workstations and Windows NT 
workstations. In addition, any Windows 2000/XP workstation that are connected to a 
Windows NT server can be managed by a Windows NT system policy file. 

See also 

System Policies and Windows 95/98 Workstations  

System Policies and Windows NT Workstations  

System Policies and Windows 2000/XP Workstations  

System Policies and Windows 95/98 Workstations 

To install the client applications and start the Collection Client from Windows 95/98 
System Policies, you must add the command to run Setup.exe to the system policy file 
(Config.pol).  

 In a Standalone Deployment of ZENworks Asset Management, Setup.exe resides in the \Filestore\Setup\Client 
folder of the ZENworks Asset Management installation folder.  

 In an Enterprise Deployment of ZENworks Asset Management with a LAN-based File Store, Setup.exe resides 
in the \Filestore\Setup\Modules\Client Apps folder of the File Store. If you are using an FTP-based File Store 
and copied component installation files to your network during the initial installation, Setup.exe resides in 
the \Setup\Modules\Client Apps folder of the location specified during installation. 

Consult your Microsoft Windows documentation for information about accomplishing 
this procedure. 

Tips 

 For some examples of running Setup, see Setup Command Line 
 For Windows 95/98 workstations to find the policy file on a Novell NetWare server, the file must be stored in 

the Public folder of the SYS volume of all servers that act as the preferred server to any Windows 95/98 
workstation, for example, \\Site2\Sys\Public. 

 For Windows 95/98 workstations to find the policy file on a Windows NT server, the file must be stored in the 
Netlogon folder of all domain controllers used by Windows 95/98 workstations, for example, 
\\NTServer\Netlogon. 
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System Policies and Windows NT Workstations 

To install the client applications and start the Collection Client from NT System Policies, 
you must add the command to run Setup.exe to the system policy file (NTConfig.pol).  

 In a Standalone Deployment of ZENworks Asset Management, Setup.exe resides in the \Filestore\Setup\Client 
folder of the ZENworks Asset Management installation folder.  

 In an Enterprise Deployment of ZENworks Asset Management with a LAN-based File Store, Setup.exe resides 
in the \Filestore\Setup\Modules\Client Apps folder of the File Store. If you are using an FTP-based File Store 
and copied component installation files to your network during the initial installation, Setup.exe resides in 
the \Setup\Modules\Client Apps folder of the location specified during installation. 

You can set up the System Policies either from a Windows NT Server or from a 
Windows NT workstation using the Windows NT Server Resource Kit CD. Consult your 
Microsoft Windows NT documentation for more information. 

Caution: The System Policy Editor for Windows 95/98 is not compatible with the one for Windows NT. 

Tips 

 For some examples of running Setup, see Setup Command Line. 
 For Windows NT workstations to find the policy file on a Novell NetWare server, the file must be stored in the 

server’s folder: <Server>\Sys\Public\WinNT. In addition, the Windows NT workstations must be using Novell’s 
IntraNetWare Client 2.2 or later. For each NT 4.0 workstation, you must set the Novell server as the 
preferred server in the Novell IntraNetWare Client for Windows NT Properties dialog on the Services tab of 
the Network Control Panel. 

 For Windows NT workstations to find the policy file on a Windows NT server, the file must be stored in the 
server’s shared folder named Netlogon. Generally, this folder is in <Windows>\System32\Rep1\Import\Scripts 
when on the server. In addition, you must specify the Windows NT server’s domain name on the 
Identification tab of the Network Control Panel. 

System Policies and Windows 2000/XP Workstations 

If you have Windows 2000/XP workstations that are connected to a Windows NT server, 
you can use Windows NT System Policies to indicate the applications you want to run on 
a workstation each time a user logs on. 

Note: You cannot run the System Policy Editor for Windows NT from a Windows 2000/XP workstation or server. You 
must run the System Policy Editor from a Windows NT workstation or server as described in System Policies and 
Windows NT Workstations . 

Group Policies 

If you have Windows 2000/XP workstations that are connected to a Windows 2000/XP 
server, you can use Group Policies to indicate the applications you want to run on a 
workstation each time a user logs on. You can therefore use Group Policies to install the 
client applications and start the Collection Client. The client applications will be installed 
on a workstation only if they are not already installed. 
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To install the client applications and start the Collection Client from Group Policies, you 
must add the command to run Setup.exe to the logon group policy.  

 In a Standalone Deployment of ZENworks Asset Management, Setup.exe resides in the \Filestore\Setup\Client 
folder of the ZENworks Asset Managment installation folder.  

 In an Enterprise Deployment of ZENworks Asset Management with a LAN-based File Store, Setup.exe resides 
in the \Filestore\Setup\Modules\Client Apps folder of the File Store. If you are using an FTP-based File Store 
and copied component installation files to your network during the initial installation, Setup.exe resides in 
the \Setup\Modules\Client Apps folder of the location specified during installation. 

Consult your Microsoft Windows 2000/XP Server documentation for more information.  

Tip 

For some examples of running Setup, see Setup Command Line. 

Setup Command Line 

Unless you are installing the client applications from the ZENworks Asset Management 
CD, you will need to provide a command to start the Setup program (Setup.exe). This 
section provides some guidelines about specifying the command line to run Setup. 

 The client applications reside in the \Client Apps folder in the File Store. This folder also includes Setup.exe. 
You may want to copy the contents of the \Client Apps folder to a folder to which all your users have access. 
You must then provide the correct path to start Setup.exe. 

 You need to use the -s command line option so that Setup runs in silent mode. In addition, the -SMS 
command line option ensures a network connection is maintained during the installation process. (The 
options are case sensitive.) 

 Setup needs to use the contents of the silent response file (Setup.iss), as described in Editing Setup.iss. You 
will need to specify a path to this file if it is not in the same folder as Setup.exe or is not named Setup.iss. In 
this case, use the -f1 command line option to specify the path and/or name of the file. 

Note: Use quotation marks around a path or file name containing spaces. 

 If you want to rename Setup.iss to be more descriptive (especially in an installation consisting of multiple 
Collection Servers), you can do so and then use the -f1 command line option to specify a particular .iss file. 

 If you are running Setup from a 16-bit process, you must specify all file names in short form. 
 In Windows 95/98, any share names are limited to 8 characters only. 

Some examples of command lines follow. 

 In this command line, Setup is run from the File Store and Setup.iss is in the \Bin folder of the Collection 
Server’s installation folder: 
 
"S:\TSC\Filestore\Setup\Modules\Client Apps\Setup.exe" -s -SMS -
f1"<server>\Bin\Setup.iss" 

 In this command line, Setup is run from a folder named NH and the -f1 command line option specifies an .iss 
file named NH.iss in the \Bin folder of the Collection Server’s installation folder:  
 
"S:\TSC\NH\Setup.exe" -s -SMS -f1"<server>\Bin\NH.iss" 

 In this command line, both Setup.exe and Setup.iss reside in the S:\TSC\NH folder: 
 
"S:\TSC\NH\Setup.exe" -s -SMS 
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Editing Setup.iss 

If you are not installing from the ZENworks Asset Management CD, you have the option 
of editing the InstallShield silent response file (Setup.iss) to specify a particular 
Collection Server. In addition, you always have the option of changing the workstation 
assignments with ZENworks Asset Management Manager later. See Re-Assigning a 
Workstation to a Different Collection Server  

The Setup.iss file also controls where the client applications are installed, the name of the 
program folder, and whether the Collection Client is installed as a service or as an 
application. By default, the client applications are installed in full in \Program 
Files\Novell\ZENworks\Asset Management, and the Collection Client is 
installed as a service. You can edit Setup.iss to change these. 

Note 

If the service installation fails (usually due to lack of administrator privileges), the Collection Client will be installed as 
an application instead.  

To edit Setup.iss:  

In an Enterprise Deployment of ZENworks Asset Management, Setup.iss resides in the 
\Bin folder of each Collection Server’s installation folder. In a Standalone Deployment of 
ZENworks Asset Management, Setup.iss resides in the \Bin folder of the ZENworks 
Asset Management installation folder. The file is a text file and is set up in sections like 
an initialization file. 

Caution: Be careful about the changes you make to this file, or Setup may not run correctly. Make only the changes 
listed below. 

1. Back up Setup.iss. 
2. Open Setup.iss with any text editor. 
3. To change the destination folder, locate the [SdAskDestPath-0] section and provide a 

different value for szDir. 
4. To perform a compact rather than full installation of the client applications, locate the 

[SdOptionsButton-0] section and change Result=101 to Result=102. (In a compact 
installation, only some of the client files are installed initially; others are installed later by 
the Collection Server as needed.) 

5. To install the Collection Client as an application instead of as a service, locate the 
[CustClientAsService-0] section and change Check1=Check1True to Check1=Check1False. 

6. (Enterprise Deployments only) To specify a different Collection Server, locate the 
[DlgComputerName-0] section and provide a different value for ComputerName. 

7. Save the file. 

Tip 

Setup Command Line provides some examples of how you specify Setup.iss in a command line. 
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Installing Client Applications from the Web 

Web Install Overview 

If you are using an intranet at your enterprise, you can set up your Web server so that 
users can access it with their Web browser and install the client applications on their 
workstations. The client applications will be installed only if they are not already 
installed on a workstation. During the installation process, a registry key will be set to 
ensure that the Collection Client always starts running when the user starts up the 
workstation.  

Any Windows 95/98, Windows NT, or Windows 2000/XP workstation that meets the 
following requirements can install the client applications using the Internet method: 

 Has a TCP/IP connection and access to your intranet. 
 Has Microsoft Internet Explorer 4.01 or higher or Netscape Communicator 4.5 or higher. 
 If running Windows NT or Windows 2000/XP and using Internet Explorer has permissions to install an ActiveX 

control. 

Using the Internet for installation and startup involves two main steps: 

1. Set up the Web server with the files users will need. 
2. Provide instructions to your users (usually by e-mail) about accessing the Web server. 

Setting Up the Web Server 

The process of setting up a Web server so users can install the client applications 
involves creating a folder on the Web server and then copying certain files to it from the 
ZENworks Asset Management CD. You will also need to copy the Setup.iss file, which is 
created when you install ZENworks Asset Management or set up additional Collection 
Servers. This file identifies the Collection Server with which you want users’ 
workstations associated. Therefore, if you have multiple Collection Servers you will need 
to create a separate folder on your Web server for each Collection Server. 

To set up the Web server: 

1. When you installed ZENworks Asset Management, an initial Collection Server was 
created. If you plan on having multiple Collection Servers, install each server as 
described in Chapter 4 of the Getting Started Guide. You will now have a Setup.iss 
file for each Collection Server, for example, London or New York. 

2. Create a folder on your Web server. For example, if the Collection Server is named 
London, and your Web server is on a Windows NT or Windows 2000 machine 
running IIS, create a folder named London in the C:\InetPub\wwwroot folder. 

3. Copy the files from http://support.novell.com/filefinder/20636/index.html 
to the folder you created on your Web Server in step 2. Continuing the example, copy 
the files from the CD to C:\InetPub\wwwroot\London. 
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4. Copy the Setup.iss file from the Collection Server to the folder you created on the 
Web server. 
 
In a Standalone Deployment of ZENworks Asset Management, Setup.iss resides in 
the \Bin folder of the ZENworks Asset Management installation folder.  
 
In a Enterprise Deployment of ZENworks Asset Management, Setup.iss resides in 
the \Bin folder of the Collection Server’s installation folder. 
 
Continuing the example, copy Setup.iss from the machine where the London 
Collection Server is installed to C:\InetPub\wwwroot\London. 

5. If you have multiple Collection Servers, repeat steps 2 through 4 for each Collection 
Server so a separate folder exists for each Collection Server on your Web server. 

Instructing Your Users 

The most efficient way to inform users about installing the client applications from the 
Internet is to send the users e-mail that includes the following key pieces of information: 

 The location on the Web server where you want users to point their browser. For example, any users whose 
workstations you want associated with the London Collection Server would need to point their browser at 
http://TheWebServer/London. If your e-mail system supports hot links, users can click on the address in your 
e-mail message. If your e-mail system does not support hot links, instruct users to open their browser and 
enter the URL address you have provided. 

 General instructions for completing the dialogs that perform the installation. In particular, 

When completing dialogs using Internet Explorer: 

 Users must accept the certificates of authenticity so installation can take place. 
 Users may get a message about missing .dlls. In this case they should proceed so the .dlls can get installed. 

They may also need to re-boot their workstations in this case. 

When completing dialogs using Netscape Communicator: 

 Users need to get the plug-in when asked. 
 Users must grant permission to install the plug-in. 

Logon Scripts 

Logon Scripts 

If your organization uses a centralized network logon script, you can install the client 
applications from the logon script, as well as start the Collection Client. The client 
applications will be installed only if they are not already installed on a workstation. You 
can use a centralized logon script for Windows 95/98, Windows NT, and Windows 
2000/XP workstations. 

Caution: If your users can get onto the network without using a logon script, this method of starting the Collection 
Client will not guarantee that it is running on workstations. As a result, workstations may not be scanned at their 
scheduled times. Consider an alternative startup method such as System Policies, Group Policies, or Internet. 

To install the client applications from a network logon script: 
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 Add a command to run Setup.exe to the script. The applications will be installed only if they are not yet 
installed on the workstation. 
 
In a Standalone Deployment of ZENworks Asset Management, Setup.exe resides in the \Filestore\Setup\Client 
folder of the ZENworks Asset Management installation folder.  
 
In an Enterprise Deployment of ZENworks Asset Management with a LAN-based File Store, Setup.exe resides 
in the \Filestore\Setup\Modules\Client Apps folder of the File Store. If you are using an FTP-based File Store 
and copied component installation files to your network during the initial installation, Setup.exe resides in 
the \Setup\Modules\Client Apps folder of the location specified during installation. 

To start the Collection Client from a network logon script 

 Add to the script a command to run CClient.exe. This resides in the \Bin folder of the ZENworks Asset 
Management installation folder. 
 
If necessary, modify logon scripts for Novell NetWare and Windows NT Server. See Logon Scripts and Novell 
NetWare and Logon Scripts and Windows NT Server. 

Logon Scripts and Novell NetWare 

You can start Setup.exe with the NetWare command # or @. When you use #, Login.exe 
(the program that processes the logon script) remains in memory while Setup runs. When 
Setup is done, control returns to the logon script. When you use @, Login.exe processes 
the logon script independently of what Setup.exe is doing; Login.exe will not wait for 
Setup.exe to finish before exiting itself. 

For example, in the logon script, enter 

map p:=Applic:Filestore\Setup\Modules\Client Apps 
drive P: 
#Setup.exe -s -SMS 

OR 

map p:=Applic:Filestore\Setup\Modules\Client Apps 
drive P: 
@Setup.exe -s -SMS 

OR 

map p:=Applic:Filestore\Setup\Modules\Client Apps 
#P:\Setup.exe -s - SMS 

OR 

map p:=Applic:Filestore\Setup\Modules\Client Apps 
@P:\Setup.exe -s – SMS 

  

Note: In the examples above, Applic is the name of a volume. 

Tips 

 If the silent response file is not in the same folder as Setup.exe or is not named Setup.iss, use the -f1 
command line option to specify the path and/or name of the file. For example, Setup.exe -s -SMS -
f1"VT.iss" specifies a silent response file named VT.iss that resides in the same folder as Setup.exe. 

 If you set up the correct access privileges and are in the correct folder, you can enter Setup.exe anywhere in 
the logon script. 
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Logon Scripts and Windows NT Server 

Typically, logon scripts for Windows NT Server are batch files. By default, they reside in 
the \System32\Repl\Import\Scripts folder in the NT system root folder of the domain 
controller(s). If, for example, NT Server is installed in C:\WinNT, then the default path 
for the logon script is C:\WinNT\System32\Repl\Import\Scripts. 

If your site is already using logon scripts, edit the scripts to start Setup.exe. (If your site 
does not yet have logon scripts, you can set them up by using User Manager for Domain 
in the NT Server Administrative Tools group.) 

Edit the logon script by adapting this example, 

net use Q: \\NTServer\Filestore\Setup\Modules\Client Apps 
Q: 
Setup.exe -s -SMS 
net use q: /delete /y 

You also have the option of using UNC to avoid mapping a drive, for example, 

\\NTServer\Filestore\Setup\Modules\Client Apps\Setup.exe -s –SMS 

Tip 

 If the silent response file is not in the same folder as Setup.exe or is not named Setup.iss, use the -f1 
command line option to specify the path and/or name of the file. For example, Setup.exe -s -SMS -
f1"VT.iss" specifies a silent response file named VT.iss that resides in the same folder as Setup.exe. 

Setup from ZENworks Asset Management CD 

If none of the methods described above suits your purposes, you always have the option 
of installing the client applications on workstations from the ZENworks Asset 
Management CD. This, however, requires a visit to each workstation, so it may not be 
practical for large numbers of workstations. If you happen to need to visit workstations 
for another reason, you may not mind the manual installation. One advantage is that it 
gives you full control over the timing of the installation and lets you add workstations to 
the inventory process gradually. 

When you install the client applications from the ZENworks Asset Management CD, the Setup program automatically 
makes a registry setting on the workstation that ensures the Collection Client will start automatically whenever the 
workstation is started up. 

To set up an individual workstation from the ZENworks Asset Management CD 

 Insert the ZENworks Asset Management CD into the CD-ROM drive of the 
workstation. The Setup program may start automatically. If it does not, start it 
manually: 

 Click on the Windows Start button and then click on Run. 
 In the Run dialog, specify the path to the Setup program on the CD, for 

example, D:\Setup. 
 Click on the OK button. 

1. Click on the Next button on the Welcome screen. 
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2. Review the license agreement and accept its terms by selecting the Yes option. 
Then click on the Next button. (You will not be able to continue if you do not 
accept the license agreement.) 

3. In the Choose Installation Type dialog, select either Install/Upgrade Standalone 
Deployment or Install/Upgrade Enterprise Deployment. Then click on the Next 
button. 

4. If you selected Install/Upgrade Standalone Deployment, 

 In the Choose Setup Type dialog, select Install Client Applications and click on 
the Next button. 

 Proceed to step 7. 

1. If you selected Install/Upgrade Enterprise Deployment,  

 In the Choose Setup Type dialog, select Components Only and click on the 
Next button. 

 In the Select Components dialog, clear all applications except for ZENworks 
Asset Management Client Applications. Setup will suggest an installation 
folder. If you want to install the client applications in another folder on a 
local drive, enter the folder name or browse to the folder and click on the 
Next button. 

1. In the Select Type of Client Installation dialog, unless you have 
concerns abut bandwidth when installing the client applications, select 
Typical. If you select Compact, only the files required to connect to a 
Collection Server are installed; additional files are installed automatically by 
the Collection Server when the workstation first connects to it. 

2. In the Choose Destination Location dialog, either accept the folder Setup proposes 
for the client applications or browse for another folder. (You can also create a new 
folder.) Then click on the Next button. 

3. In the ZENworks Asset Management Client Applications Setup dialog, do the 
following: 

 Specify the machine name of the Collection Server with which you want to 
associate this workstation. 

 In the Local Client TCP/IP box, accept the default TCP/IP port number for the 
client applications (7461) or enter a new port number if another application 
uses this port number. 

 If you changed the port number for the Collection Server you specified in step 
8a, enter the changed number in the Remote Collection Server TCP/IP Port 
box. (You should change the number here only if you changed the default port 
number when installing the Collection Server.) 

 Click on the Next button to continue. 

1. In the next ZENworks Asset Management Client Applications Setup 
dialog, determine how you would like the Collection Client to be installed and 
configured: 
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 To install the Collection Client as a service, select the as a service option; to 
install the Collection Client as a standard program, select the as a standard 
executable program option. 
Note: The service installation option requires administrator privileges on the 
machine on which you are installing the Collection Client. If you do not have 
those privileges, the Collection Client will be installed as a standard program.  

 Select the Start the Collection Client automatically option if you want the 
Collection Client to start each time the system is started (if the Collection 
Client is installed as a service) or Windows is started (if the Collection Client is 
installed as a standard program). If you do not want the Collection Client to 
start automatically, clear this option. 

 Select the Start the Collection Client now option if you want the Collection 
Client to start when Setup finishes. If you do not want the Collection Client to 
start when Setup finishes, clear this option. 

 Click on the Next button to continue. 

1. Review your settings in the Start Copying Files dialog. If you need to 
make a change, click on the Back button. Otherwise, click on the Next button. 
Setup will now copy the client applications to the folder you specified. 

2. Click on the Finish button when Setup is complete. 

Shutting Down the Collection Client 

In a trouble-shooting situation, you may need to shut down the Collection Client on all 
the workstations associated with a particular Collection Server. (This is not something 
you would do in normal day-to-day operation.)  

You can shut down the Collection Client either from the Collection locator tab or the 
process control panel. 

To shut down the Collection Client from the Collection locator tab: 

1. Click on the Collection locator tab. 
2. Right-click on the Collection Server whose Collection Clients you want to shut down and 

then click on Shut Down Collection Clients on the shortcut menu. 

To shut down the Collection Client from the process control panel 

1. Click on the Collection Servers tab in the process control panel. 
2. Right-click on the Collection Server whose Collection Clients you want to shut down and 

then click on Shut Down Collection Clients on the shortcut menu. 
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About the ZENworks Asset Management Network Discovery Engine 
The ZENworks Asset Management Network Discovery Engine collects data about 
devices on your network, for example, hubs, routers, printers, or switches. The engine 
uses Internet Protocol (IP), Simple Network Management Protocol (SNMP), and 
Windows Management Interface (WMI) standards to identify any networked device with 
an IP address.  

The ZENworks Asset Management Network Discovery Engine offers the following 
features: 

 Automatically locates, identifies, and reports on IP-based network devices. 
 Lets you specify subnets or IP address ranges you want scanned. 
 Collects SNMP and WMI data from enabled devices. 
 Reconciles discovered devices based on serial number, MAC address, or client ID. 
 Offers Web-based analysis and editing of collected data. 

Using the ZENworks Asset Management Network Discovery Engine you can answer 
questions such as: 

 How many routers, switches, and network printers do I have and where are they located? 
 What are the IOS levels of my routers? Do I need to upgrade them for security reasons? 
 Which printers have been used the most? 
 Which printers do I need to replace next year? 
 Have I installed the ZENworks Asset Management Collection Client on all my workstations? 
 Which leased network devices are expiring next month and where are they located? 
 Which devices and software need to be brought up to "standard"? For example, are there some non-Cisco 

devices in a supposedly "all-Cisco" environment? 
 Which devices need support or version upgrades? 

Before you can collect data about network devices, you must set up a network discovery 
task, which you can execute immediately or schedule. When you set up the task, you can 
choose which types of devices you want to load into the database. (The ZENworks Asset 
Management Network Discovery Engine always identifies all types of network devices, 
but you can control which data is loaded into the database.) You can also specify which 
subnets or IP addresses you want to scan. After you submit a task, you can track it 
through the process control panel, just like any other task. 

The data collected about network devices is available through the ZENworks Asset 
Management Web Console. You can view the data grouped in different ways, for 
example, by device type, manufacturer, location, or subnet. You can also edit or enter 
certain kinds of data, for example, asset tag or location.  

Note: Certain Linux platforms are discovered and differentiated exclusively with SNMP. 
By default, these platforms are not configured to allow discovery by the Network 
Discovery Engine. Before these platforms can be differentiated, each machine must have 
SNMP enabled and configured correctly. For information on configuring a Linux 
machine for discovery by the Network Discovery Engine, see TID #10100611. 
See Also 

Viewing and Editing Network Discovery Data  
Data Collected from Devices During Network Discovery  
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Performing Portable Collections 
If you cannot collect inventory data from a Windows 95/98, Windows NT, or Windows 
2000/XP workstation using any of the automated methods available, you can perform a 
portable collection. This involves visiting a workstation and scanning it from a removable 
medium such as a Zip disk, CD, or diskette. 

CAUTION: Whenever you perform a portable collection and load the data into the inventory database, the contents of 
the workstation inventory file replace any data you previously loaded into the database, including any changes you 
made to the inventory data with ZENworks Asset Management Manager. As a result, you may want to avoid using the 
Manager to edit workstations that are scanned with a portable Collector. You can filter out these workstations in a 
workstation query by specifying an inventory type of "portable." 

To perform a portable collection 

NOTE: When you create a portable Collector, you will need to select the Collection Server whose scan now option set 
you want to use to customize the portable collection process. 

1. Create a portable Collector: 
 
a) Have ready the removable medium on which you want to create a portable Collector. 
For example, insert a blank Zip disk into the Zip drive or have ready four blank, formatted 
1.44 MB diskettes. If you want to create a portable Collector on a CD, create a folder on 
your hard drive for all the collection-related files. You can later burn the contents of this 
folder onto a CD. 
b) In the Manager, click on the Tools menu and click on Create Portable Collector. 
c) Follow the directions in the Create Portable Collector Wizard to create your collection 
medium. 

2. Scan workstations with the portable Collector:  
 
a) If your portable Collector is on a CD, make sure you have some blank formatted 
diskettes for storing the collected data. 
b) Insert the disk or CD with the portable Collector into a drive of the workstation you 
want to scan. 
c) Change to the drive that includes your portable Collector and then run the Collect.bat 
batch file. For example, if the portable Collector is in the D drive, switch to that drive and 
then double click on Collect.bat. (You can also do this from the DOS prompt by changing 
the directory and typing collect.)  A DOS box will appear on the screen. If necessary, you 
will be asked to insert additional diskettes during the scan. 
 
 NOTE: If you are scanning a Windows 95 or Windows 98 workstation, you may get a 
message about being out of environment space. Ignore this message; the portable 
collection will take place regardless. In addition, if you are scanning with a diskette-based 
Collector, you may be asked for a disk with a batch file. Insert disk #1 into the floppy drive 
so you can complete the collection process. 
 
d) If the Collection Editor runs on the workstation, enter any additional information you 
want, save it, and then exit.  
 
 NOTE: If your portable Collector is on a CD, you will be prompted for a diskette so the 
inventory data can be saved. 
 
 Your disk will now include a workstation inventory file (.wif), ready for loading into the 
inventory database. If you collected configuration files, it will also include a workstation 
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auxiliary file (.waf). 
e) Repeats steps 2b through 2d on all the workstations you are scanning manually. 

3. Load collected data into the inventory database: 
 
a) Insert the disk or diskette with the workstation inventory files (.wif) and workstation 
auxiliary files (.waf) into a drive of the workstation where you are running the Manager. 
Alternatively, copy the files to a folder on your hard drive. Be sure you have access to the 
same Collection Server that was selected when you created the portable Collector. 
b) In the Manager, click on the Tools menu and click on Load Portable Collection. 
c) Follow the directions in the Load Portable Collection Wizard to load the collected data 
into the database. 
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Using the Collection Editor 

About the Collection Editor 
The Collection Editor is an application that can run on individual workstations to let 
workstation users review and modify a workstation’s inventory data. Through the 
Collection Editor, a workstation user can provide additional information, such as a 
telephone number or department name. A ZENworks Asset Management administrator 
controls whether and how the Collection Editor runs on workstations by means of a 
collection option set in ZENworks Asset Management Manager. 

By default, the Collection Editor is not enabled. A ZENworks Asset Management 
administrator can specify, however, that the Collection Editor should run only the first 
time a workstation is scanned or each time the Collection Client starts up. See Changing 
Collection Editor Options. 

When you make changes with the Collection Editor, those changes become part of the 
workstation inventory file (.wif), the contents of which are then loaded automatically into 
the inventory database. 

Note: The Collection Editor runs only on Windows systems.  

Why Use the Collection Editor? 

Although inventory data is collected from a workstation automatically, it is often helpful 
to have a workstation user provide some additional information such as a telephone 
number or department name. To make this possible you can set up the inventory process 
so that the Collection Editor runs on workstations as soon as the automatic scan of the 
workstation is over. The Collection Editor lets workstation users review and modify the 
inventory data associated with their workstations. 

See Also 

Collection Editor Toolbar and Menus  

Changing Collection Editor Options 
Collection Editor Options are disabled if the Never option of the Run Collection Editor 
section is selected. 

The Collection Editor tab lets you customize the Collection Editor. By default, the 
Collection Editor: 

 Displays information on four tabs: User, Workstation, Inventory, and Process. (The Process tab shows the 
details of the current collection cycle. This tab can never be edited.)  

 Displays all components on the Inventory tab. 
 Lets workstation users add components (or delete ones they have added), but not create local products. 
 Does not require a password to override restrictions. 

You can choose to display only some of the tabs to workstation users. If you decide to 
display the Inventory tab, you can also select which components you want displayed and 
control to what extent users can modify them and how they can do so. 
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You can create edit masks to require users to enter data in a particular format. You can 
also set up a list of choices for any field, requiring users to choose only from that list. 

To customize the Collection Editor 

NOTE: Collection Editor Options are disabled if the Never option of the Run Collection Editor section is selected in 
the General tab of the Collection Option Set dialog. 

1. In the Collection Option Set window, click on the Collection Editor tab.  
2. If you do not want the Collection Editor to display a tab, clear its check box in the 

Collection Editor Will Display section. 
3. To customize the User, Workstation, or Inventory tabs, click on a Configure button.  
4. If you do not want the Collection Editor to display all components on the Inventory tab, in 

the Inventory Displayed Components box, clear the check box next to the component you 
do not want. (This affects which components are displayed, not which components are 
gathered during a scan.) 
 
NOTE: Choices made on the Collector tab may affect what you can control in the Inventory 
Displayed Components box. For example, if you indicated you do not want to gather 
hardware, there will be no hardware components to display.  

5. If you do not want workstation users to add components (or delete ones they have added), 
clear the Add/Delete User Entered Components check box. Note that if the check box is 
selected, users will not be able to delete any components identified by the Collector, just 
those they previously added. 

6. To give workstation users the ability to add a local product like a system, select the Create 
Local Products check box.  

7. To require users to enter a password to override any restrictions you have set, select the 
Require Password check box, enter a password in the Password box, and confirm it in the 
Confirm Password box. (The password is case-sensitive.) You can then give this password to 
users of your choice. 
 
CAUTION: If you do not require a password, but impose some restrictions on Collection 
Editor use, workstation users will be able to by-pass the restrictions by removing them 
without providing a password. 

8. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 

TIPS 

 If you want to maintain tight control over how and when local products are created, do not give workstation 
users permission to create them. If the need arises to define a local product for an unknown system, you 
always have the option of giving a workstation user the password to let him or her do so.  

 Even if you decide that you do not want workstation users defining local products, you may want them to add 
components to a workstation’s inventory by selecting products defined by Novell. That way workstation users 
can provide you with more complete data about workstations without the possibility of introducing 
inconsistencies or incorrect data into the inventory database. 

 When users provide the password while running the Collection Editor, they will be able to see any data you 
hid, edit fields that you specified as read-only, add components, and create local products. Users will not, 
however, be able to circumvent how data is to be entered in a specific field. For example, if you specified 
that a value is required, it will still be required after the password is provided. 

See Also 
About Collection Option Sets  
Changing General Options  
Changing Collector Options  
Selecting Workstations for Scanning  



ZENworks Asset Management User's Guide 

142 

User Tab 
The User tab in the Collection Editor lets you review and change information about the 
workstation's primary user. 

To review and change user data 

1. Review the data on the tab and make any necessary additions or corrections. In some 
fields you may have to select data rather than type it or you may have to enter it in a 
particular format. If data is required, the field will appear outlined in red. 
 
NOTE: In addition to using the mouse to move among the fields you can use the Enter key 
and arrow keys on the keyboard.  

2. When done, do one of the following:  
 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 
About the Workstation Tab 
About the Inventory Tab 
About the Process Tab  

Workstation Tab 
 
The Workstation tab in the Collection Editor lets you review and change general 
information about the workstation itself, for example, its location or department. On this 
tab you must also enter a workstation ID if it is not supplied.  

To review and change workstation data 

1. (Required) Enter a descriptive name for the workstation in the Workstation ID field. (This 
initially has the same value as the Machine Name field if the Collector was able to obtain a 
machine name.) 
 
 NOTE: In addition to using the mouse to move among the fields you can use the Enter key 
and arrow keys on the keyboard.  

2. Review the other data on the tab and make any necessary additions or corrections. In some 
fields you may have to select data rather than type it or you may have to enter it in a 
particular format. If data is required, the field will appear outlined in red.  

3. When finished, do one of the following:  
 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 
About the User Tab 
About the Inventory Tab 
About the Process Tab  
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Inventory Tab 
 
The Inventory tab in the Collection Editor lets you review and change information about 
the components that make up the workstation. This tab is set up as a grid. Each row can 
include information about one component and each cell in a row can include a specific 
type of data about the component, for example, model or serial number. 

Which components you see depends on the settings made by your administrator in 
ZENworks Asset Management Manager. If all the components are displayed, the 
Collection Editor always displays the system, monitor, printer, and keyboard components 
first, followed by the other hardware components and then software components. The 
information for each component always includes the product type, manufacturer, product 
name, model/version, category, and subcategory. The display of other pieces of 
information, such as serial number or asset tag, depends on what the administrator set up 
in the Manager. Regardless of what your administrator specified you should see, not all 
component information is displayed on the Inventory tab because of the amount of 
potential data involved. You always have the option of seeing all component details in 
the Edit Component Properties dialog, however. 

You may be able to add a component or delete a component that was added manually. 
(You can never delete a component that was identified automatically during the inventory 
process.) You may also be able create a local product. Again, what you will be able to do 
with components depends on settings made by your ZENworks Asset Management 
administrator. 

To review and change inventory data 

1. Review the inventory data. Use both the horizontal and vertical scroll bars to see 
additional components and fields. 
 
NOTE: If data is required, the field will appear outlined in red. 

2. Navigate from field to field using either the mouse or the keyboard.  
 Use the Tab key to move across a row. 
 Use the Enter key to move down a column. 
 Use the arrow keys to move from field to field. 

3. Do one or more of the following:  
 View all the available data for a component by displaying the Edit Component Properties dialog. 
 Add a component. 
 Edit a component. 
 Delete a component that was added manually. 

4. When done, do one of the following:  
 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 
About the User Tab 
About the Workstation Tab 
About the Process Tab  
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About the Process Tab 
 
The Process tab in the Collection Editor is purely informational. You cannot change any 
information on this tab. The tab provides information about the most recent scan of a 
workstation, and is for diagnostic and administrative purposes. 

NOTE: Depending on how your ZENworks Asset Management administrator has chosen to customize the Collection 
Editor, the Process tab may not be available to you. 

To examine information on the Process tab 

1. Either click on the Process tab or click on the View menu and click on Process Tab. 
2. Review the information. 
3. When done, do one of the following:  

 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 

About the User Tab  

About the Workstation Tab  

About the Inventory Tab  

Changing the Display 
 
Although many aspects of the Collection Editor window are fixed, you have the option of 
hiding the toolbar or status bar and of adjusting column widths. 

To hide the toolbar or status bar 

 Click on the View menu and click on Toolbar or Status Bar. To display them again, repeat this command. A 
check mark next to the command means the toolbar or status bar is displayed. 

To adjust column widths 

On any of the four tabs you can change the widths of columns to display more or less 
information. This is particularly helpful on the Inventory tab which contains many 
columns of data. 

1. Position the mouse pointer where two columns join in the column header row. 
2. When the pointer changes shape, drag the edge of the column left or right until it is the 

size you want. (If you make a column so narrow that it is hidden, double-click where the 
two columns join to restore the hidden column.) 
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Exiting the Collection Editor 
 
It is a good idea to save your work as you go, but if you try to exit without saving your 
work, the Collection Editor will give you the opportunity to do so before closing down. 

To exit the Collection Editor 

Do one of the following: 

 Click on the Save and Exit button on the toolbar. 
 Click on the File menu and click on Save and Exit. 
 Click on the File menu and click on Exit. 
 Close the Collection Editor window. 

If you have made changes during an inventory cycle but have not saved them, the 
Collection Editor will inform you that it will save your changes automatically when you 
exit. You have the option of canceling the exit and continuing to use the Collection 
Editor. 

Editing Inventory Data 
Reviewing and Editing User Data 

 
The User tab in the Collection Editor lets you review and change information about the 
workstation's primary user. 

 NOTE: Depending on how your ZENworks Asset Management administrator has chosen to customize the Collection 
Editor, the User tab may not be available to you. 

To review and change user data 

1. Either click on the User tab or click on the View menu and click on User Tab. 
2. Review the data on the tab and make any necessary additions or corrections. In some 

fields you may have to select data rather than type it or you may have to enter it in a 
particular format. If data is required, the field will appear outlined in red.  
 
 NOTE: In addition to using the mouse to move among the fields you can use the Enter key 
and arrow keys on the keyboard.  

3. When done, do one of the following:  
 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 

About the Workstation Tab 

About the Inventory Tab 

About the Process Tab  
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Reviewing and Editing Workstation Data 

The Workstation tab in the Collection Editor lets you review and change general 
information about the workstation itself, for example, its location or department. On this 
tab you must also enter the workstation ID if it is missing.  

NOTE: Depending on how your ZENworks Asset Management administrator has chosen to customize the Collection 
Editor, the Workstation tab may not be available to you. 

To review and change workstation data 

1. Either click on the Workstation tab or click on the View menu and click on Workstation 
Tab. 

2. (Required) Enter a descriptive name for the workstation in the Workstation ID field. 
(Initially this has the same value as the Machine Name field, but you can change it.) 
 
 NOTE: In addition to using the mouse to move among the fields you can use the Enter key 
and arrow keys on the keyboard.  

3. Review the other data on the tab and make any necessary additions or corrections. In some 
fields you may have to select data rather than type it or you may have to enter it in a 
particular format. If data is required, the field will appear outlined in red.  

4. When done, do one of the following:  
 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 

About the User Tab  

About the Inventory Tab  

About the Process Tab  

Reviewing and Editing Hardware and Software Data 

The Inventory tab in the Collection Editor lets you review and change information about 
the hardware and software components that make up the workstation. This tab is set up as 
a grid. Each row can include information about one component and each cell in a row can 
include a specific type of data about the component, for example, model or serial number. 

Which components you see depends on the settings made by your administrator in 
ZENworks Asset Management Manager. If all the components are displayed, the 
Collection Editor always displays the system, monitor, printer, and keyboard components 
first, followed by the other hardware components and then software components. The 
information for each component always includes the product type, manufacturer, product 
name, model/version, category, and subcategory. The display of other pieces of 
information, such as serial number or asset tag, depends on what the administrator set up 
in the Manager. Regardless of what your administrator specified you should see, not all 
component information is displayed on the Inventory tab because of the amount of 
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potential data involved. You always have the option of seeing all component details in 
the Edit Component Properties dialog, however. 

You may be able to add a component or delete a component that was added manually. 
(You can never delete a component that was identified automatically during the inventory 
process.) You may also be able create a local product. Again, what you will be able to do 
with components depends on settings made by your ZENworks Asset Management 
administrator. 

To review and change hardware and software data 

1. Either click on the Inventory tab or click on the View menu and click on Inventory Tab. The 
first column on the Inventory tab may include one of the following icons: 
 

 This component was discovered during the inventory process but was then edited by the 
user. 

 This component was added by the user. 
2. Review the inventory data. Use both the horizontal and vertical scroll bars to see 

additional components and fields. 
 
NOTE: If data is required, the field will appear outlined in red. 

3. Navigate from field to field using either the mouse or the keyboard.  
 Use the Tab key to move across a row. 
 Use the Enter key to move down a column. 
 Use the arrow keys to move from field to field. 

4. Do one or more of the following:  
 View all the available data for a component by displaying the Edit Component Properties dialog. 
 Add a component. 
 Edit a component. 
 Delete a component that was added manually. 

5. When done, do one of the following:  
 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 

About the User Tab  

About the Workstation Tab  

About the Process Tab  

Adding a Component 

If your administrator has given you permission to add components, you can add them to 
the workstation's inventory. You may need to add a component for any of the following 
reasons: 

 Some external peripherals (such as scanners or digitizers) cannot be recognized automatically during the 
inventory process. 

 A new brand or device may not have recognition available for it yet. 
 A piece of software is not installed on the computer but is perhaps run from a CD-ROM. 
 A hardware component is custom built or a piece of software is internally developed.  
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In many cases you will be adding a component that corresponds to a product already 
defined by Novell. In other cases, the component will not correspond to a product defined 
by Novell and will represent a local product.  

NOTE: Even if you have permission to do so, avoid defining a local product unless you are doing so for a system 
component. Software local products and hardware products other than systems should not be added with the 
Collection Editor. (An enterprise administrator should add them with ZENworks Asset Management Manager.) 

You can add a component in one of two ways: 

 By entering it directly on the Inventory tab in the blank row below displayed components. 
 By completing the Add New Component dialog. 

To add a component 

1. Click on the Inventory tab. 
2. To add a component directly on the Inventory tab: 

 
a) In the blank row below the existing components, do one of the following: 

 Select data in the Product Type, Manufacturer, Product Name, and Model/Version columns to specify 
the product you want. If the product you want is not listed, you can create a local product if you have 
permission to do so.  

  Either click on   on the toolbar or click on the Component menu and click on Browse. You can then 
select a product in the Browse for Product dialog.  

 
b) If any additional information can be added about the component on the Inventory tab, 
for example, serial number or asset tag, enter this information.  
c) Press the Enter key to complete the definition of the component. 

3. To add a component by completing the Add New Component dialog: 

a) While on the Inventory tab, either click on   on the toolbar or click on the 
Component menu and click on Add. 
b) In the Select Component Type dialog, select the product type, for example, printer, and 
click on the OK button. The Collection Editor will now display the Add New Component 
dialog. 
c) To find a specific product quickly, click on the Browse button. If the product you want is 
not listed in the Browse for Product dialog, you can create a local product if you have 
permission to do so.  
d) Complete any additional fields and click on the OK button when done.  

TIPS 

 If you know the model or version of a product, enter it in the Model/Version field, and the Collection Editor 
will try to complete the Manufacturer and Product Name fields for you. If the model number is not unique, 
the Collection Editor will display the Browse for Product dialog with the list filtered by the model/version. 
You can then identify the product you want. 

 Components can also be added with the Manager. 

See Also 

Creating a Local Product  
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Editing a Component 

 
You may want to edit a component for any of the following reasons: 

 To add brand information about a monitor, printer, or keyboard. 
 To add a serial number or asset tag. 
 To provide version information about software. 
 To correct an incorrectly identified system. This may occur when a supplier puts its label on a computer that 

another company manufactures. You can make the Collector attribute the system to the supplier by 
correcting the manufacturer information. 

NOTE: If a system is listed as "unknown" on the Inventory tab, create a local product for it if you have permission to do 
so. Doing so will ensure that the Collector correctly recognizes that system and others like it during subsequent 
collection cycles. 

Most component editing can be done directly on the Inventory tab. Because of the 
potential volume of information about a component, however, not all component data 
appears on the Inventory tab. To see and/or change that data, you can display the Edit 
Component Properties dialog. This dialog shows all the existing data for a component. 

To edit a component 

1. On the Inventory tab, click on the cell where you want to make a change or to add data. 
Type the data or select it from a drop-down list (if available). In some cases you may have 
to select data; typing will not be an option. 

2. To display all the available information about a component in the Edit Component 
Properties dialog, do one of the following:  

 Double-click on the indicator column to the left of the component's Product Type. (This column of the 
Inventory tab sometimes includes an icon to indicate an added or changed component.) 

 Select a component by clicking on any cell in its row and then click on   on the toolbar. 
 Select a component by clicking on any cell in its row and then click on the Component menu and click 

on Edit. 

 
The Edit Component Properties dialog shows both the current value for a component 
property and the scanned value (the value identified during the inventory process). What 
you can change in this dialog again depends on decisions made by your administrator. 
Some data in this dialog, however, can never be changed, for example, the product type. 

3. Review the information in the Edit Component Properties dialog and make any necessary 
changes. 

4. To change product-related data (manufacturer, name, or model/version), click on the 
Browse button to display the Browse for Product dialog. Find the product you want and 
click on the OK button.  

5. After you finish making changes in the Edit Component Properties dialog, click on the OK 
button to return to the Inventory tab. 

TIP 

 Components can also be edited with the Manager.  
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Deleting a Component 

You can delete any component that was added manually; you cannot delete a component 
identified by the Collector. 

To delete a component that was manually added 

1. Select the component you want to delete by clicking on any cell in its row. 
2. Delete the component in one of these ways:  

 Click on   on the toolbar. 
 Press the Delete key. 
 Click on the Component menu and click on Delete. 

3. Confirm the deletion.  

TIP 

 Manually-entered components can also be deleted with the Manager. 

Creating a Local Product 

 
ZENworks Asset Management can identify thousands of different commercial products 
during the scan of a workstation. Nonetheless, your organization may use hardware and 
software products that are not among those that ZENworks Asset Management 
automatically identifies. These products can include commercial products, internally 
developed software, or custom-built computers. You can add such products to the 
inventory database by defining local products. 

Local products can be defined in one of two ways: 

 With the Collection Editor. You need special permission to do this, however. 
 With ZENworks Asset Management Manager by an enterprise administrator. 

NOTE: Novell strongly recommends that the Collection Editor be used to define local products for system components 
only. This would be necessary if the Collection Editor listed the computer as "unknown system" or showed incorrect 
identification. When you create a system local product with the Collection Editor, the Collector can then obtain 
recognition data about the system directly from the computer on which it is running. This recognition data will let the 
Collector correctly identify this computer and others like it during future inventory cycles. The Collection Editor should 
not be used to define software local products or local products for hardware other than systems. An enterprise 
administrator should define such local products with the Manager. 

To create a local product 

1. If the system component is listed as unknown on the Inventory tab or is identified 
incorrectly, edit it. Provide the manufacturer, name, model/version, and any additional 
data you want, or are required to enter.  
If you are adding a component, and enter product-related data that does not correspond to 
a product that was defined by Novell, the Collection Editor will assume you are creating a 
local product. (You must have permission to do so, however.) 

2. When the Collection Editor detects that you are creating a local product, it will ask you to 
confirm. Click on the Yes button to do so. 

3. In the Select Category dialog, select a category and subcategory for the local product and 
click on the OK button. 
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Using the Collection Editor Without Restrictions 

 
When a ZENworks Asset Management administrator customizes the Collection Editor, 
he or she has the option of requiring and defining a password that you must provide if 
you want to run the Collection Editor without restrictions. If you have this password, you 
can use it to see data that the administrator may have hidden or edit data that was 
specified as read-only. The password, however, will not let you change how you enter 
data in specific fields. For example, if a field value is required it will still be required 
after you use the password. 

You can provide the password at any time while using the Collection Editor. 

To provide a password 

1. Either click on   on the toolbar or click on the File menu and click on Grant 
Permissions. 

2. Enter the password given to you by your administrator and click on the OK button. Note 
that the password is case-sensitive. 

Undoing Changes You Have Made 

 
If you edit a workstation’s inventory data and then change your mind, you can undo the 
edits for the current Collection Editor session or you can undo all the edits you have ever 
made with the Collection Editor to certain component fields on the Inventory tab. 

To discard edits from the current Collection Editor session 

You can discard all the edits you made during the current Collection Editor session and 
revert back to the data as it was before you started editing. Any edits you made during 
previous Collection Editor sessions will be unaffected. 

 Click on the File menu and click on Reload.  

To discard edits to certain component fields from all Collection Editor sessions 

You can also discard all the edits you have ever made with the Collection Editor (over 
any number of sessions) to the Manufacturer, Product Name, Model/Version, Serial 
Number, and Asset Tag fields on the Inventory tab. Any data in these fields will then 
revert to the data gathered by the Collector. Any data specific to a particular type of 
component (for example, path for software or speed for a modem) will remain 
unchanged. 

1. Click on the File menu and click on Reset to Scan.  
2. Confirm that you want to do this.  
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Collection Editor Dialogs 
Add New Component/Edit Component Properties 

 
The Add New Component dialog lets you provide information about a component you 
are adding to your workstation. The Edit Component Properties dialog lets you review 
and change information about an existing component. 

To add or edit a component 

1. Do one of the following:  
 Enter or select data directly in the dialog. 
 Click on the Browse button to locate a particular product in the Browse for Product dialog. 

 
NOTE: Unless you have permission to create local products, you must select an existing 
product.  

2. Add or change any additional information such as a serial number or asset tag. 
3. Click on the OK button when done. 

TIP 

 If you have permission to create local products and you specify product-related data that does not 
correspond to a product that was defined by Novell, the Collection Editor will assume you are creating a local 
product. You will need to confirm this and provide information about the product's category and subcategory. 

Browse for Product 

 
The Browse for Product dialog lets you locate a particular product while you are adding 
or editing a component. 

To browse for a product 

1. Narrow the search for product you want by selecting criteria in the top row of the dialog. 
The products listed will change according to these criteria. 

2. Select the product you want. 
3. Click on the OK button to return to the Add New Component dialog or Edit Component 

Properties dialog. 

Process Tab 

 
The Process tab in the Collection Editor is purely informational. You cannot change any 
information on this tab. The tab provides information about the most recent scan of a 
workstation, and is for diagnostic and administrative purposes. 
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To examine information on the Process tab 

1. Review the information. 
2. When done, do one of the following:  

 To continue reviewing and changing data, click on another tab. 
 To save your changes and leave the Collection Editor, either click on the Save and Exit button on the 

toolbar or click on the File menu and click on Save and Exit. 

See Also 

About the User Tab 

About the Workstation Tab 

About the Inventory Tab  

Select Component Type 

1. Select the type of product you want to add, for example, printer. 
2. Click on the OK button. 
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Analysis and Maintenance 

Reports 

About Reports 
ZENworks Asset Management includes many reports to help you analyze your inventory 
data in a variety of ways.  

Web Reports 

A large number of reports are available through the browser-based Web Console. For 
information about these reports, see About Web Reports and Running Web Reports.  

  

You can also create your own custom reports. For more information, see Using Custom 
Reports and Alerts, in the Using the Web Console section of the Web Console help. 

ZENworks Asset Management Manager Reports 

These reports are organized by type and category.  

Report Types 

ZENworks Asset Management includes several types of reports to reflect the inventory 
data you may want to analyze: 

 Component reports 
 FNI reports 
 Maintenance reports 
 Product reports 
 Usage reports 
 Workstation reports 

Although each type of report focuses on a particular type of data, the report may also 
include related data to give you a fuller picture. 

Report Categories 

Report categories group reports by the kind of information they include or the analysis 
they perform. Six categories of report exist, but not every category is applicable to every 
type of report: 

 Breakdown reports are available for component, FNI, product, or workstation data. They count instances of 
items, for example, total memory breakdown or FNI breakdown. Top (n) reports are a kind of breakdown 
report that list the top n values. For example, a top 10 report of software components list the top 10 
software components in the inventory database. 

 Trend reports show breakdowns at a given time for component or workstation data, for example, a hardware 
component trend analysis or a total memory trend. Such a report essentially answers questions such as "How 
many existed then?" and "How many exist now?" 

 Catalog reports are available for component, product, or workstation data. They list values in a simple 
spreadsheet-like fashion, for example, a hardware component catalog or local software product catalog. 
Such a report essentially shows who has what. 
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 History reports are available for component or workstation data, as well as software product usage data. 
These reports show changes to information over time, for example, a workstation scan history. The types of 
changes listed in a history report can include created, moved, edited, and deleted components or 
workstations. 

 Detail reports are available for FNI data or for workstations. These reports provide as much detail as 
possible.  

 Upgrade reports determine if the hardware or software on workstations needs to be upgraded on the basis of 
some criteria. 

The ZENworks Asset Management Reports container on the Report locator tab includes 
all the reports supplied with ZENworks Asset Management. The Report locator tab is 
also the starting point for any activities you perform with reports. 

NOTE: Although you cannot create your own reports from scratch using ZENworks Asset Management Manager, you can 
create custom reports with Crystal Reports and then import them into ZENworks Asset Management so that they are 
available from the Manager.  

See Also 

Running a Report  

ZENworks Asset Management Report Reference  

ZENworks Asset Management Sample Report Reference  

About Web Reports 
Through Web-based reports you can view your inventory data in a variety of ways using 
the ZENworks Asset Management Web Console. You can access the Web Console from 
ZENworks Asset Management Manager, but you can also access it directly from Internet 
Explorer without needing a ZENworks Asset Management installation. 

Several categories of Web reports are available, for example: 

 Software reports such as Software Summary by Manufacturer or Duplicate Software Serial Numbers provide 
information about installed software. 

 Hardware reports such as Disk Space or Memory Size provide information about installed hardware. 
 Usage reports provide information about software product usage. 
 License reports provide information about compliance with license purchases. 

The Web reports contain links that allow you to drill down to greater and greater 
inventory detail. For example, many reports start with summary information for a group 
of workstations, but by clicking on links in the report, you can obtain details about 
individual workstations. 

Before you can start running Web reports, make sure all those who need to run Web 
reports are set up as ZENworks Asset Management users. A ZENworks Asset 
Management user name and password are required to run the Web reports. 
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Viewing Web Reports 
After you select the Reports tab in the ZENworks Asset Management Web Console, you 
will see a System List tree and a list of pre-defined Web reports in the left-hand frame. 
You can now run the reports. 

To view Web reports 

1. By default, the System List is organized by Department. If you want it organized 
differently, for example, by Site or Cost Center, make a selection in the System Group box 
and click on the Submit button. 

2. Click on the report you want to run. The report will be displayed in the right-hand frame. 
The initial view of the report gives you the option of drilling down to more data for all 
workstations or for those in a specific department. Links in each view of the report let you 
drill down to more detailed information.  

3. To change the way data is sorted in the report, click on a column heading. To change the 
sort order, click on the column heading a second time. 

4. To print the report, use the print commands in Internet Explorer. 
5. To export any report to Microsoft Excel, click on the Excel button. If there are more than 

100 items in the report, click on the Excel (All) button to export all the items. (The Excel 
button exports up to 100 items only).  

6. After you finish viewing reports, close Internet Explorer. If you were using ZENworks Asset 
Management Manager, you will now return there. 

TIPS 

 If you selected one of the upgrade readiness reports, choose one of the pre-defined readiness requirements, 
use the general system requirements, or customize your system criteria. Click on the Report button once you 
have specified your criteria. 

 You can click on the Find link in the Reports section of the tree and enter search criteria to find the 
workstations that interest you. By default, each field contains an asterisk (*) which acts as a wildcard. For 
example, you can enter a value such as c* to find data that begins with a "c" or enter a value such as *ch* to 
find that that includes "ch" in the word. Refine the criteria and click on the Search button. (If you use the 
default criteria, all workstations will be listed in the report.) 
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Creating Report Folders 
The Public Reports container and Personal Reports container initially have no folders. It 
is up to you to create folders for organizing any reports you want to store in these 
containers. You can create as many folders as you like and name them as you like, but 
you cannot create folders inside other folders. If you choose not to create any folders, 
your reports will be stored in the container. 

Only an enterprise administrator can create folders in the Public Reports container; other 
users are restricted to creating them in their Personal Reports container. 

To create a report folder 

1. Either click on the Report locator tab or click on the View menu and click on Report. 
2. Do one of the following:  

 Select the Public Reports container or Personal Reports container, click on   on the toolbar, and 
then click on Folder. 

 Right-click on the Public Reports or Personal Reports container and then click on New Folder on the 
shortcut menu.  

 Select the Public Reports container or Personal Reports container, click on the File menu, click on New, 
and then click on Folder.  

3. Enter a name for the folder in the Folder dialog and click on the OK button. The name 
must be unique within the container. 

See Also 

Running a Report  

Running Reports 
Running a Report 

The procedure for producing a report with ZENworks Asset Management Manager is 
very similar no matter what kind of report you want to run. In all cases you complete the 
Configure Report dialog. Some settings in this dialog are standard for all reports; others 
are specific to certain types of reports. ZENworks Asset Management Report Reference 
summarizes all the possible settings for each report.  

NOTE: Web reports are run differently. 

When you run a report, you have the choice of displaying it on the screen or printing it. 
Reports that you print can be scheduled so they take place at a time of your choosing. 

NOTE: If you plan to display the report on the screen, be sure you have set up a printer, or the report will not display 
correctly. (Crystal Reports requires a printer to be set up.) See the Windows Help system for details of setting up a 
printer. 

In ZENworks Asset Management, the process of scheduling the printing of a report is 
known as a task. (A report you display on the screen is not considered a task.) When you 
start a task, it becomes part of a queue to wait its turn if other tasks are in progress or to 
wait until it is scheduled to run. To view the status of your tasks or to pause or stop them, 
you can examine the Tasks tab in the process control panel.  
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To set up and produce a report 

1. Either click on the Report locator tab or click on the View menu and click on Report.  
2. Do one of the following to display the Configure Report dialog for the report you want to 

run:  
 Double-click on the report. 

 Select the report and click on   on the toolbar. 
 Right-click on the report and click on Open on the shortcut menu. 
 Select the report, click on the File menu, and click on Open. 

3. On the General tab provide the report title, subtitle, and description and, for some 
reports, to provide additional information such as dates.  

4. Click on the Grouping tab to group data in the report in various ways, for example, by site 
or by product. The choices here depend on the type of report you are running. Grouping 
puts related items together; it does not sort them. Step 6 covers sorting.  

5. Click on the Filtering tab to set up filters to narrow down the amount of data that is 
included in the report.  

6. Click on the Sorting tab to sort some of the data in the report in a particular order. For 
example, if you have grouped data by site, you can sort the data for each site.  

7. Click on the Options tab to control the inclusion of certain elements in the report, for 
example, a logo, or the report title or description.  
 
NOTE: If you want to run a report more than once, be sure to save it as described in step 
8. If you do not save the report settings, you will have to re-do them the next time you 
want to run the same report. 

8. To save the changed settings to update an existing report, click on the Save button in the 
Configure Report dialog. If you are trying to save a report in the ZENworks Asset 
Management Reports container, the Manager will display the Save Report As dialog. 
Complete steps b through d below. 
 
To save the changed settings in the form of a new report, do the following: 
 
a) Click on the Save As button in the Configure Report dialog. 
b) Enter a name for the report. 
c) Select a folder for the report in your Personal Reports container. If you do not select a 
folder, the report will be saved in the container. 
d) Click on the OK button. 

9. Click on the Submit button to specify a destination for the report.  
10. If you selected the screen as the destination for the report, you will now be able to view 

the report as described. If you selected a printer as the destination and scheduled it, you 
can check on its status on the Tasks tab in the process control panel.  

See Also 

Viewing a Report  
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General Tab 

The General tab of the Configure Report dialog lets you provide a title, subtitle, and 
description for all reports. The rest of this tab varies according to the category of the 
report. For some breakdown reports, you can also select a report format and indicate 
whether you want to see the top (n) items or all items. For history reports, you can 
specify a range of dates for the history. For some trend reports, you can select a report 
format and dates for the trend analysis. 

To provide general report information 

1. 1. In the Report Information section on the General tab, edit the title, subtitle, and/or 
description for the report. These appear on the header (first) page of the report. The title 
and subtitle also appear at the top of each report page. 

2. 2. For a breakdown report, do the following (if available): 
 
a) Select Tabular, Bar Graph, or Pie Chart in the Format section. Tabular is the default. 
 
 NOTE: Graphs work best for small data sets; if you try to graph too many values, the 
graph will be hard to read. Use the Filtering and Grouping tabs to limit the amount of data 
shown. 
 
b) In the Top(n) section, either select the Display All option button to see all the data 
broken down or select the Display Only Top option button to see a subset of data. For 
tabular reports, you can specify a number to see that top number of items. For graphs, 
ZENworks Asset Management Manager will display the top 10 values. (The default is Display 
All.) 

3. For a history report, specify a range of dates for which you want a history. The default is 
1/1/2000 through the current day. Do one of the following:  

 Type a date in each box in the Report History section. 
 Click on the down arrow on the right of the date box so you can select a date from a calendar. On the 

calendar, click on the arrows to go forward or backward by a month at a time or click on the month or 
year to select a different month or year. To select a specific date, click on it. To select today's date, 
click on Today. 

4. For a trend report, do the following (if available): 
 
a) Select Tabular or Line Graph in the Format section. Tabular is the default.  
 
 NOTE: Graphs work best for small data sets; if you try to graph too many values, the 
graph will be hard to read. Use the Filtering and Grouping tabs to limit the amount of data 
shown. 
 
b) Select Daily, Weekly, Monthly, Quarterly, or Yearly in the Frequency box to control the 
interval at which the trend is analyzed. The default is Weekly. 
c) Specify a range of dates for the analysis either by typing a date in the Beginning and 
Ending boxes or by selecting dates from a calendar. To use the calendar, click on the down 
arrow to the right of the date box. On the calendar, click on the arrows to go forward or 
backward by a month at a time or click on the month or year to select another. To select a 
specific date, click on it. The default date range is 1/1/2000 through today. 
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Grouping Tab 

The Grouping tab of the Configure Report dialog lets you place related data together in a 
report, for example, all workstations at the same site. Some reports allow a hierarchy of 
grouping, for example, by site, then building, then floor. The fields by which you can 
group are determined by the kind of report you are running. A grouping option also 
determines where page breaks should occur. 

In some reports, grouping also determines how subtotals and totals are to be calculated. 
For example, a report that groups workstations by site, building, and floor might show 
subtotals of workstations for each site, building, and floor. 

NOTE: In addition to grouping related items in a report, you may want to sort the data in a particular way.  

ZENworks Asset Management reports have three different levels of grouping that serve 
different purposes in different kinds of reports. 

The top grouping level is often demographics, and here you can specify up to three fields 
by which you want data to be grouped, for example, by site, then building, then 
department. The second grouping level depends on the report. For example, in a product 
related report you may have a choice between no grouping and grouping by category 
name, subcategory name, manufacturer, and product name. In breakdown and trend 
reports, the third grouping level is the field by which you want to count items. In other 
reports, where counting does not apply, you have the option of grouping on a third level. 

To group data in a report 

1. If available, in the Demographics section of the Grouping tab select up to three fields for 
your first level of grouping. 

2. If available, in the Product section select a second level of grouping. The selections here 
will depend on the report you are running. 

3. For breakdown and trend reports, in the Count By section select the field by which you 
want to count items. For other reports, select a third level of grouping if you want. 

4. In the Page Break On section, select the field that you always want to start on a new page. 
(The fields available here depend on your selections in step 1 for the first level of 
grouping.) The default is None (for no specific page break). 

Filtering Tab 

The Filtering tab of the Configure Report dialog gives you the option of narrowing down 
the amount of data in the report by setting up a filter. A filter ensures that only some data 
is included in the report. Without a filter, ZENworks Asset Management will include all 
relevant data in the report. For example, you can set up a filter to include only data 
associated with particular departments or sites. 

NOTE: Workstation upgrade reports, component trend reports, and component breakdown reports all require a filter; 
for other reports, a filter is optional. 

The process of defining a filter for a report is very similar to defining a query. You set up 
a criterion by selecting a field, an operator, and a value, for example, Department = 
Engineering. The fields, operators, and values that you can select are determined by the 
type of report you are running. 
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You can have several criteria in your filter and use AND or OR to indicate their 
relationships. AND means that both criteria have to be met. For example, Department = 
Engineering AND Site = New York means that ZENworks Asset Management will 
include data in the report only if both criteria are met. For the data to be displayed, the 
workstations must be in the Engineering department and at the New York site. 

If, on the other hand, the criteria are combined with OR, either criterion can be met for 
data to be included in the report. For example, Department = Engineering OR 
Department = Sales means that ZENworks Asset Management will include any data in 
the report that applies to workstations in either the Engineering or the Sales department. 

In addition, you can use parentheses to group criteria logically, for example, (Site = New 
York AND Department = Sales) OR (Site = Atlanta AND Department = Sales). Here 
ZENworks Asset Management will include any data in the report that applies either to 
workstations that are in the Sales Department and New York or to workstations that are 
in the Sales Department and Atlanta.  

To filter data in a report 

1. (Optional) Enter a description of the filter. This will appear at the top of each page so you 
know how data is filtered in the report. 

2. If you are planning to group some criteria, select ( in the column labeled (. 
3. In the Field column, select the field on which you want to filter, for example, Subcategory 

Name. The available selections depend on the type of report you are running. 
 
 NOTE: If you are running a Workstation Hardware Upgrade or Software Upgrade report, 
you can select Contains Component as the field. If you do, ZENworks Asset Management 
Manager will display a Contains Component dialog which requires another level of filtering. 

4. In the column, select an operator:  
= (equal to) 
> (greater than) 
< (less than) 
>= (greater than or equal to) 
<= (less than or equal to) 
!=  (not equal to) 
Starts with (text that starts with) 
!Start with (text that does not start with) 
Contains (text that includes) 
!Contains (text that does not include) 
 
NOTE: The "starts with" and "contains" operators are particularly helpful in finding values. 

5. In the Value column, enter or select the value for which you are testing, for example, Hard 
Drive.  
 
In some cases you have a choice of typing data or clicking on the browse button so you can 
select a value. In this case, clicking on the browse button will display the Browse Database 
Fields dialog in which you can find and select a value. 
 
In other cases you must click on the browse button. Doing so will display a "Browse for" 
dialog, for example, Browse for User or Browse for Product. Here you need to find the 
item you want.  
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6. If you selected an open parenthesis in step 2, and the criterion in this row represents the 
end of your group of criteria, select ) in the column labeled ). (The Manager will check for 
pairs of parentheses.) 

7. Unless this is your last or only criterion, select AND or OR in the Combine column to 
indicate the relationship between the criterion you have just defined and the one that will 
follow in the next row. 

8. Check the criteria to make sure you have combined them the way you want. Do any of the 
following to make corrections:  

 To insert a blank row above the current row, click on the Insert Row button.  
 To delete a row, click on the Clear Row button.  
 To clear all the rows in the Define Filter Criteria section, click on the Clear All button 

Sorting Tab 

The Sorting tab of the Configure Report dialog lets you sort the data in a report by up to 
five fields in either ascending or descending order. The fields by which you can sort will 
depend on the type of report you are running. Not all reports can be sorted.  

To sort data in a report 

1. On the Sorting tab select a field in the Sort by row and then select Ascending or 
Descending. Ascending order results in items listed by numbers first and then from A to Z. 
Descending order results in items listed from Z to A and then by numbers. 

2. To sort by any additional fields, select a field in a "Then Sort by" row and select Ascending 
or Descending. 

Options Tab 

The Options tab of the Configure Report dialog lets you specify what the report header 
and footer page should contain. Each report has a first page called the header page. This 
page automatically includes a logo supplied by Novell, but you can replace this with your 
own company logo. The header page also includes certain pieces of information about the 
report such as the report title and description, the date it was created, the filter being used, 
and the name of the user who ran the report. You can choose not to include the header 
page at all or to include only some items on it.  

Some reports also include a report footer that is placed on the last page of the report to 
show, for example, grand totals or graphs of grand totals in breakdown and trend reports. 
You can choose not to include the footer information on the last page of a report.  

To change report header page and footer page options 

1. If you want to include your own company logo in reports, create the logo. 
2. If you do not want the report to include the header page, clear the Display Report Header 

Page check box on the Options tab. Doing so clears all the check boxes in that section. (By 
selecting the Display Report Header Page check box again you select all the check boxes in 
that section.) 

3. If you do not want the report header page to include certain items, leave the Display 
Report Header Page check box selected, but clear the check boxes of the items you do not 
want. 

4. If you do not want the report to include the footer information on the last page, clear the 
Display Report Footer Page check box. (This applies only to some reports.) 
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Submit Report 

The Submit Report dialog gives you a choice of two destinations for the report:  

 You can display the report on the screen. While viewing the report, you will have the option to print it, 
export it to a file, or attach it to e-mail. 

NOTE: If you plan to display the report, be sure you have set up a printer, or the report will not display correctly. 
(Crystal Reports requires a printer to be set up.) See the Windows Help system for details of setting up a printer. 

 You can print the report without first displaying it. In this case, you have the option of scheduling the report 
and selecting a specific printer for it.  

To display a report on the screen 

1. Select Screen as the report destination. 
2. Click on the OK button.  

To print a report directly 

1. Select Printer as the report destination. 
2. Select a printer. Printers are associated with Task Servers so you will have access to any 

printer that is associated with a public Task Server or with a Task Server in your Collection 
Domains. 
 
a) Click on the browse button in the Target Printer box. 
b) In the Select Printer dialog, select a public or domain-level printer. Then click on the 
OK button. 
 
NOTE: The printers listed are those associated with the machines on which you have 
installed your Task Servers (and to which you have access). For setting up additional 
printers on your Task Server machines, see your Windows documentation. 

3. Select a number of copies if you want more than one. 
4. To schedule the printing of the report, click on the Schedule button. If you do not schedule 

the report, ZENworks Asset Management will print it as soon as it can, depending on other 
tasks taking place. 

5. Click on the OK button to submit the report.  

TIPS 

 If you add or delete a printer on a Task Server, you must stop and re-start the Task Server service before the 
change is reflected in ZENworks Asset Management. If you rename a printer, you must also stop and re-start 
the service, or a print task will fail. (To stop the service, in the Control Panel in Windows NT, double-click on 
Services; in Windows 2000/XP, double-click on Administrative Tools and then Services. Select ZENworks Asset 
Management Task Server and click on the Stop button. To re-start the service, select it and click on the Start 
button.) 

 Once you submit a report for printing, it becomes part of the task queue. You can track its status on the 
Tasks tab of the process control panel. (A report whose destination is the screen will not appear on the Tasks 
tab.)  
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Report Save As 

1. Enter a name for the report. 
2. Select a folder for the report in your Personal Reports container. If you do not select a 

folder, ZENworks Asset Management Manager will save the report in the container. 
3. Click on the OK button. 

Import Custom Report 

The Import Custom Report dialog lets you import a custom report template into 
ZENworks Asset Management so you can run the report from ZENworks Asset 
Management Manager. (Be sure you have removed the database owner prefix in Crystal 
Reports.) 

To import a custom report 

1. In the Report Name box, enter the name you want to give the report. (The name must be 
unique within a folder.) This name will appear on the Report locator tab as well as in the 
title bar when you are viewing the report on the screen. 

2. In the Template box, specify the name and location of the template you want to import. 
Use the Browse button to help you. 

3. To save the custom report in a specific folder in the Personal Reports container, select the 
folder. 

4. Click on the OK button. 

See Also 

Using an Imported Report  

Select Printer 

The Select Printer dialog lets you select the printer for the report. Any printers in the 
Public Printers container are associated with your public Task Servers; those in a domain 
Printers container are associated with your domain-level Task Servers. 

NOTE: The printers listed in this dialog are those associated with the machines on which you have installed your Task 
Servers (and to which you have access). For setting up additional printers on your Task Server machines, see your 
Windows documentation. 

To select a printer 

1. Select a printer either from the Public Printers container or a domain Printers container. 
2. Click on the OK button. 

 
NOTE: If you add or delete a printer on a Task Server, you must stop and re-start the Task 
Server service before the change is reflected in ZENworks Asset Management. If you 
rename a printer, you must also stop and re-start the service, or a print task will fail. (To 
stop the service, in the Control Panel in Windows NT, double-click on Services; in Windows 
2000/XP, double-click on Administrative Tools and then Services. Select ZENworks Asset 
Management Task Server and click on the Stop button. To re-start the service, select it and 
click on the Start button.) 
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Viewing a Report 
If you selected the screen as the destination for a report when you submitted it, a Crystal 
Reports view utility will display the first page of data on the screen. 

NOTE: If you have not set up a printer with Windows, the report will not display correctly. See the Windows Help 
system for details of setting up a printer. 

With the report viewer utility you can: 

 Click on   or   to view the next or previous page. 

 Click on   or   to view the first or last page. 

 Click on   to print the report. 

 Click on   to refresh data. 

 Click on   to export the report (for example, to PDF format) or to attach it to e-mail. 

 Use   to change the size of the report display. 

 Click on   to display a Preview locator tab on the left of the window which lets you get to a particular 
part of the report by expanding and selecting the information in the locator tab. For example, in a Hardware 
Product Breakdown report, you could expand Monitor and then Color, and then select AST to view the AST 
records in the report. 

 Click on   to display the Search dialog so you can find particular text in the report. 

Copying a Report 
None of the reports in the ZENworks Asset Management Reports container can be 
changed permanently in any way, but you can copy any of these reports to your Personal 
Reports container. In addition, if you are an enterprise administrator, you can copy any 
ZENworks Asset Management report to the Public Reports container. Similarly, unless 
you are an enterprise administrator you cannot change a report in the Public Reports 
container, but you can copy it to your Personal Reports container. Once you have copied 
a report you can change it as you please and make additional copies of it. 

NOTE: You can always make temporary changes to a report in the ZENworks Asset Management Reports container, you 
just cannot save those changes as part of the original report. You can, however, save the changed report in your 
Personal Reports container. By saving your changes as another report you leave the original report as it was. 

To copy a report 

You can copy a report on the Report locator tab in one of the following ways: 

 Use the right mouse button to drag the report to a folder in your Personal Reports container (or in the Public 
Reports container if you are an enterprise administrator). Then click on Copy Here on the menu that appears.  

 Select the report and click on   on the toolbar. Then select a folder in your Personal Reports container 

(or in the Public Reports container if you are an enterprise administrator) and click on .  
 Right-click on the report and click on Copy on the shortcut menu. Then right-click on a folder in the Personal 

Reports container (or in the Public Reports container if you are an enterprise administrator) and click on 
Paste on the shortcut menu.  

 Select the report, click on the Edit menu, and click on Copy. Then select a folder in your Personal Reports 
container (or in the Public Reports container if you are an enterprise administrator), click on the Edit menu, 
and click on Paste. 



ZENworks Asset Management User's Guide 

166 

When you open the copied report and make changes to it, you will be able to save the 
changes for future use. 

Renaming a Report 
All ZENworks Asset Management users can change the names of reports in their 
Personal Reports container. In addition, an enterprise administrator can rename reports in 
the Public Reports container. No user can rename any of the reports supplied by Novell in 
the ZENworks Asset Management Reports container. 

To rename a report 

1. On the Report locator tab, do one of the following to rename a report:  
 Right-click on the report and click on Rename on the shortcut menu. 
 Select a report, click on the File menu, and click on Rename. 

2. In the Rename Report dialog, enter a different name for the report and click on the OK 
button. 

Promoting a Report 
If you are an enterprise administrator you can make a report in your Personal Reports 
container available to all ZENworks Asset Management users by promoting it to the 
Public Reports container. For example, if you have spent some time setting up a report 
that others would find useful, consider promoting it so they can take advantage of it.  

To promote a report 

Do one of the following to promote a personal report: 

 Use the right mouse button to drag the report to the Public Reports container. Then click on Move Here on 
the menu that appears. 

 Right-click on the report and click on Promote on the shortcut menu. 
 Select the report, click on the File menu, and click on Promote. 
 Drag the report to the Public Reports container. 
 Cut and paste the report using either the Edit menu or shortcut menu. 

TIP 

 If you are not the only enterprise administrator in your environment, consider keeping a copy of reports that 
you promote in your Personal Reports container. You could then restore a promoted report if another 
enterprise administrator inadvertently changed or deleted it.  

Deleting a Report 
All ZENworks Asset Management users can delete reports in their Personal Reports 
container. In addition, an enterprise administrator can delete reports in the Public Reports 
container. No user can delete any of the reports supplied by Novell in the ZENworks 
Asset Management Reports container. 
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To delete a report 

1. On the Report locator tab, do one of the following to delete a report:  

 Select the report and click   on the toolbar. 
 Right-click on the report and click on Delete on the shortcut menu. 
 Select the report, click on the File menu, and click on Delete. 

2. Confirm the deletion. 

Submitting a Report 
After you finish specifying all your report settings, you can submit the report task so that 
it runs according to your instructions. When you submit a report, you have two choices: 

 You can display the report on the screen. While viewing the report, you will have the option to print it, 
export it to a file, or attach it to e-mail. 

NOTE: If you plan to display the report, be sure you have set up a printer, or the report will not display correctly. 
(Crystal Reports requires a printer to be set up.) See the Windows Help system for details of setting up a printer. 

 You can print the report without first displaying it. In this case, you have the option of scheduling the report 
and selecting a specific printer for it.  

To display a report on the screen 

1. In the Configure Report dialog, click on the Submit button. 
2. Select Screen and click on the OK button. Then look at the report on the screen.  

To print a report directly 

1. In the Configure Report dialog, click on the Submit button. 
2. Select Printer as the report destination. 
3. Select a printer. Printers are associated with Task Servers so you will have access to any 

printer that is associated with a public Task Server or with a Task Server in your Collection 
Domains.  
 
a) Click on the browse button in the Target Printer box. 
b) In the Select Printer dialog, select a public or domain-level printer. Then click on the 
OK button. 
 
NOTE: The printers listed are those associated with the machines on which you have 
installed your Task Servers (and to which you have access). For setting up additional 
printers on your Task Server machines, see your Windows documentation. 

4. Select a number of copies if you want more than one. 
5. To schedule the printing of the report, click on the Schedule button. If you do not schedule 

the report, ZENworks Asset Management will print it as soon as it can, depending on other 
tasks taking place. 

6. Click on the OK button to submit the report.  
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TIP 

 If you add or delete a printer on a Task Server, you must stop and re-start the Task Server service before the 
change is reflected in ZENworks Asset Management. If you rename a printer, you must also stop and re-start 
the service, or a print task will fail. (To stop the service, in the Control Panel in Windows NT, double-click on 
Services; in Windows 2000/XP, double-click on Administrative Tools and then Services. Select ZENworks Asset 
Management Task Server and click on the Stop button. To re-start the service, select it and click on the Start 
button.) 

Once you submit a report for printing, it becomes part of the task queue. You can track its 
status on the Tasks tab in the process control panel. (A report whose destination is the 
screen will not appear on the Tasks tab.)  

Exporting a Report 
After you display a report on the screen, you can export it to a file for use with other 
products. A wide selection of export formats is available, for example, Acrobat PDF, 
comma-separated values (CSV), HTML, Data Interchange Format (DIF), Paginated Files, 
Excel, or Lotus 1-2-3. 

Note: The ability to export a report to a particular format depends on Seagate’s Crystal Reports. In particular, 
Workstation Detail Reports and Workstation Change History Reports are limited to the following formats: PDF, RTF, 
Word, Text, Paginated Text, HTML Standard, HTML Extended, HTML Draft, Excel Standard, Excel Extended Non-
Tabular, and Excel Extended Tabular. (For any Excel format the Column Headings check box in the Formats Option 
dialog must also be clear.) Other export format limitations may apply. 

To export a report 

1. While viewing a report, click on the Export button on the viewer toolbar. 
2. In the Export dialog, do the following:  

a. Select an output format. 
b. Select Disk File in the Destination box 
c. Click on the OK button. Depending on the format you selected, the dialogs you will 

need to complete will vary. 
3. If you chose Character-Separated Values in Step 2a, complete the Character-Separated 

Values dialog:  
a. In the Separator box, enter the character you want to use to separate fields, for 

example, , (comma). 
b. In the Delimiter box, enter ‘ or " to indicate whether you want to enclose 

alphanumeric values within single or double quotes. 
c. Click on the OK button. 

4. If it is displayed, complete the Number and Date Format dialog as follows:  
a. Select the appropriate check box if you want to export either numeric data or dates in 

the same format as they appear in your report. If you leave these check boxes clear, 
numbers and dates will appear in the default Windows display format. 

b. Click on the OK button. 
5. If you selected one of the Excel Extended formats in step 2a, complete the Format Options 

dialog:  
a. Select the Column Headings check box to include column headings. 
b. If you do not want subtotal fields represented by worksheet functions, clear the Use 

worksheet functions check box. 
c. Choose between a constant column width or one based on the width of particular 

objects. 
d. Choose between a tabular and non-tabular format. 
e. Click on the OK button. 

6. If you selected the Paginated Text format in step 2a, complete the Lines Per Page dialog:  
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a. Enter the number of lines you want per page. If you do not want to paginate, enter 0. 
b. Click on the OK button. 

7. The dialog you complete next depends on the format you selected: 
 If you selected a format other than HTML, complete the Choose Export File. Use standard 

Windows controls to specify a file for your exported data and click on the Save button to 
start the export. 

 If you selected an HTML format, complete the Export to Directory dialog and click on the 
OK button. HTML exporting can produce multiple files so you must specify the name of a 
folder for these files. Novell recommends that you specify an empty or new folder. 

The report will now be exported to the file or folder you specified. 

Tip 

Crystal Reports will assign an extension to files you export. The extension depends on the format you selected, for 
example, .chr for character separated format. The program into which you import the data may look for a different 
extension. Consult the documentation for the destination program to determine the correct file extension and, if 
necessary, change the extension accordingly. 

Creating a Custom Report 
If you have defined your own fields and want them to appear in reports, you can create 
your own reports using Crystal Reports and the information in ZENworks Asset 
Management Database Tables. 

CAUTION: Do not edit the report templates supplied by Novell. If you do, the reports will no longer run. 

To help you create your own reports, Novell includes two templates (Portrait.rpt and 
Landscape.rpt) that reside in the \Bin\Reports folder of your ZENworks Asset 
Management installation folder. These templates mimic the layout used in ZENworks 
Asset Management report and thus offer a convenient starting point for creating your own 
reports. (You can, of course, create your own templates from scratch.) 

Once you have created your custom report templates, you have the option of importing 
them into ZENworks Asset Management. You will then be able to run the reports from 
ZENworks Asset Management Manager. 

The report templates in ZENworks Asset Management are based on Crystal Reports 8.5. 
Novell recommends that you use this version of Crystal Reports to create your templates 
if you are planning to import them; doing so will ensure the reports run correctly from the 
Manager. You should, however, be able to run reports successfully based on an earlier 
version of Crystal Reports.  

CAUTION: When you create a report template in Crystal Reports developer studio, a database owner prefix is added to 
each table used in the report. You must remove this prefix if you want to run the report against a database other than 
the one you used to create the report. Use the procedure that follows to remove the prefix. 

To remove the database owner prefix 

1. When you have the template open in the Crystal Reports developer studio, click on the 
Database menu and click on Set Location. 

2. In the Set Location dialog, select a table in the Databases box, for example, 
NC_Workstation. 
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3. In the Table box, delete the information that precedes the table name. For example, if 
the Table box includes JoeOwner.dbo.NC_Workstation, delete all the information that 
precedes NC_Workstation, that is, JoeOwner.dbo. 

4. Repeat steps 2 and 3 for each table listed. 
5. Click on the Done button to save your changes. 

See Also 

Importing a Report into ZENworks Asset Management Manager  

Using an Imported Report  

Importing a Report into ZENworks Asset Management Manager 
Once you have created your custom report templates, you can import them into the 
Manager. (Be sure you have removed the database owner prefix.) To import a custom 
report, you must be an enterprise administrator and be in the Personal Reports container 
on the Report locator tab. (You do not need to save your report templates in a particular 
folder; you will be able to browse for them during the import procedure.) 

To import a report into the Manager 

1. In the Manager, select the Personal Reports container on the Report locator tab (or select 
a folder in that container). 

2. Do one of the following to start the import process:  
 Right-click and then click on Import Report on the shortcut menu. 
 Click on the File menu and then click on Import Report. 

3. Complete the Import Custom Report dialog: 
 
a) In the Report Name box, enter the name you want to give the report. (The name must 
be unique within a folder.) This name will appear on the Report locator tab as well as in 
the title bar when you are viewing the report on the screen. 
b) In the Template Path box, specify the path to the template you want to import. Use the 
Browse button to help you. 
c) To save the custom report in a specific folder in the Personal Reports container, select 
the folder. 
d) Click on the OK button. 

See Also 

Using an Imported Report  

Using an Imported Report 
Custom reports are always imported into an enterprise administrator's Personal Reports 
container. The administrator then has the option of promoting the report to the Public 
Reports container so that it is available to the entire enterprise. 

NOTE: Once a custom report has been promoted, it cannot be demoted back to the Personal Reports container. 

When you run a custom report, you will not be able to change any settings in the report 
(for example, on the Grouping, Filtering, or Sorting tabs). Otherwise, the procedure for 
generating the report is the same as for generating any other ZENworks Asset 
Management report in terms of submitting it, scheduling it, or viewing it. 
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TIP 

 If you need to change a custom report template, you must edit the template with Crystal Reports and then 
re-import it to the Personal Reports container. (A report must have a unique name within its folder in 
ZENworks Asset Management so either delete the original report or give the report that you are re-importing 
a different name.) 

Using Your Own Logo in Reports 
The header page of each report automatically includes a logo supplied by Novell. A logo 
also appears on each subsequent page of the report. You can replace either of these logos 
with your own company logos, using a different image for the header page and for the 
report pages. 

  

Five Logo files are installed with ZENworks Asset Management:  

Filename Description 

rhLogo.bmp Appears on the header page of the report. Replace this file 
with your header page logo. 

phLogo.bmp Appears on each page of the report. Replace this file with 
your page logo. 

rhCustom.bmp Bitmap template for header page logo. This template is 
sized as large as possible without obscuring parts of the 
report. 

phCustom.bmp Bitmap template for page logo. This template is sized as 
large as possible without obscuring parts of the report. 

TallyIcon.bmp Original Tally Systems logo. Replace rhLogo.bmp or 
phLogo.bmp with this file if you want to restore the 
default Novell logo to your reports. 

  

To use your own logo in reports 

1. Create a bit map for your logo that is no larger than rhCustom.bmp or phCustom.bmp (172 
pixels wide by 64 pixels high.) 

2. Name the bit map rhLogo.bmp (for the header page) or phLogo.bmp (for each page) and 
save it in the \Bin\Reports folder in your ZENworks Asset Management installation folder. 
Confirm that you want to replace the rhLogo.bmp or phLogo.bmp file provided by Novell. 
ZENworks Asset Management will automatically use the contents of rhLogo.bmp on the 
header page and phLogo.bmp on each remaining page. 

TIPS 
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 To prevent a logo from appearing on the header page, or on the remaining pages, delete or rename the 
appropriate file. 

 If you do not want any logo to appear on reports, clear the Company Logo check box on the Options tab of 
the Configure Report dialog box. 

 If for any reason you need to restore either of the Novell logos, a backup copy exists in \Bin\Reports as 
TallyIcon.bmp. Make a copy of this file (so you still have a backup) and rename it rhLogo.bmp. or 
phLogo.bmp. 

Attaching a Report to E-Mail 
While viewing a report, you have the option of attaching the report to e-mail. You have 
the same choice of formats for the report as when exporting a report, for example, 
comma-separated values (CSV), HTML, Data Interchange Format (DIF), or Excel. 

To attach a report to e-mail 

1. While viewing a report, click on the Export button on the viewer toolbar. 
2. In the Export dialog, do the following:  

a. Select an output format. 
b. Select an e-mail application in the Destination box, for example, Exchange Folder or 

Microsoft Mail (MAPI). Exchange Folder exports a file to a specified Exchange folder; 
MAPI sends an e-mail message with the report as an attachment. 
Note: MAPI must be active, or no message will be sent. 

c. Click on the OK button. 
3. Depending on the format you selected, complete the dialogs as described in Exporting a 

Report.  
4. If you selected an HTML format, complete the Export to Directory dialog and click on the 

OK button. HTML exporting can produce multiple files so you must specify the name of a 
folder for these files. 

5. If you selected MAPI in the Destination box (step 2b), complete the Send Mail dialog:  
a. Select the individual(s) to whom you are going to send the report. 
b. Enter any message you want to include with the report. 
c. Send the message.  

A record counter will indicate the progress of the mail transfer. 

6. If you selected Exchange Folder in the Destination box (step 2b), do the following: 

a. Complete the Choose Profile dialog by selecting the person to whom you are 
going to send the report in the Profile Name box. (You must have access to this 
person’s inbox for the export to be successful.) If no account exists for the 
person, click on the New button and complete the wizard as directed. Then set 
any options you want. For example, if you are going to send reports to this 
person routinely, you can make the profile you selected the default profile. Click 
on the OK button when done. 

b. If the mail system is not open, log on when prompted. 

c. In the Select a Folder dialog, select the mail folder in which you want the report 
file to reside, for example, Inbox. 

d. Click on the OK button to send the file. A record counter will indicate the progress of 
the mail transfer. 
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Queries 

About Queries 
A query is a set of criteria that ZENworks Asset Management Manager uses to find 
specific data in the inventory database and display it on the screen. You can then review 
the data and change it if necessary. A query is the only way you can gain access to 
inventory data so you can edit it. 

Each query can consist of one or more filter criteria that narrow down the data you want 
to see. For example, you may want to see the workstations just for the Chicago site, not 
any other sites, or see the components for all the workstations in the Sales Department. A 
query lets you do this. 

ZENworks Asset Management includes five types of query: 

 Workstation queries locate workstation-related data, for example, all the workstations in the Accounting 
department or all workstations for whom the technical contact is Josh Cohen. You can also use workstation 
queries to find information about stockrooms and about the Lost and Found .  

 Component queries locate component-related data, for example, all the components installed on 
workstations in the Accounting Department or all the components that are hard drives smaller than 1 GB.  

 Product queries locate product-related data (including local products ), for example, all the products in the 
accounting product category or all products used in the Engineering department.  

 User queries locate data pertaining to workstation users, for example, all users with the last name of Smith.  
 FNI queries locate files-not-identified data, for example, all the FNIs that may be drivers or all the FNIs 

associated with the Accounting department.  

The ZENworks Asset Management Queries container on the Query locator tab includes a 
number of pre-defined queries to help you get started. The Query locator tab is also the 
starting point for activities you perform with queries.  

See Also 

Creating a Query  

Using a Query  

Sample Queries  

Database Structure and Queries  
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Database Structure and Queries 
Although you do not need to know how information is organized in the ZENworks Asset 
Management inventory database to run queries, knowing something about its structure 
may help you understand why certain queries need to be constructed a particular way.  

Each type of query corresponds to an "object" in the inventory database: workstation, 
component, product, user, or FNI. Each such object, in turn, has fields associated with it. 
The fields include standard information about the object, as the table below shows. For 
more details about each object and its underlying data structures, see ZENworks Asset 
Management Database Tables. 

Workstation 
Asset Tag 
Building 
Check In/Out Time 
Checked Out 
Cost Center 
Create Date 
Default Gateway 
Department 
Floor 
Free Disk Space 
IP Address 
Inventory Type 
LAN Address 
Last Successful Load 
Date 
Last Successful Scan 
Date 
Last Usage Date 
Lease Contract ID 
Lease Expiration Date 
Leased 
Login Name 
Machine Name 
NetCensus Config ID 
Phone 
Room 
Serial Number 
Site 
Subnet Mask 
Total Disk Space 
Total Memory 

Component * 
Asset Tag 
Component Source 
Model Number 
Serial Number 

Product 
Date Created 
Language 
Last Modified 
License Count 
License ID 
License Name 
License Required 
Manufacturer 
Model/Version 
Platform 
Product Name 
Product Source 
Product Type 

User ** 
Email 
Fax 
First Name 
Last Name 
Middle Name 
Phone 
Second Phone 

FNI 
File Date 
File Extension 
File Name 
File Size (Bytes) 
Startup Count 
Subdirectory 
Total Active (sec) 
Total Runtime (sec) 
VRB Company Name 
VRB File Version 
VRB Language 
VRB Product Name 
VRB Product Version 

  

* This is the basic data common to all components. Additional data is available for specific types of components. For 
example, a modem has information about a communications port; software has path information. The database tables. 
are a good reference for these extended fields. 

** A user may be the primary user of a workstation or the technical contact person for a workstation. 

In addition to the fields shown above, there may be user-defined fields you can query. See About User-Defined Fields 
for information. 

As you can see from the preceding lists, the choice of fields for a particular type of query may be extensive. Your field 
selection in turn determines how you can specify a value for the criterion. 
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Creating a Query 
The queries supplied by Novell in the ZENworks Asset Management Queries container 
are generic queries to help you get started. You are likely, however, to need additional 
queries to locate specific data such as that associated with a particular department or 
product. In this case you will need to create your own query from scratch. 

TIPS 

 When you create a query you must indicate what type of query you want to create: workstation, component, 
product, user, or FNI. As you select the query type, keep in mind what you want to see as a result of the 
query. For example, to see which workstations include a particular component, create a workstation query; 
to see which printers are components of workstations in your enterprise, create a component query. 

 You can create queries from scratch only in your Personal Queries container. If you are an enterprise 
administrator you then have the option of placing one of your personal queries in the Public Queries 
container so it is available to everyone. 

 If you want to adapt and save an existing public or ZENworks Asset Management query, you can edit it and 
then save the changed query in your Personal Queries container. 

To create a query 

1. Either click on the Query locator tab or click on the View menu and click on Query. 
2. Do one of the following to create a query:  

 Select the Personal Queries container or a folder in this container; click on   on the toolbar; and 
then click on Workstation Query, Component Query, Product Query, User Query, or FNI Query. 

 Right-click on the Personal Queries container or a folder in this container; click on New on the shortcut 
menu; and then click on Workstation Query, Component Query, Product Query, User Query, or FNI 
Query. 

 Select the Personal Queries container or a folder in this container; click on the File menu; click on New; 
and then click on Workstation Query, Component Query, Product Query, User Query, or FNI Query. 

ZENworks Asset Management Manager will now display the two-window query tool in the 
workspace alongside the Query locator tab. 

3. Set up the criteria for the query on the Filter tab.  
4. To customize the display of the results, click on the Layout tab.  
5. To try the query, click on the Display Results button on the Filter tab. 
6. When satisfied with the results you are getting, save the query: 

 

a) Either click on   on the toolbar or click on the File menu and click on Save or on Save 
As. 
b) In the Save Query As dialog, enter a name for the query. The name must be unique 
within the folder (or container). 
c) (Optional) Select a folder for the query if you want a folder other than the one listed in 
the Folder box. If no folders exist, the Manager will store the query in your Personal 
Queries container. 
d) Click on the OK button. 

See Also 

About Queries  

Creating Query Folders  
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Filter Tab 

The Filter tab in the query window lets you define criteria for locating data in the 
inventory database. If you do not define a filter and click on the Display Results button 
on the Filter tab, ZENworks Asset Management Manager will display all the possible 
data as specified on the Layout tab in the query window. The amount of data may be 
considerable. 

To set up a query filter 

1. If you are planning to group some criteria by using parentheses, select ( in the column 
labeled (.  

2. Select the field on which you want to filter by doing the following: 
 
a) Click on a cell in the Field column. 
b) Click on the right arrow in the cell to display a menu of available fields. 
c) Make a selection from the menu that appears, for example, Site or Contains Component. 
You may need to go through a series of menus to find the field you want. The available 
selections depend on the type of query you are defining. The selections on the menus 
appear in alphabetical order except for any selections that result in a "Contains" dialog, for 
example, Contains Component or Contains FNI. These selections are listed at the bottom of 
the menu. 
 
NOTE: If the menu of fields offers a choice such as Primary User or Primary User Fields, 
select Primary User if you want to find a user by specifying more than one criterion, for 
example, last name and e-mail address; select Primary User Fields if you want to find a 
user with a single criterion, for example, phone number.  

3. If the Manager displays an additional dialog such as Contains Component Software or 
Contains FNI, complete the dialog and proceed to step 6.  

4. In the Operator column, select an operator:  
 
= (equal to) 
> (greater than) 
< (less than) 
>=  (greater than or equal to) 
<=  (less than or equal to) 
!=  (not equal to) 
Contains  (text that includes) 
!Contains  (text that does not include) 
Starts with  (text that starts with) 
!Start with  (text that does not start with) 
 
NOTE: The operators that are available depend on the field you selected in step 2. 

5. Click on the Value column and then enter or select the value for which you are testing, for 
example, New York. In some cases you have a choice of typing a value or clicking on the 
browse button to display the Browse Database Fields dialog. If you display this dialog, 
select a value in it and click on OK. 
 
In some cases, your only option in the Value column is to click on the browse button. 
TheManager will then display a "Browse for" dialog, for example, Browse for Product. This 
type of dialog lets you provide further criteria to locate a value. After you have located 
and selected the value, the Manager will display it in the Value column on the Filter tab. 
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6. If you selected open parenthesis in step 1, and the criterion in this row represents the end 
of your group of criteria, select ) in the column labeled ). The Manager will check for 
matching pairs of parentheses. 
 
NOTE: You cannot nest parentheses. 

7. Unless this is the last or only criterion, select AND or OR in the Combine column to indicate 
the relationship between the criterion you have just defined and the one that will follow in 
the next row.  

8. Continue defining criteria as described in steps 1 to 7. When done, check the criteria to 
make sure you have set them up and combined them the way you want. Do any of the 
following to make changes:  

 To insert a blank row before the current row, click on the Insert Row button.  
 To delete the current row, click on the Clear Row button. 
 To clear all the rows in the Define Filter Criteria section, click on the Clear All button. 

9. (Optional) To find out how many items will meet your criteria, click on the Count button. 
This may take a while. 

10. To see the results of the query, click on the Displays Results button. 

TIP 

 In addition to using the mouse to navigate around the Filter tab, you can use the following shortcut keys: 
 Use Tab to move to the next cell. 
 Use Shift-Tab to move to the preceding cell. 
 Use Alt- in a cell to display a menu in the Field column; a drop-down list in the (, ), or Combine column; 

and the Browse Database Fields dialog in the Value column. 

Contains Dialog 

A "Contains" dialog lets you complete an advanced query that is referenced by another 
object in the database. The title of this dialog will reflect the kind of reference involved. 
For the sake of simplicity, the Help system uses the generic term "Contains" dialog. The 
process of completing this dialog is always the same.  

You need to define a further set of criteria in the "Contains" dialog. For example, if you 
selected Contains Component, you will need to indicate what the component must 
include to meet your criteria. The process of setting up a criterion in this dialog is 
identical to that on the Filter tab in the query window. 

To complete a "Contains" dialog 

1. Complete this dialog by setting up one or more additional criteria the same way as on the 
Filter tab of the query window.  
The first criterion will already be set for you based on the field you selected (and you will 
not be able to change this criterion). For example, if you are trying to find all workstations 
that include accounting software products, the first criterion may be set as Component 
Type = Software. 

2. Click on the OK button to return to the query window. 

The Value column in the query window will now include a summarized version of the 
criteria you defined in the "Contains" dialog. 
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Layout Tab 

The Layout tab in the query window lets you change which fields appear in the query 
results window and how they are sorted. 

By default, ZENworks Asset Management Manager displays certain columns of data 
when showing the results of a query. You have the option of changing what is displayed. 
For example, you can control which columns of data are displayed in the query results 
window, the order in which the columns appear, and how the data in the columns is 
sorted. You can also group data so that a value that appears in a number of records (such 
as a department name) appears only once. Any such customizing is saved as part of the 
query. 

The Selected Columns box on the Layout tab lists all the columns that will appear in the 
query results window. For each type of query, a certain set of columns is selected by 
default. The Available Columns box includes all the columns that you can display for a 
particular type of query. 

To customize the query results window 

1. Review the possibilities in the Available Columns box. If an item is preceded by +, click on 
the + to expand the list of available columns. For example, if you expand the list for 
Technical Contact Field(s), you can then choose among items such as last name, phone, or 
e-mail. 

2. If an item is not preceded by a +, add it to the Selected Columns box in any of the 
following ways:  

 Double-click on it in the Available Columns box. 
 Select it and click on the Add button. 
 Drag it to the Selected Columns box. 

3. If an item is preceded by a +, and you select it for display, the Manager will display one of 
the following in the query results window:  

Listed in Available Columns As Displayed in Query Results Window As 

Primary User Field(s) First name, middle name, last name 
(concatenated in a single cell) 

Technical Contact Field(s) First name, middle name, last name 
(concatenated in a single cell) 

Collection Server Field(s) Collection Server name  

Domain Domain name 

Product Field(s) Manufacturer, product name, 
model/version (concatenated in one cell) 

Workstation Field(s) Machine name 

Classification Product type, category, subcategory 
(concatenated in one cell) 

Category Product category name 

4.  To add an item preceded by a + to the Selected Columns box, do one of the following:  
 Select it and click on the Add button. 
 Drag it to the Selected Columns box. 
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5. To move all the columns to the Selected Columns box, click on the Add All button. 
6. To remove a column from the Selected Columns box, do one of the following:  

 Double-click on the column name in the Selected Columns box. 
 Select the column and click on the Remove button. 
 Drag the column to the Available Columns box. 
 To move all the columns to the Available Columns box, click on the Remove All button. 

7. To change the position in which a column appears in the query results window, either drag 
the column up or down in the Selected Columns box or select the column and use an arrow 
button to move it up or down in the list. The column at the top of the list corresponds to 
the first column in the query results window. 

8. To control how data is sorted in the query results window, click on the Sort button and 
complete the Sort Columns dialog. 

Query Results Window 

The query results window is the bottom window in the query tool which shows the results 
of a query. After you display or create a query on the Filter tab of the query window (the 
top window of the query tool) and click on the Display Results button, ZENworks Asset 
Management Manager will display any data that matched your criteria in the query 
results window. You can then review and change the data. 

See Also 

Customizing the Query Results Window  

Displaying Inventory Data  

Creating a Query  

Editing Inventory Data  

Customizing the Query Results Window 

By default, ZENworks Asset Management Manager displays certain columns of data 
when showing the results of a query. You have the option of changing what ZENworks 
Asset Management displays. For example, you can control which columns of data are 
displayed in the query results window, the order in which the columns appear, and how 
the data in the columns is sorted. You can also group data so that a value that appears in a 
number of records (such as a department name) appears only once. Any such customizing 
is saved as part of the query. 

To customize the query results window 

 In the query window, click on the Layout tab. The Selected Columns box on the 
Layout tab lists all the columns that will appear in the query results window. For 
each type of query, a certain set of columns is selected by default. The Available 
Columns box includes all the columns that you can display for a particular type of 
query.  

 Review the possibilities in the Available Columns box. If an item is preceded by +, 
click on the + to expand the list of available columns. For example, if you expand 
the list for Technical Contact Field(s), you can then choose among items such as 
last name, phone, or e-mail.  
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 If an item is not preceded by a +, add it to the Selected Columns box by doing any 
of the following:  

 Double-click on it in the Available Columns box. 
 Select it and click on the Add button. 
 Drag it to the Selected Columns box. 

 If an item is preceded by a +, and you select it for display, the Manager will display 
one of the following in the query results window:  

Listed in Available Columns As Displayed in Query Results Window As 

Primary User Field(s) First name, middle name, last name 
(concatenated in one cell) 

Technical Contact Field(s) First name, middle name, last name 
(concatenated in one cell) 

Collection Server Field(s) Collection Server name 

Domain Domain name 

Product Field(s) Manufacturer, product name, model/version 
(concatenated in one cell) 

Workstation Field(s) Machine name 

Classification Product type, category, subcategory 
(concatenated in one cell) 

Category Product category name 

 To add an item preceded by a + to the Selected Columns box, do one of the 
following:  

  
 Select it and click on the Add button. 
 Drag it to the Selected Columns box. 

 To move all the columns to the Selected Columns box, click on the Add All button. 
 To remove a column from the Selected Columns box, do one of the following:  

 Double-click on the column name in the Selected Columns box. 
 Select the column and click on the Remove button. 
 Drag the column to the Available Columns box. 
 To move all the columns to the Available Columns box, click on the 

Remove All button. 
 To change the position in which a column appears in the query results window, 

either drag the column up or down in the Selected Columns box or select the 
column and use an arrow button to move it up or down in the list. The column at 
the top of the list corresponds to the first column in the query results window. 

 To control how data is sorted in the query results window, do the following:  

 Click on the Sort button on the Layout tab. 
 To clear any existing settings, click on the Clear All button in the Sort 

Columns dialog. 
 Select the field by which you want to sort and select Ascending or 

Descending. 
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 To avoid having the same item appear multiple times in the column, 
select the Group By check box. For example, you may want a user 
name, workstation name, or manufacturer listed only once. 
 
Note: Grouping slows down the display of the query results slightly.  

 If you want to sort the data by any additional columns, complete the 
rows labeled Then Sort by. 

 Click on the OK button to return to the Layout tab. 
 In the query window, click on the Filter tab and then click on the Display Results 

button to see the results of the customizing you performed. 

Sort Columns 

The Sort Columns dialog lets you control how fields are sorted in the query results 
window or in the Query Results section of a "Browse for" dialog. 

1. To clear any existing settings, click on the Clear All button in the Sort Columns dialog. 
2. Select the field by which you want to sort and select Ascending or Descending. 
3. To avoid having the same item appear multiple times in the column, select the Group By 

check box. For example, you may want a user name, workstation name, or manufacturer 
listed only once.  
 
 NOTE: Grouping slows down the display of the query results slightly. 

4. If you want to sort the data by any additional columns, complete the rows labeled Then 
Sort by. 

5. Click on the OK button 

Save Query As 

1. Enter a name for the query. 
2. (Optional) Select a folder for the query if you want a folder other than the one listed in 

the Folder box. If no folders exist, ZENworks Asset Management Manager will store the 
query in the selected container. 

3. Click on the OK button. 

Creating Query Folders 

The Public Queries container and Personal Queries container initially have no folders. It 
is up to you to create folders for organizing any queries you define or copy from the 
ZENworks Asset Management Queries container. You can create as many folders as you 
like and name them as you like, but you cannot create folders inside other folders. If you 
choose not to create any folders, your queries will be stored in the container. 

Only an enterprise administrator can create folders in the Public Queries container; other 
users are restricted to their Personal Queries container. 
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To create a query folder 

1. Either click on the Query locator tab or click on the View menu and click on Query. 
2. Do one of the following:  

 Select the Public Queries container or Personal Queries container, click on   on the toolbar, and 
then click on Folder. 

 Right-click on the Public Queries or Personal Queries container, click on New on the shortcut menu, and 
then click on Folder.  

 Select the Public Queries container or Personal Queries container, click on the File menu, click on New, 
and then click on Folder.  

3. Enter a name for the folder in the Folder dialog and click on the OK button. The name 
must be unique within the container. 

See Also 

Creating a Query  

Displaying and Editing Inventory Data 
Using a Query to Display Inventory Data 

Any time you want to examine or edit data in the inventory database, you must use a 
query to find and display the data. After you have displayed the results of the query in the 
query results window, you can review and change the data. 

Using a query to display inventory data involves two steps: 

1. Displaying the query itself on the screen (or creating the query if it does not exist yet). 
2. Running the query to display the data that meets the criteria of the query. 

To use a query to display inventory data 

1. If a query does not exist for what you want to locate, create it. 
If a query exists, display it by doing one of the following on the Query locator tab:  

 Double-click on the query. 

 Select the query and click on   on the toolbar. 
 Right-click on the query and then click on Open on the shortcut menu. 
 Select the query, click on the File menu, and click on Open. 

2. Click on the Display Results button. The query results window will now list the data that 
met the criteria of the query.  

3. Review the results. 
4. If necessary, edit the data. 

See Also 

Finding Data in the Query Results Window  
Creating a Query  
Editing Inventory Data  
Exporting Inventory Data  
Printing a Query  
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Before You Edit Inventory Data 

At some point during an inventory cycle, you will probably want to look at some of the 
inventory data and make any necessary additions or corrections. The best time to do this 
is after all the data has been collected and before the next scheduled collection. Suppose 
that your collections are scheduled to take place every quarter during a one-week period. 
It is generally not a good idea to examine or edit inventory data during that one-week 
period because not all workstations may have been scanned yet. Once this one week is 
up, however, you can get a good picture of the inventory data that was collected. 

At the end of an inventory cycle you may want to start by running some reports to get an 
overall picture of the inventory data. For example, a workstation detail report gives you 
detailed information about a workstation. If some data in a report catches your eye, you 
can then locate it in the database by using a query. On the other hand, if you already 
know what kind of inventory data you want to review and possibly change, you may just 
want to start with a query rather than a report. 

In an Enterprise Deployment of ZENworks Asset Management, several users may be 
running queries and potentially changing data in the inventory database simultaneously. 
Although two users cannot change the same piece of data at exactly the same time, they 
can do so in rapid succession. As a result, something one ZENworks Asset Management 
user changes may be changed by another user a few minutes later. 

Tips 

 To avoid unnecessary (and possibly conflicting) changes to inventory data, you may want to establish some 
rules at your organization for how and when data should be edited. Such rules can help prevent one user 
from undoing the changes made by another.  

 When you make changes to inventory data, you may want to filter out any workstations from which you 
gathered data with a portable Collector. Edits to such workstations will be replaced by the contents of the 
workstation inventory files the next time you load the data from a portable collection. You can filter out 
these workstations by specifying an inventory type of "portable" in a workstation query. For more information 
about workstation queries, see About Workstation Queries. 

Finding Data 

If your query locates many records that match the criteria you specified, you may find it 
useful to search for a specific record. Each record is a row in the query results window. 
You can search by a value in a particular field, for example, Engineering in the 
Department field. In addition to searching for data in a query results window, you can 
search for data in a Component List window for a workstation.  

To find data 

1. When the query results window includes data, or when you are looking at a Component List 
window, select the row in which you want to start searching for a value. 
 
NOTE: ZENworks Asset Management Manager starts the search in the selected row and 
works downwards. It will not search above the current row. 

2. Click on   on the query toolbar or click on the Edit menu and click on Find. 
3. Select the field in which you want to find a value, for example, Department. 
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4. Select an operator. 
5. In the Value box, specify the value you want to locate in the field, for example, 

Engineering. Use the browse button to help you. Depending on your choice of field, the 
Manager may display the Browse Database Fields dialog or a "Browse for" dialog.  

6. (Optional) Select the Match case check box if you want the Manager to consider case when 
searching for the value. This check box applies only if the value you have specified is a 
simple text string. 

7. Click on the Find button. In the query results window or Component List window, the 
Manager will place a black border around the first cell that includes the field value you 
specified. 

8. (Optional) To find the next occurrence of the same field value, click on the Edit menu and 
click on Find Next. the Manager will continue the search downwards through the query 
results window or Component List window. 

Find 

The Find dialog lets you locate a value in the query results window or a Component List 
window for a workstation. In the Find dialog, you can search by a value in a particular 
field, for example, Engineering in the Department field.  

NOTE: ZENworks Asset Management Manager starts the search in the selected row and proceeds below the row. (It will 
not search above the current row.) 

To use the Find dialog 

1. Select the field in which you want to find a value, for example, Department. 
2. Select an operator. 
3. In the Value box, specify the value you want to locate in the field, for example, 

Engineering. Use the browse button to help you. Depending on your choice of field, the 
Manager may display a Browse for Database Fields dialog or a "Browse for" dialog in which 
you must select a value.  

4. (Optional) Select the Match case check box if you want the Manager to consider case when 
searching for the value. This check box applies only if the value you have specified is a 
simple text string. 

5. Click on the Find button. In the query results window or Component List window, the 
Manager will place a black border around the first cell that includes the field value you 
specified. 

6. (Optional) To find the next occurrence of the same field value, click on the Edit menu and 
click on Find Next. The Manager will continue the search downwards through the query 
results window. 

Editing Inventory Data 

Once you have located some data with a query, you can change it in the query results 
window. The methods available to you depend on the type of data you are trying to 
change as well as your ZENworks Asset Management user role.  

TIPS 

 Consider the timing of any editing you do in the context of the overall inventory cycle. For example, if you 
scan workstations twice a year for a week at a time, avoid editing inventory data during that week because it 
may be not be up-to-date. Also, ZENworks Asset Management will not let you edit any data associated with a 
workstation that is being scanned. 

 If a number of users at your organization can edit inventory data, you may want to set some rules for how 
this is done to prevent one user from undoing or editing the changes made by another. 
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 You may want to filter out any workstations from which you gathered data with a portable Collector, since 
any edits you make to these workstations are replaced by the contents of the workstation inventory files the 
next time you load the data from a portable collection. You can filter out these workstations by specifying an 
inventory type of "portable" in the Filter Tab of a workstation query. 

To edit inventory data 

What you can edit depends on the data you are trying to change and your ZENworks 
Asset Management user role.  

NOTE: If you try to make a change to a workstation that is currently being scanned, the Manager will inform you that 
the workstation is checked out, and that changes cannot be made to it. 

Edit data in one or more of the following ways: 

 Type the change directly in the cell. 
 Select a value from a drop-down list. 
 Click on the browse button and select a value from a Browse Database Fields dialog or "Browse for" dialog. 
 Use the find and replace feature. 
 Display an Edit Properties dialog in which you can make changes to any of the data associated with the item 

you are editing. (The query results window generally shows a subset of available data.) To display an Edit 
Properties dialog, do one of the following: 

 Double-click on the row number of the item for which you want additional information. 

 Click on the item’s row number and click on   on the query toolbar. 
 Right-click on a row number and then click on Edit on the shortcut menu. 
 Click on a row number, click on the Query menu, and click on Edit. 

See Also 

Saving Changes to Inventory Data  

Finding and Replacing Inventory Data  

Editing Component Data  

Editing Workstation Data  

Editing User Data  

Saving Changes to Inventory Data 

Generally you will not need to do anything explicit to save any changes you have made to 
inventory data. Any of the following will result in changes being saved: 

 Moving to another row in the query results window. 
 Saving the query. 
 Displaying an Edit Properties dialog for the row that includes the change. 
 Running the query again. 
 Using the Count button on the Filter tab of the query window. 
 Closing the query. 
 Exiting ZENworks Asset Management Manager. 
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Finding and Replacing Inventory Data 

At times you may want to find all the records in the query results window that share the 
same piece of data so that you can change it in all the records at the same time. You do so 
by indicating the value you want to find in a specific field and the value with which you 
want to replace it. For example, you may want to replace Engineering in the Department 
field with Custom Engineering. You also have the option of finding and replacing data in 
a Component List window.  

To find and replace inventory data 

1. If you want to replace the data in just certain rows, select those rows in the query results 
window or Component List window. 

2. Click on the Edit menu and click on Replace. 
3. Select the field in which you want to replace a value. 
4. Select an operator. 
5. In the Value box, specify the value you want to change in the field. Use the browse button 

to help you. Depending on your choice of field, ZENworks Asset Management Manager may 
display a Browse Database Fields dialog or a "Browse for" dialog that you must complete. 

6. (Optional) Select the Match case check box if you want ZENworks Asset Management to 
consider case when searching for the value. This check box applies only if the value you 
have specified is a simple text string. 

7. In the Replace With box, select the value with which you are replacing the found value in 
the field. You can use the browse button to display the Browse Database Fields dialog in 
which you can find and select a value. 

8. If you want to replace the value in all affected records versus the record you have 
selected, leave the Replace Selected Records Only check box cleared. 

9. Check that what you have entered in the Value and Replace With boxes is correct. You can 
correct a mistake only by doing another search and replace to reverse what you did.  

10. Click on the Replace All button. 

Replace 

The Replace dialog lets you find a value in one or more records in the query results 
window (or in a Component List window for a workstation) and replace it with another 
value. For example, you may want to replace Engineering in the Department field with 
Custom Engineering. 

To complete the Replace dialog 

1. Select the field in which you want to replace a value. 
2. Select an operator. 
3. In the Value box, specify the value you want to change in the field. Use the browse button 

to help you. Depending on your choice of field, ZENworks Asset Management Manager may 
display a Browse for Database Fields dialog or a "Browse for" dialog in which you must 
select a value.  

4. (Optional) Select the Match case check box if you want the Manager to consider case when 
searching for the value. This check box applies only if the value you have specified is a 
simple text string. 

5. In the Replace With box, select the value with which you are replacing the found value in 
the field. You can use the browse button to display the Browse Database Fields dialog in 
which you can find and select a value. 
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6. If you want to replace the value in all affected records versus the record you have 
selected, leave the Replace Selected Records Only check box cleared. 

7. Check that what you have entered in the Value and Replace With boxes is correct. You can 
correct a mistake only by doing another search and replace to reverse what you did.  

8. Click on the Replace All button. 

Exporting Inventory Data 

If you want to export inventory data so you can use it with another application such as a 
spreadsheet or report writer, you can run a query and export the results to a file in 
comma-separated values (CSV) format. Each value is enclosed in quotes. 

To export inventory data 

1. Run a query to locate the data you want to export. 
2. When the query results window includes the data you want to export, click on the File 

menu and click on Export. 
3. Use the standard Windows controls to specify a file for the exported data. 

TIP 

 You can also export data by displaying a report on the screen and then exporting the data to a variety of 
formats, including PDF, HTML, Excel, and 1-2-3. See Exporting a Report. 

Editing a Query 
If a query is not giving you the results you want, you can edit it. You can edit any query 
in your Personal Queries container (or the Public Queries container if you are an 
enterprise administrator). If you edit a query in the ZENworks Asset Management 
Queries container, you can save the edited query only in your Personal Queries container. 

To edit a query 

1. On the Query locator tab, do one of the following to display a query you want to edit:  
 Double-click on the query. 

 Select the query and click on   on the toolbar. 
 Right-click on the query and then click on Open on the shortcut menu. 
 Select the query, click on the File menu, and click on Open. 

2. Make the changes to the query using the same techniques as when creating one.  
3. Click on the Display Results button to make sure the query is producing the results you 

want. If it is not, change the criteria on the Filter tab. Also check the Layout tab to make 
sure the fields you want are being displayed. Then click on the Display Results button 
again. 

4. To update an existing query, click on   on the toolbar or click on the File menu and 
click on Save. If you try to save a query in the ZENworks Asset Management Queries 
container, the Manager will display the Save Query As dialog. Complete steps 5a through c 
below. 
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5. To save the changed query as a new query, click on the File menu and click on Save As. 
Then complete the Save Query As dialog: 
 
a) Enter a name for the query. 
b) Select a folder for the query. If you do not select a folder (or a folder does not exist), 
the Manager will save the query in your Personal Queries container. 
c) Click on the OK button. 

Printing a Query 
You can print the query definition and/or its results on your local printer.  

If you choose to print the query itself, ZENworks Asset Management Manager will print 
the name of the query, the filter criteria, the names of the columns that will make up the 
results of the query, and the way columns will be sorted.  

If you choose to print the results of the query, the Manager will print them in a 
spreadsheet-like format. Keep in mind that you can use the Layout tab in the query 
window to control what is included in the results.  

To print the query definition or results 

1. On the Query locator tab, open a query in one of the following ways:  
 Double-click on the query. 

 Select the query and click on   on the toolbar. 
 Right-click on the query and then click on Open on the shortcut menu. 
 Select the query, click on the File menu, and click on Open. 

2. If you want to print the results of the query, click on the Display Results button. 

3. Either click on   on the toolbar or click on the File menu and click on Print.  
4. To print the query itself, select Filter and Layout; to print its results, select Result Set. 

Copying a Query 
None of the queries in the ZENworks Asset Management Queries container can be 
changed permanently in any way, but you can copy any of these queries to your Personal 
Queries container. In addition, if you are an enterprise administrator, you can copy any 
ZENworks Asset Management query to the Public Queries container. Similarly, unless 
you are an enterprise administrator you cannot change a query in the Public Queries 
container, but you can copy it to your Personal Queries container. Once you have copied 
a query you can change it as you please and make additional copies of it. 

NOTE: You cannot copy a query if it is open in the query window in the workspace. Close the window first. 

To copy a query 

You can copy a query on the Query locator tab in any of the following ways: 

 Use the right mouse button to drag the query to a folder in your Personal Queries container (or in the Public 
Queries container if you are an enterprise administrator). Then click on Copy Here on the menu that appears. 

 Select the query and click on   on the toolbar. Then select a folder in your Personal Queries container 

(or in the Public Queries container if you are an enterprise administrator) and click on . 
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 Right-click on the query and click on Copy on the shortcut menu. Then right-click on a folder in your Personal 
Queries container (or in the Public Queries container if you are an enterprise administrator) and click on 
Paste on the shortcut menu. 

 Select the query, click on the Edit menu, and click on Copy. Then select a folder in your Personal Queries 
container (or in the Public Queries container if you are an enterprise administrator), click on the Edit menu, 
and click on Paste. 

When you open the copied query and make changes to it, you will be able to save the 
changes for future use. 

Renaming a Query 
All ZENworks Asset Management users can change the names of queries in their 
Personal Queries container. In addition, an enterprise administrator can rename a query in 
the Public Queries container. No user can rename any of the queries supplied by Novell 
in the ZENworks Asset Management Queries container. 

NOTE: You cannot rename a query if it is open in the query window in the workspace. Close the window first. 

To rename a query 

1. On the Query locator tab, do one of the following to rename a query:  
 Right-click on the query and click on Rename on the shortcut menu. 
 Select the query, click on the File menu, and click on Rename. 

2. In the Rename Query dialog, enter a different name for the query and click on the OK 
button. 

Promoting a Query 
If you are an enterprise administrator you can make a query in your Personal Queries 
container available to all ZENworks Asset Management users by promoting it to the 
Public Queries container. For example, if you have spent some time setting up a query 
that you think others would find useful, consider promoting it so they can take advantage 
of it. 

NOTE: You cannot promote a query if it is open in the query window in the workspace. Close the window first. 

To promote a query 

Do one of the following to promote a personal query: 

 Use the right mouse button to drag the query to the Public Queries container. Then click on Move Here on 
the menu that appears. 

 Right-click on the query and click on Promote on the shortcut menu. 
 Select the query, click on the File menu, and click on Promote. 
 Drag the query to the Public Queries container. 
 Cut and paste the query using either the Edit menu or shortcut menu. 

Deleting a Query 
All ZENworks Asset Management users can delete queries in their Personal Queries 
container. In addition, an enterprise administrator can delete a query in the Public Queries 
container. No user can delete any of the queries supplied by Novell in the ZENworks 
Asset Management Queries container. 
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NOTE: You cannot delete a query if it is open in the query window in the workspace. Close the window first. 

To delete a query 

1. On the Query locator tab, do one of the following to delete a query:  

 Select the query and click on   on the toolbar. 
 Right-click on the query and then click on Delete on the shortcut menu. 
 Select the query, click on the File menu, and click on Delete. 

2. Confirm the deletion. 

Sample Queries 
This topic provides examples for each type of object in your ZENworks Asset 
Management database. The steps to create the query vary slightly with object type, but 
the steps are essentially the same: 

 Create a Query as described in Creating a Query., setting the parameters as described in the table below. 

  

Query type Query Purpose Field Operator Value Combine Add’l Steps 

Workstation Find 
workstations in 
the Finance 
department 
with less than 
100MB of disk 
space 

Department  

Total Disk 
Space 

= 

< 

Finance 

100 

AND   

Workstation View 
components for 
workstation 
whose primary 
user is named 
"Friar Tuck 

Primary User 
Field(s)= 
Last Name 

= Friar Tuck   Right-click 
workstation 
Row #, 
choose 
View 
Component 
List 

Workstation List all 
workstations 
managed by 
Technical 
Contact named 
"Ahern" 

Technical 
Contact 
Field(s)= 
Last Name 

= Ahern     

Workstation List all 
workstations 
with a 
processor 

Contains 
component= 
CPU 

< 233     
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Query type Query Purpose Field Operator Value Combine Add’l Steps 

slower than 
233MHz 

Workstation List all 
workstations 
for associated 
with Collection 
Server named 
"San 
Francisco" 

Collection 
Server 
Field(s)= 
Collection 
Server Name 

= San 
Francisco 

    

Component, 
Component 
Type= 
Any (Basic 
Data Only) 

List all 
components for 
a workstation 
whose primary 
user is named 
"Clarence 
Alvarez" 

Workstations 
Field(s)= 
Primary User 

  

= Clarence 
Alvarez* 

    

Component, 
Component 
Type= 
Any (Basic 
Data Only) 

List all 
components in 
the Engineering 
Department 

Workstations 
Field(s)= 
Department 

= Engineering*     

Component, 
Component 
Type= 
Software 

List all 
components in 
the "Software 
Word 
Processor" 
category 

Product 
Fields(s)>> 
Classification 
Field(s)= 
Category 
Name 

= Word 
Processor* 

    

Product List all 
Microsoft 
products 

Manufacturer = Microsoft*     

Product List all 
software 
database 
products 

Classification 
Field(s)= 
Category 
Name 

= database*     

Product List all 
software local 
products 
created with 

Product 
Source 

Product Type 

= 

= 

Manager* 

Software* 

AND   
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Query type Query Purpose Field Operator Value Combine Add’l Steps 

ZENworks 
Asset 
Management 
manager 

User Find a user 
named "Mark 
Vermette" 

Last Name 

First Name 

= 

= 

Vermette 

Mark 

AND   

User List all users 
with 
workstations 
containing less 
than 32Mb of 
RAM 

Belongs to 
Primary 
User=Total 
Memory 
(MB) 

< 32.0     

FNI List all FNIs 
with the file 
extension 
".drv" 

File 
Extension 

= drv*     

FNK Find an FNI 
named 
"Amazon.exe" 

File Name = Amazon.exe     

FNI Find all FNIs in 
the Finance 
Department 

Workstation 
Field(s) =  
Department 

= Finance     

*Type the value, or click the right-arrow to browse for an appropriate value. 
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Workstations 

About Workstations 
In ZENworks Asset Management, a workstation is any computer for which you have 
inventory data. As you work with your inventory data, you may want to do any of the 
following with workstations: 

 View workstation data, for example, see the name of the primary user or the name of the department to 
which the workstation belongs. 

 View the components that make up the workstation. 
 View and print any auxiliary data for the workstation, for example, I/O maps or configuration files. 
 Add a manually-entered workstation. 
 Edit workstation data. 
 Scan a workstation outside its regular inventory cycle (administrators only). 
 Re-assign a workstation to different Collection Server (enterprise administrators only). 
 Check in a workstation. 
 Delete a workstation. 
 Recover a workstation (administrators only). 

You can examine workstation data either through reports or queries. If you want to 
change any of the data, you must run a query. 

NOTE: An analyst can view workstation data, but cannot change it in any way; other ZENworks Asset Management users 
can change workstation data. In addition, only users with enterprise roles can view all the workstations in the 
enterprise; users with domain roles can view the workstations associated with their Collection Domains only. 

See Also 

About Workstation Queries  

Running a Report  

About Stockrooms  

About the Lost and Found  
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About Workstation Queries 
A workstation query lets you locate workstation or stockroom data in a variety of ways. 
Here are some examples of the kind of information you can obtain with a workstation 
query: 

 A list of all the workstations in the Sales department, including location information and the name of the 
primary user. 

 A list of all the workstations in the enterprise for which a particular technical contact person is responsible. 
 A list of all the workstations that include a particular kind of ink jet printer, sorted by department. 
 A list of all the workstations that do not include a particular version of Microsoft Word, sorted by site. 

The Workstation folder of the ZENworks Asset Management Queries container includes 
the following pre-defined workstation queries for you to use: 

Network Servers 
Portably-Scanned Workstations 
Scanned PCs 
Stockrooms 
Workstation Status 
Workstations from NetCensus 

By nature, the ZENworks Asset Management queries are generic. You are likely, 
therefore, to need additional queries to locate specific workstation data, for example, the 
data that is associated with particular departments or users. You may be able to modify a 
ZENworks Asset Management query to accomplish your needs or you may have to create 
a workstation query from scratch. Sample Queries includes some sample workstation 
queries on which you can model your own. 

The information that you can examine with a workstation query includes the following: 

Workstation Field Description 

Asset Tag The asset tag of the workstation. 

Building The building where the workstation is located. 

Check In/Out Time The last time the workstation was checked in or 
out. ZENworks Asset Management automatically 
checks out a workstation when it is being scanned 
and then checks it back in.  

Checked Out The checked-out status of the workstation. 

Cost Center The cost center to which the workstation belongs. 

Create Date The date the workstation was created in the 
database. 

Default Gateway The default gateway of the workstation. 

Department The department to which the workstation belongs. 

Floor The floor where the workstation is located. 
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Workstation Field Description 

Free Disk Space (MB) The free space on the hard disk. 

Inventory Type The kind of inventory this represents: 
workstation, stockroom, Lost and Found, network 
server, manually-entered workstation, portable, or 
NetCensus. 

IP Address The IP address of the workstation. 

LAN Address The LAN address of the workstation. 

Last Successful Load Date * The date inventory data was last loaded 
successfully from the workstation. 

Last Successful Scan Date * The date the workstation was last scanned 
successfully. 

Last Usage Date The date usage data from the workstation was last 
loaded into the database. 

Lease Contract ID The lease contract ID, if leased. 

Lease Expiration Date The lease expiration date, if leased 

Leased Whether or not the workstation is leased. 

Login Name The workstation user’s logon name. 

Machine Name The machine name. 

NetCensus Config ID The NetCensus configuration ID of the 
workstation (for migrated workstations). 

Phone The telephone number at the workstation. 

Room The room where the workstation is located. 

Serial Number The serial number of the workstation. 

Site The site of the workstation. 

Subnet Mask The subnet mask of the workstation. 

Total Disk Space (MB) The total space on the hard disk. 

Total Memory (MB) The total system memory. 

* These fields initially have the date set to 01/01/1980. This means that the field has not 
been set to a specific date yet, as the result of a scan, for example. 
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A workstation query also lets you: 

 Locate data in any user-defined workstation fields.  
 Locate workstations by referencing either the workstation’s primary user or technical contact (or both). 
 Locate workstations by referencing a Collection Domain or Collection Server.  
 Locate workstations that are referenced by (include) a certain type of component, for example, a laser 

printer. 
 Locate workstations that are referenced by (include) a particular FNI. 
 Locate workstations by detailed connection information such as collection begin and end times. 

See Also 

Creating a Query 
Viewing Workstation Data  
Adding a Workstation  
Editing a Workstation  
Re-Assigning a Workstation to a Different Collection Server  
Scanning a Workstation on Demand  
Checking in a Workstation  
Deleting a Workstation  
Recovering a Workstation  
Sending Packages to Workstations  
Performing Live Support on a Workstation  
Sample Queries  

Viewing Workstation Data 
Viewing Workstation Data with a Query 

If you anticipate making any changes to workstation data, you must first display the 
workstation(s) by running a workstation query. With a workstation query, you can obtain 
a list of workstations and then optionally display a list of components for a particular 
workstation. 

To view workstation data 

1. To use an existing workstation query, double-click on the query on the Query locator tab. 
To create a workstation query: 

a) Select the Personal Queries container and click on   on the toolbar. 
b) Click on Workstation Query. 
c) Define the filter criteria.  

2. Click on the Layout tab to make sure the fields you want will be displayed. 
3. Click on the Filter tab and then click on the Display Results button.  
4. Examine the data ZENworks Asset Management Manager displays. If it is not quite what you 

wanted, edit the criteria that make up the query and then display its results again. 
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5. (Optional) Do any of the following:  
 Display the components associated with the workstation.  
 If you have gathered it, examine the auxiliary data such as I/O and DMA maps associated with the 

workstation.  
 Edit the workstation data.  
 Add a workstation manually.  
 Re-assign a workstation to another Collection Server (enterprise administrators only).  
 Start the scan of a workstation (administrators only).  
 Check in a workstation. 
 Remove a workstation altogether.  
 Recover a workstation’s internal identification so it can be re-instated in ZENworks Asset Management 

(administrators only).  

TIPS 

 For specific examples of workstation queries, see Sample Queries. 
 ZENworks Asset Management also includes many kinds of reports for analyzing workstation data.  
 A workstation query lets you look at the results of the most recent scan of a workstation. To see historical 

information about past scans, run a workstation history report such as a Workstation Scan History report. 

Viewing Workstation Components 

Whenever you are viewing workstation or stockroom data in the query results window, 
you have the option of displaying a Component List window that shows all the 
components that belong to a specific workstation or stockroom. In addition to viewing 
and printing the list of components, you can add, edit, delete, and move components.  

To view workstation components 

1. Do one of the following in the query results window to see the components that make up a 
workstation:  

 Click on the row number of the workstation and then click on   on the query toolbar. 
 Right-click on the workstation row number and then click on View Component List on the shortcut 

menu. 
 Click on the workstation row number, click on the Query menu, and click on View Component List. 

2. Do any of the following in the Component List window:  
 Sort the list of components differently by clicking on any column heading. To sort in reverse order, 

double-click on the column heading again. 
 Look for a particular component in the Component List window by using the find feature. To find and 

replace data, use the replace feature.  

 Print the list of components either by clicking on   on the toolbar or by clicking on the File menu 
and clicking on Print. 

 Add, edit, delete, or move components. 
 Edit data about the workstation itself by right-clicking on a cell and then clicking on Edit Workstation 

on the shortcut menu. 
3. Close the Component List window when done. 

TIPS 
 You can leave the Component List window open even if you close the workstation query. 

 If you have had the Component List window open for a while, click on   on the toolbar to update the list 
of components. 

 You can also view workstation components by running a component query filtered by a particular 
workstation. 
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Component List 

A Component List window lists all the components associated with a workstation. 

To work in the Component List window 

1. Do any of the following:  
 Sort the list differently by clicking on any column heading. To sort in reverse order, double-click on the 

heading again. 

 Locate a particular component either by clicking on  on the toolbar or by clicking on the Edit menu 
and clicking on Find. Then complete the Find dialog. 

 Print the list of components either by clicking on  on the toolbar or by clicking on the File menu 
and clicking on Print. 

 Add a component. 
 Edit a component. 
 Move a component to another workstation. 
 Delete a component. 
 Edit data about the workstation itself by right-clicking on a cell and then clicking on Edit Workstation 

on the shortcut menu. 
2. When done, close the Component List window. 

TIPS 

 You can leave the Component List window open even if you close the workstation query. 

 If you have had the Component List window open for a while, click on  on the toolbar to update the list 
of components. 

Viewing and Printing Workstation Auxiliary Data 

Auxiliary data about a workstation can include information about memory; IRQ, I/O, and 
DMA maps; system configuration files; and any ASCII text files you have chosen to 
gather. ZENworks Asset Management does not collect this data by default, but you have 
the option of doing so by changing Collector settings in the collection option set.  

The auxiliary workstation data is not directly accessible via a query, but you can look at it 
whenever workstations are listed in the query results window. You can also print this 
data. 

To view and print auxiliary data about a workstation 

1. When the query results window includes workstation data, do one of the following:  

 Click on a workstation row number and click on  on the query toolbar. 
 Right-click on a workstation row number and then click on View Auxiliary Data on the shortcut menu. 
 Click on a workstation row number, click on the Query menu, and click on View Auxiliary Data. 

2. By default, ZENworks Asset Management Manager displays IRQ data in the View Auxiliary 
Data dialog. To display a different type of auxiliary data, select DMAs, I/O Map, Memory, 
or Files from the Auxiliary Data to View drop-down list. 
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3. To print the auxiliary data, do the following: 
 

a) Either click on  on the toolbar or click on the File menu and click on Print. 
b) In the Print Auxiliary Data dialog, select the types of data you want to print and click on 
the OK button. By default, the type of data you were displaying is selected. 

View Auxiliary Data 

The View Auxiliary Data window shows any auxiliary data you have gathered about a 
workstation, for example, IRQ data, I/O maps, DMA data, memory data, or files. (What 
is available for viewing depends on what was specified in the collection option set.) 

To view auxiliary data 

1. By default, ZENworks Asset Management Manager displays IRQ data. To display a different 
type of auxiliary data, select it in the Auxiliary Data to View drop-down list. 

2. (Optional) To print the data, either click on   on the toolbar or click on the File menu 
and click on Print. 

3. When done, close the View Auxiliary Data window. 

Print Auxiliary Data 

The Print Auxiliary Data dialog lets you select which auxiliary data you want to print. By 
default, the type of data you were displaying is selected. 

1. Select the type of data you want to print. 
2. Click on the OK button. 

Adding a Workstation 
Adding a Manually-Entered Workstation 

ZENworks Asset Management is designed to collect inventory data automatically from 
Windows 95/98, Windows NT, and Windows 2000 workstations that are connected by 
TCP/IP. If a Windows 95/98, Windows NT, or Windows 2000 workstation cannot be 
scanned automatically, you can perform a portable collection as described in Performing 
Portable Collections.  

If a workstation does not fall into any of the above categories, you can add it manually to 
the inventory database. This type of workstation is known as a manually-entered 
workstation because you enter all the inventory data for the workstation yourself. Once 
you have added a workstation manually, you can examine and edit it with ZENworks 
Asset Management Manager, just as any other workstation. 

When you add a workstation manually, you must associate it with a particular Collection 
Server. If you want a particular domain administrator to manage the manually-entered 
workstation, be sure to select a Collection Server in that administrator's domain. 
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When you create a manually-entered workstation, you must also be sure to add a system 
component to the workstation. A system component is the computer itself, as identified 
by manufacturer, product, and model, for example, Dell Dimension XPS Pro20. Without 
a system component, the manually-entered workstation is missing a critical part of its 
definition. 

NOTE: You can also add stockrooms, which do not require system components. 

In some cases you may already know you need to add a workstation manually. In other 
cases you may find out you need to create a manually-entered workstation while 
examining the results of a workstation query. 

To add a workstation manually 

1. If you already know you need to add a manually-entered workstation, click on the Add 
Data menu and click on Workstation/Stockroom. 
 
 If you have run a workstation query and realize you need to add a manually-entered 
workstation, do one of the following:  

 Click on  on the query toolbar. 

 Right-click on any row number and click on Add on the shortcut menu. 

 Click on the Query menu and click on Add. 

2. In the Select Workstation Type to Create dialog, do the following: 
 
a) Select Manually Entered Workstation in the Workstation Type section. 
b) Select the Collection Server with which you want to associate the manually-entered 
workstation. 
c) Click on the OK button. 

3. Do the following in the Add New Workstation dialog: 
 
a) Enter a descriptive name for the manually-entered workstation in the Machine Name 
field. Try to make this name unique. 
b) Provide any additional information you want such as the primary user or department. 
You will find you can type data in some fields directly, but in other cases, you will need to 
click on the browse button and complete a further dialog. 
c) Click on the OK button when done. 

4. Add components to the manually-entered workstation. Be sure to include a system 
component. 

TIP 

 Once you have created a manually-entered workstation, you can edit it and delete it 
just like any scanned workstation, except that you can edit some additional fields 
(Free Disk Space, Total Disk Space, Total Memory, Serial Number, Asset Tag, IP 
Address, and LAN Address). 
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Add New Workstation/Edit Workstation Properties 

The Add New Workstation dialog lets you add information about a manually-entered 
workstation or stockroom you are creating; the Edit Workstation Properties dialog lets 
you change data about a workstation or stockroom. 

To add or edit a workstation 

1. Enter a descriptive name for the workstation or stockroom in the Machine Name field. Try 
to make this name unique. 

2. Provide any additional information you want such as the primary user or department. You 
will find you can type data in some fields directly, but in other cases, you will need to 
click on the browse button and complete a further dialog. 

3. Click on the OK button when done. 

Select Workstation Type to Create 

The Select Workstation Type to Create dialog gives you a choice of creating a stockroom 
or manually-entered workstation and lets you associate it with a Collection Server. 

1. Select Stockroom or Manually Entered Workstation. 
2. Select the Collection Server with which you want to associate the stockroom or 

workstation. 
3. Click on the OK button. 

Editing Workstation Data 
Once you have displayed the results of a workstation query, you can change the data if 
necessary. How you edit it depends on the kind of data you are trying to change. For 
example, 

 You can change many workstation details, for example, name or location, directly in the query results 
window. 

 You can display the components associated with the workstation. You can then add, edit, move, or delete 
components.  

 You can change data in any field for a primary user or technical contact (for example, first name) directly in 
the query results window. To edit user data that is not in the query results window, right-click on the user 
cell and then click on Edit on the shortcut menu. To replace a user, click on the browse button in the cell 
and then make a selection in the dialog that appears.  

 You can find all instances of a particular value in a field and replace it with another value.  
 You can change additional workstation data in the Edit Workstation Properties dialog. This dialog shows all 

the available information about a workstation.  

To edit workstation data 

1. Run a workstation query to display the workstation(s) you want to edit. 
2. Make your changes. If you can edit the data directly in the query results window, do so. 

Otherwise, click on the browse button in a cell and complete the dialog that appears. 
3. If you want to see all the available data for a workstation, do one of the following in the 

query results window:  
 Double-click on the row number of the workstation. 

 Click on the workstation row number and click on   on the query toolbar. 
 Right-click on the workstation row number and then click on Edit on the shortcut menu. 
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 Click on the workstation row number, click on the Query menu, and click on Edit. 

ZENworks Asset Management Manager will now display the Edit Workstation Properties 
dialog. Not all workstation data can be edited in this dialog.  

4. Make your changes, for example, provide a descriptive name for the workstation in the 
Machine Name field. (Try to make the name unique). 
Some fields include a browse button so you can locate the value you want. For example, 
when you click on the browse button in a field that includes a user name, the Manager 
displays the Browse for User dialog.  

5. Click on the OK button when done. 

TIP 

 If you want to move a workstation to another Collection Server, you can re-assign it.  

Re-Assigning a Workstation to a Different Collection Server 
Each workstation in ZENworks Asset Management is associated with a Collection Server 
for organizational and tracking purposes. At times, you may want to move a workstation 
to a different Collection Server. You can do so directly from ZENworks Asset 
Management Manager. 

NOTE: Only an enterprise administrator can re-assign workstations. 

To re-assign a workstation to a different Collection Server 

1. Run a workstation query to locate the workstation(s) you want to re-assign. 
2. Select the workstation(s) in the query results window. 
3. Do one of the following:  

 Right-click and click on Re-Assign Workstation on the shortcut menu. 
 Click on the Query menu and click on Re-Assign Workstation. 

4. In the Re-Assign Workstation dialog, select a Collection Server and click on the OK button. 

Re-Assign Workstation 
The Re-Assign Workstation dialog lets you associate the selected workstation(s) with a 
different Collection Server. 

To re-assign the workstation(s) 

1. Select the Collection Server to which you want to re-assign the workstation(s). 
2. Click on the OK button. 

Scanning a Workstation on Demand 
Occasionally you may need to scan a particular workstation outside its regular inventory 
schedule. For example, suppose that you know some workstations have had some 
memory added to them, but are not due to be scanned for a while. You can scan the 
workstations right away to bring the inventory database up-to-date. You do so by running 
a query to find the workstations in question and then initiating a scan of them.  
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When you scan workstations on demand, ZENworks Asset Management uses the scan 
now collection option set that is assigned to the Collection Server with which a 
workstation is associated. 

Note: If you want ZENworks Asset Management to confirm that a scan on demand took place, select the Confirm Scan 
on Demand check box in the Preferences dialog. 

To scan a workstation on demand 

Note: You can also scan a workstation on demand from the Web Console. For more information, see the Web Console 
help. 

1. If you want a particular collection option set to be used when you scan the workstation, 
assign the option set to the Collection Server as the scan now option set. (You do this on 
the General tab of the Collection Server window.)  

2. Run a workstation query to locate the workstation(s) you want to scan.  
3. In the query results window, do one of the following to scan the workstation(s):  

 Select the workstation(s), right-click, and then click on Scan Workstation Now on the shortcut menu. 
 Select the workstation(s), click on the Tools menu, and click on Scan Workstation Now. 

The Collection Server of the selected workstation(s) will then initiate the scan of the 
workstation(s) and automatically load the collected data into the inventory database. 
ZENworks Asset Management will notify you if the scan was successful if you selected the 
Confirm Scan on Demand check box in the Preferences dialog.  
 
Note: If the client for the workstation you are trying to scan is not in a Ready state, the 
command will be grayed out on the menu. Try again in a few minutes. For more 
information, see Viewing Detailed Status Information About Workstations. 

Deleting a Workstation 
If you no longer have a particular workstation, or for some reason do not want it as part 
of your inventory data, you can delete it.  

What Happens When You Delete a Workstation? 

When you delete a workstation, you do not lose the workstation record or history 
immediately. The following should be kept in mind about a deleted workstation: 

 The workstation record and all associated component records are kept in the database, but are marked with 
the deletion date.  

 The ZENworks Asset Management license count in decremented.  
 The length of time deleted records are kept in the database is set in Enterprise Options, available from the 

Tools menu. The default is for Workstation History Data to be kept for 1 year.  
 Deleted records are removed from the database by a purge task. The purge task removes all records with a 

deletion date older than the default value described above.  
 Once a workstation has been deleted you cannot modify any fields for the record, as deleted workstations 

cannot be viewed from the Manager's Query Browser. 
 The deletion date fields are available in the Web Console only and are "Workstation Is Deleted", "Workstation 

Deletion Date", "Product Is Deleted", and "Product Deletion Date". See Viewing a List of Deleted Workstations, 
below. 
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To delete a workstation 

1. Run a workstation query to locate the workstation(s) you want to delete. 
2. In the query results window, select one or more workstations by clicking on the row 

number. To select more than one workstation, use the standard Windows Ctrl or Shift key 
combinations.  

3. Do one of the following to delete the workstation(s):  

 Click on   on the query toolbar. 
 Right-click and then click on Delete on the shortcut menu. 
 Click on the Query menu and click on Delete. 

4. Confirm the deletion. 
 
NOTE: If you delete a workstation accidentally, you will lose the historical data for the 
workstation. In addition, the next time the workstation is scanned, ZENworks Asset 
Management will treat it as a new workstation. 

Viewing a List of Deleted Workstations 

You can use the Web Console view a list of deleted workstations. You do this by creating 
a custom report. 

To view a list of deleted workstations: 

1. In the Web Console, create a new custom report. 
2. Set the type to Workstations and the focus to Basic Workstation Attributes. (This is the 

default setting.) 
3. Choose the columns you want to view. 
4. In the Criteria area, choose Workstation is Deleted from the Field drop-down menu. 
5. Choose Yes from the Value drop-down menu. 
6. You may also wish to add a second filter on the Workstation Deletion Date. You can then 

specify a certain date, or use the "within x days" or "Not within x days" operators. 

Checking in Workstations from a Query Results Window 
When workstations are being scanned, ZENworks Asset Management considers them to 
be "checked out." When a workstation is checked out, you cannot edit its associated data 
with ZENworks Asset Management Manager. (You can, however, make changes at the 
workstation with the Collection Editor.) 

Sometimes workstations remain checked out even when they are not being scanned. For 
example, the Collection Editor may be waiting for user input at the workstation, but the 
user is out on extended medical leave. In this case you can check in the workstation. 

To find out which workstations are checked out and when they were checked out, you 
can run a workstation query that has the criteria Checked Out = Yes and a Check 
In/Check Out time earlier than some date you specify. You can then check in any 
workstations that have been checked out for a long time. 



Analysis and Maintenance 

205 

To check in a workstation 

1. Set up and run a workstation query that includes the criteria Checked Out = Yes and a 
Check In/Check Out Time earlier than some date you specify. 

2. Select those workstations that you want to check in. 
3. Right-click and then click on Check in Workstation on the shortcut menu. 

TIP 
 The Check Outs tab in the process control panel also lists checked-out workstations and gives you the option 

of checking them back in. 

Recovering a Workstation 
Each workstation in the ZENworks Asset Management inventory database has a unique 
identifier that is used internally for tracking purposes. Every time ZENworks Asset 
Management scans a workstation ZENworks Asset Management checks for an identifier. 
If it does not find an identifier, ZENworks Asset Management assigns one to the 
workstation, thus treating it as a new workstation. If it finds an identifier, ZENworks 
Asset Management knows the workstation is already part of the inventory database. 

In some situations you may want to recover a workstation’s identifier so you can "re-
instate" the workstation in the ZENworks Asset Management inventory database. For 
example, you may rebuild a workstation to such an extent that ZENworks Asset 
Management will treat it as a new workstation. A hard disk crash or re-installation of the 
operating system will have the same effect. To avoid having the same workstation in the 
database twice, you can re-instate the original identifier on the workstation so that during 
its next scan it is treated as a "known" workstation. 

NOTE: Collection Server reconciliation options let you recover workstations automatically. The procedure described 
below offers another method of recovering workstations if for some reason you cannot use the Collection Server 
options. 

ZENworks Asset Management Manager lets you save a workstation’s identifier in a 
special registry (.reg) file. You can then use this file on the workstation itself to restore its 
identity. Be sure to perform this procedure before re-installing the client applications. 

NOTE: Only a ZENworks Asset Management administrator can recover a workstation. 

To recover a workstation 

1. If you have rebuilt a workstation, or a workstation has had a hard disk crash (and you have 
fixed the problem), run a workstation query to locate the workstation in the database. 

2. Select the workstation in the query results window. 
3. Do one of the following:  

 Right-click and click on Recover Workstation on the shortcut menu. 
 Click on the Tools menu and click on Recover Workstation. 

4. Use standard Windows controls to save the registry (.reg) file in a folder of your choice. 
5. Copy the registry file to the workstation you are recovering and double-click on it from 

Windows Explorer. 
6. Re-install the client applications on the workstation using any of the methods described in 

Performing Automated Inventories. When the Collection Client next runs on the 
workstation, the workstation’s original identity will be restored. 

TIP 
 You can also use Collection Server options to recover workstations.  
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Stockrooms 

About Stockrooms 
A stockroom consists of components that are not currently associated with a particular 
workstation but are grouped together for organizational purposes. For example, you may 
want to track unused or extra components by technical contact, building, or department. 
You could also have a repair room stockroom to keep track of components that are being 
repaired. The underlying organization of stockrooms and their contents are completely up 
to you. 

In ZENworks Asset Management, a stockroom is considered to be a type of workstation 
so you use workstation queries to work with stockroom data. 

You can create and manage a stockroom with ZENworks Asset Management Manager.  

See Also 

Adding a Stockroom  

Viewing Stockroom Data  

Editing a Stockroom  

Deleting a Stockroom  

Adding a Stockroom 
When you create a stockroom, you must associate it with a particular Collection Server. 
If you want a particular domain administrator to manage the stockroom, be sure to select 
a Collection Server in that administrator's domain. 

Unlike a workstation, a stockroom can include several system components or none; a 
workstation must include one (and only one) system. 

In many cases you will already know you need to add a stockroom. In other cases you 
may find out you need to create one while examining the results of a workstation query. 

To add a stockroom 

1. If you already know you need to add a stockroom, click on the Add Data menu and click on 
Workstation/Stockroom. 
 If you have run a workstation query and realize you need to add a stockroom, do one of 
the following:  

 Click on   on the query toolbar. 
 Right-click on a row number and click on Add on the shortcut menu. 
 Click on the Query menu and click on Add. 

2. In the Select Workstation Type to Create dialog, do the following: 
 
a) Select Stockroom in the Workstation Type section. 
b) Select the Collection Server with which you want to associate the stockroom. 
c) Click on the OK button. 
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3. Do the following in the Add New Workstation dialog: 
 
a) Enter a descriptive name for the stockroom in the Machine Name field.  
b) Provide any additional information you want such as the technical contact or 
department. You will find you can type data in some fields directly, but in other cases, you 
will need to click on the browse button and complete a further dialog. 
c) Click on the OK button when done. 

4. Add components to the stockroom.  

Viewing Stockroom Data 
You display the data associated with a stockroom by using a workstation query and 
indicating an inventory type of stockroom. The Workstation folder of the ZENworks 
Asset Management Queries container includes a pre-defined query named Stockrooms 
for listing all stockrooms. You can use this query and then select the stockroom for which 
you want to see components. You can also modify this query or create a workstation 
query to locate a specific stockroom. 

To view stockroom data 

1. To use the pre-defined ZENworks Asset Management query, double-click on Stockrooms in 
the Workstation folder of the ZENworks Asset Management Queries container. 
 To create a new query to locate a specific stockroom, create a query and do the 
following: 
 
a) Select Workstation Query as your query type. 
b) Select Inventory Type in the Field column and = in the Operator column. 
c) Select Stockroom in the Value column. 
d) Add another criterion to filter by a field that will identify the particular stockroom you 
want, for example, by machine name or site. 

2. Click on the Display Results button in the query window.  
3. Examine the data ZENworks Asset Management Manager displays. If it is not quite what you 

wanted, edit the criteria that make up the query and then display its results again. 
4. Do any of the following:  

 Display the components associated with the stockroom just as you would for a workstation. You can 
then add, edit, move, or delete components.  

 Edit the stockroom data.  
 Add another stockroom.  
 Delete a stockroom altogether.  
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Editing Stockroom Data 
You can change the data associated with a stockroom just as you can for a workstation. 
For example, you can change location information or the name of the technical contact 
person. You can also add, edit, move, or delete stockroom components.  

To edit stockroom data 

1. Run a workstation query to list the stockroom(s) you want to edit.  
2. Edit the stockroom data just as you would edit workstation data.  

TIPS 

 If you are primarily interested in editing stockroom components, run a component query that filters on the 
stockroom you want.  

 If you are repairing a component and have a repair room stockroom defined, move the component from the 
workstation to the stockroom while it is being repaired. After it is fixed, move the component back to the 
workstation.  

Deleting a Stockroom 
If you no longer want to maintain a particular stockroom or track its inventory data, you 
can delete it. 

CAUTION: When you delete a stockroom, ZENworks Asset Management Manager permanently removes it from the 
inventory database, with all of its associated components. 

To delete a stockroom 

1. Run a workstation query to locate the stockroom you want to delete. 
2. In the query results window, select a stockroom by clicking on the row number. To select 

more than one stockroom, use the standard Windows Ctrl or Shift key combinations.  
3. Do one of the following to delete the stockroom(s):  

 Click on   on the query toolbar. 
 Right-click and then click on Delete on the shortcut menu. 
 Click on the Query menu and click on Delete. 

4. Confirm the deletion. 
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Lost and Found 

About the Lost and Found 
The Lost and Found is a special kind of stockroom that is created and maintained by 
ZENworks Asset Management. If a component with a serial number or asset tag was 
discovered on a workstation during the inventory process, but is found to be missing 
during a subsequent inventory cycle, ZENworks Asset Management places the 
component in the Lost and Found. If a component with the same serial number or asset 
tag later turns up on another workstation, ZENworks Asset Management automatically 
removes it from the Lost and Found. A component must have a serial number or asset tag 
to be maintained in the Lost and Found. 

You can examine the contents of the Lost and Found at any time to see if all the 
components are really lost and respond accordingly. For example, 

 If you know that a component has been sold, stolen, or "retired," you can delete it from the Lost and Found. 
 If you have a stockroom set up for repairs, you could periodically check the Lost and Found for any 

components you know are being repaired and move them to that stockroom. 

Note: If you make a change to the Lost and Found by deleting or moving a component, and the Collector’s findings in 
the next inventory cycle contradict the change, your manual changes will be replaced by the Collector’s findings.  

You cannot delete the Lost and Found; it is always there for ZENworks Asset 
Management's use. 

Disabling Lost and Found Tracking 

By default, Lost and Found tracking is turned on. If you are an administrator, you can 
specify whether your installation tracks Lost and Found. You can enable or disable the 
tracking of Hardware and Software independently.  

For more information, see Changing Enterprise Options. 

Note: For the purposes of Lost and Found tracking, an operating system is treated as Hardware. If you want to track 
operating systems, you must choose Hardware in the Enterprise Options dialog. 

See Also 

Seeing What Is in the Lost and Found  

Moving a Component Out of the Lost and Found  

Deleting a Component in the Lost and Found  
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Seeing What is in the Lost and Found 
ZENworks Asset Management includes a query for seeing the contents of the Lost and 
Found. This query is named Lost and Found Components and is in the Component folder 
of the ZENworks Asset Management Queries container. 

NOTE: To list the Lost and Found in the query results window (perhaps along with some stockrooms), run a workstation 
query that filters by the inventory type of Lost and Found. 

To see what is in the Lost and Found 

1. In the Component folder of the ZENworks Asset Management Queries container, double-
click on Lost and Found Components. 

2. Click on the Display Results button in the query window.  
3. Examine the data ZENworks Asset Management Manager displays. If you notice any 

components that are not really lost, you may want to do one of the following:  
 If a component is being repaired, consider setting up a stockroom named "Repair Shop" and moving the 

component to this stockroom.  
 If a component no longer exists (maybe it has been sold, stolen, or simply "retired"), delete the 

component.  

Moving a Component Out of the Lost and Found 
One reason a component will find its way into the Lost and Found is if a scan occurs 
while it is being repaired. If the Collector found the component before, but no longer 
finds it on the workstation, the Collector will place the component in the Lost and Found. 
In this case, you may want to move the component out of the Lost and Found because, 
for example, 

 You want to use the component with a different workstation.  
 You want to track all components that are being repaired in some sort of repair room stockroom. 

To move a component out of the Lost and Found 

1. Run the pre-defined Lost and Found Components query in the Component folder of the 
ZENworks Asset Management Queries container.  

2. In the query results window, select the component you want to move. 
3. Right-click and click on Move on the shortcut menu. 
4. In the Move Components dialog:  

 
a) Click on the Browse button. 
b) Complete the Browse for Workstation dialog to select the workstation or stockroom to 
which you want to move the component.  
c) Click on the OK button. 
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Deleting a Component in the Lost and Found 
If you see a component in the Lost and Found that you know has been sold, stolen, or 
"retired," you can remove it. 

To delete a component in the Lost and Found 

1. Run the pre-defined Lost and Found Components query in the Component folder of the 
ZENworks Asset Management Queries container.  

2. Do one of the following to remove a component from the Lost and Found:  

 Select the component you want to delete and click on   on the query toolbar. 
 Right-click on the component you want to delete and then click on Delete on the shortcut menu. 
 Select the component you want to delete, click on the Query menu, and click on Delete. 

3. Confirm the deletion. 

Components 

About Components 
A component is a hardware or software product associated with a workstation or 
stockroom, for example, a spreadsheet application or a network interface card. As you 
work with your inventory data, you may want to do any of the following with 
components: 

 View the components for a workstation or stockroom or find workstations that include particular 
components. 

 Add components. 
 Edit components. 
 Move components. 
 Delete components. 

You can examine component data either through reports or queries. If you want to change 
any of the data, you must run a query. 

NOTE: An analyst can view component data, but cannot change it in any way; other ZENworks Asset Management users 
can change component data. 

See Also 

Running a Report  

About Component Queries  
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About Component Queries 
A component query lets you locate component data in a variety of ways. Here are some 
examples of the kind of information you can obtain with a component query: 

 A list of the components for a particular workstation or stockroom. 
 A list of all the components for which a particular technical contact is responsible. 
 A list of all the components in a particular product category. 
 A list of all the components on workstations in the Accounting department. 
 A list of all hard drives that are smaller than 1 GB and made by a certain manufacturer. 

The Component folder of the ZENworks Asset Management Queries container includes 
the following pre-defined component queries for you to use: 

Collector-Created Components 
Components Entered with Collection Editor 
Hardware Component Summary 
Lost and Found Components 
Manager-Entered Components 
Operating Systems 
Software Component Summary 
Systems 

By nature, the ZENworks Asset Management queries are generic. You are likely, 
therefore, to need additional queries to locate specific component data, for example, for a 
particular workstation or manufacturer. You may be able to modify a ZENworks Asset 
Management query to accomplish your needs or you may have to create a component 
query from scratch. Sample Queries includes some sample component queries on which 
you can model your own. 

Whenever you create a component query, you must always select the type of component 
you want to find, for example, system, printer, or software. Different types of 
components have different information associated with them so ZENworks Asset 
Management needs to know what kind of data it should display. For example, a printer 
has different characteristics than a modem or a piece of software. 

When selecting the component type, you have two basic choices, depending on the data 
you want to find. You can choose a specific type of component, in which case you will be 
able to see all the available information for that type of component, but not for any other 
type. Alternatively, you can choose to find any type of component with the query. In this 
case, you will be able to see information about a mix of components of different types, 
but the information available will be limited to the data that all components have in 
common. 

The information that you can examine with a component query and that is common to all 
components includes the asset tag, component source, model/version, and serial number. 

If you are examining a specific type of component, other data will be available to you in 
extended fields, for example, speed and communications port for a modem or chassis 
type for a system. 
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A component query also lets you: 

 Locate data in any user-defined component fields.  
 Locate components by referencing workstation data such as a machine name or department.  
 Locate components by referencing product data such as a manufacturer name or classification.  

See Also 

Creating a Query  
Viewing Component Data  
Adding a Component  
Editing a Component  
Deleting a Component  
Moving a Component  
Sample Queries  

Viewing Component Data with a Query 
If you anticipate making any changes to components, you must first display them by 
running a query. Depending on what kind of component data you want to see, you can 
either run a workstation query or a component query.  

With a workstation query, you can obtain a list of workstations and then display a list of 
components for a particular workstation. A component query also lets you display 
components for a workstation but gives you greater flexibility in what kind of component 
data you display and how you display it. The procedure that follows illustrates how to 
view component data with a component query. 

To view component data 

1. To use an existing component query, double-click on the query on the Query locator tab. 
 
To create a component query: 
 

a) Select the Personal Queries container and click on   on the toolbar. 
b) Click on Component Query.  
c) When ZENworks Asset Management Manager displays the Select Component Type dialog, 
either select a specific type of component such as software or select Any (Basic Data Only) 
if you want to work with a mix of component types. Then click on the OK button. 
d) Define the filter criteria.  

2. Click on the Layout tab to make sure the fields you want will be displayed. 
3. Click on the Filter tab and then click on the Display Results button.  
4. Examine the data the Manager displays. If it is not quite what you wanted, edit the criteria 

that make up the query and then display its results again. 
5. (Optional) Do any of the following:  

 Edit component data.  
 Add a component.  
 Move a component.  
 Delete a component.  
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TIPS 

 For specific examples of component queries, see Sample Queries. 
 A component query gives you information about products that are part of a workstation or stockroom in your 

organization. Many of the thousands of products known to ZENworks Asset Management will not be in use on 
any of your workstations. For example, VP-Planner 1.3 by Paperback is a product recognized by ZENworks 
Asset Management, but it may not be on any workstations in your organization. To see which products are 
available (regardless whether they are components of workstations), run a product query.  

 ZENworks Asset Management also includes many reports for analyzing component data. For example, 
component breakdown reports give you counts of hardware or software components. 

 A component query provides data based on the most recent scan of workstations. To see historical data 
about past scans, run a history report such as a Component Change History Report or a Component Move 
History Report. 

See Also 

Sample Queries  

Adding a Component 
You may need to add a component for any of the following reasons: 

 Some external peripherals (such as scanners or digitizers) cannot be recognized automatically during the 
inventory process. 

 A new device may not have recognition available for it yet. 
 A piece of software is not installed on the PC but is perhaps run from a CD-ROM. 
 A hardware component is custom built or a piece of software is internally developed. 
 Some extra or unused components need to be associated with a stockroom. 

In many cases, you will be adding a component that corresponds to a product already 
defined by Novell. In other cases, the component will not correspond to a product defined 
by Novell and will represent a local product.  

NOTE: Only an enterprise administrator can create a local product. In addition, the inventory process must be shut 
down.  

You can add a component in any of these contexts: 

 You have run a workstation query and want to add a component to a specific workstation or stockroom. 
 You have run a component query and decide to add a component. In this case you will need to assign the 

component to a workstation when you create the component. 
 You already know you need to add a component to a workstation or stockroom without needing to run a 

query to discover this. For example, you may have just created a stockroom and now need to add 
components to it. 

To add a component 

1. If you already know you need to add a component to a workstation or stockroom (perhaps 
because you have just created a stockroom), click on the Add Data menu and click on 
Component. ZENworks Asset Management Manager will display the Select Component Type 
to Create dialog. 
 
If you have run a workstation query and then displayed the Component List window for a 
workstation, or, if you have run a component query, do one of the following to add a 
component:  

 Click on   on the query toolbar. 
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 Right-click on a row number and click on Add on the shortcut menu. 
 Click on the Query menu and click on Add. 

2. In the Select Component Type to Create dialog, do the following: 
 
a) Select the type of component you want to add, for example, printer or software. 
b) If necessary, select the workstation to which you want to add the component by clicking 
on the Browse button in the Assign to Workstation section and then completing the Browse 
for Workstation dialog. If you were viewing the component list for a workstation, the 
workstation will already be listed in the Assign to Workstation section. 
c) Click on the OK button. 
 
The Manager will now display an Add New dialog, the title of which will reflect the type of 
component you are adding, for example, Add New Printer or Add New Software. 

3. Provide information about the component in the Add New dialog as follows: 
 
a) Click on the browse button in the Product box and find and select the product you want 
in the Browse for Product dialog.  
 If you cannot find the product you want, you have the option of creating a local product 
by clicking on the New button in the Browse for Product dialog. This button is available 
only if you are an enterprise administrator and have shut down the inventory process.  
b) Provide any additional information about the component, such as its serial number or 
asset tag. 
c) Click on the OK button when done. 

TIPS 

 Components can also be added with the Collection Editor.  
 When you add a component from a query, the component is assigned to the current workstation 

automatically. When you add a component by using the Add Data menu, you must browse for the workstation 
you want. 

Editing Component Data 
You may want to edit a component for any of the following reasons: 

 To add brand information about a monitor, printer, or keyboard. 
 To add a serial number or asset tag. 
 To provide version information about software. 

You can edit component data whenever the query results window includes component 
data. Depending on the data you have chosen to display in the query results window, you 
may be able to make all your changes directly in the window. For example, 

 You can change an asset tag, serial number, model number directly in the query results window or change 
data in a user-defined field. 

 You cannot change user, workstation, or product data directly in the query results window. Instead, click on 
the browse button in the cell and then make a selection in the dialog that appears. 

 You can find all instances of a particular value in a field and replace it with another value.  
 You can change additional component data in an Edit Properties dialog. This dialog shows all available 

information about a component. 
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To edit component data 

1. Run a component query to display the component(s) you want to edit. 
 
NOTE: You can also edit some component data when viewing the component list for a 
workstation. 

2. If you can edit the data directly, do so. Otherwise, click on the browse button and 
complete the dialog that appears. 

3. If you want to see all the available data for a component, do one of the following in the 
query results window:  

 Double-click on the row number of the component. 

 Click on the component row number and click on  on the query toolbar. 
 Right-click on the component row number and then click on Edit on the shortcut menu. 
 Click on the component row number, click on the Query menu, and click on Edit. 

The Manager will now display an Edit Properties dialog whose title will reflect the type of 
component you are editing, for example, Edit Software Properties. Not all the component 
data can be edited in the Edit Properties dialog. In particular, you can never change the 
component’s type. Also, if the Collector discovered the component, you will be limited in 
what you can change.  
 
The Edit Properties dialog includes a Scanned Value column that shows the data the 
Collector gathered. This may differ from the data in the Value column, which will include 
any changes that have been made.  

4. Make your changes in the Value column. 
5. Click on the OK button when done. 

TIPS 

 Components can also be edited with the Collection Editor .  
 The data shown in the Value column of the Edit Component Properties dialog is the data that appears in 

queries and reports. The data in the Scanned Value column is used "behind the scenes" by the Collector. 

Moving a Component 
Occasionally you may need to move components. For example, you may have to move a 
sound card from a workstation to a stockroom. To keep your inventory data accurate, you 
can move components with ZENworks Asset Management Manager to reflect the 
physical move.  

NOTE: When moving components, be sure to coordinate the Manager move with the physical move and with your 
inventory cycle, especially if the component was discovered by the Collector. Continuing the example above, suppose 
you use the Manager to move the sound card to a stockroom. If then you do not remove the sound card physically from 
the workstation, and another scan takes place, the Collector will find the sound card on the workstation. The inventory 
database will be incorrect because both the workstation and the stockroom will include the sound card. 

To move a component 

1. Either run a component query to locate the component(s) you want to move or run a 
workstation query and display the Component List window for a workstation. 

2. Select the component(s) you want to move. 
3. Right-click and click on Move on the shortcut menu. The Manager will display the Move 

Components dialog. 
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4. In the Move Components dialog, select the workstation or stockroom to which you want to 
move the component(s) as follows: 
 
a) Click on the Browse button. The Manager will display the Browse for Workstation dialog. 
 
b) In the Browse for Workstation dialog, find and select the workstation or stockroom to 
which you want to move the component(s) and then click on the OK button.  
c) Click on the OK button in the Move Components dialog. 

5. If you moved a component from a workstation that is part of the inventory cycle, be sure 
to remove the component physically from the workstation itself. 

Deleting a Component 
You can delete a component that was previously added with ZENworks Asset 
Management Manager or with the Collection Editor, but you cannot delete a component 
that the Collector discovered. 

To delete a component 

1. Either run a component query to locate the component(s) you want to delete or run a 
workstation query and display the Component List window for a workstation. 

2. Select the component(s) you want to delete by clicking on the row number. 
3. Do one of the following to delete the component:  

 Click on   on the query toolbar. 
 Right-click and click on Delete on the shortcut menu. 
 Click on the Query menu and click on Delete. 

TIP 

 Components that were added manually can also be deleted with the Collection Editor.  

Products 

About Products 
A product is a piece of hardware or software identified by the manufacturer, product 
name, and model/version. ZENworks Asset Management includes definitions of 
thousands of products so that they can be identified automatically during an inventory 
cycle. 

ZENworks Asset Management classifies all products using three pieces of information: 
product type, category, and subcategory. See ZENworks Asset Management Product 
Type, Category, and Subcategory Reference for a description of the classification built 
into ZENworks Asset Management. 

The product type classifies a product according to its inherent characteristics. For 
example, a software application, printer, and removable media drive all have different 
characteristics and so are different product types. ZENworks Asset Management includes 
numerous product types which you cannot change. You also cannot create additional 
product types. 
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Within each type, products are classified by category. For example, software products 
include categories such as accounting, graphics, or spreadsheet. Hardware product 
categories often correspond to the product type, for example, printer or monitor. 
ZENworks Asset Management includes many pre-defined product categories, and you 
can define additional categories of your own.  

Subcategories offer further classification of a product within a category. For example, 
payroll is a subcategory of accounting and inkjet is a subcategory of printer. ZENworks 
Asset Management includes many pre-defined product subcategories, and you can define 
additional subcategories of your own. 

You can examine product data either through reports or queries. If you want to change 
any of the data, you must run a query. 

NOTE: All ZENworks Asset Management users can examine product-related data, but only an enterprise administrator 
can manage it. 

An enterprise administrator can do the following: 

 Re-classify products by changing their associated category and/or subcategory.  
 Create local products and manage them. (Local products can be created only for software files discovered on 

Windows systems.) 

TIPS 

 An enterprise administrator can re-classify products and create and edit local products as long as the 
inventory process is not starting up. Once the process is started, these activities can take place. To reconcile 
and delete local products, on the other hand, the enterprise administrator must first stop the inventory 
process. 

 If local products are created while the inventory process is running, they will not be used during a scan until 
the inventory process is stopped and re-started. This gives you control over the timing of new or changed 
local products. 

See Also 

Running a Report  

About Local Products  

ZENworks Asset Management Product Type, Category, and Subcategory Reference  

About Product Queries 
A product query lets you locate product data in a variety of ways. Here are some 
examples of the kind of information you can obtain with a product query: 

 All products that are classified as database products. 
 All hard drive products that are smaller than 1 GB and that are installed on workstations in the enterprise. 
 All the local products that have been created. 
 All the products used in the Engineering department. 
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The Product folder of the ZENworks Asset Management Queries container includes the 
following pre-defined product queries for you to use: 

 All Local Products 
 Hardware Local Products 
 Software Local Products 

By nature, the ZENworks Asset Management queries are generic. You are likely, 
therefore, to need additional queries to locate specific product data, for example, the data 
that is associated with a particular manufacturer. You may be able to modify a ZENworks 
Asset Management query to accomplish your needs or you may have to create a product 
query from scratch. Sample Queries includes some sample product queries on which you 
can model your own. 

The information that you can examine with a product query includes the following: 

Product Field Description 
Date Created The time and date the product was created. 
Language The language of the product. 
License Count The number of licenses for this product. 
License ID An identifier that groups different versions of this 

product for licensing purposes. 
License Name The name of the product as used for licensing. 
License Required Whether the product is licensed. 
Manufacturer The manufacturer of the product. 
Model/Version The model or version of the product. 
Platform The operating system of the product. 
Product Name The name of the product. 
Product Source Software component that created the product. 
Product Type The product type, for example, hard drive, monitor, 

printer, or software. 
A product query also lets you: 

 Locate data in any user-defined product fields.  
 Locate products by referencing their classification, for example, listing all the products that are laser 

printers.  
 Locate products that are referenced by a component (included in a workstation). 

TIPS  

 A product query gives you information about products that are known to ZENworks Asset Management. 
Products are not necessarily components of any workstations. For example, MovieMan for Windows 1.1 by 
Logitech is a product recognized by ZENworks Asset Management, but it may not be on any workstations in 
your organization. To see which products actually exist on workstations, run a component query. 

 If you are an enterprise administrator and want to reconcile or delete local products, you must first shut 
down the inventory process. If you want to re-classify products or create or edit local products, you do not 
need to stop the inventory process. As long as the inventory process is not starting up, you will be able to 
perform these activities.  

See Also 
Sample Queries  
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Viewing Product Data with a Query 
If you want to view product data you can run a product query. All ZENworks Asset 
Management users can view product data. Only an enterprise administrator can manage 
products by re-classifying them or by creating or reconciling local products. 

NOTE: ZENworks Asset Management also includes many reports for examining product data. For a complete list, see 
ZENworks Asset Management Report Reference. 

To view product data with a query 

1. To use an existing product query, double-click on the query on the Query locator tab. 
 
To create a product query: 

a) Select the Personal Queries container and click on   on the toolbar. 
b) Click on Product Query.  
c) Define the filter criteria.  

2. Click on the Layout tab to make sure the fields you want will be displayed. 
3. Click on the Filter tab and then click on the Display Results button.  
4. Examine the data the Manager displays. If it is not quite what you wanted, edit the criteria 

that make up the query and then display its results again. 
5. (Optional) If you are an enterprise administrator, do any of the following:  

 Re-classify products. 
 Create a local product.  
 Edit a local product.  
 Delete a local product.  
 Reconcile local products.  

See Also 

Sample Queries  

Re-Classifying Products 
ZENworks Asset Management classifies products by type, category, and subcategory. 
You can never change the type of a product, but you can change its category or 
subcategory if you would prefer to classify the product differently. You have the option 
of defining additional categories and subcategories for a product type and then re-
assigning a product to one of these categories or subcategories.  

Only an enterprise administrator can re-classify products, and the inventory process 
cannot be starting up. 

Note: Updates to the Product Knowledgebase (using the Product Recognition Update 
command, available from the Administration menu) might include changes to product 
categories and subcategories. If you re-classify a product, the change you made might be 
overwritten when the Product Knowledgebase is updated. 
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To re-classify a product 

1. Be sure you have defined the product categories and subcategories you want to use.  
2. Run a product query to display the products you want to re-categorize. 
3. In the query results window, click on the Classification cell and select a different category 

or subcategory in the Browse for Product Classification dialog. The product will now be re-
classified. 

See Also 

ZENworks Asset Management Product Type, Category, and Subcategory Reference  



ZENworks Asset Management User's Guide 

222 

Creating Local Products 
About Local Products 

ZENworks Asset Management can identify thousands of different commercial products 
during the scan of a workstation. Nonetheless, your organization may use hardware and 
software products that are not among those that ZENworks Asset Management 
automatically identifies. These products can include commercial products, internally 
developed software, or custom-built PCs. You can add such products to the inventory 
database by defining local products.  

Notes:  

 Local products can be created only for software files discovered on Windows systems. 
 Novell regularly offers Product Recognition Updates (PRUs) to customers with ZENworks Asset Management 

technical support contracts. Contact your Novell Sales Representative for details. 

Local products can be created in one of two ways: 

 By workstation users with the Collection Editor. Workstation users need special permission to do this, 
however. 

 By an enterprise administrator with ZENworks Asset Management Manager. 

The Collection Editor and the Manager should not be used interchangeably when creating 
local products. Some local products should always be created with the Collection Editor; 
others should be created with the Manager. Follow these guidelines; 

 Use the Collection Editor for creating local products for systems only. If workstation users start to define 
their own local products, the result is likely to be multiple instances of the same products and inaccurate 
data in the inventory database. You will then have to clean up the discrepancies by reconciling the local 
products. Also, any software local products created with the Collection Editor will not include any 
recognition data. 

 Use the Manager for all software local products and all hardware except for systems. You can then include 
recognition data for software and provide consistent choices for hardware products in list boxes. Also, only 
an enterprise administrator can define local products with the Manager. As a result, you will have greater 
control over which local products are created and will avoid the situation in which numerous users are 
creating local products and inevitably introducing inconsistencies into the inventory database. 

 Use the Manager to manage all your local products by editing and deleting them and reconciling any 
discrepancies.  

TIP 

 You can create or edit local products while the inventory process is running. These local products, however, 
will not be used during a scan until you stop and re-start the inventory process. You can therefore control 
when the local products will be used during a scan. 

See Also 

Creating a Local Product  

Editing a Local Product  

Deleting a Local Product  

Reconciling Local Products  



Analysis and Maintenance 

223 

Creating a Local Product 

To create a local product you must be an enterprise administrator, and the inventory 
process can be running. The advantage of adding local products while the inventory 
process is running is that it lets you control when they are used during a scan: the local 
products will not be available until you stop and re-start the inventory process. For 
example, you may want to spend a few days working on local products and then 
distribute them all at the same time (by stopping and re-starting the inventory process). 

Note: Local products can be created only for software files discovered on Windows systems. 

In some cases you may already know that a local product is required, perhaps for an 
internally-developed piece of hardware or software. In other cases, you may find out you 
need to create a local product while: 

 Examining the results of a product query and noticing a missing product. 
 Searching for a product in the Browse for Product dialog and not finding it. For example, you may be trying 

to add a component to a workstation when you discover you need to create a local product. 

No matter what your starting point, the procedure for creating the local product is very 
similar. 

NOTE: You can also create a software local product while examining the results of an FNI query.  

When you create a software local product, you have the option of providing recognition 
data about the product so that the Collector can recognize the product automatically 
during future inventory cycles. You can provide this recognition data in one of two ways: 

 By selecting one or more files from the FNI list. 
 By selecting one or more product files and having ZENworks Asset Management Manager take information (if 

available) from the Version Resource Block (VRB) of the files, as a way to identify the files. VRB data is a 
block of identifying information within a file which many vendors include in their applications. If VRB data is 
available, the Collector can obtain the following if included by the vendor: company name, product name, 
product version, file version, and language. You can then examine this VRB data and correct it if necessary. 
(Sometimes the version information is not up-to-date and does not match the product.) 

To create a local product 

1. If you already know a local product is required, click on the Add Data menu and click on 
Product. The Manager will now display the Select Product Type to Create dialog.  
If you do not yet know which local products may need to be defined, run a product query. 
Then do one of the following:  

 Click on   on the query toolbar. 
 Right-click in the query results window and click on Add on the shortcut menu. 
 Click on the Query menu and click on Add. 

If you are looking for a product in the Browse for Product dialog, and do not find it, click 
on the New button in this dialog. 
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2. In the Select Product Type to Create dialog, select the type of product you are creating 
and click on the OK button.  
 
NOTE: You will not be able to change the product’s type later. 
 
The Manager will now display the Add New Product dialog. If you are defining a software 
local product, the dialog will include a Recognition Data tab; otherwise, it will not.  

3. Complete the Product Data tab: 
 
a) Click on the Classification field and then complete the Browse for Product Classification 
dialog to select a category and subcategory for the product.  
b) Complete the Manufacturer, Product Name, and Model/Version fields in the Add New 
Product dialog. 
c) If you are creating a hardware local product, click on the OK button when done. 

4. If you are creating a software local product, click on the Recognition Data tab. Here you 
can select one or more files on which you want to base recognition of the product. You 
then have the option of refining the recognition data that ZENworks Asset Management 
uses by editing the file data. This recognition data is also known as the "fingerprint." 

5. To use a file from the FNI list, click on the Add from FNI button on the Recognition Data 
tab and then complete the Browse for FNI Data dialog to find and select the FNI file you 
want.  
 
NOTE: You can also drag files from Windows Explorer to the Recognition Data tab. 

6. To select specific product files, click on the Add from File button and then select the 
file(s) in the Select File to Add dialog using standard Windows techniques. The Manager 
will automatically include Version Resource Block (VRB) information for a file if it is 
available. 
 
 NOTE: The more files you select, the more specific the recognition data will be. In other 
words, the Collector will need to find all the specified files on a workstation before it 
recognizes the product. Use this method with caution. 

7. To review and edit the recognition data being used for a file, select the file in the Files 
Included in Fingerprint section and click on the Edit button: 
 
a) Change any of the data in the Edit Software Fingerprint dialog. All the boxes except for 
the Folder box must include data.  
b) To review and change VRB data for a file, click on the Advanced button in the Edit 
Software Fingerprint dialog. Click on the OK button when done. 
 
 If no VRB information is available, all the Enable check boxes in the Advanced Fingerprint 
Information dialog will be clear.  
 
 If VRB information is available, the Enable check boxes for Product Name and Product 
Version will be selected. You can select or clear additional Enable check boxes in this 
dialog. You can also edit the text in any box for which the Enable check box is selected. 
For example, if you know this is MyProduct 2001 and not MyProduct 2000, you can change 
the name and the product will be identified correctly during future scans. 
 
 NOTE: You can change VRB version information either to broaden the recognition or to 
make it very specific. For example, if the Advanced Fingerprint Information dialog lists 
8.0a as the product version, you could delete the "a" to catch all the letter versions of 8.0 
or leave the "a" so the recognition is very specific. 
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8. To remove a file that was being used for recognition, select the file in the Files Included in 
Fingerprint section on the Recognition Data tab, click on the Delete button, and confirm 
the deletion.  

9. When the Recognition Data tab includes all the files you want to use for recognition, click 
on the OK button in the Add New Product dialog. 

10. When you are ready to use the local products during a scan, stop and re-start the inventory 
process.  

TIP  

 You can also create a local product when examining the results of an FNI query. 

Select Product Type to Create 

1. Select the type of local product you want to create, for example, software. 
 
NOTE: You will not be able to change the product type later. 

2. Click on the OK button. 

Product Data Tab 

The Product Data tab is part of the Add New Product dialog when you create a local 
product and the Edit Product Properties dialog when you edit a local product. The 
Product Data tab is for general information about the product. (If you are creating or 
editing a software local product, the dialog will also include a Recognition Data tab.) 

To complete the Product Data tab 

1. Click on the Classification field and then select a category and subcategory for the product 
in the Browse for Product Classification dialog.  

2. Enter data in the Manufacturer, Product Name, and Model/Version fields. 
3. If you are creating a hardware local product, click on the OK button when done. 
4. If you are creating a software local product, click on the Recognition Data tab. (There you 

can select one or more files on which you want to base recognition of the product.)  

Recognition Data Tab 

The Recognition Data tab lets you provide or edit recognition data for a software local 
product. On this tab you can select one or more files on which you want to base 
recognition of the product. You then have the option of refining the recognition data that 
ZENworks Asset Management uses by editing the file data. This recognition data is also 
known as the "fingerprint." 

To complete the Recognition Data tab 

1. To use a file from the FNI list, click on the Add from FNI button and then complete the 
Browse for FNI Data dialog to find and select the FNI file you want.  
 
NOTE: You can also drag files from Windows Explorer to the Recognition Data tab. 
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2. To select specific product files, click on the Add from File button and then select the 
file(s) in the Select File to Add dialog using standard Windows techniques. The Manager 
will automatically include Version Resource Block (VRB) information for a file if it is 
available. 
 
 NOTE: The more files you select, the more specific the recognition data will be. In other 
words, the Collector will need to find all the specified files on a workstation before it 
recognizes the product. Use this method with caution. 

3. To review and edit the recognition data being used for a file, select the file in the Files 
Included in Fingerprint section and click on the Edit button. Then complete the Edit 
Software Fingerprint dialog. 

4. To remove a file that was being used for recognition, select the file in the Files Included in 
Fingerprint section, click on the Delete button, and confirm the deletion. 

5. When the Recognition Data tab includes all the files you want to use for recognition, click 
on the OK button. 

Editing a Local Product 

If you need to change a local product, you can edit it with ZENworks Asset Management 
Manager. For example, you may want to provide different recognition data for a software 
product. 

To edit a local product you must be an enterprise administrator, and the inventory process 
cannot be starting up. The advantage of editing local products while the inventory process 
is running is that it lets you control when they are used during a scan: the changed local 
products will not be available until you stop and re-start the inventory process. For 
example, you may want to spend a few days working on local products and then 
distribute them all at the same time (by stopping and re-starting the inventory process). 

To edit a local product 

1. Run a product query to display the local product(s) you want to edit.  
2. If the data you need to change is in the query results window, edit it directly. 
3. If you need to change additional data such as recognition data for a software product, do 

one of the following:  

 Select the local product and click on   on the query toolbar. 
 Right-click on the local product, and click on Edit on the shortcut menu.  
 Select the local product, click on the Query menu, and click on Edit. 

4. Make your changes on the Product Data and/or Recognition Data tabs in the Edit Product 
Properties dialog and click on the OK button when done. 

5. When you are ready to use the changed local products during a scan, stop and re-start the 
inventory process.  
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Edit Software Fingerprint 

The Edit Software Fingerprint dialog lets you review and change the recognition data 
being used for a file. 

1. Change or delete data in the Basic File Information section. All the boxes except for the 
Folder box must include data.  

2. (Optional) To review and change VRB information for the file, click on the Advanced 
button. 

3. Click on the OK button when done. 

Advanced Fingerprint Information 

VRB data is a block of identifying information within a file which many vendors include 
in their applications. If VRB data is available, the Collector can obtain the following if 
included by the vendor: company name, product name, product version, file version, and 
language. The Advanced Fingerprint Information dialog lets you review and change VRB 
(version resource block) information for a file. If no VRB data is available, all the Enable 
check boxes are clear.  

1. If VRB information is available, the Enable check boxes for Product Name and Product 
Version are selected. Select or clear any additional Enable check boxes. 

2. (Optional) Edit the text in any box for which the Enable check box is selected. For 
example, if you know this is MyProduct 2001 and not MyProduct 2000, you can change the 
name and the product will be identified correctly during future scans. 

3. Click on the OK button. 

Displaying Local Products 
ZENworks Asset Management includes some pre-defined product queries for displaying 
local products, for example, you can display all local products, all hardware local 
products, or all software local products. In addition, you can create your own queries for 
displaying local products. For example, you may just want to see the local products 
associated with a particular department or those created with the Collection Editor. 

All products have a "source" of creation known as the product source. Most products are 
defined by Novell and have a product source of "ZENworks Asset Management-
Defined." A local product, on the other hand, may have one of the following product 
sources: Collection Editor, Collector, Manager, Translator/Migrator (if you have 
migrated data from NetCensus), or UNIX Translator. You can therefore use the product 
source as a filter criterion in a product query to locate local products. 

To display local products 

1. To use an existing product query, double-click on the query on the Query locator tab. 
 
NOTE: The Product folder of the ZENworks Asset Management Queries container includes 
three local product queries for your use: All Local Products, Hardware Local Products, and 
Software Local Products. 
 
To create a product query to locate a local product, select Product Query as your query 
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type, Product Source as the filter field, and Collection Editor, Manager, Collector, and/or 
Translator/Migrator as the value on which to filter.  

2. Click on the Display Results button in the query window. 
3. Examine the data the Manager displays. If it is not quite what you wanted, edit the criteria 

that make up the query and then display its results again. 

TIP 

 If you want to manage local products in any way, you must be an enterprise administrator. To reconcile or 
delete local products, the inventory process must also be stopped. (To create or edit local products, the 
inventory process need not be stopped; it just cannot be starting up.) 

Deleting a Local Product 
If a local product is no longer being used, you can delete it.  

CAUTION: When you delete a local product, you delete all instances of the product on all workstations. The product is 
no longer considered a component of any workstation. 

To delete a local product you must be an enterprise administrator, and the inventory 
process must be stopped. Therefore, you may want to time the deletion of local products 
so it has the least impact on your inventory cycles. It is simpler and faster to stop the 
inventory process when you are not in the middle of an inventory cycle, and workstations 
are not being scanned 

To delete a local product 

1. Shut down the entire inventory process from the Control menu.  
2. Run a product query to display the local product(s) you want to delete. 
3. Do one of the following:  

 Select the local product and click on  on the query toolbar. 
 Right-click on the local product and click on Delete on the shortcut menu. 
 Select the local product, click on the Query menu, and click on Delete. 

4. Confirm the deletion. 
5. If you have finished working with local products, re-start the inventory process from the 

Control menu. Until you do, no workstations will be scanned and no tasks will run. 
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Reconciling Local Products 
If more than one person has created local products at your organization, the inventory 
database may include misleading information about them. A misspelling or different way 
of referring to a product (HP versus Hewlett Packard, for example) can result in more 
than one instance of the same product in the database. In addition, a user may have 
created a local product for a product that already existed under a slightly different name. 
As a result, the data you see in reports and queries will be less accurate. Product counts 
will be misleading, and you will have difficulty knowing whether you are accounting for 
all the products in your organization because the same product appears under different 
names. 

ZENworks Asset Management lets you resolve local product discrepancies in your 
inventory database. You can identify all the instances of a local product that should be the 
same, select the "official" version of the product, and merge the other instances with it. 
The result will be one product.  

You reconcile local products by running a product query to display the local products you 
want to check. If you notice any discrepancies you can reconcile them by selecting one 
product to serve as the target product and then selecting the products that should be 
merged with this target product. (You can also create a new local product to serve as the 
target product.) 

To reconcile local products you must be an enterprise administrator, and the inventory 
process must be stopped. Therefore, you may want to time the local product 
reconciliation so it has the least impact on your inventory cycles. It is simpler and faster 
to stop the inventory process when you are not in the middle of an inventory cycle, and 
workstations are not being scanned. 

CAUTION: When you reconcile software local products, recognition data is kept only for the target product. Any 
recognition data for the products being reconciled is discarded. As a result, Novell strongly recommends that before 
you reconcile software local products you look closely at the recognition associated with them. Based on this analysis, 
make the product with the most accurate recognition the target product, even if, for example, it is misspelled. After 
the reconciliation you can always edit the product if necessary. 

To reconcile local products 

1. Shut down the entire inventory process from the Control menu.  
2. Run a product query to display the local products you want to check for discrepancies. 
3. Select the products that need reconciling. All the products you select must be of the same 

type  

. (If the product you want to use as a target product is in the query results window, you 
can select it now, but you will also have the opportunity to select it later.) 
 
 NOTE: If you discover that the products you want to reconcile do not have the same 
classification, you will need to re-classify them before you can continue. 
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4. Do one of the following to begin the reconciliation process:  

 Click on  on the query toolbar. 
 Right-click in the query results window and then click on Reconcile Local Products on the shortcut 

menu. 
 Click on the Query menu and click on Reconcile Local Products. 

5. In the Reconcile Local Products dialog, specify the target product in one of these ways:  
 Double-click on a product in the These Products Will be Reconciled section. 
 Select the product from the drop-down list in the Into This Product section. 
 Click on the Browse button to find and select a product in the Browse for Product dialog. If the product 

you want is not listed, you can click on the New button in this dialog to create a new local product. Be 
sure to create a product of the same type as the products you are reconciling. 

If the target product is a product listed in the These Products Will be Reconciled section, 
its status will now read "Target." 

6. In the These Products Will Be Reconciled section, select the products you want to combine 
with your target product.  

7. Check your selections. You cannot undo a reconciliation once you perform it.  
8. Click on the Reconcile button to start the reconciliation. 

After you click on the Reconcile button, the Status column may include one of the 
following messages: 
 

Pending  The product is ready for reconciliation.  

In progress  The reconciliation is taking place.  

Retry  An error caused the reconciliation to be tried again.  

Failed  The reconciliation failed after three attempts. The most 
likely reason for an error is an action by another user, 
for example, a product you selected for reconciliation 
was deleted or modified. Try the reconciliation again. If 
the failure recurs, check the NetCMgrEvent log file for 
the day. See Error Logs and Files.  

Interrupted  The reconciliation was canceled by the user so was not 
completed.  

9. After you finish reconciling local products, start the inventory process again from the 
Control menu. Until you do, no workstations will be scanned and no tasks will run.  
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Reconcile Local Products 
The Reconcile Local Products dialog lets you fix discrepancies in local products. In this 
dialog you must select one product as the official "target" product and identify all the 
products you want to merge with it. 

CAUTION: When you reconcile software local products, recognition data is kept only for the target product. Any 
recognition data for the products being reconciled is discarded. As a result, Novell strongly recommends that before 
you reconcile software local products you look closely at the recognition associated with them. Based on this analysis, 
make the product with the most accurate recognition the target product, even if, for example, it is misspelled. After 
the reconciliation you can always edit the product if necessary. 

To reconcile local products 

NOTE: If you discover that the products you want to reconcile do not have the same classification, you will need to re-
classify them before you can continue. 

1. Specify the target product in one of these ways:  
 Double-click on a product in the These Products Will be Reconciled section. 
 Select the product from the drop-down list in the Into This Product section. 
 Click on the Browse button to find and select a product in the Browse for Product dialog. If the product 

you want is not listed, you can click on the New button in this dialog to create a new local product. Be 
sure to create a product of the same type as the products you are reconciling. 

If the target product is a product listed in the These Products Will be Reconciled section, 
its status will now read "Target." 

2. In the These Products Will Be Reconciled section, select the products you want to combine 
with your target product. (The products listed in this section are those you selected in the 
query results window before you began the reconciliation process.) 

3. Check your selections. You cannot undo a reconciliation once you perform it. 
4. Click on the Reconcile button to start the reconciliation. 

After you click on the Reconcile button, the Status column may include one of the 
following messages: 

Pending The product is ready for reconciliation. 

In progress The reconciliation is taking place. 

Retry An error caused the reconciliation to be tried again. 

Failed The reconciliation failed after three attempts. The most 
likely reason for an error is an action by another user, 
for example, a product you selected for reconciliation 
was deleted or modified. Try the reconciliation again. If 
the failure recurs, check the NetCMgrEvent log file for 
the day. SeeError Logs and Files. 

Interrupted The reconciliation was canceled by the user so was not 
completed. 

5. After you finish reconciling local products, start the inventory process again from the 
Control menu. Until you do, no workstations will be scanned and no tasks will run. 
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Users 

About Workstation Users 
ZENworks Asset Management tracks two types of users associated with workstations: 
primary users and technical contacts. A primary user is the user chiefly associated with a 
workstation. A technical contact might be the person in the IT department responsible for 
particular workstations. You may or may not track technical contacts in your 
organization.  

As you work with your inventory data, you may want to do any of the following with 
users: 

 View user data.  
 Add a user.  
 Edit user data.  
 Delete a user.  

You can examine user data through queries.  

NOTE: An analyst can view user data, but cannot change it in any way; other ZENworks Asset Management users can 
change user data. 

See Also 

About User Queries  
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About User Queries 
A user query lets you locate user data in a variety of ways. Here are some examples of 
the kind of information you can obtain with a user query: 

 All the data for a specific user. 
 All the users with a workstation that has more than 64 MB of memory. 
 All the technical contacts at a particular site. 

The User folder of the ZENworks Asset Management Queries container includes a pre-
defined user query for you to use: All Workstation Users. By nature, this query is generic. 
You are likely, therefore, to need additional queries to locate specific user data, for 
example, the data that is associated with particular workstations. You may be able to 
modify the ZENworks Asset Management query to accomplish your needs or you may 
have to create a user query from scratch. Sample Queries includes some sample user 
queries on which you can model your own.  

The information that you can examine with a user query is as follows: 

User Field Description 

Email  The user's e-mail address. 

Fax The user's fax number. 

First Name The user's first name. 

Last Name The user's last name. 

Middle Name The user's middle name. 

Phone  The user's phone number 

Second Phone  The user's second phone number. 

A user query also lets you: 

 Locate data in any user-defined user fields.  
 Locate users by referencing workstation data, for example, site or department.  

See Also 

Creating a Query  
Viewing User Data  
Adding a User  
Editing User Data  
Deleting a User  
Sample Queries  
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Viewing User Data with a Query 
You can view data about a workstation user by running a user query. 

To view user data 

1. To use an existing user query, double-click on the query on the Query locator tab. 
To create a user query: 
 

a) Select the Personal Queries container and click on   on the toolbar. 
b) Click on User Query.  
c) Define the filter criteria.  

2. Click on the Layout tab to make sure the fields you want will be displayed. 
3. Click on the Filter tab and then click on the Display Results button.  
4. Examine the data ZENworks Asset Management Manager displays. If it is not quite what you 

wanted, edit the criteria that make up the query and then display its results again. 
5. (Optional) Do any of the following:  

 Edit user data.  
 Add a new user.  
 Delete a user.  

See Also 

Sample Queries  

Adding a User 
You may want to add a workstation user if, for example, someone new is to be a 
technical contact for a group of workstations. After adding the user, you can use the 
replace feature to change the technical contact person’s name for all the affected 
workstations. 

In some cases you may already know you need to create a user, for example, a new hire. 
In other cases, you may find out you need to create a user while: 

 Examining the results of a query and noticing a missing user. 
 Searching for a user in the Browse for User dialog and not finding the user. 

To add a user 

1. If you already know you need to add a user, click on the Add Data menu and click on User. 
ZENworks Asset Management Manager will display the Add New User dialog.  
If you have run a user query and realize a user is missing, do one of the following:  

 Click on a row number and click on   on the query toolbar. 
 Right-click on a row number and click on Add on the shortcut menu. 
 Click on the Query menu and click on Add. 

If you are looking for a user in the Browse for User dialog, and do not find him or her, click 
on the New button in this dialog. 
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2. Provide information about the user in the Add New User dialog and click on the OK button 
when done. 
 
The user now exists in the inventory database but is not associated with any workstations. 
If you have created the primary user for a workstation, run a workstation query to locate 
the workstation and then select your new user as the workstation’s primary user. If you 
have created a technical contact to replace an existing technical contact, run a 
workstation query to find all the workstations associated with that technical contact and 
then use the replace feature.  

TIP 

 You can also add a primary user to a workstation by running a workstation query to find the workstation and 
then clicking on the browse button in the Primary User field. In the Browse for User dialog, click on the New 
button and complete the Add New User dialog. The Manager then automatically assigns the new user to the 
selected workstation. 

Editing User Data 
If you need to change some data about a workstation user, for example, correct the 
spelling of a name or provide an e-mail address, you can run a user query and then make 
your changes. Depending on the data you have chosen to display in the query results 
window, you may be able to make all your changes there. Otherwise, you always have 
the option of displaying the Edit User Properties dialog. This dialog shows all the 
available information about a user. 

NOTE: You can also edit some user data when you run a workstation query.  

To edit user data 

1. Run a user query to display the user(s) you want to edit.  
2. If the data you need to change is in the query results window, edit it directly. 
3. If you want to see all the available data for the user, do one of the following in the query 

results window:  
 Double-click on the row number. 

 Click on the row number and click on   on the query toolbar. 
 Right-click on the row number and then click on Edit on the shortcut menu. 
 Click on the row number, click on the Query menu, and click on Edit. 

ZENworks Asset Management Manager will display the Edit User Properties dialog. Make 
changes and click on the OK button when done. 
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Add New User/Edit User Properties 
The Add New User dialog lets you create a workstation user; the Edit User Properties 
dialog lets you change information about the user. 

 Enter or change information about the user and click on the OK button when done. 

If you have added a user, the user now exists in the inventory database but is not 
associated with any workstation. If you have created the primary user of a workstation, 
run a workstation query to locate the workstation and then select your new user as the 
workstation's primary user. If you have created a technical contact to replace an existing 
technical contact, run a workstation query to find all the workstations associated with that 
technical contact and then use the replace feature. 

See Also 

Finding and Replacing Data  

Deleting Users 
If you no longer want a particular workstation user in the inventory database, you can 
delete the user. 

NOTE: When you delete a user, ZENworks Asset Management Manager removes the user from all the workstations with 
which the user was associated. 

To delete a user 

1. Run a user query to display the user you want to delete.  
2. Do one of the following to delete the user:  

 Click on the row number and click on   on the query toolbar. 
 Right-click on the row number and then click on Delete on the shortcut menu. 
 Click on the row number, click on the Query menu, and click on Delete. 

3. Confirm the deletion. 

FNI Data 

About File-Not-Identified (FNI) Data 
 Software Applications – software that has been identified and reported through the ZENworks Asset 

Management Knowledgebase (also known as the Product Recognition Database). 
 
To collect those applications found in the ZENworks Asset Management Knowledgebase,  

Select the Collect Software Applications check box in the Collector Tab of a Collection Option set. 

 Software Files – software that has been discovered during a scan, but is not currently found in the ZENworks 
Asset Management Knowledgebase. These files have previously been known as Files-not-identified, or FNI. 
 
To collect information about software not found in the ZENworks Asset Management Knowledgebase,  

Select the Collect Software File Information check box in the Collector Tab of a Collection Option set. 

 Files-not-identified (FNI) – former term for what is now known as Software Files in the Collector Tab of a 
Collection Option set. 
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If you are using the default option set with its initial settings, the Collector gathers no 
FNI data by default. If you select Collect Software File Information, the Collector 
gathers EXE files by default. You can specify any additional extensions you want to 
collect. 

NOTE: If the Collector has identified product files in a particular folder, or if you have created a local product based 
on files in a particular folder, no FNI data will be listed for that folder. 

If you collected FNI data, you can examine it with ZENworks Asset Management 
Manager by running a query or report, or from the Web Console by creating a custom 
report with Software Files as the selected type.  

NOTE: All ZENworks Asset Management users can examine FNI data, but only an enterprise administrator can manage 
it. A Web Console user can a report if the user is included in the report’s scope. 

An enterprise administrator can do the following: 

 Use FNI data to create a software local product. Basing a local product on FNI data automatically provides 
recognition data for the product. As a result, the Collector will be able to identify the product during 
subsequent scans. 

 Specify that certain files be excluded from future scans to decrease the amount of FNI data that is gathered. 
The amount of FNI data that the Collector gathers can be considerable.  

TIP 

 You can use the ZENworks Asset Management Usage Monitor to analyze how the applications that result in FNI 
data are being used. 

See Also 

Controlling FNI Data Collection  

About FNI Queries  

Running a Report  

About FNI Queries 
An FNI query lets you locate FNI data in various ways. Here are some examples of the 
kind of information you can obtain with an FNI query: 

 A specific FNI for which you want to create a local product. 
 All FNIs that may be drivers. 
 All FNIs in the Sales department. 

The FNI folder of the ZENworks Asset Management Queries container includes the 
following pre-defined FNI queries for you to use: 

 All FNIs 
 FNIs in Program Files Folder 
 FNIs with .exe Extension 
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By nature, the ZENworks Asset Management queries are generic. You are likely, 
however, to need additional queries to locate specific FNI data, for example, for a 
specific product or different file extension. You may be able to modify a ZENworks 
Asset Management query to accomplish your needs or you may have to create an FNI 
query from scratch. Sample Queries includes some sample FNI queries on which you can 
model your own. 

The information that you can examine with an FNI query includes the following: 

FNI Field Description 

File Date The date of the file. 

File Extension The file extension. 

File Name The name of the file. 

File Size The size of the file. 

Startup Count The number of times the file was started (opened) 
since the last scan. 

Subdirectory The folder in which the file resides. 

Total Active Seconds The time the file was active. 

Total Runtime Seconds The time the file was open. 

VRB Company Name The VRB (version resource block) company 
name. 

VRB File Version The VRB file version. 

VRB Language The VRB language. 

VRB Product Name The VRB product name. 

VRB Product Version The VRB product version. 

An FNI query also lets you locate FNIs by referencing workstation fields, for example, 
by site or department. 

See Also 

Creating a Query 
Viewing FNI Data  
Creating a Local Product Based on FNI Data  
Excluding FNIs from Future Scans  
Sample Queries  
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Viewing FNI Data with a Query 
You can view FNI data by running an FNI query. All ZENworks Asset Management 
users can examine FNI data, but only an enterprise administrator can manage it by 
creating local products based on FNI data or by excluding FNI data from future scans. 

To view FNI data 

1. To use an existing FNI query, double-click on the query on the Query locator tab. 
To create an FNI query: 

a) Select the Personal Queries container and click on   on the toolbar. 
b) Click on FNI Query.  
c) Define the filter criteria.  

2. Click on the Layout tab to make sure the fields you want will be displayed. 
3. Click on the Filter tab and then click on the Display Results button.  
4. Examine the data ZENworks Asset Management Manager displays. If it is not quite what you 

wanted, edit the criteria that make up the query and then display its results again. 
5. (Optional) If you are an enterprise administrator, do either of the following:  

 Create a software local product based on the FNI data. 
 Exclude an FNI from future scans.  

TIPS 

 ZENworks Asset Management also includes breakdown and detail reports for FNI data. For example, you can 
run a breakdown report to see the top (n) FNIs. Such information can help you make decisions about creating 
local products.  

 To see which workstations include a particular FNI, create a workstation query using Contains FNI as the 
filter field.  

See Also 

Sample Queries  

Creating a Local Product Based on FNI Data 
If you are an enterprise administrator, you have the option of creating a software local 
product based on the FNI data you have displayed with an FNI query. The FNI data will 
provide the recognition data the Collector will use to recognize the product on 
workstations during future inventories. 

You can create local products while the inventory process is running. These local 
products, however, will not be used during a scan until you stop and re-start the inventory 
process. You can therefore control when the local products will be used during a scan.  

NOTE: When you create a local product based on FNI data, the FNI(s) remain listed until all workstations have been re-
scanned.  

To create a local product based on FNI data 

1. Run an FNI query to locate the FNI data on which you want to base a local product. 
2. Select all the FNI(s) you want to use for recognition by clicking on their row numbers while 

the Shift or Ctrl key is pressed down. 
3. Right-click and then click on Create Local Product on the shortcut menu.  
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4. Complete the Product Data tab of the Add New Product dialog: 
 
a) Click on the browse button in the Classification box and complete the Browse for 
Product Classification dialog to select a category and subcategory for the product.  
b) Provide information about the manufacturer, product name, and model/version 
product. 
 The Recognition Data tab will already include the FNI(s) you selected in step 2.  
 
c) Click on the OK button when done. 

5. When you are ready to use the new local products during a scan, stop and re-start the 
inventory process. 

Excluding FNIs from Future Scans 
After examining FNI data, you may want to exclude some FNI data from future scans so 
that it is ignored during the inventory process. For example, you can choose to exclude 
all FNIs with a particular file extension, all FNIs with a particular file name, and all FNIs 
that are found in a particular folder. By excluding any FNIs that you consider irrelevant 
or accounted for, you will reduce the amount of FNI data you will need to analyze and 
manage. 

You must be an enterprise administrator to exclude FNIs from the inventory process.  

To exclude FNIs from future scans 

1. Run an FNI query to display the FNI data you may want to exclude from future scans. You 
have a choice of excluding data by file name, extension, or folder. For example, if you 
want to exclude FNIs with a particular extension, your query should use the extension as 
its criterion.  

2. In the query results window, select the data you want to exclude by clicking on the row 
number(s). 

3. Do one of the following:  
 Right-click and click on Exclude Extension, Exclude FNI, or Exclude Folder.  
 Click on the Query menu and click on Exclude Extension, Exclude FNI, or Exclude Folder. 

4. When asked, indicate that it is OK to delete the indicated FNI data. 
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Stopping and Starting the Inventory Process 

In some situations, for example, if you want to work with user-defined fields, delete a 
product category, or reconcile or delete local products, you must stop the entire inventory 
process. ZENworks Asset Management gives you two choices: 

 You can stop the inventory process immediately. In this case, ZENworks Asset Management will cancel any 
active scans and tasks and discard any workstation inventory files (.wif) that were waiting to be loaded.  

 You can stop the inventory process after a specified amount of time so that ZENworks Asset Management has 
a chance to complete any scans, tasks, or loads in progress.  

What happens when you stop the inventory process 
When you stop the inventory process, you stop the following: 

 Collection Servers - processing of collections and the updating of clients  
 Task Servers – processing of reports, purges and network discovery tasks. 

  

Notes about starting and stopping:  

 Unless you are working with user-defined fields, other ZENworks Asset Management users can still log onto 
ZENworks Asset Management Manager. 

 After you complete the activity which required you to stop the inventory process you must start the process 
again. Until you do, no collections will take place on any workstations and no tasks will run.  

 Only an enterprise administrator can stop and start the inventory process. 
 While the inventory process is shutting down, you can check the status of your Collection Servers, Task 

Servers, and tasks in the process control panel. The status of the servers will read "Inventory Stopped" as 
they are stopped. If, however, you previously stopped a server yourself, its status will read "Stopped" to 
indicate it was not stopped as a result of the inventory process shut-down. 

 While the inventory process is starting, you can check the status of your Collection Servers and Task Servers 
in the process control panel. 

 If you stopped a Collection Server or Task Server yourself (with the Stop/Start Server command), starting 
the inventory process will not start up the server again. When you start the inventory process, ZENworks 
Asset Management starts up only the servers it stopped as part of the inventory shut-down process. Any 
servers you stopped yourself you must start again with the Stop/Start Server command on the Control menu. 

To stop the inventory process: 

1. Click on the Control menu and click on Stop Inventory Process. 
2. Click on the Yes button to confirm that you want to stop the inventory process.  

 
If no workstations are currently being scanned and no tasks are running, ZENworks Asset 
Management will stop the inventory process and inform you when it has done so. 
 
Otherwise, the Manager will inform you if:  

 Any workstations are currently being scanned. 
 Any tasks are running. 

The Manager will also give you the choice of stopping immediately or waiting some number 
of minutes for the scans and/or tasks to complete. By default, the inventory process is 
stopped immediately.  
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3. If you want to wait for scans and/or tasks to complete, select the Wait option, specify the 
number of minutes you want to wait, and click on the OK button. Otherwise, just click on 
the OK button. 

4. If you opted to wait, and the time you specified has gone by without all the scans or tasks 
being completed, you will be given three choices:  

 You can stop the process immediately. Select the Stop Immediately button and click on the OK button. 
 You can continue to wait for some number of minutes again. Select the Wait option button, enter the 

number of minutes, and click on the OK button. 
 You can change your mind about stopping the inventory process at this time and click on the Restart 

button. This will start up the inventory process again. 

The Manager will inform you when the inventory process is stopped (or re-started). 

To start the inventory process 

 Click on the Control menu and click on Start Inventory Process. 

The Manager will inform you when the inventory process is started again. 
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About User-Defined Fields 

A user-defined field is a field that you can create in the ZENworks Asset Management 
inventory database to track additional information about a component, product, 
workstation user, or workstation, for example, a purchase date or home telephone 
number. Once you have defined your own fields, information can be entered in them 
either with the Collection Editor during the inventory process or with ZENworks Asset 
Management Manager as part of inventory maintenance. 

Some examples of user-defined fields include: 

 For components, a purchase date, a purchase price, or warranty length. When you define your own field for a 
component, it is available for all components, but you do not need to provide data in this field in all cases. 

 For products, an indication that this is an approved product or one that makes up a standard configuration. 
You can then check individual workstations for compliance. 

 For workstation users, an employee number or home telephone number. 
 For workstations, purchasing or warranty information.  

User-defined fields affect the entire organization so you must be an enterprise 
administrator to create, edit, or delete them. In addition, to prevent inconsistencies in the 
inventory database, the inventory process has to be stopped while you are working with 
user-defined fields. After you finish, you must re-start the inventory process.  

TIPS 

 Novell strongly suggests you spend some time thinking about what additional data you need before you 
create your own database fields. When you create your own fields, the consequences are far-reaching 
because you change the structure of the database. In addition, if you are using Microsoft SQL Server 7.0 or 
2000 with 6.5 compatibility mode enabled, you will not be able to remove any user-defined fields after you 
create them. 

 You may find it helpful to identify and create the fields you want before you start using ZENworks Asset 
Management on a large scale. That way you can obtain the additional data you want right from the start. 

See Also 

Creating a User-Defined Field  

Editing a User-Defined Field  

Deleting a User-Defined Field  
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About Product Classification 

 
A product is a piece of hardware or software. ZENworks Asset Management classifies 
all products using three pieces of information: product type, category, and subcategory. 

The product type classifies a product according to its inherent characteristics, for 
example, software, printer, or monitor. ZENworks Asset Management includes pre-
defined product types which cannot be changed. 

A product category classifies a product within a product type. For example, software 
products include categories such as accounting, graphics, or spreadsheet. Hardware 
product categories in some cases have the same name as the product type, for example, 
printer or monitor; in other cases, they are different, for example, processor is a category 
of the CPU type. ZENworks Asset Management includes many pre-defined product 
categories, but you can also define your own. 

A subcategory provides further classification of a product within a product category. For 
example, payroll is a subcategory of the accounting category and inkjet is a subcategory 
of the printer category. ZENworks Asset Management includes many pre-defined product 
subcategories, but you can also define your own. 

Novell keeps its product classification scheme as up-to-date as possible with industry 
trends, but you may have some products representing an unusual or very new technology. 
You may also have some software applications you have developed in-house that you 
want to classify differently. In any of these cases you may want to define additional 
product categories or subcategories so that you can classify your products accurately. For 
example, you may want to add a category named CD-RW to the CD/DVD Drive product 
type to account for your latest CD-RW acquisitions. 

If you define additional product categories or subcategories, you can then rename or 
delete them. You can never rename or delete the categories and subcategories supplied by 
Novell. 

Any additional categories or subcategories you define can be used to do the following: 

 Set up filter criteria for queries or reports.  
 Classify local products.  
 Re-classify products.  

Product categories and subcategories affect the entire ZENworks Asset Management 
installation so you must be an enterprise administrator to create, rename, or delete them.  

See Also 

Adding a Product Category or Subcategory  

Renaming a Product Category or Subcategory  

Deleting a Product Category or Subcategory  
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Adding a Product Category or Subcategory 

To see the product classification that is included with ZENworks Asset Management, see 
ZENworks Asset Management Product Type, Category, and Subcategory Reference. You 
can also see the available classification in the Manage Product Classification dialog in 
ZENworks Asset Management Manager, as described in the procedure below. By seeing 
what is already included in ZENworks Asset Management, you can decide whether you 
need to define any additional product categories or subcategories. 

You can add a product category to any product type. Within a type, a product category 
must be uniquely named, but different product types may have categories with the same 
name.  

You can add a subcategory to any product category defined by Novell or to one you have 
defined. Again, within a category a subcategory must be uniquely named, but different 
categories may have subcategories with the same name. 
NOTE: Only an enterprise administrator can add product categories or subcategories.  

To add a product category or subcategory 

1. Click on the Administration menu and click on Product Classification. 
 
The Manage Product Classification dialog lists all the product types. Within each type is 
one or more product categories. Within each category is one or more subcategories.  

2. To define an additional category for a product type, do the following: 
 
a) Select the product type to which you want to add a category. 
b) Click on the New button. 
c) Enter a name for the category in the Add Product Category dialog and click on the OK 
button. The category you added will have a different icon in the Manage Product 
Classification dialog to distinguish it from the categories defined by Novell. 
 
NOTE: If you define a new category, be sure to define at least one subcategory for it. 
Product classification requires three pieces of information: type, category, and 
subcategory. If you do not define a subcategory for a category you have added, the 
product classification will be incomplete and the product category will not be available as 
a selection in other parts of the product, for example, when creating queries.  

3. To define an additional subcategory for a product category, do the following: 
 
a) Select the product category to which you want to add a subcategory. 
b) Click on the New button. 
c) Enter a name for the subcategory in the Add Product Subcategory dialog and click on 
the OK button. The subcategory you added will have a different icon in the Manage 
Product Classification dialog to distinguish it from the categories defined by Novell. 

4. When done, close the Manage Product Classification dialog. 

TIP 
 If you have any custom applications, create a subcategory named Custom in the applicable software 

category. 

See Also 
Renaming a Product Category or Subcategory  
Deleting a Product Category or Subcategory  
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Renaming a Product Category or Subcategory 

You can change the name of a product category or subcategory that you added, but not of 
one supplied by Novell.  

NOTE: Only an enterprise administrator can rename product categories or subcategories.  

To rename a product category or subcategory 

1. Click on the Administration menu and click on Product Classification. 
2. In the Manage Product Classification dialog, either select the product category or 

subcategory you want to rename and click on the Rename button or double-click on the 
product category or subcategory. 

3. Enter the new name in the Rename Category or Rename Subcategory dialog and click on 
the OK button. 

4. Close the Manage Product Classification dialog. 

Deleting a Product Category or Subcategory 

 
You can delete a category or subcategory that you added, but not one that was supplied 
by Novell. If the category or subcategory that you want to delete has products associated 
with it, you will not be able to delete it until you have assigned the products to a different 
category or subcategory. If you delete a category that includes subcategories, the 
subcategories will be deleted also. 

NOTE: Only an enterprise administrator can delete product categories or subcategories, and the inventory process 
must be stopped. 

To delete a product category or subcategory 

1. Shut down the inventory process from the Control menu.  
2. If the product category or subcategory you want to delete has products associated with it, 

re-assign them to a different category or subcategory.  
3. Click on the Administration menu and click on Product Classification. 
4. In the Manage Product Classification dialog, select the product category or subcategory 

you want to delete. 
5. Click on the Delete button.  
6. If you are deleting a category that includes subcategories, confirm the deletion. (The 

subcategories will be deleted, too.) 
7. Close the Manage Product Classification dialog. 
8. Start the inventory process again from the Control menu. 
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Managing Tasks 

Scheduling a Task 
In ZENworks Asset Management, you can schedule tasks. If you choose not to schedule a 
task, ZENworks Asset Management will process the task according to the following 
default schedule settings: 

 A task runs as soon as possible after you submit it. This is the cycle option named Immediately. 
 A task is not restricted to run within a particular range of dates. 
 A task runs with normal priority. 
 A task is considered late if 60 minutes have passed after its scheduled time, and it has not run. A task may be 

late if a number of tasks are scheduled for the same time and some take a while to run. 
 A late task runs as soon as ZENworks Asset Management can start it, even though its scheduled time has 

elapsed. 

To schedule a task 

1. In the Purge Database dialog, the Submit Report dialog, or Product Recognition Update 
dialog, or Active Directory Import dialog, click on the Schedule button. 

2. In the Cycle section of the Schedule Task dialog, select Yearly, By the Month, By the Day, 
By the Hour, Once, or Immediately. The default is Immediately. Your selection here will 
affect other choices you can make in the Cycle section. 
 
NOTE: For PRUs, Novell recommends a monthly cycle. 
 
a) (Optional) For all cycles except Immediately, define the overall dates within which the 
task can run by entering the dates in the Beginning and Ending boxes. By default, the 
beginning date is the earliest date the selected cycle could start, and there is no ending 
date. To provide an ending date, first select the check box. 
Either type a date in the Beginning or Ending box or click on the down-arrow in the box to 
select a date from a calendar. On the calendar, click on the arrows to go forward or 
backward by a month at a time or click on the month or year to select another. To select a 
specific date, click on it. 
b) If you selected Yearly, either indicate a particular day in a month, for example, every 
December 7th, or, indicate a specific day of a specific week of a month, for example, the 
first Monday of December. The default is the first Monday of the current month. 
c) If you selected By the Month, either indicate a specific day every x number of months, 
for example, the seventh day of every third month, or, indicate a specific day of the week 
every x number of months, for example, the second Monday of every month. The default is 
the first Monday of every month. 
d) If you selected By the Week, select a day of the week for the task to run and specify 
every x number of weeks. For example, you may want the task to run every three weeks 
on Mondays. The default is every week on Monday. 
e) If you selected By the Day, either select a day of the week for the task to run (you can 
select more than one day) or specify every x number of days, for example, every five days. 
The default is every day. 
f) If you selected By the Hour, select an interval, for example, every eight hours. The 
default is every hour. 
g) If you selected Once, specify a date. 
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3. In the Task Options section, specify a starting time for the task in the Start At box. The 
default is 12:00 P.M. Keep the following in mind:  

 ZENworks Asset Management Manager takes the starting time into account when calculating the first 
day a task will run. Suppose it is 2:00 P.M. on Friday, August 18th, and you leave the default starting 
time of 12:00 P.M. You then schedule the task to run every Friday, starting August 18th. The task will 
first run on Friday, August 25th, unless you change the starting time to be after 2:00 P.M. 

 In an Enterprise Deployment of ZENworks Asset Management, a task will run as scheduled based on your 
local time, even if the Task Server is in a different time zone. For example, suppose you are running 
the Manager on a machine in the Eastern (U.S.) time zone and you schedule a task to run at midnight. If 
the Task Server is in the Central (U.S.) time zone, the task will run at 11:00 P.M. Central time, 12:00 
A.M. Eastern time. 

4. To change the priority of the task, select one of the following in the Priority box: 

High The task will run as soon as system resources become available. 

Normal The task will run as scheduled, after any high priority tasks but 
before any low priority ones. This is the default. 

Low The task will run after all higher priority tasks have run. 

5.  
6. To specify how a late task should be handled, click on the Late Task button and complete 

the Late Task Options dialog. 
7. Click on the OK button to return to the Submit Report, Purge Database, or Product 

Recognition Update dialog. 

TIP 

 If you submit a task and then decide you need to change its schedule or priority, you can do so on the Tasks 
tab of the process control panel. (You cannot change the schedule of a task that is running, however.) 

Changing the Schedule or Priority of a Task 
When you set up a schedule for a task you cannot really predict what other tasks may also 
be scheduled for the same time by other ZENworks Asset Management users. As a result, 
when you see your task listed in the queue on the Tasks tab, you may decide you need to 
change the schedule. Alternatively, you may decide to leave the schedule alone but 
change the task’s priority. By default, tasks run with normal priority, but a scheduling 
option lets you change the priority to high or low. 

You cannot change the schedule or priority of a task that is running. 

NOTE: Enterprise administrators can change the priority of any task; all other ZENworks Asset Management users are 
restricted to their own tasks. 

To change the schedule or priority of a task 

1. Click on the Tasks tab in the process control panel. 
2. Right-click on the task for which you want to change the schedule or priority and then click 

on Edit Schedule on the shortcut menu. 
3. ZENworks Asset Management will display the Schedule Task dialog. Change the schedule 

settings you want, including the priority. 
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Removing a Task 
If you change your mind about running a task that is currently waiting in the queue, you 
can remove it. When you do so, ZENworks Asset Management permanently deletes the 
task. If you want to run it again, you will need to re-submit the task and, if necessary, re-
schedule it. 

NOTE: You cannot stop a task once it has started to run; it will run to completion. 

To remove a task 

1. Click on the Tasks tab in the process control panel. 
2. Do one of the following to remove a task: 

 Select the task and click   on the process control panel toolbar. 
 Right-click on the task and then click on Remove on the shortcut menu. 
 Select the task, click on the Control menu, and click on Remove 

TIPS 

 If you have a recurring task, but do not want it to run just this time, pause it until its scheduled time has 
gone by and then resume it. If you remove a recurring task, you will have to re-schedule and re-submit it. 

 You cannot remove a paused task, you must resume it first. 

About Purges 

Over time, your inventory database will accumulate a great deal of data, some of which 
you will no longer need. For example, you are unlikely to need all the error data that has 
ever been generated or all the historical data about workstations or tasks you have run. To 
keep your inventory database a reasonable size you will want to purge it of such data 
periodically. When you perform a purge you can choose which type of historical data is 
removed. If you do not purge the database, the historical data will continue to accumulate 
and the database will continue to grow. 

ZENworks Asset Management Manager includes settings that control when historical 
data is considered outdated and therefore a candidate for purging. By default, historical 
workstation data is kept for one year, error data for one month, and historical task data for 
two weeks. You can use the Enterprise Options dialog to change the length of time the 
data is kept. The number specified in the Enterprise Options dialog affects which data 
gets removed during a purge of the inventory database. For example, suppose you 
indicate you want to keep error data for two weeks. When you then purge the database 
and indicate you want to remove error data, the Manager will remove any error data that 
is older than two weeks. 

Consider scheduling your purges to coincide with the length of time you have specified in 
the Enterprise Options dialog. For example, if you have decided to keep task history data 
for a month, you can create a purge named Outdated Task History Data and schedule it to 
run monthly. 

Only an enterprise administrator can purge the database. 
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A purge is a ZENworks Asset Management activity known as a task. You schedule a 
purge to run at a particular time or on a recurring basis and you can then track its progress 
on the Tasks tab of the process control panel. If you have more than one Task Server in 
an Enterprise Deployment of ZENworks Asset Management, you also have the option of 
selecting the Task Server that will run the purge task. 

See Also 

Purging the Database  

Purging the Database 

When you purge the database you must decide which type of data you want to purge 
(workstation history, task history, or error); select a Task Server to run the purge task (if 
you have multiple Task Servers); and schedule the purge. You can either schedule the 
purge on a one-time basis or on a recurring basis, for example, every three months. You 
can also change the priority of a purge task and indicate how you want ZENworks Asset 
Management to handle it if it is late. 

To purge the database 

1. Click on the Administration menu and click on Database Purge. 
2. In the Purge Description box, enter a name for the purge task. This is how the task will be 

identified on the Tasks tab of the process control panel. 
3. By default, the purge task will be handled by any available Task Server. To select a 

specific Task Server or group of Task Servers, 
 
a) Click on the browse button in the Target Task Server(s) box. 
b) In the Select Task Server dialog, either select a specific Task Server or group of Task 
Servers so that any of the Task Servers in that group can handle the purge task. (Task 
Servers are grouped either in the Public Task Servers container or in a domain Task Servers 
container.) Then click on the OK button. 

4. In the Data to Purge section, select the type of data you want to purge. By default, 
ZENworks Asset Management will purge all outdated data. (The settings that control when 
data becomes outdated are in the Enterprise Options dialog.) 

5. To schedule the purge, click on the Schedule button. If you do not set up a schedule , the 
purge will run on a one-time basis as soon as ZENworks Asset Management can start it. 

6. Click on the Submit button. The task now enters the task queue and can be tracked on the 
Tasks tab of the process control panel. 

See Also 

About Purges  
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Analyzing License Compliance 

About License Compliance 
You can track software license compliance in two ways with ZENworks Asset 
Management: 

 Use the ZENworks Asset Management Software Compliance to import or enter purchasing information and 
reconcile this information with products that you have installed and that have been discovered during the 
inventory process.  

 Use ZENworks Asset Management Manager to enter license totals for products discovered during the inventory 
process. 

About the ZENworks Asset Management Software Compliance 
ZENworks Asset Management Software Compliance lets you import or enter purchasing 
information and reconcile this information with products that you have installed and that 
have been discovered during the inventory process. This applicastion is Web-based; you 
run it from the ZENworks Asset Management Web Console.  

ZENworks Asset Management Software Compliance offers these benefits: 

 Provides a consolidated view of software installations to facilitate the reconciliation and reporting process. 
For major software publishers, the consolidated view rolls up point releases, service packs, and language 
editions but excludes software titles with no licensing implications, for example, WordPad. 

 Lets you import software purchasing data transactions (for example, date, PO number, reseller, product 
quantity, and so on) to reduce the amount of manual input and editing. 

 Provides a direct link from discovered software to proof-of-ownership documentation, resulting in a more 
comprehensive system that can be audited. 

 Includes a reconciliation process that facilitates the process of matching purchased to installed products. By 
using unique product identifiers like manufacturer part numbers, a purchased product needs to be matched 
only once to the corresponding installed product. All future purchases of matched products will automatically 
be reflected in compliance reports. 

 Provides a clear picture of your software compliance status so you can identify and correct exceptions. You 
can group and sort compliance reports in various ways and drill down to the underlying purchase and 
workstation details. 

For more information, check the Novell Web site (www.novell.com) or contact your 
sales representative. 

Entering License Data into the Database 
If you are using ZENworks Asset Management Manager to perform license compliance 
analysis, you will need purchasing information for each product that you want to check. 
You will then need to: 

1. Enter some licensing information (based on your purchasing data) into the database using 
the query tool in the Manager. (See the instructions below.) 

2. Run a License Compliance Breakdown report to see how the licensing for a product 
compares to the number of products you have installed. 
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Before you start entering any licensing data into the database, obtain the purchasing 
information for the products for which you want to check license compliance. You will 
need to know the product name, for example, Word 97, and the number of licenses that 
were purchased. You may also want to note any identifying number for the purchase, 
such as a SKU number. 

To enter the licensing data into the database, you will use a product query to find your 
product and then to provide licensing information for it. The licensing information gets 
entered into four fields: license required, license name, license ID, and license count. 
When you create your product query you will need to display these fields in the query 
results window so that you can enter your licensing information. 

When you locate products in the ZENworks Asset Management database, you will notice 
that products often have multiple versions. For example, Word 97 has versions 8.0, 8.0 
SR-1, and 8.0 SR-2. Your license for the product, on the other hand, is unlikely to 
differentiate among versions. So, for example, you may be licensed for 50 copies of 
Word 97, but ZENworks Asset Management may find 25 copies of Word 97 version 8.0, 
10 copies of Word 97 version 8.0 SR-1, and 12 copies of Word 97 version 8.0 SR-2 
installed on your workstations. As a result, when you enter licensing information in the 
database, you will need to account for this "one-to-many" relationship by providing a 
single identifier (in the license ID field) for all the versions of a product. The procedure 
that follows will illustrate how to do this. 

NOTE: When providing licensing information you should assume that you have different versions of the same product 
installed. You do not need to know how many copies of a particular version you have, however. 

To enter licensing data in the database 

1. Obtain the licensing purchasing data that you need to enter into the ZENworks Asset 
Management database, for example, product name, license quantity, and any identifying 
name or number for the purchase (such as a SKU number). 

2. On the Query locator tab in the Manager, right-click on the Personal Queries container, 
click on New, and then click on Product Query. 

3. On the Filter tab, enter the criteria for locating the product for which you want to enter 
licensing information. You may want to narrow the search by language.  

4. Click on the Layout tab and make sure that the Selected Columns box includes 
Manufacturer, Product Name, Model/Version, License Required, License Name, License ID, 
and License Count. (The order in which these appear is up to you. Also feel free to include 
any other fields you would like displayed in the query results.) 

5. Click on the Filter tab and then click on the Display Results button. 
6. Enter your licensing information: 

 
a) For each version of the product, select Yes in the License Required column. 
b) For each version of the product, enter the same name in the License Name column. This 
name is up to you, but you may want to enter the same name as is used in your purchasing 
data. The product names in the License Compliance Breakdown Report will then match the 
purchasing data. For example, for Word 97 you could enter Microsoft Word, Microsoft 
Select, or MS-Word.  
c) For each version of the product, enter the same license ID. This ID can be anything you 
want, for example, a SKU number obtained from your purchasing data. (You could also 
create your own numbering scheme for grouping products for licensing purposes.) The 
license ID simply lets ZENworks Asset Management know that from a licensing perspective 
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all the versions of a product are to be grouped as one product. 
d) In the License Count column for one version of the product, enter the number of 
licenses you purchased. (This one number will then be used for all the products that share 
the same license ID). 

7. Repeat this entire procedure for each product for which you want to enter licensing 
information. The figures above show how to enter the information for one product, but you 
can find multiple products with a single query if you prefer. 

8. After you finish entering the licensing information, run a License Compliance Breakdown 
report. 

TIP 

 When entering licensing information, you can use the find and replace feature to avoid entering data for 
each field individually. 

Reporting on License Compliance 
Once you have entered product licensing information into the database, you can run a 
License Compliance Breakdown report to compare the number of licenses you purchased 
for a product to the number you have actually installed. (If a product is installed more 
than once on a workstation, it is counted only once.) 

For each product, the License Compliance Breakdown report shows the total number of 
licenses purchased, the total licenses installed (broken down by version), and the variance 
between purchased and installed licenses. (If the variance is negative, you have installed 
more licenses than you have purchased.) 

NOTE: The report will include products for which you indicated that a license was required, even if you did not provide 
any additional licensing information such as the number of licenses, or if you do not have the product installed.  

To report on license compliance 

1. On the Report locator tab, display the contents of the ZENworks Asset Management 
Reports container. Then display the contents of the Product folder and the Breakdown 
folder inside it.  

2. Double-click on License Compliance Breakdown. 
3. Select a filter if you want. (You can filter by license ID, manufacturer, model/version, or 

product name.) 
4. Submit the report as usual.  

TIP 

 If you are using the ZENworks Asset Management Usage Monitor and you want information about license usage 
as well as license compliance, you can run a License and Usage Summary by License ID report. 
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Analyzing Application Usage 

About the ZENworks Asset Management Usage Monitor 
Tracking application use can be a challenge in an enterprise. For example, when you 
order software, predicting how many licenses you need can be difficult. Without some 
way of knowing the demand for an application, you can only guess how many licenses to 
order. 

The ZENworks Asset Management Usage Monitor lets you track software usage on 
individual workstations. It keeps track of the days an application ran and the amount of 
time it ran. It also tracks the total time the application was active. You can then analyze 
this data with reports.  

The ZENworks Asset Management Usage Monitor offers the following features: 

 The ZENworks Asset Management Usage Monitor can track applications in a Windows 95/98, Windows NT 4.0, 
and Windows 2000/XP environment (except for 16-bit applications running in those environments).  

Note: The ZENworks Asset Management Usage Monitor tracks only software running on Windows systems, and does not 
run during portable collections. 

 The ZENworks Asset Management Usage Monitor can track all software applications recognized by the 
Collector, including software local products you have created. 

 If FNI data is gathered during your scans, the ZENworks Asset Management Usage Monitor can provide usage 
information about the applications that generate the FNI data.  

 The ZENworks Asset Management Usage Monitor also tracks applications that are run from directly from a 
server. Server Usage reports are available from the Reports tab of the Web Console in the Software Server 
Usage folder. 
 
Note: The Usage Monitor tracks the launching of EXE files – it does not track Metaframe- and Terminal 
Server-launched applications. 

 The ZENworks Asset Management Usage Monitor tracks not only how much an application was used, also who 
was using it. This allows you to view usage data by user. A Usage by User report is available from the Reports 
tab of the Web Console. Usage information is also available in the Software Compliance Report, available 
from the Software Compliance tab of the Web Console.  

 A single Collection Server setting activates the ZENworks Asset Management Usage Monitor. Once activated, 
the ZENworks Asset Management Usage Monitor will track software usage on all the workstations associated 
with the Collection Server and record the information in a daily log file on each workstation.  
 
Note: For the ZENworks Asset Management Usage Monitor to run on workstations, the client applications 
(Collection Client, Collector, and Collection Editor) must already be installed on them. See New Installation 
Considerations for more information. 

 The usage data from the log files is loaded into the ZENworks Asset Management inventory database 
whenever a software scan of the workstations occurs. You must therefore use collection schedules to control 
how frequently usage data in the database is updated.  

 Special usage reports let you analyze the usage data in a variety of ways.  

To run the ZENworks Asset Management Usage Monitor, you must have purchased a 
license for it. (It is not part of your ZENworks Asset Management license.) Contact your 
Novell Sales Representative for details. 

See Also 

Starting Usage Monitoring  
Running Usage Reports  
Usage Report Settings  
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Starting Usage Monitoring 
The ZENworks Asset Management Usage Monitor comes with ZENworks Asset 
Management. If you are an existing ZENworks Asset Inventory user who has just 
purchased the ZENworks Asset Management, you will need to upgrade your license by 
running the License Management wizard.  

The ZENworks Asset Management Usage Monitor is controlled by a Collection Server 
setting. To start usage monitoring, you will need to turn on this setting. The ZENworks 
Asset Management Usage Monitor will then run automatically on all the workstations 
associated with the Collection Server. If you do not want to monitor software usage on 
the workstations associated with a particular Collection Server, you can turn off the 
ZENworks Asset Management Usage Monitor. 

  

Notes:  

 The ZENworks Asset Management Usage Monitor runs only on Windows systems. 
 The ZENworks Asset Management Usage Monitor does not run when you are performing portable collections. 

  

When the ZENworks Asset Management Usage Monitor runs on workstations, it creates 
a daily log file of its findings on each workstation. You can control how many days these 
log files are kept. (Depending on the type of activity on a workstation, a daily log file will 
average about 20 KB in size.)  

  

Note: Be sure the number of days you keep log files exceeds the interval at which scans occur (as determined by your 
collection schedule), or usage data may be incomplete. 

The usage data remains on a workstation until a software scan occurs. As part of the scan, 
the contents of the log files are loaded into the inventory database. You must therefore 
make sure the collection option set associated with the Collection Server has software 
scanning turned on.  

Before starting the ZENworks Asset Management Usage Monitor also keep the following 
in mind: 

 If you want to see how the applications that result in FNI data are being used, make 
sure FNI data is being gathered. This is controlled by a Collector option. (Keep in 
mind, however, that the collection of FNI data adds overhead to the inventory 
process.)  

 The availability of usage data in the inventory database depends on the frequency of 
your software scans. For example, if your collection schedule is set for quarterly 
scans, usage data will be loaded into the database every quarter. If you want usage 
data more frequently, change the collection schedule.  
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To start usage monitoring 

1. If you have not yet purchased a ZENworks Asset Management Usage Monitor license, contact your Novell Sales 
Representative. Then run the License Management wizard.  

2. For each Collection Server for which you plan to track software usage, make sure the assigned collection option set 
has software scanning turned on. If you also want to analyze FNI usage, make sure FNI data is being gathered. (Both 
these settings are Collector Options.)  

3. If necessary, adjust your collection schedules so that the inventory cycles on your Collection Servers occur at 
intervals that are convenient for usage data analysis.  

4. On the Management locator tab, display the settings for a particular Collection Server in one of these ways: 

 Double-click on the Collection Server. 

 Select the Collection Server and click on the Open button on the toolbar. 

 Right-click on the Collection Server and then click on Open on the shortcut menu. 

 Select the Collection Server, click on the File menu, and click on Open. 

5. Click on the Usage tab. 

6. To turn on the ZENworks Asset Management Usage Monitor for the Collection Server, select the Enable Usage 
Monitor check box. (To turn it off, clear the check box.) 

7. To change the number of days you want to keep log files on each client workstation, select a different number of 
days. The default is 180 days. (It is a good idea to keep log files longer than your collection frequency.) The log files 
will be deleted either after the specified number of days has passed or after the usage data has been loaded 
successfully into the database. 

Note: Be sure the number of days you keep log files exceeds the interval at which scans occur (as determined by 
your collection schedule), or usage data will be incomplete. 

8. To save your changes, either click on   or click on the File menu and click on Save. ZENworks Asset Management 
will automatically ensure that the Collection Server will use the updated settings. 

9. Close the Collection Server window. 

10. Repeat steps 4 through 8 for each Collection Server for which you want to activate the ZENworks Asset 
Management Usage Monitor. 

TIPS 

 For the ZENworks Asset Management Usage Monitor to run on a workstation, the client 
applications (Collection Client, Collector, and Collection Editor) must already be 
installed. For details, see New Installation Considerations.  

 The ZENworks Asset Management Usage Monitor uses the date and time that is set 
locally on each workstation. If this date or time is wrong, the usage data for the 
workstation will not be accurate. In addition, a date in the future could result in log 
files being deleted before the usage data was loaded into the database. The usage 
data would then be lost. 

See Also 

Running Usage Reports  

Changing Other Collection Server Settings  
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Running Usage Reports 
 
After each software scan, usage data is loaded into the inventory database. The usage data 
always includes the total time each application ran, the time it was active, and the 
percentage of time it was active. Special usage reports let you analyze this data in 
different ways. 

NOTE: An application is active when its window is open on the desktop and its title bar is highlighted. If an application 
is open, but is minimized or hidden behind another window, it is inactive. 

You can analyze usage data with the following reports, all of which are in the Usage 
folder of the ZENworks Asset Management Reports container on the Report locator tab: 

 An FNI Usage Detail report shows how applications that result in FNI data are being used on workstations. 
 A License and Usage Summary by License ID report shows products grouped by license ID, with total products 

installed summarized against total licenses purchased. In addition the report shows the number of 
workstations on which the software ran versus the number of workstations on which it was installed. 

 A Software - In Use Versus Installed report provides information about how installed products are being used.  
 A Software Usage History by Manufacturer report lets you review usage by manufacturer and application.  
 A Software Usage History by Workstation report lets you review application usage on particular workstations 

during a given period.  
 A Software Usage Trend by Manufacturer report shows trends in software usage over time by manufacturer.  

The procedure for running any of these reports is just the same as for any other 
ZENworks Asset Management report. For details of all the settings in these reports, see 
Usage Report Settings. 

Changing Enterprise Options 

If you are an enterprise administrator you can control how long workstation history data, 
error data, and task history data is kept in the inventory database. You can specify a 
number of days, weeks, months, or years for each type of data. The number you specify 
here affects which data gets removed during a purge of the inventory database. For 
example, suppose you indicate you want to keep error data for two weeks. When you 
then purge the database and indicate you want to remove error data, ZENworks Asset 
Management Manager will remove any error data that is older than two weeks. 

An enterprise option also controls how your servers are upgraded when you upgrade to a 
future version of ZENworks Asset Management or apply a server patch. 

To change enterprise options 

1. Click on the Tools menu and click on Enterprise Options. 
2. In the Historical data section, select a number of days, weeks, months, or years for each of 

the three types of data.  
 Workstation History - Data Historical information about previous scans of workstations. By default, 

ZENworks Asset Management keeps this data for one year in the inventory database. 
 Error Data - Error data that comes from the Manager, a Collection Server, a Task Server, the Collection 

Client, the Collector, or the Collection Editor. By default, ZENworks Asset Management keeps this data 
for one month in the inventory database. 

 Task History Data - Historical information about the reports and purges that have been run. By default, 
ZENworks Asset Management keeps this data for two weeks in the inventory database 
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3. In the Track Lost and Found box, select or clear the check boxes to track hardware or 
software that cannot be found. 
 
The Lost and Found is a special kind of stockroom that is created and maintained by 
ZENworks Asset Management. For more information, see About the Lost and Found.  
 
Note: For the purposes of Lost and Found tracking, an operating system is treated as 
Hardware. If you want to track operating systems, you must choose Hardware in the 
Enterprise Options dialog. 

4. In the Upgrade Interval box, specify the interval (in minutes) at which your servers should 
check the Filestore after an update or upgrade has been applied. 

5. Click the OK button. 

 

See Also 

Purging the Database  

Managing a Product Recognition Update (PRU) 

Novell regularly offers Product Recognition Updates (PRUs). A PRU keeps the product 
data in your inventory database up-to-date and increases the number of new products and 
new versions of products that ZENworks Asset Management recognizes automatically. 

You can obtain and apply a PRU through an automated process that requires access to the 
Internet and either an FTP connection or an HTTP proxy server. If you cannot use the 
automated system, you can obtain the PRU manually (by contacting Novell Technical 
Support) and then apply it manually.  

The PRU process involves three steps:  

1. Downloading the PRU from the Novell Web site. The PRU comes in the form of a self-
extracting zip file. 

2. Extracting the PRU files from the downloaded file. 
3. Applying the PRU to incorporate the product data into the database. 

 
NOTE: The application process may take several minutes depending on your system and 
network traffic. 

Only an enterprise administrator can manage PRUs, and the inventory process must be 
stopped. Novell recommends you perform this procedure between inventory cycles 
(when collections are not taking place). Not only is it faster to stop the inventory process 
when workstations are not being scanned, but also the new product data will then be 
available to all workstations during their next inventory cycle. 
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To incorporate a PRU automatically 

NOTE: If you plan to obtain your PRUs via a proxy server, you must first provide some information about it. (This is a 
one-time procedure.) 

1. Click on the Administration menu and click on Product Recognition Update. 
2. If you want to incorporate the PRU right away:  

 
a) Leave the Manager option selected and click on the Submit button. 
 The Manager checks the Novell Web site to see if a PRU is available. If it is not available, 
you are told and then returned to the Product Recognition Update dialog. If a PRU is 
available, you are asked if you want to apply it. 
 
b) If you indicate you want to apply the PRU, the Manager displays the Stop Inventory 
Process dialog so you can stop the inventory process.  
 Once the inventory process is stopped, the PRU is retrieved and applied. After it has been 
applied, the Manager will restart the inventory process for you automatically.  

3. If you want to incorporate PRUs according to a schedule (Novell recommends monthly): 
 
a) Select the Task Server option. By default, the PRU task will be handled by any available 
Task Server. If you want to select a specific Task Server, click on the browse button and 
select a Task Server (or group of Task Servers).  
 
b) Click on the Schedule button to set up a schedule for the PRU task. 
 
c) Click on the Submit button. The task now enters the task queue and can be tracked on 
the Tasks tab of the process control panel. 

To incorporate a PRU manually 

1. After obtaining the PRU from Novell Technical Support, extract the PRU files to a folder to 
which you have access from the Manager. (To extract the files, double-click on the file you 
downloaded and specify the folder you want.) 

2. Click on the Administration menu and click on Product Recognition Update. 
3. Select the Locate manually option. 
4. Specify the path to the PRU files. 
5. Click on the Submit button. 

 
The Manager displays the Stop Inventory Process dialog so you can stop the inventory 
process. (The PRU will not be applied until you do so.) 

Once the inventory process is stopped, the PRU is applied. After it has been applied, the 
Manager asks if you want to restart the inventory process. If you choose not to restart it 
now, be sure to do so later. Until you restart the inventory process, no workstations will 
be scanned and no tasks will run.  
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Defining a Proxy Server 
If you plan to obtain your PRUs via a proxy server, you must provide some information 
about it. (This is a one-time procedure.) 

To define a proxy server 

1. Click on the Tools menu and click on Proxy Server Management. 
2. To use a proxy server, select the Use Proxy Server check box. 
3. In the Address box, enter the name of the proxy server, for example, RDHA2. 
4. Enter the port number of the proxy server. 
5. Enter the user name and password for accessing the proxy server. 
6. Click the OK button. 

Moving the File Store 
The ZENworks Asset Management File Store consists of shared non-database files, for 
example, the recognition files used by the Collector and the main program files for the 
Collection Server, Task Server, and Collector. In addition, if you initially installed a 
LAN-based File Store, it will contain the client application setup files. In an Enterprise 
Deployment of ZENworks Asset Management, you can install the File Store on a 
machine of your choice as long as the File Store is accessible to all Task Servers, 
Collection Servers, and Managers. 

If you need to move the File Store for any reason, you can do so by copying the files that 
make up the File Store to another location and then using the Manager to indicate the File 
Store's new location. (If you do not specify the new location, ZENworks Asset 
Management will not be able to find the File Store.) 

To move the File Store 
1. Copy the \Filestore folder and its contents to another location.  

 
NOTE: If you are copying the file store to an FTP site, copy all files and folders except the 
\Setup folder and contents. 

2. Use the Manager to stop the inventory process. 
 
a) Click on the Control menu and click on Stop Inventory Process. 
b) Click on the Yes button to confirm that you want to stop the inventory process. 
 For more information see Stopping and Starting the Inventory Process.  

3. Use the Manager to specify the File Store's new location: 
 
a) Click on the Tools menu and click on File Store Management. 
b) Choose the type of File Store you will be using, LAN-based, Anonymous FTP, or 
Authenticated FTP. 
c) If you are using a LAN-based File Store, enter the path to the File Store's new location. 
If necessary, use the browse button to help you. 
d) If you are using an FTP-based File Store with anonymous FTP, enter the IP address of 
the FTP server. 
e) If you are using an FTP-based File Store with authenticated FTP, enter the IP address of 
the FTP server and enter the user name and password for the user account to be used by 
ZENworks Asset Management Managers, Collection Servers, and Task Servers when 
accessing the File Store. 
f) Click on the OK button. 

4. Use the Manager to start the inventory process by clicking on the Control menu and 
clicking on Start Inventory Process. 
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Upgrading Your ZENworks Asset Management License 

You may need to upgrade your ZENworks Asset Management license for any of the 
following reasons: 

 You have an evaluation copy of ZENworks Asset Management and now want a full license. 
 You want to track application usage or software license compliance so you need to upgrade to the full 

version of ZENworks Asset Management. 
 You want to upgrade so you can collect data from your UNIX/Linux workstations. 

Notes:  

 You do not need a license key to upgrade from Standalone to Enterprise deployment.  
 Only an enterprise administrator can upgrade a ZENworks Asset Management license.  
 You can check your license status at any time, by choosing About ZENworks Asset Management from the 

Manager's Help menu. The About window indicates how many licenses you have used.  

To upgrade your ZENworks Asset Management license 

1. Figure out what kind of license change you want to make and contact your Novell Sales 
Representative or reseller to purchase the upgrade. When you purchase a license upgrade 
you receive a ZENworks Asset Management license code. 

2. From Manager's Administration menu, choose License Management. 
3. Use the License Management Wizard to enter your new license code. 

Using the License Management Wizard 

The License Management Wizard allows you to enter a license code to upgrade your 
ZENworks Asset Management installation after you have purchased a license upgrade. 

To use the License Management Wizard 
1. In ZENworks Asset Management Manager, Choose License Management... from the 

Administration menu. The License Management Wizard appears, with details of your 
current license.  

2. Review the details and then click Next. 

3. Enter your license code in the License Key box. If you do not have a license key, 
contact your Novell sales representative. When finished, click Next. Your installation 
is upgraded as determined by your license code. 

4. Review the new license details in the License Upgrade Complete dialog and click 
Finish. 
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Upgrading from NetCensus 

If you have NetCensus version 2.8x or higher, and are upgrading to TS.Census, you can 
migrate your NetCensus database to TS.Census.  

You migrate a NetCensus database by running the Database Migration Wizard directly 
from TS.Census Manager. This wizard unloads data from a NetCensus database, 
translates it, and then loads it into the TS.Census inventory database. In addition, the 
wizard makes some mapping decisions about where certain kinds of data (especially 
contact data) are placed in the TS.Census database. You will have the opportunity to 
review and change this mapping so that data is migrated to the correct fields.  

When you migrate a NetCensus database, the following data is transferred: 

 For each workstation (configuration), the associated hardware, software, contact data, and configuration ID. 
 Local products if they are referenced by one or more components. 
 Recognition data ("fingerprints") for software and system local products. 

FNI data, environment data, and system files, are not migrated.  

NOTE: Macintosh configurations are migrated, but will be identified as manually-entered workstations in the TS.Census 
inventory database.  

Before You Migrate 
Before you begin the migration process, you need to understand two issues: 

 The timing of the migration. 

 The mapping of certain NetCensus database fields to TS.Census fields. 

Timing the Migration 

In general, if you know you are going to migrate a NetCensus database, Novell 
recommends you do so before you start large-scale use of TS.Census. TS.Census tracks 
historical data about workstations and uses the first scan of a workstation as the 
"baseline" scan for future comparisons. If you start scanning a lot of workstations before 
you migrate a database, your baseline historical data for those workstations will be the 
data collected by TS.Census. If you have entered a lot of data manually in NetCensus, 
you will still be able to load it into the inventory database, but it will no longer serve as a 
baseline inventory in the case of any workstations that you have already scanned with 
TS.Census. 

Field Mapping During Migration 

The TS.Census inventory database has more fields for demographic information than 
NetCensus offers through its Contact Info dialog. The fields are also more specific. 

For example,  

 NetCensus has a Location #1 and Location #2 field, whereas TS.Census has fields such as Site, Building, Floor, 
and Room.  
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 NetCensus also has two Note fields for miscellaneous data and a third Note field for a machine name 
(although you can also use this third Note field for other data).  

 Not only are fields in TS.Census more specific, but they can also be user-defined, making it possible to add 
other kinds of information to the inventory database, for example, purchasing or leasing information. 

See Field Mapping During Database Migration for a table showing the mapping of a 
NetCensus database to a TS.Census database. 

Using the Database Migration Wizard 
The Database Migration Wizard guides you through the migration process. During this 
process you will need to do the following: 

 Identify a Collection Server with which the migrated workstation data is to be associated. If you later want to 
associate any of these migrated workstations with a different Collection Server, you can do so with TS.Census 
Manager as explained in Re-Assigning a Workstation to a Different Collection Server. 

 Specify the folder where your NetCensus database files reside. This folder must include the files listed in 
step 6 of the procedure below. 

 Review the mapping of fields and make any necessary corrections. 

After you have provided the necessary information, the Database Migration Wizard 
unloads data from the NetCensus database, translates it, and then loads it into the 
TS.Census inventory database. At the end of the migration, you must stop and re-start the 
inventory process so that any recognition data for migrated local products is incorporated 
into the TS.Census inventory database, as described in step 11 of the procedure below.  

If you have scanned some workstations with TS.Census before starting this migration, the 
wizard will detect this and ask you which data you want to keep: the data already in the 
TS.Census inventory database or the incoming NetCensus data. If you have spent time 
editing your data in NetCensus, you will generally want this data to replace whatever is in 
the TS.Census inventory database as the result of any trial scans you may have 
performed. Should you choose not to replace data already in the inventory database, any 
customized editing ("data scrubbing") you may have done with NetCensus will be lost.  

Caution: When you scan a workstation with TS.Census, it checks for the existence of a hidden file in the root folder of 
C: to determine if this is a migrated NetCensus workstation. If the hidden file is in some other folder, TS.Census will 
not find it, and will treat the workstation as a new workstation. As a result, the database will include two instances of 
the same workstation.  

Note: You must be a TS.Census administrator to run the Database Migration Wizard. 

To migrate a NetCensus database to TS.Census 

1. Back up your NetCensus database. 
2. Be sure you understand how certain fields will be mapped during the migration. See Field 

Mapping During Migration. 
3. In TS.Census Manager, click on the Tools menu and click on Database Migration. 
4. After reading the Welcome screen of the Database Migration Wizard, click on the Next 

button. 
5. In the Select Collection Server dialog, select the Collection Server with which you want to 

associate the workstation data being migrated and click on the Next button. 
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6. In the Specify Database Location dialog, provide the path to the folder that contains your 
NetCensus database and then click on the Next button. (The default installation folder for 
NetCensus is named Netcwin.) This folder must include the following files: 
 Asset_id.ntx 
 Assettag.dbf 
 Com_cfpr.ntx 
 Compon.dbf 
 Config.dbf 
 Config.ntx 
 Product.dbf 
 Product.ntx 
 
If you want to migrate local products, the folder must include the following in addition to 
the files listed above: 
 Lswp.crp 
 Lsys.crp 
 Lvt.crp 

7. Carefully review the mapping information shown in the Field Mapping dialog. The 
TS.Census fields (including any user-defined fields) are listed on the left and grouped by 
workstation, user, and LAN adapter. Any NetCensus fields that are going to be mapped to 
the TS.Census fields appear to their right. 
 
Note: If you are migrating more than one NetCensus database, and have customized 
contact information differently for each database, make sure you account for those 
differences in the Field Mapping dialog. 
 
Do any of the following to make changes and then click on the Next button:  

 To remove the current mapping for a field, select it and click on the Clear button. The icon next to the 
field will now indicate no mapping will take place. 

 To change the mapping for a field (or to add mapping), select the field, click on the Change button, 
and make the change. The icon next to the field will now indicate that the mapping has changed. 

 To restore the default mapping to a field, select it, and click on the Restore Default button. The icon 
next to the field will now indicate that default mapping is in effect. (The table in Field Mapping During 
Migration shows all the mapping defaults.) 

8. Review your selections. If you need to make a change, click on the Back button; to 
continue, click on the Next button. The Database Migration Wizard will now start the 
process of unloading configurations from the NetCensus database, translating the data, 
and loading it into the TS.Census inventory database. 
 
Note: If you click on the Cancel button during the migration process, the Collection Server 
will finish loading any configuration it is currently loading, but will then stop the migration 
process. 

9. If the wizard detects that you are trying to migrate workstation data for a workstation that 
is already in the TS.Census inventory database, it will display the Replace Configuration 
dialog and give you the following choices:  

 Yes - Updates the workstation in the TS.Census database with the corresponding NetCensus 
configuration. Select this option if you want to preserve any data editing you have done for this 
configuration in NetCensus. 

 Yes All – Updates all the workstations that already exist in the TS.Census database with their 
corresponding NetCensus configurations. Select this option if you want to preserve any data editing you 
have done in NetCensus for any configurations that correspond to workstations that you have already 
scanned with TS.Census. 

 No – Leaves the workstation in the TS.Census database as it is. Select this option if any data you have 
entered with NetCensus is not important to you, and you do not want to preserve it. 
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 No All - Leaves as they are all the workstations in the TS.Census database which correspond to 
NetCensus configurations you are trying to migrate. Select this option if you do not want to preserve 
any data editing you have done in NetCensus for any configurations that correspond to workstations 
that you have already scanned with TS.Census. 

10. Be sure to stop and re-start the inventory process after running the wizard so that the 
recognition data for migrated local products is added to the TS.Census inventory database. 
 
Caution: Although you may continue to find NetCensus configuration IDs useful in 
TS.Census, do not edit any configuration IDs until after you have scanned workstations 
with TS.Census. TS.Census requires the original configuration ID to match up workstations 
and migrated data correctly.  

Field Mapping During Database Migration 

 

Type of Data  ZENworks Asset Management 
Field (Length)  

NetCensus Field (Length)  

Workstation  Department (32)  Department (25)  

   Phone (32)  Phone (20)  

   Floor (10)  Note #2 (55)  

   Machine Name (32)  Note #3 (55)  

   Building (32)  Location #1 (40)  

   Room (32)     

   Site (32)     

   Cost Center (32)     

User  First Name (32)  First Name (15)  

   Middle Name (32)  Middle Name (15)  

   Last Name (32)  Last Name (15)  

   E-Mail (100)  Location #2 (40)  

   Second Phone (32)     

   Fax (32)     

LAN Adapter  LAN Address (12)  LAN Address (25)  

   IP Address (15)     

   Serial Number (50)     

   Asset Tag (32)     
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Novell Technical Support 

Contacting Novell Technical Support 

Before you contact Novell Technical Support, please do the following: 

 Check Troubleshooting Tips. 
 Check the Release Notes by clicking on the Release Notes icon in the ZENworks Asset Management program 

folder. 
 Use the Contents and Index tabs in this Help system to check on the procedure you are trying to use. 

Then contact Novell Technical Support at: 

  

http://support.novell.com 

Troubleshooting Tips 

How Can I Find Out Which Workstations Are Associated with a Collection 
Server? 
To find out which workstations are associated with a particular Collection Server, run a 
workstation query that filters on Collection Server. For an example of such a query, see 
Sample Queries. 

How Do I Associate a Workstation with a Different Collection Server? 
If you want to associate a workstation with a different Collection Server, you can use 
ZENworks Asset Management Manager to re-assign the workstation. For example, you 
may want to re-assign workstations so that a Collection Server has fewer (or more) 
workstations associated with it. 

How Do I Prevent Workstation Users from Editing Certain Fields? 
If you do not want workstation users to edit certain fields during a collection cycle, you 
can customize the Collection Editor with a collection option set and make the fields read-
only. You can even hide the fields altogether. Many options are available to you for 
controlling what users can do when the Collection Editor runs on their workstations. 

How Can I Avoid Duplicate Workstations in the Database? 
If you re-build a workstation, fix a hard disk crash, or re-install the operating system, you 
will lose the workstation's unique ZENworks Asset Management identifier. As a result, 
ZENworks Asset Management will treat the workstation as a new workstation when you 
scan it again, and you will have two versions of the same workstation in the database. 

You can avoid the duplication of workstations in two ways: 

 You can take advantage of Collection Server reconciliation settings that instruct ZENworks Asset Management 
to check for unique data such as a serial number, NIC address, NetCensus configuration ID, or machine name 
when determining whether a workstation is new or not.  

 You can restore a workstation's ZENworks Asset Management identity through a registry setting. 
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Can I Track Spare Parts that Are Not Associated with a Workstation? 
If you want to track spare parts or parts that are being repaired, create a stockroom. 

How Can I Find Out Which Users Do Not Have a Particular Component on 
Their Workstations? 
If you need to know which users do or do not have a particular component on their 
workstations, you can run a query. For an example of such a query, see "Listing 
Workstations by a Component Criterion" in Sample Queries. 

Is There Data that ZENworks Asset Management Gathers that Can Increase 
Inventory Time? 
Two kinds of data can potentially add overhead to your inventories: FNI data and the 
files you choose to gather. 

FNI data is most useful when you are rolling out ZENworks Asset Management and need 
to identify which software local products you should define. After that, you may just 
want to gather FNI data occasionally to see if there is any additional need for software 
local products. A Collector option controls whether FNI data is gathered or not. 

ZENworks Asset Management also lets you gather files of your choice by specifying 
them as another Collector option. If you choose to gather many such files or files that are 
very large in size, you will add overhead to the inventory process. 

How Do I Assign a Collection Schedule to the Enterprise? 
To use one collection schedule throughout the enterprise, use the default schedule 
supplied by Novell. The default schedule does not need to be assigned; it is automatically 
in effect, and is used by all Collection Domains and Collection Servers unless you assign 
a different schedule to the collection option sets the domains and servers are using. The 
default schedule is initially inactive so you need to edit it to activate it and customize it to 
the needs of your organization. 

How Can I Setup Up a Schedule to Account for Remote Users Who Rarely Call 
In? 
If you want to make sure you scan the workstations of remote users who rarely call in, set 
up a schedule with a long duration. For example, if you collect inventory data on a 
quarterly basis, consider a month-long duration so you "catch" as many workstations as 
possible. You can then remind remote users to log on during that period. 

Why Does the Date 01/01/1980 Appear in Some Fields? 
Some fields in ZENworks Asset Management initially have the date set to 01/01/1980. 
This indicates that the field has not been set to a specific date yet. You are most likely to 
see this date in user-defined fields, but it also appears in some built-in fields. For 
example, if you create a workstation date field it initially has the value 01/01/1980 for all 
existing workstations. Therefore, you can run a query to locate all the workstations with 
this date field set to 01/01/1980 and change the date to another date. When you create 
new workstations, however, the date in your user-defined field will be the current date. 
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Why Is My Query to Find a Product by Language and Version Not Producing 
Any Results? 
When setting up a criterion to locate a product by foreign language and model/version, 
the model/version must include language information. For example, if you want to find 
version 2.3 of a particular French product, you need to specify French as the language 
and 2.3 (FR) as the model/version. If you just specify 2.3 as the model/version, the query 
will not return any data. 

How Do I Get User-Defined Fields to Appear in Reports? 
User-defined fields do not appear in reports, but you can run queries of the database and 
thus analyze data in user-defined fields. You can control how the results of a query are 
displayed and then print these results.  

In addition, you can use Crystal Reports to create your own reports that include user-
defined fields. You can then have the option of importing the reports into ZENworks 
Asset Management so that you can run them from the Manager.  

CAUTION: Do not edit the report templates supplied by Novell. If you do, the reports will no longer run. 
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References 
ZENworks Asset Management Main Window 

 
 The locator window displays lists of schedules, collection option sets, Collection Domains, Collection 

Servers, queries, or reports on locator tabs. The locator window helps you find these items as well as manage 
them in a logical fashion. 

 The locator tab lets you select the contents of the locator window. Each locator tab displays related items. 
For example, the Management locator tab lists schedules, collection option sets, Collection Domains, 
Collection Servers, and Task Servers. 

 The title bar identifies the product you are using. 
 Three toolbars give you quick access to frequently performed ZENworks Asset Management Manager 

activities. The standard toolbar is for general activities, the process control panel toolbar is for working in 
the process control panel (see below), and the query toolbar is for working in the query tool. (See "Query 
Tool" on page 13-12.) To see a description of what a button on a toolbar does, position the mouse pointer 
over it; to use a button, click on it.  

 The menu bar gives you access to the Manager menus. To display the commands on a menu, click on it. 
Depending on what you are doing and the type of ZENworks Asset Management user you are, not all the 
menus will be available all the time. 

 The process control panel is a window in which you can view and manage data associated with your 
Collection Servers and tasks such as reports. For example, you can check the status of your reports, view 
errors reported on workstations during a collection, or see which users are currently using the Manager. 
 
The process control panel initially appears at the bottom of the main Manager window, but you can drag it to 
another edge of the window. You can also hide the process control panel by clicking on the Process Control 
Panel button on the toolbar. (You will not need to refer to the process control panel all the time, and hiding 
it will give you more room for the locator window and workspace.) 

 The status bar shows general messages, the name of the database, the name of the currently logged on user, 
and the status of the inventory process by means of the traffic light in the far right corner. If you do not 
want to see the status bar, click on the View menu and click on Status Bar. To display it again, repeat this 
procedure. 

 The workspace is an area where you can display one or more windows containing the details about an item 
selected on a locator tab, for example, schedule settings. The workspace may be empty at times. 
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Menus and Commands 

ZENworks Asset Management Manager Menus and Commands 
ZENworks Asset Management Manager includes ten menus, but some menus or 
commands are available only to certain ZENworks Asset Management users. For 
example, only an enterprise administrator has access to the Administration menu. In 
addition, some menus or some commands on menus are available only in a certain 
context. If unavailable, they will appear in gray instead of black. 

The menus are as follows: 

File  The File menu includes commands for creating, opening, closing, 
saving, renaming, printing, and exporting items and for exiting the 
Manager.  

Edit The Edit menu lets you perform standard editing such as cutting, 
copying, and pasting and lets you find and replace items in a query 
results window or Component List window. 

View The View menu lets you control the appearance and contents of the 
main Manager window. 

Tools The Tools menu lets you change some options for your inventory 
database, set enterprise and user options, and change your password. It 
also lets you start an immediate scan of a workstation or network 
server, start wizards that help you manage portable collections and 
migrate NetCensus data. 

Administration The Administration menu lets you manage ZENworks Asset 
Management users, product classification, and user-defined fields; 
purge the database; upgrade your ZENworks Asset Management 
license; and apply a Product Recognition Update (PRU). 

Network 
Discovery 

The Network Discovery menu includes the Options command for 
setting global options for the ZENworks Asset Management Network 
Discovery Engine. 

Control The Control menu includes process-related commands, for example, 
for stopping the inventory process or for pausing or resuming a task 
such as a purge. This menu is available when the process control panel 
is active. 

Add Data The Add Data menu lets you create workstations, stockrooms, 
components, local products, or workstation users. 

Query The Query menu lets you work with the results of a query in a query 
results window. 

Window The Window menu provides standard Windows commands for 
managing your desktop and lists the currently open windows so you 
can activate the one you want. This menu is always available. 

Help The Help menu gives you access to the Manager Help system and the 
Novell Web site. This menu is always available. 
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File Menu 
The File menu includes commands for creating, opening, closing, saving, renaming, 
printing, and exporting items and for exiting ZENworks Asset Management Manager. 

New The New command does the following: 

 On the Management locator tab, lets you create a collection option set folder, schedule 
folder, collection option set, collection schedule, or Collection Domain. 

 On the Query locator tab, lets you create a folder or a workstation, component, 
product, user, or FNI query. (Folders can be created only in the Public Queries or 
Personal Queries container depending on your user role.) 

 On the Report locator tab, lets you create a folder. (Folders can be created only in the 
Public Reports or Personal Reports container depending on your user role.) 

Import 
Report  

The Import Report command lets you import a custom report into the 
Manager when the Personal Reports container (or a folder in that 
container) is selected on the Report locator tab. 
For More 
Importing a Report into ZENworks Asset Management Manager  

Open  The Open command opens the item you have selected on a locator tab 
and displays it in the workspace. 

Close The Close command closes the active window in the workspace. 

Close All  The Close All command closes all the open windows in the workspace. 

Save  The Save command saves the information in the active window in the 
workspace. 

Save As  The Save As command lets you save the information in the active 
window under a different name. 

Save All  The Save All command saves all the information that has changed in all 
the open windows in the workspace. 

Rename  The Rename command lets you change the name of an item or folder on 
a locator tab. (Some items cannot be renamed.) 

Delete  The Delete command removes a folder or item from a locator tab. (Some 
items cannot be deleted.) 

Promote  (Enterprise administrators only) The Promote command makes a domain 
collection option set or domain collection schedule public so that it is 
available to all ZENworks Asset Management users. This command also 
makes an enterprise administrator’s personal query or report public so all 
ZENworks Asset Management users can run it.  
For More 
Promoting or Demoting a Collection Schedule  
Promoting or Demoting a Collection Option Set  
Promoting a Query  
Promoting a Report  



ZENworks Asset Management User's Guide 

272 

 

Print  The Print command lets you print queries, the contents of the process 
control panel, and auxiliary data for workstations. 

Print Setup  The Print Setup command lets you select a printer and other printing 
options. 

Export  The Export command lets you export the results of a query to a comma-
delimited file. 

For More 

Exporting Inventory Data  

  

Exit  The Exit command closes the Manager. 

  

 



References 

273 

Edit Menu 
The Edit menu lets you perform standard editing such as cutting, copying, and pasting 
and lets you find and replace items in a query results window or Component List 
window. 

  

Undo  The Undo command reverses what you entered or deleted (typically in a 
text box). 

Cut  The Cut command removes the selected item from a locator tab or text 
box and places it on the clipboard so it can then be pasted elsewhere. 

Copy  The Copy command copies the selected item from a locator tab or text 
box to the clipboard so it can then be pasted elsewhere. 

Paste  The Paste command places the contents of the clipboard in the current 
location on the locator tab or in a text box. 

Find  The Find command lets you search for an item in the query results 
window or Component List window. 

For More 

Finding Specific Inventory Data 

Find Next  The Find Next command lets you search for the next instance of a found 
item in the query results window or Component List window. 

For More 

Finding Specific Inventory Data 

Replace  The Replace command lets you find and change one or more instances of 
an in the query results window or Component List window. 

For More 

Finding and Replacing Inventory Data  
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View Menu 
The View menu lets you control the appearance and contents of the main ZENworks 
Asset Management Manager window. 

Management  The Management command displays the Management locator tab. 

For More 
About the Management Locator Tab  

Query  The Query command displays the Query locator tab. 

For More 
About the Query Locator Tab  

Report  The Report command displays the Report locator tab. 

For More 
About the Report Locator Tab  

Synchronize  The Synchronize command selects on the locator tab the item that is 
displayed in the active window in the workspace.  

For More 
Synchronizing the Locator Window with the Window in the Workspace  

Sort  The Sort command arranges items on a locator tab in either ascending or 
descending alphanumerical order. 

Refresh  The Refresh command updates information on a locator tab, in the 
process control panel, or in the Component List window for a 
workstation. 

Refresh 
Branch  

The Refresh Branch command updates information in the currently 
selected branch of a locator tab. 

For More 
Updating Information on a Locator Tab  

Toolbars  The Toolbars command hides or displays the main Manager toolbar, the 
query toolbar, or the process control panel toolbar. 

For More 
ZENworks Asset Management Manager Toolbars  

Status Bar  The Status Bar command hides or displays the status bar. 

Locator  The Locator command hides or displays the locator window.  

For More 
About the Locator Window  

Process 
Control Panel  

The Process Control Panel command hides or displays the process 
control panel. 

For More 
Using the Process Control Panel  
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Tools Menu 
The Tools menu lets you change some options for your inventory database, set enterprise 
and user options, and change your password. It also lets you start an immediate scan of a 
workstation or network server, start wizards that help you manage portable collections 
and migrate NetCensus data. 

Remote Client 
Install 

Use the Remote Client Install command to launch the Remote Client 
Install Utility, which allows you to select a group of workstations, and to 
install client software to each workstation. 

Enterprise 
Options  

(Enterprise administrators only) The Enterprise Options command lets 
you change options that control how long historical data is kept for 
workstations, errors, and tasks in the inventory database before it 
becomes a candidate for purging. 

For More 

Changing Enterprise Options  

Web Console 
Management 

The Web Console Management command lets you specify the name of 
your Web server so you can access the ZENworks Asset Management 
Web Console.  

For More 

Running Web Reports  

Accessing Network Discovery Data  

Proxy Server 
Management  

(Enterprise administrators only) The Proxy Server Management 
command lets you configure an HTTP proxy server for managing PRUs. 

For More 

Managing PRUs  

File Store 
Management  

(Enterprise administrators only) The File Store Management command 
lets you move the file store.  

For More 

Moving the File Store  

Preferences  The Preferences command lets you customize ZENworks Asset 
Management Manager user preferences.  

For More 

Changing User Preferences  
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Change 
Password  

The Change Password command lets you change your password for 
logging onto the Manager. 

For More 

Changing Your Password  

Create 
Portable 
Collector  

(Administrators only) The Create Portable Collector command starts the 
wizard that lets you create a Collector for performing portable (walk-
around) collections.  

For More 

Performing Portable Collections  

Load Portable 
Collection  

(Administrators only) The Load Portable Collection command starts the 
wizard that loads the results of a portable collection into the inventory 
database.  

For More 

Performing Portable Collections  

Scan 
Workstation 
Now  

The Scan Workstation Now command collects inventory data from the 
workstation currently selected in the query results window. 

For More 

Scanning a Workstation on Demand  

Recover 
Workstation  

(Administrators only) The Recover Workstation command lets you save 
the workstation’s unique identifier so you can later "re-instate" the 
workstation and not lose any historical data. 

For More 

Recovering a Workstation  

Load 
NetCensus 
Data  

(Administrators only) The Load NetCensus Data command starts the 
wizard that loads data into the inventory database from NetCensus 2.98 
data files.  

Database 
Migration  

(Administrators only) The Database Migration command starts the 
wizard that lets you migrate a database from NetCensus 2.8x (and 
higher) to the ZENworks Asset Management inventory database.  

For More 

Upgrading from NetCensus  
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Administration Menu 
The Administration menu lets you manage ZENworks Asset Management users, product 
classification, and user-defined fields; purge the database; upgrade your ZENworks Asset 
Management license; and apply a Product Recognition Update (PRU).  

This menu is available only if you are an enterprise administrator.  

ZENworks 
Asset 
Management 
Users  

The ZENworks Asset Management Users command lets you create and 
manage ZENworks Asset Management users and to set rules for user 
passwords. 

For More 
About ZENworks Asset Management Users  

Product 
Classification  

The Product Classification command lets you create and manage product 
categories and subcategories.  

For More 
About Product Classification  

User Defined 
Fields  

The User Defined Fields command lets you define your own fields and 
manage them. (The inventory process needs to be stopped.) 

For More 
About User-Defined Fields  

Database 
Purge  

The Database Purge command removes unwanted or obsolete data from 
the inventory database. 

For More 
Purging the Database  

License 
Management  

The License Management command starts the wizard for upgrading your 
ZENworks Asset Management license. 

For More 
Upgrading Your ZENworks Asset Management License  

Product 
Recognition 
Update  

The Product Recognition Update command lets you apply a Product 
Recognition Update (PRU) so the inventory database can be updated 
with the latest product recognition data.  

For More 
Managing a Product Recognition Update (PRU)  

Product Live 
Update 

Use the Product Live Update command to download and apply software 
updates automatically, and to schedule a task to check for and download 
them. 

For More 
Managing ZENworks Asset Management Application and Product 
Recognition Updates  
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Network Discovery Menu 
The Network Discovery menu includes the Options command for setting global options 
for the ZENworks Asset Management Network Discovery Engine. 

For More 

Setting Network Discovery Options  

Control Menu 
The Control menu includes process-related commands, for example, for stopping the 
inventory process or for pausing or resuming a task such as a purge. This menu is 
available when the process control panel is active.  

Stop Inventory 
Process 
Start Inventory 
Process 

(Enterprise administrators only) The Stop Inventory Process 
command stops the inventory process; the Start Inventory Process 
command starts the inventory process again.  

For More 
Stopping and Starting the Inventory Process  

Stop/Start Server (Administrators only) The Stop/Start Server command stops a 
Collection Server or Task Server or starts it again. 

For More 
Stopping or Starting a Collection Server  

Stopping or Starting a Task Server  

Pause Task The Pause Task command pauses a selected task that is waiting to 
run. 

For More 
Pausing and Resuming a Task  

Resume Task The Resume Task command starts a paused task again. 

For More 
Pausing and Resuming a Task 

Remove Task The Remove Task command removes a selected task from the 
queue so it does not run. 

For More 
Removing a Task  

Check In 
Workstation 

(Administrators only) The Check In Workstation command lets you 
check in a workstation that is checked out.  

For More 
Checking In a Workstation 
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View Errors Any errors that occur during the collection process or while tasks 
are running can be viewed in the process control panel. The View 
Errors command displays error details for Collection Servers, Task 
Servers, or workstations. 

See Also 
Error Logs and Files 

Viewing Collection Server or Workstation Errors 

Viewing Task Server Errors  

See Also 

Using the Process Control Panel  

Add Data Menu 
The Add Data menu lets you create workstations, stockrooms, components, local 
products, or workstation users. 

Workstation/Stockroom The Workstation/Stockroom command lets you create a 
workstation manually or create a stockroom. 

For More 

Adding a Workstation  

Adding a Stockroom  

Component  The Component command lets you add a component to a 
workstation or stockroom. 

For More 

Adding a Component  

Product  (Enterprise administrators only) The Product command lets 
you create a local product.  

For More 

Creating a Local Product  

User  The User command lets you create a workstation user. 

For More 

Adding a User  
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Query Menu 
The Query menu lets you work with the results of a query in a query results window.  

  

Add  In the query results window, the Add command lets you add an item, for 
example, a component. The type of item you can add depends on the 
type of query you have run. 

  

Edit  In the query results window, the Edit command displays an Edit 
Properties dialog for a selected item such as a workstation user. An Edit 
Properties dialog displays all the available data for an item so you can 
review and edit it. The type of item you can edit depends on the type of 
query you have run. 

  

Delete  In the query results window, the Delete command removes a selected 
item, for example, a workstation, from the inventory database. The type 
of item you can delete depends on the type of query you have run. 

  

View 
Component 
List  

When you are viewing the results of a workstation query, the View 
Component List command lets you display the components for a selected 
workstation. 

For More 

Viewing Workstation Components  

  

View 
Auxiliary 
Data  

When you are viewing the results of a workstation query, the View 
Auxiliary Data command lets you display auxiliary data (for example, 
IRQ data) for a selected workstation. 

For More 

Viewing Workstation Auxiliary Data  

  

Re-Assign 
Workstation  

(Enterprise administrators only) In the query results window, the Re-
Assign Workstation command lets you re-assign the selected 
workstation(s) to a different Collection Server. 
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For More 

Re-Assigning a Workstation to a Different Collection Server  

  

Exclude FNI  (Enterprise administrators only) When you are viewing the results of an 
FNI query, the Exclude FNI command lets you specify the name of a file 
to be excluded from FNI data during future scans.  

For More 

Excluding FNIs from Future Scans  

  

Exclude 
Extension  

(Enterprise administrators only) When you are viewing the results of an 
FNI query, the Exclude Extension command lets you specify a file 
extension so that files with that extension are excluded from FNI data 
during future scans. This command is available only when the inventory 
process is stopped. 

For More 

Excluding FNIs from Future Scans 

  

Exclude 
Folder  

(Enterprise administrators only) When you are viewing the results of an 
FNI query, the Exclude Folder command lets you specify a folder so that 
files in that folder are excluded from FNI data during future scans.  

For More 

Excluding FNIs from Future Scans 

  

Reconcile 
Local 
Products  

(Enterprise administrators only) When you are viewing the results of a 
product query, the Reconcile Local Products command lets you reconcile 
discrepancies in local products.  

For More 

Reconciling Local Products  

  

See Also 

About Queries  
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Window Menu 
The Window menu provides standard Windows commands for managing your desktop 
and lists the currently open windows so you can activate the one you want. This menu is 
always available. 

  

Cascade  The Cascade command rearranges the open windows so they overlap (in 
a cascade) with their title bars visible. 

  

Tile  The Tile command rearranges the open windows so they fit next to one 
another. 

  

Arrange 
Icons  

The Arrange Icons command places all minimized windows into neat 
rows at the bottom of the workspace. 

  

Help Menu 
The Help menu gives you access to the ZENworks Asset Management Manager Help 
system and the Novell Web site. This menu is always available. 

  

Search for Help 
On  

The Search for Help On command displays the Contents, Index, and 
Find tabs so you can look for Help on a particular topic. 

  

How to Use Help  The How to Use Help command displays information about using the 
Help system. 

  

Novell on the 
Web  

The Novell on the Web command uses your Web browser to give 
you access to product news or technical support on the Novell Web 
site, to the ZENworks Asset Management or Novell home page, or to 
the frequently-asked questions page. 

  

About ZENworks 
Asset 
Management  

The About ZENworks Asset Management command displays general 
information about ZENworks Asset Management including your 
serial number and license status. 
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Toolbars 

ZENworks Asset Management Manager Toolbars 
The three Manager toolbars give you access to frequently-performed activities. The 
Manager includes a standard toolbar which is generally available. Two additional 
toolbars, the process control panel toolbar and the query toolbar, are active when you are 
working in the process control panel or the query tool. 

The toolbars are normally docked below the menu bar in the main Manager window, but 
you can drag any of the toolbars to another edge of the window if you prefer. You can 
also hide any of the toolbars by clicking on the View menu, clicking on Toolbars, and 
selecting the toolbar you want to hide. (To display a toolbar again, repeat this procedure.) 

Standard Toolbar  

Process Control Panel Toolbar  

Query Toolbar  

Process Control Panel Toolbar 
The process control panel toolbar is active whenever you are working in the process 
control panel. 

The buttons on the process control panel toolbar are as follows: 

 (Administrators only) Lets you stop a Collection Server or Task Server and start it 
again. 

 (Administrators only) Displays errors for a Collection Server, Task Server, or 
workstation. 

 Pauses a task that is waiting to run. 

 Resumes a paused task. 

 Removes a task from the queue so it does not run. 

 (Administrators only) Lets you check in a checked-out workstation. 

See Also 

Using the Process Control Panel  
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Query Toolbar 
The query toolbar is active whenever you are working in the query tool. 

The buttons on the query toolbar are as follows: 

 In the query results window, lets you add an item, for example, a component. The 
type of item you can add depends on the type of query you have run. 

 In the query results window, displays an Edit Properties dialog for the selected item, 
for example, a user. An Edit Properties dialog displays all the available data for an item 
so you can review and edit it. The type of item you can edit depends on the type of query 
you have run. 

 In the query results window, deletes the selected item(s), for example, a workstation. 
The type of item you can delete depends on the type of query you have run. 

 (Enterprise administrators only) Lets you reconcile discrepancies in local products. 
This button is available only when the inventory process is stopped. 

 Lets you search for an item in a query results window or Component List window. 

 When you are viewing the results of a workstation query, displays the components 
for the selected workstation. 

 When you are viewing the results of a workstation query, displays the auxiliary data 
for the selected workstation. 
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Standard Toolbar 
The buttons on the standard toolbar are as follows: 

 On a locator tab, lets you create a folder or a collection option set, collection 
schedule, Collection Domain, or query. 

 Opens the item you have selected on a locator tab and displays it in the workspace. 

 Saves the information in the active window in the workspace. 

 Saves the information in all the open windows in the workspace. 

 Removes a folder or item from a locator tab (except for certain items supplied by 
Novell). 

 Prints queries, the contents of the process control panel, and auxiliary data for 
workstations. 

 Removes the selected item from a locator tab or text box and places it on the 
clipboard so it can be pasted elsewhere. 

 Copies the selected item from a locator tab or text box to the clipboard so it can be 
pasted elsewhere. 

 Places the contents of the clipboard at the current location on a locator tab or in a text 
box. 

 Hides or displays the locator window. 

 Hides or displays the process control panel. 

 Selects on the locator tab the item that is displayed in the active window in the 
workspace. 

 Arranges items on a locator tab in ascending alphanumerical order. 

 Arranges items on a locator tab in descending alphanumerical order. 

 (Enterprise administrators only) Displays the Manage ZENworks Asset Management 
Users dialog so you can create, edit, or delete ZENworks Asset Management users. 

 Updates information on the current locator tab, in the process control panel, or in the 
Component List window for a workstation. 

 Lets you access the ZENworks Asset Management Web Console. 

 Gives you access to the ZENworks Asset Management Manager Help system. 
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Error Logs and Files 
Any errors that occur during the collection process or while tasks are running can be 
viewed in the process control panel. The View Errors command displays error details for 
Collection Servers, Task Servers, or workstations.In addition, a daily log file of errors is 
created by ZENworks Asset Management Manager, Collection Servers, and Tasks 
Servers. These log files track serious errors, such as problems with the connection to the 
database. 

Error log files are created in the \Logs folder of the ZENworks Asset Management 
installation folder. The names of the files reflect which ZENworks Asset Management 
application created them, include the current date, and have a .log extension. For 
example, the error log files created on August 21, 2004, by the Manager, the Collection 
Server, and the Task Server would be TSCMgrEvent20040821.log, 
ColSvrCoreEvent20040821.log, and TaskServerCoreEvent20040821.log, respectively. 

See Also 

Viewing Collection Server or Workstation Errors  

Viewing Task Server Errors  
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ZENworks Asset Management Report Reference 

ZENworks Asset Management Report Reference 
Below is alphabetical reference to the ZENworks Asset Management reports. The 
description of each report includes its purpose and a list of all its possible settings. The 
settings are listed by the tab name in the Configure Report dialog, for example, Grouping 
or Sorting. 

The report descriptions show only the settings that you can change. Some reports have 
fixed settings for grouping or sorting, for example.  

Note: Demographics as a grouping choice means you can group report data by building, 
cost center, department, floor, room, or site. 

For More 

For sample reports, see ZENworks Asset Management Sample Report Reference  

For information about running reports, see Running a Report. 
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Reports Listed Alphabetically 

AntiVirus Details by Manufacturer Report  
AntiVirus Details by Workstation Report  
AntiVirus Summary by Manufacturer Report  
Collection Option Set Summary Report  
Component Breakdown Report  
Component Change History Report  
Component Move History Report  
Component Trend Report  
Duplicate Components Report  
FNI Breakdown Report  
FNI Detail Report  
FNI Usage Detail Report 
Hardware Component Breakdown Report  
Hardware Component Catalog Report  
Hardware Component Trend Report  
Hardware Product Breakdown Report  
Hardware Product Catalog Report  
Hot Fix Details by Manufacturer Report  
Hot Fix Details by Workstation Report  
Hot Fix Summary by Manufacturer Report  
License and Usage Summary by License ID Report  
License Compliance Breakdown Report  
Local Software Product Catalog Report  
Lost Components Report  
Software - In Use Versus Installed Report  
Software Component Breakdown Report  
Software Component Catalog Report  
Software Component Trend Report  
Software Product Breakdown Report  
Software Product Catalog Report  
Software Usage History by Manufacturer Report  
Software Usage History by Workstation Report  
Software Usage Trend by Manufacturer Report  
Total Free Space Breakdown Report  
Total Free Space Trend Report  
Total Hard Drive Size Breakdown Report  
Total Hard Drive Size Trend Report  
Total Memory Breakdown Report  
Total Memory Trend Report  
Workstation Catalog Report  
Workstation Change History Report  
Workstation Detail No FNI Report  
Workstation Detail No FNI/No Component Detail Report  
Workstation Detail Report  
Workstation Hardware Upgrade Report  
Workstation Lease Catalog Report  
Workstation Move History Report  
Workstation Scan History Report  
Workstation Software Component Catalog Report  
Workstation Software Upgrade Report  
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AntiVirus Details by Manufacturer Report 
An AntiVirus Details by Manufacturer report lists information about antivirus software 
components by manufacturer. For example, the report includes the name of the machine 
on which the components are installed and the name of the primary user. 

  

General N/A 

Grouping Demographics 

Filtering Additional Info, Building, Cost Center, Department, 
Floor, Machine Name, Manufacturer, 
Model/Version, Primary User, Product Name, 
Room, Serial Number, and Site  

Sorting Manufacturer, Model/Version, and Product Name 

AntiVirus Details by Workstation Report 
An AntiVirus Details by Workstation report lists information about antivirus software 
components by workstation.  

  

General N/A 

Grouping Demographics 

Filtering Additional Info, Building, Cost Center, Department, 
Floor, Machine Name, Manufacturer, 
Model/Version, Primary User, Product Name, 
Room, and Site  

Sorting Manufacturer, Model/Version, and Product Name 
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AntiVirus Summary by Manufacturer Report 
An AntiVirus Summary by Manufacturer report summarizes antiviral software 
components by manufacturer. 

  

General Display All or Display Only Top n 

Grouping Demographics 

Count by Model/Version 

Filtering Building, Cost Center, Department, Floor, 
Manufacturer, Model/Version, Product Name, 
Room, and Site  

Sorting N/A 

Collection Option Set Summary Report 
A Collection Option Set Summary report provides information about collection option 
sets and their current settings.  

  

General N/A 

Grouping N/A 

Filtering COS Name and Collection Server 

Sorting N/A 
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Component Breakdown Report 
A Component Breakdown report counts instances of components, for example, the 
number of systems made by different manufacturers. 

  

General Tabular (display All or Top n), Bar Graph (display 
All or Top 10), or Pie Chart (display All or Top 10) 

Grouping Demographics 

Count by Category Name, Manufacturer, 
Model/Version, Product Name, or Subcategory 
Name  

Filtering (Required) Building, Category Name, Cost Center, 
Department, Floor, Inventory Type, Manufacturer, 
Model/Version, Product Name, Room, Site, and 
Subcategory Name 

Sorting N/A 

Note: The filtering options in a Component Breakdown report are hierarchical in that 
they depend on the Count By choice you make. For example, if you count by Product 
Name, then Category Name, Subcategory Name, Manufacturer, and Product Name are 
the filter fields available to you. 
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Component Change History Report 
A Component Change History report shows how components have changed over time by 
being created, edited, moved, retired, or deleted. 

  

General Date range 

Grouping Demographics 

Product grouping: None or by Category Name, 
Subcategory Name 

Count by Asset Tag or Serial Number 

Filtering Asset Tag, Building, Category Name, Change Type, 
Changed By, Changed Field, Changed From, 
Changed To, Cost Center, Department, Floor, 
Inventory Type, Machine Name, Primary User, 
Room, Serial Number, Site, and Subcategory Name 

Sorting N/A 

Component Move History Report 
A Component Move History report lists components that have been moved among 
workstations, stockrooms, and the Lost and Found. 

  

General Date range 

Grouping Demographics 

Product Grouping: None or by Category Name, 
Subcategory Name 

Count by Asset Tag or Serial Number 

Filtering Building, Category Name, Changed By, Changed 
From, Changed To, Cost Center, Department, Floor, 
Inventory Type, Primary User, Room, Site, and 
Subcategory Name 

Sorting N/A 
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Component Trend Report 
A Component Trend report counts components over time so you can analyze trends. 

  

General Tabular or Line Graph, Frequency, and Date Range 

Grouping Demographics 

Count by Category Name, Manufacturer, 
Model/Version, Product Name, or Subcategory 
Name  

Filtering (Required) Building, Category Name, Cost Center, 
Department, Floor, Inventory Type, Manufacturer, 
Model/Version, Product Name, Room, Site, and 
Subcategory Name 

Sorting N/A 

Duplicate Components Report 
A Duplicate Components report identifies any components with the same asset tag or 
serial number. You can then run a query to delete one of the duplicated components. 

  

General N/A 

Grouping Demographics 

Count by Asset Tag or Serial Number 

Filtering Building, Category Name, Cost Center, Date 
Created, Department, Floor, Inventory Type, 
Machine Name, Manufacturer, Model/Version, 
Primary User, Product Name, Product Type, Room, 
Site, and Subcategory Name  

Sorting N/A 
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FNI Breakdown Report 
An FNI Breakdown report counts instances of FNIs (software product files that were not 
identified by the Collector during a scan) by file name or extension. For example, if your 
organization uses some internally-developed applications, you can use an FNI 
Breakdown report to see the instances of the applications broken down by department or 
cost center.  

You can produce an FNI Breakdown report as a tabular report, bar graph, or pie chart. 

Tip 

To see detailed FNI data by workstation, run an FNI Detail report 

General Tabular (display All or Top n), Bar Graph (display 
All or Top 10), or Pie Chart (display All or Top 10)  

Grouping Demographics 

Count by File Extension or File Name 

Filtering Building, Cost Center, Department, File Extension, 
File Name, Floor, Room, and Site 

Sorting N/A 

FNI Detail Report 
An FNI Detail report provides a detailed list of FNIs, for example, for one department. 

  

General N/A 

Grouping Demographics 

Count by File Name or File Extension 

Filtering Building, Cost Center, Department, File Date, File 
Extension, File Name, File Size (Bytes), Floor, 
Machine Name, Primary User, Room, Site, and 
Subdirectory 

Sorting File Date, File Size (Bytes), Machine Name, 
Primary User, and Subdirectory 
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FNI Usage Detail Report 
An FNI Usage Detail report shows in detail how applications that result in FNI data are 
being used on workstations. For each file name or file extension, the report shows the 
total time the application ran, the time it was active, and the percentage of time it was 
active. The report also lists the machine name of each workstation on which the 
application was running and the name of the primary user. By default, the reports filters 
on Total Runtime (sec)!=0 so that applications that did not run are not listed in the report  

General N/A 

Grouping Demographics  

Count by File Name or File Extension  

Filtering Building, Cost Center, Department, File Extension, 
File Name, Floor, Machine Name, Primary User, 
Room, Site, Subdirectory, Total Active (sec), and 
Total Runtime (sec) 

Sorting Subdirectory, Total Active (sec), and Total Runtime 
(sec)  

Hardware Component Breakdown Report 
A Hardware Component Breakdown report counts instances of hardware components, for 
example, the number of processor types at each site.  

A wide range of grouping and filtering options are available in a Hardware Component 
Breakdown report so you have a great deal of flexibility in how you look at how the 
counts of hardware components. For example, the possibilities include the following: 

 Counts of printers by subcategory, manufacturer, product, and model/version, grouped by cost center. 
For each cost center, the counts of each model printer would be shown, with further subtotals by product, 
manufacturer, and subcategory. 

 Categories of hardware components grouped by department. For each department, the counts of each 
category of component (for example, monitor or printer) would be shown. 

 Manufacturers of systems by cost center. For each cost center, the counts of system manufacturers (for 
example, Dell, Gateway, or COMPAQ) would be shown. 

 Subcategories of processors by site. For each site, the counts of processors according to subcategory (for 
example, 486 or Pentium Pro) would be shown. 

General Display all or top n 
Grouping Demographics 

Count by Model/Version 
Filtering Building, Category Name, Cost Center, Department, 

Floor, Inventory Type, Manufacturer, 
Model/Version, Product Name, Room, Site, and 
Subcategory Name  

Sorting N/A 
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Hardware Component Catalog Report 
A Hardware Component Catalog report lists information about hardware components, for 
example, users who have Dell Latitude systems.  

  

General N/A 

Grouping Demographics 

Filtering Asset Tag, Building, Category Name, Cost Center, 
Department, Floor, Inventory Type, Machine Name, 
Manufacturer, Model/Version, Primary User, 
Product Name, Product Source, Room, Serial 
Number, Site, and Subcategory Name 

Sorting Category Name, Manufacturer, Model/Version, 
Product Name, Product Source, and Subcategory 
Name  

Note: If you select Product Source as your sorting field, the sort will not be alphabetical. 

Hardware Component Trend Report 
A Hardware Component Trend report counts hardware components over time so you can 
analyze trends. 

  

General Frequency and Date Range 

Grouping Demographics 

Count by Model/Version 

Filtering Building, Category Name, Cost Center, Department, 
Floor, Inventory Type, Manufacturer, 
Model/Version, Product Name, Room, Site, and 
Subcategory Name 

Sorting N/A 
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Hardware Product Breakdown Report 
A Hardware Product Breakdown report counts hardware products defined by Novell. 

  

General N/A 

Grouping Count by Model/Version 

Filtering Category Name, Manufacturer, Model/Version, 
Product Name, and Subcategory Name 

Sorting N/A 

Hardware Product Catalog Report 
A Hardware Product Catalog report lists information about hardware products defined by 
Novell. 

  

General N/A 

Grouping N/A 

Filtering Category Name, Date Created, Manufacturer, 
Model/Version, Product Name, Product Source, and 
Subcategory Name  

Sorting Category Name, Date Created, Manufacturer, 
Model/Version, Product Name, Product Source, and 
Subcategory Name 

Hot Fix Details by Manufacturer Report 
A Hot Fix Details by Manufacturer report lists information about hot fix components, for 
example, the date they were installed. 

  

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Date Installed, Department, 
Description, Floor, Manufacturer, Model/Version, 
Product Name, Registry Key, Room, and Site  

Sorting Model/Version 
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Hot Fix Details by Workstation Report 
A Hot Fix Details by Workstation report lists information about hot fix components by 
workstation.  

  

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Date Installed, Department, 
Description, Floor, Machine Name, Manufacturer, 
Model/Version, Primary User, Product Name, 
Registry Key, Room, and Site  

Sorting Manufacturer, Model/Version, and Product Name 

Hot Fix Summary by Manufacturer Report 
A Hot Fix Summary by Manufacturer report summarizes instances of hot fix (patch) 
components. 

  

General Display All or Display Only Top n 

Grouping Demographics 

Count by Model/Version 

Filtering Building, Cost Center, Department, Floor, 
Manufacturer, Model/Version, Product Name, 
Room, and Site  

Sorting N/A 
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License and Usage Summary by License ID Report 
A License and Usage Summary by License ID report shows products grouped by license 
ID, with the total installed summarized against the total licenses assigned. In addition, the 
report shows the number of workstations on which the software ran versus the number of 
workstations on which it was installed.  

  

General N/A 

Grouping N/A 

Filtering License ID, License Name, Manufacturer, 
Model/Version, and Product Name 

Sorting N/A 

License Compliance Breakdown Report 
For each product, a License Compliance Breakdown report shows the total number of 
licenses purchased, the total licenses installed (broken down by version), and the variance 
between purchased and installed licenses. (If a product is installed more than once on a 
workstation, it is counted only once, however.) 

Before you can run a License Compliance Breakdown report, you must provide some 
licensing information for your products. For details, see Entering License Data into the 
Database. 

Note: License Compliance Reports are also available through the ZENworks Asset 
Managment Software Compliance. 

  

General N/A 

Grouping N/A 

Filtering License ID, License Name, Manufacturer, 
Model/Version, Product Name, and Product Type 

Sorting N/A 
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Local Software Product Catalog Report 
A Local Software Product Catalog report lists information about local products that have 
been defined. 

General N/A 

Grouping N/A 

Filtering Category Name, Date Created, File Date, File Name, 
File Size, File Time, Manufacturer, Model/Version, 
Product Name, Product Source, Subcategory Name, 
and Subdirectory 

Sorting Date Created, Manufacturer, Model/Version, 
Product Name, and Product Source 

Lost Components Report 
A Lost Components report lists all the components in the Lost and Found. The Lost and 
Found is a special kind of stockroom that is created and maintained by TS.Census. If a 
component was discovered on a workstation during the inventory process, but is found to 
be missing during a subsequent inventory cycle, TS.Census places the component in the 
Lost and Found. If the component later turns up on another workstation, TS.Census 
automatically removes it from the Lost and Found. For a component to be maintained in 
the Lost and Found, it must have a serial number or asset tag. 

Tip 

If the Lost Components report lists any components that you know are not really lost, you 
can run the pre-supplied Lost and Found Components query and then move or delete the 
components as necessary. See About the Lost and Found for information. 

General N/A 

Grouping Demographics plus Collection Server Name and 
Domain Name 

Product Grouping: None or by Category Name, 
Subcategory Name 

Filtering Asset Tag, Building, Category Name, Collection 
Server Name, Cost Center, Department, Domain 
Name, Floor, Inventory Type, Machine Name, 
Primary User, Product, Room, Serial Number, Site, 
and Subcategory Name 

Sorting Asset Tag, Change Date, Machine Name, Primary 
User, Product, and Serial Number 
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Software - In Use Versus Installed Report 
A Software - In Use Versus Installed report lists software products and their usage. For 
each product in a particular category and subcategory, the report shows the total time it 
ran, the time it was active, and the percentage of the time it was active. The report also 
shows the number of workstations on which the software ran versus the number of 
workstations on which it was installed. If, for example, a number of word processing 
applications are used in your company, you can use this report to see which are used most 
heavily, perhaps to determine whether you should standardize on one. By default, the 
report is filtered by Total Runtime (sec)!=0 so that applications that did not run are not 
included.  

  

General Report History date range 

Grouping N/A  

Filtering Category Name, Manufacturer, Model/Version, 
Product Name, Subcategory Name, Total Runtime 
(sec), and Total Time Active (sec)  

Sorting N/A 

Software Component Breakdown Report 
A Software Component Breakdown report counts instances of software components, for 
example, the number of Microsoft applications in the enterprise. 

  

General Display All or Top n 

Grouping Demographics 

Count by Model/Version 

Filtering Building, Category Name, Cost Center, Department, 
Floor, Inventory Type, Manufacturer, 
Model/Version, Product Name, Room, Site, and 
Subcategory Name 

Sorting N/A 
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Software Component Catalog Report 
A Software Component Catalog report lists information about software components, for 
example, users who have Microsoft 2000 applications in each department. 

  

General N/A 

Grouping Demographics 

Filtering Building, Category Name, Cost Center, Department, 
Floor, Inventory Type, Machine Name, 
Manufacturer, Model/Version, Primary User, 
Product Name, Product Source, Room, Serial 
Number, Site, and Subcategory Name 

Sorting Category Name, Manufacturer, Model/Version, 
Product Name, Product Source, and Subcategory 
Name 

 

Software Component Trend Report 
A Software Component Trend report counts software components over time so you can 
analyze trends. 

  

General Frequency and Date Range 

Grouping Demographics 

Count by Model/Version 

Filtering Building, Category Name, Cost Center, Department, 
Floor, Inventory Type, Manufacturer, 
Model/Version, Product Name, Room, Site, and 
Subcategory Name 

Sorting N/A 
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Software Product Breakdown Report 
A Software Product Breakdown report counts software products defined by Novell. 

  

General N/A 

Grouping Count by Model/Version 

Filtering Category Name, Manufacturer, Model/Version, 
Product Name, and Subcategory Name 

Sorting N/A 

Software Product Catalog Report 
A Software Product Catalog report lists information about software products defined by 
Novell.  

Note: Thousands of software products are known to ZENworks Asset Management so 
Novell strongly recommends that you filter the contents of the report. For example, you 
can filter by category name, subcategory name, manufacturer, product name, 
model/version, product source, or date created. 

Tip 

If you want information about products that are components of workstations in your 
organization, run a Software Component Catalog report. A product report tells you which 
products are known to ZENworks Asset Management, not which products are associated 
with workstations. 

  

  

General N/A 

Grouping N/A 

Filtering Category Name, Date Created, Manufacturer, 
Model/Version, Product Name, Product Source, and 
Subcategory Name 

Sorting Category Name, Date Created, Manufacturer, 
Model/Version, Product Name, Product Source, and 
Subcategory Name 
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Software Usage History by Manufacturer Report 
A Software Usage History by Manufacturer report shows the total time each application 
ran, the time it was active, and the percentage of time it was active. The report also lists 
the machine name of each workstation on which the application was running and the 
name of the primary user. By default, the reports filters on Total Runtime (sec)!=0 so that 
applications that did not run are not listed in the report. 

  

General Report History date range 

Grouping Demographics  

Filtering Building, Category Name, Cost Center, Department, 
Floor, Inventory Type, Machine Name, 
Manufacturer, Model/Version, Primary User, 
Product Name, Room, Site, Subcategory Name, 
Total Runtime (sec), and Total Time Active (sec) 

Sorting N/A 

Software Usage History by Workstation Report 
A Software Usage History by Workstation report provides information about application 
usage on particular workstations during a given period. The report shows the total time 
each application ran, the time it was active, and the percentage of time it was active on a 
particular day. 

  

General Report History date range 

Grouping Demographics  

Filtering Building, Cost Center, Department, Floor, Inventory 
Type, Machine Name, Primary User, Room, Site, 
Subdirectory, Total Runtime (sec), and Total Time 
Active (sec) 

Sorting N/A 
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Software Usage Trend by Manufacturer Report 
A Software Usage Trend by Manufacturer report shows trends in software usage over 
time. The report provides usage data for each application on each day during a specified 
period. The report includes the total time the application ran, the time it was active, and 
the percentage of time it was active. By default, the reports filters on Total Runtime 
(sec)!=0 so that applications that did not run are not listed in the report. 

  

General Frequency and Date Range 

Grouping Demographics  

Count by Model/Version 

Filtering Building, Category Name, Cost Center, Department, 
Floor, Inventory Type, Machine Name, 
Manufacturer, Model/Version, Product Name, 
Room, Site, Subcategory Name, Total Runtime 
(sec), and Total Time Active (sec)  

Sorting N/A 

Total Free Space Breakdown Report 
A Total Free Space Breakdown report counts workstations according to the amount of 
free disk space they have. For example, you can see how many workstations have free 
disk space ranging in amount from 0 MB to 999 MB, 1 GB to 9.99, 10 GB to 39.99 GB, 
and so on. (These ranges are fixed.) 

  

General Tabular (display All or Top n), Bar Graph (display 
All or Top 10), or Pie Chart (display All or Top 10) 

Grouping Demographics 

Count by Free Disk Space (MB) 

Filtering Building, Cost Center, Department, Floor, Free Disk 
Space (MB), Inventory Type, Room, and Site 

Sorting N/A 
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Total Free Space Trend Report 
A Total Free Space Trend report tracks changes over time to the amount of free disk 
space on workstations so you can analyze trends. 

  

General Tabular or Line Graph, Frequency, and Date Range 

Grouping Demographics 

Count by Free Disk space (MB) 

Filtering Building, Cost Center, Department, Floor, Free Disk 
Space (MB), Inventory Type, Room, and Site  

Sorting N/A 

Total Hard Drive Size Breakdown Report 
A Total Hard Drive Size Breakdown report counts workstations according to the size of 
their hard drives. For example, you can see how many workstations have hard drives 
ranging in size from 0 MB to 999 MB, 1 GB to 9.99, 10 GB to 39.99 GB, and so on. 
(These ranges are fixed.)  

  

General Tabular (display All or Top n), Bar Graph (display 
All or Top 10), or Pie Chart (display All or Top 10) 

Grouping Demographics 

Count by Total Disk Space (MB) 

Filtering Building, Cost Center, Department, Floor, Inventory 
Type, Room, Site, and Total Disk Space (MB) 

Sorting N/A 
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Total Hard Drive Size Trend Report 
A Total Hard Drive Size Trend report tracks changes over time to the size of hard drives 
on workstations so you can analyze trends. 

General Tabular or Line Graph, Frequency, and Date Range 

Grouping Demographics 

Count by Total Disk Space (MB) 

Filtering Building, Cost Center, Department, Floor, Inventory 
Type, Room, Site, and Total Disk Space (MB) 

Sorting N/A 

Total Memory Breakdown Report 
A Total Memory Breakdown report counts workstations according to the amount of 
memory they have in MB. For example, you can see how many workstations have 
memory amounts that range from 0 MB to 16 MB, 17 MB to 64 MB, 65 MB to 128 MB, 
129 MB to 256 MB, 257 MB to 512 MB, and so on. (The size ranges are fixed.) 

General Tabular (display All or Top n), Bar Graph (display 
All or Top 10), or Pie Chart (display All or Top 10) 

Grouping Demographics 

Count by Total Memory (MB) 

Filtering Building, Cost Center, Department, Floor, Inventory 
Type, Room, Site, and Total Memory (MB) 

Sorting N/A 

Total Memory Trend Report 
A Total Memory Trend report tracks changes over time to the amount of total memory on 
workstations so you can analyze trends. 

General Tabular or Line Graph, Frequency, and Date Range 

Grouping Demographics 

Count by Total Memory (MB) 

Filtering Building, Cost Center, Department, Floor, Inventory 
Type, Room, Site, and Total Memory (MB) 

Sorting N/A 
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Workstation Catalog Report 
A Workstation Catalog report lists workstations and their properties, for example, all the 
workstations at a particular site. 

  

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Department, Floor, IP 
Address, Inventory Type, LAN Address, Machine 
Name, Phone, Workstation:Technical 
Contact\Phone, Primary User, Room, Site, and 
Technical Contact 

Sorting IP Address, LAN Address, Machine Name, Phone, 
Primary User, Room, and Technical Contact 

Workstation Change History Report 
A Workstation Change History report lists changes made to a workstation, for example, 
added or deleted components, as well as changes made to components. 

  

General Report History date range 

Grouping Demographics, plus Collection Server Name and 
Domain Name 

Filtering Building, Collection Server Name, Cost Center, 
Department, Domain Name, Floor, IP Address, 
Inventory Type, LAN Address, Lease Contract ID, 
Lease Expiration Date, Leased, Login Name, 
Machine Name, Primary User, Room, and Site 

Sorting N/A 
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Workstation Detail No FNI Report 
A Workstation Detail No FNI report provides all the details about a workstation except 
for the FNI information.  

  

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Department, Floor, IP 
Address, Inventory Type, LAN Address, Login 
Name, Machine Name, Primary User, Room, and 
Site 

Sorting N/A 

Workstation Detail No FNI/No Component Detail Report 
A Workstation Detail No FNI/No Component Detail report provides all the details about 
a workstation except for FNI information and component details.  

  

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Department, Floor, IP 
Address, Inventory Type, LAN Address, Login 
Name, Machine Name, Primary User, Room, and 
Site 

Sorting N/A 
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Workstation Detail Report 
A Workstation Detail report provides as much information as possible about a 
workstation. The information includes the following: 

 Details about the workstation itself, for example, machine name, associated 
Collection Domain and Collection Server, site, department, cost center, building, 
room, telephone, and technical contact person. 

 Details about the workstation’s primary user, for example, name, phone and fax 
numbers, and e-mail address. 

 System information, for example, manufacturer, product name, model, serial 
number, asset tag, total memory, total disk space, and free disk space. 

 Scan information, for example, the dates of the last scan and the baseline (original) 
scan, the total number of scans to date, and the Collector and the version of the KB 
(recognition) files used. 

 A summary of the workstation components that includes such information as the 
category name, subcategory name, product description, serial number, and asset tag 
for each component. 

 Detailed component information, for example, the resolution and size of a monitor. 

 FNI data for the workstation which includes the file name; the path to the folder in 
which the file resides; and the file size, date, and time. 

 Environmental information such as IRQ use. 

Note: Given the amount of information available for each workstation, Novell strongly 
recommends that you filter the report by a relatively narrow criterion, for example, by a 
department or even a room. 

Tip 

Two other workstation detail reports are available: Workstation Detail No FNI and 
Workstation Detail No FNI/No Component Detail. These provide workstation details 
without as many pages per workstation as the Workstation Detail report. 

 

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Department, Floor, IP 
Address, Inventory Type, LAN Address, Login 
Name, Machine Name, Primary User, Room, and 
Site 

Sorting N/A 
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Workstation Hardware Upgrade Report 
A Workstation Hardware Upgrade report lists workstations that are candidates for 
upgrading according to criteria you specify, for example, the amount of disk space or 
processor speed. With this kind of report you can see, for example which workstations 
have less than 64 MB memory or which workstations do not have a processor of a certain 
kind of speed. 

Tip 

For analyzing software upgrade requirements, run a Workstation Software Upgrade 
report. 

Below is a sample Workstation Hardware Upgrade report that lists workstations with a 
processor speed of less than or equal to 300 MHz and with less than 4 GB of disk space. 
(These criteria are specified on the Filtering tab.)  

  

General N/A 

Grouping Demographics, plus Collection Server Name and 
Domain Name 

Filtering (Required) Building, Collection Server Name, Cost 
Center, Department, Domain Name, Floor, Free 
Disk Space (MB), Inventory Type, Machine Name, 
Primary User, Room, Service Pack, Site, Total Disk 
Space (MB), and Total Memory (MB). In addition, 
if you select Contains Component and then CPU as 
the filter field, Manufacturer and Speed (MHz) are 
available; if you select Contains Component and 
then Operating System as the filter field, Product 
Name is available; and if you select Contains 
Component and then System as the filter field, 
Manufacturer, Model/Version, and Product Name 
are available. 

Sorting N/A 
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Workstation Lease Catalog Report 
A Workstation Lease Catalog report lists workstations and their lease status, for example, 
the leasing status of all workstations at a particular site. 

  

General N/A 

Grouping Demographics 

Filtering Building, Cost Center, Department, Floor, Inventory 
Type, Lease Contract ID, Lease Expiration Date, 
Leased, Machine Name, Room, and Site 

Sorting Lease Contract ID, Lease Expiration Date, Leased, 
and Machine Name 

Workstation Move History Report 
A Workstation Move History report tracks the history of a workstation’s physical 
movements among rooms, floors, buildings, or sites. For a sample report, see Sample 
Workstation Hardware Upgrade Report. 

  

General Report History date range 

Grouping Demographics, plus Collection Server Name and 
Domain Name 

Count by Machine Name  

Filtering Building, Changed Field, Changed From, Changed 
To, Collection Server Name, Cost Center, 
Department, Domain Name, Floor, Inventory Type, 
Machine Name, Primary User, Room, and Site  

Sorting N/A 
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Workstation Scan History Report 
A Workstation Scan History report tracks a workstation’s scan history. With this report 
you can see, for example, which workstations have not been scanned in the past month or 
which have experienced unusually long scan times. 

  

General Report History date range 

Grouping Demographics, plus Collection Server Name and 
Domain Name 

Count by Date or Machine Name 

Filtering Building, Collection Server Name, Cost Center, 
Date, Department, Domain Name, Duration, Floor, 
Inventory Type, Machine Name, Primary User, 
Room, Site, and Technical Contact  

Sorting N/A 

Workstation Software Component Catalog Report 
A Workstation Software Component Catalog report lists software components by 
workstation. 

  

General N/A 

Grouping Demographics 

Filtering Building, Category Name, Cost Center, Department, 
Floor, Machine Name, Manufacturer, 
Model/Version, Primary User, Product Name, 
Product Source, Room, Serial Number, Site, and 
Subcategory Name 

Sorting Category Name, Manufacturer, Model/Version, 
Product Name, Product Source, and Subcategory 
Name 
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Workstation Software Upgrade Report 
A Workstation Software Upgrade report lists workstations that are candidates for 
upgrading according to criteria you specify, for example, a particular version of an 
application. 

  

General N/A 

Grouping Demographics, plus Collection Server Name and 
Domain Name 

Filtering (Required) Building, Collection Server Name, Cost 
Center, Department, Domain Name, Floor, 
Inventory Type, Machine Name, Primary User, 
Room, and Site. In addition, Manufacturer, 
Model/Version, and Product Name are available if 
you select Contains Component and then Software 
as the filter field. 

Sorting N/A 
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ZENworks Asset Management Database Tables 

This section provides information about the ZENworks Asset Management database 
tables for advanced users who may need information about their contents. 

To help you find the information you need, the tables are grouped as follows: 

 Inventory Data Tables  
 Network Discovery Tables  
 Inventory Process Tables  
 Administrative Tables  
 History and Reporting Tables  
 Software Compliance Tables  

Within each group, the tables are listed alphabetically.  

How to Use Database Table Definitions 

This information is for advanced users who need to understand the structure of the 
ZENworks Asset Management inventory database. For example, some users may want to 
create their own custom reports with Crystal Reports. 

This section is purely informational; its contents should not be used to change the 
database in any way. In particular, 

 Never edit data in the inventory database directly.  
 Never change the structure of the database tables.  

Either action would compromise the integrity of the database severely. 

Caution: If you edit the inventory database directly or alter the database tables in any way, you will forfeit your right 
to receive any technical support from Novell related to the altered database. 
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Table Description Format 

The description of each database table includes the following information for the columns 
in the table: 

 The column name. 
 The key (if any): PK is a primary key; FK is a foreign key. 

 The data type. Note that some data types have different names in Microsoft SQL 
Server, Microsoft Data Engine, and Oracle.  

The following data types may be found in the ZENworks Asset Management database. 

 A float is an 8-byte floating point number.  
This data type is called a float(126) in Oracle. 

 A short <INT2> is a 2-byte integer from -32,768 to 32,767. 
This data type is called a smallint in both Microsoft SQL Server and Microsoft Data Engine and is called a 
number(10,0) in Oracle. 

 A long <INT4> is a 4-byte integer from -2,147,483,648 to 2,147,483,647. 
This data type is called an int in both Microsoft SQL Server and Microsoft Data Engine and is called a 
number(30,0) in Oracle. 

 A binary(n) is an array of bytes, n bytes in length. 
This data type is called a raw in Oracle. 

 A varbinary(n) is a variable length array of bytes, with a maximum length of n. 
 A GUID is equivalent to Uniqueidentifier in Microsoft SQL Server 7.0, 2000, and Microsoft Data Engine. In 

Oracle, it is a raw(18). 
 A char(n) is a character string of length n. 
 A varchar(n) is a variable length character string, with a maximum length of n. 

This data type is called a varchar2 in Oracle. 
 Text is character data greater than 255 characters, stored in linked lists of 2 KB data pages. 
 Numeric(p,s) is numeric data with fixed precision (p) and scale (s). The storage is based on the precision. 

This data type is called a number in Oracle. 
 A DateTime is the date and time. 

This data type is called a date in Oracle. 
 The status of nulls. A "No" in the Null column indicates that a null is not allowed; the absence of a "No" 

means a null is allowed. 
 A description of the column. 
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ZENworks Asset Management Database Tables 
This section provides information about the ZENworks Asset Management database 
tables for advanced users who may need information about their contents. 

To help you find the information you need, the tables are grouped as follows: 

 Inventory Data Tables  
 Network Discovery Tables  
 Inventory Process Tables  
 Administrative Tables  
 History and Reporting Tables  
 Software Compliance Tables  

Within each group, the tables are listed alphabetically.  

How to Use Database Table Definitions 

This information is for advanced users who need to understand the structure of the 
ZENworks Asset Management inventory database. For example, some users may want to 
create their own custom reports with Crystal Reports. 

This section is purely informational; its contents should not be used to change the 
database in any way. In particular, 

 Never edit data in the inventory database directly.  
 Never change the structure of the database tables.  

Either action would compromise the integrity of the database severely. 

Caution: If you edit the inventory database directly or alter the database tables in any way, you will forfeit your right 
to receive any technical support from Novell related to the altered database. 

Table Description Format 

The description of each database table includes the following information for the columns 
in the table: 

 The column name. 
 The key (if any): PK is a primary key; FK is a foreign key. 

 The data type. Note that some data types have different names in Microsoft SQL 
Server, Microsoft Data Engine, and Oracle.  

The following data types may be found in the ZENworks Asset Management database. 

 A float is an 8-byte floating point number.  
This data type is called a float(126) in Oracle. 

 A short <INT2> is a 2-byte integer from -32,768 to 32,767. 
This data type is called a smallint in both Microsoft SQL Server and Microsoft Data Engine and is called a 
number(10,0) in Oracle. 

 A long <INT4> is a 4-byte integer from -2,147,483,648 to 2,147,483,647. 
This data type is called an int in both Microsoft SQL Server and Microsoft Data Engine and is called a 
number(30,0) in Oracle. 
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 A binary(n) is an array of bytes, n bytes in length. 
This data type is called a raw in Oracle. 

 A varbinary(n) is a variable length array of bytes, with a maximum length of n. 
 A GUID is equivalent to Uniqueidentifier in Microsoft SQL Server 7.0, 2000, and Microsoft Data Engine. In 

Oracle, it is a raw(18). 
 A char(n) is a character string of length n. 
 A varchar(n) is a variable length character string, with a maximum length of n. 

This data type is called a varchar2 in Oracle. 
 Text is character data greater than 255 characters, stored in linked lists of 2 KB data pages. 
 Numeric(p,s) is numeric data with fixed precision (p) and scale (s). The storage is based on the precision. 

This data type is called a number in Oracle. 
 A DateTime is the date and time. 

This data type is called a date in Oracle. 
 The status of nulls. A "No" in the Null column indicates that a null is not allowed; the absence of a "No" 

means a null is allowed. 
 A description of the column. 
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ZENworks Asset Management Software Compliance Tables 
LC_Component 

Reporting table with component and workstation OID’s copied from the NC_Component 
table, and the product OID’s mapped to the LC_TallyProduct table. 

Field Key Type Null Description 

ComponentOID PK uniqueidentifier N to the NC_Component  

WorkstationOID   uniqueidentifier N to the NC_Workstation 

TallyProductOID   uniqueidentifier N to the LC_TallyProduct 

Excluded   tinyint N 0 - not excluded (default) 

1 - Component is excluded 
because the product is excluded 
by Novell 

2 - Component is excluded 
because it is a member of a 
software suite and the suite is 
installed 

Notes 

1. Primary Key ‘PK_LC_Component’ on ComponentOID column. 
2. Index ‘IX_LC_Component_WorkstationOID’ on WorkstationOID column. 
3. Index ‘IX_LC_ Component _TallyProductOID’ on TallyProductOID column. 
4. Indes 'IDX_LC_TallyProduct_Excluded' on Excluded column. 
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LC_ImportError 

Errors occuring during imports 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

ErrorOID PK uniqueidentifier N Unique identifier for errors during 
import jobs 

JobOID FK uniqueidentifier N Unique identifier for import jobs 

AccountID   uniqueidentifier N Account ID (NULL for ZENworks 
Asset Management) 

CreatedDate   datetime N Date/time of error 

FileName   varchar(64) Y Name of uploaded purchase record 
file 

LineNum   int N Line number of error in purchase 
record file 

ErrorMsg   varchar(64) Y Error message of error 

StackTrace   varchar(256) Y Stace trace describing error 
scenario 

Notes 

 Primary Key ‘PK_LC_ImportError’ on ErrorOID column. 
 Foreign Key constraint ‘FK_LC_ImportError_LC_ImportHistory’ : JobOID references LC_ImportHistory. JobOID. 
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LC_ImportHistory 

History of imports. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

JobOID PK uniqueidentifier N Unique identifier for import 
jobs 

AccountID   uniqueidentifier Y Account ID (NULL for 
ZENworks Asset 
Management) 

NumRecordsCreated   int N Number of records 
imported 

NumDetailsCreated   int  N Number of Purchase Record 
Details rows created 

NumProductsCreated   int N Number of new Products 
created 

ImportStartTime   datetime N When the import started 

ImportEndTime   datetime N When the import finished 

Duration   Decimal(19) N Duration of import 
(EndTime – StartTime) 

NumErrors   Int N Number of errors reported 

FileName   varchar(64) Y Name of uploaded purchase 
record file 

FileLength   Decimal(19) N Length of uploaded 
purchase record file 

NumRows   Int N Number of rows in uploaded 
purchase record file 

Success   Int N Status of the import job 

Progress   Decimal(19) N Default 0 - Progress of the 
import job 

Note 

 Primary Key ‘PK_LC_ImportHistory’ on JobID column. 
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LC_License 

License information. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

LicenseOID PK uniqueidentifier N Internal identifier 

AccountID   uniqueidentifier Y Account ID (NULL for ZENworks 
Asset Management) 

Manufacturer   varchar(64) N Product Manufacturer 

Name   varchar(255) N Product name 

Version   varchar(32) N Product version 

Notes   varchar(256) Y Optional license notes 

AllocateBy   tinyint N Allocate License By: 1-Site,  
2-Department,  
3-CostCenter 

AllocateImports   tinyint   Importer should create license 
allocation records from purchase 
record demographic data  
(0-No, 1-Yes) 

Platform   Varchar(32) Y   

Notes 

 Primary Key ‘PK_LC_License’ on LicenseOID column. 
 Index ‘IX_LC_License_AccountID’ on AccountID column. 
 Unique constraint ‘UC_LC_License_Mfr_Name_Version_AccountID’ on (Manufacturer, Name, Version and 

AccountID) 
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LC_LicenseAllocation 

Demographic License Allocation information. 

  

Field Key Type Null Description 

InstanceVersion   int N Default 1 

AllocationOID PK uniqueidentifier N Unique identifier for 
demographic allocation 

LicenseOID FK uniqueidentifier N Unique identifier for 
related license 

Type   int N Allocation type: 1-Site, 
2-Department, 3-
CostCenter 

Unit   varchar(32) N Allocation Unit (ie, Site 
name) 

Qty   int N Number of licenses 
allocated to this 
Allocation Unit 

Notes: 

 Primary Key ‘PK_LC_License’ on LicenseOID column. 
 Index ‘IDX_License_Account’ on AccountID column. 
 Unique constraint ‘UQ_License_Prod_Account’ on (Manufacturer, Name, Version and AccountID) 

LC_LicenseToPPMap 

Mapping of Licenses to Purchased Products. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

MapOID PK uniqueidentifier N   

PurchasedProductOID FK uniqueidentifier N FK to the Purchased 
Product table 

LicenseOID FK uniqueidentifier N FK to the License table 

AccountID   uniqueidentifier Y Account ID (NULL for 
ZENworks Asset 
Management) 

Notes 

 Primary Key ‘PK_LC_LicenseToPPMap’ on MapOID column. 
 Index ‘IX_LC_LicenseToPPMap_AccountID’ on AccountID column. 
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 Unique constraint ‘UC_LC_LicenseToPPMap_PurchasedProductOID_AccountID’ on (PurchasedProductOID and 
AccountID) which says a given purchased product can be assigned to only one license, for each account. 

 Foreign Key constraint ‘FK_LC_LicenseToPPMap_LC_PurchasedProduct’ : PurchasedProductOID references 
LC_PurchasedProduct. PurchasedProdOID. 

 Foreign Key constraint ‘FK_LC_LicenseToPPMap_LC_License’ : LicenseOID references LC_License. LicenseOID. 

LC_LicenseToTPMap 

Mapping of Licenses to Discovered Novell Products. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

MapOID PK uniqueidentifier N   

TallyProductOID FK uniqueidentifier N FK to the Consolidated Novell Product 
table 

LicenseOID FK uniqueidentifier N FK to the License table 

AccountID   uniqueidentifier Y Account ID (NULL for ZENworks Asset 
Management) 

Notes 

 Primary Key ‘PK_LC_LicenseToTPMap’ on MapOID column. 
 Index ‘IX_LC_LicenseToTPMap_AccountID’ on AccountID column. 
 Unique constraint ‘UC_LC_LicenseToTPMap_TallyProductOID_AccountID’ on (TallyProductOID and AccountID) 

which says a given discovered product can be assigned to only one license, for each account. 
 Foreign Key constraint ‘FK_LC_LicenseToTPMap_LC_TallyProduct’ : TallyProductOID references 

LC_TallyProduct. ProductOID 
 Foreign Key constraint ‘FK_LC_LicenseToTPMap_LC_License’ : LicenseOID references LC_License. LicenseOID 
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LC_ProductStandards 

For Product Standards report. 

  

Field Key Type Null Description 

InstanceVersion   int N Default 1 

StandardsOID PK uniqueidentifier N Unique identifier for 
product standards 
record 

ProductOID   uniqueidentifier N Novell consolidated 
product ID to which 
standard is applied 

GroupName   Varchar(30) Y For future use 

StandardName   Varchar(30) Y Name of standard 
applied to product 

AccountID   uniqueidentifier Y Account ID (NULL for 
ZENworks Asset 
Management) 

Notes: 

 Primary Key ‘PK_LC_ProductStandards’ on StandardsOID column. 
 Unique constraint UQ_LC_ProductStandards on (ProductOID, GroupName) 
 Foreign Key ‘FK_LC_ ProductStandards’: ProductOID references LC_TallyProduct. ProductOID. 
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LC_PurchasedProduct 

Purchased Products are the items purchased/referenced in the Purchase Record Details. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

PurchasedProdOID PK uniqueidentifier N Unique internal 
identifier 

AccountID   uniqueidentifier Y Account ID (NULL for 
ZENworks Asset 
Management) 

ProductDesc   varchar (128) Y   

ResellerSKU   varchar( 32) Y   

MfgPartNum   varchar( 32) Y   

Manufacturer   varchar(64) Y Product Manufacturer 

Name   varchar(255) Y Product Name 

Version   varchar(32) Y Product Version 

Type   varchar(32) Y Product Type 

LicenseQty   int N Default 1 – licenses per 
package 

Upgrade   int (1) N Default 0 – is it an 
upgrade? 

Excluded   int (1) N Default 0 – has user 
excluded it? 

Matched   int (1) N Default 0 

Associated   int (1) N Default 0 

Notes   Varchar(255) Y   

Notes 

1. Primary Key ‘PK_LC_PurchasedProduct’ on PurchasedProdOID column. 
2. Index ‘IX_LC_PurchasedProduct_AccountID’ on AccountID column. 
3. Product Type = ‘Media Only’, ‘Documentation’, ‘Upgrade’, etc. 
4. Excluded = 1/0 - True/False 
5. Unique constraint 

‘UC_LC_PurchasedProduct_Manufacturer_Name_Version_Type_LicenseQty_AccountID’ on 
(Manufacturer, Name, Version, Type, LicenseQty, and AccountID) 
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LC_PurchasedProductUpgrades 

Purchased Product Upgrades that have been matched to Purchased Products  

Field Key Type Null Description 

InstanceVersion   int N Default 1 

MapOID PK uniqueidentifier N   

UpgradeFromLicenseOID FK uniqueidentifier N ID of upgraded License 

PurchasedProductOID FK uniqueidentifier N ID of purchased 
product 

AccountID   uniqueidentifier Y Account ID (NULL for 
ZENworks Asset 
Management) 

Notes 

 Primary Key ‘PK_LC_ PurchasedProductUpgrades’ on MapOID column. 
 Index ‘IX_LC_PurchasedProductUpgrades_AccountID’ on AccountID column. 
 Foreign Key ‘FK_LC_PurchasedProductUpgrades_LC_ License’: UpgradeFromLicenseOID references 

LC_License. LicenseOID 
 Foreign Key ‘FK_LC_PurchasedProductUpgrades_LC_PurchasedProduct’: PurchasedProductOID references 

LC_PurchasedProduct. PurchasedProdOID 
 Unique constraint ‘UC_LC_PurchasedProductUpgrades_PurchasedProductOID_AccountID’ on 

(PurchasedProductOID and AccountID) which says a given product can be assigned as an upgrade only once. 
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LC_PurchaseRec 

Purchase Order header information. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

PurchaseRecOID PK uniqueidentifier N   

AccountID   uniqueidentifier Y Account ID (NULL for ZENworks 
Asset Management) 

OrderDate   datetime N   

PONumber   varchar( 32) Y   

Reseller   varchar(64) Y   

Company   varchar(32) Y   

ShipAddress1   varchar(64) Y   

ShipAddress2   varchar(64) Y   

ShipAddress3   varchar(64) Y   

ShipCity   varchar(32) Y   

ShipState   varchar(32) Y   

ShipZip   varchar(16) Y   

ShipCountry   varchar(32) Y   

Recipient   varchar(32) Y   

Notes   varchar(256) Y   

Notes 

 Primary Key ‘PK_LC_PurchaseRec’ on PurchaseRecOID column. 
 Index ‘IX_LC_PurchaseRec_AccountID’ on AccountID column. 
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LC_PurchaseRecDetail 

Purchase record detail has the detail about each product ordered in the purchase order. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

DetailOID PK uniqueidentifier N Need an identifier to 
locate the record for 
deleting and editing. We 
could also do this with a 
sequence number. 

PurchaseRecOID FK uniqueidentifier N Purchase record for this 
product 

PurchasedProdOID FK uniqueidentifier N   

AccountID   uniqueidentifier Y Account ID (NULL for 
ZENworks Asset 
Management) 

Quantity   int N Default 1 

InvoiceNumber   varchar( 32) Y   

SerialNumber   varchar( 40) Y   

Comments   varchar(128) Y   

CostCenter   varchar(32) Y   

Department   varchar(32) Y   

Site   varchar(32) Y   

UnitMSRP   Decimal (18,2) N Default 0 

UnitPrice   Decimal (18,2) N Default 0 

TotalPrice   Decimal (18,2) N Default 0 

Notes 

 Primary Key ‘PK_LC_PurchaseRecDetail’ on DetailOID column. 
 Foreign Key ‘FK_LC_PurchaseRecDetail_LC_PurchasedProduct’: PurchasedProdOID references 

LC_PurchasedProduct. PurchasedProdOID 
 Foreign Key ‘FK_LC_PurchaseRecDetail_LC_PurchaseRec’: PurchaseRecOID references 

LC_PurchaseRec.PurchaseRecOID  
 Index ‘IX_LC_PurchaseRecDetail_AccountID’ on AccountID column. 
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LC_PurchaseRecordImportMap 

Purchase record import map has one record for each supported import file format (it 
currently contains 2 records: TSC and softchoice) 

  

Field Key Type Null Description 

MapName   varchar (64) N Name/description of 
the import format 

MapResellerName   varchar( 32) Y Fixed value to be used 
for reseller field for all 
imported records 

MapDelim   varchar( 8) Y Column delimiter (null 
defaults to tab) 

MapDateFormat   varchar( 16) Y Date format (null 
defaults to Java SHORT 
date format) 

MapIgnoredCols   varchar( 512) Y ‘|’-delimited list of 
column names to be 
ignored 

PONum   varchar( 32) Y Column heading value 
(all fields from here 
down) 

OrderDate   varchar( 32) Y   

InvoiceNum   varchar( 32) Y   

Reseller   varchar( 32) Y   

Recipient   varchar( 32) Y   

CompanyName   varchar( 32) Y   

ShippingAddress1   varchar( 32) Y   

ShippingAddress2   varchar( 32) Y   

ShippingAddress3   varchar( 32) Y   

City   varchar( 32) Y   

State   varchar( 32) Y   

Zip   varchar( 32) Y   

Country   varchar( 32) Y   

Notes   varchar( 32) Y   

Manufacturer   varchar( 32) Y   
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ProductName   varchar( 32) Y   

Version   varchar( 32) Y   

ProductType   varchar( 32) Y   

LicensesPerPackage   varchar( 32) Y   

ResellerSKU   varchar( 32) Y   

MfrPartNum   varchar( 32) Y   

Upgrade   varchar( 32) Y   

PurchaseQty   varchar( 32) Y   

SerialNum   varchar( 32) Y   

Site   varchar( 32) Y   

Department   varchar( 32) Y   

CostCenter   varchar( 32) Y   

Comments   varchar( 32) Y   

UnitMSRP   varchar( 32) Y   

UnitPrice   varchar( 32) Y   

ExtendedPrice   varchar( 32) Y   
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LC_SuiteComponent 

Reporting table. 

  

Field Key Type Null Description 

ComponentOID PK, FK uniqueidentifier N   

TallyProductOID FK uniqueidentifier N   

SuiteComponentOID FK uniqueidentifier N   

SuiteProductOID FK uniqueidentifier N   

Notes: 

 Primary Key ‘PK_LC_SuiteComponent’ on ComponentOID column. 
 Index ‘IDX_LC_SuiteComponent_Product’ on SuiteProductOID column. 
 Foreign Key ‘FK_LC_ SuiteComponent_CompOID’: ComponentOID references LC_Component.ComponentOID 
 Foreign Key ‘FK_LC_ SuiteComponent _ProdOID’: TallyProductOID references LC_ TallyProduct.ProductOID 
 Foreign Key ‘FK_LC_ SuiteComponent _SuiteCompOID’: SuiteComponentOID references LC_Component. 

ComponentOID 
 Foreign Key ‘FK_LC_ SuiteComponent _SuiteProdOID’: SuiteProductOID references LC_ TallyProduct. 

ProductOID 
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LC_TallyProduct 

This is the Consolidated Novell Product catalog, which is a consolidation of the 
ZENworks Asset Management NC_Product table (fingerprinted products). In this 
consolidation, we group together all the language versions and patch releases into a single 
licensed product. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

ProductOID PK uniqueidentifier N Internal identifier 

Name   varchar(64) N Product name 

Version   varchar(64) Y Product version 

Manufacturer   varchar(64) N Product Manufacturer 

Excluded   int(1) N Default 0 - Exclude the product 
from license counts 

Source   int(1) N Default 0 – 0 = Novell, 1 = 
Collector Promotion Test 

Platform   SmallInt Y   

Notes   Varchar(255 Y   

Notes 

 Primary Key ‘PK_LC_TallyProduct’ on ProductOID column. 
 Index ‘IX_LC_TallyProduct_Source’ on Source column. 
 Unique constraint ‘UC_LC_TallyProduct_Mfg_Name_Version’on (Manufacturer, Name, Version) which says this 

tuple must be unique. 
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LC_TallyProductMap 

This is the map table defining relationships between fingerprinted ZENworks Asset 
Management products and the Consolidated Novell Product Catalog. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

MapOID   uniqueidentifier N   

FPProdOID FK uniqueidentifier N FK to the ZENworks Asset 
Management Product table 

TallyProdOID FK uniqueidentifier N FK to the Consolidated Novell 
Product Catalog 

Source   int(1) N Default 0 – 0 = Novell , 1 = 
Collector Promotion Test 

Notes 

 Foreign Key ‘FK_LC_TallyProductMap_NC_Product’: FPProdOID references NC_Product.ProductOID 
 Foreign Key ‘FK_LC_TallyProductMap_LC_TallyProduct’: TallyProdOID references LC_TallyProduct.ProductOID 
 Unique clustered index ‘IX_LC_TallyProductMap_FPProd’ on FPProd column to insure fingerprint is assigned to 

only one consolidated Novell product. 
 Index ‘IX_LC_TallyProductMap_TallyProd’ on TallyProd column. 
 Index ‘IX_LC_TallyProductMap_Source’ on Source column. 

LC_TallyProductSuite 

This table lists the product suites. Components are mapped to suites via the 
LC_TallyProductSuiteMap table. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

ProductOID PK, FK uniqueidentifier N Software Suite Product OID from 
the Novell Product table, 

FK to the Consolidated Novell 
Product Catalog 

SuiteName   varchar(64) N Name of Software Suite, e.g., 
Office 2000 Professional 

Notes 

 Primary Key ‘PK_LC_TallyProductSuite_ProductOID’ on ProductOID column 
 Foreign Key ‘FK_LC_TallyProductSuite_LC_TallyProduct’: ProductOID references LC_TallyProduct.ProductOID 
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LC_TallyProductSuiteMap 

This table maps component products from the Consolidated Novell Product Catalog to 
Product Suites. (It lists the suite members.) 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

MapOID   uniqueidentifier N   

SuiteOID FK uniqueidentifier N Suite ID from the 
Consolidated Novell 
Product Catalog  

ComponentProductOID FK uniqueidentifier N Component ID from the 
Consolidated Novell 
Product Catalog 

Notes 

 Unique constraint ‘UC_LC_TallyProductSuiteMap_SuiteOID_CompProdOID’on (SuiteOID, 
ComponentProductOID) which says a given component can be a member of a given suite only once. 

 Foreign Key ‘FK_LC_TallyProductSuiteMap_LC_TallyProductSuite_SuiteOID’: SuiteOID references 
LC_TallyProductSuite.ProductOID 

 Foreign Key ‘FK_LC_TallyProductSuiteMap_LC_TallyProduct_CompProdOID’: ComponentProductOID 
references LC_TallyProduct. ProductOID 
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LC_UserExcludedTallyProduct 

Novell Products that customers have excluded from the license calculation via the user 
interface. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

TallyProductOID FK uniqueidentifier N FK to the Consolidated Novell 
Product Catalog 

AccountID   uniqueidentifier Y Account ID (NULL for ZENworks 
Asset Management) 

Excluded   int(1) N Default 0 - Exclude the product 
from license counts 

Notes 

 Unique Clustered Constraint ‘UC_LC_ UserExcludedTallyProduct_TallyProductOID_AccountID’ on 
(TallyProductOID, AccountID) which says a given account can exclude a Novell Product only once. 

 Foreign Key ‘FK_LC_ UserExcludedTallyProduct _LC_TallyProduct’: TallyProductOID references 
LC_TallyProduct.ProductOID 

 Index ‘IX_LC_UserExcludedTallyProduct_AccountID’ on the AccountID column. 
 Index ‘IX_LC_UserExcludedTallyProduct_Excluded’ on the Excluded column. 
 Excluded = 1/0 - True/False 

LC_WorkstationAllocation 

Workstation License Allocation information. 

Field Key Type Null Description 

InstanceVersion   int N Default 1 

AllocationOID PK uniqueidentifier N Unique identifier for 
workstation license allocation 

LicenseOID FK uniqueidentifier N Unique identifier for related 
license 

WorkstationOID FK uniqueidentifier N Unique identifier for related 
workstation 

Qty   int N Number of licenses allocated 
to this workstation (always 1) 

Notes: 

 Primary Key ‘PK_LC_WorkstationAllocation’ on AllocationOID column. 
 Foreign Key ‘FK_LC_WorkstationAllocation_LicOID’: LicenseOID references LC_License.LicenseOID. 
 Foreign Key ‘FK_LC_WorkstationAllocation_WkstnOID’: WorkstationOID references 

NC_Workstation.WorkstationOID. 
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ReportTimePeriodSettings 

Report time period settings for usage reports. 

  

Field Key Type Null Description 

AccountID   uniqueidentifier N   

Period   Varchar(32) N   

StartDate   datetime Y   

EndDate   datetime Y   
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Network Discovery Tables 
The network discovery tables contain data related to the ZENworks Asset Management 
Network Discovery Engine. 

  

NC_NetWareServer Table (Entity)  

NC_NetworkDeviceAddress (Entity)  

NC_NetworkDeviceBase Table (Entity)  

NC_NetworkDeviceExtended Table (Entity)  

NC_NetworkDiscOptions Table (Entity)  

NC_NetworkDiscovery Table (Entity)  

NC_NetworkDiscSegment Table (Entity)  

NC_NetworkHub Table (Entity)  

NC_NetworkPrinter Table (Entity)  

NC_NetworkRouter Table (Entity)  

NC_NetworkSwitch Table (Entity)  

NC_NetworkWin32Device Table (Entity)  
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NC_NetWareServer Table (Entity) 

The NC_NetWareServer table contains extended properties discovered about NetWare 
servers. 

Column Key Type Null Description 

NetworkDeviceOID FK GUID No An internal ID number used as a 
primary key. 

ServerName   Varchar(50)   The name of the server. 

OSSerialNumber   Varchar(15)   The serial number of the network 
operating system. 

InternalIPXNumber   Varchar(12)   The internal IPX number (the 
logical network number that 
identifies an individual NetWare 
server). 

OSSFTLevel   Varchar(10)   The System Fault Tolerance Level 
of the NetWare operating system 
running on this server: 1 = Other, 
2 = Level I, 3 = Level II, or 4 = 
Level III. 

OSVersion   Varchar(5)   The operating system version. 

OSReleaseDate   DateTime   The operating system release 
date. 

Note 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceExtended table. 
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NC_NetworkDeviceAddress (Entity) 

The NC_NeworkDeviceAddress table contains data about network device addresses.. 

Column Key Type Null Description 

NetworkDeviceAddressOID PK GUID No An internal ID number used as a 
primary key. 

NetworkDeviceOID FK GUID No The network device to which the 
address belongs. 

IPAddress   Varchar(15) No The IP address of the device. 

SubnetMask   Varchar(15) No The subnet mask. 

LANAddress   Varchar(12)   The LAN address of the device. 

Interface   Short <INT2> No A number that represents the 
interface. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Subnet   Varchar(15) Yes Calculated 

Note 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceBase table. 

 Unique constraint ‘UQ_Wkstn_Conninfo’ on ConnectionInfoOID (Oracle only) 
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NC_NetworkDeviceBase Table (Entity) 

The NC_NetworkDeviceBase table contains the basic properties common to all devices 
discovered by the ZENworks Asset Management Network Discovery Engine. 

Column Key Type Null Description 

NetworkDeviceOID PK GUID No An internal ID number used as a 
primary key. 

PrimaryIPAddress   Varchar(15) No The primary IP address. 

PrimaryLANAddress   Varchar(12)   The primary LAN address. 

DNSName   Varchar(50)   The DNS name. 

CreateDate   DateTime No The creation date. 

LastSuccessfulScanDate   DateTime   The last successful scan date. 

NetworkDeviceType   Short <INT2> No The device type; see "Note" 
below. 

NetworkDeviceTypeAlias   Varchar(50) No The NetworkDeviceType as edited 
by the ZENworks Asset 
Management user . 

Source   Short <INT2> No The source : 

0 = ZENworks Asset Management 
Network Discovery Engine or  

1 = ZENworks Asset Management 
Web Console (user-entered). 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

 The NetworkDeviceType can have one of the following values: 

0 Other Ungrouped 14 Midrange Server 
1 Other SNMP 15 Print Serverk 
2 Hub 16 Remote Access Device 
3 Printer 17 Terminal Server 
4 Router 17 Main Server Chassis 
5 Switch 18 Thin Client 
6 UNIX 19 UPS 
7 Windows 20 Wireles 
8 NetWare Server 21 Bridge 
9 CD-ROM Server 22 Copier Scanner 
10 IP Telephony 23 Fax 
11 Linux 24 MultiPlexer 
12 Macintosh 25 Storage Device 
13 Mainframe Server 26 Firewall 
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NC_NetworkDeviceExtended Table (Entity) 

The NC_NetworkDeviceExtended table includes additional information about network 
devices. 

Column Key Type Null Description 
NetworkDeviceOID PK,FK GUID No An internal ID number used 

as a primary key. 

ClientId    GUID    The client ID. 

ClientVersion    VARCHAR(32)    Version of the ZENworks 
Asset Management collection 
client on the machine. 

ClientInstallType    SHORT<INT2> N 0=Unknown,  
1=Service,  
2=Executable 

SystemName    Varchar(255)    The system name. 

SystemDescription    Varchar(255)    The description of the 
system. 

SystemObjectId    Varchar(255)    The unique identifier 
(provided by the vendor) of 
the system. 

SystemUpTime    Numeric(10,0)    The time in hundreds of a 
second since the network 
management portion of the 
system was last initialized. 

SystemContact    Varchar(50)    The name of the system 
contact. 

SystemLocation    Varchar(50)    The location of the system. 

SystemServices    Long <INT4> No A value that indicates the set 
of services that this device 
primarily offers. 

Manufacturer    Varchar(35)    The name of the 
manufacturer. 

ManufacturerAlias    Varchar(35)    The name of the 
manufacturer as edited by 
the ZENworks Asset 
Management user. 

ProductName    Varchar(100) No The name of the product. 

ProductNameAlias    Varchar(100) No The name of the product as 
edited by the ZENworks Asset 
Management user. 

SerialNumber    Varchar(38)    The serial number of the 
device. 

AssetTag    Varchar(38)    The asset tag of the device. 

SerialNumberAlias    Varchar(38)    The serial number as edited 
by the ZENworks Asset 
Management user. 

AssetTagAlias    Varchar(38)    The asset tag as edited by 
the ZENworks Asset 
Management user. 

LastSuccessfulLoadDate    DateTime    The date information about 
this device was successfully 
loaded into the database. 

DateLastModified    DateTime No The date and time the 
device was last modified by a 
ZENworks Asset Management 
user in the ZENworks Asset 
Management Web Console. 
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Column Key Type Null Description 
IsLeased    Short <INT2> No 1 (TRUE) if the device is 

leased; else 0. 

LeaseExpireDate    DateTime    The date the lease expires. 

LeaseContractId    Varchar(20)    The contract ID of the lease. 

AccountId    GUID No For future use. 

Note 

1. ClientInstallType: 0=Unknown, 1=Service, 2=Executable  

FK references: 

2. FK_NWDevX_NWDevOID: NetworkDeviceOID references 
NC_NetworkDeviceBase.NetworkDeviceOID  

Indexes: 

3. IDX_NWDevX_SysObjId: SystemObjectId 
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NC_NetworkDiscOptions Table (Entity) 

The NC_NetworkDiscOptions table contains global network discovery options that affect 
all network discovery tasks. For more information, see Setting Network Discovery 
Options. 

Column Key Type Null Description 

NetworkDiscOptionsOID PK GUID No An internal ID number used as a 
primary key. 

PasswordList   Varchar(200)   The community names that grant 
access to your network devices. 

IPInitTime   Long <INT4> No The number of milliseconds to 
wait for a response to an ICMP 
query. 

IPIncrTime   Long <INT4> No The incremental number of 
milliseconds to wait for a 
response for each retry of an 
ICMP query before sending 
another. 

IPMaxRetry   Short <INT2> No The number of retries in sending 
an ICMP query. 

SNMPInitTime   Long <INT4> No The number of milliseconds to 
wait for a response to an SNMP 
query. 

SNMPIncrTime   Long <INT4> No The incremental number of 
milliseconds to wait for a 
response for each retry of an 
SNMP query before sending 
another. 

SNMPMaxRetry   Short <INT2> No The number of retries in sending 
an SNMP query. 

TaskDelay   Long <INT4> No The number of milliseconds that 
ZENworks Asset Management 
should wait before sending a 
request to a device or IP address. 

NameLookup   Short <INT2) No 1 (TRUE) if you want a reverse 
lookup performed for the 
DNS/WINS name of each IP 
address; else 0. 

IPThreadCount   Short <INT2> No The ICMP thread count. 

SNMPThreadCount   Short <INT2> No The SNMP thread count. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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NC_NetworkDiscovery Table (Entity) 

The NC_NetworkDiscovery table contains data about network discovery tasks submitted 
for a later date. 

Column Key Type Null Description 

NetworkDiscoveryOID PK GUID No An internal ID number used as a 
primary key. 

NetworkDiscoveryName   Varchar(48) No The name of the network 
discovery task. 

DOMFolderOID FK GUID   The folder in which the task is 
stored. 

CollDomainOID FK GUID No Not in current use. 

TaskScheduleOID FK GUID No The task schedule. 

TaskServerOID FK GUID   The Task Server handling the task. 

SubnetType   Short <INT2> No The way you want subnets 
scanned: 0=local subnet only, 
1=range of IP addresses, or 2= 
selected subnets. 

LoadMask   Binary(10) No The devices to be loaded as a 
result of network discovery. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The DOMFolderOID foreign key references the DomFolderOID primary column of the NC_DomainFolder table. 
 The CollDomainOID foreign key references the CollDomainOID primary column of the NC_CollDomain table. 
 The TaskScheduleOID foreign key references the TaskScheduleOID primary column of the NC_TaskSchedule 

table. 
 The TaskServerOID foreign key references the TaskServerOID primary column of the NC_TaskServer table. 
 CollDomainOID + NetworkDiscoveryName has a unique constraint named UQ_NWDisc_NameDomainOID. 
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NC_NetworkDiscSegment Table (Entity) 

The NC_NetworkDiscSegment table contains the properties of the segments that you 
intend to scan. 

Column Key Type Null Description 

NetworkDiscSegmentOID PK GUID No An internal ID number used as a 
primary key. 

TaskOID FK GUID   The ID of the task. 

IPAddress   Binary(4) No The starting IP address to be 
scanned. 

IPEnding   Binary(4) No The ending IP address to be 
scanned. 

NetMask   Binary(4) No The subnet mask associated witih 
the segment. 

IgnoreSegment   Short <INT2> No 1 (TRUE) if the segment is to be 
scanned; else 0. 

ExcludeList   Varchar(200)   The addresses to be excluded 
from a scan. 

LoadMask   Binary(10) No The devices you want to load as 
a result of network discovery. 

NetworkDiscoveryOID FK GUID   The ID of the network discovery 
task. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The TaskOID foreign key references the TaskOID primary column of the NC_Task table. 
 The NetworkDiscoveryOID foreign key references the NetworkDiscoveryOID primary column of the 

NC_NetworkDiscovery table. 

NC_NetworkHub Table (Entity) 

The NC_NetworkHub table contains data about hubs. 

Column Key Type Null Description 

NetworkDeviceOID PK,FK GUID No The ID of the network device. 

FirmwareRevision   Varchar(25)   The firmware revision. 

Ports   Long <INT4>   The port numbers. 

Note 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceExtended table. 
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NC_NetworkPrinter Table (Entity) 

The NC_NetworkPrinter table contains data about network printers.. 

Column Key Type Null Description 

NetworkDeviceOID PK,FK GUID No The ID of the network device. 

FirmwareRevision   Varchar(25)   The firmware revision. 

TotalPagesPrinted   Long <INT4>   The number of pages printed on 
the printer. 

Note 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceExtended table. 

NC_NetworkRouter Table (Entity) 

The NC_NetworkRouter table contains data about network routers.. 

Column Key Type Null Description 

NetworkDeviceOID PK,FK GUID No The ID of the network device. 

FirmwareRevision   Varchar(25)   The firmware revision. 

Ports   Long <INT4>   The port numbers. 

Note 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceExtended table. 

NC_NetworkSwitch Table (Entity) 

The NC_NetworkSwitch table contains data about network switches.. 

Column Key Type Null Description 

NetworkDeviceOID PK,FK GUID No The ID of the network device. 

FirmwareRevision   Varchar(25)   The firmware revision. 

Ports   Long <INT4>   The port numbers. 

Note 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceExtended table. 
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NC_NetworkWin32Device Table (Entity) 

This table stores domain and user names for workstations discovered by a Network 
Discovery Task. 

  

Column Key Type Null Description 

NetworkDeviceOID PK, FK GUID N internal ID number used as 
primary key 

LoggedOnUser   VARCHAR(64)   Login ID of the user currently 
using the device. 

WkstnDomain   VARCHAR(64)   Windows domain to which 
the device belongs. 

Notes: 

 The NetworkDeviceOID foreign key references the NetworkDeviceOID primary column of the 
NC_NetworkDeviceExtended table. 
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Inventory Process Tables 
The inventory process tables contain information that is used to control the collection of 
inventory data. 

NC_ChoiceListItem Table (Entity)  

NC_CollClientOptions Table (Entity)  

NC_CollDomain Table (Entity)  

NC_CollDomainCOptSet Table (Entity)  

NC_CollectorOptions Table (Entity)  

NC_CollEditorOptions Table (Entity)  

NC_CollOptionSet Table (Entity)  

NC_CollSchedule Table (Entity)  

NC_CollServer Table (Entity)  

NC_CollServerCOptSet Table (Entity)  

NC_ConnectionInfo Table (Entity)  

NC_CosPaths Table (Entity)  

NC_DomainFolder Table (Entity)  

NC_FieldDispDesc Table (Entity)  

NC_LDAPImport Table (Entity)  

NC_LDAPImportSettings Table (Entity)  

NC_LDAPImportTask Table (Entity)  

NC_ObjChoiceListItem Table (Entity)  

NC_StrChoiceListItem Table (Entity)  

NC_TaskServer Table (Entity)  

NC_WkstnReconcileData Table (Entity)  
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NC_ChoiceListItem Table (Entity) 

The NC_ChoiceListItem table tracks choice list items. For more details, see Setting Up a 
List of Choices. 

Column Key Type Null Description 

ChoiceListItemOID PK GUID No An internal ID number used as a 
primary key. 

COSOID FK GUID No The collection option set to which 
the choice list belongs. 

FieldID   Numeric(5,0) No The field to which the choice list 
belongs. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The COSOID foreign key references the COSOID primary key column of the 
NC_CollOptionSet table. 
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NC_CollClientOptions Table (Entity) 

The NC_CollClientOptions table specifies options that control what the Collection Client 
runs. For more details, see Changing General Options. 

Column Key Type Null Description 

CollClientOptsOID PK GUID No An internal ID number used as a 
primary key. 

IsResidentMode   Short <INT2> No 1 (TRUE) if the Collection Client 
should run in resident mode; else 
0. 

RunCollector   Short <INT2> No 1 (TRUE) if the Collector should 
run; else 0. 

RunEditor   Short <INT2> No 0 if the Collection Editor should 
never run, 1 if it should run only 
during the first scan of a 
workstation, and 2 if it should 
always run. 

RunTranslator   Short <INT2> No 0=no translation to SMS MIF files, 
1=translation to SMS 1.2 MIF files, 
and 2=translation to SMS 2.0 MIF 
files. 

RunUsageTranslator   Short <INT2> No 1 (TRUE) if software usage data 
should be translated and loaded 
into the database; else 0. 

RunXMLTranslator   Short <INT2> No 1 (TRUE) if inventory data should 
be saved in .xml files; else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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NC_CollDomain Table (Entity) 

The NC_CollDomain table includes data about a Collection Domain. 

Column Key Type Null Description 

CollDomainOID PK GUID No An internal ID number used as a 
primary key. 

CollDomainName   Varchar(48) No The name of the Collection 
Domain. 

NewWkstnCOSOID FK GUID No The collection option set in effect 
when new workstations are being 
scanned. 

DiagnosticCOSOID   GUID No The collection option set in effect 
when scanning workstations on 
demand. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The NewWkstnCOSOID foreign key references the COSOID primary key column of the NC_CollOptionSet table. 
 The DiagnosticCOSOID foreign key references the COSOID primary key column of the NC_CollOptionSet table. 
 CollDomainName has a unique constraint named UQ_CollDom_CollDomName. 

NC_CollDomainCOptSet Table (Entity) 

The NC_CollDomainCOptSet table includes data about the collection option sets 
assigned to a Collection Domain. 

Column Key Type Null Description 

CollDomainCOSOID PK GUID No An internal ID number used as a 
primary key. 

CollDomainOID FK GUID No The name of the Collection 
Domain. 

COSOID FK GUID No The collection option set that is 
assigned to the domain.  

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The CollDomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain 
table. 

 The COSOID foreign key references the COSOID primary key column of the NC_CollOptionSet table. 
 CollDomainOID and COSOID have a unique constraint named UQ_CollDomainCOS. 
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NC_CollectorOptions Table (Entity) 

The NC_CollectorOptions table specifies what the Collector should gather. For details, 
see Changing Collector Options. 

Column Key Type Null Description 
CollectorOptionsOID PK GUID N Internal ID number used as a 

primary key 
SpecialOptions   VARCHAR(128)   List of options to pass to collector 
IsHardwareScan   SHORT<INT2> N TRUE(1)=Do a hardware scan 
IsSoftwareScan   SHORT<INT2> N TRUE(1)=Do a software scan 
FNIExtensions   VARCHAR(255)   param is list of file extensions 
IsCollectAuxData   SHORT<INT2> N TRUE(1)=Collect Auxilliary data 
IsProbeMode   SHORT<INT2> N TRUE(1)=Probe Mode is on 
IsGatherWINConfig   SHORT<INT2> N TRUE(1)=Gather Windows 

Configuration Files 
IsGatherFNIStdExts   SHORT<INT2> N TRUE(1)=Gather FNIs with Standard 

file extensions 
IsGatherFNIAddlExts   SHORT<INT2> N TRUE(1)=Gather additional FNIs 

with user-specified file extensions 
(from FNIExtensions) 

IsCollectFileInfo   SHORT<INT2> N TRUE(1) = obey settings of 
IsCollectSystemFiles, 
IsCollectAncillaryFiles, and 
IsCollectOtherFiles, otherwise 
ignore those settings. 

IsCollectSystemFiles   SHORT<INT2> N TRUE(1) = collect those FNI files 
that are categorized as "System" 
files (with IsCollectFileInfo) 

IsCollectAncillaryFiles   SHORT<INT2> N TRUE(1) = collect those FNI files 
that are categorized as "Ancillary" 
files (with IsCollectFileInfo) 

IsCollectOtherFiles   SHORT<INT2> N TRUE(1) = collect those FNI files 
that are categorized as "Other" 
files (with IsCollectFileInfo) 

CollectorPriority   SHORT<INT2> N 0 = Normal, 1= Below Normal, 2 = 
Lowest, 3 = Idle 

InstanceVer   LONG <INT4> N Instance Version 
CollectorOptionsOID PK GUID N Internal ID number used as a 

primary key 
SpecialOptions   VARCHAR(128)   List of options to pass to collector 
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NC_CollEditorOptions Table (Entity) 

The NC_CollEditorOptions table controls the Collection Editor options. For details, see 
Changing Collection Editor Options. 

Column Key Type Null Description 

CollEditorOptsOID PK GUID No An internal ID number used as a 
primary key. 

IsWorkstationShown   Short <INT2> No 1 (TRUE) if the Workstation tab is 
to be displayed; else 0. 

IsInventoryShown   Short <INT2> No 1 (TRUE) if the Inventory tab is to 
be displayed; else 0. 

IsProcessShown   Short <INT2> No 1 (TRUE) if the Process tab is to 
be displayed; else 0. 

IsUserShown   Short <INT2> No 1 (TRUE) if the User tab is to be 
displayed; else 0. 

ShowComponents   Varchar(32)   The list of components to be 
displayed on Inventory tab. 

IsAllowAddComponents   Short <INT2> No 1 (TRUE) if the workstation user 
can add components; else 0. 

IsAllowCreateLocalProds   Short <INT2> No 1 (TRUE) if the workstation user 
can define local products; else 0. 

TimeoutMinutes   Short <INT2> No The number of minutes that the 
Collection Editor may remain idle 
before the TimeoutAction occurs. 
Default=30.  

TimeoutAction   Short <INT2> No The action to take if the 
TimeoutMinutes limit is reached: 
0 = Never time-out, 1 = Exit and 
Load, 2 = Quit (no load). 
Default=0. 

CEPassword   Varchar(64)   The password for removing 
restrictions. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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NC_CollOptionSet Table (Entity) 

The NC_CollOptionSet table contains data about collection option sets. See About 
Collection Option Sets. 

Column Key Type Null Description 

COSOID PK GUID No An internal ID number used as a 
primary key. 

COSName   Varchar(48) No The name of the collection option 
set. 

CollectorOptionsOID FK GUID No The Collector options. 

CollEditorOptsOID FK GUID No The Collection Editor options. 

CollClientOptsOID FK GUID No The Collection Client options. 

CollDomainOID FK GUID No The Collection Domain to which 
the collection option set is 
assigned. 

DomFolderOID FK GUID   The domain folder in which the 
collection option set resides. 

CollScheduleOID   GUID No The collection schedule associated 
with the collection option set. 

WkstnCriteria   Text   The criteria for determining which 
workstations are affected by the 
collection option set. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The CollectorOptionsOID foreign key references the CollectorOptionsOID primary key column of the 
NC_CollectorOptions table. 

 The CollEditorOptsOID foreign key references the CollEditorOptsOID primary key column of the 
NC_CollEditorOptions table. 

 The CollClientOptsOID foreign key references the CollClientOptsOID primary key column of the 
NC_CollClientOptions table. 

 The CollDomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain 
table. 

 The DomFolderOID foreign key references the DomFolderOID primary key column of the NC_DomainFolder 
table. 

 The CollScheduleOID foreign key references the CollScheduleOID primary key column of the NC_CollSchedule 
table. 

 COSName + CollDomainOID has a unique constraint named UQ_COS_NameDomainOID. 
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NC_CollSchedule Table (Entity) 

The NC_CollSchedule table includes information about collection schedules. For more 
details, see About Collection Schedules. 

Column Key Type Null Description 

CollScheduleOID PK GUID No An internal ID number used as a 
primary key. 

ScheduleName   Varchar(48) No The name of the collection 
schedule. 

ScheduleOID FK GUID No The schedule details. 

CollDomainOID FK GUID No The Collection Domain to which 
this schedule is assigned. 

DomFolderOID FK GUID   The domain folder in which this 
schedule resides. 

Duration   Short <INT2>   The length of time the schedule 
will be active. 

DurationUnitType   Short <INT2> No The unit in which the duration is 
measured: 0=days, 1=weeks, 
2=months. 

UseTimeWindow   Short <INT2> No 1 (TRUE) if StartTimeWindow and 
EndTimeWindow should be used; 
else 0. 

StartTimeWindow   DateTime   The start time for the schedule in 
the active window. 

EndTimeWindow   DateTime   The end time for the schedule in 
the active window. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The ScheduleOID foreign key references the ScheduleOID primary key column of the NC_Schedule table. 
 The CollDomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain 

table. 
 The DomFolderOID foreign key references the DomFolderOID primary key column of the NC_DomainFolder 

table. 
 ScheduleName + CollDomainOID has a unique constraint named UQ_CollSched_NameDomain. 



References 

357 

NC_CollServer Table (Entity) 

The NC_CollServer table includes data about a collection server. For information about 
collection servers, see About Collection Servers. 

Column Key Type Null Description 
CollServerOID PK GUID No An internal ID number used 

as a primary key. 
CollServerName  Varchar(48) No The name of the collection 

server. 
CollDomainOID FK GUID No The Collection Domain to 

which this server belongs. 
ReconcileWksByNIC  Short <INT2> No 1 (TRUE) if the NIC address 

should be used to reconcile 
new workstations; else 0. 

EnableUsageMonitor  Short <INT2> No 1 (TRUE) if the ZENworks 
Asset Management Usage 
Module should run on the 
workstations associated with 
the Collection Server; else 0. 

MaxUsageLogDays  Short <INT2>  The number of days software 
usage log files should be 
kept on workstations 
associated with the 
Collection Server. 

CacheCollectionFiles  Short <INT2> No 1 (TRUE) if the client .wif 
files are kept in the 
Collection Server’s cache 
directory; else 0. 

CacheCatalogFiles  Short <INT2> No 1 (TRUE) if the client 
catalog.ini files are kept in 
the Collection Server’s cache 
directory; else 0. 

EnableClientSearch  Short <INT2> No 1 (TRUE) if the Collection 
Server searches for clients 
after a restart instead of 
waiting for clients to re-
connect; else 0. 

ClientCheckinInterval  Long <INT4> No The interval (in seconds) at 
which clients check into the 
server. 

LoaderPriority  Short <INT2> No The priority at which the 
loader runs: 0=Normal, 
1=Below Normal, 2=Lowest, 
3=Idle. 

UnloaderPriority  Short <INT2> No The priority at which the 
unloader runs: 0=Normal, 
1=Below Normal, 2=Lowest, 
3=Idle. 

ReconcileWksbyConfigID  Short <INT2> No 1 (TRUE) if the NetCensus 
configuration ID is to be used 
to reconcile new 
workstations; else 0. 

ReconcileWksBySerialNumber  Short <INT2> No 1 (TRUE) if the serial number 
is to be used to reconcile 
new workstations; else 0. 

ReconcileWksByMachineName  Short <INT2> No 1 (TRUE) if the machine 
name is to be used to 
reconcile new workstations; 
else 0. 

DiffWksBySerialNumber  Short <INT2> No 1 (TRUE) if the serial number 
is to be used to differentiate 
workstations when they have 
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the same ZENworks Asset 
Management identifier; else 
0. 

InheritNewWkstnCOS  Short <INT2> No 1 (TRUE) if the Collection 
Server should inherit the 
new workstation collection 
option set from its parent 
collection domain; else 0. 

InheritDiagnosticCOS  Short <INT2> No 1 (TRUE) if the Collection 
Server should inherit the 
scan on demand collection 
option set from its parent 
collection domain; else 0. 

InheritStandardCOSList  Short <INT2> No 1 (TRUE) if the Collection 
Server should inherit all the 
assigned collection option 
sets from its parent 
collection domain; else 0. 

LoaderConnections  Short <INT2> No The number of database 
connections and threeads 
that are dedicated to loading 
workstation inventory (.wif) 
files. 

UnloaderConnections  Short <INT2> No The number of database 
connections and threeads 
that are dedicated to 
unloading workstation 
inventory (.wif) files. 

ClientConnectionThreads  Short <INT2> No The number of database 
connections and threads that 
are dedicated to handling 
Collection Client 
connections, check-in, and 
disconnects.  

UpdaterThreads  Short <INT2> No The number of threads 
dedicated to handling 
Collection Client updates. 

InstanceVer  Long <INT4> No The instance version (used 
internally to control changes 
in a multi-user 
environment). 

Notes 

 The CollDomainOID foreign key references the CollDomainOID primary key column of 
the NC_CollDomain table.  

 The CollScheduleOID foreign key references the CollScheduleOID primary key column of 
the NC_CollSchedule table. 

 The COSOID foreign key references the COSOID primary key column of the 
NC_CollOptionSet table. 

 CollServerName + CollDomainOID has a unique constraint named 
UQ_CollSvr_NameCollDom. 
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NC_CollServerCOptSet Table (Entity) 

The NC_CollServerCOptSet table includes data about the collection option sets assigned 
to a Collection Server. 

Column Key Type Null Description 

CollServerCOSOID PK GUID No An internal ID number used as a 
primary key. 

CollServerOID FK GUID No The name of the Collection 
Server. 

COSOID FK GUID No The collection option set ??  

COSRole   Short <INT2> No The type of collection option set: 
0=New Workstation, 1=Scan Now, 
2=Standard. 

LastScanCount   Long <INT4>   The number of workstations 
scanned during the last inventory 
cycle. 

CurrentScanCount   Long <INT4>   The number of workstations 
scanned during the current 
inventory cycle. 

CycleActive   Short <INT2> No 1 (TRUE) if workstations are 
currently being scanned; else 0. 

ActiveCollectionCount   Long <INT4> No The number of scans taking place 
while the inventory process was 
being stopped. 

LastErrorCount   Long <INT4>   The error count for the last 
inventory cycle. 

CurrentErrorCount   Long <INT4>   The error count for the current 
inventory cycle. 

LastScheduledCycle   DateTime   The date and time of the last 
scheduled inventory cycle. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The CollServerOID foreign key references the CollServerOID primary key column of the NC_CollServer table. 
 The COSOID foreign key references the COSOID primary key column of the NC_CollOptionSet table. 
 CollServerOID, COSOID, and COSRole have a unique constraint named UQ_CollServerCOS. 
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NC_ConnectionInfo Table (Entity) 

The NC_ConnectionInfo table contains information about Collection Client connections.  

Column Key Type Null Description 
ConnectionInfoOID PK GUID No An internal ID number used as a primary key. 
MachineName    Varchar(32)    The name of the machine on which the Collection Client is 

running. 
ConnectionTime    DateTime No The time the Collection Client last connected with the Collection 

Server. 
DisconnectionTime    DateTime    The time the Collection Client disconnected or was no longer 

reachable. 
IsConnected    Short <INT2> No 1 (TRUE) if the Collection Client is connected; else 0. 
ConnectionMode    Short <INT2> No The way the Collection Client connected: 0=unknown, 1=scan 

mode, 2=stockroom mode. 
PlatformType    Short <INT2> No The platform. See "Notes" below. 
UpdateBeginTime    DateTime    The starting time the Collection Client was last updated. 
UpdateEndTime    DateTime    The ending time the Collection Client was last updated. 
UnloadBeginTime    DateTime    The starting time workstation data was unloaded. 
UnloadEndTime    DateTime    The ending time workstation data was unloaded. 
CollectionBeginTime    DateTime    The starting time of the scan. 
CollectionEndTime    DateTime    The ending time of the scan. 
TranslationBeginTime    DateTime    The starting time of the translation of UNIX data to a workstation 

inventory file (.wif). 
TranslationEndTime    DateTime    The ending time of the translation of UNIX data to a workstation 

inventory file (.wif). 
LoadBeginTime    DateTime    The starting time of loading workstation data. 
LoadEndTime    DateTime    The ending time of loading workstation data. 
ErrorsDetected    Long <INT4> No For future use. 
LastErrorDate    DateTime    For future use. 
DateLastModified    DateTime    The date and time the workstation was last modified. 
ClientInstallType    Short <INT2> No The Collection Client installation type: 0=Unknown, 1=Service, 

2=Executable. 
ClientPort    Numeric 

(5,0) 
No The number of the client port. 

ClientVersion    Varchar(32)    The version number of the Collection Client. 
InstanceVer    Long <INT4> No The instance version (used internally to control changes in a 

multi-user environment). 
Notes 

1. The CollServerOID foreign key references the CollServerOID primary key column of the 
NC.CollServer table. 

2. The WorkstationOID foreign key references the WorkstationOID primary key column of the 
NC_Workstation table. 

3. PlatformType can be one of the following values: 

0 Unknown 
1 Windows 32 
2 Windows 64 
3 Sun 
4 IBM 
5 HP 
6 Linux 
7 BSD 
8 Other 
9 Common 
10 Common Windows Only 
11 Common Unix Only 
12 PalmOS 
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NC_CosPaths Table (Entity) 

The NC_CosPaths table contains information about any additional files the Collector 
should collect. See Changing Collector Options. 

  

Column Key Type Null Description 

COSPathOID PK GUID N Internal ID number used as a 
primary key 

COSOID FK GUID N Collection Option Set this file 
belongs to 

Path   VARCHAR(255) N Pathname to file 

CollectorAction   SHORT<INT2> N 0 = gather file, 1 = skip 
directory 

InstanceVer   LONG <INT4> N Instance Version 

Note: 

 The COSOID foreign key references the COSOID primary key column of the NC_CollOptionSet table. 
 Path + COSOID has a unique constraint named UQ_COSPaths_COSOID. 

NC_DomainFolder Table (Entity) 

The NC_DomainFolder table contains data about Collection Domain folders. 

Column Key Type Null Description 

DomFolderOID PK GUID No An internal ID number used as a 
primary key. 

DomFolderName   Varchar(48) No The name of the folder. 

MemberType   Short <INT2> No The type of data contained in this 
folder: 0=collection schedules, 
1=collection option sets. 

DomainOID FK GUID No The Collection Domain to which 
this folder belongs. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The DomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain table. 
 DomFolderName + MemberType + DomainOID has a unique constraint named UQ_DomFld_NameTypeDomain. 
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NC_FieldDispDesc Table (Entity) 

The NC_FieldDispDesc table controls display and edit characteristics of the fields 
displayed in the Collection Editor. For more details, see Customizing the User, 
Workstation, and Inventory Tabs.  

Column Key Type Null Description 
FieldDispDescOID PK GUID No An internal ID number used as a 

primary key. 
COSOID FK GUID No The collection option set to which 

this field belongs. 
FieldID   Numeric(5,0) No The ID of the field. 
Label   Varchar(32) No The label of the field. 
DefaultValue   Varchar(255)   The default value for the field. 
IsDisplay   Short <INT2> No 1 (TRUE) if the field should be 

displayed; else 0. 
IsEditable   Short <INT2> No 1 (TRUE) if the field can be 

edited; else 0. 
ControlType   Short <INT2> No The way data can be entered in 

the field. See "Notes" below. 
EditMask   Varchar(64)   The edit mask for the field. 
IsStoreMask   Short <INT2> No 1 (TRUE) if the mask template 

should be stored with the data; 
else 0. 

IsRequired   Short <INT2> No 1 (TRUE) if the field is required; 
else 0. 

IsUnique   Short <INT2> No 1 (TRUE) if the value in the field 
must be unique; else 0. 

MaxLength   Short <INT2>   The maximum field length in 
characters. 

Position   Short <INT2>   The Collection Editor column 
number for ordering fields. 

OverrideFields   Varchar(16)   Used internally to indicate which 
default values are being 
overridden. 

AutoFill   Short <INT2> No The situation when this field is 
filled automatically by the 
Collector: 0=when empty, 
1=always, 2=never. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 ControlType can be one of the following values: 
0 Edit 
1 Edit mask 
2 List 
3 Combo box 
4 Check box 
5 Browser 
6 Spinner 
7 Date 
8 Time 
9 Date time 

 The COSOID foreign key references the COSOID primary key column of the NC_CollOptionSet table. 
 COSOID + FieldID has a unique constraint named UQ_FldDisp_FOSFieldID. 
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NC_LDAPImport Table (Entity) 

This table stores settings from the Task tab of the Active Directory Import Task dialog. 
For more information, see Active Directory Import Dialog. 

  

Column Key Type Null Description 

LDAPImportOID PK GUID N internal ID number used as primary key 

LDAPImportName   VARCHAR(50) N The name of this set of LDAP Import 
options. 

CollDomainOID FK GUID N Collection domain in which this set of LDAP 
import options exists. 

DomFolderOID FK GUID   Identifies the folder in which the LDAP 
import option set is contained. 

LDAPPassword   VARCHAR(50)   LDAP server password 

LDAPLogon   VARCHAR(50)   LDAP server login 

LDAPAuthenticationMethod   SHORT<INT2> N Method used to authenticate to the LDAP 
server  

1 = ADS_SECURE_AUTHENTICATION 

LDAPServerName   VARCHAR(50) N Name of the LDAP server 

LDAPPort   NUMERIC(5,0) N Port number for LDAP server 
communication. 

InstanceVer   LONG <INT4> N Instance Version 

  

Notes: 

 The CollDomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain 
table. 

 The DomFolderOID foreign key references the DomFolderOID primary key column of the NC_DomainFolder 
table. 

 CollDomainOID + LDAPImportName has a unique constraint named UQ_LDAPImp_CollDomName. 
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NC_LDAPImportSettings Table (Entity) 

This table stores settings from the Mapping tabof the Active Directory Import Task 
dialog. For more information, see Active Directory Import Dialog. 

Column Key Type Null Description 

LDAPImportSettingsOID PK GUID N internal ID number used as 
primary key 

LDAPImportOID FK GUID N Links this map setting to an 
LDAP Import option set. 

LDAPObject   VARCHAR (100) N LDAP name of the Active 
Directory object. 

LDAPProperty   VARCHAR (100) N LDAP name of the data field of 
the Active Directory object. 

TSCClassId   NUMERIC (5,0) N ID of the target ZENworks Asset 
Management class. 

TSCFieldId   NUMERIC (5,0) N ID of the target ZENworks Asset 
Management field. 

Match   SHORT<INT2> N TRUE(1) = Setting defines a 
criteria for matching an LDAP 
object to a ZENworks Asset 
Management object.  

FALSE(0) = setting maps an 
LDAP property to a ZENworks 
Asset Management field. 

InstanceVer   LONG <INT4> N Instance Version 

Notes: 

 The LDAPImportOID foreign key references the LDAPImportOID primary key column of the NC_LDAPImport 
table. 
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NC_LDAPImportTask Table (Entity) 

This table stores information about an Active Directory Import task. 

  

Column Key Type Null Description 

TaskOID PK, FK GUID N internal ID number used as primary 
key 

LDAPImportOID FK GUID N Identifies the LDAP import option 
set to be used. 

Notes: 

 The LDAPImportOID foreign key references the LDAPImportOID primary key column of the NC_LDAPImport 
table. 

 The TaskOID foreign key references the TaskOID primary key column of the NC_Task table. 

NC_ObjChoiceListItem Table (Entity) 

The NC_ObjChoiceListItem table indicates what type of database object a choice list 
item is. (For details of choice lists, see Setting Up a List of Choices.)  

Column Key Type Null Description 

ChoiceListItemOID PK, FK GUID No An internal ID number used as a 
primary key. 

ClassID   Numeric(5,0) No The proxy’s class identification. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The ChoiceListItemOID foreign key references the ChoiceListItemOID primary key 
column of the NC_ChoiceListItem table. 
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NC_StrChoiceListItem Table (Entity) 

The NC_StrChoiceListItem table includes the text that appears in choice lists in the 
Collection Editor. See Setting Up a List of Choices. 

Column Key Type Null Description 

ChoiceListItemOID PK, FK GUID No An internal ID number used as a 
primary key. 

ChoiceText   Varchar(100) No The text that makes up the 
selection. 

Note 

The ChoiceListItemOID foreign key references the ChoiceListItemOID primary key 
column of the NC_ChoiceListItem table. 

NC_TaskServer Table (Entity) 

The NC_TaskServer table includes data about Task Servers. 

Column Key Type Null Description 

TaskServerOID PK GUID No An internal ID number used as a 
primary key. 

TaskServerName   Varchar(48) No The name of the Task Server. 

CollDomainOID FK GUID No The collection domain to which 
this Task Server belongs. 

ProcessReportTask   Short <INT2> No 1 (TRUE) if the Task Server can 
process report tasks; else 0. 

ProcessPurgeTask   Short <INT2> No 1 (TRUE) if the Task Server can 
process purge tasks; else 0. 

ProcessDirImportTask   Short <INT2> No For future use. 

ProcessPRUTask   Short <INT2> No 1 (TRUE) if the Task Server can 
process PRU (Product Recognition 
Update) tasks; else 0. 

ProcessNetworkDiscTask   Short <INT2> No 1 (TRUE) if the Task Server can 
process network discovery tasks; 
else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The CollDomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain 
table. 

 TaskServerName + CollDomainOID has a unique constraint named UQ_TaskSvr_NameCollDom. 
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NC_WkstnReconcileData Table (Entity) 

The NC_WkstnReconcileData table includes data used in reconciling new workstations 
in the database. 

Column Key Type Null Description 

WkstnReconcileDataOID PK GUID No An internal ID number used as a 
primary key. 

ReconcileData   Varchar(38) No The data used to reconcile the 
workstation. 

ReconcileType   Short <INT2> No The type of reconcilation: 0=NIC 
Address, 1=Serial Number, 
2=Config ID, 3=Machine Name. 

IsTally   Short <INT2> No 1 (TRUE) if the data is defined by 
Novell (versus the user); else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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Inventory Data Tables 
The inventory data tables contain all the available data about a workstation, including 
hardware and software data, demographic data, and FNI data. 

NC_BIOS Table (Entity)  
NC_Category Table (Entity)  
NC_CDROM Table (Entity)  
NC_Component Table (Entity)  
NC_CPU Table (Entity)  
NC_DeviceRes Table (Entity)  
NC_Disk Table (Entity)  
NC_DMI Table (Entity)  
NC_FEC Table (Entity)  
NC_Floppy Table (Entity)  
NC_FNIData Table (Entity)  
NC_HotFix Table (Entity)  
NC_Keyboard Table (Entity)  
NC_LANAdapter Table (Entity)  
NC_LogicalDrive Table (Entity)  
NC_MemoryModule Table (Entity)  
NC_Modem Table (Entity)  
NC_Monitor Table (Entity)  
NC_Mouse Table (Entity)  
NC_NetworkDriver Table (Entity)  
NC_OperatingSystem Table (Entity)  
NC_ParallelPort Table (Entity)  
NC_Printer Table (Entity)  
NC_Product Table (Entity)  
NC_ProductCategory Table (Entity)  
NC_RemovableMedia Table (Entity)  
NC_SerialPort Table (Entity)  
NC_ServerData Table (Entity)  
NC_Software Table (Entity)  
NC_System Table (Entity)  
NC_SystemBoard Table (Entity)  
NC_User Table (Entity)  
NC_VideoAdapter Table (Entity)  
NC_VirtualMachine Table Table (Entity)  
NC_VRBSoftware Table (Entity)  
NC_WebSoftware Table (Entity) 
NC_WebSoftwareAttributes Table (Entity) 
NC_Workstation Table (Entity)  
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NC_BIOS Table (Entity) 

The NC_BIOS table contains inventory data about BIOS components. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Version   Varchar(64)   The BIOS version. 

ReleaseDate   Varchar(9)   The ROM release date. 

DMICompVersion   Varchar(6)   The DMI (SM) BIOS version. 

IsAPMSupport   Short <INT2> No 1 (TRUE) if it supports the 
Advanced Power Management 
specification; else 0. 

IsACPICompatible   Short <INT2> No 1 (TRUE) if it supports the 
Advanced Configuration and Power 
Interface; else 0. 

FamilyCode   Varchar(32)   The BIOS family. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_Category Table (Entity) 

The NC_Category table tracks product categories. 

Column Key Type Null Description 

CategoryOID PK GUID No An internal ID number used as a 
primary key. 

CategoryName   Varchar(32) No The name of the product category. 

CategoryType   Short <INT2> No The product type to which the 
category belongs. See "Note" 
below. 

IsTally   Short <INT2> No 1 (TRUE) if the category was 
defined by Novell; else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

IsDeleted   DateTime   The date and time the record was 
deleted; else null. 

Note 

The CategoryType can be one of the following:  

1 BIOS 17 Printer 
2 CPU 18 BUS Adapter 
3 CD/DVD Drive 19 Serial Port 
4 DMI 20 Sound Card 
5 Diskette Drive 21 Software 
6 Hard Disk 22 System 
7 Keyboard 23 System Board 
8 LAN Adapter 24 Video Adapter 
9 Memory Module Socket 25 Removable Media Drive 
10 Modem 26 Other 
11 Monitor 29 Hot Fix 
12 Mouse 30 USB Port 
13 Network Driver 31 Docking Station 
14 Operating System     
15 Parallel Port     
16 Partition     
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NC_CDROM Table (Entity) 

The NC_CDROM table contains inventory data about CD-ROM components. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

InterfaceType   Short <INT2> No The interface type: 0=Unknown, 
1=IDE, 2=SCSI, 3=USB, 4=FireWire. 

DriveLetter   Char(1) Yes (space char)  

DeviceType   SHORT<INT2> Yes Drive type (capabilities) 

Notes 

1. InterfaceType: 0 = Unknown, 1= IDE, 2 = SCSI, 3 = USB, 4 = FireWire 
2. DeviceType: 0 = Unknown,1=CD Reader,2=DVD ROM,2=CDR,3=CD Read/Write, 

4=CD/DVD,5=DVD RAM,6=CDR/DVD -R,7=CDR/DVD -RW,8=CDR/DVD +R, 
9=CDR/DVD +RW,10=CDR/DVD +/-R,11=CDR/DVD +/-RW  

FK references: 

 FK_CDROM_CompOID: ComponentOID references 
NC_Component.ComponentOID 
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NC_Component Table (Entity) 

The NC_Component table contains component data. 

Column Key Type Null Description 
ComponentOID PK GUID No An internal ID number used as a primary key. 
WorkstationOID FK GUID No The workstation with which the component is associated. 
DomainID    GUID    The Collection Domain with which the component is associated. 
ProductOID FK GUID No The product as identified by the Collector. 
ProductAlias FK GUID No The product as edited by the user. 
ProductType    Short <INT2> No The product type. See "Notes" in "NC_Product Table." 
Collector    Short <INT2>    The Collector that found the component: 0=Win32, 1=OS/2, 2=DOS. 
Source    Short <INT2>    The source of the component: 1=Collector, 2=Collection Editor, 

3=ZENworks Asset Management Manager, 4=Translator/Migrator, 
5=Palm Translator,  
6=UNIX Translator. 

SerialNumber    Varchar(38)    The serial number as discovered by the Collector. 
AssetTag    Varchar(38)    The asset tag as discovered by the Collector. 
SerialNumberAlias    Varchar(38)    The serial number as provided by the user. 
AssetTagAlias    Varchar(38)    The asset tag as provided by the user. 
ModelNumber    Varchar(32)    The model number. 
CreateDate    DateTime No The date the component was created. 
DateLastModified    DateTime No The date the component was last changed. 
DerivedClassID    Numeric(5,0)    Reserved for internal use. 
InstanceVer    Long <INT4> No The instance version (used internally to control changes in a multi-

user environment). 
IsDeleted    DateTime    The date and time the record was deleted; else null. 
ExcludedNonColl   Tinyint Yes 0 

Notes 

1. Collector: 0=Win32 Collector, 1=OS/2 Collector, 2=DOS Collector 
2. Source: 0=Tally, 1=Collector, 2=Collection Editor, 3=Manager 
3. ProductType: See note 1 within NC_ProductCategory Table  

FK references: 

1. FK_Comp_WkstnOID: WorkstationOID references NC_Workstation.WorkstationOID 
2. FK_Comp_ProductOID: ProductOID references NC_Product.ProductOID 
3. FK_Comp_ProductAlias: ProductAlias references NC_Product.ProductOID  

Indexes: 

1. IDX_Comp_WkstnOID: WorkstationOID (nonclustered) 
2. IDX_Comp_ProdOID: ProductOID 
3. IDX_Comp_ProdAlias: ProductAlias 



References 

373 

NC_CPU Table (Entity) 

The NC_CPU table contains CPU inventory data. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Speed   Float   The CPU speed in MHz. 

VendorIdentifier   Varchar(12)   The manufacturer of the CPU. 

CPUIDType   Short <INT2>   The CPU type. 

CPUIDFamily   Short <INT2>   The CPU family. 

CPUIDModel   Short <INT2>   The CPU model. 

CPUIDStepping   Short <INT2>   The CPU stepping result. 

IsMMX   Short <INT2> No 1 (TRUE) if the MMX flag features 
flags; else 0. 

L1CacheSize   Short <INT2>   The size of the L1 cache. 

Is64Bit   Bit   Initial value = 0 

CoreCount   TinyInt   Initial value = 1 

IsHyperThreaded   Bit   Initial value = 0 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_DeviceRes Table (Entity) 

The NC_DeviceRes table includes information about a device’s I/O map, IRQ, DMA, or 
memory. 

Column Key Type Null Description 

DeviceResOID PK GUID No An internal ID number used as a 
primary key. 

Description   Varchar(64)   The name of the device. 

IOMap   Varchar(64)   The I/O map. 

IRQs   Varchar(64)   The IRQ. 

DMAs   Varchar(64)   The DMA data. 

Memory   Varchar(64)   Data about memory. 

WorkstationOID FK GUID No The workstation ID. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The WorkstationOID foreign key references the WorkstationOID primary key column of 
the NC_Workstation table. 
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NC_Disk Table (Entity) 

The NC_Disk table contains data about disk components. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

DriveNumber   Short <INT2>   The link to partitions. 

IsSmartWarning   Short <INT2> No 1 (TRUE) if SMART warning is 
supported; else 0. 

LogicalDrives   Varchar(32)   A list of drive letters on this disk. 

RawTotalSpace   Float   The total disk capacity. 

InterfaceType   Short <INT2> No The interface type: 0=Unknown, 
1=IDE, 2=SCSI, 3=USB, 4=FireWire. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_DMI Table (Entity) 

The NC_DMI table contains inventory data about DMI (Distributed Management 
Interface) registered components. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Manufacturer   Varchar(64)   The manufacturer reported by 
DMI. 

Product   Varchar(64)   The product reported by DMI. 

Version   Varchar(64)   The version reported by DMI. 

SerialNumber   Varchar(64)   The serial number reported by 
DMI. 

InstallationDate   Varchar(20)   The installation date reported by 
DMI. 

Verify   Short <INT2>   The verification reported by DMI. 
See "Notes" below. 

Notes 

 The ComponentOID foreign key references the ComponentOID primary key column of the NC_Component 
table. 

 Verify can have one of the following values: 

0 Error 

1 Component does not exist 

2 Not supported 

3 Reserved 

4 Component exists but is untested 

5 Component exists but is unknown 

6 Component exists but is no good 

7 Component exists and is good 

8 Unknown 

 



References 

377 

NC_FEC Table (Entity) 

The NC_FEC table contains information about a system local product entered with the 
Collection Editor. 

Column Key Type Null Description 

FECOID PK GUID No An internal ID number used as a 
primary key. 

ProductOID FK GUID No The product ID. 

Fingerprint   Varbinary(255)   The recognition data used to 
attempt the product’s 
identification. 

IsMerged   Short <INT2> No 1 (TRUE) if the local product has 
been merged into a KB file; else 
0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The ProductOID foreign key references the ProductOID primary key column of the 
NC_Product table. 

NC_Floppy Table (Entity) 

The NC_Floppy table includes data about floppy drives. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Capacity   Float   The storage capacity of the drive. 

DriveLetter   Char(1)   The drive letter. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_FNIData Table (Entity) 

The NC_FNIData table tracks FNI data. 

Column Key Type Null Description 

FNIDataOID PK GUID No An internal ID number used as a 
primary key. 

DomainID   GUID   The Collection Domain with 
which the FNI data is 
associated. 

FileDate   DateTime   The date the file was created. 

FileSize   Numeric(20, 0)   The size of the file. 

FileName   Varchar(64)   The file name. 

SubDirectory   Varchar(255)   The folder in which the file 
resides. 

Extension   Varchar(32)   The three-character file 
extension. 

WorkstationOID FK GUID   The workstation with which the 
file is associated. 

FileScanCategory   SHORT<INT2>   0=None,  
1=System, 
2=Ancillary,  
3=Other 

VICompanyName   Varchar(64)   Version information company 
name. 

VIProductName   Varchar(80)   Version information product 
name. 

VIProductVersion   Varchar(32)   Version information product 
version. 

VILanguage   Varchar(16)   Version information language. 

VIFileVersion   Varchar(32)   Version information file 
version. 

StartupCount   Long <INT4> No The number of times the 
application file was detected as 
started. 

TotalActiveSeconds   Long <INT4> No The number of seconds the file 
was active. 

TotalRuntimeSeconds   Long <INT4> No The number of seconds the file 
was open. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in 
a multi-user environment). 

Note 

The WorkstationOID foreign key references the WorkstationOID primary key column of 
the NC_Workstation table. 
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NC_HotFix Table (Entity) 

The NC_HotFix table contains inventory data about hot fixes (patches). 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

RegistryKey   Varchar(256)   The registry key that indicates the 
hot fix has been installed. 

Description   Varchar(128)   The description of the hot fix. 

DateInstalled   Varchar(20)   The date the hot fix was installed. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_Keyboard Table (Entity) 

The NC_Keyboard table contains inventory data about keyboards. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

InterfaceType   Short <INT2>   The interface type: 0=Unknown, 
1=PS/2, 2=USB. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_LANAdapter Table (Entity) 

The NC_LANAdapter table contains inventory data about LAN adapters. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

LANAddress   Varchar(12)   The 48-bit Ethernet address 
associated with this card. 

IPAddress   Varchar(2048)   The IP addresses that map to this 
adapter. 

SubnetMask   Varchar(2048)   The subnet masks that are 
assigned to this adapter. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_LogicalDrive Table (Entity) 

The NC_LogicalDrive table contains inventory data about logical drives. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

DriveNumber   Short <INT2>   The number of the drive. 

DriveLetter   Char(1)   The drive letter (without a 
colon). 

AvailableSpace   Float   The free space on this drive. 

TotalSpace   Float   The total space on this drive. 

LogicalNumber   Short <INT2>   The sequential number of this 
drive on the disk. 

IsRemote   Short <INT2> No 1 (TRUE) if the drive is 
networked; else 0. 

FileSystem   Short <INT2>   The file system: 0=Unknown, 
1=FAT, 2=FAT 32, 3=NTFS, 
4=HPFS, 5=NetWare. 

VolumeLabel   Varchar(64)   The volume name of the drive. 

VolumeSerialNumber   Varchar(32)   The serial number of the drive. 

UNCPath   Varchar(100)   The UNC path of the drive. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_MemoryModule Table (Entity) 

The NC_MemoryModule table contains inventory data about memory. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

MemoryType   Short <INT2> No The type of memory: 0=other, 
1=unknown, 2=standard, 3=fast 
page mode, 4=EDO, 5=Burst EDO, 
6=SDRAM. 

ModuleSize   Short <INT2>   The size of the module in MB. 

Speed   Short <INT2>   Access time in nanoseconds. 

SocketDesignator   Varchar(24)   The socket designator for the 
module. 

FormFactor   Short <INT2> No The physical configuration: 
0=unknown, 1=SIMM, 2=DIMM. 

Parity   Short <INT2> No 1 (TRUE) if the parity bit is 
present; else 0. 

ECC   Short <INT2> No 1 (TRUE) if error checking and 
correction is present; else 0. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_Modem Table (Entity) 

The NC_Modem table contains inventory data about modems. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Speed   Long <INT4>   The maximum speed of the modem 
in bps. 

ComPort   Varchar(4)   The communications port to which 
the modem is attached. 

ModemType   Short <INT2> No The modem type: 0=Unknown, 
1=External, 2=Internal, 3=PC Card. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_Monitor Table (Entity) 

The NC_Monitor table contains inventory data about monitors. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

EISAManufacturer   Varchar(64)   The manufacturer’s name. 

VESAProduct   Varchar(64)   The product name. 

YearManufactured   Short <INT2>   The year of manufacture. 

WeekManufactured   Short <INT2>   The week (1-52) of manufacture. 

DiagonalSize   Float   The calculated diagonal size. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_Mouse Table (Entity) 

The NC_Mouse table contains inventory data about mice. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

InterfaceType   Short <INT2>   The interface type: 0=Unknown, 
1=PS/2, 2=Inport, 3=Bus, 4=USB.  

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_NetworkDriver Table (Entity) 

The NC_NetworkDriver table contains inventory data about network drivers. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

FileVersion   Varchar(32)   The file version. 

Filename   Varchar(16)   The file name. 

Description   Varchar(80)   The driver description. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_OperatingSystem Table (Entity) 

The NC_OperatingSystem table contains inventory data about operating systems. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Build   Varchar(8)   The build string. 

ServicePack   Varchar(8)   The service pack string. 

BootDriveLetter   Char(1)   The drive from which the 
operating system started (without 
a colon). 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_ParallelPort Table (Entity) 

The NC_ParallelPort table contains inventory data about parallel ports. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

LogicalName   Varchar(64)   The name of the port, for 
example, LPT1. 

IsEPP   Short <INT2> No 1 (TRUE) if EPP is supported; else 
0. 

IsECP   Short <INT2> No 1 (TRUE) if ECP is supported; else 
0. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_Printer Table (Entity) 

The NC_Printer table contains inventory data about printers. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used 
as a primary key. 

IsRemote   Short <INT2> No 1 (TRUE) if it’s a network 
printer; else 0. 

UNCPath   Varchar(255)   The UNC path of the 
printer. 

Port   Varchar(6)   The port to which the 
printer is assigned, for 
example, LPT1. 

DriverName   Varchar(64)   The printer driver name. 

WindowsName   Varchar(64)   The Windows name of the 
printer. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_Product Table (Entity) 

The NC_Product table contains product information. 

Column Key Type Null Description 
ProductOID PK GUID No An internal ID number used as a primary 

key. 
Code   Long <INT4>   The product’s unique ID where 0 as the 

leading digit represents hardware and 1 
represents software. 

ProductType   Short <INT2> No The product type. See "Notes"below. 
ProductCategoryOID FK GUID   Product classification information. 
Manufacturer   Varchar(35)   The manufacturer’s name. 
Product   Varchar(100)   The product name.  
Model   Varchar(25)   The model of the product. 
Source   Short <INT2> No How the product was created: 

0=ZENworks Asset Management-defined, 
1= Collector,  
2=Collection Editor,  
3 = ZENworks Asset Management 
Manager, 4=Translator/Migrator,  
5=Palm Translator,  
6=UNIX Translator. 

SWPlatform   Short <INT2>   The platform under which a software 
product runs. See "Notes" below. 

ProductContactOID FK GUID   Product contact information. 
NotInUse   Short <INT2> No 1 (TRUE) if the product is a local 

product that has been reconciled into 
another product; else 0. 

Classification   Short <INT2> No The classification of a product: 
0=hardware, 1=software. 

Platform   Short <INT2> No The platform. See "Notes" below. 
Language   Short <INT2> No The language. See "Notes" below. 
IsCodeValid   Short <INT2> No 1 (TRUE) if the code is valid; else 0. 
IsMerged   Short <INT2> No 1 (TRUE) if the local product has been 

merged into the product KB files; else 
0. 

CreateDate   DateTime   The time and date the product was 
created. 

DateLastModified   DateTime   The time and date the product was last 
modified by a ZENworks Asset 
Management User. 

LicenseRequired   Short <INT2> No 1 (TRUE) if a license is required; else 0. 
LicenseCount   Long <INT4>   The number of licenses for the product. 
LicenseId   Varchar(25)   An identifier used to group different 

versions of the product. (For more 
details, see Entering License Data into 
the Database.) 

LicenseName   Varchar(50)   The name of the product license. 
InstanceVer   Long <INT4> No The instance version (used internally to 

control changes in a multi-user 
environment). 

IsDeleted   DateTime   The date and time the record was 
deleted;else null. 
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Notes 

 The ProductType can be one of the following:  
1 BIOS 16 Partition 
2 CPU 17 Printer 
3 CD-ROM 18 Bus Adapter 
4 DMI 19 Serial Port 
5 Floppy 20 Sound Card 
6 Hard Disk 21 Software 
7 Keyboard 22 System 
8 LAN Adapter 23 System Board 
9 Memory Module 24 Video Adapter 
10 Modem 25 Removable Media 
11 Monitor 26 Other 
12 Mouse 29 Hot Fix 
13 Network Driver 30 USB Port 
14 Current Operating 

System 
31 Docking Station 

15 Parallel port     

 SWPlatform and Platform can have one of the following values: 
0 DOS 
1 Windows 3.x 
2 Windows 95 
3 Windows 98 
4 Windows 32-bit 
5 Windows NT 
6 Windows 9x 
7 OS/2 
8 Unassigned 
10 Windows 2000 
11  Windows XP 

 Language can have one of the following values: 
1 Afrikaans 15 Hungarian 
2 Arabic 16 International 
3 Chinese 17 Italian 
4 Simple Chinese 18 Japanese 
5 Traditional Chinese 19 Korean 
6 Danish 20 Norwegian 
7 Dutch 21 Polish 
8 English (U.K.) 22 Portuguese 
9 English (U.S.) 23 Brazilian Portuguese 
10 Finnish 24 Russian 
11 French 25 Spanish 
12 German 26 Swedish 
13 Greek 27 Turkish 
14 Hebrew     

 The ProductCategoryOID foreign key references the ProductCategoryOID primary key column of the 
NC_ProductCategory table. 

 ProductType + Manufacturer + Product + Model + Source + Language + IsDeleted has a unique constraint 
named UQ_Product_Names. 
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NC_ProductCategory Table (Entity) 

The NC_ProductCategory table identifies the product category.  

Column Key Type Null Description 

ProductCategoryOID PK GUID No An internal ID number used as a 
primary key. 

ProductCategoryName   Varchar(32) No The name of the product 
subcategory. 

CategoryOID FK GUID No Product category information. 

IsTally   Short <INT2> No 1 if this is a product category 
defined by Novell; 0 if it is user-
defined. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

IsDeleted   DateTime   The date and time the record was 
deleted; else null. 

Note  

The CategoryOID foreign key references the CategoryOID primary key column of the 
NC_Category table. 

NC_RemovableMedia Table (Entity) 

The NC_RemovableMedia table contains inventory data about removable media. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

InterfaceType   Short <INT2>   The inteface type: 0=Unknown, 
1=IDE, 2=SCSI, 3=USB, 4=FireWire. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 



ZENworks Asset Management User's Guide 

388 

NC_SerialPort Table (Entity) 

The NC_SerialPort table contains inventory data about serial ports. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

LogicalName   Varchar(4)   The name of the port, for 
example, COM1. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 

NC_ServerData Table (Entity) 

The NC_ServerData table contains inventory data about servers. 

Column Key Type Null Description 

ServerDataOID PK GUID No An internal ID number used as a 
primary key. 

ServerName   Varchar(255)   The UNC path to the server. 

ServerNOS   Varchar(32)   The network operating system 
that is running on the server. 

Usage   Short <INT2>   What the server is being used for: 
16=file server, 32=print server. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

IsDeleted   DateTime   The date and time the record was 
deleted; else null. 
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NC_Software Table (Entity) 

The NC_Software table contains inventory data about software. 

Column Key Type Null Description 
ComponentOID PK, 

FK 
GUID No An internal ID number used as a primary key. 

Path    Varchar(255)    The path to the folder where the software resides. 

StartupCount    Long <INT4> No The number of times the application was detected as started. 

TotalRuntimeSeconds    Long <INT4> No The number of seconds the application was open. 

TotalActiveSeconds    Long <INT4> No The number of seconds the application was active. 

AdditionalInfo    Varchar(200)    Additional information about the software, for example, the 
date of a virus definition. 

ParentSuiteOID    GUID Yes    

FirstUsed   Datetime Yes Null 

LastUsed   Datetime Yes Null 

FirstServed   Datetime Yes Null 

LastServed   Datetime Yes Null 

Notes 

FK references:  

1. FK_SW_CompOID: ComponentOID references NC_Component.ComponentOID  
2. FK_SW_ParentSuiteOID: ParentSuiteOID references NC_Software.ComponentOID  

Indexes:  

  

 IDX_SW_ParentSuiteOID: ParentSuiteOID  
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NC_System Table (Entity) 

The NC_System table contains inventory data about systems. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

ChassisType   Short <INT2>   The type of chassis. See "Notes" 
below. 

ThermalState   Short <INT2>   The thermal state. See "Notes" 
below. 

CoverRemoved   DateTime   The CPU cover has been 
removed. 

Fingerprint   Varbinary(255)   The fingerprint used to identify 
the system. 

Notes 

 The ComponentOID foreign key references the ComponentOID primary key column of the NC_Component 
table. 

 The ChassisType can have one of the following values: 

0 Out of Range 13 All in One 
1 Other 14 Sub Notebook 
2 Unknown 15 Space-saving 
3 Desktop 16 Lunch Box 
4 Low Profile Desktop 17 Main Server Chassis 
5 Pizza Box 18 Expansion Chassis 
6 Mini Tower 19 SubChassis 
7 Tower 20 Bus Expansion Chassis 
8 Portable 21 Peripheral Chassis 
9 Laptop 22 RAID chassis 
10 Notebook 23 Rack Mount Chassis 
11 Hand Held 24 Sealed-case PC 
12 Docking Station     

 

 ThermalState can have one of the following values: 

0 Out of range 
1 Other 
2 Unknown 
3 Safe 
4 Warning 
5 Critical 
6 Non-recoverable 
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NC_SystemBoard Table (Entity) 

The NC_SystemBoard table contains inventory data about system boards. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

Revision   Varchar(32)   The motherboard version. 

Bus1type   Short <INT2>   The first bus type: 0=unknown, 
1=ISA, 2=PCI, 3=MCA, 4=EISA, 
5=PCMCIA, 6=VL. 

Bus1slots   Short <INT2>   The number of slots for the first 
bus. 

Bus2type   Short <INT2>   The second bus type: 0=unknown, 
1=ISA, 2=PCI, 3=MCA, 4=EISA, 
5=PCMCIA, 6=VL. 

Bus2slots   Short <INT2>   The number of slots for the second 
bus. 

L2CacheSize   Short <INT2>   The size of the L2 cache. 

L2CacheSpeed   Short <INT2>   The access time of the L2 cache in 
nanoseconds. 

L2CacheWritePolicy   Short <INT2>   The write policy of the L2 cache: 
0=unknown, 1=write back, 2=write 
through, 3=write variable. 

SystemBoardId   Varchar(64)   The identification of the system 
board. 

MotherboardUID   Binary(16)   The identification of the mother 
board. 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_User Table (Entity) 

The NC_User table contains inventory data about workstation users. 

Column Key Type Null Description 

UserOID PK GUID No An internal ID number used as a 
primary key.  

FirstName   Varchar(32)   The user’s first name. 

MiddleName   Varchar(32)   The user’s middle name. 

LastName   Varchar(32)   The user’s last name. 

Phone   Varchar(32)   The user’s telephone number. 

Email   Varchar(100)   The user’s e-mail address. 

Phone2   Varchar(32)   The user’s second telephone 
number. 

Fax   Varchar(32)   The user’s fax number. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

IsDeleted   DateTime   The date and time the record was 
deleted; else null. 
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NC_VideoAdapter Table (Entity) 

The NC_VideoAdapter table contains inventory data about video adapters. 

Column Key Type Null Description 

ComponentOID PK, FK GUID No An internal ID number used as a 
primary key. 

MinRefreshRate   Short <INT2>   The minimum refresh rate. 

MaxRefreshRate   Short <INT2>   The maximum refresh rate. 

MemoryType   Short <INT2>   The memory type. 

MemorySize   Long <INT4>   The memory size. 

MinVertResolution   Short <INT2>   The minimum vertical resolution. 

MinHorizResolution   Short <INT2>   The minimum horizontal resolution. 

MaxVertResolution   Short <INT2>   The maximum vertical resolution. 

MaxHorizResolution   Short <INT2>   The maximum horizontal 
resolution. 

NumberBitsPerPixel   Short <INT2>   The number of bits per pixel. 

PixelShaderMajorVersion   SHORT<INT2>     

PixelShaderMinorVersion   SHORT<INT2>     

Note 

FK references: 

1. FK_VideoAdapt_CompOID: ComponentOID references NC_Component.ComponentOID  
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NC_VRBSoftware Table (Entity) 

This table stores information about applications identified as being run from the network. 

  

Column Key Type Null Description 
VRBSoftwareOID PK GUID N internal ID number used as primary key 

Server    VARCHAR 
(256) 

N The name of the server where the application resides. 

Sharename    VARCHAR 
(256) 

N The name of share where the application resides. 

Path    VARCHAR 
(256) 

N The path relative to the UNC path (ServerName+ShareName) where 
the application resides. 

Manufacturer    VARCHAR (35)    The manufacturer of the application (VRB). 

ManufacturerAlias    VARCHAR (35)    The user-edited manufacturer. 

ProductName    VARCHAR 
(100) 

   The product name (VRB). 

ProductNameAlias    VARCHAR 
(100) 

   User-edited product name. 

Version    VARCHAR (25)    The product version (VRB). 

VersionAlias    VARCHAR (25)    User-edited version. 

FileVersion    VARCHAR (25)    The file version (VRB). 

Language    VARCHAR (25)    The product language (VRB). 

CreateDate    DATETIME N Date that the record was entered into the database. 

DateLastModified    DATETIME    Last modification of the record. 

InstanceVer    LONG<INT4> N Instance Version 

Filename    Varchar(64)    Computed from Path 

IsDeleted   Datetime Yes Date that the record was deleted, NULL if not deleted. 
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NC_Workstation Table (Entity) 

The NC_Workstation table tracks workstation inventory data. 

Column Key Type Null Description 

WorkstationOID PK GUID No An internal ID number used as a 
primary key.  

DomainID   GUID   The Collection Domain to which 
the workstation belongs. 

V29xConfigID   Varchar(8)   The NetCensus configuration ID. 

MachineName   Varchar(32)   The machine name. See "Notes" 
below. 

InventoryType   Short <INT2> No The type of inventory: 
0=Workstation,  
1=Server,  
2=Stockroom,  
3=Lost and Found,  
4= Portable,  
5=NetCensus,  
6=Manually-entered Workstation,  
7=Workstation Not Yet Scanned,  
8=PDA,  
9=UNIX. 

LoginName   Varchar(32)   The user’s logon name. See 
"Notes" below. 

PrimaryUserOID FK GUID   The main user of the 
workstation. 

TechContactOID FK GUID   The technical contact for the 
workstation. 

Site   Varchar(32)   The site of the workstation. 

Dept   Varchar(32)   The department to which the 
workstation belongs. 

CostCenter   Varchar(32)   The cost center to which the 
workstation belongs. 

Building   Varchar(32)   The building in which the 
workstation resides. 

Floor   Varchar(10)   The floor on which the 
workstation resides. 

Room   Varchar(32)   The number of the room. 

Phone   Varchar(32)   The telephone number at the 
workstation. 

TotalMemory   Long <INT4>   The total system memory. 

TotalHardDiskSpace   Float   The total space on the hard disk. 
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FreeHardDiskSpace   Float   The total free space on the hard 
disk. 

CollServerOID FK GUID   The Collection Server to which 
the workstation belongs. 

IsCheckedOut   Short <INT2> No 1 (TRUE) if the workstation is 
checked out; else 0. 

HasMoved   Short <INT2> No 1 (TRUE) if the workstation has 
been moved with ZENworks Asset 
Management Manager. 

CheckedOutBy   GUID   The process that checked out the 
workstation. 

CheckInOutTime   DateTime   The last time the workstation 
was checked in and out. 

ScheduledScanPending   Short <INT2> No For future use. 

ScanASAPPending   Short <INT2> No For future use. 

LastSuccessfulScanDate   DateTime   The date and time of the last 
successful scan of the 
workstation. 

LastSuccessfulLoadDate   DateTime   The date and time of the last 
successful load of inventory from 
the workstation. 

LastUsageGatherDate   DateTime   The date and time software 
usage data was last collected 
from the workstation. 

ConnectionInfoOID FK GUID   Connection detail information. 

LANAddress   Varchar(12)   The LAN address from the LAN 
adapter. 

IPAddress   Varchar(15)   The IP address from the LAN 
adapter. 

SerialNumber   Varchar(38)   The serial number of the system 
component. 

AssetTag   Varchar(38)   The asset tag of the system 
component. 

IsLeased   Short <INT2> No 1 (TRUE) if the machine is 
leased; else 0. 

LeaseExpireDate   DateTime   Lease expiration date. 

LeaseContractId   VarChar(20)   The contract ID of the lease. 

CreateDate   DateTime No The date and time the 
workstation was added. 

DateLastModified   DateTime No The date and time the 
workstation was last modified. 
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DefaultGateway   Varchar(15)   The IP address for the 
workstation’s default gateway. 

WkstnDomain   VARCHAR(64)   Windows domain to which the 
workstation belongs. 

SubnetMask   Varchar(15)   The subnet mask. 

ClientId   GUID   The workstation ID. 

CenergyAgentId   GUID   An ID provided by the Collector if 
it finds Cenergy Agent installed 
on the workstation. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

IsDeleted   DateTime   The date and time the record 
was deleted; else null. 

AssetType   TinyInt   Computed from 
InventoryType 

AvailableMemorySlots   Short Yes Computed by 
counting # of rows 
for workstation in 
NC_MemoryModule 
where modulesize = 
0 

VirtualMachineType   TinyInt     

ZenWorksAgentId   Varchar(256) Yes   

Notes 

 MachineName and LoginName are obtained from the network. If more than one network is available, the 
order used is Windows network, NetWare, and NetBIOS. 

 The PrimaryUserOID foreign key references the UserOID primary key column of the NC_User table. 
 The TechContactOID foreign key references the UserOID primary key column of the NC_User table. 
 The CollServerOID foreign key references the CollServerOID primary key column of the NC_CollServer table. 
 The ConnectionInfoOID foreign key references the ConnectionInfoOID primary key column of the 

NC_ConnectionInfo table.  
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History & Reporting Tables 
The history and reporting tables contain data that is used in various reports. 

  

NC_CompChanges Table (Entity)  

NC_Error Table (Entity)  

NC_ExtProperty Table (Entity)  

NC_LocProductChanges Table (Entity)  

NC_NetSoftwareUsageHistory Table (Entity)  

NC_NetSoftwareUsageSummary Table (Entity)  

NC_NetworkPrinterAlerts Table (Entity)  

NC_NetworkPrinterConsumables Table (Entity)  

NC_ProcessEvents Table (Entity)  

NC_SoftwareUsageHistory Table (Entity)  

NC_TaskHistory Table (Entity)  

NC_TimeTable (Entity)  

NC_WebSoftwareUsageHistory Table (Entity)  

NC_WebSoftwareUsageSummary Table (Entity) 

NC_WkstnChanges Table (Entity)  

NC_WkstnProcess Table (Entity)  
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NC_CompChanges Table (Entity) 

The NC_CompChanges table tracks changes to components. 

Column Key Type Null Description 

CompChangesOID PK GUID No An internal ID number used as a 
primary key. 

TimeTableOID FK GUID No A particular day in the format 
yyyymmdd. 

ComponentOID FK GUID No The component that was changed. 

NCUserOID FK GUID   The ZENworks Asset Management 
user who made the change. 

TypeOfChange   Short <INT2> No The type of change: 0=created, 
1=edited, 2=deleted, 3=moved, 
4=retired. 

SourceOfChange   Short <INT2> No The source of the change: 
0=Collector, 1=Collection Editor, 
2=Collection Server, 3=ZENworks 
Asset Management Manager, 
4=Task Server. 

FieldId   Numeric(5,0)   The field ID. 

FieldLabel   Varchar(50)   The field name. 

Value1   Varchar(255)   The old value that was changed. 

Value2   Varchar(255)   The new value. 

PrevWkstnOID FK GUID   The workstation with which the 
component was associated. 

CreateDate   DateTime No The date that the change was 
entered in the database. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The TimeTableOID foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The ComponentOID foreign key references the ComponentOID primary key column of the NC_Component 

table. 
 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
 The PrevWkstnOID foreign key references the WorkstationOID primary key column of the NC_Workstation 

table. 



ZENworks Asset Management User's Guide 

400 

NC_Error Table (Entity) 

The NC_Error table tracks errors. 

Column Key Type Null Description 

ErrorOID PK GUID No An internal ID number used as a 
primary key. 

ID   GUID   The instance of the error. 

SequenceNumber   Short <INT2>   The sequence in the error chain. 

Severity   Short <INT2>   The severity of the error. 

Code   Short <INT2>   The code associated with the 
error. 

ComputerName   Varchar(255)   The name of the workstation. 

ComputerUser   Varchar(50)   The name of the user. 

HostID   GUID   The host identifier. 

ErrorTime   DateTime   The time of the error. 

Product   Numeric(5,0)   The name of the product. 

Module   Numeric(10,0)   The module that generated the 
error. 

Class   Varchar(255)   Used internally to identify the 
code that produced the error. 

Method   Varchar(255)   Used internally to identify the 
code that produced the error. 

Param1   Varchar(255)   Context-specific data associated 
with a particular error, for 
example, a file name.  

Param2   Varchar(255)   Context-specific data associated 
with a particular error. 

Param3   Varchar(255)   Context-specific data associated 
with a particular error. 

Param4   Varchar(255)   Context-specific data associated 
with a particular error. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 



References 

401 

NC_ExtProperty Table (Entity) 

The NC_ExtProperty table contains component property information used in Workstation 
Detail Reports. 

Column Key Type Null Description 

ExtPropertyOID PK GUID No An internal ID number used as a 
primary key. 

ComponentOID FK GUID No The component ID. 

FieldID   Numeric(5,0) No The field ID. 

FieldLabel   Varchar(50) No The field label. 

FieldValue   Varchar(255)   The field value. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The ComponentOID foreign key references the ComponentOID primary key column of 
the NC_Component table. 
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NC_LocProductChanges Table (Entity) 

The NC_LocProductChanges table tracks data about changes to local products. 

Column Key Type Null Description 

LocProductChangesOID PK GUID No An internal ID number used as a 
primary key. 

TimeTableOID FK GUID No A particular day in the format 
yyyymmdd. 

ProductOID FK GUID No The ID of the local product that 
was changed. 

NCUserOID FK GUID   The name of the ZENworks Asset 
Management user who made the 
change. 

TypeOfChange   Short <INT2> No The type of change that was 
made: 0=created, 1=edited with 
Collection Editor, 2=deleted, 
3=moved, 4=retired. 

SourceOfChange   Short <INT2> No The source of the change: 
0=Collector, 1=Collection Editor, 
2=Collection Server, 3=ZENworks 
Asset Management Manager, 
4=Task Server. 

FieldId   Numeric(5,0)   The field ID number. 

FieldLabel   Varchar(50)   The label of the field. 

Value1   Varchar(255)   The value that was changed. 

Value2   Varchar(255)   The new value. 

CreateDate   DateTime No The date the change was entered 
in the database. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The TimeTableOID foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The ProductOID foreign key references the ProductOID primary key column of the NC_Product table. 
 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
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NC_NetworkPrinterAlerts Table (Entity) 

This table stores information about scheduled Alerts and Custom Reports. For more 
information, see Using Custom Reports and Alerts in the Using the Web Console book of 
the Web Console’s online help. 

  

Column Key Type Null Description 

NetworkPrinterAlertsOID PK GUID N internal ID number used as 
primary key 

NetworkPrinterOID FK GUID N Indicates the network printer 
that generated the alert. 

SeverityLevel   VARCHAR (16) N The severity of the alert (device-
specific) 

TrainingLevel   VARCHAR (48) N Training level required to resolve 
the alert 

AlertingSubunitName   VARCHAR (64) N Printer subsystem generating the 
alert 

Alert   VARCHAR (64) N Alert overview 

AlertDetail   VARCHAR (64)     

InstanceVer   LONG<INT4> N Instance Version 

Notes: 

 The NetworkPrinterOID foreign key references the NetworkPrinterOID primary key column of the 
NC_NetworkPrinter table. 
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NC_NetworkPrinterConsumables Table (Entity) 

This table stores information about the status of network printers. (Examples: low toner, 
out of paper, etc.) 

  

Column Key Type Null Description 

NetworkPrinterConsumableOID PK GUID N internal ID number used as 
primary key 

NetworkPrinterOID FK GUID N Indicates the network 
printer generating the 
information. 

SupplyType   VARCHAR (20) N Specifies the consumable 
being measured 

SupplyDescription   VARCHAR (64)     

SupplyLevel   VARCHAR (20) N   

InstanceVer   LONG<INT4> N Instance Version 

Notes: 

 The NetworkPrinterOID foreign key references the NetworkPrinterOID primary key column of the 
NC_NetworkPrinter table. 
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NC_ProcessEvents Table (Entity) 

The NC_ProcessEvents table contains information about events that happen to a 
workstation during the inventory process. 

Column Key Type Null Description 

ProcessEventOID PK GUID No An internal ID number used as a 
primary key. 

TimeTableOID FK GUID No A particular day in the format 
yyyymmdd. 

ClassId   Numeric(5,0) No The class of the affected object, 
for example, Collection Domain or 
Collection Server. 

ObjectId   GUID No The ID of the affected object. 

TypeOfEvent   Short <INT2> No The type of event that occurred. 
See "Notes" below. 

SourceOfEvent   Short <INT2> No The source of the event: 
0=Collector, 1=Collection Editor, 
2=Collection Server, 3=ZENworks 
Asset Management Manager, 
4=Task Server. 

StartTime   DateTime   The start time of the event in the 
format HH:MM:SS. 

EndTime   DateTime   The end time of the event in the 
format HH:MM:SS. 

Duration   Long <INT4>   The duration of the event in 
seconds. 

WkstnProcessOID FK GUID   The associated workstation. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 TypeOfEvent can have one of the following values: 

0 Created 
1 Scanned 
2 Edited 
3 Loaded 
4 Deleted 
5 Moved 
6 Retired 

 

 The TimeTableOID foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The WkstnProcessOID foreign key references the WkstnProcessOID primary key column of the 

NC_WkstnProcess table. 
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NC_SoftwareUsageHistory Table (Entity) 

The NC_SoftwareUsageHistory table tracks historical information about software that 
has been launched over a network. 

Column Key Type Null Description 

SWUsageHistoryOID PK GUID No An internal ID number used as a primary key. 

ComponentOID FK GUID No The component identifier. 

TimeTableOID FK GUID No A day in the format yyyymmdd. 

UserOID FK GUID    Indicates the user running the software 

UsageDate    DATETIME N Date on which the software component was used. 

StartupCount    Long 
<INT4> 

No The number of times the application was detected as started since 
the last scan. 

RuntimeSeconds    Long 
<INT4> 

No The time in seconds the software ran. 

ActiveSeconds    Long 
<INT4> 

No The time in seconds the software was active. 

InstanceVer    Long 
<INT4> 

No The instance version (used internally to control changes in a multi-
user environment). 

IsServerUsage   Smallint Yes 0 

Indicates that usage was detected to be run from 
remotely using a thin-client (e.g. WTS/Citrix). 

SourceDevice   Varchar(32) Yes Identifies the Machine Name or IP Address of the device used that 
generated the event. 

RemoteWorkstationOID   GUID Yes Links the remote device to the Workstation that was used to 
execute the server-based application. 

Notes: 

FK References: 

1. FK_SWUHist_CompOID: ComponentOID references NC_Component.ComponentOID 
2. FK_SWUHist_TimeTableOID: TimeTableOID references NC_TimeTable.TimeTableOID 
3. FK_SWUHist_UserOID: UserOID references NC_User.UserOID 
4. FK_SWUHist_RemoteWkstnOID: RemoteWorkstationOID references 

NC_Workstation.WorkstationOID 

Indexes: 

1. IDX_SWUHist_CompOID: ComponentOID 
2. IDX_SWUHist_TimeTableOID: TimeTableOID (clustered) 
3. IDX_SWUHist_UserOID: UserOID 
4. IDX_SWUHist_UsageDate: UsageDate 
5. IDX_SWUHist_RemoteWkstnOID: RemoteWorkstationOID 
6. IDX_SWUHist_IsServerUsage: IsServerUsage 
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NC_TaskHistory Table (Entity) 

The NC_TaskHistory table tracks historical information about tasks. 

Column Key Type Null Description 

TaskHistoryOID PK GUID No An internal ID number used as a 
primary key. 

TaskName   Varchar(64) No The name of the task. 

TaskStatus   Short <INT2> No The status of the task: 
0=completed, 1=late canceled, 
2=late skipped, 3=killed, or 
4=failed. 

TaskPriority   Short <INT2> No The priority of the task: 0=low, 
1=medium, 2=high. 

StartTime   DateTime No The actual start time of the task. 

FinishedTime   DateTime   The actual finish or cancellation 
time of the task. 

ScheduledStartTime   DateTime   The scheduled start time. 

NCUserName   Varchar(32) No The ZENworks Asset Management 
user who submitted the task. 

TaskType   Short <INT2> No The type of task: 0=report, 
1=purge, 2=KB builder, or 
3=unloader. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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NC_TimeTable (Entity) 

The NC_TimeTable is populated by Novell and "categorizes" a particular day with a 
frequency such as month or week. 

Column Key Type Null Description 

TimeTableOID PK GUID No An internal ID number used as a 
primary key. (This also indicates a 
particular day in the format 
yyyymmdd.) 

DayInWeek   Short <INT2> No The day of the week, represented 
by 1-7, with 
1=Sunday,...7=Saturday. 

DayInMonth   Short <INT2> No The day of the month, represented 
by 1-31. 

DayInYear   Short <INT2> No The day of the year, represented 
by 1-366. 

WeekInYear   Short <INT2> No The week of the year, represented 
by 1-52. 

MonthInYear   Short <INT2> No The month of the year, 
represented by 1-12. 

Day   Char(10) No The name of the day, for example, 
Monday. 

Month   Char(10) No The name of the month, for 
example, March. 

Year   Char(4) No The year in the format yyyy. 

Quarter   Char(2)   The quarter in the format Qn. 

FiscalPeriod   Char(6)   The fiscal year in the format 
FYyyyy. 

LastDayInMonth   Short <INT2> No 1 (TRUE) if this is the last day of 
the month; else 0. 

DisplayDate   DateTime No The date formatted for reports. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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NC_WkstnChanges Table (Entity) 

The NC_WkstnChanges table tracks changes to a workstation. 

Column Key Type Null Description 

WkstnChangesOID PK GUID No An internal ID number used as a 
primary key.  

TimeTableOID FK GUID No A particular day in the format 
yyyymmdd. 

WorkstationOID FK GUID No The ID of the workstation that 
changed. 

NCUserOID FK GUID   The ZENworks Asset Management 
user who made the change. 

TypeOfChange   Short <INT2> No The type of change: 0=created, 
1=edited, 2=deleted, 3=moved, 
4=retired. 

SourceOfChange   Short <INT2> No The source of the change: 
0=Collector, 1=Collection Editor, 
2=Collection Server, 3=ZENworks 
Asset Management Manager, 
4=Task Server. 

FieldId   Numeric(5,0)   The field ID. 

FieldLabel   Varchar(50)   The field name. 

Value1   Varchar(255)   The old value that was changed. 

Value2   Varchar(255)   The new value. 

CreateDate   DateTime No The date and time the change 
occurred. 

InstanceVersion   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The TimeTableOID foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The WorkstationOID foreign key references the WorkstationOID primary key column of the NC_Workstation 

table. 
 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
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NC_WkstnProcess Table (Entity) 

The NC_WkstnProcess table tracks processes associated with a workstation. 

  

Column Key Type Null Description 

WkstnProcessOID PK GUID No An internal ID number used as a 
primary key.  

TimeTableOID FK GUID No A particular day in the format 
yyyymmdd. 

WorkstationOID FK GUID No The workstation ID. 

Collector   Short <INT2> No The name of the Collector: 
0=Win32, 1=OS/2, 2=DOS. 

CollectorVersion   Varchar(48)   The version number of the 
Collector. 

KBVersion   Varchar(48)   The version number of the KB files 
used. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The TimeTableOID foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The WorkstationOID foreign key references the WorkstationOID primary key column of the NC_Workstation 

table. 
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Administrative Tables 
The administrative tables organize data for the various ZENworks Asset Management 
applications and control their behavior. 

  

NC_EnterpriseOptions Table (Entity)  

NC_FileStore Table (Entity)  

NC_FileStoreCatalog Table (Entity)  

NC_HostInfo Table (Entity)  

NC_MsgQueue Table (Entity)  

NC_NCUser Table (Entity)  

NC_NCUserDomainRelation Table (Relationship)  

NC_NCUserFolder Table (Entity)  

NC_NCUserPreferences Table (Entity)  

NC_ProcessData Table (Entity)  

NC_PurgeTask Table (Entity)  

NC_Query Table (Entity)  

NC_Report Table (Entity)  

NC_ReportDesc Table (Entity)  

NC_ReportTask Table (Entity)  

NC_Schedule Table (Entity)  

NC_Task Table (Entity)  

NC_TaskSchedule Table (Entity)  

NC_TaskServerPrinter Table (Entity)  

NC_TIFConfiguration Table (Entity)  

NC_UDF Table (Entity)  

NC_UpdateInfo Table (Entity)  
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NC_EnterpriseOptions Table (Entity) 

The NC_EnterpriseOptions table controls how long workstation, error, and history data is 
kept in the inventory database. For more details, see Changing Enterprise Options. 

Column Key Type Null Description 

EnterpriseOptionsOID PK GUID No An internal ID number used as a 
primary key. 

HistoryDataQty   Short <INT2> No The quantity of 
HistoryDataInterval that 
determines the amount of 
workstation history data to be 
kept. 

HistoryDataInterval   Short <INT2> No The unit (for example, month) 
for keeping workstation history 
data. See "Note" below. 

ErrorDataQty   Short <INT2> No The quantity of ErrorDataInterval 
that determines the amount of 
error data to be kept. 

ErrorDataInterval   Short <INT2> No The unit (for example, month) 
for keeping error data. See 
"Note" below. 

TaskDataQty   Short <INT2> No The quantity of TaskDataInterval 
that determines the amount of 
task data to be kept. 

TaskDataInterval   Short <INT2> No The unit (for example, month) 
for keeping task data. See "Note" 
below. 

UpgradeMinutesQty   Short <INT2> No The window of time (in minutes) 
across which servers spread their 
upgrades so they are not all 
downloading files from the File 
Store and logging back onto the 
database at the same time. 

UseProxyServerForPRU   Short <INT2> No 1 (TRUE) if a proxy server should 
be used for the PRU task; else 0. 

HTTPProxyAddress   Varchar(48)   The HTTP address of the proxy 
server. 

HTTPProxyPort   Number(5,0)   The HTTP port number of the 
proxy server. 

HTTPProxyUsername   Varchar(64)   The HTTP user name for 
accessing the proxy server. 
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HTTPProxyPassword   Varchar   The HTTP password for accessing 
the proxy server. 

WebReportsURL   Varchar(256)   The URL for accessing Web 
reports on a Web server. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

PwdMinLengthReq   Bit   Initial value = 0 

PwdMinLength   TinyInt   Initial value = 0 

PwdAlphaNumeric   Bit   Initial value = 0 

PwdMixedCase   Bit   Initial value = 0 

PwdAging   Bit   Initial value = 0 

PwdAgingDays   SmallInt   Initial value = 0 

PwdNotUserName   Bit   Initial value = 0 

LockInactiveUsers   Bit   Initial value = 0 

InactiveUserDays   SmallInt   Initial value = 0 

Note 

HistoryDataInterval, ErrorDataInterval, and TaskDataInterval can have the following 
values: 0=days, 1=weeks, 2=months, or 3=years. 
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NC_FileStore Table (Entity) 

The NC_FileStore table contains information about the ZENworks Asset Management 
File Store. 

Column Key Type Null Description 

FileStoreOID PK GUID No An internal ID number used as a 
primary key. 

FileStoreType   Short <INT2> No The type of File Store:  
0=UNC-based network drives,  
1=LAN-based network drives, 
2=Anonymous FTP, or 
3=Authenticated FTP. 

ServerName   Varchar(255) No Depending on FileStoreType, the 
mapped drive or UNC name. 

PathName   Varchar(255) No The path, relative to ServerName, 
that points to the File Store. 

UserName   Varchar(32)   The user name required to log 
onto a server for permission-based 
network drives. 

Password   Varchar(64)   The password required to log onto 
a server for permission-based 
network drives. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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NC_FileStoreCatalog Table (Entity) 

The NC_FileStoreCatalog table tracks version information about files at the File Store. 

Column Key Type Null Description 

FileStoreCatalogOID PK GUID No An internal ID number used as a 
primary key. 

FileName   Varchar(255) No The name of the file stored at 
the File Store. 

FileType   Short <INT2> No The type of file stored. 
See"Notes" below. 

Platform   Short <INT2> No The platform. See "Notes" below. 

Language   Short <INT2> No The language. See "Notes" 
below. 

MajorVersion   Short <INT2>   The major version number for 
product KBs. 

MinorVersion   Short <INT2>   The minor version number for 
product KBs. 

PRU   Short <INT2>   The identification of a (PRU) 
product recognition update. 

FileStamp   DateTime No The file stamp of the file before 
it was stored. 

Build   Long <INT4>   The build number of product 
KBs. 

IsLocked   Short <INT2> No 1 (TRUE) if the File Store is 
locked; else 0. 

LockTime   DateTime No The time the file was locked. 

HostInfoOID FK GUID   The ID of the Task Server locking 
the KB file. 

Checksum   Numeric(10,0) No The checksum value used to 
verify the integrity of the file’s 
data. 

FileSize   Numeric(10,0) No The size of the file in bytes. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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Notes 

 FileType can be one of the following values: 

0 Recognition KB 
1 Collection option set 
2 Workstation auxiliary file 
3 Collection Client executable 
4 Collection Server executable 
5 Task Server executable 
6 User-defined field KB 
7 Compressed 
8 FNI data 
9 Miscellaneous KB 
 

 Platform can be one of the following values: 

0 Unknown 
1 Windows 32 
2 Windows 64 
3 Sun 
4 IBM 
5 HP 
6 Linux 
7 BSD 
8 Other 
9 Common 
10 Common Windows Only 
11 Common Unix Only 
 

 Language can be one of the following values: 

0 Unknown 
1 English 
2 French 
3 German 
4 Other 
5 Common 
 

 The HostInfoOID foreign key references the HostInfoOID primary key column of the NC_HostInfo table. 
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NC_HostInfo Table (Entity) 

The NC_HostInfo table tracks information about host processes such as a ZENworks 
Asset Management Manager or Task Server. 

Column Key Type Null Description 

HostInfoOID PK GUID No An internal ID number used as a 
primary key. 

Type   Short <INT2> No The type of host: 0=ZENworks 
Asset Management Manager, 
1=ZENworks Asset Management 
Manager SDK, 2=Task server, 
3=Collection Server. 

HostName   Varchar(255) No The DNS name or IP address of 
the host. 

MachineName   Varchar(32)   The Windows machine name of 
the host. 

Port   Numeric(5,0) No The port on which the host will 
be listening. 

CheckInInterval   Long <INT4> No The interval (in minutes) at 
which the host will update the 
LastCheckInTime. 

LastCheckInTime   DateTime No The date and time the host last 
updated its status. 

State   Short <INT2> No The state of the host: 
0=available, 1=unavailable. 

NCUserOID FK GUID   The current ZENworks Asset 
Management user. 

Status   Short <INT2> No The status of the host: 
0=enabled, 1=disabling, 
2=disabled, 3=manually disabling, 
or 4=manually disabled. 

InvProcessLockCount   Short <INT2> No 1 (TRUE) if the inventory process 
cannot be stopped; else 0. 

StartupTime   DateTime No The start-up time. 

PurgeDiagLogDays   Short <INT2> No The number of days (0 to 365) 
that diagnostic log files should be 
kept. The default is 14. 

DiagLogLevel   Short <INT2> No The diagnostic logging level: 1 = 
informational, warning, and error 
messages; 2 = warning and error 
messages; 3 = error messages. 
The default is 1. 
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EnablePersisterLogging   Short <INT2> No 1 (TRUE) if database persister 
logging is activated. 

ServerUpgradeId   GUID   The server being upgraded. 

ServerUpgradeDate   DateTime   The date of the server upgrade. 

ServerUpdateId   GUID   Unique identifier of the last 
patch. 

ServerUpdateDate   DATETIME   Release date of the last patch. 

HostIPAddressList   Varchar(128)   The IP addresses for the host 
system. 

UseHelperService   Short <INT2> No 1 (TRUE) if "helper" service 
should be used to assist 
automatically with installation 
issues; else 0. 

EnableMsgQueue   Short <INT2> No 1 (TRUE) if NC_MsgQueue is used 
to queue inter-process messages; 
else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The NCUserOID foreign key references the NCUserOID primary key column of the 
NC_NCUser table. 
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NC_MsgQueue Table (Entity) 

The NC_MsgQueue table allows ZENworks Asset Management components to 
communicate through the table instead of directly. 

Column Key Type Null Description 

MsgOID PK GUID No An internal ID number used as a 
primary key. 

MsgSequenceId   Long <INT4> No An internal message sequence 
number. 

MsgTimeStamp   DateTime   The date and time that the 
message originated. 

SourceOID   GUID No The host ID of the source of the 
message. 

DestinationOID   GUID No The host ID of the destination of 
the message. 

MsgClassOID   GUID No The type of message sent. 

VersionSignature   Short <INT2> No The message version. 

DataStream   Varbinary(255)   The contents of the message. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in 
a multi-user environment).  

 



ZENworks Asset Management User's Guide 

420 

NC_NCUser Table (Entity) 

The NC_NCUser table contains data about a ZENworks Asset Management user. See 
About ZENworks Asset Management Users for information about ZENworks Asset 
Management users. 

Column Key Type Null Description 

NCUserOID PK GUID No An internal ID number used as a 
primary key. 

NCUserName   Varchar(48) No The logon name of the user. 

Role   Short <INT2> No The user’s role. See "Notes" below. 

Password   Varchar(64) No The user’s password. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

LastPasswordChangeDate   Datetime No Initial value = Current 
date 

LastLoginDate   Datetime Yes Null 

Notes 

 NCUserName has a unique constraint named UQ_NCUser_NCUserName. 
 Role can have one of the following values:  

0 Enterprise administrator 

1 Domain administrator 

2 Enterprise assistant 

3 Domain assistant 

4 Enterprise analyst 

5 Domain analyst 

6 System process 
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NC_NCUserDomainRelation Table (Relationship) 

The NC_NCUserDomainRelation table tracks the relationship between ZENworks Asset 
Management users and Collection Domains. 

Column Key Type Null Description 

NCUserDomainRelOID PK GUID No An internal ID number used as a 
primary key. 

NCUserOID FK GUID No The ZENworks Asset Management 
user. 

CollDomainOID FK GUID No The Collection Domain. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
 The CollDomainOID foreign key references the CollDomainOID primary key column of the NC_CollDomain 

table. 
 NCUserOID + CollDomainOID has a unique constraint named UQ_NCUDRel_NCUserColDom. 

NC_NCUserFolder Table (Entity) 

The NC_NCUserFolder table contains data about user-created folders on the Query and 
Report locator tabs. 

Column Key Type Null Description 

NCUserFolderOID PK GUID No An internal ID number used as a 
primary key. 

FolderName   Varchar(48) No The name of the folder. 

FolderType   Short <INT2> No The type of folder: 0=container, 
1=query, or 2=report. 

NCUserOID FK GUID No The ZENworks Asset Management 
user to whom this folder belongs. 

ParentNCUserFolderOID FK GUID No The parent folder of this folder. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
 The ParentNCUserFolderOID foreign key references the NCUserFolderOID primary key column of the 

NC_NCUserFolder table. 
 NCUserOID + ParentNCUserFolderOID + FolderName + FolderType has a unique constraint named 

UQ_NCUserFld_FldrNames. 
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NC_NCUserPreferences Table (Entity) 

The NC_NCUserPreferences table contains ZENworks Asset Management Manager user 
preferences. See Changing User Preferences. 

Column Key Type Null Description 

NCUserPrefOID PK GUID No An internal ID number used as a 
primary key. 

NCUserOID FK GUID No The ID of the ZENworks Asset 
Management user. 

NameFormat   Short <INT2> No The order of user’s names. See 
"Notes" below. 

DeleteWarning   Short <INT2> No 1 (TRUE) if the ZENworks Asset 
Management user should be 
warned before deleting an item 
from a locator tab; else 0. 

ConfirmScanOnDemand   Short <INT2> No 1 (TRUE) if a ZENworks Asset 
Management user is given a 
confirming message after 
workstations are scanned on 
demand; else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 NameFormat can have one of the following values: 

0 First, middle, last 

1 Last, first, middle 

2 First, last 

3 Last, first 

 

 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
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NC_ProcessData Table (Entity) 

The NC_ProcessData table tracks the state of the inventory process and task queue. 

Column Key Type Null Description 

ProcessDataOID PK GUID No An internal ID number used as a 
primary key. 

ManagerLoginState  Short <INT2> No 1 (TRUE) if users cannot log onto 
ZENworks Asset Management 
Manager because the inventory 
system is shut down; else 0. 

InventoryProcessState  Short <INT2> No Current state of the inventory 
process: 0=Enabling, 1=Enabled 
and active, 2=Disabling, 
3=Disabled and inactive. 

TaskQueueState  Short <INT2> No Current state of the task queue: 
0=Enabling, 1=Enabled and active, 
2=Disabling, 3=Disabled and 
inactive. 

ProductMergeState  Short <INT2> No 0 if a product merge is not 
required the next time the 
inventory process is started; 1 if a 
merge is required. 

InstanceVer  Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes: 

1. ManagerLoginState: 0=Enabled, 1=Disabled 
2. InventoryProcessState: 0=Enabling, 1=Enabled, 2=Disabling, 3=Disabled 
3. TaskQueueState: 0=Enabling, 1=Enabled, 2=Disabling, 3=Disabled 
4. ProductMergeState: 0=Not Required, 1=Required 
5. WebDefinitionBuildState: 0=Not Required, 1=Required, 2=Build in Progress 
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NC_PurgeTask Table (Entity) 

The NC_PurgeTask table contains data about a purge task. See Purging the Database for 
details of purges. 

Column Key Type Null Description 

TaskOID PK, FK GUID No An internal ID number used as a 
primary key. 

WorkstationHistory   Short <INT2> No 1 (TRUE) if workstation history is 
to be purged; else 0. 

TaskHistory   Short <INT2> No 1 (TRUE) if task history is to be 
purged; else 0. 

ErrorData   Short <INT2> No 1 (TRUE) if error data is to be 
purged; else 0. 

Note 

The TaskOID foreign key references the TaskOID primary key column of the NC_Task 
table. 

NC_Query Table (Entity) 

The NC_Query table includes details of queries. See About Queries for details. 

Column Key Type Null Description 

QueryOID PK GUID No An internal ID number used as a 
primary key. 

QueryName   Varchar(48) No The name of the query. 

Target   Numeric(5,0) No The type of query, for example, 
workstation or product. 

SelectionListString   Text   The ordered list of columns. 

FilterListString   Text   The filter criteria. 

SortOrderString   Text   The sort order for columns. 

NCUserOID FK GUID No The ZENworks Asset Management 
user whose query this is. 

NCUserFolderOID FK GUID No The folder in which the query 
resides. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 
 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
 The NCUserFolderOID foreign key references the NCUserFolderOID primary key column of the 

NC_NCUserFolder table. 
 NCUserOID + QueryName has a unique constraint named UQ_Qry_QryNames. 
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NC_Report Table (Entity) 

The NC_Report table contains data about the report being generated. For details, see 
About Reports. 

Column Key Type Null Description 

ReportOID PK GUID No An internal ID number used as a 
primary key. 

Title   Varchar(64) No The title of the report. 

ReportName   Varchar(64) No The name of the report, as it is 
displayed on the Report locator 
tab. 

IsQueued   Short <INT2> No 1 (TRUE) if the report is queued; 
else 0. 

ReportDescOID FK GUID No The associated report 
description. 

OriginalTitle   Long <INT4> No The original report title as 
shipped by Novell. 

Format   Short <INT2> No The report format selected by 
the user: 0=tabular, 1=bar graph, 
2=pie chart, 3=line graph. 

SubTitle   Varchar(64)   The report subtitle. 

Description   Varchar(255)   The description of the report. 

TopNValue   Short <INT2>   The "n" for top(n) reports. 

HistStartDate FK GUID   The start date for a history 
report. 

HistEndDate FK GUID   The end date for a history 
report. 

TrendFrequency   Short <INT2> No The frequency for a trend 
report: 0=daily, 1=weekly, 
2=monthly, 3=quarterly, 
4=yearly. 

TrendBeginDate FK GUID   The beginning date for a trend 
report. 

TrendColsToDisplay   Short <INT2>   The number of values to display 
within the frequency of a trend 
report. 

DemogGroups   Text   A comma-separated list of 
demographic field IDs for first 
level report groupings. The user 
can select up to three. 
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PageBreakField   Numeric(5,0)   The field that should start a new 
page. 

DispProdGroups   Short <INT2>   1 (TRUE) if the user specified 
grouping by product fields; else 
0. 

CountByField   Numeric(5,0)   The field by which the user 
wants to count (breakdown 
reports) or group (history 
reports). 

SortByFields   Text   A comma-separated list of field 
IDs to control sorting. The user 
can choose up to five fields. 

FilterName   Varchar(48)   The name of the filter criteria. 

FilterCriteria   Text   The filter criteria. 

ReportDestination   Short <INT2> No The destination of the report: 
0=screen, 1=printer, 2=web. 

NCUserFolderOID FK GUID No The folder in which the report 
resides. 

NCUserOID FK GUID No The ZENworks Asset Management 
user who is generating the 
report. 

IsHeaderDisplayed   Short <INT2> No 1 (TRUE) if report header page is 
to be included; else 0. 

IsCompanyLogoDisplayed   Short <INT2> No 1 (TRUE) if Novell logo is to be 
included; else 0. 

IsRptTitleDisplayed   Short <INT2> No 1 (TRUE) if the report title is to 
be included; else 0. 

IsRptDescDisplayed   Short <INT2> No 1 (TRUE) if the report 
description is to be included; 
else 0. 

IsDateCreatedDisplayed   Short <INT2> No 1 (TRUE) if the creation date is 
to be included; else 0. 

IsRptFormatDisplayed   Short <INT2> No 1 (TRUE) if the report format is 
to be included; else 0. 

IsGrpbyNamesDisplayed   Short <INT2> No 1 (TRUE) if data about field 
grouping is to be included; else 
0. 

IsSortbyNamesDisplayed   Short <INT2> No 1 (TRUE) if data about sort fields 
is to be included; else 0. 

IsFilterbyNamesDisplayed   Short <INT2> No 1 (TRUE) if data about filter 
fields is to be included; else 0. 
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IsNCUserNameDisplayed   Short <INT2> No 1 (TRUE) if the ZENworks Asset 
Management user’s name is to be 
included; else 0. 

IsFooterDisplayed   Short <INT2> No 1 (TRUE) if the footer page is to 
be included; else 0. 

IsTemporary   Short <INT2> No 1 (TRUE) if this is a temporary 
copy of the report; else 0. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Notes 

 The ReportDescOID foreign key references the ReportDescOID primary key column of the NC_ReportDesc 
table. 

 The HistStartDate foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The HistEndDate foreign key references the TimeTableOID primary key column of the NC_TimeTable table. 
 The TrendBeginDate foreign key references the TimeTableOID primary key column of the NC_TimeTable 

table. 
 The NCUserFolderOID foreign key references the NCUserFolderOID primary key column of the 

NC_NCUserFolder table. 
 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
 NCUserOID + ReportName + IsTemporary has a unique constraint named UQ_Rpt_RptNames. 

NC_ReportDesc Table (Entity) 

The NC_ReportDesc table contains data about a particular type of report. 

Column Key Type Null Description 

ReportDescOID PK GUID No An internal ID number used as a 
primary key. 

RptType   Short <INT2> No The type of the report: 
0=workstation, 1=component, 
2=product, 3=FNI, or 
4=Workstation User. 

RptCategory   Short <INT2> No The category of the report. See 
"Note" below. 

ViewName   Varchar(64) No The name of the view used by the 
report template. 

TemplateName   Varchar(32) No The name of the Crystal Reports 
template file. 

Formats   Short <INT2> No The report formats supported by 
this report: tabular, bar graph, 
pie chart, and/or line graph. 

HasSubReports   Short <INT2> No If 1 (TRUE), then the report has 
subreports; else 0. 
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DemogGroups   Text   A comma-separated list of 
demographic field IDs for first 
level report groupings. The user 
can select up to three. 

ProdGroups   Text   A comma-separated list of 
product field IDs for second level 
report groupings. 

CountByFields   Text   A comma-separated list of field 
IDs for third level report 
groupings or for counting. The 
user can choose one field. 

SortByFields   Text   A comma-separated list of field 
IDs to control sorting. The user 
can choose up to five fields. 

FilterOnFields   Text   The fields that control filtering. 

StaticFilterCriteria   Text   A list of filters that the user 
cannot modify. 

ColumnDetailFields   Text   The order in which column 
headers will appear in the report. 

SubReportIds   Varchar(128)   Links to subreports that make up 
sections of the report. 

TargetClassId   Short <INT2>   Used internally to determine the 
type of query the report uses. 

SubQueryChoices   Text   Subqueries used internally. 

ResourceStringIds   Text   Used internally to determine the 
column headers the report uses. 

TemplateName   Varchar(128)   The name of the template being 
imported. 

TemplateLocation   Varchar(255) No The location of the report 
template when it was selected for 
import. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

RptCategory can be one of the following values: 

0 Catalog 
1 Breakdown 
2 Trend 
3 History 
4 Detail 
5 Upgrade 
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NC_ReportTask Table (Entity) 

The NC_ReportTask table includes data about a report task. See Running a Report. 

Column Key Type Null Description 

TaskOID PK, FK GUID No An internal ID number used as a 
primary key. 

ReportOID FK GUID No The report being run. 

Destination   Short <INT2> No The destination of the report: 
0=screen, 1=printer, 2=Web. 

NumberOfCopies   Numeric(5,0)   The number of copies to be 
printed. 

ExportFilePath   Varchar(255)   The path to the export file. 

ExportFile   Varchar(255)   The name of the export file. 

ExportFormat   Short <INT2> No The export format to be used. 
See "Notes" below. 

WebPublishLocation   Varchar(255)   Where the report will be 
published on the web. 

TargetPrinter   Varchar(255)   The target printer for print-only 
tasks. 

Notes 

 The TaskOID foreign key references the TaskOID primary key column of the NC_Task table. 
 The ReportOID foreign key references the ReportOID primary key column of the NC_Report table. 
 ExportFormat can be one of the following values: 

0 CSV (comma-separated values) 

1 HTML3 

2 Microsoft HTML 

3 Netscape HTML 
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NC_Schedule Table (Entity) 

The NC_Schedule table contains schedule details for collection schedules and task 
schedules. 

Column Key Type Null Description 

ScheduleOID PK GUID No An internal ID number used as a 
primary key. 

CycleIntervalPattern   Short <INT2> No The interval at which the cycle 
repeats itself. See "Notes" below. 

CycleBeginDate   DateTime   The starting date of the schedule. 

CycleEndDate   DateTime   The ending date of the schedule. 

IsCyclePerpetual   Short <INT2> No 1 (TRUE) if no ending date exists; 
else 0. 

RepeatCycleType   Short <INT2> No When the cycle should be 
repeated. See "Notes" below. 

OrdinalType   Short <INT2> No The ordinal that specifies the 
weekday of the month: 0=first, 1-
second, 2=third, 3=fourth, 4=last. 

DayNumber   Short <INT2>   The day number in a month (1 - 
31). 

Frequency   Short <INT2>   How often the schedule repeats 
itself. 

DayOfWeek   Long <INT4>   The day the schedule repeats 
itself. 

MonthType   Short <INT2> No The month with 0=January, 
1=February..., 11=December. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 
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Notes 

 CycleIntervalPattern can have one of the following values: 

0 Yearly 

1 By the month 

2 By the week 

3 By the day 

4 Hourly 

5 Once 

6 Immediately 

 

 RepeatCycleType can have one of the following values: 

0 Once (or not specified) 

1 Day of month 

2 Week and day of month 

3 Weekly 

4 Daily 

5 On interval 
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NC_Task Table (Entity) 

The NC_Task table contains information about tasks. 

Column Key Type Null Description 

TaskOID PK GUID No An internal ID number used as a 
primary key.  

TaskName   Varchar(64) No The name of the task. 

TaskType   Short <INT2> No The type of the task: 0=report, 
1=purge, 2=KB builder, 
3=unloader. 

StartTime   DateTime   The scheduled start time of the 
task. 

LatestStartTime   DateTime   The latest start time of the 
task. 

ActualStartTime   DateTime   The actual task start time. 

TaskState   Short <INT2> No The state of the task: 
0=running, 1=waiting, 
2=paused. 

HostInfoOID FK GUID   The host for the task. 

TaskPriority   Short <INT2> No The priority of the task: 0=low, 
1=medium, 2=high. 

TaskScheduleOID FK GUID   The task schedule. 

NCUserOID FK GUID No The ZENworks Asset 
Management user who 
submitted the task. 

TargetCollDomainOID FK GUID   Task execution is restricted to 
the Task Servers in this 
Collection Domain. 

TargetTaskServerOID FK GUID   The Task Server for the task. 

TaskProgress   Varchar(40)   The progress of the task. 

SendLogsOnError   SHORT<INT2> N TRUE(1)=Send log files to Novell 
if an error occurred (PRU and 
LiveUpdate tasks only) 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in 
a multi-user environment). 

Notes 

 The HostInfoOID foreign key references the HostInfoOID primary key column of the NC_HostInfo table. 
 The TaskScheduleOID foreign key references the TaskScheduleOID primary key column of the 

NC_TaskSchedule table. 
 The NCUserOID foreign key references the NCUserOID primary key column of the NC_NCUser table. 
 The TargetCollDomainOID foreign key references the CollDomainOID primary key column of the 

NC_CollDomain table. 
 The TargetTaskServerOID foreign key references the TaskServerOID primary key column of the NC_TaskServer 

table. 
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NC_TaskSchedule Table (Entity) 

The NC_TaskSchedule table includes data about a task’s schedule. 

Column Key Type Null Description 

TaskScheduleOID PK GUID No An internal ID number used as a 
primary key.  

OptionStartTime   DateTime   The start time of the task. 

OptionPriority   Short <INT2> No The priority of the task: 0=high, 
1=normal, 2=low. 

LateTaskMinutes   Short <INT2>   The number of minutes before a 
task is considered late. 

LateTaskOption   Short <INT2> No What should happen to a task if it 
is late: 0=run anyway, 1=skip, or 
2=cancel. 

ScheduleOID FK GUID No The schedule of the task. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The ScheduleOID foreign key references the ScheduleOID primary key column of the 
NC_Schedule table. 

NC_TaskServerPrinter Table (Entity) 

The NC_TaskServerPrinter table contains information about all the printers available to 
Task Servers. 

Column Key Type Null Description 

TaskServerPrinterOID PK GUID No An internal ID number used as a 
primary key. 

TaskServerOID FK GUID No The host’s ID. 

PrinterName   Varchar(255) No The printer name. 

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

Note 

The TaskServerOID foreign key references the TaskServerOID primary key column of 
the NC_TaskServer table. 
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NC_TIFConfiguration Table (Entity) 

The NC_TIFConfiguration table includes data about integration with TS.Webport. 

Column Key Type Null Description 

TIFConfigOID PK GUID No An internal ID number used as a 
primary key.  

HostName   Varchar(48)   The workstation name or IP 
address of the TS.Webport 
monitor system. 

RegisteredName   Varchar(64)   The name of the token returned 
by the TS.Webport monitor during 
registration.  

InstanceVer   Long <INT4> No The instance version (used 
internally to control changes in a 
multi-user environment). 

NC_UDF Table (Entity) 

The NC_UDF table contains data about user-defined fields. For more details, see About 
User-Defined Fields. 

Column Key Type Null Description 

FieldDispDescOID PK, FK GUID No An internal ID number used as a 
primary key.  

ClassID   Numeric(5,0) No The ID of the field’s parent class. 

ColumnName   Varchar(24) No The database column name. 

DataType   Short <INT2> No The type of data in the field: 
0=character, 1=integer, 
2=decimal, 3=date. 

Notes 

 The FieldDispDescOID foreign key references the FieldDispDescOID primary key column of the 
NC_FieldDispDesc table. 

 ClassID + ColumnName has a unique constraint named UQ_UDF_ClassIDColName. 
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NC_UpdateInfo Table (Entity) 

This table stores information about ZENworks Asset Management software updates. 

  

Column Key Type Null Description 

UpdateInfoOID PK GUID   internal ID number used as 
primary key 

UpdateDate   DATETIME     

DateApplied   DATETIME     

Version   VARCHAR(20)     

PatchLevel   VARCHAR(8)     

Type   SHORT<INT2>     

InstanceVer   LONG<INT4>   Instance Version 

 



ZENworks Asset Management User's Guide 

436 

Collection Editor Toolbar and Menus 

For information about the Collection Editor, see About the Collection Editor. 

Collection Editor Toolbar 
The Collection Editor toolbar gives you access to frequently-performed activities. You 
can hide the toolbar altogether by clicking on the View menu and clicking on Toolbar. To 
display it, you would use the same command again. 

  

The buttons on the Collection Editor toolbar are as follows:  

Button Description 

  
Saves the changes you have made and exits the 
Collection Editor. 

  

Saves the changes you have made. 

  

Removes data from a field and copies it to the 
clipboard. 

  

Copies data to the clipboard. 

  

Pastes data from the clipboard to the current 
field. 

  

Lets you provide a password so you can use the 
Collection Editor without restrictions or reverts 
to any restrictions established with ZENworks 
Asset Management Manager.  

  

Lets you add a component to the workstation. 

  

Lets you change a component. 

  

Removes a component that you previously 
added. (You cannot delete a component that the 
Collector identified.) 

  

Lets you look for a particular product while 
adding a component. 

  

Gives you access to the Collection Editor Help 
system. 
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Collection Editor Menus 
The Collection Editor includes five menus. Some commands are available only in a 
certain context. If unavailable, they will appear in gray instead of black. 

  

File Menu 

The File menu lets you save changes you have made, use the Collection Editor without 
restrictions, discard changes you have made, and exit the Collection Editor. 

Command Description 

Save Saves the changes you have made. 

Save and Exit Saves the changes you have made and 
exits the Collection Editor. 

Grant 
Permissions/Remove 
Permissions 

Lets you use the Collection Editor without 
restrictions by providing a password or 
reverts to any restrictions established with 
ZENworks Asset Management Manager.  

Reset to Scan Discards any data you have entered or 
changed with the Collection Editor in 
certain component fields on the Inventory 
tab over any number of sessions. Any data 
in these fields reverts back to the data 
obtained by the Collector. 

Reload Discards any changes you made with the 
Collection Editor during the current 
session and reverts back to the data as it 
was before you started editing. (Any edits 
you made during previous Collection 
Editor sessions will be unaffected.) 

Exit Closes the Collection Editor. 
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Edit Menu 
The Edit menu includes standard editing commands for cutting, copying, and pasting. 

Command Description 

Cut Removes data from a field and copies it to the 
clipboard. 

Copy Copies data from a field to the clipboard. 

Paste Pastes data from the clipboard to the current field. 

Component Menu 
The Component menu lets you add, edit, and delete components as well as browse for 
products while adding components. 

Command Description 

Add Lets you add a new component to the 
workstation. 

Edit Lets you change a component. 

Delete Removes a component that you previously 
added. (You cannot delete a component that the 
Collector identified.) 

Browse Product While adding a component, lets you look for a 
particular product. 

View Menu 
The View menu lets you control the appearance and contents of the Collection Editor 
window. 

Command Description 

Inventory Tab Displays the Inventory tab. 

Workstation Tab Displays the Workstation tab. 

User Tab Displays the User tab. 

Process Tab Displays the Process tab. 

Toolbar Hides or displays the toolbar. 

Status Bar Hides or displays the status bar. 
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Help Menu 

The Help menu gives you access to the Collection Editor Help system. 

Command Description 

Search for Help on Displays the Contents, Index, and Find 
tabs so you can locate the Help topic you 
need. 

How to Use Help Displays information about using the Help 
system. 

About Collection Editor Displays general information about the 
Collection Editor. 
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ZENworks Asset Management Product Type, Category, and 
Subcategory Reference 

The list that follows contains all the Product Types that Novell includes with ZENworks 
Asset Management. Where a type contains many categories, the catetgories are listed as 
well. Click to view a table of subcategories for each type or category. 

Tip 

You can also define your own categories and subcategories as described Re-classifying Products. 

Product Types (and Categories) 
BIOS  
Bus Adapter  
CD/DVD Drive  
CPU  
Diskette Drive  
DMI  
Docking Station  
Hard Drive  
Hot Fix  
Keyboard  
LAN Adapter  
Logical Drive  
Memory Module Socket  
Modem  
Monitor  
Mouse  
Network Driver  
Operating System  
Other  

Boards  
Comm Hardware  
I/O  
Mass Storage  
Other Hardware  
Security  
Server  
Year2000  

Parallel Port  
Printer  
Removable Media Drive  
Serial Port  
Software  

Accounting  
Administration  
Asset Mgmt  
CAD  
CASE  
Comm Software  
Database  
Expert Systems  
Financial  
Games  
Graphics  
Industry Spec  
Integrated  
Internet  
Language  
Library Sub  
Mathematical  
Multimedia  
Network  
Op System  
Other Software  
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Project Mgmt  
Publishing  
Server SW  
Software Devel  
Spreadsheet  
Statistical  
Suite  
Suspicious  
Text Editor  
Utility  
Word Processor  
Year2000  

Sound Card  
System  
System Board  
USB Port  
Video Adapter  
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Usage Logs 

When monitoring usage, usage log files are created on each scanned machine each day. 
By default, these files are in an encoded format. They can also be output as a plain text 
file. Contact a Novell Technology Specialist for more information.
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ZENworks Asset Management .MIF File Formats 

This section provides information about the data found in the .MIF files produced by 
ZENworks Asset Management for Microsoft’s Systems Management Server (SMS).  

If you are translating inventory data so that it can be incorporated into Microsoft’s 
Systems Management Server (SMS), ZENworks Asset Management creates four .MIF 
files. The tables these topics show the group identification and attribute definitions for 
each type of data found in these .MIF files. Use this information if you need to work with 
the data directly. 

 SWCensus.MIF - contains software data. 
 HWCensus.MIF - contains hardware data. 
 CNCensus.MIF (optional) - contains contact data. 
 FNCensus.MIF (optional) - contains files-not-identified (FNI) data. 

The attributes appear in the .MIF files in the same order as they appear in the tables. 

For more 

For information about translating data to SMS, see Changing General Options. 
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SWCensus.MIF 
The SWCensus.MIF file contains data about the software on a workstation. 

  

Operating System Group Identification 
Operating System Attributes  

Software Data Group Identification 
Software Data Attributes  

Hot Fix Data Group Identification 
Hot Fix Data Attributes  

Operating System Group Identification 

Group Name TS.Census-OS 

ID 401 

Operating System Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Version 103   Specific String (25) 

Build 104   Specific String (8) 

Service Pack 105   Specific String (8) 

Boot Drive 106   Specific String (1) 

WorkstationOID 107   Specific String (38) 

 



References 

445 

Software Data Group Identification 

Group Name TS.Census-Software 

ID 402 

Software Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Version 103 Yes Specific String (25) 

Serial Number 104   Specific String (38) 

Path 105 Yes Specific String (255) 

Asset Tag 106   Specific String (38) 

Additional Info 109   Specific String (100) 

WorkstationOID 110   Specific String (38) 

Hot Fix Data Group Identification 

Group Name TS.Census-Hot Fixes 

ID 403 

Hot Fix Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102   Specific String (45) 

Version 103 Yes Specific String (25) 

Registry Key 104   Specific String (256) 

Description 105   Specific String (128) 

Date Installed 106   Specific String (20) 

WorkstationOID 107   Specific String (38) 
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HWCensus.MIF 
HWCensus.MIF 

The HWCensus.MIF file contains data about the hardware on a workstation. The 
following tables describe the hardware data contained in the file. 

HWCensus.MIF 

BIOS Data Group Identification 
BIOS Data Attributes  

CD-ROM Data Group Identification 
CD-ROM Data Attributes  

CPU Data Group Identification 
CPU Data Attributes  

DMI Data Group Identification 
DMI Data Attributes  

Disk Data Group Identification 
Disk Data Attributes  

Docking Station Data Group Identification 
Docking Station Data Attributes  

Floppy Data Group Identification 
Floppy Data Attributes  

Keyboard Data Group Identification 
Keyboard Data Attributes  

LAN Adapter Data Group Identification 
LAN Adapter Data Attributes  

Logical Drive Data Group Identification 
Logical Drive Data Attributes  

Memory Module Data Group Identification 
Memory Module Data Attributes0  

Modem Data Group Identification 
Modem Data Attributes0  

Monitor Data Group Identification 
Monitor Data Attributes  

Mouse Data Group Identification 
Mouse Data Attributes  

Network Drivers Data Group Identification 
Network Drivers Data Attributes  

Other Data Group Identification 
Other Data Attributes  

Parallel Port Data Group Identification 
Parallel Data Attributes  

Printer Data Group Identification 
Printer Data Attributes  

Removable Media Data Group Identification 
Removable Media Data Attributes  
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SCSI Adapter Data Group Identification 
SCSI Data Attributes  

Serial Port Data Group Identification 
Serial Port Data Attributes  

Server Data Group Identification 
Server Data Attributes  

Sound Card Data Group Identification 
Sound Card Data Attributes  

System Data Group Identification 
System Data Attributes  

System Board Data Group Identification 
System Board Data Attributes  

USB Data Group Identification 
USB Data Attributes  

Video Adapter Data Group Identification 
Video Adapter Data Attributes  

Workstation Data Group Identification 
Workstation Data Attributes  
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BIOS Data Group Identification 

Group Name TS.Census-BIOS 

ID 301 

BIOS Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

BIOS Version 105   Specific String (64) 

Release Date 106 Yes Specific String (9) 

DMI Version 107   Specific String (6) 

APM Support 108   Common String (5) 

ACPI Compatible 109   Common String (5) 

Family Code 110   Specific String (32) 

WorkstationOID 111   Specific String (38) 

CD-ROM Data Group Identification 

Group Name TS.Census-CDROM 

ID 302 

CD-ROM Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Interface Type 105   Specific String (25) 

WorkstationOID 106   Specific String (38) 
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CPU Data Group Identification 

Group Name TS.Census-CPU 

ID 303 

CPU Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Speed 105   Common Integer 

Speed Units 106   Common String (3) 

Vendor ID 107   Specific String (12) 

Type 108   Specific Integer 

Family 109   Specific Integer 

CPU Model 110   Specific Integer 

Stepping 111   Specific Integer 

MMX 112   Common Integer 

L1 Cache Size 113   Specific Integer 

L1 Cache Size Units 114   Common String (3) 

WorkstationOID 115   Specific String (38) 
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DMI Data Group Identification 

Group Name TS.Census-DMI 

ID 304 

DMI Data Attributes 

Name ID Key Storage Type 

DMI Manufacturer 101 Yes Specific String (64) 

DMI Product 102 Yes Specific String (64) 

DMI Version 103 Yes Specific String (64) 

Serial Number 104   Specific String (64) 

Installation Date 105   Specific String (20) 

WorkstationOID 106   Specific String (38) 

Disk Data Group Identification 

Group Name TS.Census-Disk 

ID 305 

Disk Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Drive Number 105 Yes Specific Integer 

SMART Warning 106   Common String (5) 

Logical Drives 107   Specific String (32) 

Total Space 108   Specific String (15) 

Total Space Units 109   Common String (2) 

Interface Type 110   Specific String (25) 

WorkstationOID 111   Specific String (38) 
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Docking Station Data Group Identification 

Group Name TS.Census-Docking Station 

ID 327 

Docking Station Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

WorkstationOID 105   Specific String (38) 

 

Floppy Data Group Identification 

Group Name TS.Census-Floppy 

ID 306 

Floppy Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Drive Letter 105 Yes Specific String (1) 

Capacity 106   Specific String (15) 

Capacity Units 107   Common String (2) 

WorkstationOID 108   Specific String (38) 
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Keyboard Data Group Identification 

Group Name TS.Census-Keyboard 

ID 307 

Keyboard Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Interface Type 105   Specific String (25) 

WorkstationOID 106   Specific String (38) 

LAN Adapter Data Group Identification 

Group Name TS.Census-LAN Adapter 

ID 308 

LAN Adapter Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

LAN Address 105 Yes Specific String (12) 

IP Address 106 Yes Specific String (15) 

Subnet Mask 107   Specific String (15) 

WorkstationOID 108   Specific String (38) 
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Logical Drive Data Group Identification 

Group Name TS.Census-Logical Drive 

ID 309 

Logical Drive Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Drive Letter 105 Yes Specific String (1) 

Available Space 106   Specific String (15) 

Available Space Units 107   Common String (2) 

Total Space 108   Specific String (15) 

Total Space Units 109   Common String (2) 

File System Type 110   Specific String (25) 

Volume Label 111   Specific String (64) 

Volume Serial Number 112   Specific String (32) 

Remote 113   Common String (5) 

UNC Path 114   Specific String (100) 

WorkstationOID 115   Specific String (38) 
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Memory Module Data Group Identification 

Group Name TS.Census-Memory Module 

ID 310 

Memory Module Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Type 105   Specific String (25) 

Size 106   Specific Integer 

Size Units 107   Common String (2) 

Speed 108   Specific Integer 

Speed Units 109   Common String (2) 

Socket Designator 110 Yes Specific String (24) 

Form Factor 111   Specific String (25) 

Parity 112   Common String (5) 

ECC 113   Common String (5) 

WorkstationOID 114   Specific String (38) 
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Modem Data Group Identification 

Group Name TS.Census-Modem 

ID 311 

Modem Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Speed 105   Specific Integer 

Speed Units 106   Common String (3) 

COM Port 107 Yes Common String (4) 

Device Type 108   Common String (25) 

WorkstationOID 109   Specific String (38) 
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Monitor Data Group Identification 

Group Name TS.Census-Monitor 

ID 312 

Monitor Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

EISA Manufacturer 105 Yes Specific String (64) 

VESA Product 106 Yes Specific String (64) 

Year Manufactured 107   Specific Integer 

Week Manufactured 108   Specific Integer 

Diagonal Size 109   Specific String (15) 

Diagonal Size Units 110   Common String (2) 

WorkstationOID 111   Specific String (38) 

Mouse Data Group Identification 

Group Name TS.Census-Mouse 

ID 313 

Mouse Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Interface Type 105   Specific String (25) 

WorkstationOID 106   Specific String (38) 
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Network Drivers Data Group Identification 

Group Name TS.Census-Network Driver 

ID 314 

Network Drivers Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

File Version 105   Specific String (32) 

File Name 106 Yes Specific String (16) 

Description 107   Specific String (80) 

WorkstationOID 108   Specific String (38) 

Other Data Group Identification 

Group Name TS.Census-Other 

ID 315 

Other Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

WorkstationOID 105   Specific String (38) 
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Parallel Port Data Group Identification 

Group Name TS.Census-Parallel Port 

ID 316 

Parallel Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Logical name 105 Yes Specific String (64) 

EPP 106   Common String (5) 

ECP 107   Common String (5) 

WorkstationOID 108   Specific String (38) 

Printer Data Group Identification 

Group Name TS.Census-Printer 

ID 317 

Printer Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Remote 105   Common String (5) 

UNC Path 106 Yes Specific String (255) 

Port 107 Yes Common String (4) 

Windows Name 108   Specific String (64) 

Driver Name 109   Specific String (64) 

WorkstationOID 110   Specific String (38) 

 



References 

459 

Removable Media Data Group Identification 

Group Name TS.Census-Removable Media 

ID 318 

Removable Media Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Interface Type 105   Specific String (25) 

WorkstationOID 106   Specific String (38) 

SCSI Adapter Data Group Identification 

Group Name TS.Census-SCSI Adapter 

ID 319 

SCSI Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

WorkstationOID 105   Specific String (38) 
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Serial Port Data Group Identification 

Group Name TS.Census-Serial Port 

ID 320 

Serial Port Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Logical Name 105 Yes Specific String (4) 

WorkstationOID 106   Specific String (38) 

Server Data Group Identification 

Group Name TS.Census-Server Data 

ID 321 

Server Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Server Name 105 Yes Specific String (255) 

Server NOS 106   Specific String (32) 

WorkstationOID 107   Specific String (38) 
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Sound Card Data Group Identification 

Group Name TS.Census-Sound Card 

ID 322 

Sound Card Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

WorkstationOID 105   Specific String (38) 

System Data Group Identification 

Group Name TS.Census-System 

ID 323 

System Data Attributes 

Name ID Key Storage Type 

Manufacturer 101   Specific String (35) 

Product 102   Specific String (45) 

Model 103   Specific String (25) 

Serial Number 104   Specific String (50) 

Chassis Type 105   Specific String (25) 

Thermal State 106   Specific String (25) 

Data Covered Removed 107   Specific String (10) 

Time Covered Removed 108   Specific String (5) 

Asset Tag 109   Specific String (38) 

WorkstationOID 110   Specific String (38) 
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System Board Data Group Identification 

Group Name TS.Census-System Board 

ID 324 

System Board Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Revision 105   Specific String (32) 

Bus 1 Type 106   Specific String (25) 

Number 1 Bus Slots 107   Specific Integer 

Bus 2 Type 108   Specific String (25) 

Number Bus 2 Slots 109   Specific Integer 

L2 Cache Size 110   Specific Integer 

L2 Cache Size Units 111   Specific String (2) 

L2 Cache Speed 112   Specific Integer 

L2 Cache Speed Units 113   Common String (2) 

Cache Write Policy 114   Specific String (25) 

System Board ID 115   Specific String (64) 

WorkstationOID 116   Specific String (38) 
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Video Adapter Data Group Identification 

Group Name TS.Census-Video Adapter 

ID 325 

Video Adapter Data Attributes 

Name ID Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

Min Refresh Rate 105   Specific Integer 

Max Refresh Rate 106   Specific Integer 

Refresh Rate Units 107   Common String (2) 

Memory Type 108   Specific Integer 

Memory Size 109   Specific Integer 

Memory Size Units 110   Common String (2) 

Min Vertical Resolution 111   Specific Integer 

Max Vertical Resolution 112   Specific Integer 

Min Horizontal Resolution 113   Specific Integer 

Max Horizontal Resolution 114   Specific Integer 

Bits Per Pixel 115   Specific Integer 

WorkstationOID 116   Specific String (38) 
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USB Data Group Identification 

Group Name TS.Census-USB Port 

ID 328 

USB Data Attributes 

Name ID  Key Storage Type 

Manufacturer 101 Yes Specific String (35) 

Product 102 Yes Specific String (45) 

Model 103 Yes Specific String (25) 

Serial Number 104   Specific String (50) 

WorkstationOID 105   Specific String (38) 

Workstation Data Group Identification 

Group Name TS.Census-Workstation 

ID 326 

Workstation Data Attributes 

Name ID Key Storage Type 

Total Memory 101   Specific Integer 

Total Memory Units 102   Common String (2) 

Total Hard Disk Space 103   Specific String (15) 

Total Hard Disk Space Units 104   Common String (2) 

Total Free Hard Disk Space 105   Specific String (15) 

Total Free Hard Disk Space 
Units 

106   Common String (2) 

Workstation OID 107   Specific String (38) 
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CNCensus.MIF 

The CNCensus.MIF file contains contact data for a workstation. 

Contact/User Data Group Identification 
Group Name TS.Census-User 

ID 601 

Contact/User Data Attributes 
Name ID Key Storage Type 

Last Name 101   Specific String (32) 

First Name 102   Specific String (32) 

Middle Name 103   Specific String (32) 

Phone 104   Specific String (32) 

Phone2 105   Specific String (32) 

Email 106   Specific String (32) 

FAX 107   Specific String (32) 

LAN Address 108   Specific String (12) 

IP Address 109   Specific String (15) 

Site 110   Specific String (32) 

Department 111   Specific String (32) 

Cost Center 112   Specific String (32) 

Building 113   Specific String (32) 

Floor 114   Specific String (10) 

Room 115   Specific String (32) 

Date Scanned 116   Specific MIF Date 

WorkstationOID 117   Specific String (38) 

Note: The MIF Date format is YYYYMMDDHHMMSS.000000+000. 
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FNCensus.MIF 

The FNCensus.MIF file contains files-not-identified (FNI) data. This identifies program 
files that the Collector could not associate with any software product in the ZENworks 
Asset Management inventory database. 

FNI Data Group Identification 
Group Name TS.Census-FNI 

ID 501 

FNI Data Attributes 
Name ID Key Storage Type 

Path 101 Yes Specific String (255) 

File Name 102 Yes Specific String (64) 

File Extension 103 Yes Specific String (32) 

File Size 104   Specific Integer 

File Date 105   Specific String (10) 

File Time 106   Specific String (8) 

Company Name 107   Specific String (64) 

Product Name 108   Specific String (80) 

Product Version 109   Specific String (32) 

Language 110   Specific String (16) 

File Version 111   Specific String (32) 

File Scan Category 112   Common String(9) 

WorkstationOID 113   Specific String (38) 
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Dialog Reference 

About Domain Windows 
In a Domain window you can create or edit a Collection Domain. When you do so, you 
can assign different types of collection option sets and ZENworks Asset Management 
users to it. By default, ZENworks Asset Management assigns the default option set to a 
domain, but you can change this assignment. In addition, when you create a domain, only 
enterprise-level ZENworks Asset Management users have the right to work with it. To 
give other ZENworks Asset Management users the right to work with the domain (as 
domain administrators, assistants, or analysts), you must assign them to the domain. 

Only an enterprise administrator can create a Collection Domain; domain administrators 
can edit the option set assignments for their domains, but cannot change the user 
assignments. 

To create or edit a Collection Domain 

1. Make your collection option set and/or ZENworks Asset Management user assignments. For 
more information about your choices, click on the figure below.  
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2. After you have made your assignments in the Domain window, save the Collection Domain: 
 

a) Either click on   on the toolbar or click on the File menu and click on Save or on Save 
As. 
b) If the Manager displays the Save Domain As dialog, enter a name for the domain and 
click on the OK button. 

3. Close the Domain window. 

See Also 

About Collection Domains  

About Task Server Windows 
A Task Server is responsible for managing tasks. By default, a Task Server will process 
all types of tasks, but you can specify that it process only selected types of tasks. For 
example, you may want one Task Server dedicated to database purges. You can make this 
change in a Task Server window, as well as review some additional settings. 

To edit Task Server settings 

1. Review the current Task Server settings and make any necessary changes. For information 
about the choices available to you, click on the figure below.  

 

2. To save your changes, either click on   on the toolbar or click on the File menu and 
click on Save. 

3. Close the Task Server window. 
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Active Directory Import Dialog 
Dialog buttons 

 Submit – Click this button when you have connected to the Active Directory server, finished mapping Active 
Directory fields to ZENworks Asset Management fields, and scheduled the Active Directory Import task. 

 Close – Click this button if you have made no changes, or if you do not want to save your changes. 
 Save – Click this button to save the current Active Directory Import task. 
 Save As – Click this button to save a copy of the current Active Directory Import task. 
 Help – Click this button to display this help topic. 

Task Tab 

Target Task Server(s) section 

 Task Server box – Click   to choose a Task Server if desired. 
 Schedule button – Click this button to schedule the task. 

Active Directory Connection section 

 AD Server – Enter the name of the Active Directory server you want to connect to. 
 Username – Enter the username for a valid Active Directory account. 
 Password – Enter the password associated with the username. 
 Port – If you want to use a port that is different from the default (389) enter it in this box. 
 AD Connection Status – Shows the current status of the Active Directory connection. 
 Connect – Click this button to initiate the connection to the Active Directory server. 

Mapping Tab 

 Active Directory Field – Expand any branch of the tree, then click the field in this list you want to map to a 
field in the ZENworks Asset Management Field list. 

 ZENworks Asset Management Field - Expand any branch of the tree, then click the field in this list you want 
to map to a field in the Active Directory Field list. 

 Map – Click this button after you have clicked a field in the Active Directory Field list and a field in the 
ZENworks Asset Management Field list to map the selected fields to each other.  
 
The selected field in the Active Directory Field list changes to bold. The selected field in the ZENworks 
Asset Management Field list changes to bold, and shows "=[Active Directory class]/[Active Directory field 
name]" after the ZENworks Asset Management Field name. 

 Key - Click this button after you have clicked a field in the Active Directory Field list and a field in the 
ZENworks Asset Management Field list to set the selected field Active Directory field and ZENworks Asset 
Management field as the unique key field.  
 
The selected field in the Active Directory Field list changes to bold. The selected field in the ZENworks 
Asset Management Field list changes to bold, and shows "=[Active Directory class]/[Active Directory field 
name]" after the ZENworks Asset Management Field name. 
 
You can have only one key field. 

 Remove – Click this button after selecting a ZENworks Asset Management field that has already been mapped 
or set as a key field. The mapping is removed. 

Add Directory To Skip 
Use this dialog to define a directory you want the Collector to skip when scanning 
workstations in this Collection Option Set. 

 Directory Name – Enter a pathname in this box for the directory you want to skip. 
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Add New Component/Edit Component Properties 
The Add New dialog lets you add a component to workstation or stockroom. The title of 
the dialog indicates what kind of component you are adding, for example, Add New 
Printer.  

The Edit Component Properties dialog lets you change component data. Again, the title 
of the dialog will reflect the specify type of component you are editing, for example, Edit 
Modem Properties. The Edit Properties dialog includes a scanned value column that 
shows the data the Collector gathered. This data is used "behind the scenes," and you 
cannot change it. The data shown in the Value column is the data used in queries and 
reports. 

To add or edit component data 

1. Click on the browse button in the Product box to find and select the product you want. 
ZENworks Asset Management Manager will display the Browse for Product dialog. 
If you cannot find the product you want, you have the option of creating a local product by 
clicking on the New button in the Browse for Product dialog. This button is available only if 
you are an enterprise administrator and have shut down the inventory process. 

2. Provide any additional information about the component such as its serial number or asset 
tag. 

3. Click on the OK button when done. 

Add Product Category/Subcategory 
 
The Add Product Category dialog lets you add your own category to a product type; the 
Add Product Subcategory dialog lets you add your own subcategory to a product 
category. 

1. Enter a name for the category or subcategory. 
2. Click on the OK button to return to the Manage Product Classification dialog. 

 
NOTE: If you define a new category, be sure to define at least one subcategory for it. 
Product classification requires three pieces of information: type, category, and 
subcategory. If you do not define a subcategory for a category you have added, the 
product classification will be incomplete and the product category will not be available as 
a selection in other parts of the product, for example, when creating queries.  

TIP 

 If you have any custom applications, create a subcategory named Custom in the applicable software 
category. 

See Also 

About Product Classification  
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Advanced Task Server Options 
In the Advanced Task Server Options dialog you can control settings pertaining to error 
logging and to the frequency of server check-in. In general, you will not need to change 
these settings. 

To change advanced Task Server options 

1. By default, a Task Server updates its connection status in the database every 15 minutes. 
To increase or decrease the interval at which the Task Server checks in, select a different 
number of minutes. 

2. By default, a Task Server logs every type of possible error (informational, warning, and 
severe). If you do not want to log every type of error, clear the Enable maximum 
diagnostic logging check box. 

3. By default, the error log files are purged after 14 days. To increase or decrease the 
number of days, select a different number. 

4. To turn on detailed database logging (so that all database server errors are logged), select 
the Enable detailed database logging check box. 
 
CAUTION: Detailed database logging can be very useful if you are troubleshooting, but 
results in large amounts of data being logged. This will affect database performance 
noticeably. 

5. Click on the OK button when done. 

Browse Database Fields Dialog 
The Browse Database Fields dialog lets you select a value from the database.  

Make a selection in one of these ways: 

 If the list of items is short or if you want to scroll through it, either locate the item and then double-click on 
it or select the item and click on the OK button. 

 If the list in the Browse Database Fields is long, use the top row of the dialog to locate the item you want by 
selecting an operator, entering a value, and clicking on the Find button. Then either double-click on the item 
or select the item and click on the OK button.  

TIP 

 The "start with" operator provides a quick way of locating certain kinds of values. 

Browse for Dialog 
A "Browse for" dialog lets you locate the data you want by defining one or more criteria, 
displaying the results, and selecting a resulting value. Depending on the context, the 
Browse for dialog may be Browse for Product, Browse for User, Browse for Workstation, 
Browse for Product Classification, or Browse for Files Not Identified. No matter what 
you are browsing for, the procedure for completing this dialog is the same. Essentially 
this dialog lets you select an item from a potentially very large number of items. You can 
define one or more criteria to locate the data you want and display the results. (If you do 
not define any criteria, all possible values are displayed.) You then select one of the 
resulting values.  
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When the Manager displays a "Browse for" dialog, some parts of a criterion may already 
be supplied, based on what you were doing previously. Any such pre-defined criteria are 
read-only and are combined with the rest of your filter with AND. 

To complete a "Browse for" dialog 

1. If you are planning to group some criteria by using parentheses, select ( in the column 
labeled (.  

2. In the Field column, select the field on which you want to filter, for example, 
Manufacturer. You may need to go through a series of menus to find the field you want.  

3. Select an operator. 
4. In the Value column enter or select the value for which you are testing, for example, Dell. 

The browse button will bring up the Browse Database Fields dialog in which you must find 
and select a value and then click on the OK button. 

5. If you selected open parenthesis in step 1 and the criterion in this row represents the end 
of your group of criteria, select ) in the column labeled ). the Manager will check for 
matching pairs of parentheses. 

6. Unless this is your only or last criterion, select AND or OR in the Combine column to 
indicate the relationship between the criterion you have just defined and the one that will 
follow in the next row. 

7. Continue defining criteria as described in steps 1 through 6. When done, check the criteria 
to make sure you have set them up and combined them the way you want. Do any of the 
following to make corrections:  

 To insert a blank row above the current row, click on the Insert Row button.  

 To delete a row, click on the Clear Row button.  

 To clear all the rows in the Define Filter Criteria section, click on the Clear All button. 

8. (Optional) To control how data is sorted in the Query Results section, click on the Sort 
button, make your selections in the Sort Columns dialog, and click on the OK button. 

9. (Optional) To find out how many items will meet your criteria, click on the Count button. 
This sometimes takes a little while. 

10. Click on the Display Results button. 
11. Select the item you want in the Query Results section and click on the OK button.  

 
If you were defining a query, the Manager will now display the Query Filter tab with the 
item you selected in the "Browse for" dialog listed in the Value column. 

TIP 

 Depending on your ZENworks Asset Management user role and what you were doing before the Manager 
displayed the "Browse for" dialog, a New button may be available so, for example, you can create a new user 
or a local product. 

Change Password 

1. Enter your current password. 
2. Enter the new password. 
3. Enter the new password again in the Confirm New Password box. 
4. Click on the OK button. 
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Collection Editor Tab 
The Collection Editor tab lets you customize the Collection Editor. By default, the 
Collection Editor: 

 Displays information on four tabs: User, Workstation, Inventory, and Process. (The Process tab shows the 
details of the current collection cycle. This tab can never be edited.)  

 Displays all components on the Inventory tab. 
 Lets workstation users add components (or delete ones they have added), but not create local products. 
 Does not require a password to override restrictions. 

You can choose to display only some of the tabs to workstation users. If you decide to 
display the Inventory tab, you can also select which components you want displayed and 
control to what extent users can modify them and how they can do so. 

To customize the Collection Editor 

NOTE: If you selected the Never option button in the Run Collection Editor section on the General tab, you will not be 
able to change any options on the Collection Editor tab. 

1. If you do not want the Collection Editor to display a tab, clear its check box in the 
Collection Editor Will Display section. 

2. To customize the User, Workstation, or Inventory tabs, click on a Configure button.  
3. If you do not want the Collection Editor to display all components on the Inventory tab, in 

the Inventory Displayed Components box, clear the check box next to the component you 
do not want. (This affects which components are displayed, not which components are 
gathered during a scan.) 
 
NOTE: Choices made on the Collector tab may affect what you can control in the Inventory 
Displayed Components box. For example, if you indicated you do not want to gather 
hardware, there will be no hardware components to display.  

4. If you do not want workstation users to add components (or delete ones they have added), 
clear the Add/Delete User Entered Components check box. Note that if the check box is 
selected, users will not be able to delete any components identified by the Collector, just 
those they previously added. 

5. To give workstation users the ability to add a local product like a system, select the Create 
Local Products check box.  

6. To require users to enter a password to override any restrictions you have set, select the 
Require Password check box, enter a password in the Password box, and confirm it in the 
Confirm Password box. (The password is case-sensitive.) You can then give this password to 
users of your choice. 
 
CAUTION: If you do not require a password, but impose some restrictions on Collection 
Editor use, workstation users will be able to by-pass the restrictions by removing them 
without providing a password. 

7. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 
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TIPS 

 If you want to maintain tight control over how and when local products are created, do not give workstation 
users permission to create them. If the need arises to define a local product for an unknown system, you 
always have the option of giving a workstation user the password to let him or her do so.  

 Even if you decide that you do not want workstation users defining local products, you may want them to add 
components to a workstation’s inventory by selecting products defined by Novell. That way workstation users 
can provide you with more complete data about workstations without the possibility of introducing 
inconsistencies or incorrect data into the inventory database. 

 When users provide the password while running the Collection Editor, they will be able to see any data you 
hid, edit fields that you specified as read-only, add components, and create local products. Users will not, 
however, be able to circumvent how data is to be entered in a specific field. For example, if you specified 
that a value is required, it will still be required after the password is provided. 

See Also 

About Local Products  

Collector Tab 
The Collector tab in the Collection Option Set window lets you control what kind of data 
the Collector should gather from workstations. By default, the Collector: 

 Gathers hardware and software data. 
 Does not gather auxiliary data such as IRQ or DMA maps or configuration files, for example, Autoexec.bat or 

Config.sys. 
 Does not gather FNI data (software product files not recognized by the Collector). 

NOTE: A new collection option set has FNI data collection turned off by default, but the default option set supplied by 
Novell collects FNI data by default. 

The Collector tab also lets you specify any small viewable ASCII files such as 
initialization (.ini) files that you want gathered. 

CAUTION: The more data you gather in addition to hardware and software inventory data, the greater the overhead on 
the inventory process. 

To change Collector options 

NOTE: If you cleared the Run Collector check box on the General tab, you will not be able to change any options on 
this tab. 

1. Review the settings on the Collector tab and make any necessary changes. For information 
about the Collector options, see the Collector Options reference topic. 

2. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 
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Collector Options 
Select or clear the following check boxes to control what kind of data is collected: 

Hardware and Other Collection 

Collect Hardware Controls whether hardware data is collected. 

Collect Software   

Collect Auxiliary Data Controls whether auxiliary data such as IRQ data or 
DMA data is collected. You can review this 
auxiliary data with the ZENworks Asset 
Management Manager or Web Console. 

Retrieve Text Files The Retrieve Configuration Files check box 
controls whether configuration files such as *.INI, 
Autoexec.bat, or Config.sys are collected. This data 
is stored in workstation auxiliary (.waf) files, and 
you can review it with the Manager. 

Use the Other Text Files to Retrieve box with the 
Add… and Remove buttons to create and edit a list 
of other text files to retrieve. 

Advanced… The Advanced Collector Options dialog is a special 
dialog to be used under the guidance of Novell 
Technical Support. Complete this dialog as 
directed. 

  

Software Collection  

Collect Software 
Applications 

Controls whether software application data is 
collected. (If you are licensed to run the ZENworks 
Asset Management Usage Monitor, you must 
collect software data.) 

Use the Skip Directories During Application and 
File Scan box to view the directories that are 
skipped during scanning. Use the Browse…, Add, 
or Remove buttons to edit the list. 

Collect Software File 
Information (formerly 
"FNI") 

Controls whether to collect information about 
software files that do not appear in the Novell 
Knowledgebase. 

 Select or clear the .EXE check box to control whether files 
with the .EXE extension are collected. 
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 Select or clear the Additional Extensions check box, then 
enter a list of file extensions separated by semicolons. 
(Example: ABC;DEF;JKL) Do not use spaces in the list. 

File Categories If a file matches the criteria above, these check 
boxes control which types of files are collected. 
Files are collected based on the following: 

 System Files – File and path properties indicate a direct 
relationship to the workstation’s operating system. 

 Ancillary Application Files – File and path properties 
indicate a direct relationship with an application that is 
currently in the ZENworks Asset Management 
Knowledgebase. 

 Other Files – Includes any files that do not match the 
criteria for System Files or Ancillary Application Files. 

  

Configure Choice List 
The Configure Choice List dialog lets you set up or change a list of selections for a field. 
You can either type the possible values or import them from a text file. If using a text file, 
be sure it has one value per line in any order; the Collection Editor will display the values 
in alphanumeric order to the workstation user. 

To set up a choice list 

1. To supply a value by typing, enter it in the text box and click on the Add button. 
2. To import values from a text file, click on the File Import button and then select your text 

file. 
3. To remove an item from the choice list, select it and click on the Remove button. To clear 

the list completely, click on the Remove All button. 
4. Click on the OK button when done. 

TIPS 

 To import values from the database, run a query to obtain the data you want and then export this data to a 
file. You can then import the contents of this file to your choice list. 

 To change the case of an entry, add the value with the changed case; ZENworks Asset Managment Manager 
will update the original value automatically. 
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Configure Choice List 
The Configure Choice List dialog lets you set up or change a list of selections for a field. 
You set up the selections by completing a "Browse for," dialog, for example, Browse for 
User. 

To set up a choice list 

1. Click on the Add button. 
2. Complete the "Browse for" dialog to locate and select the items you want. 
3. To remove an item from the choice list, select it and click on the Remove button. To clear 

the list completely, click on the Remove All button. 
4. Click on the OK button when done. 

Configure User/Workstation/Inventory Tab 
The Configure User Tab Fields dialog lets you customize the User tab of the Collection 
Editor, the Configure Workstation Tab Fields dialog lets you customize the Workstation 
tab of the Collection Editor, and the Configure Inventory Tab Columns dialog lets you 
customize the Inventory tab of the Collection Editor. The process of customizing is 
identical for all three tabs, but the actual changes you can make to particular fields or 
columns on the tabs differ. 

For example, you can customize the tabs in the following ways: 

 By deciding whether to display a field in the Collection Editor. 
 By indicating whether and when you want data entered in a field automatically if the data is available (for 

example, from the registry or network). 
 By specifying whether users can edit a field and how they can edit it if you choose to allow editing. 
 By providing default values through environment variables or registry keys, or by typing them. You have the 

option of letting users change the default, of making it read-only (by preventing users from editing it), or of 
hiding it altogether. 

 By providing a list of values from which the user can choose. 
 By creating an edit mask to control how users enter data. 

To customize the User, Workstation, or Inventory tab 

NOTE: Any field that appears in gray cannot be modified, for example, you cannot move it or change its label. 

1. To re-arrange the order in which fields will appear on the tab, click on the row number 
and drag it to a different position. 
 
 NOTE: You cannot re-arrange the first six rows on the Inventory tab. 

2. Make your selections in the dialog. For information about the choices, click on the figure 
below.  
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3. Click on the OK button when done. 
 
CAUTION: Be careful which fields you require. For example, if you indicate that a serial 
number is required, it will be required for all the components which you have chosen to 
display in the Collection Editor. Make sure you are requiring data that workstation users 
can provide, or they will not be able to exit the Collection Editor. 

TIP 

 Any changes you make to a user-defined field apply only when this collection option set is in effect. For 
example, if a user-defined field has the label "Purchase Date," but you change this in a collection option set 
to "Date Bought," only those workstations associated with the Collection Servers that have this option set 
assigned will see "Date Bought" in the Collection Editor; the field will still be "Purchase Date" for other 
Collection Servers. 

Create/Edit ZENworks Asset Management User 
The Create ZENworks Asset Management User dialog lets you define a new ZENworks 
Asset Management user; the Edit ZENworks Asset Management User dialog lets you edit 
information about a ZENworks Asset Management user. 

1. In the Logon Information section, enter or change information about the user: 
 
a) Enter the unique name that you want the user to provide when logging onto ZENworks 
Asset Management Manager.  
b) Enter and confirm the password that you want the user to provide.  
c) Select a role for this user, for example, Domain Administrator. 
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2. If the role you selected is on the domain level and you have already defined some 
Collection Domains, assign the user to one or more domains: 
 
a) Click on the Add button in the Assigned Collection Domains section. 
b) In the Select Collection Domain dialog, select the domain(s) to which you want to assign 
this user and click on the OK button to return to the Create ZENworks Asset Management 
User or Edit ZENworks Asset Management User dialog. You can also double-click on a 
domain to assign the user to it. 

3. Click on the OK button to return to the Manage ZENworks Asset Management Users dialog.  

TIPS 

 If users do not like the password you have assigned, they can change it after they log onto the Manager with 
the password you provided them. 

 All enterprise-level ZENworks Asset Management users automatically have access to all Collection Domains so 
you do not need to assign them to domains. 

 You can also assign domain-level ZENworks Asset Management users to a Collection Domain when you create 
it.  

General Tab 
The General tab in the Collection Option set window lets you control which applications 
run as part of the inventory process, which collection schedule is in effect, and whether 
inventory data is translated into other file formats. By default,  

 The Collection Client runs in resident mode on workstations, always ready to receive instructions from the 
Collection Server. 

 The Collector gathers data from the workstations when instructed by the Collection Client. 
 The default collection schedule is assigned to the collection option set. 
 The Collection Editor always runs on workstations after the Collector has finished so that users can review 

and modify the collected data. 
 The Collection Editor does not time out. The workstation user must exit the Collection Editor. 
 ZENworks Asset Management does not translate inventory data to Management Information Format (MIF) files 

so the data can be incorporated into Microsoft's Systems Management Server (SMS) nor does it translate the 
data to .xml files. 

You may want to change these default settings if, for example, you want the Collection 
Editor to run just the first time a workstation is scanned.  

Run Collection Client in Resident Mode 

The Run Collection Client in Resident Mode check box controls whether the Collection 
Client runs in resident mode on workstations, always ready to receive instructions from 
the Collection Server. Novell recommends that you leave this check box selected. 

Run Collector Always 

If you do not want the Collector to gather data from workstations, clear the Run Collector 
check box. Generally you will want the Collector to run so you can collect hardware and 
software data (plus any auxiliary data), but occasionally you may want to collect only 
user information by running the Collection Editor alone. 

NOTE: Even if you clear the Run Collector check box, the Collector will always run the first time a workstation is due 
to be scanned, for example, when a new workstation is added to a Collection Server. 
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Schedule 

The Schedule box controls which schedule is assigned to the collection option set. When 
you create an option set, ZENworks Asset Management Manager automatically assigns it 
the default schedule. You have the option of assigning a different schedule.  

Do one of the following to assign a different schedule to the collection option set:  

 To select an existing schedule, click on the browse button at the end of the Schedule box. Then, in the 
Select Collection Schedule dialog, select the schedule you want and click on the OK button to return to the 
Collection Option Set window.  

 To create and assign a schedule, click on the browse button at the end of the Collection box in the Collection 
Option Set window. Then, in the Select Collection Schedule dialog, click on the New button and set up the 
schedule. After you have saved the schedule, you will return to the Select Collection Schedule dialog and the 
newly-created schedule will be highlighted. Click on the OK button to return to the General tab of the 
Collection Option Set window.  

Run Collection Editor 

To control when the Collection Editor runs on workstations during the inventory process, 
select one of the following in the Run Collection Editor section: 

 Always (the default). 
 Only on New Workstations (the Collection Editor will run only the first time a workstation is scanned). 
 Never. 

Time-out Mode 

To control whether the Collection Editor "times out" if there is no user activity, do one of 
the following: 

 To always require user input in the Collection Editor, select Never in the Time-out Mode box. 
 To have the Collection Editor exit and save the inventory data even if there is no user input, select Exit and 

Load in the Time-out Mode box and indicate the number of minutes after which the Collection Editor will 
time out. 

 To have the Collection Editor exit without saving the inventory data if there is no user input, select Quit (No 
Load) in the Time-out Mode box and indicate the number of minutes after which the Collection Editor will 
time out. 

Run Translator 

Use this section to control whether inventory data is translated into other file formats: 

1. If you want to convert inventory data to SMS Management Information Format (MIF) files, 
select click to select the version of SMS you are running in the Run Translator section. By 
default, no translation occurs. ZENworks Asset Management will translate the data to a MIF 
file after each scan of a workstation, and the SMS agent will pick up the resulting MIF files 
according to its own schedule. 

2. If you want to convert inventory data to .xml file format, select the Generate XML File 
check box in the Run Translator section. The .xml file is saved in the \Bin folder of your 
ZENworks Asset Management installation folder. 
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TIPS 

 The MIF files are placed in the default folder where the SMS 1.2 or 2.0 Agent expects to find the files. 
Workstations must be clients of SMS for MIF files to be picked up from them. See the Systems Management 
Server Administrator’s Guide for details. 

 For information about MIF file formats, see ZENworks Asset Management .MIF File Formats. 
 The Run Translator settings do not apply to portable collections or scans of network servers. 

Late Task Options 
The Late Task Options dialog lets you specify how you want late tasks handled. 

To specify late task options 

1. By default, a task is considered late if it has not yet run 60 minutes after it was scheduled 
to start. If you want to specify a number of minutes other than 60, enter the number in 
the Wait box.  

2. In the When a Task Becomes Late section, indicate how you want ZENworks Asset 
Management to handle the task if it is late:  

 Run the Task Anyway - The late task will run anyway, as soon as ZENworks Asset Management can start 
it (the default). 

 Skip the Task and Run Next Time - If a late task is scheduled to recur, ZENworks Asset Management will 
not run it this time, but will do so at its next scheduled time. 

 Cancel the Task - The late task and its schedule are canceled. To run the task again, you will need to 
re-schedule and re-submit it. 

3. Click on the OK button to return to the Schedule Task dialog. 

Log Onto ZENworks Asset Management Database 
The Log Onto ZENworks Asset Management Database dialog appears automatically after 
you start ZENworks Asset Management Manager. 

NOTE: The first time you run the Manager, you must log on as the enterprise administrator that Novell created for you 
during setup. The user name is "EntAdmin" and the password is "enterprise." Change the password right away to prevent 
other users from logging onto the Manager using the EntAdmin account. (This account gives the highest level of 
privileges when running the Manager.) You can then set up additional ZENworks Asset Management users and let them 
know what their user names and passwords are. 

1. If the database you want is not shown in the dialog, click on the Database button. (The 
correct database will already be selected for you if you installed the Standalone 
Deployment of ZENworks Asset Management.) 

2. If necessary, enter your name in the User Name box. (This box displays the name used 
during the last successful logon.) 

3. Enter your password. 
4. Click on the OK button to start the logon process. 

 
NOTE: For Microsoft SQL Server or MSDE, the Log Onto ZENworks Asset Management 
Database dialog displays the server and database names; for Oracle, it displays the ODBC 
data source name. 

Manage Product Classification 
 
The Manage Product Classification dialog lets you add your own categories to a product 
type and add your own subcategories to a product category. This dialog also lets you 
rename and delete any categories or subcategories you added. 
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The Manage Product Classification dialog lists all the product types. Within each type is 
one or more product categories. Within each category is one or more subcategories.  

To define an additional category for a product type 

1. Select the product type to which you want to add a category. 
2. Click on the New button and complete the Add Product Category dialog. 
3. When done, close the Manage Product Classification dialog. 

 
NOTE: If you define a new category, be sure to define at least one subcategory for it. 
Product classification requires three pieces of information: type, category, and 
subcategory. If you do not define a subcategory for a category you have added, the 
product classification will be incomplete and the product category will not be available as 
a selection in other parts of the product, for example, when creating queries.  

To define an additional subcategory for a product category 

1. Select the product category to which you want to add a subcategory. 
2. Click on the New button and complete the Add Product Subcategory dialog. 
3. When done, close the Manage Product Classification dialog. 

To rename a product category or subcategory 

NOTE: You can rename product categories or subcategories you added, not those that are pre-defined in ZENworks 
Asset Management. The categories or subcategories you added are identified by a different icon.  

1. Either select the product category or subcategory you want to rename and click on the 
Rename button or double-click on the category or subcategory. 

2. Enter the new name in the Rename Category or Rename Subcategory dialog and click on 
the OK button. 

3. Close the Manage Product Classification dialog. 

To delete a product category or subcategory 

NOTE: You can delete product categories or subcategories you added, not those that are pre-defined in ZENworks Asset 
Management. The categories or subcategories you added are identified by a different icon. Also, if a product category 
or subcategory has products associated with it, you will not be able to delete it until you have assigned the products to 
a different category or subcategory. 

1. Be sure that you have re-assigned any products that were associated with the category or 
subcategory you want to delete. 

2. Select the product category or subcategory you want to delete.  
3. Click on the Delete button. 
4. If you are deleting a category that includes subcategories, confirm the deletion. (The 

subcategories will be deleted, too.) 
5. Close the Manage Product Classification dialog. 

TIPS 

 If you were deleting product categories or subcategories, be sure to re-start the inventory process. Until you 
do, no collections will take place and no tasks will run. 

 If you have any custom applications, create a subcategory named Custom in the applicable software 
category. 
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Manage ZENworks Asset Management Users 
The Manage ZENworks Asset Management Users dialog lets you create, edit, and delete 
ZENworks Asset Management users. 

1. Do any of the following:  
 To create a new ZENworks Asset Management user, click New and complete the Create ZENworks Asset 

Management User dialog. 
 To edit user information, select the user in the Available ZENworks Asset Management Users box, click 

Edit, and then make your changes in the Edit ZENworks Asset Management User dialog. 
 To delete a user, select the user in the Available ZENworks Asset Management Users box, click Delete, 

and confirm the deletion. 
 To edit the rules for creating passwords, click Password Rules... 

2. Click on the Close button when done. 

See Also 

About ZENworks Asset Management Users  

Creating a ZENworks Asset Management User  

Editing a ZENworks Asset Management User  

Deleting a ZENworks Asset Management User  

Move Components 
The Move Components dialog lets you move the components you selected to another 
workstation or stockroom. 

1. Click on the Browse button. 
2. In the Browse for Workstation dialog, find and select the workstation or stockroom to 

which you want to move the selected component(s) and then click on the OK button. 
3. Click on the OK button. 

TIP 

 If you moved a component from a workstation that is part of the inventory cycle, be sure to remove the 
component physically from the workstation itself. If you do not, and another inventory cycle takes place, the 
Collector will find the component on the workstation again. The inventory database will be incorrect because 
the component will appear in two places. 

Proxy Server Management 
Use the Proxy Server Management dialog to define the HTTP proxy server you want to 
use for obtaining PRUs from the Novell Web site. 

1. To use a proxy server, select the Use Proxy Server check box. 
2. In the Address box, enter the name of the proxy server, for example, RDHA2.  
3. Enter the port number of the proxy server. 
4. Enter the user name and password for accessing the proxy server. 
5. Click the OK button. 
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Purge Database 
The Purge Database dialog lets you select the kind of data you want to purge, select a 
Task Server to run the purge task (if you have multiple Task Servers), and schedule the 
purge. 

To purge the database 

1. In the Purge Description box, enter a name for the purge task. This is how the task will be 
identified on the Tasks tab of the process control panel. 

2. By default, the purge task will be handled by any available Task Server. To select a 
specific Task Server or group of Task Servers, 
 
a) Click on the browse button in the Target Task Server(s) box. 
b) In the Select Task Server dialog, either select a specific Task Server or group of Task 
Servers so that any of the Task Servers in that group can handle the purge task. (Task 
Servers are grouped either in the Public Task Servers container or in a domain Task Servers 
container.) Then click on the OK button. 

3. In the Data to Purge section, select the type of data you want to purge. By default, 
ZENworks Asset Management will purge all outdated data. (The settings that control when 
data becomes outdated are in the Enterprise Options dialog.) 

4. To schedule the purge, click on the Schedule button. If you do not set up a schedule, the 
purge will run on a one-time basis as soon as ZENworks Asset Management can start it. 

5. Click on the Submit button. The task now enters the task queue and can be tracked on the 
Tasks tab of the process control panel. 

Rename 
The Rename dialog lets you change the name of the item or folder that you selected on a 
locator tab. The dialog title indicates what you are renaming. 

1. Change the name. 
2. Click on the OK button. 

Rename Category/Subcategory 
 
The Rename Category dialog lets you change the name of a category you have defined; 
the Rename Subcategory dialog lets you change the name of a subcategory you have 
defined. 

1. Enter a different name for the category or subcategory. 
2. Click on the OK button to return to the Manage Product Classification dialog. 

Save Collection Option Set As 

1. Enter a unique name for the collection option set.  
2. (Optional) Select a folder for the option set if you want a folder other than the one listed 

in the Folder box. If no folders exist, ZENworks Asset Management will store the option set 
in the container you selected when you began creating the option set. 

3. Click on the OK button. 
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Select Collection Schedule 
The Select Collection Schedule dialog lets you choose the schedule you want to assign to 
a collection option set. If the schedule does not exist yet, you have the option of creating 
it. 

To select a collection schedule 

Do one of the following: 

 If the schedule you want is listed in the Available Collection Schedules box, select the schedule and click on 
the OK button to return to the General tab of the Collection Option Set window. 

 To create a new schedule, click on the New button, complete the Collection Schedule window, and save the 
schedule. You will then return to this dialog. Click on the OK button to return to the General tab of the 
Collection Option Set window. 

Select Database 
The Select Database dialog lets you select the database to which you want to log on. 

1. Select database type.  
2. If the database type you selected is Microsoft SQL Server or MSDE, select the names of the 

server and database and then select the ODBC data source for reports. 
3. If the database type you selected is Oracle, select the ODBC data source. 
4. Click on the OK button to return to Log Onto ZENworks Asset Management Database dialog.  

Select Collection Domain 
In the Select Collection Domain dialog you can select the domain(s) to which you want 
to assign the ZENworks Asset Management user. 

Do one of the following: 

 Select a domain and click on the OK button. 
 Double-click on a domain. 

TIP 

 You can also assign domain-level ZENworks Asset Management users to a Collection Domain when you create 
it. 

Select Component Type 
The Select Component Type dialog gives you two basic choices when creating a 
component query: 

 Your query can be for a specific type of component, for example, printer or modem. In this case, you will be 
able to see all the available information for that type of component, but not for any other type.  

 Your query can be for any type of component. In this case, you will be able to see information for a mix of 
components of different types, but the information will be limited to the data that all components have in 
common.  
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To select a component type 

1. Either select a specific type of component such as System or select Any (Basic Data Only) if 
you want to work with a mix of component types. 

2. Click on the OK button. 

Select Component Type to Create 
The Select Component Type to Create dialog lets you specify what type a component you 
want to add to a specific workstation.  

1. Select the type of component you want to add, for example, printer or software. 
2. If necessary, select the workstation to which you want to add the component by clicking 

on the Browse button in the Assign to Workstation section and then completing the Browse 
for Workstation dialog. If you were viewing the component list for a workstation, the 
workstation will already be listed in the Assign to Workstation section. 

3. Click on the OK button. 

Select Task Server 
The Select Task Server dialog lets you select the Task Server or group of Task Servers 
that you want to handle the task you are submitting. By default, any available Task 
Server handles a task. 

To select a Task Server 

1. If you want to specify a particular Task Server for this task, open the Public Task Servers 
container or the container for a domain and select the Task Server you want. 

2. If you want any public Task Server or any Task Server in a Collection Domain to handle the 
task, select the Public Task Servers container or the domain container. When your task is 
submitted, any available Task Server in the group (container) you selected will handle the 
task. 

3. Click on the OK button. 

Stop Inventory Process 
You have two options for stopping the inventory process: 

 You can stop the inventory process immediately. In this case, ZENworks Asset Management will cancel any 
active scans and tasks and discard any workstation inventory files (.wif) that were waiting to be loaded.  

 You can stop the inventory process after a specified amount of time so that ZENworks Asset Management has 
a chance to complete any scans, tasks, or loads in progress.  

When you stop the inventory process, you stop all your Collection Servers and Task 
Servers. Unless you are working with user-defined fields, other ZENworks Asset 
Management users can still log onto ZENworks Asset Management Manager.  

1. If you want to wait for scans and/or tasks to complete, select the Wait option, specify the 
number of minutes you want to wait, and click on the OK button. Otherwise, just click on 
the OK button. 

2. If you opted to wait, and the time you specified has gone by without all the scans or tasks 
being completed, you will once again be given three choices:  

 You can stop the process immediately. Select the Stop Immediately option button and click on the OK 
button. 
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 You can continue to wait for some number of minutes again. Select the Wait option button, enter a 
number of minutes, and click on the OK button. 

 You can change your mind about stopping the inventory process at this time and click on the Restart 
button. This will start up the inventory process again. 

The Manager will inform you when the inventory process is stopped (or re-started). 

TIPS 

 While the inventory process is shutting down, you can check the status of your Collection Servers, Task 
Servers, and tasks in the process control panel. The status of the servers will read "Inventory Stopped" as 
they are stopped. If, however, you previously stopped a server yourself, its status will read "Stopped" to 
indicate it was not stopped as a result of the inventory process shut-down. 

 After you complete the activity which required you to stop the inventory process you must start it again. 
Until you do, no collections will take place on any workstations and no tasks will run. 

Preferences 
The Preferences dialog lets you customize some aspects of ZENworks Asset 
Management Manager's behavior. For example, you can control how the Manager 
displays the names of workstation users, whether it asks you to confirm the deletion of 
items on locator tabs, and whether it asks you to confirm a scan on demand.  

NOTE: The user preferences affect just what you see or experience; any changes to these settings have no effect on 
other ZENworks Asset Management users. 

1. To display the names of workstation users in a format other than last name followed by 
first name, select a different option in the Display Workstation User Name As section. 

2. If you do not want to be asked to confirm deletions on locator tabs, clear the Display 
Delete Confirmation on Locator Tabs check box. 

3. If you want to confirm that a scan on demand has taken place, select the Confirm Scan on 
Demand check box. 

4. Click on the OK button. 

View Collection Server/Task Server Errors 
The View Collection Server Errors dialog or View Task Server Error dialog lets you 
review any errors that have occurred on a Collection Server or Task Server. By default, 
ZENworks Asset Management lists severe errors only, but you have the option of 
viewing warning or informational errors, as well as of filtering errors by date or 
description. 

1. Review the errors listed.  
2. To see an updated list of errors, click on the Refresh button. 
3. To view different errors, edit the filter above the error list by selecting Level, Date, or 

Description; selecting an operator; specifying the value that you want to match; and 
clicking on the Filter button. For example, to see informational errors you would select 
Level and the = operator and then type info. (The possible values you can enter for the 
error level are severe, warning, or info.) 

4. To display the errors in a different order, click on the Date, Level, or Description column 
heading. 

5. To obtain more details about an error, select it. ZENworks Asset Management will display 
the additional information in the Detailed Description box. 

6. To obtain even more details (if available) about an error, double-click on it.  
7. Click on the Close button after you finish reviewing the errors. 
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View Errors 

1. Select Collection Server or Workstations to indicate which kinds of errors you want to see. 
2. Click on the OK button. 

View Workstation Errors 
The View Workstation Errors dialog lets you review errors that occurred on workstations. 
By default, ZENworks Asset Management lists severe errors only, but you have the 
option of viewing warning or informational messages, as well as of filtering errors by 
workstation or primary user. 

1. To see an updated list of workstations with errors, click on the Refresh button. 
2. To view different errors, edit the filter in the Available Workstations section by selecting 

Error Level, Workstation, or Primary User; selecting an operator; specifying the value that 
you want to match; and clicking on the Filter button. For example, to see informational 
errors you would select Error Level and the = operator and then type info. (The possible 
values you can enter for the error level are severe, warning, or info.) 

3. To display the errors in a different order, click on the Workstation, Primary User, or Error 
Level column heading. 

4. To see a complete list of errors for a particular workstation, select it in the Available 
Workstations section. ZENworks Asset Management will then display all the errors for the 
workstation in the Errors for Selected Workstation section of the dialog. To display the 
workstation errors in a different order, click on the Date, Module, Level, or Description 
column heading. 

5. To obtain more details about a particular error, select it. ZENworks Asset Management will 
display the additional information in the Detailed Description box. 

6. To obtain even more details (if available) about an error, double-click on it.  
7. Click on the Close button after you finish reviewing the errors. 

Web Console Management 
The Web Console Management dialog lets you specify the name of the server where you 
installed the ZENworks Asset Management Web Console.  

1. Enter the name of the server. 
2. Click on the OK button. 

Workstations Tab 
The Workstations tab in the Collection Option Set window lets you specify filter criteria 
for selecting the workstations to be scanned. 

If you are using multiple collection option sets, you may want some collection option sets 
to apply only to certain workstations associated with a Collection Domain or Collection 
Server. For example, you could specify a department or building as your criterion. If you 
do not specify any workstation filter criteria, all the workstations associated with a 
Collection Domain or Collection Server are scanned. 

Specifying the filter criteria for workstations is very similar to setting up a filter for a 
query in ZENworks Asset Management. Just as in a query, each workstation criterion 
includes a field, an operator, and a value, for example, Department = Marketing.  
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To select workstations for scanning 

1.  If you are planning to group some criteria by using parentheses, select ( in the column 
labeled (. 

2. Select the field on which you want to filter by doing the following:  
 Click on a cell in the Field column. 
 Click on the right arrow in the cell to display a menu of available fields. 
 Select a field, for example, Department. 

3. In the Operator column, select an operator. 
4. Click on the Value column and then enter or select a value, for example, Marketing.  
5. If you selected an open parenthesis in step 2, and the criterion in this row represents the 

end of your group of criteria, select ) in the column labeled ). 
6. Unless this is the last or only criterion you want to specify, select AND or OR in the 

Combine column to indicate the relationship between the criterion you have just defined 
and the one that will follow in the next row. 

7. Continue defining criteria as described in steps1 to 6. When done, check the criteria to 
make sure you have set them up and combined them the way you want. Do any of the 
following to make changes:  

 To insert a blank row before the current row, click on the Insert Row button.  
 To delete the current row, click on the Clear Row button. 
 To clear all the rows in the Define Filter Criteria section, click on the Clear All button. 

8. If you have finished making changes to the collection option set, either click on   on 
the toolbar or click on the File menu and click on Save. If asked, provide a name for the 
collection option set. 
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ZENworks Asset Management Terms 
administrator 
A ZENworks Asset Management user who has editing privileges of the inventory data 
and control over the inventory process. An administrator's role can be enterprise-wide or 
restricted to a Collection Domain. See domain administrator , enterprise administrator . 

analyst 
A ZENworks Asset Management user who has read-only privileges of the inventory data. 
Such a user can analyze the data using queries and reports. An analyst's role can be 
enterprise-wide or restricted to a Collection Domain. See domain analyst, enterprise 
analyst. 

assistant 
A ZENworks Asset Management user who has editing privileges of the inventory data. 
Such a user can both analyze the data using queries and reports and change it. An 
assistant's role can be enterprise-wide or restricted to a Collection Domain. See domain 
assistant, enterprise assistant. 

auxiliary data 
Additional information about a workstation that can include IRQ, I/O, or DMA maps and 
configuration files. The data can be viewed with ZENworks Asset Management Manager. 

This data is not stored in the ZENworks Asset Management database. It is stored in the 
\FileStore\WAFDir folder in your ZENworks Asset Management installation folder.  

checking out 
The process of unloading a workstation from the inventory database and making it 
unavailable for editing. ZENworks Asset Management automatically checks out 
workstations when they are being scanned and then checks them back in.  

client applications 
The three ZENworks Asset Management applications that run on a workstation to ensure 
that inventory data is collected from it: Collection Client, Collector, and Collection 
Editor. 

Collection Client 
The ZENworks Asset Management application that runs on a workstation and manages 
the inventory process on the workstation according to instructions received from the 
Collection Server with which the workstation is associated. For example, the Collection 
Client ensures that the Collector runs as scheduled and that files are updated as necessary. 

Note: A client checks its ZENworks Asset Management Collection Server’s DNS name every 24 hours (assuming the 
workstation is running) to make sure it hasn’t changed. If the name changes, the collection client reconnects to the 
updated collection server. 
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Collection Domain 
An organizational tool for grouping together one or more Collection Servers to help you 
manage the inventory process. (The grouping is completely up to you.) Task Servers can 
also be assigned to Collection Domains to help in task management. A ZENworks Asset 
Management installation always includes at least one Collection Domain. 

Collection Editor 
The ZENworks Asset Management application that can run on a workstation during the 
inventory process so that a workstation user can review and edit inventory data. 

collection option set 
A group of settings that controls many aspects of the inventory process on workstations, 
for example, which applications run during a scan, which collection schedule is in effect, 
or which workstations are to be scanned. Collection option sets are assigned to Collection 
Domains and Servers to control the nature and timing of the inventory process on their 
associated workstations. 

See Also 

standard option set  

new workstation option set  

scan now option set  

collection schedule 
A schedule that controls the timing of collections on workstations. A collection schedule 
is put into effect by being associated with a collection option set, which in turn is 
associated with a Collection Domain or Server.  

Collection Server 
The ZENworks Asset Management application (and machine on which it is running) that 
is responsible for providing instructions to the Collection Clients on its associated 
workstations based on the collection option set (and its associated collection schedule) 
that you assigned to the Collection Server. A Collection Server also receives workstation 
inventory files from its workstations and loads the data into the inventory database. You 
can set up several Collection Servers to organize and distribute the inventory process at 
your organization and you can group Collection Servers into Collection Domains as a 
further organizational aid. 

Collector 
The ZENworks Asset Management inventory discovery application that scans the 
hardware and software on a workstation and performs product recognition. The 
Collection Client on the workstation ensures that the Collector runs when scheduled. 
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component 
A hardware or software product installed on a workstation, for example, a network 
interface card, a processor, or Microsoft Word 2000. A component includes data specific 
to the workstation, such as processor speed or the location of a software application. 

Component List window 
A window you can display after running a workstation query to list all the components of 
the workstation. 

container 
A special type of folder in ZENworks Asset Management Manager. In terms of the 
hierarchy of a locator tab, containers are at the highest level and can in turn include other 
containers, folders, and items such as queries or schedules. 

Current Task 
The Current Task column shows the name of the task currently running on the Task 
Server. (To see more details about the task, click on the Tasks tab in the process control 
panel.) 

demotion 
The process by which an enterprise administrator moves a public collection schedule or 
collection option set to the domain level so that it is no longer available to all ZENworks 
Asset Management users. 

domain 
See Collection Domain. 

domain administrator 
A ZENworks Asset Management user with the privileges to manage one or more 
Collection Domains by setting up collection schedules and options and by analyzing and 
maintaining inventory data from the domain(s). A domain administrator cannot perform 
administrative or maintenance activities that affect the entire enterprise. See also 
enterprise administrator. 

domain analyst 
A ZENworks Asset Management user with read-only privileges for the inventory data for 
a Collection Domain. A domain analyst can run reports and queries, but cannot perform 
any administrative or maintenance activities. See also enterprise analyst. 

domain assistant 
A ZENworks Asset Management user with editing privileges for the inventory data for a 
Collection Domain. A domain assistant can analyze and change inventory data, but 
cannot perform any administrative activities related to the inventory process. See also 
enterprise assistant. 
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edit mask 
A template that requires a user to enter information (such as a telephone number) in a 
particular format. 

enterprise 
The entire ZENworks Asset Management installation consisting of one or more 
Collection Domains. 

enterprise administrator 
A ZENworks Asset Management user with the highest privileges. Such an administrator 
can manage all aspects of the inventory process for the entire organization - across all 
Collection Domains - including creating other ZENworks Asset Management users. See 
also domain administrator. 

enterprise analyst 
A ZENworks Asset Management user with read-only privileges for the inventory data for 
the whole enterprise. An analyst can run reports and queries, but cannot perform any 
administrative or maintenance activities. See also domain analyst. 

enterprise assistant 
A ZENworks Asset Management user with editing privileges for the inventory data for 
the entire enterprise. An enterprise assistant can analyze and change inventory data, but 
cannot perform any administrative activities related to the inventory process. See also 
domain assistant. 

File Store 
ZENworks Asset Management non-database files that reside in a shared folder structure 
on the network or on an FTP server. In an Enterprise Deployment, the File Store needs to 
be accessible to all Task Servers, Collection Servers, and ZENworks Asset Management 
Managers. 

FNI (files-not-identified) data 
Information that identifies software product files that the Collector could not recognize 
during the scan of a workstation. You can review FNI data in ZENworks Asset 
Management Manager and use it to establish recognition data for a software product. As 
a result, the Collector will identify the product correctly in future inventories. 

Host Name 
The Host Name column shows the name of the machine on which the Task Server is 
running. 

inventory data 
All the available data about a workstation. This data can include hardware and software 
data; demographic data (such as the name of the workstation user, associated department, 
and location); FNI data; and auxiliary data. 
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inventory database 
The database in which ZENworks Asset Management stores and maintains the data 
collected from workstations. 

local product 
A product (such as an internally-developed piece of software) that is not one of the 
products defined by Novell. A local product is usually defined by a ZENworks Asset 
Management enterprise administrator or, in some cases, by a workstation user. 

locator tab 
A tab that lists related items in the locator window. For example, the Query locator tab 
lists queries; the Management locator tab lists schedules, collection option sets, 
Collection Domains, Collection Servers, and Task Servers. 

locator window 
A ZENworks Asset Management window that displays organized lists of items (for 
example, schedules, queries, reports, or Collection Domains) to help you find and 
manage these items. The lists appear on locator tabs. 

Lost and Found 
A special stockroom created and maintained by ZENworks Asset Management for 
tracking previously discovered components that come up missing in subsequent 
inventories. 

Only components with serial numbers or asset tag numbers will be added to the Lost and 
Found. 

manually-entered workstation 
A workstation that has been manually entered into the ZENworks Asset Management 
database with ZENworks Asset Management Manager.  

menu 
A list of available ZENworks Asset Management Manager commands. Menu names 
appear in a menu bar near the top of the window. 

menu bar 
A horizontal bar near the top of a window containing the names of the ZENworks Asset 
Management Manager menus, for example, File and Edit. 

network discovery task 
A task that performs a scan of a network to obtain data about devices on your network, 
for example, hubs, routers, printers, or switches. 

new workstation option set 
A collection option set that is used for scanning new workstations in the enterprise (in 
contrast to standard option sets or scan now option sets). 
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not-yet-scanned workstation 
A workstation on which the client applications have been installed, but no scan has 
occurred. 

ODBC (Open Database Connectivity) data source 
Information about your database that Crystal Reports (used by ZENworks Asset 
Management) requires so that it can connect to the database to generate reports. 

Port 
The Port column provides the port number of the Task Server. 

portable collection 
The process of making the media that includes the software for gathering inventory data 
manually from a workstation, going to the workstation(s) and running the software from 
the media you created, and using a wizard to load the collected data into the ZENworks 
Asset Management inventory database. Ordinarily, the collection process is automated so 
these steps are not necessary. 

process control panel 
A window in ZENworks Asset Management Manager in which you can view and manage 
data related to the inventory process and to tasks. For example, you can check the status 
of your Collection Servers or tasks, view errors reported on workstations, or see which 
users are currently using the Manager. 

product 
A piece of hardware or software identified by its type, manufacturer, name, and model 
(or version). ZENworks Asset Management includes thousands of products that are 
already defined so that the Collector can identify them. A ZENworks Asset Management 
enterprise administrator can define additional products known as local products. 

product classification 
The way ZENworks Asset Management groups products by type, category, and 
subcategory. 

product category 
The classification of a product within a product type. For example, software products 
include categories such as accounting, graphics, or spreadsheet. Hardware product 
categories often correspond to the product type, for example, printer or monitor. 
ZENworks Asset Management includes many pre-defined product categories, and you 
can define additional categories of your own. 

product knowledgebase 
A knowledgebase developed and maintained by Novell used to identify installed 
hardware and software products and to present a license view of installed software. 
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product subcategory 
The further classification of a product within a product category. For example, payroll is 
a subcategory of the accounting category and inkjet is a subcategory of the printer 
category. ZENworks Asset Management includes many pre-defined subcategories, and 
you can define additional subcategories of your own. 

product type 
The classification of a product according to its inherent characteristics, for example, 
software, memory module, or printer. ZENworks Asset Management includes pre-
defined product types which cannot be changed. 

promotion 
The process by which an enterprise administrator makes public a domain collection 
schedule or collection option set so that it is available to all ZENworks Asset 
Management users. Enterprise administrators can also promote their personal reports or 
personal queries so all users can run them. 

purge 
The process of removing obsolete workstation, task, or error data from the database. 

query 
A set of criteria that ZENworks Asset Management Manager uses to find specific data in 
the inventory database and display it on the screen. 

query results window 
In the query tool, the bottom window where ZENworks Asset Management Manager 
displays the inventory data that matched the criteria in the query. 

query tool 
A two-window display in the workspace that shows a query and its results. See also query 
window and query results window. 

query window 
In the query tool, the top window where you display and define the criteria that make up 
the query. 

recognition data 
The information used by the Collector to identify a hardware or software component 
during the scan of a workstation. 

scan 
The process of collecting inventory data from workstations. 

scan now option set 
A collection option set that is used for scanning workstations on demand (outside their 
regular inventory cycle), including portable collections and server scans. (Other types of 
collection option sets include standard option sets and new workstation option sets .) 
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server inventory type 
An inventory type referring to Novell NetWare servers. 

Server Status 
The Server Status column shows the current status of the Task Server:  

 Starting - The Task Server is in the process of starting. 
 Started - The Task Server is in its normal state (running). 
 Stopping - The Task Server is in the process of stopping. 
 Stopped - The Task Server has been stopped by an administrator. 
 Unavailable - Either the service is currently stopped or a serious condition (such as a problem with a network 

cable or card) is preventing the Task Server from communicating with the inventory database. This status 
appears in red to warn you the Task Server is not working. 

 Inventory Stopped - The Task Server has been stopped because the entire inventory process has been 
stopped. 

shortcut menu 
Also known as a pop-up menu or context-sensitive menu, a menu that appears when you 
right-click (press the right mouse button). Such a menu offers a quick way of getting to 
commands that are useful in a particular context. 

standard option set 
A collection option set that controls your regular inventory cycles (in contrast to a new 
workstation option set or scan now option set). 

status bar 
The line at the bottom of the ZENworks Asset Management Manager window that 
provides information about the current status of the application. 

stockroom 
Components that are currently not associated with a particular workstation, but are 
grouped together for organizational reasons, for example, spare computer parts for the 
Sales Department or components currently being repaired. You can create and manage 
stockrooms with ZENworks Asset Management Manager.  

system component 
The component at the heart of every workstation - the computer itself, as identified by 
manufacturer, product, and model, for example, Dell Dimension XPS. 

task 
A scheduled report, scheduled PRU (Product Recognition Update), network discovery, or 
purge managed by a Task Server. 

Task Server 
The ZENworks Asset Management application that is responsible for executing tasks. In 
an Enterprise Deployment of ZENworks Asset Management, you can set up several Task 
Servers that are either public (available to the entire enterprise) or associated with a 
specific Collection Domain. 
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Task Type 
The Task Type column indicates what kind of task is running: report, purge, or PRU. 

TCP/IP Address 
The TCP/IP Address column provides the TCP/IP address of the Task Server. 

toolbar 
The line of buttons below the menu bar that gives you quick access to frequently-
performed tasks. 

ZENworks Asset Management Manager 
The ZENworks Asset Management application that lets you customize and manage your 
ZENworks Asset Management installation. 

ZENworks Asset Management Network Discovery Engine 
The ZENworks Asset Management application that collects data about devices on your 
network, for example, hubs, routers, printers, or switches. The engine uses Internet 
Protocol (IP), Simple Network Management Protocol (SNMP), and Windows 
Management Interface (WMI) standards to identify any networked device with an IP 
address. 

ZENworks Asset Management Software Management 
The Web-based ZENworks Asset Management application that lets you import or enter 
purchasing information and reconcile this information with products that you have 
installed and that have been discovered during the inventory process. You run ZENworks 
Asset Management Software Compliance from the ZENworks Asset Management Web 
Console. 

ZENworks Asset Management Usage Monitor 
The ZENworks Asset Management application that lets you track and analyze how 
software is being used on workstations. 

ZENworks Asset Management user 
A user who has been granted access to the ZENworks Asset Management inventory 
database and assigned the role of enterprise administrator, enterprise assistant, enterprise 
analyst, domain administrator, domain assistant, or domain analyst. A user's role 
determines the type of activities the user can perform with ZENworks Asset Management 
Manager. 

ZENworks Asset Management Web Console 
The main access point for all Web-based ZENworks Asset Management features and 
reports. The Web Console gives you access to your network device inventory data, Web 
reports, and ZENworks Asset Management Software Compliance. You can access the 
ZENworks Asset Management Web Console directly from Internet Explorer or from 
ZENworks Asset Management Manager. 
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user-defined field 
A field an enterprise administrator can set up to track additional inventory information 
about a component, product, user, or workstation, for example, a purchase date or home 
telephone number. 

workspace 
The area in the ZENworks Asset Management Manager window where you can see and 
work with an item such as a schedule or collection option set. 

workstation 
Any computer for which you have inventory data in the ZENworks Asset Management 
database. 

workstation auxiliary file (.waf) 
A file with the extension .waf that includes information about configuration files gathered 
by the Collector. This data does not get loaded into the inventory database, but you can 
examine it with ZENworks Asset Management Manager. See also auxiliary data. 

workstation inventory file (.wif) 
A file with the extension .wif that includes all the user, component, and product 
information for a workstation. This information is gathered automatically by the 
Collector or entered by the user with the Collection Editor and then loaded automatically 
into the inventory database. 

workstation user 
The user associated with a workstation from which inventory data is collected 
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Getting Started with ZENworks®  Asset 
Management Web Console 
Application Version 7.5 
Document Version 7.5.06-061017 
O ctober 2006 

 

The Web Console is a browser-based control environment. Use it to access all of the web-based functionality available 
as part of ZENworks Asset Management. 

How to Get Started 
Use the following topics to get you started using ZENworks Asset Management to manage your assets. 

 Web Console Overview - How to get around the Web Console. 
 Software Management Overview - Basic overview of the compliance process, including 

the steps required to view the compliance status for a single product. 
 Compliance Building Blocks - The Parts of the ZENworks Asset Management system. 
 Recommended Approach - The steps to get management of your assets under way.  

Novell Trademarks 
For a list of Novell trademarks, see the Novell Trademark and Service Mark list. 

Apache Server 
The ZENworks Asset Management Web Console uses the Apache Tomcat server.  
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Using the Web Console 
See below for general information about how to get around the Web Console. 

Navigation Overview 
The ZENworks Asset Management Web Console contains two navigation bars across the top of the window. Depending 
on page you are viewing, there may also be a left navigation pane. 

 The top bar contains three buttons: Help, Options, and Log Out, described below. 
 The second bar, a tabbed navigation bar, contains four tabs: Home, Asset Inventory, 

Asset Management, and Administration, described below. Each tab contains links to a 
number of pages. 

 The left navigation pane contains a Menu tab and sometimes a Filter tab, described 
below. 

Notes:  

 The Asset Management tab appears only if you have purchased the full version of 
ZENworks Asset Management.  

 The Administration tab appears only if you have Enterprise Administrator or Enterprise 
Assistant privileges.  

 All ZENworks Asset Management users have access privileges to the certain tabs. Access 
is limited to other tabs, depending on your user role. For more information, see 
Security and Access.  
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Navigating the Web Console 

 Click Help to view the Web Console's online help system. 
 Click Options to edit available options for the Web Console. Options vary, depending 

on your user role. 
 Click Log Out to log out of the Web Console. 
 Use the Home tab to view to the Web Console Home page. 

Asset Inventory Tab 

 Use the Asset Inventory > Workstation Inventory page of the Web Console to view 
workstation hardware and software inventory, and to initiate scans of selected 
workstations. 
 
For computers with the ZENworks Asset Management client software installed, view a 
list of machines and comprehensive hardware and software reports, find machines, 
create, save and run custom reports, set alerts based on custom reports, edit machine 
demographics, create Local Products and execute scan now commands for one or more 
machines. 

 Use the Asset Inventory > Network Discovery page of the Web Console to view and 
manage your printers, hubs, routers, and other network hardware discovered using the 
ZENworks Asset Management Network Discovery Engine. 
 
For devices discovered through the Network Discovery Engine, view a list of devices 
and reports, create, save and run custom reports, set alerts based on custom reports, 
identify machines without the ZENworks Asset Management client software installed, 
and edit device demographics and lease information.  

Asset Management Tab 

 Use the Asset Management > Software Usage page of the Web Console to view a 
variety of software usage reports, including Application usage, Software File usage, 
Server Software usage, and Web Application usage.  
 
For Windows computers with the ZENworks Asset Management client software installed, 
view local and server-based application usage by product, user and machine. Also view 
usage associated with collected software files. 

 Use the Asset Management > Software Management page of the Web Console, 
(formerly called "Software Compliance") to manage and reconcile software purchase 
records and to view a variety of product, license, and compliance reports generated by 
ZENworks Asset Management Software Management. 
 
Import software purchase records, manage product catalog, define license 
entitlements, reconcile product catalog to discovered products, attach document files, 
allocate licenses to groups or workstations, establish software standards, view 
compliance status and usage reports, and create, save, and run custom reports. 
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 Use the Asset Management > Contract Management page of the Web Console to 
manage and reconcile software purchase records and to view a variety of product, 
license, and compliance reports generated by ZENworks Asset Management Software 
Management. 
 
Define IT contract details, including key dates, vendor, financial, SLA, lease, and 
renewals, attach related documents, associate contracts with assets, licenses, and 
demographics. Set date email notifications, view contract reports, and create, save, 
and run custom reports. 

Administration Tab 

 Use the Administration > Local Software Products page to manage local products. 
 
View, edit, and delete local software products created through local product creation 
reports. 

 Use the Administration > Web Applications page to define and manage Web 
Applications. 
 
View, add, edit, and delete web applications. 

 Use the Administration > Documents page to manage documents associated with 
contracts. 
 
Upload, view and delete document files available for attachment to Contract and 
License Records. 

 Use the Administration > Alert Status page to manage Alerts and Date Notifications. 
 
Review details about the Alerts and Date Notifications that have been setup in 
ZENworks Asset Management. 

 Use the Administration > User Roles page to add, edit, and delete ZENworks Asset 
Management users. 
 
Add, change and remove user security privileges, including assigning roles and 
individual user access  
rights for Web Console tabs and folders, and change user passwords. 
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The Menu and Filter Tabs 
From each page of the Web Console, one or both of the following tabs is available: 

 

 Menu tab - All pages of the Web Console have a Menu tab, from which you can access 
the commands and reports available from the page.  

 Filter tab - Many pages also have a Filter tab, allowing you to narrow a search or limit 
the amount of data contained in a report. For more information on using filters, see 
Using Filter and Sort Options. 

Customizing the Web Console 
To a certain extent, you can customize the Web Console. For more information see Web Console Options. 

Logging In to the Web Console 

You can launch the Web Console in two ways. For each method, the Log-In procedure is slightly different: 

 From ZENworks Asset Management Manager - You do not have to log in to the web 
console; your Manager authentication is used automatically. The default tab appears 
immediately. 

 Using a URL supplied your ZENworks Asset Management administrator - Paste the 
URL into your browser's address box. When you first enter the Web Console from a URL, 
a Log In page appears. Enter the user name and password supplied by your 
administrator. 
 
The default URL is: 
 
   http://<your server>:8080/rtrlet/rtr?act=network.Login&rtyp=login 

Logging Out of the Web Console 

To log out of the Web Console: 

 Click Log Out at the top right of the Web Console, or exit your browser.   

Security and Access 
Your level of user role determines which data you are able to access, view or edit. 

 Each Web Console page has its own default limitations with respect to user roles, as 
shown in the table below. An Enterprise Administrator can limit any user's access to any 
Web Console page. 

 An Enterprise Administrator can also limit access all standard reports, all custom 
reports, or to specific folders of standard or custom reports. See About Page- and 
Folder-level Security below. 
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Web Console Tabs and User Roles 

The table below shows the default level of access to Web Console pages for each User Role. 

Notes: 

 The table below shows only the default access for different user roles. An Enterprise 
Administrator can place further limitations on any user's access from the Administration 
tab's User Roles page. 

 "All functions" includes creating, editing, exporting and importing custom report 
definitions.  

Page Enterprise 
Administrator 

Enterprise 
Assistant 

Enterprise 
Analyst 

Domain 
Administrator 

Domain 
Assistant 

Domain 
Analyst 

Asset Inventory Tab 

Workstation 
Inventory 

View all data 
 
All Custom 
Report 
functions 
for all 
domains 

View all 
data  
 
All Custom 
Report 
functions 
for all 
domains 

View all data 
 
View existing Custom 
Reports only 

View your 
domain(s) 
only 
 
All Custom 
Report 
functions 
for your 
domain(s)  

View your 
domain(s) only 
 
View existing 
reports only  

View your 
domain(s) only 
 
View existing 
reports only  

Network 
Discovery 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all 
domains 

View, 
Add, 
Edit, 
Delete 
 
All Custom 
Report 
functions 
for all 
domains  

View Only 
 
View existing Custom 
Reports only 

No access  No access  No access  

Asset Management Tab 

Software Usage 

View all data 
 
All Custom 
Report 
functions 
for all 
domains 

View all 
data  
 
All Custom 
Report 
functions 
for all 
domains  

View All Data 
 
View existing Custom 
Reports only 

No access  No access  No access  

Software 
Management 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all 
domains 

View, 
Add, 
Edit, 
Delete 
 
All Custom 
Report 
functions 
for all 
domains  

View Only 
 
View existing Custom 
Reports only 

No access  No access  No access  

Contract 
Management 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all 
domains 

View, 
Add, 
Edit, 
Delete 
 
All Custom 
Report 
functions 
for all 
domains  

View Only 
 
View existing Custom 
Reports only 

No access  No access  No access  



Using the Web Console 

7 

 

Administration Tab 

Local Software Products 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all domains 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all domains  

No access  No access  No access  No access  

Web Applications 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all domains 

View, Add, 
Edit, Delete 
 
All Custom 
Report 
functions 
for all domains  

No access  No access  No access  No access  

Documents View, Add, 
Edit, Delete  

View, Add, 
Edit, Delete  No access  No access  No access  No access  

Alert Status 

View all data 
 
All Custom 
Report 
functions 
for all domains 

View all data 
 
All Custom 
Report 
functions 
for all domains  

No access  No access  No access  No access  

User Roles View, Add, 
Edit, Delete  No access  No access  No access  No access  No access  

Other 

Options All functions Default page.  
Password 

Default page.  
Password 

Default page.  
Password 

Default page.  
Password 

Default page.  
Password 

About Page- and Folder-level Security 

By default, a user is given access defined by the role assigned to the user. Within those access limits, an Enterprise 
Administrator can further limit access for that user. 

 

A user can be prevented from viewing the following: 

 Any page normally available by default 
 Any report folder 
 Any custom report folder 

 

 



Using the ZENworks Asset Management Web Console 

8 

Web Console Options 
Use the Web Console Options page to: 

 Specify the tab that appears after you log in to the Web Console  
 Change your login password 
 Specify the graphics file used to display your company logo on reports (Enterprise 

Administrators only) 
 Specify an E-mail server for use with Alerts and Notifications (Enterprise Administrators 

only) 
 Manage a list of E-mail contacts to be used with Alerts and Notifications (Enterprise 

Administrators only) 
 Specify the default settings for Date Notifications 

 

Note to Administrators: By default, Software Management reports run automatically with the default filter options 
when you call them from the Asset Management > Software Management tab. If you have large amounts of data, there 
may be a significant delay before the report appears. You can disable this feature, so that the report does not run until 
you set up a filter and click Search. For more information see TID #10100612. 

Changing the Default Tab 

When you log in to the ZENworks Asset Management Web Console the Home tab is selected by default. You can change 
what appears by default, using the Web Console Options page.  

 

To change the default tab: 

1. Near the upper right corner of the Web Console page, click Options. The Web Console 
Options page appears in a new window. 

2. From the Default Login Tab drop-down menu, choose the tab you want to appear by 
default. 

3. Click Update. The next time you log in, the selected tab appears. 

Changing Your Password 

Use the Password Maintenance section of the Web Console Options page to change your login password. 

 

To change your login password: 

1. Click Change Password. The Change Password window appears. 
2. Enter your current password in the Enter Current Password box. 
3. Enter your new password in the Enter New Password box and again in the Enter New 

Password Again box. 
4. Click Submit. Your password is changed. 
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Displaying Your Company Logo On Reports 

You can display your company logo on the reports that appear in the Web Console. 

 

Note: The file must be in .GIF format. 

 

To display your company logo in the Web Console and in reports: 

1. Copy the graphics file containing your company logo into the 
\Tomcat4\webapps\rtrlet\brandinglogos directory on the machine where your ZENworks 
Asset Management Web Console is installed. 

2. Near the upper right corner of the Web Console page, click Options. The Web Console 
Options page appears. 

3. In the Logo File Name text box, enter the name of the graphics file containing your 
company logo. 

4. Click Update. The next time you log in, your logo appears on all reports available from 
the Web Console. 

 

Specifying an E-mail Server for Alerts and Date Notifications 

To send Alerts when custom reports are run, or to send Date Notifications associated with contracts, you must specify 
an SMTP server to use for sending Alert and Date Notification E-mail messages. 

 

To specify an SMTP server: 

1. Near the upper right corner of the Web Console page, click Options. The Web Console 
Options page appears in a new window. 

2. In the Manage E-mail Server section of the Web Console Options page, click Manage E-
mail Server. The E-mail Server Information page appears in a new window. 

3. In the SMTP Server box, enter the name or IP address of the SMTP Server you want to 
use. Edit the Port if appropriate. 

4. In the Sender E-mail Address box, enter the address you want to appear as the sender 
of the email. 

5. In the E-mail Account Login Name box, enter the login name for the E-mail account 
you want to use for sending E-mail messages. 

6. In the E-mail Account Password box, enter the password for the specified E-mail 
account. 
 
Note: ZENworks Asset Management stores the password in encrypted form. 
  

7. Enter the same password in the Verify Account Password box. 
8. Click Update. Alert and Date Notification E-mail messages are now sent through this 

account. 
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Importing E-mail Addresses for Use With Alerts and Notifications 

You can import a group of E-mail addresses you want to appear in the Contacts list in the Schedule/Alert window or in 
a Date Notification. Addresses can be imported in two ways: 

 

 From information gathered by ZENworks Asset Management 
 From a comma-separated list in a text file 

 

You can also delete all existing addresses from the Contacts list. 

Importing from Inventory Data 

You can import E-mail addresses into the Contacts list from Inventory Data collected by ZENworks Asset Management 
during the inventory process. This information could come from the Collection Editor, from Active Directory Imports, or 
can be entered directly from ZENworks Asset Management Manager. 

 

To import E-mail addresses from inventory data: 

1. In the Manage E-mail Addresses section of the Web Console Options page, click 
Manage E-mail Addresses. The Manage E-mail Addresses window appears. The default 
setting of the Import From drop-down menu is set to Inventory Data. 

2. Click Import. E-mail addresses are imported from inventory data. All available E-mail 
addresses are imported from workstation information in your inventory. 

Importing Addresses from a Text File 

You can import E-mail addresses from a comma-separated text file. The format is: 

 

[name],[email address][CR] 

Example:  

 

James Doe, jpdoe@novell.com 

Jane H. Doe, jhdoe@novell.com 

To import E-mail addresses from a text file: 

1. In the Manage E-mail Addresses section of the Web Console Options page, click 
Manage E-mail Addresses. The Manage E-mail Addresses window appears.  

2. From the Import From drop-down menu, choose to Comma-Separated File. The E-
mail Address File box appears. 

3. Click Browse..., choose the text file you want to import, and click Open. The path for 
the selected file appears in the E-mail address import file box. 

4. Click Import. The E-mail addresses in the selected file are imported. 
 
Note: If the file contains any addresses that match existing addresses, they are not 
imported. 
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Deleting all E-mail Addresses from the Contacts List 

You can delete all E-mail addresses from the Contacts list. 

 

To delete all E-mail addresses from the Contacts list: 

1. In the Manage E-mail Addresses section of the Web Console Options page, click 
Manage E-mail Addresses. The Manage E-mail Addresses window appears. 

2. Click Delete... A confirmation window appears. 
3. Click Ok. All E-mail addresses are deleted from the Contacts list. 

Changing the Default Settings for Date Notifications 

Use the Default Date Notification Settings section of the Web Console Options page to specify the default settings for 
Date Notifications. 

To change the default setting for Date Notifications: 

 

1. Click Default Date Notification Settings. 
2. In the Send Notification X Days Before Associated Date box, enter the default 

number of days before a Notification's specified date you want the notification to be 
sent. 

3. If you want the notification to be repeated, click to select Repeat Notification, then 
specify the period and repeat count in the Every [Day/Week/Month] for [X] 
[Days/Weeks/Months] boxes. 

4. If you want the notification record to be deleted when all instances of the notification 
have been sent, click to select Delete Date Notification Record When Complete. 

5. Click the left or right arrow buttons to move E-mail address in the Contacts box to or 
from the To box. 

6. If you want to specify a default additional recipient, enter it in the Additional 
Recipients box. 

7. When finished, click Submit. The default settings are saved. 
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Viewing Reports 
Use the Standard reports to view and filter data in useful ways. For every page that contains Standard reports, they 
appear in the Reports folder of the Menu tab in the left frame.  

 

Depending on which report you choose, the right frame may show different types of information: 

 

 Some reports display automatically when you click them. Most reports display a 
summary, from which you drill-down to greater detail as needed. 

 Some reports require you to enter filter criteria before viewing the report. 
 Some reports provide a History column, from which you can view Change History for a 

workstation or component. See Viewing Change History. 

Using Custom Reports 

You can also create, view, and edit custom reports, and create Alerts from them. For more information, see Using 
Custom Reports and Alerts.  
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Viewing Graphs  
Many reports and lists allow you to view and print the data in a graph format. This feature creates a file in PDF format, 
and uses the Adobe Acrobat Reader plug-in to display the graph in your browser. 

 

Note: Adobe Acrobat Reader is required. 

Viewing a Graph 

If a report contains support for graph viewing, a G raph link appears at the bottom of the report window. If the report 
contains more than 100 lines, a G raph (All) link appears. 

 

To view a report as a graph: 

1. View the report. Use Filter and Group options as necessary to narrow your search. 
2. Click G raph. A graph of the data in the current window in PDF format appears in a new 

window. If the current report contains more than 100 lines, click G raph (All) to graph 
all the data in the report. 

The PDF contains at least three pages - a bar chart, a pie chart, and a line chart. Bar charts can span multiple pages. 
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Exporting Data 
You can export data from a report shown in the right frame of the Web Console in the following formats: 

 Excel (.XLS) - You can export report data in Excel's native format. If you have Excel, 
you can open this file directly with Excel.  

 Comma-separated file (.CSV) - You can export report data to a comma-separated text 
file. This file contains one line per row, with row columns in each line separated by 
commas. 

 Portable Document Format (.PDF) - You can export report data to a PDF file. 

Exporting Data From the Current Window 

If the report you are viewing has 200 rows or fewer, all items are included in the exported data. Use the Excel, CSV, or 
PDF buttons at the bottom of the right frame to export only the data for the current window. 

Exporting Data For the Entire List 

If the report that you are viewing contains more than 200 rows, it is broken into multiple pages. Use the Excel (All), 
CSV (All), or PDF (All) buttons at the bottom of the right frame to export all report data. 

Exporting the Data 

All export methods work in exactly the same way. 

To export the data shown in the current window: 

1. Click Excel, CSV, PDF, Excel (All), CSV (All), or PDF (All), located at the bottom of 
the right frame.  The File Download window appears. 

2. In the File Download window, 
To open the file, click Open. The application associated with the export file type is 
launched, and opens the exported file.  
To save the file, click Save. A standard file Save As dialog appears. Enter a file name, 
choose a location, and click Save. 
The report is exported in the selected format. 

Note: If your browser is set up with a plug-in for PDF format (most browsers are,) the document appears in a 
browser window. If you want to save the document, click the Acrobat Reader's save button. Alternatively, 
you can right-click or Control-click the export link (Excel, CSV, etc.) and choose the appropriate command 
to save the file. 
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Using Custom Reports and Alerts 
In addition to viewing the Standard reports and Custom reports available from a given Web Console page, you can 
create custom reports in any of these pages for a wide variety of purposes. 

 

Any of these reports can be viewed and printed, but you can also schedule them to run periodically. The output can 
either be stored automatically for later viewing, or can be sent as an e-mail Alert. 

Custom Reports and Web Console Pages 

The options available in a custom report vary, depending on which page the report is created in. Only those options 
that are relevant to a particular page appear, including report focus, column names, and filtering criteria. Each page 
has its own set of reports and folders. 

 

See Also 

Viewing the Custom Reports List 

What You Can Do With Custom Reports 

Working With Custom Reports 

Working With Custom Report Folders 

About Custom Report Scope 

Custom Report Reference 

Viewing the Custom Reports List 

Each page has its own set of custom reports. Your level of permissions determines which pages and which custom 
reports you can view and edit. For more information, see Security and Access. 

 

To view the Custom Reports List: 

1. Click the tab. A navigation tree appears in the left frame. 
2. Click plus (+) to expand the Custom Reports branch of the tree. 
3. Continue to expand branches of the tree until you find the report you want. 
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What You Can Do With Custom Reports 

 Run them just as they are. A number of pre-defined custom reports are shipped with 
new versions of ZENworks Asset Management. 

 Edit an existing report. You may find that some aspect of a report does not meet your 
needs. In this case, you can edit the report. Novell recommends that you make a copy 
of the report definition before you edit it. 

 Copy an existing report. You may find that a report meets your needs, but you would 
like a similar report with slightly different search criteria. For example, from the 
"Compliance - Adobe Products" report, you might make a "Non-compliance - Adobe 
Products" report. You can simply copy the definition, change the name, and change the 
search criteria. 

 Create a new report. You can create a completely new report from scratch, and save 
it in any folder you choose. 

 Create new folders to hold report definitions. You may find yourself creating many 
report definitions. You can create new folders to help you organize your definitions. 
You can also move reports from one folder to another. 

 Schedule a report to run periodically. You may want to run certain reports daily, 
weekly, or monthly. You can schedule them to run automatically. The results of the 
reports appear in the Scheduled Reports Output folder. 

 Schedule a report to run as an Alert. You can schedule a report to run periodically, 
with the results sent by email to one or more recipients. You can also choose to have 
the results stored in the Scheduled Reports Output folder. 

 Delete or rename a report. You may find you don't need a particular report definition, 
or that the name is not useful. You can delete or rename the report. 

 Delete or rename a folder. You may find you don't need a particular folder any more, 
or that the name is not useful. You can delete or rename the folder. 

 Import and export report definitions - Novell and our partners may create a custom 
report definition for a particular purpose. If you have the proper permissions (see 
below), you can import these custom report definitions. 

Notes:  

 Your user role determines which of the functions above you can perform. For more 
information user roles, see Security and Access. 

 For Scheduled Reports Output, the report scope and your user role determine which 
reports are visible to you. 

Working With Custom Report Folders 

When you first install ZENworks Asset Management, a number of pre-defined custom reports are included in the Custom 
Reports folder. By default, any new reports you create appear in a folder you are viewing when you create the report. 
You can create new folders, rename or delete existing folders, and move custom report definitions between folders. 

Viewing the contents of a custom report folder 

You can view the contents of any folder as a report definition summary list, or as a list of links in the Custom Reports 
tree. 

To view the contents of a custom report folder: 

 Click the link for the folder whose contents you want to view. A summary list of reports 
contained in the folder appears in the right frame. 

 Click the folder's plus (+) icon to expand the folder. A list of report definitions appears 
as links in the Custom Reports tree below the folder link. 
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Creating a new custom report folder 

You can create as many custom folders as you like. Each folder appears as a sub-folder of the Custom Reports tree. 

To create a new folder: 

1. In the Custom Reports tree, click the Custom Reports link. A summary of existing 
reports and folders appears in the right frame. 

2. At the bottom of the right frame, click Add New Folder. The New Folder page appears 
in a new window. 

3. Enter a name in the New Folder text box. 
4. Click Add. The new folder appears in the Custom Reports tree. 

Renaming a custom report folder 

You can rename any existing custom reports folder. 

To rename a custom reports folder: 

1. Click the link for the folder you want to rename. A summary list of reports appears in 
the right frame. 

2. At the bottom of the right frame, click Rename Folder. 
3. The Rename Folder page appears in a new window. 
4. In the New Name box, enter a new name for the folder. 
5. Click Save. The folder appears in the Custom Reports tree with its new name. 

Moving or copying a custom report from one folder to another 

You can move an existing report from one folder to another. You can also copy a report, saving the copy in a new 
folder. 

To move a custom report to a different folder: 

1. In the Custom Reports tree, click to select the report you want to move. A report 
definition summary appears in the right frame. 

2. At the bottom of the right frame, click Edit. The selected report's definition appears in 
a new window. 

3. In the Folder drop-down list, choose the folder to which you want to move the report 
definition. 

4. At the bottom of the report definition window, click Save. The report definition is 
moved to the new folder. 

 

To copy a custom report to a different folder: 

1. In the Custom Reports tree, click to select the report you want to copy. A report 
definition summary appears in the right frame. 

2. At the bottom of the right frame, click Copy. A copy of the selected report's definition 
appears in a new window. 

3. In the Name box, enter a new name or edit the existing name. 
4. In the Folder drop-down menu, choose the folder to which you want to save the copied 

report definition. 
5. At the bottom of the report definition window, click Save. The copied report definition 

is saved in the new folder. 
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Deleting a custom report folder 

When you delete a custom report folder, you delete all report definitions contained in the folder. Be sure you want to 
delete all the report definitions in the selected folder.  

 

To delete a custom reports folder: 

1. In the Custom Reports tree, click the link for the folder you want to delete. A list of 
reports appears in the right frame. 

2. At the bottom of the right frame, click Delete Folder. A confirm dialog appears. 
3. Click Delete to delete the folder. The selected folder is removed from the Custom 

Reports tree. 

Working With Custom Reports 

You can create, edit, copy, run, rename, or delete a custom report. You can also schedule it to run periodically, either 
as a report to be stored in the Scheduled Reports Output folder for later viewing (or deleting), or as an alert to be E-
mailed to one or more recipients, or both. You can export a custom report definition that can be imported for use on 
another ZENworks Asset Management server.  

 

Reports can also depend on the output of other reports, including results in one report based on the output of another. 

Editing an existing custom report 

ZENworks Asset Management comes with a number of custom reports. Any of these reports can be edited. 

 

Note: You must have the correct permissions to edit a custom report. For more information, see Security and Access. 

 

To edit an existing report: 

1. In any of the custom reports folders in the left frame, click the report definition you 
want to edit. A summary of the selected report definition appears in the right frame. 

2. At the bottom of the right frame, click Run. The report runs, with the results appearing 
in the right frame. If no entries appear, no data was found that matches your report's 
search criteria. 

 

For a complete reference to the Custom Report Definition window, see Custom Report Window Reference. 
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Copying an existing custom report 

You can create a copy of any report definition. 

 

To copy an existing report: 

1. In any of the custom report folders in the left frame, click the report definition you 
want to copy. A summary of the selected report definition appears in the right frame. 

2. At the bottom of the right frame, click Copy. The Custom Report Definition page opens 
in new window. The name box contains "Copy of " and the name of the report you are 
copying. 

3. Edit the name of the report if you want to change it. 
4. Select a new folder if you want to save it in a different folder from the original. 

Note: If you folder you want to save it in does not exist, you can save it in the current 
folder and move it later. 

5. Edit the Scope, Columns and Criteria areas of the copied report. For a complete 
reference to the Custom Report Definition window, see Custom Report Window 
Reference. 

6. When finished, click Save. The new copy is saved in the selected folder. 

Creating a new custom report 

You can create a completely new custom report. 

 

To create a new report: 

1. In the left frame, click any custom report folder. A list of existing reports contained in 
that folder appears. 

2. At the bottom of the right frame, click New Report. The New Report page opens in a 
new window. 

3. Enter a name for the new report. 
4. In the Focus area, click to choose a Focus for the report. The Focus determines which 

columns and search criteria are available to your report. 
5. Click Continue... The Custom Report Definition page appears. 
6. In the Name box, edit the name if you want to change it. 
7. Enter a Description if you want to include one. 
8. From the Folder drop-down list, choose the folder you want to store the report 

definition in. 
Note: If you folder you want to save it in does not exist, you can save it in the current 
folder and move it later. 

9. Edit the Scope, Columns and Criteria areas of the new report. For a complete 
reference to the Custom Report Definition window, see Custom Report Window 
Reference. For more on Report Scope, see About Custom Report Scope. 

10. If you find that you have chosen the wrong Focus for the report, click Back and choose 
a new focus. 

11. When finished, click Save. The new report is saved in the selected folder. 
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Creating a new Alert 

Creating an Alert is identical to creating a custom report, except that you can specify one or more recipients of an E-
mail message. The message can contain a link to a stored report, or you can choose to attach an Excel spreadsheet. 

 

For more information, see Scheduling a custom report, an alert, or both. 

 

When you save an Alert, it appears in the Alerts folder. 

Running a custom report 

You can run a custom report at any time, and view its output in the right frame. 

 

To run a custom report: 

1. In any of the custom report folders in the left frame, click the definition you want to 
run. A summary of the selected report definition appears in the right frame. 

2. At the bottom of the right frame, click Run. The report runs immediately, and the 
results appear in the right frame. 

Scheduling a custom report, an alert, or both 

You can schedule a custom report to run periodically. You can: 

 

 Run the report and save the output to the Scheduled Reports Output folder. 
 Run the report as an Alert, and E-mail the resulting output to one or more specified 

addresses. 
 Run the report as an Alert, and E-mail the resulting output to one or more specified 

addresses, but also save the output to the Scheduled Reports folder. 
 
Note: The addresses available in the Contacts list, the return address of the sender, 
and the outgoing mail server are specified in the Web Console Options page. For more 
information, see Web Console Options. 

 

To schedule a custom report: 

1. In any of the custom report folders in the left frame, click the report definition you 
want to schedule. A summary of the selected report definition appears in the right 
frame. 

2. At the bottom of the right frame, click Schedule/Alert. The Schedule/Alert page 
appears in a new window, showing the name of the selected report definition. 

3. In the Start Date box, click  

       
and click to choose a date from the calendar. 

4. From the Frequency drop-down menu, choose how often you want the Alert to run. 
5. In the Output section, click to choose Store Report Results, Send an Alert, or Both.  
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6. If you want an Alert to be sent only when matching records are found and the report 
contains data, select Send alert/Store results only when matching records are 
found. 

7. In the Maximum Records box, enter the maximum number of records you want to 
include in the report. 

8. If you chose Send an Alert or Both, a number of additional options appear. In the 
Delivery Format section, choose Excel Attachment or Link to Stored Report. 

9. In the Contacts box, click to select the recipients you want to send the alert to. 
10. To move the selected recipients to the To box, click  

         
To move all recipients, click  

        .  
For a complete reference to the Custom Report Definition window, see the schedule 
section of the Custom Report Window Reference topic. 

11. If you want to specify additional recipients, enter their E-mail addresses in the 
Additional Recipients box, separated by commas (,). 

12. When finished, click Save. The Alert or report runs on the specified schedule. 

Viewing and Deleting the output of a scheduled report 

Use the Scheduled Reports Output folder of the Custom Reports tree to view a list of reports whose output has been 
stored there. You can view the list of reports by title or by date. You can also delete any stored report. 

 

To change the way the Scheduled Reports Output folder is organized: 

1. In the Custom Reports tree, click the link for the Scheduled Reports Output folder. A 
Report Group selector appears in the right frame. 

2. From the Report G roup drop-down menu, choose to group reports by Date or by Title. 
3. Click Submit. An All Titles or All Dates subfolder appears in the Scheduled Reports 

Output folder in the Custom Reports tree. 

 

To view a list of available reports in the Scheduled Reports Output folder: 

 In the Custom Reports tree, expand the Scheduled Reports Output folder, then expand 
the All Titles or All Dates subfolder. A list of stored reports appears in the Custom 
Reports tree. Click a report link to view the report. 

 In the Custom Reports tree, expand the Scheduled Reports Output folder, then click 
the link for the All Titles or All Dates folder. A list of reports appears in the right 
frame. Click a report link to view the report. 

 

To delete a stored report: 

1. View the report as described above. The selected report appears in the right frame. 
2. At the bottom of the right frame, click Delete Report. A confirm window appears. 
3. Click Delete to delete the selected report. It disappears from the list of custom reports 

in the left frame. 
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Renaming a custom report 

You can rename any existing report definition. 

 

To rename a custom report: 

1. In any of the custom report folders in the left frame, click the report definition you 
want to rename. A summary of the selected report definition appears in the right 
frame. 

2. At the bottom of the right frame, click Edit. The Custom Report Definition page 
appears in a new window. 

3. In the Name box, edit the report name. 
4. When finished, click Save. The selected report definition appears in the selected folder 

with the new name. 

Deleting a custom report 

You can delete a custom report definition. 

 

Caution: You cannot retrieve a report definition once you have deleted it. 

 

To delete a custom report definition: 

1. In any of the custom report folders in the left frame, click the report definition you 
want to delete. A summary of the selected report definition appears in the right frame. 

2. At the bottom of there right frame, click Delete. The Custom Report Definition page 
disappears from the Custom Reports tree. 

Importing and Exporting Custom Report Definitions 

You can import a custom report definition created on another ZENworks Asset Management system. You can also export 
your own custom report definitions for use on other ZENworks Asset Management systems. 

 

Note: You must have proper permissions to import a report definition. For more information, see Security and Access. 

 

To import a report definition: 

1. Click the link for Custom Reports. A list of report folders appears in the right frame. 
2. At the bottom of the right frame, click Import Custom Report Definition. The Import Custom Report 

Definition window appears. 

3. Click Browse... and locate the file containing the custom report definition. 
4. Click Import. The selected report appears in the Imported Report Definitions folder. 

 
Note: If you do not already have one, an Imported Report Definitions folder is created 
for you automatically. 
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To export a report definition: 

1. In the Custom Reports tree, click the link for the custom report definition you want to 
export. A summary of the report definition appears in the right frame. 

2. In the lower right corner of the right frame, click Export. A standard Save As dialog 
appears. 

3. Choose a location for the file, and click Save. The report definition is saved in a file at 
the specified location. 

Dependent Reports 

When creating custom reports, you can make the results in one report depend on the output of another report. 

 

You could use this feature, for example, to create a report that shows all workstations in Building X that have a 
particular application installed (or not installed). 

Dependent Reports in the Workstation Inventory Page 

In the Asset Inventory > Workstation Inventory page, a report can depend on any Workstation report.  

 

You can specify that results from your Workstation Inventory report appear only if a workstation appears in another 
report. This is useful, for example, if you want to show workstations in a particular group that do not have a certain 
product installed on them. 

Dependent Reports in the Network Discovery Page 

In the Asset Inventory > Network Discovery page, a report can depend on any Network Device report.  

 

You can specify that results from your report appear only if a network device appears in another report. This is useful, 
for example, if you want to show all buildings in a particular group in which a certain network device is installed. 

Dependent Reports in the Software Usage Page 

In the Asset Management > Software Usage page, a report can depend on any Workstation report.  

 

You can specify that results from your Software Usage report appear only if a workstation appears in another report. 
This is useful, for example, if you want to show workstations in a particular group that have application usage that 
meets certain criteria, such as "All Microsoft Application Usage for Workstations in Building X." 

Creating a Dependent Report 

The process for creating a dependent report is the same in the Workstation Inventory, Network Discovery, and Software 
Usage pages. 

 

To create a report that depends on the output of another report: 

1. Create or edit the report. 

2. In the Custom Report Definition's Criteria section, click  to add a line. 
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3. If you are creating a report from the Workstation Inventory or Software Usage page, 
choose Workstation from the Field drop-down menu. The Operator box changes to in 
report. 
If you are creating a report from the Network Discovery page, choose Network Device 
from the Field drop-down menu. The Operator box changes to in report. 

4. If you want the results of the report to depend on workstations or network devices that 
appear in the report, leave the Operator setting as is. 
If you want the results to appear if the workstation or network device does not exist, 
choose not in report from the Operator drop-down menu. 

5. Click , then choose the report you want this report to depend on. 
6. Make sure that boolean operator for the previous criteria line is set to AND, rather than 

OR. 
7. Choose the rest of the criteria for the report. 

 

Example: Show all Workstations in Building X that have Excel installed 

1. On the Workstation Inventory page, create a report that shows workstations from 
Building X, (named Workstations in Building X). 

2. Create a report showing Workstations that have Excel installed (Product = "Excel"). 
3. Add a line to the Criteria section that depends on the Workstations in Building X 

report. Make sure the boolean operator for the previous line is set to AND. 

When you run the report, it shows only those workstations in Building X that have Excel installed. 

 

About Custom Report Scope 

The scope of a report definition is the area of the enterprise that it has access to.  

 If the scope of the report definition is the entire enterprise, the report produces 
results from the entire enterprise.  

 If the scope of the report definition is a list of domains, the report produces results 
only from those domains. 

How does the report scope get assigned? 

When you create a report definition, it is assigned a scope.  
  

 If you do nothing, your scope is assigned to the report definition. For example, if the 
you are an enterprise level user, the report has access to all domains.  

 If you are a domain level user, the report has access to just the domains that you have 
access to. 

How does the report scope affect what you see? 

The report scope affects what you see only in Asset Inventory and Software Usage reports. You can see only those 
report definitions, schedules, and stored results whose scope is a subset of your scope. The scope of a stored result is 
the same as the scope of the report definition at the time the stored result was created.  

 

You can change scope of the report definition, but a stored result always has the scope it was created with. 
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How do you set or change the report scope? 

You change the scope of a report definition the Custom Report Definition detail page. The scope also appears in the 
header of all custom reports. For more information on editing the report scope, see Working With Custom Reports. For 
a complete reference to the Custom Report Definition window, see Custom Report Window Reference.  

 

The choices available for scope depend on your user role and the domains you have access to.  

 

 Enterprise level users can choose “All Domains” or any combination of domains.  
 Domain level users can choose only from the domains they have access to. 

 

For more information, see Security and Access.  

Custom Report Reference 

The following sections describe the elements that appear in various pages of the Custom Reports features. 

Custom Report Definition Summary 

Use the Custom Report Definition Summary window to view a summary of the Custom Report Definition.  

 Description - Descriptive text about the report 
 Type - Report type and focus 
 Columns - A list of columns in the report 
 Criteria - The search criteria for the report 
 Scope - The report scope 
 Creator - The user who created the report 
 Creation Date - The date the report was created 
 Last Run Date - The date that the report was last run 

 

Use the commands at the bottom of the right frame as follows: 

 Run - Run the selected report immediately. 
 Schedule/Alert - Schedule the selected report to run at a specified time, for a 

specified period, as a stored report, as an alert or both. 
 Edit, Edit Report Definition - Edit the definition of the selected report. 
 Copy - Create a copy of the selected report. 
 Delete - Delete the selected report. 
 Export - Save the report definition to a file that can be imported by another ZENworks 

Asset Management system. 
 Excel - Export the viewed records of the report to an Excel spreadsheet. 
 Excel All - Export all records in the report to an Excel spreadsheet.  
 PDF - Convert the viewed records of the report to a PDF file. 
 PDF All - Convert all records in the report to a PDF file. 
 Graph - Convert the viewed records of the report to a graph, and output to a PDF. 
 Graph All - Convert all of the data in the report to a graph, and output to a PDF. 
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New Report Window 

Use the New Report Window to set the name and focus for a custom report. This is the first step in creating a new 
custom report. 

 

 Name - Enter a name for the new report. 
 Focus - Click to choose a focus for the report. Choosing a focus determines the 

available columns and search criteria for the new report. New focus options may 
appear with new releases. 

Custom Report Definition Window 

Use the Custom Report Definition Window to create or edit report definitions. Through this window, you can specify all 
the information necessary to create a wide variety of reports. 

 

 Name - Enter or edit the name for the report. 
 Folder - Choose a folder in which you want to save the report definition. Use this 

control to move an existing report from one folder to another, or to specify a 
destination folder for a new report. 

 Description - Enter text to describe the report. This description appears in the Report 
Definition Summary. 

 Type - Shows the selected focus for the report. 

 Scope - Set a scope for the report. Click  to choose a domain. For more information, 
see Edit Report Scope Window Reference. 

 Columns  
   

 
Add a column to the report. Click to move a selected column name from the Available box 
to the Displayed box.  

 
Add all columns to the report. Click to move all column names from the Available box to 
the Displayed box.  

 
Remove a column from the report. Click to move a selected column name from the 
Displayed box to the Available box.  

 
Remove all columns from the report. Click to move all column names from the Displayed 
box to the Available box.  

 
Move the selected column up. Click to move the selected column toward the top of the list 
in the Displayed box. This moves the column to the left in the report.  

 
Move the selected column down. Click to move the selected column toward the bottom of 
the list in the Displayed box. This moves the column to the right in the report.  

 



Using the Web Console 

27 

 Criteria 
Use the criteria to include or exclude entries in the report based on a value in the 
database. 
   

 
Add search criteria - Click to add another line of search criteria.  

 
Remove search criteria - Click to remove the selected line from the search criteria.  

 
Choose from a list of available values - Click to select from a list of available values for the 
selected criteria field.  

 
Choose a date from a calendar - Click to view a calendar on which you can click to choose a 
date.  

Note:  
Many Custom Reports appear with default criteria. Except in Custom Reports, ZENworks 
Asset Management automatically filters out the following:  
 

 Workstations that have been marked as deleted 
 Products that have been deleted 

 
In Custom Reports, however, you can view workstations and products that have been 
deleted. For this reason, default criteria in the Custom Reports definitions have been 
established to filter deleted products and workstations. These criteria can be removed 
so that deleted workstations and products can be included.  

 

 Summary Criteria - Some Custom Report types offer Summary Criteria. Use summary 
criteria to include or exclude entries in the report based on a calculated value.  
 
Each available option in the Summary Field drop-down menu corresponds to an 
available column in the Columns section. Summary criteria are added exactly in the 
same way as other criteria. 
 
Example: Many reports include an Installations column, which is available as Summary 
Criteria. If you want to see only products for which you have more than 100 
installations, add a Summary Criteria entry as follows: 
 
        Installations > 100 
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Schedule Window 

Use the Schedule/Alert window to schedule the selected report, either to be stored or to be E-mailed as an alert. 

 

 Start Date - Click  to select a date from a calendar window. 
 Frequency - Choose from the Frequency drop-down menu to specify how often you 

want the report to be run. 
 Maximum Records - Enter a value in the Maximum Records box to limit the number of 

entries in the report. 
 Output - Click to choose a destination for the output of the report. 

 
Click Store Report Results to store the report in the Scheduled Reports Output folder. 
Click Send an Alert (E-mail) to send the report as an E-mail alert to the specified 
recipients. 
Click Both to store the report results and send them as an E-mail alert. 
  

 Non-empty results only - Select or clear this check box to choose whether the result 
should be stored or E-mailed if it the resulting report is empty. 

If Send an Alert (E-mail) or Both is selected 

 Delivery Format - Choose a format for the delivery of the Alert. 
 
Click Excel Attachment to send the report in Excel format as an attachment to the E-
mail. 
Click Link to Stored Report to send an E-mail containing links to the stored report and 
an Excel file stored on the Web Console Server. 
  

 From - Shows the E-mail address of the sender. 
 Recipients - Choose recipients from the Contacts list: 

   

 
Add an E-mail recipient to the Alert. Click to move a selected E-mail recipient from the 
Contacts box to the To box.  

 
Add all E-mail recipients to the Alert. Click to move all E-mail recipients from the Contacts 
box to the To box.  

 
Remove an E-mail recipient from the Alert. Click to move a selected E-mail recipient from 
the To box to the Contacts box.  

 
Remove all E-mail recipients from the Alert. Click to move all E-mail recipients from the 
To box to the Contacts box.  

   Additional Recipients - Enter E-mail addresses for recipients that do not appear in 
the Contacts list. 
 
Note: Addresses can be added to the Contacts list from the Web Console Options page. 
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Edit Report Scope Window 

Use the Edit Report Scope to define the scope for the selected report. For more information, see About Custom Report 
Scope. 

 

 All Domains - Click this button to allow this custom report to be available to all 
domains. 

 Selected Domains - Click this button, then choose the domains for which you want this 
report to be available. 
   

 
Add a domain to the report scope - Click to move a selected domain name from the 
Available Domains box to the Active Domains box.  

 
Add all domains to the report scope. Click to move all domain names from the Available 
Domains box to the Active Domains box.  

 
Remove a domain from the report scope. Click to move a selected domain name from the 
Active Domains box to the Available Domains box.  

 
Remove all domains from the report scope. Click to move all domain names from the 
Active Domains box to the Available Domains box.  

 

Apache License 

                                 Apache License 
                           Version 2.0, January 2004 
                        http://www.apache.org/licenses/ 
        TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 
 
    1.  Definitions. 
        "License" shall mean the terms and conditions for use, reproduction,  
        and distribution as defined by Sections 1 through 9 of this document. 
 
        "Licensor" shall mean the copyright owner or entity authorized by  
        the copyright owner that is granting the License. 
 
        "Legal Entity" shall mean the union of the acting entity and all  
        other entities that control, are controlled by, or are under common 
        control with that entity. For the purposes of this definition, 
        "control" means (i) the power, direct or indirect, to cause the 
        direction or management of such entity, whether by contract or 
        otherwise, or (ii) ownership of fifty percent (50%) or more of the 
        outstanding shares, or (iii) beneficial ownership of such entity. 
 
        "You" (or "Your") shall mean an individual or Legal Entity 
        exercising permissions granted by this License. 
 
        "Source" form shall mean the preferred form for making modifications, 
        including but not limited to software source code, documentation 
        source, and configuration files. 
 
        "Object" form shall mean any form resulting from mechanical 
        transformation or translation of a Source form, including but 
        not limited to compiled object code, generated documentation, 
        and conversions to other media types. 
 
        "Work" shall mean the work of authorship, whether in Source or 
        Object form, made available under the License, as indicated by a 
        copyright notice that is included in or attached to the work 
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        (an example is provided in the Appendix below). 
 
        "Derivative Works" shall mean any work, whether in Source or Object  
        form, that is based on (or derived from) the Work and for which the 
        editorial revisions, annotations, elaborations, or other modifications 
        represent, as a whole, an original work of authorship. For the purposes 
        of this License, Derivative Works shall not include works that remain 
        separable from, or merely link (or bind by name) to the interfaces of, 
        the Work and Derivative Works thereof. 
 
       "Contribution" shall mean any work of authorship, including 
        the original version of the Work and any modifications or additions 
        to that Work or Derivative Works thereof, that is intentionally 
        submitted to Licensor for inclusion in the Work by the copyright owner 
        or by an individual or Legal Entity authorized to submit on behalf of 
        the copyright owner. For the purposes of this definition, "submitted" 
        means any form of electronic, verbal, or written communication sent 
        to the Licensor or its representatives, including but not limited to 
        communication on electronic mailing lists, source code control systems, 
        and issue tracking systems that are managed by, or on behalf of, the 
        Licensor for the purpose of discussing and improving the Work, but 
        excluding communication that is conspicuously marked or otherwise 
        designated in writing by the copyright owner as "Not a Contribution." 
 
       "Contributor" shall mean Licensor and any individual or Legal  Entity 
        on behalf of whom a Contribution has been received by Licensor and 
        subsequently incorporated within the Work. 
 
    2.  Grant of Copyright License. Subject to the terms and conditions of 
        this License, each Contributor hereby grants to You a perpetual, 
        worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
        copyright license to reproduce, prepare Derivative Works of, 
        publicly display, publicly perform, sublicense, and distribute the 
        Work and such Derivative Works in Source or Object form. 
 
    3.  Grant of Patent License. Subject to the terms and conditions of 
        this License, each Contributor hereby grants to You a perpetual, 
        worldwide, non-exclusive, no-charge, royalty-free, irrevocable 
        (except as stated in this section) patent license to make, have made, 
        use, offer to sell, sell, import, and otherwise transfer the Work, 
        where such license applies only to those patent claims licensable 
        by such Contributor that are necessarily infringed by their 
        Contribution(s) alone or by combination of their Contribution(s) 
        with the Work to which such Contribution(s) was submitted. If You 
        institute patent litigation against any entity (including a 
        cross-claim or counterclaim in a lawsuit) alleging that the Work 
        or a Contribution incorporated within the Work constitutes direct 
        or contributory patent infringement, then any patent licenses 
        granted to You under this License for that Work shall terminate 
        as of the date such litigation is filed. 
 
    4.  Redistribution. You may reproduce and distribute copies of the 
        Work or Derivative Works thereof in any medium, with or without 
        modifications, and in Source or Object form, provided that You 
        meet the following conditions: 
 
        (a) You must give any other recipients of the Work or 
            Derivative Works a copy of this License; and 
 
        (b) You must cause any modified files to carry prominent notices 
            stating that You changed the files; and 
 
        (c) You must retain, in the Source form of any Derivative Works 
            that You distribute, all copyright, patent, trademark, and 
            attribution notices from the Source form of the Work, 
            excluding those notices that do not pertain to any part of 
            the Derivative Works; and 
 
        (d) If the Work includes a "NOTICE" text file as part of its 
            distribution, then any Derivative Works that You distribute must 
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            include a readable copy of the attribution notices contained 
            within such NOTICE file, excluding those notices that do not 
            pertain to any part of the Derivative Works, in at least one 
            of the following places: within a NOTICE text file distributed 
            as part of the Derivative Works; within the Source form or 
            documentation, if provided along with the Derivative Works; or, 
            within a display generated by the Derivative Works, if and 
            wherever such third-party notices normally appear. The contents 
            of the NOTICE file are for informational purposes only and 
            do not modify the License. You may add Your own attribution 
            notices within Derivative Works that You distribute, alongside 
            or as an addendum to the NOTICE text from the Work, provided 
            that such additional attribution notices cannot be construed 
            as modifying the License. 
 
        You may add Your own copyright statement to Your modifications and 
        may provide additional or different license terms and conditions 
        for use, reproduction, or distribution of Your modifications, or 
        for any such Derivative Works as a whole, provided Your use, 
        reproduction, and distribution of the Work otherwise complies with 
        the conditions stated in this License. 
 
    5.  Submission of Contributions. Unless You explicitly state otherwise, 
        any Contribution intentionally submitted for inclusion in the Work 
        by You to the Licensor shall be under the terms and conditions of 
        this License, without any additional terms or conditions. 
        Notwithstanding the above, nothing herein shall supersede or modify 
        the terms of any separate license agreement you may have executed 
        with Licensor regarding such Contributions. 
 
    6.  Trademarks. This License does not grant permission to use the trade 
        names, trademarks, service marks, or product names of the Licensor, 
        except as required for reasonable and customary use in describing the 
        origin of the Work and reproducing the content of the NOTICE file. 
 
    7.  Disclaimer of Warranty. Unless required by applicable law or 
        agreed to in writing, Licensor provides the Work (and each 
        Contributor provides its Contributions) on an "AS IS" BASIS, 
        WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or 
        implied, including, without limitation, any warranties or conditions 
        of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A 
        PARTICULAR PURPOSE. You are solely responsible for determining the 
        appropriateness of using or redistributing the Work and assume any 
        risks associated with Your exercise of permissions under this License. 
 
    8.  Limitation of Liability. In no event and under no legal theory, 
        whether in tort (including negligence), contract, or otherwise, 
        unless required by applicable law (such as deliberate and grossly 
        negligent acts) or agreed to in writing, shall any Contributor be 
        liable to You for damages, including any direct, indirect, special, 
        incidental, or consequential damages of any character arising as a 
        result of this License or out of the use or inability to use the 
        Work (including but not limited to damages for loss of goodwill, 
        work stoppage, computer failure or malfunction, or any and all 
        other commercial damages or losses), even if such Contributor 
        has been advised of the possibility of such damages. 
 
    9.  Accepting Warranty or Additional Liability. While redistributing 
        the Work or Derivative Works thereof, You may choose to offer, 
        and charge a fee for, acceptance of support, warranty, indemnity, 
        or other liability obligations and/or rights consistent with this 
        License. However, in accepting such obligations, You may act only 
        on Your own behalf and on Your sole responsibility, not on behalf 
        of any other Contributor, and only if You agree to indemnify, 
        defend, and hold each Contributor harmless for any liability 
        incurred by, or claims asserted against, such Contributor by reason 
        of your accepting any such warranty or additional liability. 
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Using the Asset Inventory Tab 

The Asset Inventory Tab 
Use the Asset Inventory tab to: 

  

 Manage your Workstation Inventory 
 View and manage devices discovered using the Network Discovery engine. 

Note: The reports you are able to view and the data you are able to edit depends on your user role. For more 
information on user roles and access, see Security and Access. 
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Using the Workstation Inventory Page 
Use the Asset Inventory tab's Workstation Inventory page to view a list of systems, and to view a variety of and custom 
reports. 

 

The Workstation Inventory page is divided into two frames: 

 

 The Left Frame - shows a list of systems in your inventory database, organized in the 
form of a tree. Below the inventory list is a list of reports, organized by category. such 
as software, hardware, and usage reports. For detailed information on the System List, 
see Viewing the System List. For more information on using reports, see Viewing 
Reports. 

 The Right Frame - displays the inventory data or report results, depending on what 
branch of the tree you have selected on the left. 

 

To view a report or inventory list: 

1. Expand the tree until you find the list or report you want to view. 
2. Click the link for the selected list or report. 
3. In the right frame, drill-down to the specific information you are looking for.  

 

To change the way data is sorted in a report or list: 

 Click a column heading. The data is sorted by that column. 

To reverse the sort order: 

 Click the column heading again.  

To print a list of systems or a report: 

 Click PDF. The report is converted to a PDF file, ready for printing.  
 
Note: You must have Acrobat Reader installed in order to view and print PDFs. 

   

To export data to an Excel spreadsheet or CSV file: 

 Click Excel. The viewed page of the report is converted to a spreadsheet, and opens in 
Excel. Click Excel All to export all pages of the report to Excel. 

 Click CSV. The report is converted to a comma-separated text file. You can choose to 
Open or Save. If you choose Open, the file is opened in the application associated with 
CSV files. 
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Viewing the System List 

By default, the System List is organized by Department. You can organize the data in a number of ways. 

 

To change the way your system list is organized: 

1. In the left frame of the Asset Inventory > Workstation Inventory page, click System 
List. A list of system groups appears in the right frame. 

2. In the right frame, choose a System G roup from the drop-down list. 
3. If you want to group your systems further, choose a sub-group from the System Sub-

G roup drop-down list. Choose None (the default) if you do not want to sub-group your 
systems. 

4. Click Submit. The System List in the left frame is re-organized to reflect your changes. 

 

Note: When viewing reports from the Workstation Inventory page, if the report you have chosen displays a summary, it 
is organized using your grouping choice from step 2 above. 

 

To view a list of systems within a System List group or sub-group: 

1. In the left frame, click plusses (+) to expand the System List tree, until you see the list 
you want to view. 

2. Click the link for the list you want to view. The list appears in the right frame. 
3. Drill-down through the data on the right to view more details about a particular 

system. 

Scanning a Workstation Immediately 

Sometimes you need to initiate a scan of a workstation between collection cycles. For example, if you have enabled 
Software File Scanning in a Collection Option Set, you might not want to wait until the next scheduled collection to 
scan the machine. You can initiate a scan of one or more workstations from the Web Console. 

  

To initiate the scan of a workstation: 

1. View a list of workstations. The System List on the Workstation Inventory page is a good 
way to find a machine quickly. 

2. At the bottom of the right frame, click Select for Scan. A check box appears next to 
each workstation in the list. 

3. Click the check boxes for the machines you want to scan. Click a checked box to clear 
it. To select or clear all of the check boxes at once, select or clear the Select check 
box at the top of the column. 

4. Click Scan Selected Workstations. A scan is scheduled for immediate execution for 
each selected machine. 
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About Reports & Platforms 

When you collect inventory data from multiple platforms, the following should be kept in mind: 

 Macintosh machines, hardware, and applications appear in reports in the same way 
they do for Windows machines. Macintosh is one type of Platform.  

 Certain reports do not apply to Macintosh, UNIX, or Linux platforms. These reports 
contain additional text at the top of the page, indicating that they are only for 
Windows machines. 

 When discovering products, the platform becomes part of the discovered product 
definition. 

About Workstation Inventory Reports 

The Workstation Inventory reports provide you with many different ways to view the data collected by ZENworks Asset 
Management. 

Using the Workstation Inventory Reports 

Use the Workstation Inventory reports to view your inventory data in a number of ways: 

 

 Find - Use the Find feature to find one or more workstations that match the criteria 
you specify. 

 Systems - Use the Systems menu to view groups of systems (such as workstations and 
servers,) organized in a variety of ways. You can drill down to view comprehensive 
information about each system. 

 Software Applications - Use this set of reports to view your installed software in a 
number of ways - check the status of Anti-virus software, view software by Category, 
Manufacturer, or Product, track duplicate serial numbers, applications that use a lot of 
bandwidth, and view a number of other useful software reports. 

 Software Files - View a list of software files collected when the Collect Software File 
Information box is checked in the Collector Tab of a Collection Option Set. You can 
also view a report showing the usage of any of those files. 

 Hardware Components - Use this set of reports to view installed hardware components 
associated with your systems. View lists of hardware by Category, Manufacturer, or 
Product, check disk space, BIOS versions, serial numbers, processors and memory. 

 Upgrade Readiness - Check the state of your workstations with respect to upgrading 
application software and operating systems. 

 License Tracking - If you are not using ZENworks Asset Management Software 
Management, use this category to view license information that has been entered in 
ZENworks Asset Management Manager. For more information, see Analyzing License 
Compliance in the Administration book of ZENworks Asset Management Manager's online 
help. 

 ZENworks Asset Management Admin - Use the reports in this category to help you 
manage your ZENworks Asset Management installation. 
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Workstation Inventory Custom Reports 

A number of pre-defined custom reports are available with a new installation of ZENworks Asset Management. They 
appear in the following folders. You can also create your own custom reports, either in existing folders or in new 
folders. 

 HW Components - View a number of hardware component-related reports. 
 SW Applications - View a number of Software Application reports, with a focus on Anti-

Virus configuration 
 Systems - View reports related to workstations, with a focus on workstation attributes, 

product or file filtering, connection information, or workstation history. 
 Alerts - View a list of reports that have been created as Alerts. An Alert is a report that 

runs at a specified time, and the output is sent to one or more recipients in an E-mail 
message. 

 Scheduled Reports Output - View a list of reports that have been run at a scheduled 
time. 

Viewing Change History 

The Workstation Detail report contains a History link. Click this link to view Change history for the workstation. 

Many component reports contain a History column, if any history has been recorded. 

 

The history information shown in these reports represents all of the changes, additions, and deletions since the 
workstation or component was first scanned by ZENworks Asset Management, or for the period set in the Keep All 
Workstation History Data for preference in the ZENworks Asset Management Manager's Enterprise Options dialog, 
available from the Tools menu. The default value is one year. 

 

About Software File Reports 

Use these reports, available from the Asset Inventory tab > Workstation Inventory page, to review a list of Software 
Files found on workstations on your network. 

  

  

View any of these reports: 

  

 By Category - Drill down to a list of categories (Software Files by Category), and again 
to a list of software files (Software Files List) for that category. 

 By Manufacturer - Drill down to a list of manufacturers (Software Files by 
Manufacturer), again to a list of products (Software Files: Product List) for that 
manufacturer, again to a list of workstations containing copies of those products 
(Software Files: Workstation List), and finally to a list of software files on a selected 
workstation (Software Files List for Workstation) or a list of products for a selected 
workstation (Software Files: Product List). 

 By Workstation - Drill down to a list of workstations, and again to a list of software files 
on a selected workstation (Software Files List for Workstation) or a list of products for 
a selected workstation (Software Files: Product List). 
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Each report drills down to one or more of these reports: 

  

 Software Files List 
 Software Files by Category 
 Software Files by Manufacturer 
 Software Files: Workstation List 
 Software Files List for Workstation - You can create local products from this list. 
 Software Files: Product List 

  

Software Files Report Columns Explained 

Each report shows a set of columns from the list below, calculated the same way in each report. Certain columns are 
not applicable to certain reports, and do not appear. Where applicable, the calculations used to arrive at a displayed 
value are explained. Much of this information is read from the file's VRB (Version Resource Block) data.  
  

 # of Files, # of Products – The number of files or products found on a particular 
workstation. See "Unique Files, Unique Products" below for an explanation of files and 
products. 

 Unique Files, Unique Products, Total Files – The number of unique and total files 
found. The difference between these two values represents the number of duplicate 
files or products found. A "Unique File" has a unique combination of file name, 
extension and date. A "Unique Product" has a unique combination of Manufacturer, 
Version and Language. A unique file or product is counted only once, even if it appears 
on more than one workstation. 

 Manufacturer, Product, Version – Shows any available information contained in the 
file's VRB data block. (All files sharing the same values in these three fields are 
considered part of the same product.) 

 File Name, Extension, File Date – Identifies the file. 
 Size – The file's size in bytes. 
 Path – The location of the file on the selected workstation. 
 Language – The application's specified language. 
 Category – System File , Ancillary, or Other. Choose these categories in the ZENworks 

Asset Management Manager's Collector tab when defining a Collection Option set.  
 Copies – The number of copies of the file found. 
 Workstation, Login, User, MAC Address - Information about the workstation on which 

one or more software files were found. 

Software Files List 

Report Columns 

  

 File Name, Extension, File Date 
 Category - (Appears only when viewing "All" categories) 
 Copies – Drill down to view the Software Files: Workstation List. 
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Software Files: Workstation List 

Report Columns 

  

 Workstation 
 Login 
 User 
 Mac Address 
 # of Files – Drill down to view the Software Files List for Workstation. You can create 

local products from this list. 
 # of Products – Drill down to view the Software Files: Product List. 

Software Files List for Workstation 

Use the Software Files list to create local products from software files discovered during a Software File scan. 

  

Report Columns: Software Files List 

  

 Select - Click to select or clear checkboxes for software files you want to use to create 
one or more local products. Click to select or clear checkboxes for all files on the 
current page. 

 File Name, Extension, File Date 
 Size 
 Path 

Software Files: Product List 

Report Columns 

 Manufacturer 
 Product 
 Version 
 Language 
 Category 
 Copies – Drill down to view the Software Files: Workstation List Report. 
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Software Files By Category 

Use this report to view Software File grouped by Category. (System File, Ancillary, or Other. Choose these categories in 
the ZENworks Asset Management Manager's Collector tab when defining a Collection Option set.) 

  

The first page of the report shows the available groups as defined by the top-level filter in the System List tree.  

  

Drill Down Tree 

  

Software Files by Category 

Software Files List 

Software Files: Workstation List 

Software Files List for Workstation 

Software Files: Product List 

  

Report Columns 

  

 Category 
 Unique Files 
 Total Files 

Software Files By Manufacturer 

Use this report to view software files grouped by Manufacturer. 

  

The first page of the report shows the available groups as defined by the top-level filter in the System List tree.  

  

Drill Down Tree 

  

Software Files by Manufacturer 

Software Files: Product List 

Software Files: Workstation List 

Software Files List for Workstation 

Software Files: Product List 
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Software Files By Workstation 

Use this report to software files grouped by Workstation. 

  

The first page of the report shows the available groups as defined by the top-level filter in the System List tree.  

  

Drill Down Tree 

  

Software Files: Workstation List 

Software Files List for Workstation 

Software Files: Product List 
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About Reports & Virtual Machines 

ZENworks Asset Management scans machine emulation software, such as VMware and Virtual PC in the same way it 
scans any real workstation. The information reported from these installations should be viewed with the following 
information in mind. 

Finding virtual machines and machines that host virtual machines 

You can identify machines that host virtual machines as well as virtual machine installations.  

A Hosts of Virtual Machines custom report, available in the Custom Reports > Systems folder of the Asset Inventory tab 
> Workstation Inventory page, shows a list of virtual machines. In the same folder, Virtual Machines report lists all 
installed virtual machines. The Workstation Detail report for a machine lists virtual machines at the bottom of the 
report.  

Virtual machines in reports 

Virtual machines look exactly like real workstations in reports. In some reports it may be difficult to distinguish virtual 
machines from real ones. Here are some ways that you can distinguish virtual machines from real ones:  

 System List and Standard Reports - When viewing a list of systems or a standard 
report from the Reports tab, you can specify group and sub-group methods. For either 
the group or sub-group method, you can choose Virtual Machine Type as a group. This 
separates virtual machines from real workstations in all standard reports. 

 Workstation Detail - When viewing the Workstation Detail for a machine, all virtual 
machines installed on that machine are listed at the bottom of the report. If you view 
the Workstation Detail report for a virtual machine, "(Virtual Machine)" appears in the 
report header after the machine name. 

 With Virtual Machines report - The With Virtual Machines report lists all machines on 
which virtual machines are installed, as well as the machine name and other 
information about each installation of a virtual machine 

 Custom reports - Two pre-defined custom reports, the Hosts of Virtual Machines 
report and the Virtual Machines report, allow you to identify hosts of virtual machines 
and virtual machines themselves. The Hosts of Virtual Machines report and the uses the 
Hosts Virtual Machine(s)=Y es criterion to find virtual machine hosts. The Virtual 
Machines report uses the Workstation is Virtual=Y es criterion to find virtual machines 
that have been scanned by ZENworks Asset Management. You can use these criteria in 
your own custom reports. 

Hardware and Software Discovery 

When you scan virtual machines, hardware and software are reported as follows: 

 Software discovery - Any software that is installed within the virtual machine's 
environment is discovered and reported in the same manner as it is on real machines.  

 Hardware discovery - With the exception of the processor, all hardware discovered on 
a virtual machine is virtual. This may cause some inaccuracies in the actual quanities 
when virtual hardware is included along with with real hardware in total quantities.  
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Using the Network Discovery Page 
Use the Asset Inventory > Network Discovery page to view and manage your printers, hubs, routers, and other network 
hardware discovered through the ZENworks Asset Management Network Discovery Engine. 

 

Note: Access to this page is determined by your user role. See Security and Access for more information. 

Overview 

Use the Network Discovery page to view and edit the results of your network discovery scans. 

 

When viewing the Network Discovery page, the Web Console window is divided into two frames: 

 The Left Frame - contains the Device List tree, a list of devices that were discovered 
on your network, organized in the form of a tree. It also contains a list of reports.  

 The Right Frame - depending on what you have selected in the left frame, the right 
frame shows report results or information about your network devices. 

 

To view a report or device list: 

1. Expand the tree until you find the list or report you want to view. 
2. Click the link for the selected list or report. 

 

To change the way data is sorted in a report or list: 

 Click a column heading. The data is sorted by that column. 

 

To reverse the sort order: 

 Click the column heading again.  

 

To print a list of systems or report: 

 Click PDF. The report is converted to a PDF file, ready for printing.  
 
Note: You must have Acrobat Reader installed in order to view and print PDFs. 

To export data to an Excel spreadsheet or CSV file: 

 Click Excel. The viewed page of the report is converted to a spreadsheet, and opens in 
Excel. Click Excel All to export all pages of the report to Excel. 

 Click CSV. The report is converted to a comma-separated text file. You can choose to 
Open or Save. If you choose Open, the file is opened in the application associated with 
CSV files. 
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Viewing the Device List 

By default, the Device List is organized by device Type (Example: network printer, router or switch) and by Subnet. 
You can change the way your device list is organized. 

 

To change how your device list is organized: 

1. In the left frame of the Network Discovery page, click Device List. 
2. In the right frame choose the Device List group you want to use.  (Example: Type, 

Manufacturer, Subnet, or Location) 
3. Choose the Device List sub-group you want to use. (Example: Type, Manufacturer, 

Subnet, Location or None.) 
4. Click Submit. The Device List in the left frame is re-organized to reflect your changes. 

 

To view a list of network devices in a particular Device List group or sub-group: 

 In the left frame of the Network Discovery page, click to select the Device List group or 
sub-group you want to view.  The selected group of devices appears in the right frame.  

 In the right frame, drill-down through the data to view more details about a particular 
device. 

 To convert the data to a PDF, click PDF. 

 

Exporting Data 

You can export data from a report shown in the right frame of the Web Console in the following formats: 

 Excel (.XLS) - You can export report data in Excel's native format. If you have Excel, 
you can open this file directly with Excel.  

 Comma-separated file (.CSV) - You can export report data to a comma-separated text 
file. This file contains one line per row, with row columns in each line separated by 
commas. 

 Portable Document Format (.PDF) - You can export report data to a PDF file. 

Exporting Data From the Current Window 

If the report you are viewing has 200 rows or fewer, all items are included in the exported data. Use the Excel, CSV, or 
PDF buttons at the bottom of the right frame to export only the data for the current window. 

Exporting Data For the Entire List 

If the report that you are viewing contains more than 200 rows, it is broken into multiple pages. Use the Excel (All), 
CSV (All), or PDF (All) buttons at the bottom of the right frame to export all report data. 
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Exporting the Data 

All export methods work in exactly the same way. 

To export the data shown in the current window: 

1. Click Excel, CSV, PDF, Excel (All), CSV (All), or PDF (All), located at the bottom of 
the right frame.  The File Download window appears. 

2. In the File Download window, 
To open the file, click Open. The application associated with the export file type is 
launched, and opens the exported file.  
To save the file, click Save. A standard file Save As dialog appears. Enter a file name, 
choose a location, and click Save. 
The report is exported in the selected format. 

Note: If your browser is set up with a plug-in for PDF format (most browsers are,) the document appears in a 
browser window. If you want to save the document, click the Acrobat Reader's save button. Alternatively, 
you can right-click or Control-click the export link (Excel, CSV, etc.) and choose the appropriate command 
to save the file. 

 

 

 

Adding, Editing, and Deleting Devices 

Adding, Editing, and Deleting Devices 

Using the Network Discovery page, you can: 

 Add a device to your Device List. 
 Edit information for a device that already exists in your Device List 
 Delete a device from your Device List. 

 

Note: To add, edit or delete devices, you must be an Enterprise Administrator or Assistant. 

Adding a Device 

When viewing a list of devices, use the Add button to add a device to the Device List. 

 

To add a device: 

1. Before adding the device, make sure you know it's IP address. The IP address is used to 
make sure that the new device is discovered. 

2. From the Device List tree, click the Device List group or sub-group to which you want 
to add device. The selected list of devices appears in the right frame.  

3. In the right frame, click Add. A blank Device Information form appears in the right 
frame. 

4. In the Device Information form, enter information about the device.  
Note: Required fields are noted with red labels. 

5. Click Submit. The new device appears in the Device List. 
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Editing Device Information 

When viewing a list of devices, use the Edit button to edit the details for the selected device. 

 

To edit the details for a device: 

1. In the selected Device List, drill-down to view the details for the device you want to 
edit. 

2. Click Edit. A Device Information form appears. 
3. In the Edit Device Information form, edit the information for the selected device. 
4. Click Submit. The device details appear, showing the changes you’ve made. 

Deleting a Device 

When viewing a device’s details, use the Delete button to delete the selected device from the Device List. 

 

To delete a device from the Device List: 

1. In the selected Device List, drill-down to view the details for the device you want to 
delete. 

2. Click Delete. A confirmation window appears. 
3. Click OK to confirm. The device disappears from the Device List. 

Adding, Editing, and Deleting Device Groups 

 

You can organize your network devices by Device Group, which gives you some additional control over how you view 
your discovery data. There are four kinds of Device Groups – Type, Subnet, Manufacturer, and Location.  

 

During the discovery process, each network device is automatically associated with a Type, Subnet and Manufacturer 
group. The Location group is a special group you can use to associate devices with demographic or location information 
that is not available during the discovery process.  

 

With the exception of the Subnet group, you can change the group a device is associated with. 
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Changing Device Group Associations 

You can change group associations for a single device, or you can change associations for all devices in a group. You 
can also delete an entire group of devices. 

Changing Group Associations for a Single Device 
When viewing details for a device, use the Edit button to change the device groups (and other details) for the selected 
device. 

 

To change the device group for a single device: 

1. View the details for the device you want to edit. 
2. At the bottom of the window, click Edit. The Device Information form appears, 

containing information for the selected device. 
3. From the Type, Manufacturer, or Location drop-down list, choose a different device 

group. To add a device group, enter text in the box below the drop-down list. 
4. Click Submit. The network device appears in the specified group. 

Changing Group Associations for a Set of Devices 
When viewing all devices of a particular group, use the Edit button to change the device type for the selected devices.  

 

To change the device group for all devices in a group: 

1. In the Device List tree, click to select the group whose type you want to change. The 
selected group appears in the right frame. 

2. At the bottom of the window, click Edit. The Device Group form appears. 
3. In the Device Group form, choose a device group from the Device G roup drop-down 

list, or to create a new device group, enter text in the box below the pop-up menu. 
4. Click Submit. The network devices appear in the selected group. 

Deleting a Device Group 
To delete a device group:  

1. In the Device List tree, click the group you want to delete. 
2. At the bottom of the right frame, click Delete. A confirmation window appears. 
3. Click OK to confirm. The device group disappears from the Device List tree.  
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Using Network Discovery Reports 

When you select a report to run, you may be prompted to enter custom filter criteria. In the Find Device report, each 
field contains an asterisk (*) which acts as a wildcard. See Performing Wildcard Searches below. 

 
Depending on the report you choose, the right frame may show different types of information: 

 

 Some reports display automatically when you click them. 

 Some require you to enter filter criteria before viewing the report. 
 Some reports display a summary, from which you drill-down to greater detail as 

needed. 
 Some reports support viewing as a graph. See Viewing Graphs for more information. 

Using Custom Reports 

You can also create, view, and edit custom reports, and create Alerts from them. For more information, see Using 
Custom Reports and Alerts. 

 

Performing Wildcard Searches 

In the Find Devices report, each text box contains an asterisk (*) by default. This character acts as a wild card. You can 
use the wild card character in conjunction with other characters to perform advanced searches.  

 

For example, 

 Enter "Illustrator*" in the Product Name text box to find all versions of Illustrator. 
 Enter "*strator*" in the Product Name text box to find products whose name contains 

"strator". (This could be useful for finding products with varied spellings.) 
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Using the Asset Management Tab 

The Asset Management Tab 
Use the Asset Management tab to: 

  

 Monitor application usage. 
 Manage your software assets and monitor your software licensing compliance. 
 Manage contracts and associated documents. 

 
Note: The reports you are able to view and the data you are able to edit depends on your user role. For more 
information on user roles and access, see Security and Access. 

  

  

Using the Software Usage Page 
Use these reports to monitor usage of local applications, served applications, network applications, and web 
applications. All of these reports are available from the Asset Management > Software Usage page, available only 
with the full version of ZENworks Asset Management. 

 

Choose a report from any of these folders: 

 

 App Usage - Choose from a number of reports to view total application usage, local 
application usage, or served application usage. 

 Web App Usage - View web application usage by application, user, or workstation. 
 Software File Usage - View software file usage by category, manufacturer, user, or 

workstation. For more information on software files, see About Software File Reports. 
 Network Software Usage - View network software usage by product, server, user, or 

workstation. 
 All Usage - These reports bring all application usage together by user or workstation. 
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About Application Usage Reports  

Use these reports to review usage patterns and to identify unused or under-utilized applications. You can find the 
reports below in the App Usage folder, available from the Asset Managment tab's Software Usage page. 

 

 Click a column heading to sort the list by that column, and again to reverse the sort 
order. 

 Click Change Time Period or Change Time Period/Filters to control the time period 
covered by the report.  

 Click Excel, CSV, or PDF to export the report data to an Excel spreadsheet, comma-
separated file, or PDF. 

Total App Usage Folder 

These reports show usage for both local and served applications. 

 By Product 

 By Workstation 
 By User 
 Usage Collection History 

Local App Usage Folder 

These reports show only local application usage. 

 By Product 

 By Workstation 
 By User 

Served App Usage Folder 

These reports show usage for served applications. 

 By Product 

 By Server 
 By User 
 By Workstation 
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Application Usage Report Columns Explained 

These reports use a common set of columns, calculated the same way in each report. Certain columns are not 
applicable to certain reports, and do not appear. Where applicable, the calculations used to arrive at a displayed value 
are explained. 

 

 Manufacturer, Product, Version – Identifies the application by manufacturer, product name, and version. 

 Current Installations – The number of copies of the named application found installed 
at the time the report was run. Drills down to a list of workstations on which the 
application is installed. 
 
Note: These reports, which can cover a specified time period, make no distinction 
between those applications that were already installed at the beginning of the time 
period and those that were installed after start or end of the time period. It reports 
usage information on all applications that are installed at the time the report is run. In 
other words, it does not reflect the history of installation, only usage of applications 
during a specified time period - those applications installed after the specified time 
period show usage values of zero. 

 Total Used – The number of installed applications that saw some usage during the 
report period covered (and are still installed.) Drills down to a list of workstations on 
which the product has some usage. 

 Local Installs Used - The number of applications installed on local machines that saw 
some usage during the report period covered (and are still installed.)  

 Hours Used - The number of hours a particular application has been used.  

 Instances Used – The number of copies of the application used by a particular user (Application Usage By 
User report only) 

 # Not Used – The number of installed applications that have had no usage during the report period. Drills 
down to a list of workstations on which the product has no usage. 

 Total Active – The number of installed applications that saw some active time during the reporting period. 

 Ave. Usage Days – The number of Component-Days divided by the number of components that had usage, 
rounded to the nearest whole number. 
A component is an installed copy of a product.  
A Usage Day is a day on which the component saw some usage. 
A Component-Day is the total Usage Days for a component. 
For example, if one person used a product on Monday, Tuesday, and Friday, and another used the product 
Monday through Friday, the product would have an average usage of (3+5)/2 = 4 usage days. 

 Hours Active/Total Hours Active – The total number of hours that the product was active during the 
reporting period. It is the sum of active hours for all installed copies of the product, rounded to nearest 
whole number. 

 Local Hours Active - The total number of hours that the product was active on a local 
machine during the reporting period. It is the sum of active hours for all local installed 
copies of the product, rounded to nearest whole number. 
 
Note: When monitoring usage of an application run from a Windows Terminal Server 
installation, the usage is attributed to the local machine serving the application, rather 
than the client machine. 

 Last Used Date - The last date that the product was used. 
 Local Last Used Date - The last date a local version of the application was used. 
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 # of App Starts - The number of times the application was started. 
 # of Days with Starts - The total number of days during which the application was 

started. 
 # of Local Users - The total number of users who used the application on a local 

machine during the reporting period. 
 Served Hours Active - The total number of hours that the product was active when 

running from a server during the reporting period. It is the sum of active hours for all 
server-installed copies of the product, rounded to nearest whole number. 

 Workstations Used From (Served) - The total number of workstations from which the 
served application was used. 

 # of Applications Served - The total number of applications served from the selected 
server during the reporting period. 

 # of Applications Used - The total number of applications that saw usage from the 
selected server during the reporting period. 

 # of Applications Not Used - The total number of applications that saw no used from 
the selected server during the reporting period. 

 # of Users - The total number of users who used the selected product, or used a 
product from a server, during the reporting period. 

Setting the Time Period and Report Filters 

You can set the time period for any usage report. Certain reports allow you to set a filter to narrow the focus of the 
report. 

 

To change the time period and apply a report filter (if available): 
  

 At the bottom of the right frame when viewing a report, click Change Time Period or Change Time 
Period/Filters. The Usage Report Filter window appears. 

The Usage Report Filter dialog 

 Time Period - From the drop-down menu, choose the period for which you want to view the report. 

 Detail - Click to choose Used Applications Only, Unused Applications Only, or All Applications. This filter 
appears only for certain reports. 
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Total Application Usage By Product 

Use this report to view usage information at the product level. The first page of the report shows the available groups 
(such as Department, Cost Center, or other defined group.) Drill-down to view a list of manufacturers with an total 
number of products installed for each. Drill-down further to view a list of the manufacturer's products and their usage. 

 

Report Columns 

 

 Manufacturer, Product, Version 

 Local Installations – Drills down to a list of workstations on which the application is installed. 

 Local Hours Active - The number of hours the product was used on local machines. 
 Ave. Usage Days - The average number of days the product was used on local machines during the specified 

period. 

 Served Installations Used - Drills down to a list of servers from which the product was 
used. 

 Workstations Used From - Drills down to a list of workstations that used the product 
from a server. 

 # of Users - Drills down to a list of users that used the product from a server. 
 Served Hours Active - The number hours the served product was active. 
 Ave. Usage Days - The average number of days the product was used from a server during the specified 

period. 

 Total Hours Active - The total number of hours the product was active during the 
specified period. 

 Total Ave. Usage Days - The total (local and served) average number of days the 
product was used during the specified period. 

Total Application Usage By Workstation 

Use this report to view a usage of applications by workstation. The first page of the report shows a list of workstations 
by group. Drill down into a workstation to view a list of applications on selected workstation. 

 

Report Columns 
  

 Manufacturer, Product, Version 

 Local Hours Active 
 Local Last Used Date 
 # of Days with Starts 
 # of Local Users - Drill down to a list of local users with a summary of usage for each 

user. 
 Served Hours Active 
 # of Served Users - Drill down to a list of served users with a summary of usage for 

each user. 
 Total Hours Active 
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Total Application Usage By User 

Use this report to view a usage of applications by user. The first page of the report shows a list of groups of users.  

 Drill down to view the users in a group.  

 Drill down to view a list of applications for the selected user. 

Notes:  

 The listed applications are not necessarily on workstations the user is associated with. 
Applications are tracked by the user's login name, which could be used on more than 
one workstation. 

 This report is not available to domain level users. For more information, see Security 
and Access. 

Report Columns 

 Manufacturer, Product, Version 

 Local Hours Active 
 Local Installs Used - Drill down to a list of workstations on which the product was 

installed and used. 
 Served Hours Active 
 Workstations Used From (Served) - Drill down to a list of workstations on which the 

served product was used. 
 Total Hours Active 

Usage Collection History 

Use this report to view information on the workstations monitored for application usage. The first page lists groups, 
with a count of monitored workstations for each group.  

 

This report gives you a sense of the extent of usage monitoring on the PCs in your current inventory as you view the 
usage trends for these PCs. (For various reasons, some workstations may not be monitored as much as others - this 
report help you take this fact into consideration.) 

 

 Drill down to view a list of time periods and the number of workstations monitored during each time period. 

 Drill down again to view a list of workstations monitored during the time period. 

 

Report columns 

 Machine name – Drill down to view the Workstation Detail for the selected workstation. 

 Login name - The user's login name. 

 Mac Address - The machine's MAC address. 

 IP Address - The machine's IP address. 

 Inventory Date - The last date that the machine was scanned. 
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Local Application Usage By Product 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of manufacturers with an total number of products installed for each. Drill-down further to 
view a manufacturer's products and their usage. 

Report Columns 

 Product 
 Version 
 Current Installations 
 Total Used 
 # Not Used 
 Last Used Date 
 # of App Starts 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Local Application Usage By Workstation 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of workstations. Drill-down further to view a list of products installed on the selected 
workstation, with usage for each product. 

Report Columns 

 Manufacturer, Product, Version 
 Installs Used 
 # of App Starts 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Local Application Usage By User 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of users with an total number of products used for each. Drill-down further to view a list of 
products used by the selected user, with usage data for each product. 

Report Columns 

 Manufacturer, Product, Version 
 Local Last Used Date 
 # of Days with Starts 
 # of Local Users 
 Hours Used 
 Hours Active 
 Ave. Usage Days 
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Served Application By Product 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of manufacturers with an total number of products installed for each. Drill-down further to 
view a manufacturer's products and their usage from the server. 

Report Columns 

 Product, Version 
 Served Installations Used 
 Total Used 
 # Not Used 
 Workstations Used From 
 # of Users 
 Last Used Date 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Served Application By Server 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of servers with application usage, workstation from which the applications were used, and the 
number of users who used them. 

Report Columns 

 Server 
 # of Applications Served 
 # of Applications Used 
 # of Applications Not Used 
 Workstations Used From 
 # of Users 

Served Application By User 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of users with the total number of served applications used by each user. Drill-down further to 
view a list of products used by the selected user, with usage data for each product. 

Report Columns 

 Manufacturer, Product, Version 
 Servers Used From 
 Workstations Used From 
 Hours Used 
 Hours Active 
 Ave. Usage Days 
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Served Application By Workstation 

The first page of the report shows the available groups (such as Department, Cost Center, or other defined group.) 
Drill-down to view a list of workstations. Drill-down further to view a list of products installed on the selected 
workstation, with usage for each product. 

Report Columns 

 Manufacturer, Product, Version 
 # of Local Users 
 Servers Used From 
 Hours Used 
 Hours Active 
 Ave. Usage Days 
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About Web Application Usage Reports 

Use the Web Application Usage reports to view usage of all defined web applications. You can find the reports below in 
the Web App Usage folder, available from the Asset Managment tab's Software Usage page. Web applications are 
defined from the Administration tab.  

 Click a column heading to sort the list by that column, and again to reverse  
the sort order. 

 Click Change Time Period to control the time period covered by the report.  
 Click Excel, CSV, or PDF to export the report data to an Excel spreadsheet, comma-

separated file, or PDF. 

These reports show usage of web applications: 

 By Web App 
 By User 
 By Workstation 

Web Application Usage by Web Application 

Use this report to view web application usage information by application. The first page of the report shows the 
available groups (such as Department, Cost Center, or other defined group.) Drill-down to view a list of web 
applications and their usage.  

Report columns  

 Web Application 
 Version 
 Workstations Used From - Drill down to a list of workstations from which the web 

application was used. 
 # of Users - Drill down to a list of users who used the web application during the 

specified time period. 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Web Application Usage by User 

Use this report to view web application usage information by user. The first page of the report shows the available 
groups (such as Department, Cost Center, or other defined group.) Drill down to view a list of users and the number of 
web applications they have used. Drill down again to view web application usage for a particular user.  

Report Columns 

  

 Web Application 
 Version 
 Workstations Used From - Drill down to view a list of workstations from which the web 

application was used. 
 # of App Starts 
 Hours Used 
 Hours Active 
 Ave. Usage Days 
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Web Application Usage by Workstation 

Use this report to view web application usage information by workstation. The first page of the report shows the 
available groups (such as Department, Cost Center, or other defined group.) Drill-down to view a list of workstations 
with web application usage. Drill down again to view web application usage for a particular workstation. 

  

Report Columns 

  

 Web Application 
 Version 
 # of Users -  
 Last Used Date 
 # of App Starts 
 Hours Used 
 Hours Active 
 Ave. Usage Days 
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About Software File Usage Reports 

Software files are those files discovered during a scan, but not currently found in the ZENworks Asset Management 
Knowledgebase as part of a software product.  

 

From a list of software files, you can create your own Local Products, groups of software files which then appear as 
products in reports, for those applications not currently in the Knowledgebase. Use the Local Product Creation reports 
in the Custom Reports folder of the Software Usage page to create Local Products. For more information, see Creating 
Local Products. 

 

Use these reports, available from the Asset Management > Software Usage tab, to review a list of Software Files, 
their usage patterns and to identify files that might require license tracking, that violate Software Standards, or for 
any number of other purposes particular to your organization. 

 

 Click a column heading to sort the list by that column, and again to reverse  
the sort order. 

 Click Change Time Period to control the time period covered by the report.  
 Click Excel, CSV, or PDF to export the report data to an Excel spreadsheet, comma-

separated file, or PDF. 

 

Note: The usage values as shown in these reports are recalculated each time a workstation is scanned. They represent 
usage between the last two collection cycles. 

 

View any of these reports: 

 By Category 
 By Manufacturer 
 By Workstation 

 

Each report drills down to one of these reports: 

 Software Files List 
 Workstation List 
 Software Files List for Workstation 
 Product List 
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Software Files/Usage Report Columns Explained 

Each report shows a set of columns from the list below, calculated the same way in each report. Certain columns are 
not applicable to certain reports, and do not appear. Where applicable, the calculations used to arrive at a displayed 
value are explained. Much of this information is read from the file's VRB (Version Resource Block) data.  
  

 # of Files, # of Products – The number of files or products found on a particular 
workstation. See "Unique Files, Unique Products" below for an explanation of files and 
products. 

 Unique Files, Unique Products, Total Files – The number of unique and total files 
found. The difference between these two values represents the number of duplicate 
files or products found. A "Unique File" has a unique combination of file name, 
extension and date. A "Unique Product" has a unique combination of Manufacturer, 
Version and Language. A unique file or product is counted only once, even if it appears 
on more than one workstation. 

 Manufacturer, Product, Version – Shows any available information contained in the 
file's VRB data block. (All files sharing the same values in these three fields are 
considered part of the same product.) 

 File Name, Extension, File Date, Category – Identifies the file. 
 Size – The file's size in bytes. 
 Path – The location of the file on the selected workstation. 
 Language – The application's specified language. 
 Category – System File , Ancillary, or Other. Choose these categories ZENworks Asset 

Management Manager in the Collector tab of a Collection Option set.  
 Copies – The number of copies of the file found. 
 Hours Running – The number of hours the application was run between the last two 

workstation scans. 
 Hours Active – The number of hours the application was active (had application focus) 

between the last two workstation scans. 
 Startups – The number of times the application was launched between the last two 

workstation scans. 

Software Files List 

Report Columns 

 

 File Name, Extension, File Date, Category 
 Copies – Drill down to view the Workstation List. 
 Hours Running 
 Hours Active 
 Startups 

Workstation List 

Report Columns 

 Workstation 
 Login 
 User 
 Mac Address 
 # of Files – Drill down to view the Software Files List for Workstation. 
 # of Products – Drill down to view the Product List. 
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Software Files List for Workstation 

Report Columns: Software Files List 

 File Name, Extension, File Date 
 Size 
 Path 
 Hours Running 
 Hours Active 
 Startups 

Product List 

Report Columns 

 Manufacturer 
 Product 
 Version 
 Language 
 Category 
 Copies – Drill down to view the Workstation List Report 
 Hours Running 
 Hours Active 
 Startups 

Software Files/Usage By Category 

Use this report to view Software File and usage information grouped by Category. (System File, Ancillary, or Other. 
Choose these categories in the ZENworks Asset Management Manager's Collector tab when defining a Collection Option 
set.) 

 

The first page of the report shows the available groups as defined by the top-level filter in the System List tree.  

 

Drill Down Tree 

 

Software Files by Category 

Software Files List 

Workstation List 

Software Files List for Workstation 

Product List 
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Software Files/Usage By Manufacturer 

Use this report to view usage information grouped by Manufacturer. 

 

The first page of the report shows the available groups as defined by the top-level filter in the System List tree.  

 

Drill Down Tree 

 

Software Files by Manufacturer 

Product List 

Workstation List 

Software Files List for Workstation 

Product List 

Software Files/Usage By Workstation 

Use this report to view usage information grouped by Workstation. 

 

The first page of the report shows the available groups as defined by the top-level filter in the System List tree.  

 

Drill Down Tree 

 

Workstation List 

Software Files List for Workstation 

Product List 
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About Network Software Usage Reports 

Use the Network Software Usage reports to view usage of all applications launched from a network drive. You can find 
the reports below in the Network Software Usage folder, available from the Asset Managment tab's Software Usage 
page. 

 Click a column heading to sort the list by that column, and again to reverse  
the sort order. 

 Click Change Time Period/Filters to control the time period covered by the report.  
 Click Excel, CSV, or PDF to export the report data to an Excel spreadsheet, comma-

separated file, or PDF.  

These reports show usage of web applications:  

 By Product 
 By Server 
 By User 
 By Workstation 

Network Software Usage by Product 

Use this report to view network software usage information by product. The first page of the report shows the 
available groups (such as Department, Cost Center, or other defined group.) Drill-down to view a list of applications 
and their usage.  

Report Columns  

 Manufacturer, Product, Version 
 Servers - Drill down to see a list of servers from which a product has been run. 
 Workstations Used From - Drill down to the Network Software Usage by Workstation 

report and again to see network software usage for the selected workstation.  
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Network Software Usage by Server 

Use this report to view network software usage information by product. The first page of the report shows a list of 
servers, the number of applications launched from each, and the number of workstations that launched them. Drill-
down to view the Network Software Usage by Product or Network Software Usage by Workstation report.   

Report Columns  

 Server 
 # of Network Apps Used - Drill down to the Network Software by Product report.  
 Workstations Used From - Drill down to the Network Software Usage by Workstation 

report and again to see network software usage for the selected workstation.  
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Network Software Usage by User 

Use this report to view network software usage information by user. The first page of the report shows the available 
groups (such as Department, Cost Center, or other defined group.) Drill-down to view a list of users, and again to view 
network software usage for the selected user. 

  

Report Columns 

  

 Manufacturer, Product, Version 
 Instances Used 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Network Software Usage by Workstation 

Use this report to view network software usage information by workstation. The first page of the report shows the 
available groups (such as Department, Cost Center, or other defined group.) Drill-down to view a list of workstations, 
and again to view a list of network applications and their usage for the selected workstation. 

  

Report Columns 

  

 Workstation - Drill down to view network application usage for the selected 
workstation. 

 User 
 MAC Address 
 IP Address 
 # of Network Apps Used 
 Instances Used 
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About All Usage Reports 

Use these reports to view a summary of software usage for all types of applications in one report. View usage By User 
or By Workstation. You can find these reports in the Reports > All Usage folder, available from the Asset Managment 
tab's Software Usage page. 

  

 Click a column heading to sort the list by that column, and again to reverse  
the sort order. 

 Click Change Time Period to control the time period covered by the report.  
 Click Excel, CSV, or PDF to export the report data to an Excel spreadsheet, comma-

separated file, or PDF. 

All Application Usage by User 

Use the All Application Usage by User report to view a summary of application use by a single user. 

  

The first page of the report shows a list of users, and a total number of applications used for each user. Drill-down to 
view a list of applications, grouped by usage type. Drill-down further to view details about the usage for that 
application. 

  

Click one of these links at the top of the report to go directly to the selected usage group: 

  

 Local Usage 
 Served Usage 
 Web App Usage 
 Network Usage 

  

Report Columns - Local Application Usage 

 Manufacturer 
 Product 
 Version 
 Installs Used 
 # of App Starts 
 Hours Used 
 Hours Active 
 Average Usage Days 

Report Columns - Served Application Usage 

 Manufacturer 
 Product 
 Version 
 Servers Used From 
 Workstations Used From 
 Hours Used 
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 Hours Active 
 Average Usage Days 

Report Columns - Web Applicastion Usage 

 Web Application 
 Version 
 Workstations Used From 
 # of App Starts 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Report Columns - Network Application Usage 

 Manufacturer 
 Product 
 version 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

All Application Usage By Workstation 

 Use the All Application Usage by Workstation report to view a summary of application use from the selected 
workstation.  

The first page of the report shows a list of workstations, with information about the workstation and the user that 
logged in to that workstation. Drill-down to view a list of applications, grouped by usage type, with usage about each 
application. Drill-down further to view details about the usage for that application.  

Click one of these links at the top of the report to go directly to the selected usage group:  

 Local Usage 
 Served Usage 
 Web App Usage 
 Software File Usage 
 Network Usage  

Report Columns - Local Application Usage 

 Manufacturer 
 Product 
 Version 
 Local Last Used Date 
 # of Days with Starts 
 # of Local Users 
 Hours Used 
 Hours Active 
 Ave. Usage Days 
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Report Columns - Served Application Usage 

 Manufacturer 
 Product 
 Version 
 # of Local Users 
 Servers Used From 
 Hourse Used 
 Hours Active 
 Ave. Usage Days 

Report Columns - Web Application Usage 

 Web Application 
 Version 
 # of Users 
 Last Used Date 
 # of App Starts 
 Hours Used 
 Hours Active 
 Ave. Usage Days 

Report Columns - Software File Usage 

 File Name 
 Extension 
 File Daste 
 Size 
 Path 
 Hours Running 
 Hours Active 
 Startups 
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Creating and Editing Local Products 

ZENworks Asset Management can identify thousands of different commercial products during the scan of a workstation. 
Nonetheless, your organization may use hardware and software products that are not among those that ZENworks Asset 
Management automatically identifies. These products can include commercial products, internally developed software, 
or custom-built PCs. You can add such a product to the inventory database by defining it as a local product. 

 

Before you can create a local product, one or more workstations need to be scanned with the File Scan option turned 
on. If file scanning is turned off, only those products that are found in the Novell Product Knowledgebase are shown. 
You turn file scanning on or off in a Collection Option Set, using the ZENworks Asset Management Manager. 

 

If you select more than one file in the creation of local products, each software file becomes a local product. To relate 
all of the software files to a single local product, you need to merge them to one product. When you merge the local 
products to one product, you must choose which local product you want to use as the "target" for the merge. All of the 
selected software files are added to the local product you select and, as a group, become the product definition for 
the local product. 

 

Note: You can also create local products from the Manager. For more information, see Creating a Local Product in the 
Manager's online help. 

 

What do you want to do? 

 See an overview of the process of creating local products 
 Create one or more local products from a set of software files 
 View a list of local products 
 Edit a local product's details 
 Merge two or more local products 
 Remove a software file from a local product 
 Delete a local product 
 View the page reference for local products 

Overview of the Local Product Creation Process 

The process of creating a local product follows these steps: 

1. Scan one or more machines to generate a list of software files. Software file scanning 
must be turned on in the collection option set used to scan the machine. This is done 
from the Manager. 

2. View a list of software files in a Web Console Local Product Creation report. 
3. Select the software files you want to include in the local product. 
4. Create local products from each of the selected software files. 
5. Merge the local products into a single product. 
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Creating a Local Product 

When a file scan has been completed, local products can be created in several ways; one way is from the Web Console. 
You must be an enterprise administrator to create local products. 

 

To create a local product: 

1. From the Asset Management > Software Usage page, expand Custom Reports > Local 
Product Creation.  

2. Click Software Files by Machine. The report's definition summary appears in the right 
frame. 
Note: You can create local products from any report that shows a list of software files, 
as long as the report includes the Machine Name column. 

3. At the bottom of the right frame, click Run. A list of software files appears, with a 
check box to the left of each file in the list. Click a column header to sort by that 
column. Click again to reverse the sort order.  

4. Select or clear the check boxes for those files you want to add as local products. To 
select or clear all of the check boxes at once, select the Select check box at the top of 
the column. 

5. At the bottom of the right frame, click Create Local Products. A Make Local Products 
window appears, telling you how many local products have been created. 

6. Click G o to Product Detail. A list of local products appears, including one product for 
each software file you selected in step 5 above. You are now ready to merge the 
software files into a single local product. 

Merging Local Products 

When you select multiple files, ZENworks Asset Management creates a single local product for each software file you 
select. You can merge products together, creating a single product from multiple products. This product, made up of 
multiple files, becomes the "fingerprint" for the product. 

 

To merge local products: 

1. Click the Administration tab, then click the Local Software Products tab. (Enterprise 
Administrators and Enterprise Assistants only.) A list of local products appears in the 
right frame. A list of local products by manufacturer appears in the left frame. A check 
box appears to the left of each product. 

2. Select the check boxes for those products you want to merge. To select or clear all of 
the check boxes at once, select or clear the Select check box at the top of the column. 

3. Click Merge Selected Products. The Merge Products window appears, with a list of 
selected products. 

4. Click to choose the target product - that is, the product with which you want to merge 
the other selected products. 

5. Click Merge. The details for the target product appear, including the files from all 
products merged with the target product. 
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Editing Product Details 

You can edit general information about a product, such as the Manufacturer, Product Name, or Version. You can also 
edit information about each file in the product definition. 

 

To edit product details: 

1. In the Administration tab > Local Software Products page's left frame, expand Local 
Software Products. A list of local products appears. 

2. If the local product has a manufacturer associated with it, and you know the 
manufacturer's name, click it in the left frame. Otherwise, locate the product in the 
Local Products list. 

3. Click the product name for the local product you want to edit. The Details page 
appears, showing details for the selected product. 

4. Make changes, then click Update Product.  
 
For information, see the Local Product Detail page reference. 

Removing Files from a Product Definition 

If one or more files were added to a product definition inadvertently, you may want to remove them from a product 
definition so they are not recognized as part of the product. 

 

To remove a file from a product definition: 

1. Edit the product's details as described above. 
2. Locate the file you want to remove from the product definition. 
3. Click to select the Remove File check box. 
4. Click Update Product. The selected file is removed from the product definition. 

 
Note: When you remove a file from a product definition, the file no longer appears in 
the local products list. If you remove a file accidentally, follow the steps in Creating a 
Local Product above, and select the file you want to add. Then merge the resulting 
local product with the one from which you removed it. 

Deleting a Product Definition 

You can remove a local product definition completely. 

 

To delete a local product: 

1. View a list of local products, and find the product you want to delete. 
2. Click the product name to view the details for the selected product. 
3. At the bottom of the right frame, click Delete Product. A confirm window appears. 
4. Click Delete. The local product definition is deleted. 
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About the Local Product Creation Reports  

Two reports are available in the Local Product Creation folder, found in the Custom Reports folder of the Asset 
Management tab > Workstation Inventory page: 

 Software Files by Machine - Lists individual files by Machine Name, and includes file 
names, file extensions, and file folders containing the software files. If a file exists at 
more than one location on the machine, it is listed once for each location. 

 Unique Software Files - Lists files that are determined to have a unique fingerprint; 
that is, one file is listed for each unique set of VRB data found. If a file is found on 
multiple machines, but each instance contains the same VRB data, it is listed only 
once. 
 
Note: You can also create your own custom reports that allow you to create local 
products. As long as a report can uniquely identify a software file, you can create local 
products from it. To create a report that allows you to create local products, it must 
contain one of these two sets of columns: 
 
   File Name 
   File Extension  
   VRB Company  
   VRB Product Name  
   VRB Product Version  
   VRB File Version  
or 
  Machine Name 
  File Name 
  File Extension 
  File Folder 
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Using the Software Management Page 
Use the Software Management page to: 

 View, add, edit and import software purchase records. 
 Reconcile purchased products with discovered products. 
 Manage software licenses, reconciling purchase records and discovered products to 

licenses, allocating licenses to sites, departments, cost centers, or workstations. 
 View a variety of reports related to software purchases, licensing, and compliance. 
 Export report data to spreadsheets, comma-separated files, or PDFs, or create a graph 

of report data in a PDF. 

 

Note: Access to this page is determined by your user role. See Security and Access for more information. 

 
Software Management Overview 

Purchase Record Overview 

Product Catalog Overview 

Discovered Product Overview 

License Record Overview 

Software Management - Overview 

Use ZENworks Asset Management Software Management to reconcile purchased software products and software 
products discovered through ZENworks Asset Management to License Records, to ensure compliance with software 
license agreements. ZENworks Asset Management Software Management is designed to track compliance for software 
products that are licensed on a "per installation" basis. 

 

For an overview of Novell's recommended approach, see Recommended Approach. 

 

Before you can get a complete picture of your compliance status, you must reduce your unreconciled counts down to 
zero by reconciling them to License Records, or by excluding them. A quick way to check these counts is through the 
Status Summary report, available from the Software Management page's Reports > Software Compliance menu. 

 

Note: You can get useful information from the Compliance report before your Unreconciled quantity is at zero. For 
example, you can work to reconcile all products from a certain manufacturer, such as Microsoft. 

How is Compliance Determined? 

In a general sense, ZENworks Asset Management Software Management compares information about software products 
you've purchased with installed software products discovered by ZENworks Asset Management. This is an 
oversimplification —  in order to make the process of determining your compliance status reasonably flexible, there are 
some other parts of the system fundamental to its operation. For an overview of the workings of ZENworks Asset 
Management Software Management, see Compliance Building Blocks. 
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What is Automated, and What is Not 

While the process of discovery of installed products can be automated, the compliance determination process requires 
some input from a user.  

 

Here are some parts of the process that require information from a user 

 

 Enter or import software purchases 
To prove compliance, you need to prove that you have purchased licenses for the 
products you've installed. With ZENworks Asset Management Software Management, you 
add or import Purchase Records, containing information about the products you've 
purchased and the quantities of those products.  
 
Novell provides reseller connectors for several large software vendors. These vendors 
can provide you with a report of your purchases that can be used to import purchase 
records directly. This can greatly simplify the purchase record entry process, and 
increase the accuracy of your complance reports. For more information, see Import File 
Formats. 
  

 Associate the products you've purchased with Discovered Products 
Even if you import purchase data provided by a software reseller, there is no reliable 
way for ZENworks Asset Management Software Management to associate a product 
you've purchased product with a product discovered by ZENworks Asset Management.  
 
To allow flexibility in working with your data while still providing accurate compliance 
status, you do not associate your purchases directly with your Discovered Products. 
Instead, you build a catalog of products, and associate, or reconcile, those products 
with License Records. You then reconcile Discovered Products to the same License 
Records. Through this mechanism, you can make additional purchases of the same 
software in different forms, and an accurate license count is maintained. 
 
You can use the Auto-reconcile page, available from the Software Management tab > 
License Records menu, to create a license record for each discovered product. This 
can speed the process of creating license records. 
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The Steps To Compliance for a Single Software Product 

For each software application you install, you must complete these steps before the Compliance report can present 
accurate information about the status of your compliance. These steps can be completed in any order, but all steps 
must be completed. 

 

When you have completed the following basic steps for a software product, you can view the product's Compliance 
status. 

 

 Enter purchasing information 
 Add a Catalog Product to the Product Catalog 
 Add a License Record for the product 
 Reconcile the Catalog Product and Discovered Product to a License Record 

Enter Purchasing Information 

1. Add a Purchase Record - Each Purchase Record corresponds to the invoice or purchase 
order you used to purchase the software. You can add Purchase Records in two ways:  
- Add records in batches by importing them from the Import Purchase Records page.  
- Add records by entering them from the Add Purchase Record page. 

2. Add line items to the Purchase Record - Each line item in the purchase record 
contains a product from the Product Catalog . 
- If the software product exists, click Choose Product, and choose the Catalog Product 
you want to add to the Purchase Record.  
- If the software product does not exist you can click Add New Product on the Choose 
Product page to add it to the Product Catalog. 

 

For more information on entering Purchase Records, see Purchase Record Overview. 

Add a Catalog Product to the Product Catalog 

This usually happens as part of the process of entering a purchase, but you can add products to the Product Catalog , 
even when you have not purchased those products. When you import a batch of purchase records, any products in the 
Import File that do not appear in the Product Catalog are added automatically. 

Add a License Record for the Product 

For each unique version of a software product there must be a License Record. (Example: Adobe Acrobat 5.0, 
regardless of whether it is purchased as part of a volume license, a multi-pack, or as a single retail copy.) This record 
represents a license for a unique software product version, and allows you to purchase additional units and upgrades 
while maintaining an accurate count of available licenses. 

 

The Compliance report shows a list of License Records. 

 

License Records can be added easily during the reconciliation process. 
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Reconcile the Catalog Product and Discovered Product to a License Record 

Once you have created a License Record for the product, you can associate, or reconcile, the product to the License 
Record.  
  

 Reconcile the Catalog Product(s) to the License Record - You can associate one or 
more Catalog Products with a single License Record . For example, single copies, and 
multi-packs can be associated with the same license record, since they are all licensing 
the same product. 

 Reconcile the Discovered Product to the License Record - You can associate one or 
more Discovered Products with a single License Record. For example, if a license 
agreement covers all 5.x versions of a software product, you can reconcile them all to 
the same License Record. 

 

Working with Upgrades 

If a software product is an upgrade to a product you've already purchased, you can associate the product with it's 
previous version. Once you've made this association, the license count can be adjusted to take the upgrade into 
consideration. For more information, see Working with Software Upgrades. 

Importing Data 

Because you may have purchased hundreds of software products through thousands of transactions,we recommend that 
you import your data into ZENworks Asset Management Software Management. The Import process adds Purchase 
Records, and also adds Catalog Products if they do not already exist in the Product Catalog. 

 

For more information, see Importing Purchase Records. 
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Compliance Building Blocks 

The License Record is the "glue" that connects one or more products from the Product Catalog with one or more 
Discovered Products from the ZENworks Asset Management Inventory . Purchase records contain line items representing 
the purchase of quantities of Catalog Products. The Discovered Products are filtered through the License 
Knowledgebase, which delivers the subset of ZENworks Asset Management Inventory products known to require license 
tracking. 

 

ZENworks Asset Management Software Management uses these major components to determine the compliance status 
of a particular product: 

 

 ZENworks Asset Management Inventory - software inventory data collected through 
the ZENworks Asset Management inventory process. 

 Discovered Products - products from your ZENworks Asset Management inventory 
filtered through the Novell License Knowledgebase .  
 
Use the Discovered Products menu to reconcile one or more Discovered Products to a 
particular License Record . For example, if your license agreement entitles you to all 
the point releases of a given major version of a product, you can assign all discovered 
versions to the same License Record. 
 
Note: Discovered Products are filtered through the License Knowledgebase, which 
reduces the total number of Discovered Products by consolidating, combining, or 
excluding them in a number of ways. For more information, see About the License 
Knowledgebase. 

 Purchase Records - Purchase Records document the purchase of one or more software 
products and form the basis for license entitlements and proof-of-ownership. If a 
Purchase Record contains multiple line items, each line item represents the purchase 
of a Catalog Product .  
 
A purchase record has two parts: 
 
-The Purchase Record's header contains information about the purchase transaction 
(PO #, Reseller, Order Date, etc.)  
-The Purchase Record's line items, each of which contains a product from the Product 
Catalog , along with a purchase quantity and other product-specific information. 
 
You can also associate purchase record line items to organization demographics, 
specifying a Cost Center, Site, and/or Department for each line item. This allows you 
to group and display your reports by demographics. For more information on using 
demographics see Importing and Demographics. 
 
Use the Purchase Records menu to add, view, edit, and delete your Purchase Records 
and to import batches of Purchase Records. Purchase Records are also added 
automatically as part of the Purchase Record Import process. 
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 Product Catalog - The Product Catalog is a list of unique products that have been (or 
may be) purchased by your organization. Products in this list should correspond to 
individual part numbers. Organizations tend to purchase the same product in many 
different transactions over time; the Product Catalog allows ZENworks Asset 
Management Software Management to calculate an aggregate license quantity from 
many purchase transactions of a particular product.  
 
For example, you might purchase a single copy, a 10-pack, or a 100-pack for the same 
version of software. Each of these is a Catalog Product, but the purchase of each 
entitles you to a different number of licenses for that version of software. You would 
reconcile these to a single License Record. 
 
Use the Product Catalog menu to add, view and edit Catalog Products, and to 
reconcile those products to a particular Software License Record . Catalog Products are 
also added automatically as part of the Purchase Record Import process. 
 
Note: A product must appear in the Product Catalog before you can add it to a 
Purchase Record. 
  

 License Record - This is the core object used to determine compliance status, serving 
as the "glue" that connects Discovered Products to Purchase Records. The Compliance 
Report shows a list of License Records. You can drill-down to the details about the 
Catalog Products and Discovered Products related to those licenses.  
 
A License Record represents the total number of licenses you own for a particular 
product. 
 
In one scenario, for example, you may have purchased licenses for a product on several 
different occasions. In your first purchase transaction you bought a single license, in 
order the evaluate the product. Over time, you purchased additional licenses as other 
users requested the product. These purchases might have been made from different 
resellers, and in different quantities, some single copies, possibly some multi-packs. 
 
In another scenario, you might be migrating all your workstations to Office 2003. You 
may have purchased some copies of Office along with new computers, while others 
were purchased for existing computers. 
 
A License Record ties together these multiple purchases of a software product, 
providing a total count of the number of licenses that your organization owns for that 
product, as well as a total number of installations. These counts appear in the 
Compliance Report. 
 
Use the License Records menu to add, view and edit Software Licenses and to 
reconcile them to Catalog Products and Discovered Products. You can also add License 
Records when reconciling Catalog Products or Discovered Products. 
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Recommended Approach 

We recommend the following approach getting started using ZENworks Asset Management Software Management. 

 

Step 1 - Conduct a ZENworks Asset Management inventory or update your current inventory. 

Step 2 - Import or add Purchase Records. 

Step 3 - Reconcile Discovered Products and Create License Records. 

Step 4 - Reconcile Catalog Products to License Records. 

Step 5 - View Compliance Reports. 

Step 1 - Conduct a ZENworks Asset Management inventory or update your current 
inventory. 

For information on conducting a ZENworks Asset Management inventory , see the ZENworks Asset Management Users' 
Guide or ZENworks Asset Management Manager help. 

Step 2 - Import or add Purchase Records. 

You can import a batch of purchase records using the Start Import command. For more information, see Importing 
Overview. 

 

You may also want to review the Product Catalog to make adjustments for multi-packs.  

Step 3 - Reconcile Discovered Products and Create License Records. 

This process creates new License Records and reconciles them to Discovered Products in one procedure. 

 

To create License Records 

 

1. From the Discovered Products menu, choose Reconcile to License Record . 
2. Click to select one or more Discovered Products. 
3. Click Reconcile to License Record. 
4. Click Add License Record. 
5. Click Done to save License Record. 
6. Repeat steps 2 through 5 until no more Unreconciled Discovered Products appear in the 

list. 

 

Note: This step is also a good time to exclude any products you don't want to appear in license calculations. For more 
information, see Excluding Discovered Products. 
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Step 4 - Reconcile Catalog Products to License Records. 

Note: Before completing this step, you may want to review the Product Catalog to make adjustments for multi-packs.  

 

1. From the Product Catalog menu, choose Reconcile to License Record.  
2. Click to select one or more Catalog Products. 
3. Click Reconcile to License Record.  
4. Click to select an appropriate License Record. 
5. Click Done to reconcile the Catalog Products to the selected License Record. 
6. Repeat steps 2 through 5 until no more Unreconciled Catalog Products appear in the 

list. 

Step 5 - View Compliance Reports. 

The Compliance Report shows the compliance status for products for which License Records have been created and 
reconciled to both Discovered Products and Catalog Products. Additional compliance-related reports are available in 
the Custom Reports > Software Compliance folder. 

 

To view the Compliance Reports: 

 

 From the Reports menu, choose Software Compliance > Compliance Report to view 
your compliance status. 

 From the Custom Reports folder, run any of the reports in the Software Compliance 
folder. 
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Using the Filter And Sort Options 

You can use the Filter Options to view a subset of data in any list of Purchase Records, Catalog Products, License 
Records, Discovered Products , or in any of the Compliance Reports. You can also sort any list in a number of ways. 

 

Filtering a List or Report 

Use the Filter tab, found in the left frame, to narrow your search when viewing a list or report. 

 

To use the Filter Options to narrow your search: 

 

1. Choose the options you want to use from the View By, Search, and Group By sections. 
Note: The options available vary, depending on what list you are viewing. 

2. Click Search. The records matching your View By and Search criteria appear, arranged 
by the specified Group Options. 
 
For a summary of Filtering Options, see the View, Filter, and Group Options Reference. 

Sorting a List or Report 

Use the Sorting feature of any list to sort the data by any column.  

 

To sort a list or report: 

 Click any column heading that has an active link. The data is sorted by that column. 

 

To reverse the sort order: 

 Click the column heading again to reverse the sort order. 
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Working With Purchase Records 

Purchase Records document the purchase of one or more software products. If a Purchase Record contains multiple line 
items, each line item represents the purchase of a Catalog Product . 

 

Use the Purchase Record menu to add, edit, and delete Purchase Records. Each Purchase Record may contain one or 
more products from the Product Catalog. 

What would you like to do? 

Add a Purchase Record 

Edit a Purchase Record 

Delete one or more Purchase Records 

Import a batch of Purchase Records 

Replace the value of an existing Cost Center, Department or Site in all Purchase Records  

 

Purchase Records Menu Reference 

Imports - Start Import 

Imports - View Import History 

Imports - View Active Imports 

Add Purchase 

View/Edit Purchase 

Delete Purchase 

Replace Demographics 
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Adding a Single Purchase Record 

Use the Add Purchase command. available from the Purchase Records menu, to add a single Purchase Record . 

 

To add a Purchase Record: 

 

1. From the Purchase Records menu, choose Add Purchase. The Add Purchase Record 
page appears in the right frame. 

2. Enter Purchase Record's header information in the Add Purchase Record form. 
Note: You must enter a value in the PO #  or Order Date box.  

3. Click Choose Product to add one or more products to the Purchase Record. The Add 
Catalog Product to Purchase Record page appears in a new window, containing a list of 
Catalog Products in the Product Catalog . 

4. Use the filter options in the left frame to narrow your search if necessary. 
5. Click the check box in the Select column to choose the product you want to add to the 

Purchase Record. If the product you want to add does not appear in the Product 
Catalog, click Add New Product to add a product to the Product Catalog. 

6. When finished, click Next. The Choose Product page appears, showing the product 
you've chosen. 

7. Enter a Purchase Q uantity (required).  
8. Enter an invoice number in the Invoice #  box. You can also enter a Serial Number, and 

choose values in the Site, Department, and Cost Center drop-down menus. If 
appropriate, add a Comment, which is saved with the line item. 

9. Enter values in the Unit MSRP and Unit Price boxes. 
10. Click Done. The View/Edit Purchase Record page appears, showing the products you've 

added to the purchase record. 
11. To add more products to the purchase record, follow steps 3 through 8 above. When 

finished adding products to the Purchase Record, click Done. The Purchase Record is 
saved, and the Add Purchase Record page appears. 

12. To add more Purchase Records, follow steps 2 through 10. 
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Editing a Purchase Record 

Use the View/Edit Purchase command, available from the Purchase Records menu, to edit existing Purchase Records. 

 

To edit a Purchase Record : 

 

1. From the Purchase Records menu, choose View/Edit Purchase command. A list of 
Purchase Records appears in the right frame. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. In the list of Purchase Records, click any active link for the Purchase Record you want 

to edit. The View/Edit Purchase Record page appears, showing information about the 
selected Purchase Record. 

4. Edit the purchase record as necessary: 
- Edit the Purchase Record's header information. 
- Click a link for any product in the Purchase record, then edit the Purchase Q ty, 
Serial Number, Cost Center, Department, Site, Comment, Unit MSRP, or Unit Price 
for any product in the Purchase Record. 
- Add a Catalog Product to the Purchase Record - click Choose Product, and follow the 
steps to adding Catalog Products to a Purchase record as described in Adding a Single 
Purchase Record. 
- Delete a Catalog Product from the Purchase Record - click the Delete icon that 
appears to the left of the Catalog Product entry. 

5. When finished, click Done. The Purchase Record Detail report appears in the right 
frame, showing the changes you've made. 

Deleting a Purchase Record 

Use the Delete Purchase command, available from the Purchase Records menu, to delete a Purchase Record . 

 

To delete a Purchase Record: 

1. From the Purchase Records menu, choose Delete Purchase. The Delete Purchase 
Records page appears in the right frame. 

2. Use the filter options in the left frame to narrow your search if necessary. 
3. Click check boxes in the Select column to choose the Purchase Records you want to 

delete. 
4. When you have selected all Purchase Records you want to delete, click Delete. The 

selected records disappear from the list of Purchase Records. 
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Replacing Demographic Information in Purchase Records 

The values available from the Site, Department or Cost Center drop-down menus in Purchase Record line items come 
directly from Purchase Records, either imported or entered directly. These values might not match the demographic 
values that appear in your ZENworks Asset Management inventory. 

 

You can replace a Site, Department or Cost Center value for all Purchase Records with a value from your Discovered 
Products inventory, so that they correspond. Once the demographic values in your Purchase Records match the values 
in your Discovered Products, you can group and filter information in your reports and other lists by a specific 
demographic. 

 

Use the Replace submenu of the Purchase Record menu to change the value for a Site, Department or Cost Center for 
all line items in all Purchase Records that use that information. 

 

Note: The values that appear in the Site, Department or Cost Center drop-down menus come from the values entered 
in your Purchase Records. 

 

To replace demographic information: 

1. From the Purchase Record menu, choose one of the options in the Replace menu. 
2. The Replace Demographics page appears in the right frame. 
3. In the upper drop-down list, choose the demographic value in your Purchase Records 

you want to replace. 
4. In the lower drop-down list, choose the demographic value in your ZENworks Asset 

Management database you want to use to replace the old value. 
5. When finished, choose Replace. The new demographic value is replaced in all Purchase 

Records that use it. 
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Importing Purchase Records 

Use the Import submenu, available from the Purchase Records menu, to import batches of Purchase Records, and to 
view the history of Purchase Records you've imported in the past. 

What happens when you import Purchase Records? 

When you import a batch of Purchase Records, a Purchase Record is added for each unique purchase order, and a 
Catalog Product is added for each unique item in the import file. This is the most efficient way to enter a large number 
of purchase transactions and their associated catalog products. 

 

Note: The import process gives you an excellent opportunity to take advantage of grouping and filtering options that 
use demographics. If you populate the Site, Department or Cost Center columns in your import file, you can group, 
filter, and sort by any of these demographics. For more information, see Importing and Demographics. 

 

What would you like to do? 

Learn about the file format required for importing Purchase Records 

Learn about including demographic information in the Import File 

Import a batch of Purchase Records 

View the history of previous imports of Purchase Records 

View the status of an import 

Preparing Your Import File 

To prepare for importing Purchase Records, you need to create an Import File that matches a format described in 
Import File Formats.  

 

Once you have your data in the proper format, you may want to scan the data to make sure it contains reasonable 
information before you import it.  

Things to Check 
Once the file is formatted as described, you may want to check the following: 

 

 Licenses Per Package - A quantity of one is used If this column does not contain a 
value. You can enter a value before you import the file, or you can enter a value after 
you have imported the data. The LicensesPerPackage column should contain the 
number of licenses represented by the purchase of one unit of this product. For 
example, if the product is a 10-pack, this column should contain a value of 10. 

 Demographic Information - If you want to make use of demographic information for 
grouping, filtering, and sorting, you can include demographic information for each line 
item in the Site, Department, and CostCenter columns. For more information, see 
Importing and Demographics below.  

Importing and Demographics 
To get the most out of ZENworks Asset Management Software Management's demographic grouping features, you need 
to make sure that the demographic information gets into the system for every record. An easy way to do this is to 
include the information with each line item of your import file. 

The Site, Department, and Cost Center Fields 
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The Site, Department, and Cost Center fields, columns 23-25 of the Import File, are used by ZENworks Asset 
Management Software Management for tracking demographics. You can associate any line item with a value in any or 
all of these columns so that license quantities can be summarized within a particular demographic.  

 

In order for these values to be meaningful in ZENworks Asset Management Software Management, corresponding 
demographics must be associated with workstations in the ZENworks Asset Management inventory . If you are planning 
to make use of demographic tracking, you may want to populate these columns with meaningful values before you 
import your Purchase Record data.  

 

Note: If a demographic value you have used during an import doesn't match a value in the ZENworks Asset Management 
inventory, you can replace that value globally with one from the ZENworks Asset Management inventory at a later 
time. For more information, see Replacing Demographic Information. 
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Import File Formats 

Before you can import Purchase Records, you must make sure that your file matches one of the required import 
formats. 

Standard File Format 
The standard format is described in Standard Import File Format. 

Additional Formats 
The following are reseller connectors, additional file formats supported by ZENworks Asset Management Software 
Management. 

 

   Reseller  Format  Reseller Report  

 

Software House 
International  

Standard  ZENworks Asset Management 
License Compliance Report  

 

Softchoice Corporation  Custom  Product History Report  

 

Software Spectrum  Standard  ZENworks Asset Management 
Reseller Connector Report (all 
versions) 

 

Notes: 

If you supply site, department or 
cost center information to 
Software Spectrum as part of your 
purchase information, you may 
request that this information is 
included in your report. These 
fields are not included in the 
default report template. 
 
Software Spectrum does not 
populate the serial number field. 

 

CompuCom Standard  CompuCom Compliance Report 
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The Standard Software Management Import File Format 
Before you can import Purchase Records, you must make sure that your file matches one of the required import 
formats. This topic describes the format of the standard import file. For information on other formats, see Import File 
Formats. 

File Format 
The file must be an ASCII tab-delimited text file, with one row per line item. The first line of the file must contain 
column headers, and must match the field names defined below. 

Column Headers 
Each row of the Import File contains a line item in a Purchase Record . There are two parts to each row in the Import 
File: 

 

 Purchase Record Header Fields - These fields contain information specific to a 
particular invoice, purchase order, or other purchase transaction. They appear in 
columns 1-13. 

 Purchase Record Product Fields - These fields contain information about a particular 
line item in the purchase record. They appear in columns 14-30. 

 

Note: You may omit any columns that are not required. 
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Purchase Record Header Fields 

 The first 13 columns of the Import file contain header information, specific to the 
Purchase Record.  

 For each line item in a Purchase Record, you must repeat all of the Purchase Record 
information.  

 

The Purchase Record data is contained in the following columns: 

 

Column # Field Name  Field Definition  Comments  

1 PO#1  Purchase order number.  This reference helps link to supporting 
documentation and establish proof-of-ownership.  

2 OrderDate1  Order date.     

3 Reseller  Reseller from whom the products in 
this order were purchased.  

   

4 Recipient  The individual to whom the products 
in this order were shipped.  

   

5 CompanyName  The name of the company or entity 
that executed the order.  

   

6 ShippingAddress1 Shipping address - line 1  

7 ShippingAddress2 Shipping address - line 2  

8 ShippingAddress3 Shipping address - line 3  

street, PO Box, internal mail code, etc.  

9 City  City order was shipped to.     

10 State  State order was shipped to.     

11 Zip  Zip code or mail code order was 
shipped to.  

   

12 Country  Country order was shipped to.     

13 Notes  Text field for general notes about the 
purchase record.  

   

1 - one of these fields must be included in the record; one or more of these fields are used to define a unique purchase 
record in the ZENworks Asset Management database.  

 

 



Using the ZENworks Asset Management Web Console 

90 

Purchase Record Product Fields 

 Columns 14-30 contain information about a single line item of a purchase record.  
 A purchase record can contain multiple invoices. 
 An invoice or purchase record can contain multiple line items, each representing a 

single product, as long as the information in columns 1-13 remains the same for each 
line item. 

Column # Field Name  Field Definition  Comments  
14 Manufacturer3  Manufacturer of the product 

ordered.  
   

15 ProductName2,3  Name or description of the 
product ordered.  

   

16 Version3  The version of the product 
ordered.  

   

17 ProductType3  The type of product ordered.  The Product Type field helps establish what the 
product represents (Examples: full license, upgrade, 
media, etc.)  

18 LicensesPerPackage3 The number of licenses 
represented by this form of the 
product.  

Example: If the product is a 5-pack, then this value=5. 
Defaults to 1 if no value is specified.  

19 ResellerSKU  The SKU number assigned by the 
reseller.  

This value may be important when communicating 
with a particular reseller.  

20 MfrPart#  The part number assigned by the 
manufacturer.  

If available, this field can often be used distinguish 
one product from another.  

21 PurchaseQty  The number of units purchased 
in the order.  

   

22 Serial#  The software serial number 
associated with the product 
ordered.  

   

23 Site  The Site to which the software 
licenses are assigned.  

24 Department  The Department to which the 
software licenses are assigned.  

25 CostCenter  The Cost Center to which the 
software licenses are assigned.  

The Site, Department, and Cost Center fields are 
used by ZENworks Asset Management Software 
Management for tracking demographics. You can 
associate a line item with a value in any or all of these 
columns so that license quantities can be summarized 
within a particular demographic.  In order for these 
values to be meaningful in ZENworks Asset 
Management Software Management, corresponding 
demographics must be associated with workstations in 
the ZENworks Asset Management inventory.  

26 Comment  Text field for general comments 
about the product purchased.  

   

27 Invoice#  Invoice number.   This reference helps link to supporting documentation 
and establish proof-of-ownership.Note: Multiple 
invoices can be associated with the same purchase 
order number.  

28 UnitMSRP  Numeric field representing the 
product's Manufacturers' 
Suggested Retail Price  

29 UnitPrice  Numeric field representing the 
product's Unit Price.  

30 ExtendedPrice  Numeric field representing the 
product's Extended Price.  

Notes about price fields:If currency symbols and 
thousands separators appear in the fields, they are 
stripped out when the data is imported.The importer 
uses the locale of the server to determine what 
characters are used for thousands and monetary 
decimal separators. If your values contain a mix of 
currencies, the imported cost values may be 
incorrect.If no value exists in the ExtendedPrice 
field, a value is calculated based on the values of the 
PurchaseQ ty and UnitPrice fields. If a value exists, it 
is imported, and is not checked to see if it matches a 
calculated value.  

 
2 - Required field 
3 - The Manufacturer, Product Name, Version, Product Type, and Licenses Per Package fields are used to determine 
the existence of a unique product. 
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Softchoice Import File Format 
This format is generated from the Softchoice Corporation's Product History Report. 

File Format 
The file must be an ASCII tab-delimited text file, with one row per line item. The first line of the file must contain 
column headers, and must match the field names defined below. 

Column Headers 
Each row of the Import File contains a line item in a Purchase Record . There are two parts to each row in the Import 
File: 

 

 Purchase Record Header Fields - These fields contain information specific to a 
particular invoice, purchase order, or other purchase transaction. They appear in 
columns 1-13. 

 Purchase Record Product Fields - These fields contain information about a particular 
line item in the purchase record. They appear in columns 14-30. 

Note: You may omit any columns that are not required. 
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Purchase Record Header Fields 

 The first 13 columns of the Import file contain header information, specific to the 
Purchase Record.  

 For each line item in a Purchase Record, you must repeat all of the Purchase Record 
information.  

The Purchase Record data is contained in the following columns: 

Column # Field Name Softchoice Field Name Field Definition Comments 
1 PO#1 PURCHASEORDER Purchase order 

number.  
This reference helps link to 
supporting documentation and 
establish proof-of-ownership. 

2 OrderDate1 ORDERDATE Order date.  
3 Reseller  Reseller from whom 

the products in this 
order were 
purchased.  

 

4 Recipient SHIPCONTACTNAME The individual to 
whom the products 
in this order were 
shipped.  

 

5 CompanyName COMPANYNAME The name of the 
company or entity 
that executed the 
order. 

 

6 ShippingAddress1 SHIPADDR Shipping address - 
line 1 

7 ShippingAddress2 SHIPCITYSTZIP Shipping address - 
line 2 

8 ShippingAddress3  Shipping address - 
line 3 

Street, P.O. Box, Internal mail 
code, etc.  

9 City  City order was 
shipped to.  

 

10 State  State order was 
shipped to. 

 

11 Zip  Zip code or mail 
code order was 
shipped to. 

 

12 Country  Country order was 
shipped to. 

 

13 Notes  Text field for 
general notes about 
the purchase 
record. 

 

 
1 - one of these fields must be included in the record; one or more of these fields are used to define a unique 
purchase record in the ZENworks Asset Management database. 
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Purchase Record Product Fields 

 Columns 14-30 contain information about a single line item of a purchase record.  
 A purchase record can contain multiple invoices. 
 An invoice or purchase record can contain multiple line items, each representing a 

single product, as long as the information in columns 1-13 remains the same for each 
line item. 

 

Column #  Field Name Softchoice Field 
Name 

Field Definition Comments 

14 Manufacturer3 PUBLISHER Manufacturer of the 
product ordered. 

 

15 ProductName2,3 ITEMDESC Name or description of 
the product ordered. 

 

16 Version3  The version of the 
product ordered.  

 

17 ProductType3  The type of product 
ordered. 

The Product Type field helps 
establish what the product 
represents (Examples: full 
license, upgrade, media, etc.)  

18 LicensesPerPackage3  The number of licenses 
represented by this form 
of the product. 

Example: If the product is a 5-
pack, then this value=5. Defaults 
to 1 if no value is specified.  

19 ResellerSKU SKU The SKU number assigned 
by the reseller. 

This value may be important 
when communicating with a 
particular reseller. 

20 MfrPart# MFGSKU The part number 
assigned by the 
manufacturer. 

If available, this field can often 
be used distinguish one product 
from another. 

21 PurchaseQ ty QTYORD The number of units 
purchased in the order. 

 

22 Serial#  The software serial 
number associated with 
the product ordered. 

 

23 Site  The Site to which the 
software licenses are 
assigned. 

24 Department  The Department to which 
the software licenses are 
assigned. 

25 CostCenter  The Cost Center to which 
the software licenses are 
assigned. 

The Site, Department, and Cost 
Center fields are used by 
ZENworks Asset Management 
Software Management for 
tracking demographics. You can 
associate a line item with a value 
in any or all of these columns so 
that license quantities can be 
summarized within a particular 
demographic.  
 
In order for these values to be 
meaningful in ZENworks Asset 
Management Software 
Management, corresponding 
demographics must be associated 
with workstations in the 
ZENworks Asset Management 
inventory.  
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26 Comment COMMENTS Text field for general 
comments about the 
product purchased. 

 

27 Invoice# INVOICE Invoice number. This reference helps link to 
supporting documentation and 
establish proof-of-ownership. 
 
Note: Multiple invoices can be 
associated with the same 
purchase order number. 

28 UnitMSRP  Numeric field 
representing the 
product's Manufacturers' 
Suggested Retail Price 

29 UnitPrice SELLPRICE Numeric field 
representing the 
product's Unit Price. 

30 ExtendedPrice INVTOTAL Numeric field 
representing the 
product's Extended Price. 

Notes about price fields: 
If currency symbols and thousands 
separators appear in the fields, 
they are stripped out when the 
data is imported. 
 
The importer uses the locale of 
the server to determine what 
characters are used for thousands 
and monetary decimal separators. 
If your values contain a mix of 
currencies, the imported cost 
values may be incorrect. 
 
If no value exists in the 
ExtendedPrice field, a value is 
calculated based on the values of 
the PurchaseQ ty and UnitPrice 
fields. If a value exists, it is 
imported, and is not checked to 
see if it matches a calculated 
value.  

 
2 - Required field 
3 - The Manufacturer, Product Name, Version, Product Type, and Licenses Per Package fields are used to 
determine the existence of a unique product.  
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Unused Softchoice Fields 
The following Softchoice import file fields are ignored during the import process. 

 

 ORDERNO 
 INVDATE 
 PURCHASEREF 
 ORDERSTATUS 
 LINENO 
 QTYSHP 
 COMPANYNAMESHIP 
 COMPANYNAMEBILL 
 BILLCONTACTNAME 
 BUYERNAME 
 BILLADDR 
 BILLCITYSTZIP 
 ATTN 
 REQ 
 ITEM  
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Importing Your Purchase Records 

Use the Start Import command, available from the Purchase Records menu's Import submenu, to import purchase 
records from a text file. 

 

To import a set of purchase records from a text file: 

 

1. Prepare your Import File as described in Preparing Your Import File. Make sure the text 
file you are using to import your purchase records matches the format defined in The 
Import File Format. 

2. From the Purchase Records menu's Import submenu, choose Start Import. The Start 
Import page appears. 

3. Click Browse, then choose the text file containing the Purchase Records you want to 
import.  

4. Click Start Import. The View Active Imports page appears, and shows the status of 
your import. The page refreshes every 20 seconds. 

5. If you want to check your import to make sure it imported as expected, you can choose 
View Import History from the Imports submenu. 

6. Review your imported data as described in Reviewing Your Imported Data. 

Viewing Your Active Imports 

Use the View Active Imports command, available from the Purchase Records menu's Import submenu, to view the 
status of a Purchase Record import process. If you have queued up several purchase record imports, you can delete any 
import process that is not yet underway. 

 

For an explanation of all columns of the View Active Imports page, see the View Active Imports reference topic. 

 

To view your active imports: 

 From the Purchase Records menu, choose View Active Imports from the Imports 
submenu. The View Active Imports page appears in the right frame. 

 

To delete any waiting imports: 

1. In the Select column click check boxes to select the import processes you want to 
delete. To select all waiting import processes, click Select All. To clear all selected 
import processes, click Clear Selection. 

2. Click Delete to delete all selected import processes. 
 
Note: If an import process starts before you click Delete, it may not be deleted. 
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Viewing Your Import History 

Use the View Import History command, available from the Purchase Records menu's Import submenu, to view a history 
log of previous Purchase Record import operations. 

To view your import history: 

 From the Purchase Record's Import submenu, choose the View Import History 
command. The Import History page appears in the right frame, showing a list of History 
Records. 
 
For an explanation of the columns in the Import History page, see the Import History 
Reference topic. 

To delete an entry from the Import History log: 

1. In the Select column, click the check boxes for the History Records you want to delete. 
To select all records, Select All. To clear all check boxes, click Clear Selection. 

2. Click Delete to delete the selected History Records. The selected History Records 
disappear from the list. 
 
Note: Deleting a History Record does not delete any of the imported records. It simply 
deletes the entry from the History log. 

Reviewing Your Imported Data 

Once you have imported a batch of Purchase Records, you should check the following: 

 Make sure the data imported properly - If your import file was not formatted 
correctly, the import may have succeeded, but the data may be in the wrong fields. 
This will probably be quite obvious. 
  

 Review the Import History report 
 
The Row Count in the history entry should match the number of rows in your Import 
file.  
 
The number of Details Created (Purchase Record line items) in the history entry 
should match the number of line items in your Import file. One Detail should be 
created for each line item.  
 
For more information, see Viewing Your Import History. 
  

 Make sure your Licenses Per Package quantities are correct - For products with 
multiple licenses, such as 5- or 10-packs, make sure the Licenses Per Package 
quantities appear correctly in the View/Edit Catalog Products page. You can narrow 
your search for multi-packs by searching the Product Type or Product fields for "pak" or 
"pack." For the steps to changing these values, see Editing a Catalog Product. 
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Working With the Product Catalog 

Use the Product Catalog menu to add, edit, delete Catalog Products. You can also reconcile catalog products to 
licenses and exclude them so they do not appear as unreconciled products. 

What is a Catalog Product? 

 A Catalog Product represents the form in which you can purchase the software and its 
license(s). 

 

For example, a single copy or a 10-pack of a particular version of a software product are different Catalog Products. 
Each appears as a separate Catalog Product in the Product Catalog. 

What do you want to do? 

Add or Edit a Catalog Product 

Delete A Catalog Product 

Reconcile Catalog Products to a License 

Exclude a Catalog Product 

Specify a Catalog Product as an Upgrade to another Catalog Product 

Product Catalog Menu Reference 

Add Product 

View/Edit Product 

Delete Product 

Exclude Product 

Reconcile to License 
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Adding a Catalog Product 

Use the Add Product command, available from the Product Catalog menu, to add a product to the Product Catalog.  

 

To add a product to your Product Catalog: 

 

1. From the Product Catalog menu, choose Add Product. The Add Catalog Product page 
appears in the right frame. 

2. Choose a manufacturer from the drop-down list. If the manufacturer does not appear in 
the list, choose --Add a New List Item-- at the top of the drop-down list. 

3. Enter a Product name, choose a Product Type from the drop-down list, and enter the 
Version and Mfg. Part # in the boxes provided. 

4. Enter a value in the Licenses Per Pkg. box. (Example: if the product is a 10-pack, 
enter 10 here.) This value defaults to 1, and needs to be changed only if the product 
entitles you to more than one license for the specified version of software.  

5. If the software is an upgrade to a previous version of software, click the Upgrade 
check box. For more information on how to handle upgrades, see Working with 
Software Upgrades. 

6. To keep the product from appearing as an unreconciled product, click the Exclude 
check box. For more information about excluding products, see Excluding Purchased 
Products. 

7. To reconcile the catalog product to an existing license record , or to add a new License 
Record, click Reconcile to License. For more information, see Reconciling Catalog 
Products. 

8. When finished, click Done. 

Editing a Catalog Product 

Use the View/Edit Product command, available from the Product Catalog menu, to edit products already in your 
Product Catalog. 

 

To edit a Catalog Product : 

1. From the Product Catalog menu, choose View/Edit Product. A list of products in your 
Product Catalog appears. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. Click any active link in the row showing the Catalog Product you want to edit. The 

View/Edit Catalog Product page appears, containing information about the selected 
product. 

4. Make changes to any information about the product. 
5. To reconcile the Catalog Product to a License Record, click Reconcile to License. If 

the Upgrade check box is selected, you can make changes to the upgrade information 
about the product. For more information, see Working with Software Upgrades.  

6. To keep the product from appearing as an unreconciled product, click the Exclude 
check box. For more information about excluding products, see Excluding Purchased 
Products. 

7. Click Done to save your changes. 
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Deleting a Product 

Use the Delete Product command, available from the Product Catalog menu, to delete one or more products from the 
Product Catalog. 

 

To delete products from the Product Catalog: 

 

1. From the Product Catalog menu, choose Delete Product. The Delete Catalog Products 
page appears in the right frame, showing a list of Catalog Products. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. Click the check boxes in the Select column for any products you want to delete. 
4. Click Select All to select all the products on the current page, or click Clear Selection 

to clear all check boxes in the Select column. 
5. Click Delete Catalog Products. A confirmation box appears. 

 
Note: If the product is contained in a Purchase Record , or if the product is reconciled 
to a License Record , you cannot delete the product from the Product Catalog. To 
delete it, you must first delete from the License Record and/or Purchase Record . 
  

6. Click OK. The selected products disappear from the Product Catalog. 

Reconciling Catalog Products 

Use the Reconcile to License command, available from the Product Catalog menu, to reconcile one or more Catalog 
Products to an existing License Record . You can also add a new License Record from the Reconcile Products to License 
page. 

What is a Software License? 

 A Software License represents your entitlement to run a copy of a specific version of 
software. 

 A License Record represents the total number of licenses you own for a particular 
product. 

Why do I have to reconcile Catalog Products to licenses? 

Once you have imported or entered a number of Purchase Records:  

 

 You may have two or more entries in your Product Catalog for the same product, such 
as single copies and 5-packs. 

 Reconciling a Catalog Product to a License Record is one-half of the process of 
determining your compliance status for a software product. It allows ZENworks Asset 
Management Software Management to determine the total number of licenses you've 
purchased for the product, based on the number of purchases of the products in the 
Product Catalog you have associated with that License Record. 

 

That's why you reconcile - to connect entries in your Product Catalog through a License Record to one or more 
Discovered Products . This allows ZENworks Asset Management Software Management to calculate your compliance 
status by comparing your Discovered Products to the licenses you've purchased. The License Record is the "glue" that 
allows you to connect one or more purchased products to one or more discovered products. 
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What happens when I reconcile a Catalog Product to a license? 

When you reconcile a Catalog Product to a license, you are associating that particular unique manufactured software 
product version as it appears in the Product Catalog with a unique License Record. Through this process, you can 
associate different forms of the same product, such as single copies and multi-packs, with a single License Record. This 
allows the Compliance report to show an accurate license count for the product, no matter how many times you 
purchase it, or in what form. 

 

To reconcile a Catalog Product to a License: 

 

1. From the Product Catalog menu, choose Reconcile to License. The Reconcile Catalog 
Products to License page appears in the right frame, showing a list of available Catalog 
Products. Use the filter options in the left frame to narrow your search, if necessary. 

2. In the Select column, click the check boxes for the products you want to reconcile, and 
click Reconcile to License Record. In a new window, a list of Catalog Products you 
selected appears. Below it, a list of available License Records appears. Use the filter 
options in the left frame to narrow your search, if necessary.  
Note: If you choose a product that is already reconciled to another license, a 
confirmation appears, warning you that the product is already reconciled. If you then 
click OK, the association with the other license is broken, and the product is reconciled 
to the selected license. 
Note: If the license you are looking for does not appear in the list, click Add License. 
The Add License Record page appears. For more information on creating licenses, see 
Adding a License Record. 

3. In the Select column, click the check box for the license you want to reconcile to the 
selected Catalog Products. 
Note: You can choose only one license. If you choose more than one, an error message 
appears. 

4. Click Done. The View/Edit License Record page appears in the right frame, showing all 
Catalog Products and Discovered Products currently reconciled to this license, including 
the ones you just selected.  

5. When finished, click Done. The Reconcile Catalog Products to License page appears. If 
you are viewing Unreconciled Products, the reconciled products disappear from the 
list. 
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Working with Software Upgrades 

Through ZENworks Asset Management Software Management, you can maintain an accurate view of your compliance 
status for a product through a series of upgrades to the product. Before you can handle upgrades correctly, you may 
find it helpful to understand what happens to licenses when you upgrade a software product. 

What happens to my licenses when I upgrade? 

When you upgrade from one version of software to another, the number of licenses you are entitled to install for that 
software does not change. Instead, you are shifting your entitlement from one version of the software to another.  

 

This means for each copy of the new version you install, your entitlement to run the old version decreases by one. This 
is called the Adjusted License Count. 

How do I deal with upgrades? 

Before your Compliance report can display accurate information about a software product and its upgrades, you must 
specify the relationship between the full product you have purchased and the upgrades to that product. 

 

Here are some key concepts about handling upgrades: 

 

 The product you are upgrading from must be in the Product Catalog , and must have its 
own License Record . 

 The product you are upgrading to must be in the Product Catalog, and must have its 
own License Record. 

 

To enter a Catalog Product as an upgrade: 

 

1. Enter the Catalog Product as you would any other. 
2. Add a License Record for the product. 
3. Make sure you have a Purchase Record containing a Catalog Product for the software 

version you want to upgrade from, and that it is reconciled to a License Record. For 
example, if you want to enter an Adobe Acrobat 5.0 as an upgrade to Adobe 4.x, you 
must have a Purchase Record containing the Catalog Product record for Adobe 4.x, and 
it must be reconciled to a License Record for Adobe Acrobat 4.x. 

4. From the Product Catalog menu, choose View/Edit Product, choose filter options if 
necessary, and click the link for the upgrade version of software. The Edit Catalog 
Product page appears in the right frame. 

5. Click Upgrade From License Record. A list of available licenses appears. 
6. In the Select column, click the check box for the license for the earlier version of 

software, the one you are upgrading from.  
7. Click Done. The View/Edit Product page appears in the right frame, showing the 

selected License Record in the Upgraded From area. 
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Excluding Catalog Products 

In some cases, you may not want a Catalog Product to appear in your Compliance report. For example, if your Purchase 
Records contain line items other than software, such as media, manuals, or other documents. 

 

Use the Exclude Product command, available from the Product Catalog menu, to exclude products. When you exclude 
a Catalog Product, it is no longer counted and does not appears as an Unreconciled Catalog Product. 

 

To exclude a Catalog Product: 

 

1. From the Product Catalog menu, choose Exclude Product. The Exclude Catalog Product 
page appears in the right frame, showing a list of catalog products. 

2. Use the filter options in the left frame to view Included Products or All Products, and 
to narrow your search, if necessary. 

3. In the Select column, click the check boxes for those products you want to exclude. 
4. Click Exclude Product. A check mark appears in the Excluded column for the selected 

products. 
Note: if you choose a product that has been reconciled, a confirmation appears, 
warning you that you are about to exclude a product that is already reconciled to a 
license. 

 

To include a product that is currently excluded: 

 

1. From the Product Catalog menu, choose Exclude Product. The Exclude Catalog Product 
page appears in the right frame, showing a list of catalog products. 

2. Use the filter options in the left frame to view Excluded Products, and to narrow your 
search, if necessary. The Exclude Product button changes to Include Product. 

3. In the Select column, click the check boxes for those products you want to include. 
4. Click Include Product. The selected products disappear from the list. 
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Working With Discovered Products 

Use the Discovered Products menu to view a list of products determined by ZENworks Asset Management to be installed 
in your environment. 

What do you want to do? 

Reconcile Discovered Products to License Records 

Exclude Discovered Products from the Compliance Report 

Define Software Standards Categories and assign Discovered Products to them 

Discovered Products Menu Reference 

Exclude Product 

Reconcile to License Record 

Manage Software Standards 

About the License Knowledgebase 

When ZENworks Asset Management scans a machine for software, it generates a more detailed list than is needed for 
license tracking purposes. The License Knowledgebase applies a set of rules and mappings to the ZENworks Asset 
Management software inventory data to reduce unnecessary detail, presenting the information needed for license 
tracking. 

 

The License Knowledgebase adjusts your view of Discovered Products list in the following ways: 

 

 It consolidates related versions, service releases, and language versions to the minor 
release level (example: 3.1) into a single product. 

 It excludes products, such as browsers and viewers, that are known not to require 
licensing. 

 It recognizes a software suite, and ignores its components, so they are counted 
together as a single installation. When individual components are discovered, not as 
part of a suite, they are reported as individual installations. 

 

Because the Discovered Products list is filtered through the License Knowledgebase, the installed counts as they appear 
in the Discovered Products list can be significantly lower than the counts as they appear in ZENworks Asset 
Management. 

 

Note: The License Knowledgebase continues to develop, as the products of more manufacturers are identified for 
consolidation or exclusion. A new version of the License Knowledgebase is included with each release of ZENworks 
Asset Management. 
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Reconciling Discovered Products 

Use the Reconcile to License command, available from the Discovered Products menu, to reconcile one or more 
discovered products to an existing License Record . 

What happens when I reconcile a Discovered Product to a license? 

When you reconcile a Discovered Product to a license, you are associating that particular unique product in your 
installed software inventory with a unique license record. Through this process, you can connect discovered products 
through the License Record to the products you've purchased. This allows the Compliance report to show an accurate 
comparison between software installations and licenses for software products. 

 

To reconcile a Discovered Product to a License: 

 

1. From the Discovered Products menu, choose Reconcile to License Record. The 
Reconcile Discovered Products to License page appears in the right frame, showing a 
list of Discovered Products. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. In the Select column, click check boxes for the products you want to reconcile, and 

click Reconcile to License Record. A list of available License Records appears in a new 
window. Use the filter options in the left frame to narrow your search, if necessary.  
Notes: 
If you choose a product that is already reconciled to another license, a confirmation 
appears, warning you that the product is already reconciled. If you then click OK, the 
association with the other license is broken, and the product is reconciled to the 
selected license. 
If the license you are looking for does not appear in the list, click Add License. The 
Add License Record page appears. For more information on creating licenses, see 
Adding a License Record. 

4. In the Select column, click the check box for the license you want to reconcile to the 
selected Discovered Products. 
Note: You can choose only one license. If you choose more than one, an error message 
appears. 

5. Click Done. The View/Edit License Record page appears in the right frame. If you are 
viewing Unreconciled Products (the default view), the products you reconciled 
disappear from the list.  
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Excluding Discovered Products 

In some cases, you may need to exclude certain Discovered Products , even though they have been discovered on one 
or more systems. Here are some example of discovered products you might want to exclude: 

 

 The product does not require license tracking, (example: freeware or software bundled 
with a licensed application)  
 
Note: The License Knowledgebase maintained by Novell typically excludes these types 
of applications (when known) so they do not appear as Discovered Products. If a 
product of this type is not excluded by the License Knowledgebase , you may want to 
exclude it for the purposes of compliance analysis or tracking. 
  

 The product is a demo or evaluation version. 

 

Use the Exclude Product command, available from the Discovered Products menu, to excluded Discovered Products 
from the Compliance report. 

 

To exclude a Discovered Product : 

 

1. From the Discovered Products menu, choose Exclude Product. The Exclude Discovered 
Products page appears in the right frame, showing a list of Discovered Products. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. In the Select column, click the check boxes for those products you want to exclude. 
4. Click Exclude Product. If you are viewing Included Products only, the selected 

products disappear from the list. If you are viewing All Products, a check mark appears 
in the Excluded column for the selected products. 
 
Note: You cannot exclude a product that has been reconciled. If you want to exclude 
the product, you must delete the Discovered Product from the License Record. For 
more information, see Viewing and Editing Licenses. 

 

To include a product that is currently excluded: 

 

1. From the Discovered Products menu, choose Exclude Product. The Exclude Discovered 
Products page appears in the right frame, showing a list of Discovered Products. 

2. Use the filter options in the left frame to narrow your search, if necessary. In order to 
view excluded products, you must choose Excluded Products or All Products in the 
View section of the filter. 

3. In the Select column, click the check boxes for those products you want to include. 
4. Click Exclude Product. If you are viewing Excluded Products only, the selected 

products disappear from the list. If you are viewing All Products, the check mark in the 
Excluded column for the selected products disappears. 
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Managing Software Standards 

Use the Manage Software Standards command, available from the Discovered Products menu, to define Software 
Standards categories and to assign Discovered Products to them. 

Overview 

You can define categories you can use to group Discovered Products into groups that are meaningful to your 
organization. You can use these categories in a variety of ways, but the most common application is to track installed 
products as they conform to your organization's policies and standards for software installations. 

 

For example, you might define these three categories, and assign all of your Discovered Products to one of the three: 

 

 Standard 
 Non-Standard 
 Policy Violation 

 

Once you have defined these categories and assigned Discovered Products to them, you can view the Software 
Standards report, and easily see a list of products in each category, and the number of installations of each product. 
You can drill down to see a list of workstations containing a particular product, and further to view a list of Discovered 
Products on a particular workstation. 

Manage Software Standards View vs. Reconcile Discovered Products View 

There is an important difference between the list of products that appears in the Manage Software Standards page and 
the list that appears in the Reconcile to License page. Here is the difference: 

 

Page Shows 

Reconcile Discovered 
Products page 

O nly those Discovered Products that are not excluded on the Exclude Product 
page. 

 

This is because when looking at a list of products from a software license 
compliance perspective, you are not interested in those products that do not 
require license tracking.  

 

Manage Software 
Standards page 

All products, regardless of whether they are excluded or not.  

 

This is because when managing Software Standards, you are likely to want to 
know about installed products that do not require licenses, but may represent a 
violation of company Software Standards policy. 
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Assigning a Discovered Product to a Standards Category 

By default, no Standards categories are defined. You can easily create new standards as you are assigning products to 
them. 

 

1. From the Discovered Products menu, choose Manage Software Standards. The Manage 
Software Standards page appears in the right frame. 

2. In the Select column, click a check box to select a product you want to assign to a 
Standards category. 

3. At the bottom of the right frame, click Set Standards Category. The Select Standards 
Category page appears in the right frame. 

4. In the Standard drop-down menu, choose the Standards category you want to assign to 
the selected Discovered products. If the Standards category you want to use does not 
appear in the list, choose --Add a new list item--. A New List Item window appears. In 
the Standard box, enter the name of the new Standards category and click Add to 
List. A message confirms that the new category has been added to the list, and the 
new category appears in the Standard box. 

5. Click Done. The selected Discovered Products are assigned to the selected (or new) 
Standards category. 

Assigning Multiple Discovered Products to a Standards Category 

You can assign many products at once using a combination of features in the Manage Software Standards page. Use the 
following features to help you isolate groups of products and select them for assignment to Standards categories. 

 

 View - View by All Products, or view only User-Defined (Local) Products 
 Filter by - Filter by one or more selections you choose from lists of Manufacturers, 

Software Categories, Software Subcategories, or Standards Categories, or choose a 
field and enter a Search String to search for a particular value. You can use this feature 
to sort for those products with no assigned Standards category. 

 Sort by - Click a column header to sort by that column. Click the column again to 
reverse the sort order. 

 Select All and Clear Selection - Use these commands to select or clear all check boxes 
in the Select column at one time. 

Viewing the Software Standards Report 

Use the Software Standards Report page to view a list of Discovered Products and their Software Categories and 
Subcategories, and their assigned Standards Categories. You can also export the list to an Excel spreadsheet. 

 

For more information, see Software Standards Report. 

 

To view the Software Standards Report: 

 

 From the Reports menu, choose Software Standards.  
 Use the View and Filter by controls in the left frame to narrow the list.  
 Click Excel at the bottom of the right frame to export the current data to an Excel 

spreadsheet. 
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Managing Software Collections 

A software collection is a group of applications that may come bundled together, but are not recognized as a suite 
during the scanning process. By defining a collection, you can specify that if this set of applications is found on the 
same machine, they can assumed to be a suite or collection. If one of the applications is found without the others, it is 
considered to be a separate product. 

  

Once defined, the software collection appears as a discovered product, instead of its underlying member products. 
Usage is still tracked individually for a software collection's member products, and is available in the Software Usage 
reports by drilling down into the software collection. 

  

You can specify certain applications as Required. In doing so, you are specifying that the group of applications cannot 
be considered a collection unless the specified application is among them. Conversely, the collection could still be 
detected if an application that is not specified as required in the collection definition is not found on the same 
machine as the required applications.  

  

For example, a software suite could be bundled with several bonus programs from other manufacturers. You could un-
install one or more of those programs, and the collection would still be detected if those programs were not tagged as 
required. 

Adding a Software Collection 

Use the Add Collection command, available from the Software Collections submenu of the Discovered Products menu 
of the Asset Management tab's Software Management page, to add a software collection. 

  

To add a software collection: 

  

1. From the Asset Management tab, click Software Management. The View/Edit LIcense 
Records page appears. 

2. From the Discovered Products menu in the left frame, expand the Software 
Collections submenu. A list of submenu items appears 

3. Click Add Collection. The Add Collection page appears. 
4. Choose a Manufacturer from the drop-down list or choose Add a new list item (located 

at the top of the list) to add a new manufacturer. 
5. Enter a Product Name. 
6. Enter an optional Version number. 
7. Enter an optional comment in the Notes box. 
8. At the bottom of the right frame, click Add Member Products. The Add Discovered 

Products to Software Collection page appears in a new window, containing a list of 
products. 

9. Use the filters in the left frame to narrow your search. 
10. In the left column, click to select the check boxes for the products you want to add to 

the software collection. Select or clear all check boxes at once by clicking the check 
box in the column header. 

11. Click Done. The selected products appear in the lower half of the View/Edit Collection 
page. 

12. By default, all selected products are required. Clear the Required check box for any 
product you do not want to require as part of the collection. 

13. Click Done. The View/Edit Software Collections page appears, showing the updated list 
of software collections. 
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Viewing and Editing Software Collections 

You might need to edit a software collection definition at some point; change the name, the manufacturer, or version, 
add or remove member products, or change which products are required as part of the collection. 

  

Use the View/Edit Collection command, available from the Software Collections submenu, to edit a software 
collection definition. 

  

To edit a software collection definition: 

  

1. From the Asset Management tab, click Software Management. The View/Edit LIcense 
Records page appears. 

2. From the Discovered Products menu in the left frame, expand the Software 
Collections submenu. A list of submenu items appears 

3. Click View/Edit Collection. The View/Edit Software Collections page appears, showing 
a list of defined software collections.  

o To add a new software collection definition, click New. The Add Collection 
page appears. (See Adding a Software Collection for more information.)  

o Click Excel, CSV, or PDF to export the list to an Excel spreadsheet, a comma-
separated text file, or a PDF file. 

o Click Change Time Period to change the period over which the Active Usage 
Q uantity is shown. 

o Use the filters in the left frame to narrow your search. 
4. Click the Product you want to edit. The View/Edit Collection page appears, showing 

the details of the collection, along with a list of member products. 
5. Do any of the following: 

o Edit the details in the Manufacturer, Product, Version, or Notes boxes. 
o Select or clear Required check boxes for member products. 
o Click X to the left of a member product to remove it. 
o Click Add Member Products to add new products to the collection. 

6. When finished, click Done. The View/Edit Software Collections page appears, showing 
the updated list of software collections. 

Deleting a Software Collection 

Use the Delete Collection command, available from the Software Collections submenu, to delete a software collection 
definition. 

  

To delete a software collection definition: 

  

1. From the Asset Management tab, click Software Management. The View/Edit LIcense 
Records page appears. 

2. From the Discovered Products menu in the left frame, expand the Software 
Collections submenu. A list of submenu items appears 

3. Click Delete Collection. The Delete Software Collections page appears, showing a list 
of defined software collections. 

4. Use the filters in the left frame to narrow your search. 
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5. In the left column, click to select the check boxes for the software collection 
definitions you want to delete. Select or clear all check boxes at once by clicking the 
check box in the column header. 

6. Click Delete. A confirm message appears. 
7. Click OK. The Delete Software Collections page appears with the selected collections 

removed. 

  

Working With Licenses 

Use the License Record menu to add, edit, and delete License Records, and to reconcile licenses to Catalog Products 
and Discovered Products. 

What is a License Record? 

A License Record serves as the "glue" between products in the Product Catalog and Discovered Products (products 
discovered by ZENworks Asset Management.)  

 

By reconciling Catalog Products and Discovered Products to a License Record, you establish the basis for tracking 
licenses for a particular product. Once you have reconciled a license to the appropriate Catalog Products and 
Discovered Products for a given product, your Software Management Report can give you accurate information about 
the compliance status of related software products. 

 

The Compliance Report shows a list of License Records, and calculates license counts from Purchase Records and 
installation counts of Discovered Products associated with each License Record. 

 

What do you want to do? 

Add a License Record 

Edit an existing License Record 

Delete a License 

Reconcile a License to Catalog Products 

Reconcile a License to Discovered Products 

Add a License for each unreconciled Discovered Product 

Set Allocations for Licenses 

Attach a document to this license 
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License Record Menu Reference 

Add License 

View/Edit License 

Delete License 

License Allocation - Initialize Allocations 

License Allocation - Allocation Worksheet 

Auto-reconcile 

Adding a License Record 

For every line you want to track licensing for, you must have a License Record . 

 

You can add a License Record two ways: 

 

 Using the Add License Record command, available from the License Records menu. 
 Using the Add License Record button, available from the Reconcile Catalog Products: 

Select License or Reconcile Discovered Products: Select License pages. Using this 
method reconciles the product to the License Record at that same time. 

 

Adding a License Record from a Select License Page 

Use the Add License Record button, available from the Reconcile Catalog Products: Select License or Reconcile 
Discovered Products: Select License pages to add a License Record.  

 

Note: Using this method reconciles the product to the License Record at that same time. 

 

To use the Add License Record button to add a License Record: 

 

1. From the Product Catalog menu or the Discovered Products menu, choose Reconcile to 
License Record. The Reconcile Catalog Products or Reconcile Discovered Products page 
appears. You can also click Reconcile to License Record from the View/Edit Catalog 
Products page. 

2. In the Select column, click the check box for the product you want to reconcile and 
create a license for, and click Reconcile to License Record. In a new window, product 
you selected appears. 

3. Click the Add License Record button. A new License Record appears, containing 
information from the product you selected. 

4. Edit the Manufacturer, Product, or Version as necessary, add a comment, and click 
Done. The License Record is saved, and is reconciled to the selected product. 
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Adding a License Record from the License Records Menu 

Use the Add License command, available from the License Records menu, to add a new License Record. 

 

To use the Add License Record command to add a new License Record: 

 

1. From the License Records menu, choose Add License. The Add License page appears in 
the right frame. 

2. Choose a Manufacturer from the drop-down list. 
If the Manufacturer you want to use does not appear in the list, choose --Add New List 
Item-- from the top of the drop-down list and enter a manufacturer name. 

3. Choose a Product from the drop-down list.  
If the Product you want to use does not appear in the list, choose --Add New List Item-
- from the top of the drop-down list and enter a product name. 

4. Enter a version number or, if there are multiple versions that relate to a single license 
, enter useful text here, such as "3.x-5.x" or "multiple." 
Example: Through a series of purchase transactions, you purchase a few copies each of 
versions 6.0, 6.1, and 6.2 of a product. The manufacturer's license allows you to run 
any of the versions, so you are not concerned with tracking the upgrades of these 
products. You can reconcile all three products to a single license record, so they 
appear as one item in the Compliance Report. . You could enter "6.x" In the version 
number box. 

5. To reconcile this license to one or more Catalog Products, click Reconcile to Catalog 
Products.  
To reconcile this license to one or more Discovered Products, click Reconcile to 
Discovered Products. 
To specify allocations for this license, click Allocation Worksheet. 

6. When you are finished with this License Record, click Done. The View/Edit License 
Records page appears, showing a list of License Records. 

 

Viewing and Editing Licenses 

Use the View/Edit License command from the License Records menu to edit License Records. 

 

To edit a License Record : 

 

1. From the License Records menu, choose View/Edit License. A list of available License 
Records appears. 

2. Use the filter options in the left frame to narrow your search, if necessary. 

3. Click an active link for the License Record you want to edit. The Edit License Record 
page appears in the right frame. 



Using the ZENworks Asset Management Web Console 

114 

4. To reconcile this license to one or more Catalog Products, click Reconcile to Catalog 
Products.  
To reconcile this license to one or more Discovered Products, click Reconcile to 
Discovered Products . 
To specify allocations for this license, click Allocation Worksheet. 
To attach one or more documents to this license, click Attach Document(s). 
To break the association of a Catalog Product or Discovered Product with this license, 
click the "X" icon to the left of the product you want to delete from the license.  
Note: A product becomes unreconciled when you delete it from a license. 

5. When you are finished with this License Record, click Done. The View/Edit License 
Records page appears, showing a list of License Records. 

Deleting a License 

Use the Delete License command, available from the License Records menu, to delete one or more License Records. 

 

To delete a License Record : 

 

1. From the License Records menu, choose Delete License. The Delete License Record 
page appears in the right frame, showing a list of License Records. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. Click the check boxes in the Select column for any Licenses you want to delete. 

 
Note: If a check box is disabled, the License Record is reconciled to either a Catalog or 
Discovered Product, and cannot be deleted until delete the reconciliations in the 
License Record.. 
  

4. Click Select All to select all the products on the current page, or click Clear Selection 
to clear all check boxes in the Select column. 

5. Click Delete License. A confirmation box appears. 
6. Click OK. The selected products disappear from the list of License Records. 

 
Note: If a License Record has been reconciled to one or more Catalog or Discovered 
Products , you must delete those reconciliations from the License Record before you 
can delete it. 
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Reconciling From a License 

You can reconcile Catalog Products and Discovered Products to Licenses from two different points of view.  

 

 You can reconcile to a license from the Product Catalog menu and the Discovered 
Products menu. For more information, see Reconciling Catalog Products and 
Reconciling Discovered Products. 

 You can also reconcile from a license - that is, you can choose a license, then 
reconcile it to Catalog Products and to Discovered Products. 

 

To reconcile from a license: 

 

1. From the License Records menu, choose View/Edit Licenses. A list of available licenses 
appears in the right frame. 

2. Use the filter options in the left frame to narrow your search, if necessary. 
3. Click an active link for the license you want to reconcile. The Edit License Record page 

appears in the right frame. 
4. To reconcile to Catalog Products, click Reconcile to Catalog Products. A list of 

Catalog Products appears in the right frame.  
To reconcile to Discovered Products, click Reconcile to Discovered Products. A list of 
Discovered Products appears in the right frame.  

5. Choose the products you want to reconcile to the license as described in Reconciling 
Catalog Products and Reconciling Discovered Products. 
Note: If you choose a product that is already reconciled to another license, a 
confirmation appears, warning you that the product is already reconciled. If you then 
click OK, the association with the other license is broken, and the product is reconciled 
to the selected license. 

 

To delete a reconciled product from a license: 

 

 Click the Delete icon to the left of the product. The deleted product is no longer 
reconciled to a license. 
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Using Auto-reconcile 

Use the Auto-reconcile command to view a list of suggestions for creating License Records. This list is based on your 
Discovered Products list, and suggests records only for those Discovered Products that are neither reconciled nor 
excluded. 

 

It also suggests products from your Product Catalog that are likely matches for the Discovered Products.  

 

To use Auto-reconcile to create new license records: 

 

1. From the License Records menu, choose Auto-reconcile. The Auto-reconcile page 
appears in the right frame, with a short description of the function. 

2. If you want to create a new license for each discovered product for which no license 
exists, click to choose Create New License.  
If you want to reconcile any newly discovered products for which licenses already exist, 
click to choose Add to Existing License.  

3. Use the View and Filter Options in the left frame to narrow your search or click Start 
Auto-reconcile to view all suggested licenses . A list of suggested licenses appears, 
along with their corresponding Discovered Products. 

4. Click check boxes to select the suggested License Records you want to create.  
5. If any Catalog Products appear, clear the check boxes for any Catalog Products you do 

not want to reconcile to the suggested License Records. 
6. If you want to accept all the suggestions in the current window, click Select All. All 

check boxes in the current window are checked. 
7. When all check boxes in the current window are set the way you want them, click 

Create Licenses. For each checked Suggested License Record , a new License Record is 
created, reconciled to its corresponding Discovered Product. For each Catalog Product 
checked, the License Record is also reconciled to the corresponding Catalog Product. 
 
Notes:  

 Be sure to click Create Licenses after making your selections. If you view another page 
of records without clicking Create Licenses, your selections are lost and the records 
are not created. 

 The following note is added to the License Record when it is created, if you haven't 
entered a note yourself: 
 
   "Created by Auto-Reconcile on [date] [time]" 
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Editing Suggested License Record Names 

Each Suggested License Record's manufacturer, name, and version are set to match those in its corresponding 
Discovered Product exactly. For each Suggested License Record, you can edit the manufacturer, name or version 
before it is saved. 

 

To edit the manufacturer, name, or version for a Suggested License Record: 

 

1. Click the Suggested License Record name. An Edit License page opens in a new window. 
2. Make your changes, and click Create Licenses. The Suggested License Record shows 

your changes. 
 
Note: When you edit License Record, it is selected automatically when you return to 
the Suggested License Records page. 

How Does Auto-reconcile Attempt to Match Catalog Products to Discovered Products? 

1. Start with Unreconciled Discovered Products - Auto-reconcile starts with Discovered 
Products, since the name, manufacturer, and version for a Discovered Product are 
reliably accurate and consistent, because they come from the ZENworks Asset 
Management License Knowledgebase . It only looks at products that are unreconciled 
and have not been excluded. 

2. Look for Catalog Products that might be possible candidates - It then looks at the 
manufacturer, name, and version for each unreconciled Catalog Product, and tries to 
find products that might be candidates for a match to the Discovered Product. 

3. Disregard upgrades, media, documentation, and books - Auto-reconcile tries to avoid 
suggesting matches for certain kinds of Catalog Products. It does not include a product 
as a suggested match if the name of the Catalog Product is an upgrade or an order for 
media. 
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Attaching a Document to a License Record 

Use the Attach Document(s) command, available from the View/Edit License Records page to attach documents to the 
selected license record. You can also attach documents to contracts.  

  

To attach a document to a license record: 

  

1. Edit the license record to which you want to attach the document. The View/Edit 
License Record page appears, and includes a list of documents attached to the selected 
license record (if any have been attached.) 

2. Click Attach Document(s). A list of available documents appears in a new window. 
3. Use the Filters in the left frame to narrow your search. 
4. In the left column of the document list, select the documents you want to attach. 

Select or clear the check box in the column header to select or clear all check boxes.  
 
Note: If the document you want to attach does not appear in the document list, it has 
probably not been uploaded yet. If you are an Enterprise Administrator, you can upload 
the document as described in Managing Document Files, then select attach it as 
described above. 

5. Click Done. The window closes, and the selected documents appear in the license 
record's document list. 

To detach (remove) document from the license record: 

 Click the "X" icon to the left of the document you want to remove from the license's 
document list. A confirmation message appears. Click OK to detach the document. 
 
Note: The document is not deleted, it is just detached from the license record.  
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Working with License Allocations 

A software license is a company asset, and can be allocated in various ways. You may want to re-allocate licenses after 
the initial purchase, as things change within your company. For example, you may move computers from one site to 
another, or you may un-install software on one computer, and install it on another. 

 

Software Management make it easy for you to manage these changes while maintaining an overall view of your 
software license compliance. 

Methods for Allocating Licenses 

You may want to allocate your licenses in different ways: 

 By Demographic - You may want to allocate licenses by various demographics, such as 
Site, Department, or Cost Center. Using this method, for example, you can allocate a 
license to every workstation in the engineering department. This makes it easy to see 
where your licenses are allocated without the need to know which workstations are 
associated with a demographic group. 

 By Workstation - You may want to associate licenses directly with workstations. This is 
particularly useful when you have special workstations, such as CAD systems, to which 
you are allocating licenses for certain applications. 

 By Both - You may find that, for the most part, you want to allocate your licenses by 
some demographic, such as Department. You may also have a need to allocate some 
licenses by Workstation. For example, if everyone in your graphics department uses 
Adobe Illustrator, but a few individuals outside the department do graphics work, you 
might need to allocate licenses to those few workstations, while the rest are allocated 
by department. 

Getting Started Managing Your License Allocations 

There are two steps you need to take to get started with License Allocations: 

 Step 1 - Initialize your Allocations - By default, no licenses are allocated. Use the 
Initialize Allocations command, available from the License Records menu's License 
Allocation submenu, to set initial values for License Allocations for a large group of 
products at once. For more information, see Setting Initial License Allocation Values. 
 
You can allocate licenses based on your current installed inventory - a license is 
allocated for each installed copy of an application. Using this method, you can choose 
to allocate licenses based on demographic information (such as Site, Department, or 
Cost Center,) or you can allocate them directly to the workstations on which they are 
installed. 
 
You can also allocate them based on your product Purchase Records - when you use this 
approach, licenses are allocated only by Demographic. For each Purchased Product, 
licenses are allocated based on the information contained in the Site, Department, or 
Cost Center boxes within the Purchase Records..  
  

 Step 2 - Review your allocations and make any corrections - Once you have set your 
initial allocations, use the Allocation Worksheet, available from the License Records 
menu's License Allocation submenu, to review and edit the allocations created during 
the initialization process. For more information, see Using the Allocation Worksheet . 

 Step 3 -View the License Allocations Reports - You can view any one of a number of 
License Allocation reports. 
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Setting Initial License Allocation Values 

Use the Initialize Allocations command, available from the License Records menu's License Allocation submenu, to 
set the initial allocation values for your licenses. 

 

You can allocate licenses in two ways:  

 Based on your purchase records -You can also allocate them based on your product 
Purchase Records - when you use this approach, licenses are allocated only by 
Demographic. For each copy of a Purchased Product, a license is allocated based on the 
information contained in the Site, Department, or Cost Center boxes within the 
Purchase Records.  
 
If you base your allocations on your purchase records, you can allocate them by 
Demographic (Site, Department, or Cost Center) 

 Based on your inventory - for each installed copy of software discovered by ZENworks 
Asset Management, a license is allocated. 
 
If you base your allocations on your inventory, you can allocate them: 
 
- by Demographic (Site, Department, or Cost Center) 
- by Workstation 

 

To set your initial license allocations: 

 

1. From the License Records menu's License Allocation submenu, choose Initialize 
Allocations. The "Initialize License Allocations: Step 1 - Choose License Records" page 
appears in the right frame. 

2. In the Select column, click the check boxes for those products for which you want to 
set initial license values. To select all the products in the list, click Select All. To clear 
the check boxes for all selected products, click Clear Selection. 
 
Note: You can run this initialization process at any time. You may want to use the 
View and Filter by controls to view a subset of available products, or to view only 
those products for which licenses have not been allocated. You can then set your initial 
allocations for a product or group of products. 
  

3. When you have selected all the products for which you want to allocate licenses, click 
Next. The "Step 2 - Choose Initialization Options" page appears in the right frame. 

4. Choose the type of allocation for the selected licenses - 
 
Click Demographic to allocate licenses based on a Site, Department, or Cost Center. If 
you choose this option, click Site, Department, or Cost Center. 
Click Workstation to allocate licenses based on installed copies found on workstations. 
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5. Choose a data source for the initialization: 
 
Click Initialize from Purchase Records to allocate licenses based on your Purchase 
Records. 
Click Initialize from Inventory to allocate a license for each copy of a product 
discovered on a workstation. 
  

6. Choose whether, when importing new Purchase Records, you would like to update 
license allocations based on demographic data contained in the import file. 

7. Click Done. The Initialize License Allocations page appears. By default, this page shows 
only Unallocated Licenses. If no License Allocations appear, click Allocated Licenses. 
You can now use the Allocation Worksheet to review your allocations and make any 
necessary changes. 
 
Note: You can change the options you set in steps 4 and 6 from the Allocation 
Worksheet Options page, available from the License Allocations Worksheet. 
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Using the Allocation Worksheet 

Use the Allocation Worksheet to edit the License Allocations for a particular software license. Once you have selected 
a license for editing, you can modify the allocations for a workstation or demographic group, change the demographic 
you want to use for allocating licenses for the product, add allocations for more workstations, or delete a workstation 
allocation. 

 

To choose a license record for editing: 

1. From the License Records menu, choose Allocation Worksheet from the License 
Allocation submenu. The License Allocation Worksheet page appears in the right frame, 
showing a list of license records, their license quantities, and allocation quantities. 
 
Note: An unallocated license amount with a negative value indicates that you have 
allocated more licenses than you own. This could mean that the license has not been 
reconciled to a Purchased Product, or that you are out of compliance. 
  

2. Use the View and Filter by controls to narrow your view if necessary. 
3. In the License column, click the link for the License Record you want to edit. 
4. The allocation detail for the selected license appears in the License Allocation 

Worksheet. 
5. Edit allocations as described below. When finished, click Done. 

Editing License Allocations 

What you see in the license allocation detail for a particular license depends on whether the license has been allocated 
by demographic, by workstation, or both.  

 

 If, when you initialized your License Allocation values, you chose one of the options 
that allocates licenses by demographic (Site, Department, or Cost Center,) a 
Demographic Allocations area appears in the Allocation Worksheet, showing your 
current demographic allocations. 

 If you chose to initialize your License Allocations from your Inventory, based on 
workstations, one license is allocated for each workstation on which the selected 
product is found, and an entry appears in a Workstation Allocations area for each 
workstation to which the product is allocated. 

Editing Demographic License Allocations 
Use the Demographic Allocations area of the License Allocation Worksheet to allocate licenses based on demographic 
data. Your demographic choices can come from Purchase Records or from Discovered Products in your inventory.  

 

When allocating licenses by demographic, you can do any of the following: 

 

 Edit the allocation quantity for a particular Site, Department, or Cost Center. 
 Add another Site, Department, or Cost Center, then allocate licenses to it. 
 Delete an entry from the Demographic Allocations area. 
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To edit the allocation quantity for a Site, Department, or Cost Center: 

1. In the License Allocation Worksheet, choose a license record for editing. 
2. In the New Allocation box, enter a new quantity for the demographic entry you want 

to change. This is the number of licenses you want to allocate to that Site, 
Department, or Cost Center. 

3. If you want to change the existing allocations for other Sites, Departments, or Cost 
Centers, enter the new quantities. 

4. When finished, click Update Allocations. The new quantities appear in the License 
Q uantity summary a the top of the page, and in the Current Allocation column for 
each demographic entry. 

 

To add another Site, Department, or Cost Center: 

1. In the License Allocation Worksheet, choose a license record for editing. 
2. At the bottom of the Demographic Allocations area, choose the Site, Department, or 

Cost Center from the Add New <demographic>  drop-down menu.  
 
Note: If the demographic you want to use does not appear (if, for example, you see 
"Add New Site" instead of "Add New Department,") you can change the demographic you 
use for allocations from the License Allocations Worksheet Options page. For more 
information, see Setting Allocation Worksheet Options. 

3. Enter a quantity for the new Site, Department, or Cost Center. 
4. When finished, click Update Allocations. The new quantities appear in the License 

Q uantity summary a the top of the page, and in the Current Allocation column for 
each demographic entry. 

 

To delete an entry from the Demographic Allocations area: 

1. In the License Allocation Worksheet, choose a license record for editing. 
2. In the Select column, click to select the entry you want to delete. 
3. At the bottom of the right frame, click Delete Allocation. A confirm message appears. 
4. Click OK. The allocation entry disappears from the Demographic Allocations area. 

Editing Workstation Allocations 
Use the Workstation Allocations area of the License Allocation Worksheet to allocate licenses to individual 
workstations.  

 

When allocating licenses to workstations, you can do any of the following: 

 

 Add another workstation. Each workstation entry allocates one license. 
 Delete a workstation entry from the Workstation Allocations area. 
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To add a workstation allocation entry: 

1. In the License Allocation Worksheet, choose a license record for editing. 
2. At the bottom of the right frame of the License Allocation Worksheet, click Add 

Workstations. The Find Workstations to Allocation Licenses page opens in a new 
window.  

3. Enter search criteria in the User Information, Workstation Data, or Location Data 
sections to help you narrow your search, then click Search. 
 
Note: If you click Search with no criteria, all workstations are shown. Use this page to 
find workstations that match the specified search criteria. You do not have to 
complete the form completely. Enter information in any field to narrow your search for 
the workstations you are looking for. 
  

4. In the License View section, choose to view Workstations with related Discovered 
Products installed or All Workstations. 
 
Note: If these buttons are disabled, the License has not be reconciled to any 
Discovered Products.  

5. In the Select columns to display section, select or clear the check boxes for the 
columns you want to appear in the results of the workstation search. The machine 
name is always displayed. 

6. Click Next. A list of workstations appears. 
7. In the Select column, click to select the workstations you want to add to the 

Workstation Allocations area. For each workstation you choose, one license is 
allocated. To choose all the workstations in the list, click Select All. To clear the check 
boxes for all selected workstations, click Clear Selection. 

8. When you have selected all the workstations you want to add to the Workstation 
Allocations area, click Next at the bottom of the Add workstations page. The Add 
Workstations window closes, and the selected workstations appear in the Workstation 
Allocations area of the License Allocations Worksheet. 

 

To delete a workstation allocation entry: 

1. In the License Allocation Worksheet, choose a license record for editing. 
2. In the Select column, click the check boxes to choose the workstations you want to 

delete from the Workstation Allocation area. 
3. At the bottom of the right frame, click Delete Allocation. The selected workstation 

entries disappear from the Workstation Allocation area. 
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Setting Allocation Worksheet Options 

If the demographic you want to use to allocate licenses does not appear in the License Allocation Worksheet after you 
have selected a License Record for editing, use the Options command at the bottom of the right frame to change it. 
You can specify whether license allocations are affected when you import new purchase records containing 
demographic data. 

 

Caution: When you choose a different demographic from the License Allocation Worksheet Options page, all allocations 
for the current demographic are deleted. Make sure you want make the change. 

 

To change your License Allocation Worksheet Options: 

1. In the License Allocation Worksheet, choose a license record for editing. 
2. At the bottom of the right frame, click Options. The Allocation Worksheet Options 

page appears in a new window. 
3. In the Choose Demographic section, click to choose the demographic you want to use 

when allocating licenses. 
4. In the Choose Importer Behavior section, click Y es or No to specify whether you want 

allocations to be updated when you import purchase records containing demographic 
data. 
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Using the Reports Menu 

From the Asset Management tab > Software Management page's Reports menu, choose one of the following reports: 

 

 Compliance Report - Shows a list of all defined software licenses and the compliance 
status for each license. Drill-down to view more detail about purchases, installations, 
and licenses. 

 Unreconciled Products - From this submenu, choose the Catalog Products or 
Discovered Products report. Use these reports to track the products you haven't yet 
reconciled. 

 Purchase Summary - Shows a list of Purchase Records, with one row per record. Click 
a link to view or edit the record. 

 Purchase Detail - Shows a list of Purchase Records and their line items, with one row 
per line item. Click a Purchase Record link to view or edit the record. 

 License Allocation - From this submenu, choose the Current Allocations, Allocations vs 
Installations, Allocation Exceptions, or Duplicate Allocations report. 

 Alerts/Custom Reports - Shows the Custom Reports tree in the left frame. View, 
create, and edit custom reports, schedule reports and alerts, and view the output of 
previously scheduled reports. For more information on using Custom Reports, see Using 
Custom Reports and Alerts.  

Viewing More Detail in a Report 

On any report, click any active link to "drill-down" to more detail related to that link. For example, in the Compliance 
report, click a value in the License column to view the Purchased Product Detail for the selected License Record . In 
some cases, such as in the Unreconciled Products reports, a link takes you to the View/Edit page for the selected 
record. 

Exporting Data to Excel 

Any report generated by ZENworks Asset Management Software Management can be exported to an Excel spreadsheet. 
Two export options are available, depending on how many records you are viewing: 

 

 Excel - Button always available.  
-If there are fewer than 100 records in your report, click this button to launch Excel 
and open a window containing the data from the report you are viewing. 
-If there are more than 100 records in your report, click this button to launch Excel and 
open a window contain the data from the current page of the report. 

 Excel All - Button appears when your report contains more than 100 records. Click this 
button to launch Excel and open a window containing all the data in the report. 
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Software Management Tab Reference 

Purchase Records 

Use the Purchase Records menu to add, edit, and delete Purchase Records, to import Purchase Records from a text 
file, and to replace demographic values in Purchase Records with values from your Discovered Products inventory. 

 

 Imports Submenu - Use this submenu to start an import or to view your import history. 
 Add Purchase - Use this command to add individual Purchase Records 
 View/Edit Purchase - Use this command to edit Purchase Records. 
 Delete Purchase - Use this command to delete one or more Purchase Records. 
 Replace Demographics - Use this command to change the value of a demographic (Cost 

Center/Department/Site) with one from your Discovered Products inventory. 

Imports Submenu 

 

Start Import 
Use the Start Import command to upload a batch of Purchase Records from a tab-delimited text file. For information 
on the file format, see The Import File Format. 

 

Choose Import File 

Click Browse to choose a file containing the Purchase Records you want to import. For file format requirements, see 
The Import File Format. 

 

View Active Imports 

 Select - Click to select an Import job for deletion. 
 Records Created - The number of Purchase Records created. 
 Details Created - The number of line items added to Purchase Records. 
 Products Created -The number of Catalog Products created. 
 Import Start Time - The start time of the import. 
 Import End Time - The end time of the import. 
 Duration (HH:MM:SS) - The duration of the import. 
 Errors - The number of errors encountered during the import. 
 File Name - The name of the import file. 
 File Size (KB) - The size of the import file. 
 Row Count - The number of rows in the file. 
 Status - The current import status of the file. 

      Waiting () 
      In Progress (yellow exclamation point) 
      Failed (red "X") 
      Successful (blue checkmark) 

 Progress - The percentage of the import completed. 
 Select All - Click to select all waiting import processes. 
 Clear Selection - Click to clear the selection of all selected import processes 
 Delete - Click to delete all selected import processes. 

       Note: If a process is already underway, you can't delete it. 
 Refresh - Click to refresh the page. By default, the page refreshes every 20 seconds. 
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View Import History 
Use the View Import History command to view a list of History records. 

 

 Select - Click the Delete icon in this column to delete the entry for an import. 
 Records Created - the number of Purchase Record headers created by this import. 
 Details Created - the number of Purchase Record detail line items created by this 

import. 
 Products Created - the number of Catalog Products created by this import. 
 Import Start Time - the time at which the import was started. 
 Import End Time - the time at which the import was finished. 
 Duration - the duration import process in milliseconds. 
 Errors - the number of errors encountered during the import. 
 File Name - the name of the file uploaded for this import. 
 File Length - the length in bites, of the import file. 
 Row Count - the number of rows contained in the import file. 
 Status - indicates current status of an import:  

In Progress (yellow exclamation point) 
Failed (red x) 
Successful (blue checkmark) 

 

Add Purchase, View/Edit Purchase 

Use the Add Purchase command. available from the Purchase Records menu to add a single Purchase Record to the 
Purchase Records table. 

 

Use the View/Edit Purchase command, available from the Purchase Records menu, to edit existing Purchase Records. 
Use the filter and group options to narrow your search.  

 

 Click any active link for the Purchase Record you want to edit. 
 Click any column header to sort by that column. Click again to reverse the sort order. 

Add, View/Edit Purchase Record page 

 Purchase Order/Order Date - One of these is required. Enter a Purchase Order 
number, or choose an Order Date. 

 Reseller - the vendor of the software. 
 Recipient - the person or department requesting the items in the Purchase Record . 
 Company - the company name 
 Shipping Address - Enter three lines of shipping address information in the three text 

boxes. 
 City/State/Zip/Country - Enter the shipping information in each text box. 
 Notes - Enter useful comments about the purchase record. 
 Choose Product - Click this button to add Catalog Products to the Purchase Record. 
 Done - Click this button when all Catalog Products have been added to the Purchase 

Record. 
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Choose Product window - Catalog Product list  
Click Choose Product from the Add or View/Edit Purchase Record. 

 

 Select - Click a check box in the Select Column for each Catalog Product you want to 
add to a Purchase Record. 

 Add Catalog Product - If the Catalog Product you want to add to the Purchase Record 
does not exist in the Product Catalog, click this button to add a new Catalog Product to 
the Product Catalog. 

 Next - Click this button add your selected Catalog Products to the Purchase Record. 
 Click any column header to sort by that column. Click again to reverse the sort order. 

 

Choose Product window - Choose Product page 

 Manufacturer - shows the name of the Manufacturer 

 Product Name - shows the name of the selected Catalog Product. 

 Version - shows the version of the selected Catalog Product. 

 Licenses Per Pkg - shows the number of licenses you are purchasing when you buy this product. 

 Purchase Qty - enter the number of units of this product you are purchasing. 

 Invoice # - enter the invoice number associated with this purchase record. You may enter multiple invoices 
with the same Purchase Order number. 

 Serial Number - enter the serial number of this product if applicable. 

 Cost Center - choose a demographic value for this product's Cost Center, or choose --Add a new list item-- 
and enter a new value. 

 Department - choose a demographic value for this product's Department, or choose --Add a new list item-- 
and enter a new value. 

 Site - choose a demographic value for this product's Site, or choose --Add a new list item-- and enter a new 
value. 

 Comments - enter a comment about the purchase of this product. 

 Unit MSRP* - enter the Manufacturers' Suggested Retail Price. 

 Unit Price* - enter the product's unit price. 

 Extended Price* - enter an extended price. If you do not enter a value, one is calculated based on the values 
of the Purchase Q ty and Unit Price. 
 
*Prices are shown in the currency defined by your server settings. 
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Add Purchase, View/Edit Purchase 

Use the Add Purchase command. available from the Purchase Records menu to add a single Purchase Record to the 
Purchase Records table. 

 

Use the View/Edit Purchase command, available from the Purchase Records menu, to edit existing Purchase Records. 
Use the filter and group options to narrow your search.  

 

 Click any active link for the Purchase Record you want to edit. 
 Click any column header to sort by that column. Click again to reverse the sort order. 

Add, View/Edit Purchase Record page 

 Purchase Order/Order Date - One of these is required. Enter a Purchase Order 
number, or choose an Order Date. 

 Reseller - the vendor of the software. 
 Recipient - the person or department requesting the items in the Purchase Record . 
 Company - the company name 
 Shipping Address - Enter three lines of shipping address information in the three text 

boxes. 
 City/State/Zip/Country - Enter the shipping information in each text box. 
 Notes - Enter useful comments about the purchase record. 
 Choose Product - Click this button to add Catalog Products to the Purchase Record. 
 Done - Click this button when all Catalog Products have been added to the Purchase 

Record. 

Choose Product window - Catalog Product list  
Click Choose Product from the Add or View/Edit Purchase Record. 

 

 Select - Click a check box in the Select Column for each Catalog Product you want to 
add to a Purchase Record. 

 Add Catalog Product - If the Catalog Product you want to add to the Purchase Record 
does not exist in the Product Catalog, click this button to add a new Catalog Product to 
the Product Catalog. 

 Next - Click this button add your selected Catalog Products to the Purchase Record. 
 Click any column header to sort by that column. Click again to reverse the sort order. 

 

Choose Product window - Choose Product page 

 Manufacturer - shows the name of the Manufacturer 

 Product Name - shows the name of the selected Catalog Product. 

 Version - shows the version of the selected Catalog Product. 

 Licenses Per Pkg - shows the number of licenses you are purchasing when you buy this product. 

 Purchase Qty - enter the number of units of this product you are purchasing. 
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 Invoice # - enter the invoice number associated with this purchase record. You may enter multiple invoices 
with the same Purchase Order number. 

 Serial Number - enter the serial number of this product if applicable. 

 Cost Center - choose a demographic value for this product's Cost Center, or choose --Add a new list item-- 
and enter a new value. 

 Department - choose a demographic value for this product's Department, or choose --Add a new list item-- 
and enter a new value. 

 Site - choose a demographic value for this product's Site, or choose --Add a new list item-- and enter a new 
value. 

 Comments - enter a comment about the purchase of this product. 

 Unit MSRP* - enter the Manufacturers' Suggested Retail Price. 

 Unit Price* - enter the product's unit price. 

 Extended Price* - enter an extended price. If you do not enter a value, one is calculated based on the values 
of the Purchase Q ty and Unit Price. 
 
*Prices are shown in the currency defined by your server settings. 

 

Delete Purchase 

 Use the filter and group options to narrow your search. 
 Select - Click a check box in the Select Column for each Purchase Record you want to 

delete 
 Delete Purchase Record - Click this button to delete the selected Purchase Records. A 

confirm message appears, and allows you to cancel the operation. 
 Click any column header to sort by that column. Click again to reverse the sort order. 

 

Replace Demographics 

Replace Cost Center/Department/Site Demographics 

 Cost Center/Department/Site Values from Purchase Records - Choose the 
demographic value you want to replace in all matching Purchase Records. 

 Cost Center/Department/Site Values from Discovered Products - Choose the 
demographic value from a Discovered Product you want to use to replace the selected 
Cost Center, Department, or Site value in all matching Purchase Records. 
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Product Catalog 

Use the Product Catalog menu to add, edit, delete,. and exclude Catalog Products, and to reconcile Catalog Products 
to Licenses. 

 

 Add Product - Use this command to add a product to your Product Catalog. 
 View/Edit Product - Use this command to edit Catalog products. 
 Delete Product - Use this command to delete one or more Catalog Products. 
 Exclude Product - Use this command to exclude Catalog Products from your Software 

Management Report. 
 Reconcile to License Record - Use this command to reconcile one or more Catalog 

Products to a License Record . 

Add and View/Edit Product 

Add Product - Use the Add Product command to add a product to your Product Catalog . 

 

View/Edit Product - Use the View/Edit Product command to edit Catalog products. A list of Purchase Records 
appears.  

 

 Click any active link for a Purchase Record to view and edit the Purchase Record . Use 
the filter options to narrow your search. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
 
After you choose the record you want to edit, the View/Edit Catalog Product page 
appears in the right frame.  

 

Enter or edit the values as follows: 

 

 Manufacturer - Choose a manufacturer from the drop-down list, or choose --Add New 
List Item-- at the top of the list, then enter a Manufacturer name. 

 Product - (required) Enter the name of the software product. 
 Product Type - Choose a Product Type from the drop-down list, or choose --Add New 

List Item-- at the top of the list, then enter a Product Type. 
 Version - Enter a version indicator 
 Mfr. Part #  - Enter a manufacturer's part number. 
 Licenses per Pkg. - Enter the number of licenses per software package. 
 Notes: Enter a comment about the product. 
 Upgrade - If the software version is an upgrade to a previous version, select this check 

box. The Upgrade From License button becomes active. 
 Reconcile to License - Click this button to reconcile to a License Record . 
 Upgrade From License - Click this button to select the License Record this version is 

upgrading 
 Done - Saves any changes you've made. 
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Add and View/Edit Product 

Add Product - Use the Add Product command to add a product to your Product Catalog . 

 

View/Edit Product - Use the View/Edit Product command to edit Catalog products. A list of Purchase Records 
appears.  

 

 Click any active link for a Purchase Record to view and edit the Purchase Record . Use 
the filter options to narrow your search. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
 
After you choose the record you want to edit, the View/Edit Catalog Product page 
appears in the right frame.  

 

Enter or edit the values as follows: 

 

 Manufacturer - Choose a manufacturer from the drop-down list, or choose --Add New 
List Item-- at the top of the list, then enter a Manufacturer name. 

 Product - (required) Enter the name of the software product. 
 Product Type - Choose a Product Type from the drop-down list, or choose --Add New 

List Item-- at the top of the list, then enter a Product Type. 
 Version - Enter a version indicator 
 Mfr. Part #  - Enter a manufacturer's part number. 
 Licenses per Pkg. - Enter the number of licenses per software package. 
 Notes: Enter a comment about the product. 
 Upgrade - If the software version is an upgrade to a previous version, select this check 

box. The Upgrade From License button becomes active. 
 Reconcile to License - Click this button to reconcile to a License Record . 
 Upgrade From License - Click this button to select the License Record this version is 

upgrading 
 Done - Saves any changes you've made. 

 

 

Delete Product 

Use the Delete Product command to delete one or more Catalog Products. A list of Catalog Products appears. Use the 
filter options to narrow your search. 

 

 Select - Click a check box in this column to choose the Catalog Products you want to 
delete. 

 Delete Catalog Product - Click this button to delete the selected products. A 
confirmation box appears. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
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Exclude Product 

Use the Exclude Product command from the Product Catalog menu to exclude one or more Catalog Products. You can 
also use this command to include products that are currently excluded. Excluded products do not appear as 
unreconciled. 

 

Choose to View Included Products, Excluded Products, or All Products. Use the filter options to narrow your search. 

 

Note: If you want to include products that are currently excluded, you must view Excluded Products. 

 

When you choose the Exclude Product command from the Product Catalog menu, a list of Catalog Products appears. 

 

 Click the License icon to view the License to which the Discovered Product is 
reconciled. 

 Select - Click a check box in this column to choose the Catalog Products you want to 
exclude. 

 Exclude Catalog Product - (Appears while viewing Included Products or All Products.) 
Click this button to exclude the selected products. 
Note: if you choose to exclude a product that has been reconciled, a confirmation box 
appears, and allows you to cancel the operation. 

 Included Catalog Product - (Appears only while viewing Excluded Products.) Click this 
button to include the selected (currently excluded) products. 

 Click any active link for a product to view and edit the Catalog Product . 
 Click any column header to sort by that column. Click again to reverse the sort order. 

  

Reconcile to License Record (Purchased Products) 

Use the Reconcile to License Record command from the Product Catalog menu to reconcile one or more Catalog 
Products to a License Record. For more information, see Reconciling Catalog Products. 

 

 Click the check box in the Select column for the Catalog Products you want to 
reconcile. 

 To edit the information for a Catalog Product , click an active link for the product you 
want to edit. The View/Edit Catalog Products page appears in the right frame. 

 Click Reconcile to License Record when you are finished selecting the Catalog 
Products you want to reconcile. The Reconcile Products: Select License page appears. 

 Click any column header to sort by that column. Click again to reverse the sort order. 

 

Reconcile Catalog Products: Select License 

 Click the check box in the Select column for the License Record you want to reconcile 
to the selected Catalog Products, shown at the top of the window. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
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License Records 

Use the License Records menu to add, edit, and delete License Records. 

 

 Add License - Use this command to add a new License Record. 
 View/Edit License - Use this command to edit an existing License Record and the 

Catalog Products and Discovered Products associated with it. 
 Delete License - Use this command to delete one or more License Records. 
 License Allocation Submenu - Use this submenu to set initial values for your License 

Allocations, and to edit those values. 
 Auto-reconcile - Use this command to view a list of suggestions for creating License 

Records. Using this list, you can create new license records based on discovered 
products. 

Add, View or Edit License 

Use the Add License command to add a new License Record . 

 

Use the View/Edit License command to edit an existing License Record and the Catalog Products and Discovered 
Products associated with it. 

 

 Click any active link for a License Record to view and edit the License Record. Use the 
filter options to narrow your search. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
 
After you choose the record you want to edit, the View/Edit Catalog Product page 
appears in the right frame.  

 

Enter or edit the values as follows: 

 

 Manufacturer - (required) Choose a Manufacturer from the drop-down list, or choose --
Add New List Item-- at the top of the list, then enter a Manufacturer name. 

 Product - (required) Choose a product from the drop-down list, or choose --Add New 
List Item-- at the top of the list, then enter a Product name. 

 Version - (required) Enter a version number or indicator. Example: "1.0", "3.x", 
"Multiple". 

 Platform: Choose a platform from the drop-down list. 
 Notes: Enter a comment about the license. 
 Delete icon - Click this icon to delete a Catalog Product or Discovered Product from 

this license. 
 Reconcile to Catalog Product - Click this button to reconcile one or more Catalog 

Products to this license. 
 Reconcile to Discovered Product - Click this button to reconcile one or more 

Discovered Products to this license. 
 Done - Saves any changes you've made. 
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Add, View or Edit License 

Use the Add License command to add a new License Record . 

 

Use the View/Edit License command to edit an existing License Record and the Catalog Products and Discovered 
Products associated with it. 

 

 Click any active link for a License Record to view and edit the License Record. Use the 
filter options to narrow your search. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
 
After you choose the record you want to edit, the View/Edit Catalog Product page 
appears in the right frame.  

 

Enter or edit the values as follows: 

 

 Manufacturer - (required) Choose a Manufacturer from the drop-down list, or choose --
Add New List Item-- at the top of the list, then enter a Manufacturer name. 

 Product - (required) Choose a product from the drop-down list, or choose --Add New 
List Item-- at the top of the list, then enter a Product name. 

 Version - (required) Enter a version number or indicator. Example: "1.0", "3.x", 
"Multiple". 

 Platform: Choose a platform from the drop-down list. 
 Notes: Enter a comment about the license. 
 Delete icon - Click this icon to delete a Catalog Product or Discovered Product from 

this license. 
 Reconcile to Catalog Product - Click this button to reconcile one or more Catalog 

Products to this license. 
 Reconcile to Discovered Product - Click this button to reconcile one or more 

Discovered Products to this license. 
 Done - Saves any changes you've made. 

 

Delete License 

Use the Delete License command to delete a License Record . 

 

 Select - Click a check box in this column to choose the License Records you want to 
delete. 

 Delete - Click this button to delete a License Record. A confirmation box appears. 
Note: You can delete only one License Record at a time. 

 Click any active link for a License Record to view and edit the License Record. Use the 
filter options to narrow your search. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
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License Allocation Submenu 

Use the Allocation Submenu to set initial values for License Allocations, and to set and edit allocation values for 
individual licenses. 

Initialize Allocations 
Use the Initialize Allocations command to set initial allocation values for allocations. For a step-by-step procedure, see 
Setting Initial License Allocation Values. 

 

 View -Choose to view Licenses with Allocations or Licenses without Allocations. 
 Filter by - Choose to view by Manufacturer or Value. 

Initialize Allocations: Step 1 - Choose License record(s) 

 Select - Click check boxes in this column to select products for initialization. 
 Manufacturer - Software manufacturer 
 License - The Product name as it appears in the License Record 
 Version - Version as it appears in the License Record 
 License Quantity - The number of licenses for which purchase records exist 
 Unallocated Licenses - The number of licenses that haven't been allocated 
 Demographic Allocations - The number of licenses allocated by demographic 
 Workstation Allocations - The number of licenses allocated to workstations 
 Select all - Click to select all license records in found set. 
 Clear Selection - Click to clear all selected license records. 
 Next - Click to initialize allocations for the selected license records. 

Initialize License Allocations: Step 2 - Choose Initialization Options 

 Selected License(s) - Lists the licenses selected for initialization. License Allocation 
values are set based on your choice of Allocation Type and Initialization Data 
Source. 

 Allocation Type - Choose the type of allocation for the selected license(s). If you 
choose Demographic, licenses are allocated based on Discovered Products or Purchase 
Records associated with the selected Site, Department, or Cost Center. 

 Initialization Data Source - Choose a data source for the initialization.  
If you choose Initialize from Purchase Records, one license is allocated for each copy 
of an application purchased.  
If you choose Initialize from Inventory, one license is allocated for each copy of an 
application found on a workstation.  
If the workstation is associated a selected Demographic, the license is allocated to the 
Demographic. Otherwise, it is allocated to the workstation. 

 Update Allocations When Importing - Click Y es to update license allocations based on 
demographic data in future imports of Purchase Records. 

 Done - Click to set initial License Allocations based on your selected Allocation Type 
and Initialization Data Source. 
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License Allocation Worksheet  

(Product List) 

 Manufacturer - The Software manufacturer. 
 License - The Product name as it appears in the License Record. Click this link to edit 

the allocations for the product. 
 Version - Version as it appears in the License Record. 
 License Quantity - The number of licenses for which purchase records exist. 
 Unallocated Licenses - The number of licenses that haven't been allocated. 

Note: A negative number here indicates that more licenses have been allocated than 
have been purchased. 

 Demographic Allocations - The number of licenses allocated by demographic. 
 Workstation Allocations - The number of licenses allocated to workstations. 

(Product Detail) 
Demographic Allocations Area 

 Select - Click to select this entry for deletion. 
 Site/Department/Cost Center - The value of the demographic selected for allocations. 
 Workstation Count - Total workstations in the demographic group. 
 Current Allocation - The number of licenses currently allocated to this demographic. 
 Installed -The number of copies discovered on workstations in this demographic. 
 Variance - The difference between Current Allocation Quantity and Installed 

Quantity. 
 New Allocation - Edit this value to change the number of licenses allocated to this 

demographic. 

 

Workstation Allocations Area 

 Select - Click to select this entry for deletion. 
 Machine Name - The name of this workstation as it appears in your inventory. 
 Login Name - The name of the user associated with this workstation. 
 IP Address - The IP address of this workstation. 
 Site - The site to which this workstation is assigned. 
 Dept - The department to which this workstation is assigned. 
 Cost Center - The Cost Center to which this workstation is assigned. 
 Installed - The product is installed on this workstation. 
 Duplicate Allocations - The license is allocated both to a demographic and directly to a 

workstation in that demographic. 
 Select All - Click to Demographic and Workstation Allocation entries. 
 Clear Selection - Click to clear all selected entries. 
 Delete Allocations - Click to delete all selected entries. 
 Update Allocations - Click to update all changed allocation values. 
 Add Workstations - Click to add workstation allocations to the Workstation Allocation 

area. 
 Options - Click to choose a new demographic to use for allocations, and to specify 

whether allocations should be affected when importing purchase records. 
 Done - Click to leave return to the License Allocation Worksheet's Product List view. 
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Auto-reconcile 

Use the Auto-reconcile command to create a license record for each unreconciled Discovered Product in your current 
inventory .  

 

When you choose this command, a list of suggested License Records appears. For each Discovered Product that has not 
been reconciled or excluded, the following controls and information appear: 

 

 Create License Record - Click this checkbox to accept this suggestion to create a 
License Record. 

 For Discovered Product - The name of the product as it appears in the Discovered 
Products List. 

 Catalog Products - Lists products from your Product Catalog that are likely matches for 
the Discovered Product. Click the checkboxes for those Catalog Products you want to 
reconcile to the Discovered Product. 

 Select All - Click this button to select all suggested License Records and all suggested 
Catalog Products on the current page. 

 Clear Selection - Click this button to clear all checked boxes on the current page. 

 

Use the Filter Options in the left frame to narrow your search. 

Discovered Products 

Use this menu to exclude Discovered Products from the Compliance report, and to reconcile Discovered Products to 
License Records. 

 

 Exclude Product - Use this command to exclude Discovered Products from the 
Compliance report. 

 Reconcile to License - Use this command to reconcile Discovered Products to License 
Records. 

 Manage Software Standards - Use this command to define Software Standards 
categories and to assign Discovered Products to them. 

Exclude Product 

Use the Exclude Product command from the Discovered Products menu to exclude one or more Discovered Products. 
You can also use this command to include products that are currently excluded. Excluded products do not appear as 
unreconciled. 

 

 Choose to View All Knowledgebase Products or Products in current inventory . 
 Choose to View Included Products, Excluded Products, or All Products. Use the filter 

options to narrow your search. 

 

Note: If you want to include products that are currently excluded, you must view Excluded Products. 
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When you choose the Exclude Product command from the Discovered Products, a list of Discovered Products appears. 

 

 Click the License icon to view the License to which the Discovered Product is 
reconciled. 

 Select - Click a check box in this column to choose the Discovered Products you want 
to exclude. 

 Exclude Catalog Product - (Appears while viewing Included Products or All Products.) 
Click this button to exclude the selected products. 
Note: if you choose to exclude a product that has been reconciled, a confirmation box 
appears, and allows you to cancel the operation. 

 Included Catalog Product - (Appears only while viewing Excluded Products.) Click this 
button to include the selected (currently excluded) products. 

 Click any column header to sort by that column. Click again to reverse the sort order. 
  

Reconcile to License (Discovered Products) 

Use the Reconcile to License Record command from the Discovered Products menu to reconcile one or more 
Discovered Products to a License Record. For more information, see Reconciling Discovered Products. 

 

 Click the check box in the Select column for the Discovered Products you want to 
reconcile. 

 Click Reconcile to License Record when you are finished selecting the Discovered 
Products you want to reconcile. The Reconcile Products: Select License page appears. 

 Click any column header to sort by that column. Click again to reverse the sort order. 

 

Reconcile Discovered Products: Select License 

 Click the check box in the Select column for the License Record you want to reconcile 
to the selected Discovered Products, shown at the top of the window. 

 Click any column header to sort by that column. Click again to reverse the sort order. 

 

 

View/Edit Discovered Product 

Use the View/Edit Discovered Product page to enter notes or to exclude a discovered product. 

  

Enter or edit values as follows: 

 Manufacturer - The Manufacturer name discovered with the product  
 Product - The name of the discovered product 
 Version - The version of the discovered product 
 Notes - Enter a comment about the product. 
 Exclude - Select or clear this check box to include or exclude this product. 
 Related Inventory Products - Lists all inventory products associated with this product. 
 Done - Click this link to save your changes. 



Using the Asset Management Tab 

141 

Managing Software Standards 

Use the Manage Software Standards command, available from the Discovered Products menu, to assign one or more 
Discovered Products to a user-defined Standards Category. 

 

You can use this function for a number purposes: 

 

 Identify those products that should be installed on all workstations in a department. 
 Identify those products that should never be installed on any workstation. 
 Identify those products that are approved for use for a particular purpose. 
 Identify those products that should be installed only on workstations used for a 

particular specialized purpose. 

 

You can define as many Standards Categories as you want. 

Assigning Products to a Standards Category 
You create new Standards Categories as part of the assignment process. Once you have assigned products to Standards 
Categories, you can view them using the Software Standards Report. 

 

To assign a group of products to a Standards Category: 

1. From the Discovered Products menu, choose Manage Software Standards. The Manage 
Software Standards page appears in the right frame. 

2. Use the View and Filter by options to narrow your search. 
3. In the Select column, click the check boxes for those products you want to assign to a 

Standards Category. To select all products, click Select All. To clear the Select boxes 
for all products, click Clear Selection. 

4. Click Set Standards Category. The Select Standards Category page appears in the 
right frame. 

5. In the Standard drop-down menu, choose the Standards Category you want to apply to 
the selected products. If the Standards Category you want to use does not appear in 
the drop-down menu, choose --Add a new list item--, enter a new category name, and 
click Ok. The selected category appears in the Standard drop-down menu. 

6. Click Done. The Manage Software Standards page appears, showing the assigned 
category in the Standards Category column for the selected products. 

7. Continue with steps 2 through 6 to assign more products to Standards Categories. 

To remove a Standards Category assignment: 

1. From the Discovered Products menu, choose Manage Software Standards. The Manage 
Software Standards page appears in the right frame. 

2. Use the View and Filter by options to narrow your search. 
3. In the Select column, click the check boxes for those products for which you want to 

remove assignments. 
4. Click Set Standards Category. The Select Standards Category page appears in the 

right frame. No Standards Category is selected. 
5. Click Done. The Manage Software Standards page appears, showing no category in the 

Standards Category column for the selected products. 
6. Continue with steps 2 through 6 to remove assignments from more products. 
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Reports 

Choose from the following reports. 

 

 Software Compliance - From this submenu, choose the Compliance Report or the 
Status Summary. Use these reports to view detailed or summarized compliance status. 

 Unreconciled Products - From this submenu, choose the Unreconciled Purchases 
Report and the Unreconciled Discovered Products Report. Use these reports to track 
the products you haven't yet reconciled. 

 Inventory Comparison - Shows a list of inventory products and the corresponding 
discovered products. It is useful for seeing all minor versions of a product, and how 
many of each version are installed. 

 Purchase Summary Report - Shows a list of Purchase Records, with one row per 
record. Click a link to view or edit   the record. 

 Purchase Detail Report - Shows a list of Purchase Records and their line items, with 
one row per line item. Click a Purchase Record link to view or edit the record. 

 License Allocation -From this submenu, choose the Current Allocations, Allocations vs 
Installations, Allocation Exceptions, or Duplicate Allocations report.  

 Alerts/Custom Reports - Shows the Custom Reports tree in the left frame. View, 
create, and edit custom reports, schedule reports and alerts, and view the output of 
previously scheduled reports. 

 Software Standards Report - Shows a list of Discovered Products and their assigned 
Standards Categories as defined through the Manage Software Standards page. 

 Suites Reports - From this submenu, choose the Suites/Components to view 
discovered products that are considered to be software suites, and the Standalone 
Components report to view discovered products that are suite components installed as 
standalone products. 
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Compliance Report 

Use the Compliance report to view your current compliance status. 

 

Note: This report is meaningful only for those software products that contain licenses, and whose licenses are 
reconciled to the correct Catalog Products and Discovered Products.  

 

 Click any column header to sort by that column. Click again to reverse the sort order.  
 Use the View, Filter, and Group options to narrow your search. If you have created 

allocations for licenses, you can choose to view only the selected demographics. 
 Click the Excel button to export the data you are viewing to an Excel spreadsheet. For 

more information, see Exporting Data. 
 Click PDF to convert the report to a PDF file. For more information, see Exporting 

Data. 
 Click CSV to convert the report to a comma-separated text file. For more information, 

see Exporting Data. 
 If your search result contains more than 200 records, click Excel All , PDF All, or CSV 

All to export the entire data set. For more information, see Exporting Data. 
 Click Change Report Time Period to view records within a different date range. 
  

Drill-down Tree 
Software Management Report 

View/Edit License Record 

Catalog Product Detail 

Purchase Record Detail 

Discovered Product Summary 

Discovered Product Workstation List 

Application Usage 

Application Usage by Workstation 

Discovered Product Detail 

Workstation Detail 

Compliance Report Columns 

 Manufacturer - Manufacturer name as it appears in the License . 
 License -Product name as it appears in the License. 
 Version - Version as it appears in the License. 
 Platform - Platform on which the application is installed. 
 License Quantity - The cumulative quantity of all purchases of a catalog product linked 

to a license record. Click this quantity to see the Product Catalog Detail for the 
selected product. 

 Installed Quantity - the total number of copies of the software installed. Click this 
quantity to see the Discovered Product Summary for the selected product. 

 Over / -Under - your current compliance status for the product. 
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 Active Usage Quantity - The number of workstations on which the product has seen 
active usage over the specified time period. 

 Unused Licenses - License Quantity minus Active Usage Quantity, not less than zero. 
 Unused Installations - Installed Quantity minus Active Usage Quantity, not less than 

zero. 
  

Catalog Product Detail 

 Manufacturer - Manufacture name as it appears in the License . 
 Product -Product name as it appears in the License. 
 Version - Version as it appears in the License. 
 Product Type - Type of product as it appears in the Product Catalog . 
 Purchase Quantity - the total number of copies originally purchased. 
 Upgrade Quantity - the number of upgrade copies purchased 
 License Quantity -The cumulative quantity of all purchases of a catalog product linked 

to a license record. Click the total in this column to view the Purchase Record Detail 
for the selected product. 

Purchase Record Detail 

Catalog Products Purchased/Upgrades Purchased: 

 PO #  - Purchase order number 
 Invoice #  - Invoice number 
 Date - Purchase date 
 Reseller - Name of the software reseller 
 Manufacturer - Manufacture name as it appears in the License . 
 Product - Product name as it appears in the License. 
 Version - Version as it appears in the License. 
 Product Type - type of product as it appears in the Purchase Record 
 Mfr. Part #  - Manufacturer part number 
 Purchase Quantity - the number of units purchased 
 License Quantity - the number of licenses purchased (number of units X number of 

Licenses Per Package) 
 Site - Site associated with the purchase record. 
 Department - Department associated with the purchase record. 
 Cost Center - Cost Center associated with the purchase record. 

Discovered Product Summary 

 Manufacturer - Manufacture name as it appears in the License . 
 Product - Product name as it appears in the License. 
 Version - Version as it appears in the License. 
 Installed Quantity - The total number of installations of the selected product found. 

Click this quantity to view the Discovered Product Workstation List report, a list of 
workstations on which the selected product is installed. 

 Active Usage Quantity - The number of workstations on which the product has seen 
active usage over the specified time period. Opens the Application Usage Report in a 
new window. 

 Unused Licenses - License Quantity minus Active Usage Quantity, not less than zero. 



Using the Asset Management Tab 

145 

 Unused Installations -  
 
Additional Columns for Suite Components 

 Component Product - The name of the suite component. 
 Version - The version of the suite component. 
 Installed Quantity - The total number of installations of the selected product found. 

Click this quantity to view the Discovered Product Workstation List report, a list of 
workstations on which the selected product is installed. 

 Active Usage Quantity - The number of workstations on which the suite component has 
seen active usage over the specified time period. 

Discovered Product Workstation List 

 Machine Name - Name of the workstation. Click the name of a workstation to view the 
Discovered Product Detail Report for that workstation. 

 Login Name - Login ID of the user logged in. 
 Mac Address - MAC address of the workstation 
 IP Address - IP address assigned to the workstation. 

 

Discovered Product Detail 

 Workstation - The name of the workstation. Click this name to view the Workstation 
Detail Report. 

 Manufacturer - Name of the manufacturer as it appears in the License Knowledgebase. 
 Discovered Product - Name of the product as it appears in the License Knowledgebase. 
 Version - Version of the product as it appears in the License Knowledgebase. 
 Excluded by ZENworks - Checked if the product is excluded by the License 

Knowledgebase. 
 Excluded by User - Checked if the product is excluded by the user. 
 Suite Component - Checked if the product is detected as part of a software suite. 
 Inventory Product - Name of the product as it appears in the ZENworks Asset 

Management inventory. 
 Path - File path to the installed software product on the selected workstation. 
 Active Usage Days -  

Application Usage 

 Manufacturer - Name of the manufacturer as it appears in the License Knowledgebase. 
 Product - Name of the product as it appears in the License Knowledgebase. 
 Version - Version of the product as it appears in the License Knowledgebase. 
 Current Installations - The number of copies of this product discovered on 

workstations. 
 Total Used - The number of installations for which there is active usage history. 
 # Not Used - The number of installations for which there is no active usage history. 
 Hours Used - The total number of hours this product has been used on all workstations. 
 Ave. Usage Days - The average number of days this product has been used on a 

workstation. 
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Application Usage by Workstation 

 Workstation - The name of the workstation 
 Login - The user's login name. 
 User - The user's real name. 
 Department - The department to which the workstation is assigned. 
 Site - The site to which the workstation is assigned. 
 MAC Address - The workstation's MAC address. 
 IP Address - The workstation's assigned IP address. 
 Copies - The number of copies of the application discovered on the workstation. 

Workstation Detail 
Contains information down to the component level for the selected workstation. 

 

Note: Because this report is not filtered through the License Knowledgebase, there may be discrepancies between it 
and the Discovered Product Detail report. 
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Reports - Unreconciled Products Reports (Submenu) 

From this submenu, choose the Unreconciled Purchases Report and the Unreconciled Discovered Products Report. Use 
these reports to view and edit the products you haven't yet reconciled. 

 Click the Excel button to export the data you are viewing to an Excel spreadsheet. If 
your search result contains more than 100 records, click Excel All to export the entire 
data set. For more information, see Exporting Your Data To Excel. 

 Click any column header to sort by that column. Click again to reverse the sort order. 

Unreconciled Catalog Products 
Use the Unreconciled Catalog Products Report to view a list of Catalog Products that are not currently reconciled. 

 Manufacturer - Manufacturer name as it appears in the Catalog Product record. 
 Product - Product name as it appears in the Catalog Product record. 
 Version - Version as it appears in the Catalog Product record. 
 Product Type - Product Type as it appears in the Catalog Product record. 
 Licenses Per Pkg - The number of licenses per package for this Catalog Product. 
 License Quantity - The total number of licenses for this product represented by all 

Purchase Records. 

Unreconciled Discovered Products 
Drill-down Tree: 

Unreconciled Discovered Products Report 

Discovered Product Workstation List 

Discovered Product Detail 

Workstation Detail 

 

Use the Unreconciled Discovered Products Report to view a list of Discovered Products that are not currently 
reconciled. 

 Manufacturer - Manufacturer name as determined by ZENworks Asset Management. 
 Product - Product name as determined by ZENworks Asset Management. 
 Version - Product version as determined by ZENworks Asset Management. 
 Installed Quantity - The total number of installations as determined by ZENworks Asset 

Management. Click a value in the Installed Q uantity column to view a list of 
workstations on which the software is installed. From this list, you can drill-down to 
view a list of workstations on which a product is installed, and further to the 
Discovered Product Detail, to view details about any of those workstations. 

 Active Usage Quantity - The number of workstations on which the discovered product 
has seen active usage over the specified time period. 
 
Note: The Discovered Product Detail report is filtered through the License 
Knowledgebase. The Workstation Detail report is not. As a result, you may see software 
installed on a Workstation Detail report that does not appear in the Discovered Product 
Detail report . For example, the License Knowledgebase does not report multiple 
copies of the same software on a machine. You would see all installed copies in the 
Discovered Product Detail report. 
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Inventory Comparison Report 

ZENworks Asset Management's Knowledgebase contains a product definition, a kind of "fingerprint", for each software 
application it tracks. Simplified, the product definition is of a list of software files that make up the product. 

  

When a minor release or service pack of a software application is published, its product definition is consolidated with 
the other minor releases of that application. This allows the application to be reported as one product, rather than a 
separate product for each minor release. Major releases are always considered to be different products. 

  

The Inventory Comparison report allows you to see the relationships between the consolidated product and its various 
minor release versions, and the installed quantity of each minor version. This can be a quick way, for example, to see 
how many workstations are running one service pack or another.  

  

You can also see which products are installed as part of a suite, and which are installed as standalone components. 

Drill Down Tree 
Inventory Comparison Report 

Workstation List 

Workstation Detail 

Report Columns 

 Inventory Product - The discovered name of the product. 
 Installed Quantity - The number of installations of the product. This represents a 

single version of a product. 
 Discovered Product - The discovered name of the product. If multiple versions are 

discovered, this column is blank for all rows except the first row of the product. 
 Installed Quantity - The number of installations of the product, with all minor versions 

consolidated into one product. This represents the total of all versions in the Inventory 
Product's Installed Quantity column. If multiple versions are discovered, this column is 
blank for all rows except the first row of the product. 

 Suite Component - The number of workstations on which the product is installed as 
part of a suite. 

 Stand Alone - The number of workstations on which the product is installed as a stand-
alone component. 

 Excluded by ZENworks - Checked if this product is excluded automatically by 
ZENworks Asset Management. 

 Excluded by User - Checked if this product is excluded by a user. 
 Local Product - Checked if this product is defined as a local product. 
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Purchase Record Summary Report 

Use the Purchase Record Summary Report to view a list of Catalog Products and your purchase quantities for those 
licenses. 

 Click the Excel button to export the data you are viewing to an Excel spreadsheet. If 
your search result contains more than 100 records, click Excel All to export the entire 
data set. For more information, see Exporting Your Data To Excel. 

 Click PDF to convert the report to a PDF file.  
 Click CSV to convert the report to a CSV (comma-separated) file.  
 Click any column header to sort by that column. Click again to reverse the sort order. 
 Click G raph to view a graph of Average Unit Price and Total Price. For more 

information, see Viewing Graphs. 

Drill-down Tree 
Purchase Record Summary Report 

View/Edit Catalog Product 

Purchase Record Detail 

View/Edit Purchase Record 

 

Report Columns 

 Manufacturer - Manufacturer name as it appears in the Product Catalog. 
 Product - Product name as it appears in the Product Catalog. Click a product name to 

view or edit the selected Catalog Product. 
 Product Type - Product type as it appears in the Product Catalog. 
 Version - Product version as it appears in the Product Catalog. 
 Licenses Per Pkg - Number of licenses per package for the product. 
 Purchase Qty - Total quantity of product purchased. Click a value in this column to 

view or edit the Purchase Record for the selected product. 
 Average Unit Price - Total of all Unit Price values divided by the number of Purchase 

Q ty. 
 Total Price - Total of Extended Price for all purchases of this product. 

Purchase Record Detail Report 

Use the Purchase Record Detail Report to view a list of Purchase Records, and the line items in each record. 

 

 To edit a Purchase Record, click an active link for the record you want to edit. 

 Click the Excel button to export the data you are viewing to an Excel spreadsheet. If your search result 
contains more than 100 records, click Excel All to export the entire data set. For more information, see 
Exporting Your Data To Excel. 

 Click any column header to sort by that column. Click again to reverse the sort order. 

Report Columns 

 PO #  - The Purchase Order number as it appears in the Purchase Record header. 
 Invoice #  - The Invoice number as it appears in the Purchase Record header. 
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 Reseller - The Reseller name as it appears in the Purchase Record header. 
 Order Date - The Order Date as it appears in the Purchase Record header. 
 Manufacturer - Manufacturer name as it appears in the Product Catalog. 
 Product - Product name as it appears in the Product Catalog. Click a product name to 

view or edit the selected Purchase Record. 
 Product Type - Product type as it appears in the Product Catalog. 
 Version - Product version as it appears in the Product Catalog. 
 Licenses Per Pkg - Number of licenses per package for the product. 
 Purchase Qty - Number of licenses purchased as it appears in the Purchase Record. 
 Unit MSRP - Manufacturers' Suggested Retail Price as it appears in the Purchase Record. 
 Unit Price - Product's unit price as it appears in the Purchase Record. 
 Extended Price - Product's extended price, calculated from the Unit Price and the 

Purchase Q ty. 
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License Allocation Reports 

Use the Reports menu's License Allocation submenu to choose from a number of License Allocation reports. 

 

 Current Allocations - Use this report to view a list of licenses and their current 
allocations. 

 Allocations vs Installations - Use this report to view the difference between your 
installed software and your license allocations.  

 Demographic Over-Allocations - Use this report to view a list of products where the 
number of licenses allocated to a demographic exceeds the number of installations for 
that demographic.  

 Demographic Under-Allocations -Use this report to view a list of products where the 
number of installations exceeds the number of licenses allocated to that demographic.  

 Workstation Over-Allocation - Use this report to view a list of products where the 
number of licenses allocated to workstations exceeds the number of installations. 

 Installations with no Allocations - Use this report to view a list of products where the 
number of installations exceeds the number of allocated licenses.  

 Duplicate Allocations - Use this report to view a list of products for which duplicate 
allocations are found. 

Current Allocations 
Use this report to view a list of licenses and their current allocations. 

Drill Down Tree: 
Current License Allocation Summary Report 

Current License Allocation Detail Report  

Workstation List 

Workstation Detail Report  

Current License Allocation Summary Report 

 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 License Quantity - Number of licenses for this product you own (for which purchase 

transactions have been entered.) 
 Allocated Licenses - Number of licenses you have allocated, either to a demographic 

group or to a workstation. 
 Unallocated Licenses - Number of licenses you have not yet allocated.  

(License Q uantity minus Allocated Licenses) 

Current License Allocation Detail Report  
Demographic Allocations 

 Site/Dept/Cost Center -The value of the demographic to which this license is 
allocated. 

 Workstation Count - The number of workstations in this demographic. 
 Allocated Quantity - The number of licenses for this product allocated to this 

demographic.  
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Workstation Allocations 

 Machine Name - Name of the workstation to which this license is allocated. 
 Login Name - Login name associated with this workstation. 
 IP Address - IP address of this workstation. 
 Site - Site with which this workstation is associated. 
 Dept - Department with which this workstation is associated. 
 Cost Center - Cost Center with which this workstation is associated. 
 Duplicate Allocation - A check mark appears if this workstation matches a 

demographic to which this license is also allocated. (The license is allocated to the 
demographic, and is also allocated directly to the workstation.) 

Workstation List Report 
This report appears when you click a workstation quantity. 

 

 Machine Name - Name of the workstation to which this license is allocated. 
 Login Name - Login name associated with this workstation. 
 IP Address - IP address of this workstation. 
 Site - Site with which this workstation is associated. 
 Dept - Department with which this workstation is associated. 
 Cost Center - Cost Center with which this workstation is associated. 
 Installed - a check mark appears if the selected product is installed on this 

workstation. 

Allocations vs Installations 
Use this report to view the difference between your installed software and your license allocations. 

Drill Down Tree 
Allocation vs Installation Report 

Allocation vs Installation Detail Report 

Workstation List 

Workstation Detail Report  

Allocation vs Installation Report 

 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 License Quantity - Number of licenses for this product you own (for which purchase 

transactions have been entered.) 
 Allocated Quantity - Number of licenses you have allocated, either to a demographic 

group or to a workstation. 
 Installed Quantity - Number of copies installed. 
 Total Variance - (Allocated Q uantity minus Installed Q uantity) A positive number 

means you have allocated more licenses than the number of copies you have installed. 
A negative number means you have installed more copies than the number you have 
allocated. Non-zero values are shown in red. 
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 Over-allocations - Over-allocation values as shown in the Over-allocation Detail 
reports. Non-zero values are shown in red. 

 Under-allocations - Under-allocation values as shown in the Under-allocation Detail 
reports. Non-zero values are shown in red. 

Allocation vs Installation Detail Report 
Demographic Allocations 

 Site/Dept/Cost Center -The value of the demographic to which this license is 
allocated. 

 Workstation Count - The number of workstations in this demographic. 
 Allocated Quantity - The number of licenses for this product allocated to this 

demographic.  
 Installed Quantity - The number of copies of this product installed on workstations 

associated with this demographic. 
 Variance - The difference between Allocated Quantity and Installed Quantity. 

 

Workstation Allocations 

 Machine Name - Name of the workstation to which this license is allocated. 
 Login Name - Login name associated with this workstation. 
 IP Address - IP address of this workstation. 
 Site - Site with which this workstation is associated. 
 Dept - Department with which this workstation is associated. 
 Cost Center - Cost Center with which this workstation is associated. 
 Duplicate Allocation - A check mark appears if this workstation matches a 

demographic to which this license is also allocated. (The license is allocated to the 
demographic, and is also allocated directly to the workstation.) 

Demographic Over-Allocations 
Use this report to view a list of products where the number of licenses allocated to a demographic exceeds the number 
of installations for that demographic. 

Drill Down Tree 
Demographic Over-allocation Report 

Demographic Over-allocation Report: Demographic List 

Workstation List 

Workstation Detail Report  

Demographic Over-allocation Report 

 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 Allocated Quantity - Number of licenses you have allocated, either to a demographic 

group or to a workstation. 
 Installed Quantity - Number of copies installed. 
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 Total Variance - (Allocated Q uantity minus Installed Q uantity) A positive number 
means you have allocated more licenses than the number of copies you have installed. 
A negative number means you have installed more copies than the number you have 
allocated. 
Note: It is possible to have a Total Variance of zero, but have variances for a particular 
demographic. For example if you allocate 100 licenses to the Boston site, but they are 
installed on the Chicago site, the total variance would be zero, but Boston shows 100 
licenses over-allocated, while Chicago shows an under-allocation of 100 licenses. These 
anomalies are more apparent in the Allocations vs Installations Summary report. 

 Total Over-allocation - The total number of licenses over-allocated for this product. 

Demographic Over-allocation Report: Demographic List 

 Site/Department/Cost Center - The demographic by which this license is allocated. 
 Workstation Count - The number of workstations associated with this demographic. 
 License Allocation - The number of licenses allocated to this demographic. 
 Installed Quantity - The number of copies of this product installed. 
 Over-Allocation - The total over-allocation of licenses for this demographic. 

Demographic Under-Allocations 
Use this report to view a list of products where the number of installations exceeds the number of licenses allocated to 
that demographic. 

Drill Down Tree 
Demographic Under-allocation Report 

Demographic Under-allocation Report: Demographic List 

Workstation List 

Workstation Detail Report 

Demographic Under-allocation Report 

 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 Allocated Quantity - Number of licenses you have allocated, either to a demographic 

group or to a workstation. 
 Installed Quantity - Number of copies installed. 
 Total Variance - (Allocated Q uantity minus Installed Q uantity) A positive number 

means you have allocated more licenses than the number of copies you have installed. 
A negative number means you have installed more copies than the number you have 
allocated. 
Note: It is possible to have a Total Variance of zero, but have variances for a particular 
demographic. For example if you allocate 100 licenses to the Boston site, but they are 
installed on the Chicago site, the total variance would be zero, but Boston shows 100 
licenses over-allocated, while Chicago shows an under-allocation of 100 licenses. These 
anomalies are more apparent in the Allocations vs Installations Summary report. 

 Total Under-allocation - The total number of licenses under-allocated for this product. 

Demographic Under-allocation Report: Demographic List 

 Site/Department/Cost Center - The demographic by which this license is allocated. 
 Workstation Count - The number of workstations associated with this demographic. 
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 License Allocation - The number of licenses allocated to this demographic. 
 Installed Quantity - The number of copies of this product installed. 
 Under-Allocation - The total Under-allocation of licenses for this demographic. 

Workstation Over-Allocations 
Use this report to view a list of products where the number of licenses allocated to workstations exceeds the number 
of installations. 

Drill Down Tree 
Workstation Over-allocation Report 

Workstation List 

Workstation Detail Report  

Workstation Over-allocation Report 

 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 Allocated Quantity - Number of licenses you have allocated, either to a demographic 

group or to a workstation. 
 Installed Quantity - Number of copies installed. 
 Workstation Allocations without Installations - Number of workstations to which the 

license is allocated, but is not installed. 

Installations with no Allocations 
Use this report to view a list of products where the number of installations exceeds the number of allocated licenses. 

Drill Down Tree 
Installations with no Allocations Report 

Workstation List 

Workstation Detail Report  

Installations with no Allocations Report 
This report shows a list of licenses and the count of workstations on which the product is installed, but for which no 
licenses have been allocated. 

 

 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 Allocated Quantity - Number of licenses you have allocated, either to a demographic 

group or to a workstation. 
 Installed Quantity - Number of copies installed. 
 Installations without Allocations - Number of workstations on which the product is 

installed but but to which it is not allocated. 

Duplicate Allocations 
Use this report to view a list of products for which duplicate allocations are found. 

Duplicate Allocation Summary Report 
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 Manufacturer - Manufacturer name as it appears in the License record. 
 License - Product name as it appears in the License record. 
 Version - Version as it appears in the License record. 
 Demographic - The demographic to which this license is allocated. 
 Duplicate Allocations - The number of duplicate allocations associated with this 

license. (License is allocated to the demographic, and also directly to workstations.) 

 

Alerts/Custom Reports 

Use the Alerts/Custom Reports command, available from the Reports menu of the Software Management tab, to view 
the Custom Reports tree in the left frame. 

 

Using the Custom Reports tree, you can create, view, and edit an endless variety of custom reports, and create Alerts 
from them. For more information, see Using Custom Reports and Alerts. 

 

Software Standards Report 

Use this report to view a list of products with their defined Standards Categories and the number of installations. Drill 
down to see a list of workstations on which these products are installed.  

 

For more information, see Managing Software Standards. 

Drill Down Tree 
Software Standards Report 

Workstation List 

Workstation Detail 

Report Columns 

 Manufacturer - Manufacturer name as it appears in the Discovered Product. 
 License - Product name as it appears in the Discovered Product. 
 Version - Version as it appears in the Discovered Product. 
 Software Category - ZENworks Asset Management Knowledgebase Category 
 Software Subcategory - ZENworks Asset Management Knowledgebase Subcategory 
 Standards Category - User-defined category 
 Installed Quantity - Number of installed copies of this product 
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Suites Reports 

Use the Suites reports to view products that are designated as suites in the ZENworks Asset Management 
Knowledgebase. Two reports are available: 

 

 Suites/Components report - This report shows installed products that are designated 
as suites and usage of each component product. 

 Standalone Components report - This report shows installed products that are 
installed as standalone products, but designated as components of a software suite. 

Suites/Components Report 
Use this report to view a list of products designated as suites, and the number of installations of each suite. Drill down 
to see a list of workstations on which these products are installed.  

Drill Down Tree 
Discovered Suites/Components Report  

Discovered Product Workstation List 

Discovered Product Detail 

View/Edit License Record 

Report Columns 

 Manufacturer - Manufacturer name as it appears in the Discovered Product. 

 Product - Contains the name of the suite and the names of its individual components. 

 Version - Version as it appears in the Discovered Product. 

 Installed Quantity - The number of installed copies of this product 
 Active Usage Quantity - The number of installed copies for which there is active usage 

history. 
 Unused Installations - The number of installed copies for which there is no active 

usage. 
 Not Installed - The number of licenses for which no installation has been found. 
 License - The name of the license record associated with the suite. 

Standalone Components Report 
Use this report to view installed products that are installed as standalone products, but designated are as components 
of a software suite. 

 

Drill-down Tree 
Discovered Standalone Components Report (below) 

Discovered Product Workstation List 

Discovered Product Detail 

View/Edit License Record 
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Report Columns 

 Manufacturer - Manufacturer name as it appears in the Discovered Product. 

 Product - Contains the name of the suite component. 

 Version - Version as it appears in the Discovered Product. 

 Installed Quantity - The number of installed copies of this product 
 Active Usage Quantity - The number of installed copies for which there is active usage 

history. 
 Unused Installations - The number of installed copies for which there is no active 

usage. 
 License - The name of the license record associated with the component's suite. 

 

Filter Tab Reference - Software Management Page 

Use the View, Filter By, and Group By options to narrow your search and view a particular set of data. The options vary 
from one report to another as described below. For information on how to use the search filters, see Using the Value, 
Manufacturer, and Order Date Filters below. 

 

Notes on Grouping:  

 The Group By options appear only when your Purchased Products or Discovered 
Products contain demographic data in the Site, Department, or Cost Center fields. 

 Items that are not assigned to a Site, Department, or Cost Center, it appears in the 
Other category. 

Purchase Records menu 

 View/Edit Purchase Records 
Filter by: Value, Order Date 
Group By: None, Site, Department, Cost Center 

 Choose Product window - Catalog Product list 
View: Unreconciled Products, Reconciled Products, All Productions 
Filter by: Manufacturer, Value 

 Delete Purchase Records 
Filter by: Value, Order Date 
Group By: None, Site, Department, Cost Center 

Product Catalog menu 

 View/Edit Product 
View: Included Products, Excluded Products, All Products 
View: Unreconciled Products, Reconciled Products, All Products 
View: Non-upgrade Products, Upgrade Products, All Products 
Filter by: Manufacturer, Value 

 Delete Product 
View: Included Products, Excluded Products, All Products 
View: Unreconciled Products, Reconciled Products, All Products 
View: Non-upgrade Products, Upgrade Products, All Products 
Filter by: Manufacturer, Value 
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 Exclude Product 
View: Included Products, Excluded Products, All Products 
View: Unreconciled Products, Reconciled Products, All Products 
View: Non-upgrade Products, Upgrade Products, All Products 
Filter by: Manufacturer, Value 

 Reconcile To License Record  
View: Unreconciled Products, Reconciled Products, All Products 
Filter by: Manufacturer, Value 

License Records menu 

 View/Edit License Records  
License Records: Without Catalog Products,Without Discovered Products, With no 
Products, All Licenses 
Platform: Windows, Mac, All Platforms 
Filter by: Manufacturer, Value 

 Delete License Records  
License Records: Without Catalog Products,Without Discovered Products, With no 
Products, All Licenses 
Platform: Windows, Mac, All Platforms 
Filter by: Manufacturer, Value 

 License Allocation Submenu - View/Edit License Allocations 
License Records: With Allocations, Without Allocations, All Licenses 
Filter by: Manufacturer, Value 

 Auto-reconcile 
Filter by: Manufacturer, Value 

Discovered Products menu 

 Exclude Product 
View: All Knowledgebase Products, Products in Current Inventory  
View: Included Products, Excluded Products, All Products 
View: Unreconciled Products, Reconciled Products, All Products 
Platform: Windows, Mac, All Platforms 
Filter by: Manufacturer, Software Category, Software Subcategory, Value 

 Reconcile To License Record  
View: Unreconciled Products, Reconciled Products, All Products 
Platform: Windows, Mac, All Platforms  
Filter by: Manufacturer, Software Category, Software Subcategory, Value 
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Reports menu 

 Software Compliance Reports: 
Compliance Report 
License Records: Over, Equal, Under, All 
Platform: Windows, Mac, All Platforms 
Filter by: Manufacturer, Value 
Group By: None, Cost Center, Department, Site 

 Unreconciled Products Reports: 
Catalog Products Report 
Filter by: Manufacturer, Value 
Group By: None, Cost Center, Department, Site 
Discovered Products Report 
Platform: Windows, Mac, All Platforms 
Filter by: Manufacturer, Value 

 Inventory Comparison Report 
View: Included Products, Excluded Products, All Products 
View: Suite Components Only, Non-Suite Components Only, All Products 
Filter by: Manufacturer, Value 

 Purchase Summary Report 
Filter by: Manufacturer, Value 
Group by: None, Cost Center, Department, Site 

 Purchase Detail Report 
Filter by: Value, Order Date 
Group By: None, Site, Department, Cost Center 

 License Allocation Reports: 
Current Allocations 
License Records: With Allocations, Without Allocations, All Licenses 
Filter by: Manufacturer, Value 
Allocations vs Installations 
License Records: With Allocations, Without Allocations, All Licenses 
Filter by: Manufacturer, Value  

Demographic Over-Allocations 
Filter by: Manufacturer, Value 
Demographic Under-Allocations 
Filter by: Manufacturer, Value 
Workstation Over-Allocations 
Filter by: Manufacturer, Value 
Installations with no Allocations 
Filter by: Manufacturer, Value 
Duplicate Allocations 
Filter by: Manufacturer, Value  

 Software Standards Report 
View: All Products, User-Defined (Local) Products 
Platform: Windows, Mac, All Platforms 
Filter by: Manufacturer, Software Category, Software Subcategory, Standards Category, 
Value 

 Suites Reports 
Suites/Components 
View by: Unreconciled Products, Reconciled Products, All Products 
Filter by: Manufacturer, Value 
Standalone Components 
View by: Unreconciled Products, Reconciled Products, All Products 
Filter by: Manufacturer, Value  
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Using the Value, Manufacturer, and Order Data Filters 

To Search by Value: 

1. Click Value to search by value. A list of available column names appears. 
2. Click in the list of column names, click to select the column you want to search. 

3. Enter text in the Search String box. 

4. Click Search. The result of your search appears in the right frame. 

 

To Search by Manufacturer: 

1. Click Manufacturer. A list of available manufacturers appears. 
2. Click to select the manufacturer you want to filter by. To choose more than one manufacturer, shift-click to 

choose contiguous manufacturers, or control-click to choose non-contiguous manufacturers. 

3. Click Search. The result of your search appears in the right frame. 

 

To Search by Order Date: 

1. Click Order Date. The On, Before, and After radio buttons and a set of date drop-
down menus appear. 

2. Click to choose On, Before, or After. 
3. In the drop-down menus, choose a month, day, and year. 
4. Click Search. The result of your search appears in the right frame. 
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Managing Contracts 
You can use ZENworks Asset Management to track contracts associated with your hardware and software, and to notify 
a specified set of E-mail recipients when selected events associated with a contract occur. You can also attach 
electronic documents to contracts for later reference. 

 

Once you have created a contract, you can associate any number of workstations, network devices, users, licenses, 
departments, sites, or cost centers with the contract. 

 

  
 View and Edit Date Notifications 

 

Adding a New Contract 

Use the Add Contract Record command, available from the Contract Management page, to create a new contract. 

To add a new contract record: 

1. In the Menu tab of the Asset Management > Contract Management page, expand 
Contracts. A list of contract-related commands appears. 

2. Click Add Contract Record. The Contract Record page appears in the right frame. 
3. Enter information about the contract in the General, Vendor, SLA, and Lease tabs. 

Boxes marked with an asterisk (*) are required. 
4. Any date can be used for triggering a Date Notification. Enter the date first, then 

select the Date Notification check box below the date. 
 
Note: When you add Date Notifications, they are based on the the default Date 
Notification settings, and are sent through the E-mail server specified in the E-mail 
Server settings, both available to Enterprise Administrators from the Options page. The 
default Date Notification and E-mail server settings must be set up before a Date 
Notification can be sent. 

5. Attach documents to the contract from the Documents tab. 
6. Associate assets, users, licenses, departments, sites, or cost centers with the contract 

from the Associations tab. 
7. View a financial summary for the contract from the Financial tab. 
8. View a history of renewals for the contract from the Renewal History tab. 
9. To view all contract information in one window, click the All tab. 

For information on each tab, see Contract Reference. 
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Viewing and Editing Contract Records 

Use the View/Edit Contract Records command, available from the Contract Management page, to view and edit 
existing contracts. 

1. In the Menu tab of the Asset Management > Contract Management page, expand 
Contracts. A list of contract-related commands appears. 

2. Use the filter in the Filter tab of the left frame to narrow your search. 
3. Click View/Edit Contract Records. The Contract Record page appears in the right 

frame, showing a list of existing contracts. 
4. Click the Contract ID for the contract you want to edit. The Contract record appears in 

the right frame. 
5. Enter information about the contract in the General, Vendor, SLA, and Lease tabs. 

Boxes marked with an asterisk (*) are required. 
6. Any date can be used for triggering a Date Notification. Enter the date first, then 

select the Date Notification check box below the date. 
7. Attach documents to the contract from the Documents tab. 
8. Associate assets, users, licenses, departments, sites, or cost centers with the contract 

from the Associations tab. 
9. View a financial summary for the contract from the Financial tab. 
10. View a history of renewals for the contract from the Renewal History tab. 
11. To view all contract information in one window, click the All tab. 

For information on each tab, see Contract Reference. 
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Attaching a Document to a Contract 

Use the Attach Document(s) command, available from the Documents tab of the Contract Record page to attach 
documents to the selected contract. You can also attach documents to license records.  

  

To attach a document to a contract: 

  

1. Edit the contract to which you want to attach the document. 
2. Click the Documents tab. A list of documents attached to the selected contract 

appears. 
3. Click Attach Document(s). A list of available documents appears in a new window. 
4. Use the Filters in the left frame to narrow your search. 
5. In the left column of the document list, select the documents you want to attach. 

Select or clear the check box in the column header to select or clear all check boxes.  
 
Note: If the document you want to attach does not appear in the document list, it has 
probably not been uploaded yet. If you are an Enterprise Administrator, you can upload 
the document as described in Managing Document Files, then select attach it as 
described above. 

6. Click Done. The window closes, and the selected documents appear in the Documents 
tab's document list, and are attached to the contract. 

To detach (remove) document from the contract: 

 Click the "X" icon to the left of the document you want to remove from the contract's 
Documents tab. A confirmation message appears. Click OK to detach the document. 
 
Note: The document is not deleted, it is just detached from the contract.  
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Deleting Contracts 

Use the Delete Contract Records command, available from the Contract Management page, to delete contract 
records. 

  

To delete a contract: 

  

1. In the Menu tab of the Asset Management > Contract Management page, expand 
Contracts. A list of contract-related commands appears. 

2. Click Delete Contract Records. The Delete Contracts page appears in the right frame, 
showing a list of contracts. 

3. Use the filter in the Filter tab of the left frame to narrow your search. 
4. In the left column of the right frame, click to select the check boxes for the contracts 

you want to delete. Select the check box in the column heading to select or clear all 
check boxes. 

5. At the bottom of the page, click Delete. A confirm message appears. 
6. Click OK. The selected contract records are deleted. 

Renewing A Contract 

When you want to renew a contract, use the Renew Contract command, available from the General Tab of the 
Contract Management page to renew your contract. 

  

Note: The Renew Contract command is available only if Renewal Option is set to Y es. 

  

To renew a contract: 

1. From the Contract Management page, click View/Edit Contract Records. A list of 
contracts appears. 

2. Click the Contract ID of the contract you want to renew. The contract record appears, 
showing the General tab. 

3. Click Renew Contract. The Renew Contract window appears, showing the current 
contract end date. 

4. Click the calendar icon and choose a New End Date. 
5. Click the Effective Date calendar icon and choose a effective date for the renewal. 
6. Enter any notes in the Notes box. 
7. Click Apply. If the effective date has been reached, the new end date appears in the 

Current End Date box. If the effective date is in the future, the end date remains 
unchanged until the effective date is reached, at which time, the renewal is applied. 
The renewal transaction appears in the Renewal History tab.  
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Associating Information with Contracts 

You can associate a contract with one or more workstations, network devices, users, license records, departments, 
sites, or cost centers. 

What happens when you make an association? 

When you make an association with a contract: 

 The association count for that association type reflects the association, and appears as 
a link, in the contract's Associations tab and in the Association Details report (available 
from the Reports menu).  

 If you associate a license record with one or more contracts, the associated contracts 
are listed in the View/Edit License Record page (as well as in the contract's Associated 
Licenses list) with a link back to the contract record. 

Working with Associations 

For each type of association, the window from which you make your choices is designed to make your selection as easy 
as possible, and the process of association is essentially the same.  

To make an association:  

1. From the Contract Management page, click View/Edit Contract Records. A list of 
contracts appears. 

2. Click the Contract ID of the contract for which you want to create associations. The 
contract record appears, showing the General tab. 

3. Click the Associations tab. The Associations tab appears, showing a summary of current 
associations. 

4. Click the numeric link for the type of association you want to make. A list of current 
associations appears. 

5. Click Add. A window appears, showing a list of items available for association. If you 
chose workstations or network devices, a search form appears. Enter any search 
criteria you want to use to narrow your search, or click Search with the default form 
contents to view all available workstations. 

6. Once you have a list of available items for association, select the check boxes for the 
items you want to associate with the contract. Select the check box in the column 
heading to select all items in the list. Click a column heading to sort by that column; 
click again to reverse the sort. 

7. When you have selected all the items you want to associate with the contract, click 
Done. The selected items appear in the associations tab. 

8. Click Done. The summary of associations appears, and reflects the associations you 
added to the selected association group. 

To remove an association: 

1. Click the numeric link for the type of association you want to remove. A list of current 
associations appears. 

2. Select the check box for the items you want to remove from the associations list.  
3. Click Remove. The associations list is updated, and the selected items are removed. 
4. Click Done. The summary of associations appears, and reflects the associations you 

removed from the selected association group. 

To export an associations list: 

 Click Excel, CSV, or PDF to export the list you are viewing to the selected format.  
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About Parent and Child Contracts 

You can associate any number of contracts with a parent contract. Once associated, the parent contract's ID appears in 
the Parent Contract ID column of the View/Edit Contracts page. 

  

To associate a contract with a parent contract: 

1. From the View/Edit Contracts page, click the Contract ID of contract you want to 
associate with a parent contract. The Contract Record's General tab appears. 

2. Choose a contract from the Parent Contract ID (Name) drop-down menu. 
3. Click Done. The View/Edit Contracts page appears, showing the selected contract ID in 

the Parent Contract ID column. Click the Parent Contract ID column heading to sort by 
that column; click it again to reverse the sort order. 

  

Managing Date Notifications 

For each date notification specified in a contract, a Date Notification record is saved. You can view and edit a number 
of details about each notification.  

  

Note: When you add Date Notifications, they are based on the the default Date Notification settings, and are sent 
through the E-mail server specified in the E-mail Server settings, both available to Enterprise Administrators from the 
Options page. The default Date Notification and E-mail server settings must be set up before a Date Notification can be 
sent. 

  

Here are some of the things you can do with notifications: 

  

 View a list of Date Notifications 
 Edit details for a notification 
 Delete one or more notifications 
 Export a list of notifications 

  

Viewing a List of Notifications 

1. In the Menu tab of the Asset Management > Contract Management page, expand 
Date Notifications. A list of Date Notification-related commands appears. 

2. Click View/Edit Notification Records. The View/Edit Date Notifications page appears 
in the right frame, showing a list of defined notifications. 

3. Use the Filter tab to narrow your search. 
4. Click the Notification name for the Notification record you want to view or edit. Click 

link in the Source Contract column to edit the details for the contract in which this 
notification record was defined. 

5. Click, Excel, CSV, or PDF to export the Notifications list. 
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Editing Notification Details 

1. In the Menu tab of the Asset Management > Contract Management page, expand 
Date Notifications. A list of Date Notification-related commands appears. 

2. Click View/Edit Notification Records. The View/Edit Date Notifications page appears 
in the right frame, showing a list of defined notifications. 

3. Use the Filter tab to narrow your search. 
4. Click the Notification name for the Notification record you want to edit. Click link in 

the Source Contract column to edit the details for the contract in which this 
notification record was defined. 

5. Click Excel, CSV, or PDF to export the Notifications list. 

See Date Notification Reference for information on the details of a Date Notification record.  

Deleting Notification Records 

1. In the Menu tab of the Asset Management > Contract Management page, expand 
Date Notifications. A list of Date Notification-related commands appears. 

2. Click Delete Notification Records. The Delete Date Notifications page appears in the 
right frame, showing a list of defined notifications. 

3. Use the Filter tab in the left frame to narrow your search. 
4. In the left column, click to select the check boxes for the Notification records you want 

to delete. Click the check box in the column header to select or clear all check boxes.  
5. Click Delete. A confirm message appears. 
6. Click OK to delete the selected Notification records. 

Exporting the Notification List 

Use the Excel, CSV, or PDF at the bottom of the View/Edit Date Notifications or Delete Date Notifications pages to 
export the Notifications list into an Excel spreadsheet, a comma-separated file, or a PDF. 
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Contract Reference 

Use the Contract page to add and edit details for a contract. The Contract page contains the following tabbed sections: 

 

 Contract List - View a list of contracts. Click a Contract ID to edit the contract. 
 General tab - Enter general information about the current contract, such as the name, 

description, contract cost, start and end dates, and renewal information. 
 Vendor tab - Enter information about the contract vendor. 
 Financial tab - View a read-only financial analysis of the contract cost.  
 SLA tab - Enter information to help you track the contract's service level. 
 Lease tab - If the contract is a lease, enter information about the lease. 
 Documents tab - Attach electronic documents to the contract. 
 Renewal History tab - View a read-only renewal history of the contract. 
 Associations tab - Associate various assets, users, software licenses, departments, 

sites, or cost centers with the contract. 
 All tab - View and edit information from all the Contract page tabs in one page. 

Contract List 

 Contract ID - A unique identifier for a contract as defined on the General tab. 
 Contract Name - A descriptive name for the contract. 
 Type - The Contract type as defined on the General tab. 
 Status - The current status of the contract. 
 Start Date - The contract's original start date. 
 End Date - The contract's current end date. 
 Vendor Name - The vendor's name. 
 Parent Contract ID - The Contract ID of the specified parent contract. Click this link to 

view or edit the parent contract. 
 Parent Contract Name - The name of the specified parent contract. 

General Tab 

Data 

 Contract ID (required) - A unique identifier for a contract. If you create a new 
contract with the same identifier, a sequential number is appended to the Contract ID. 

 Contract Name - Enter a name for the contract. 
 Contract Description - Enter a description of the contract. 
 Total Cost - Enter a total cost for the contract. 
 Parent Contract ID (Name) - Choose a parent contract, if one exists, from the 

dropdown list. 
 General Description of Terms and Conditions - Enter a description of terms and 

condition. 
 Contract Type - Choose a contract type from the drop-down list. To add a new 

contract type, choose Add a New List Item. 
 Contract Status - Choose a contract status from the drop-down list. To add a new type 

of contract status, choose Add a New List Item. 
 Original Start Date - Enter a contract start date or click the calendar icon and choose a 

date. Select the Date Notification check box to send a Date Notification when this 
date is reached. 



Using the ZENworks Asset Management Web Console 

170 

 Current End Date - Enter a contract end date or click the calendar icon and choose a 
date. Select the Date Notification check box to send a Date Notification when this 
date is reached. 

 Evergreen - Click to select this check box if you want the contract to specify the 
contract open-ended. 

 Time Remaining - Computes the time remaining in the contract. This is a read-only 
control. 

 Renewal Option - Choose Y es or No from the drop-down menu. 
 Renewal Provision - If you chose a Renewal Option value of Y es, enter any renewal 

provisions in this text box. 
 Notice Date - Enter a general-purpose date for use with Date Notifications. You can use 

it to remind you of anything related to the contract, such as a renewal reminder. 
Select the Date Notification check box to send a Date Notification when this date is 
reached. 

 Notice Description - Enter a description of the Notice Date. You can use this to explain 
the purpose of the Notice. 

Commands 

 Renew Contract - click this link to renew a contract. A window appears, in which you 
can enter a new end date, an effective date, and a comment. 

Vendor Tab 

 Vendor Name - Enter the name of the contract vendor. 
 Vendor ID - Enter an ID for the vendor. 
 Account Number - Enter your Account number with this vendor. 
 Program Name - If the contract is part of a program offered by the vendor, enter the 

program name here. 
 Primary Vendor Contact/Phone Number/E-mail Address - Enter name, phone number 

and E-mail address for the primary vendor contact. 
 Internal Contact/Phone Number/E-mail Address - Enter name, phone number and E-

mail address for an internal vendor contact. 
 Secondary Vendor Contact/Phone Number/E-mail Address - Enter name, phone 

number and E-mail address for a secondary vendor contact. 

Financial Tab 

Use the Financial tab to view a read-only financial analysis of the contract. 

 Total Cost - The total contract cost. 
 Annualized Cost - The contract's cost-per-year. 
 Per Asset - A total or annualized cost-per-asset. 
 Per User - A total or annualized cost-per-user. 
 Per Department - A total or annualized cost-per-department. 
 Per Cost Center - A total or annualized cost-per-cost center. 
 Per Site - A total or annualized cost-per-site. 
 Per License - A total or annualized cost-per-license. 
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SLA (Service Level Agreement) Tab 

Use the SLA tab to track service level performance as it compares to the contracted service level. 

Data 

 Service Level Metric (new) - Enter a service level metric agreed to in the contract. 
Example: "Same-day (24hr) response to all tech support calls". 

 Actual Service Level - Enter an actual service level. Example: "Same-day response 
to 90% of tech support calls, remaining 10% handled within 72hrs" 

 Start Date - Enter a start date for service level tracking. Select the Date Notification 
check box to send a Date Notification when this date is reached. 

 End Date - Enter an end date for service level tracking. Select the Date Notification 
check box to send a Date Notification when this date is reached. 

Commands 

 Add SLA Metric - Use this command to add additional metric entries without clicking 
Done to save the contract. 

Lease Tab 

If the contract is for a lease use the Lease tab to enter information about the lease. 

 Delivery Procedures - Enter information about delivery procedures specified by the 
lease.  

 Return Obligations - Enter information about any return obligations specified by the 
lease. 

 Rights to Relocate, Alter, Sub-lease - Enter information about any relocation, 
alteration, or sub-lease rights specified by the lease. 

 Defaults and Remedies - Enter information about any defaults or remedies specified by 
the lease. 

 Insurance Provisions - Enter information about any insurance requirements specified 
by the lease. 

 Insurance Cost - Enter an insurance cost amount resulting from the lease.  
 Equipment Modification Provisions - Enter information about any equipment 

modification provisions specified by the lease. 
 Purchase Option - If the lease includes a purchase option, enter details.  
 End-of-Lease Provisions - Enter information about any end-of-lease provisions 

specified by the lease. 
 Prevailing Law - Enter information about any prevailing law that affects the lease. 
 Order Date - Enter an order date associated with the lease. Select the Date 

Notification check box to send a Date Notification when this date is reached. 
 Ship Date - Enter a ship date. Select the Date Notification check box to send a Date 

Notification when this date is reached. 
 Delivery Date - Enter a delivery date. Select the Date Notification check box to send 

a Date Notification when this date is reached. 
 Signature Date - Enter a signature date. Select the Date Notification check box to 

send a Date Notification when this date is reached. 
 Inspection Date - Enter an inspection date. Select the Date Notification check box to 

send a Date Notification when this date is reached. 
 Acceptance Date - Enter an acceptance date. Select the Date Notification check box 

to send a Date Notification when this date is reached. 
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Documents Tab 

Columns 

When you click the Documents tab, a list of documents associated with the Contract appears.  

 X - Click this button to detach the document from the contract. A confirmation 
message appears. 

 Document ID - The identifier for the document.  
 File Name - The file name of the document. Click this link to download or open the 

file. 
 File Type - The file's type or extension. 
 File Size - The size (in bytes) of the document. 
 Description - A description of the document. 
 Date Attached - The date the document was attached to the contract. 
 Attached By - The ZENworks Asset Management user that uploaded the document. 

 

Commands 

 Attach Document(s) - Click this button to view a list of uploaded documents in a new 
window, and to attach an uploaded document to the current contract. You can also 
upload a document from this window. 

Renewal History Tab 

Click this tab to view the renewal history for the current contract. You can delete renewals from this page, as well as 
renew the contract. 

 

Columns 

 Date Entered - The date the contract was renewed. 
 Entered By - The ZENworks Asset Management user that entered the renewal 

transaction. 
 End Date Before Renewal - The previous end date. 
 End Date After Renewal - The end date after the renewal transaction. 
 Renewal Effective Date - The effective date of the renewal. 
 Notes - Notes about this renewal. 

Commands 

 Renew Contract - Click this link to renew the current contract. 
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Associations Tab 

 Workstations Assets - Shows the number of workstations associated with this contract. 
Click the numeric link to view or edit the workstation associations for this contract.  

 Network Device Assets - Shows the number of network devices associated with this 
contract. Click the numeric link to view or edit the network device associations for this 
contract.  

 Users - Shows the number of users associated with this contract. Click the numeric link 
to view or edit the user associations for this contract.  

 License Records - Shows the number of licenses associated with this contract. Click 
the numeric link to view or edit the licenses associations for this contract.  

 Departments - Shows the number of departments associated with this contract. Click 
the numeric link to view or edit the department associations for this contract.  

 Sites - Shows the number of sites associated with this contract. Click the numeric link 
to view or edit the site associations for this contract.  

 Cost Centers - Shows the number of cost centers associated with this contract. Click 
the numeric link to view or edit the cost center associations for this contract.  

Commands 

 Add - Click to open a window and add new items to the selected associations list. See 
Editing Associations below for more information on editing an associations list. 

 Remove - Select or clear check boxes for those items you want to remove, then click 
this link. A confirmation message appears. See Editing Associations below for more 
information on editing an associations list. 

 Excel/CSV/PDF - Click one of these links to export the Associations list in the selected 
format. 

Editing Associations 

Depending on the type of association you clicked, a different set of columns appears, related to that type of 
association. You can add or remove associated assets, users, license records, sites, departments, or cost centers to a 
contract. 

 

To add associations to a contract: 

 

1. Click the numeric link for the type of item you want to add. A list of items of the 
selected type that are associated with this contract appears. 

2. Click Add. 
 
If you are viewing associations other than Workstations, a list of available items of the 
selected type appears. Use the filters in the window's left frame to narrow your search. 
 
If are viewing Workstation or Network Device associations, a search form appears. 
Enter appropriate values to narrow your search, and click Search. A list of workstations 
appears. 

3. In the left column, click to select the check boxes for those items you want to 
associate with the current contract. Click the check box in the column header to select 
or clear all check boxes. 

4. Click Done. The selected associations are added to the contract, and appear in the 
associations list. 
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To remove associations from a contract: 

 

1. Click the numeric link for the type of item you want to add. A list of items of the 
selected type that are associated with this contract appears. 

2. In the left column, click to select the check boxes for those items you want to remove 
from the associations list. Click the check box in the column header to select or clear 
all check boxes. 

3. Click Remove. A confirmation message appears. 
4. Click OK. The selected associations are removed from the contract, and disappear in 

the associations list. 

 

All Tab 

Click the All tab to view and edit information from all the Contract page tabs in one page. 

Commands 

 Add SLA Metric - Click this link to add an SLA metric to the contract. For more 
information, see the SLA tab reference. 

 Attach Document(s) - Click this link to attach one or more documents to the contract. 
For more information, see the Documents tab reference. 

 Renew Contract - Click this link to renew the contract. For more information, see the 
General tab reference. 

 PDF - Click this link to export the contract information to a PDF file. 
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Date Notification Reference 

Use the Date Notification Record page to edit the details for the selected Date Notification record. 

  

 Notification Name - Edit the name of the notification record. This is created 
automatically when you select a Date Notification check box in a contract record.  

 Source Contract - The name of the source contract from which this notification record 
was created. 

 Date field - The name of the date field from which this notification record was 
created. 

 Send Notification [X] Days before - Enter a number of days here to specify the number 
of days prior to the specified notification date that the notification is sent. 

 Repeat Notification - Select this check box to send this notification repeatedly.  
 Every [Day/Week/Month] for [X] [Days/Weeks/Months] - If the Repeat Notification 

box is checked, specify the period and number of times you want to send the 
notification. 

 Delete Date Notification Record When Complete - Select this check box to delete the 
notification record after the notification and any repeats have been sent. 

 Message Subject - Enter the subject that appears in the Notification E-mail message. 
 Message Content - Enter the text of the notification message. 
 From - The read-only address from which the message is sent. 
 Recipients - Choose the recipients for the notification. 
 Additional Recipients - Enter an additiona recipient for the notification. 

Contract Report Reference 

Use the reports available in the Contract Management Page's Reports menu to view details about reports. Choose from 
these reports: 

 

 General Contract report - Use this report to view general details about contracts. 
 Date Details report - Use this report to view details about the contract's start and end 

dates, renewal information, and notice date. 
 Vendor Details report - Use this report to view details about the vendors associated 

with contracts. 
 Financial Details report - Use this report to view annualized and total cost analysis of 

each contract. 
 SLA Details report - Use this report to view Service Level of Agreement information 

about each contract. 
 Lease Details report - Use this report to view information about lease contracts. 
 Document Details report - Use this report to view information about documents 

associated with contracts. 
 Renewal Details report - Use this report to view information about contract renewals. 
 Association Details report - Use this report to view the number of workstations, 

network devices, users, departments, sites, cost centers, or licenses associated with 
each contract. 

 Parent/Child Details report - Use this report to view the relationships between parent 
and child contracts. 

 
Use the filters available for each report to narrow your search. For more information see Contract Page Filter Tab 
Reference topic. 
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General Contract Report 

Use this report to view general details about contracts. 

Report Columns 

 Contract ID 
 Contract Name 
 Type 
 Status 
 Total Cost ($) 
 Start Date 
 End Date 
 Vendor Name 
 Parent Contract ID 
 Parent Contract Name 

Date Details Report 

Use this report to view details about the contract's start and end dates, renewal information, and notice date. 

Report Columns 

 Contract ID 
 Contract Name 
 Start Date 
 End Date 
 Time Remaining (Months) 
 Renewal Option 
 Renewal Provision 
 Notice Date 
 Notice Description 

 

Vendor Details Report 

Use this report to view details about the vendors associated with contracts. 

Report Columns 

 Contract ID 
 Contract Name 
 Vendor ID 
 Vendor Name 
 Account Number 
 Program Name 
 Primary Vendor Contact 
 Secondary Vendor Contact 
 Internal Contact 
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Financial Details Report 

Use this report to view annualized and total cost analysis of each contract. 

Report Columns 

 Contract ID 
 Contract Name 
 Total Cost ($) 
 Per Asset ($) 
 Per User ($) 
 Per Cost Center ($) 
 Per Site ($) 
 Per License ($) 
 Annual cost ($) 
 Per Asset ($) 
 Per User ($) 
 Per Cost Center ($) 
 Per Site ($) 
 Per License ($) 

 

SLA Details Report 

Use this report to view Service Level of Agreement information about each contract. 

Report Columns 

 Contract ID 
 Contract Name 
 SLA Metric 
 Actual Service Level 
 Start Date 
 End Date 

Lease Details Report 

Use this report to view information about lease contracts. 

Report Columns 

 Contract ID 
 Contract Name 
 Date Ordered 
 Date Delivered 
 Date Accepted 
 Insurance Provisions 
 End-of-Lease Provisions 
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Document Details Report 

Use this report to view information about documents associated with contracts. 

Report Columns 

 Contract ID 
 Contract Name 
 File Name 
 File Type 
 As-of Date 
 Date Attached 
 Attached By 

 

 

Renewal Details Report 

Use this report to view information about contract renewals. 

Report Columns 

 Contract ID 
 Contract Name 
 Date Entered 
 Entered By 
 End Date Before Renewal 
 End Date After Renewal 
 Renewal Effective Date 
 Notes 

 

Association Details Report 

Use this report to view the number of workstations, network devices, users, departments, sites, cost centers, or 
licenses associated with each contract. 

Report Columns 

 Contract ID 
 Contract Name 
 Workstation Assets 
 Network Device Assets 
 Users 
 Departments 
 Cost Centers 
 Sites 
 Licenses 
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Parent/Child Details Report 

Use this report to view the relationships between parent and child contracts. 

 

Note: When using a filter to narrow the scope of the report, the filter is applied only to top-level contracts. Any 
contracts having a relationship with a parent contract are shown if the parent contract is shown by the filter. If the 
parent contract is not shown as a result of the filter, the child contracts are also not shown. 

Report Columns 

 Contract ID 
 Contract Name 
 Type 
 Status 
 Total Cost ($) 
 Start Date 
 End Date 
 Vendor Name 
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Filter Tab Reference - Contract Management Page 

Use the View and Filter By options to narrow your search and view a particular set of data. The options vary from one 
report to another as described below.  

Contracts Menu 

 View/Edit Contract Records 
Filter by: Contract Type, Contract Status, Vendor Name, Program Name, Current End 
Date, Value 

 Delete Contract Records -  
Filter by: Contract Type, Contract Status, Vendor Name, Program Name, Current End 
Date, Value 

Date Notifications Menu 

 View/Edit Notification Records 
View: All Notifications, Pending Notifications, In-Progress Notifications, Completed 
Notifications 

 Delete Notification Records 
View: All Notifications, Pending Notifications, In-Progress Notifications, Completed 
Notifications  

Reports Menu 

 General Contract report 
Filter by: Contract Type, Contract Status, Vendor Name, Program Name, Current End 
Date, Value  

 Date Details report 
Filter by: Original Start Date, Current End Date, Notice Date, Value 

 Vendor Details report 
Filter by: Vendor Name, Program Name, Value 

 Financial Details report -  
Filter by: Contract Type, Contract Status, Value 

 SLA Details report 
Filter by: Contract Type, Contract Status, Value 

 Lease Details report 
Filter by: Date Ordered, Date Delivered, Date Accepted, Value 

 Document Details report 
Filter by: File Type, Value 

 Renewal Details report 
Filter by: Date Entered, End Date Before Renewal, End Date After Renewal, Renewal 
Effective Date, Value 

 Association Details report 
Filter by: Contract Type, Contract Status, Value 

 Parent/Child Details report 
Filter by: Contract Type, Contract Status, Value 
Note: When using a filter to narrow the scope of the Parent/Child Details report, the 
filter is applied only to top-level contracts. Any contracts having a relationship with a 
parent contract are shown if the parent contract is shown by the filter. If the parent 
contract is not shown as a result of the filter, the child contracts are also not shown.  
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Using the Administration Tab 
Use the Administration Tab to manage your ZENworks Asset Management users, and to manage your list of local 
products. 

 

Note: You must be logged in as an Enterprise Administrator or Enterprise Assistant to access the Administration tab. 

 

On the Administration tab, you can do the following: 

 

 View a list of current users 
 Add a new user 
 Edit an existing user 
 Change a User's password 
 Delete an existing user 

 

You can also manage local products (products not currently in the Novell License Knowledgebase.) 

 

You can: 

 View a list of local products 
 Edit a local product's details 
 Merge two or more local products 
 Remove a software file from a local product 
 Delete a local product 

See also 

 Create Local Products 
 Page Reference for Local Products 

Managing Local Products 
Use the Administration tab's Local Software Products page to manage local software products (products not currently in 
the Novell License Knowledgebase.) Local software products are created from Software Files reports available from the 
Asset Inventory tab > Workstation Inventory page. 
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Managing Web Applications 
Use the Administration tab's Web Applications page to define web-based applications for which you want to track 
usage. Once defined, usage for a web application appears in the Web App Usage reports available from the Asset 
Management tab's Software Usage page. 

Defining a Web Application 

A web application is defined and recognized by what is displayed as the title text in the browser window's title bar 
(excluding the browser name, which appears in Internet Explorer and Firefox's title bars) when viewing a web 
application. You can specify one or more titles to associate with a particular web application. A web application is 
considered terminated when all associated windows have closed. 

 

To define a web application: 

 

1. From the Administration tab, click Web Applications. The Web Applications page 
appears, showing a list of defined web applications. 

2. At the bottom of the right frame, click New Application. A blank Details page appears. 
3. Enter a Manufacturer or choose one from the drop-down list. 
4. In the Application box, enter the name of the web application. 
5. Enter a Version if applicable. 
6. Enter a Window Title for the first window you want to define for the application. 
7. Click Save Application. The details are saved, and the Details page appears, 

containing the information you entered, along with a blank Window Title box. 
8. Repeat steps 6 and 7 until you have defined all the window names you want to 

associate with the web application. 
 
Note: You can use the standard "*" and "?" wildcards in your window titles. ("*" 
represents any number of characters, "?" represents a single character.) For example, 
you could create a single web application for all Google pages with the window title 
"*Google*", or you could create separate applications for Google Search and Google 
Maps with "*Google Search*" and "*Google Maps*". 

Editing a Web Application Definition 

You may want to change some of the details about a web application, changing the titles of certain windows and 
adding new ones, deleting others. 

 

To edit a web application definition: 

 

1. From the Administration tab, click Web Applications. The Web Applications page 
appears, showing a list of defined web applications. 

2. In the left frame, click a manufacturer to narrow your search. 
3. In the right frame, click the Application link for the web application you want to edit. 

Details for the selected application appear. 
4. Edit the details as necessary. To delete a window definition, select the Remove 

Window Title check box beside that window definition. 
5. When finished editing, click Update Application. The Details page appears, showing 

the changes you've made. 
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Deleting a Web Application 

Use the Delete Application command, available from the web application's Details page, to delete the selected web 
application. 

 

To delete a web application: 

1. From the Administration tab, click Web Applications. The Web Applications page 
appears, showing a list of defined web applications. 

2. In the left frame, click a manufacturer to narrow your search. 
3. In the right frame, click the Application link for the web application you want to 

delete. Details for the selected application appear. 
4. At the bottom of the right frame, click Delete Application. A confirmation message 

appears. 
5. Click Delete. The web application definition is deleted, and the Web Applications list 

appears. 

Exporting and Graphing the Web Applications List 

You can export the web applications list to an Excel spreadsheet, a comma-separated text file, or a PDF file. You can 
also graph the usage by workstation. For more information, see Exporting Data and Viewing Graphs, both found in the 
chapter Using the Web Console. 
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Managing Document Files 
Use the Documents page, available from the Administration tab, to manage all documents uploaded for the purpose of 
attaching to contracts or license records. 

Uploading a Document 

Use the Upload Document command, available from the Documents menu, to upload a document. 

  

To upload a document: 

  

1. From the Administration tab, click Documents. The Documents page appears in the 
right frame, showing a list of documents. 

2. In the Documents menu in the left frame, click Upload Document. The Document 
Upload page appears in the right frame. 

3. Click Browse. A Choose File dialog box appears. 
4. Navigate to the file you want to upload, and click Open. The path to the selected file 

appears next to the Browse button. 
5. Enter a Document ID, Description, Source Location, As-of Date, and edit the Local 

Path. All of these are optional and editable. 
6. Click Upload. The file is uploaded, and appears in the document list, available for 

attaching to a contract or license record. 

Viewing and Editing Document Records 

Use the View/Edit Document Records command, available from the Documents menu, to view the document list. This 
is the default view when you click Documents from the Administration tab. 

  

From the document list, you can do any of the following: 

  

 Edit a document record - edit information about the document, such as Document ID, 
Description, Source Location, As-of Date, and Local Path. 

 Download a copy of the document - download the document to your local machine. 
 Export the document list - export the list to an Excel, comma-separated, or PDF file. 

Editing a Document Record 

To edit a document record: 

  

 In the document list, click the document record's Document ID. 
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Downloading the Document 

To download a document: 

  

1. In the document list, click the document record's File Name. If the document's type is 
associated with a browser plug-in, the document opens in your browser. Otherwise, a 
standard file dialog box appears.  
 
Note: If you want to save a document that opens in your browser, Right-click or 
Control-click the document record's File Name, and choose Save Target As or Save 
Link As, depending on your browser. 

2. Choose the location where you want to save the local copy of the document, and click 
Save. A copy of the file is saved on your local machine at the selected location. 

Exporting the Document List 

You can export the document list to an Excel spreadsheet, a comma-separated text file, or a PDF file. 

  

To export the document list: 

  

 Click Excel, CSV, or PDF. For Excel and CSV files, a standard file download dialog box 
opens. For PDF files, a new browser window opens, containing the exported PDF file. 

Deleting Documents 

Use the Delete Document Records command, available from the Documents menu, to delete document records from 
the document list. 

  

To delete one or more document records: 

  

1. From the Administration tab, click Documents. The Documents page appears in the 
right frame, showing a list of documents. 

2. In the Documents menu in the left frame, click Delete Document Records. The Delete 
Documents page appears in the right frame. 

3. Use the Filter tab in the left frame to narrow your search. 
4. In the left column, select the document records you want to delete by clicking the 

check boxes. Click the check box in the column header to select or clear all check 
boxes at once. 

5. Click Delete. A confirm message appears.  
6. Click OK. The selected document records are deleted. 
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Monitoring the Status of Alerts and Date Notifications 
Use the Alert Status page to view reports showing the status of alerts and date notifications that have been created by 
ZENworks Asset Management users. These reports can be useful in verifying that alerts and notfications have been sent 
successfully, as well as to trouble-shoot failed alerts and notifications. 

  

The reports available from the Alert Status page are pre-defined custom reports; you can create your own reports as 
well. 

  

Choose from the following reports in the Alert Status folder: 

  

 All Alerts Past 30 Days 
 Failed Alerts Past 30 Days 
 Successful Alerts Past 30 Days 

  

Choose from the following reports in the Date Notification Status folder: 

  

 All Notifications Past 30 Days 
 Failed Notifications Past 30 Days 
 Successful Notifications Past 30 Days 

Alert Status Reports 

Use the Alert Status reports to view the status of alerts. 

Report Columns 

 Event Identifier - A unique identifier for the alert. 
 Message Type - The type of status message that was logged. 
 Message Text - The text of the status message. 
 Event Final Status (All Alert Status Reports Only) - The status of the alert when all 

attempts to send it are complete. 

  

Date Notification Status Reports 

 Event Identifier - A unique identifier for the notification. 
 Message Type - The type of status message that was logged. 
 Message Text - The text of the status message. 
 Event Final Status (All Date Notification Reports Only) - The status of the notification 

when all attempts to send it are complete. 
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Managing User Roles 
Use the User Roles page of the Administration Tab to manage your ZENworks Asset Management users. 

 

Note: You must be logged in as an Enterprise Administrator or Enterprise Assistant to access the Administration tab. 

 

You can manage your ZENworks Asset Management users in any of the following ways: 

 

 View a list of current users 
 Add a new user 
 Edit an existing user 
 Change a User's password 
 Delete an existing user 
 View a list of Logged-in users 

Viewing Details for a ZENworks Asset Management User 

Use the Users section of the navigation tree in the left frame of the User Roles page to view the current list of users 
authorized to use ZENworks Asset Management. The list is organized hierarchically by User Role. For more information 
on user roles, see Security and Access. 

 

To view a list of users within a user role, and the details for a user: 

1. In the left frame, click plusses (+) to expand the Users tree, until you see the user you 
want to view. 

2. Click the link for the user you want to view. The User Details page appears in the right 
frame, showing details for the selected user. 

Editing a ZENworks Asset Management User's Details 

When viewing the details for a user, you can edit the user's access permissions in a variety of ways. The options 
available depend on the user's User Role. For more information on user roles, see Security and Access. 

 

If you are an Enterprise Administrator, you can set the following: 

 User Role - Choose from a drop-down list to specify the User Role for the selected 
user. 

 Allow Access - Select or clear the Access check boxes to grant or deny access to the 
selected page. 

 Standard Reports/Custom Reports - Select or clear the check boxes for the listed 
reports and custom report folders to grant or deny access. 

 

When you have finished editing details for the selected user,  

 Click Update User Details. The user's details are saved. 
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Changing a User's Password 

When viewing details for a user, you can change the user's password. 

 

To change a user's password: 

1. When viewing details for a user, click Change Password. The Change Password page 
appears in a new window. 

2. In the Enter New Password box, enter a new password. 
3. To confirm the password, enter it again in the Enter New Password Again box. 
4. Click Submit. The user's password is changed to the specified password. 

 
Note: The password must conform to the requirements defined by the Password Rules 
command, available in the Manager. 

Adding a New User 

You can add a new user from the User Roles page. 

 

To add a new user: 

1. In the left frame, click Users or one of the user roles within the Users folder. A list of 
users appears. 

2. At the bottom of the right frame, click New User. The Add a User page appears in a 
new window. 

3. In the User Name box, enter a login name for the new user. 
4. In the Password box, enter a login password for the new user. 
5. To confirm the password, enter it again in the Password Again box. 
6. Choose the user's role from the User Role drop-down menu. 
7. Click Submit. The user is added, and the User Details for the new user appears. 
8. Edit the access details for the new user, and click Update User Details. The new user's 

details are updated. 

Deleting a User 

When viewing details for a user, you can delete the user. 

 

To delete a user: 

1. When viewing details for a user, click Delete User. A confirmation window appears. 
2. Click Delete. The selected user is deleted. 
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Viewing a List of Logged-In Users 

You can view a list of users that are currently logged in to ZENworks Asset Management. You also can export the list to 
Excel, CSV (comma-separated file), or PDF. 

 

To view a list of logged-in users: 

 In the left frame, click Logged In Users. The Logged In Users report appears, showing 
each user's name, user role, and the date and time the user logged in. 
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Local Software Products 
Use the Local Software Products page to manage your local products. 

 

 In the left frame, click Local Software Products to view a list of products by 
manufacturer. 

 In the right frame, click a column heading to sort by that column. Click the column 
heading again to reverse the sort order. 

 In the right frame, click a product name to edit details for the product. 
 In the right frame, click Select Products to Merge to merge two or more products 

together. 
 In the right frame, click Excel to export the current list to an Excel spreadsheet. 
 In the right frame, click PDF to export the current list to a PDF file. 
 In the right frame, click G raph to view a graph of the current data in a PDF file. (Only 

available for graphable data.) 

Local Software Products List Reference 

Use the Local Software Products List to view a list of currently defined products. 

 Manufacturer - The name of the manufacturer for the product. 
 Product - The name of the local product. 
 Version - The version of the local product. 
 File - A list of file names associated with the local product. 
 Date Last Modified - The date that the local product definition was last modified. 
 Installations - The number of copies of the local product in your current inventory. 

Product Details Reference 

Use the Product Details page to review and edit the details for the selected product. The first section of the page, 
Product Naming, contains global information about the local product. The Product Recognition section contains 
information about each file associated with the product. 

Product Naming 

This section, at the top of the page, contains information about the product. 

 Manufacturer - Enter or edit the manufacturer's name. 
 Product - Enter or edit the product name. 
 Version - Enter or edit the product version. Click Use version entered here to display 

this version number with the product name.  
 Category - Choose a category from the drop-down list, or enter a new category. 
 Always report this version - Click this button to display the version in this box when 

the local product appears in a report. 

Product Recognition 

For each software file associated with the product, this information appears and can be edited. 

 File Name - Enter or edit the file name.  
 Remove File - Select this check box to remove the file from the product definition. 

The file is removed from the definition when you click Update Product.  
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 Extension - Enter or edit the file's extension. 
 Size - Enter or edit the file's size. 
 VRB Company Name - Enter or edit the Company Name as it appears in the VRB data. 

Select Use for Recognition to use the Company Name when determining whether a file 
is part of a local product. 

 VRB Product Name - Enter or edit the product name as it appears in the VRB data. 
Select Use for Recognition to use the Product Name when determining whether a file 
is part of a local product. 

 VRB Product Version - Enter or edit the product version as it appears in the VRB data. 
Select Use for Recognition to use the Product Version when determining whether a file 
is part of a local product. Click Report the version found here to display this file's VRB 
Product Version number with the product name. 

 VRB File Version - Enter or edit the file version as it appears in the VRB data. Select 
Use for Recognition to use the File Version when determining whether a file is part of 
a local product. Click Report the version found here to display this file's VRB File 
Version number with the product name. 

 VRB Language - Enter or edit the language as it appears in the VRB data. Select Use 
for Recognition to use the Language when determining whether a file is part of a local 
product. 
 
Note: When you clear the Use for Recognition check box for a VRB Data field, you are 
relaxing the conditions used to determine whether a file is part of an existing local 
product. 

Page Commands 

 Update Product - Click this link to save your changes to the product details. 
 Delete Product - Click this link to delete the product. 
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Web Applications 
Use the Web Applications page to define and manage web applications. 

Web Applications Menu Reference 

 In the left frame, click the plus (+) to expand the Web Applications tree to view a list 
of manufacturers of web applications. 

 In the left frame, click a manufacturer name to view a list of web applications by that 
manufacturer. 

 In right frame, click an application name to view details for that application. 

Web Applications List Reference 

Use the Web Applications list to view defined web applications. 

Web Application List Columns 

 Manufacturer - The web application's specified manufacturer. 
 Application - The name of the web application. Drill down to view details for the 

selected web application. 
 Version - The specified application version. 
 Date Last Modified - The date the web application definition was last updated. 
 Workstations Used From - The number of workstations from which the application has 

been used. 

Web Application List Page Commands 

 Excel, CSV, PDF - Export the list to a spreadsheet, comma-separated file, or PDF. 
 Graph - View the list as a series of graphs in PDF format. 
 New Application - Create a new web application definition. 

Web Application Details Reference 

Use the Web Application Details page to create or edit a web application definition. 

Application Naming 

 Manufacturer - Click , then choose a manufacturer from the list that appears in a 
new window. To create a new manufacturer, enter a new manufacturer in the 
Manufacturer box. 

 Application - Enter an application name. 
 Version - Enter an application version. 

Application Recognition 

 Window Title - Enter a window title, then click Update Application.  
 Remove Window Title - Select this check, then click Update Application to remove 

the window title from the web application definition. 
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Page Commands 

 Update Application - Click to save your changes to the web application and to add a 
new Window Title line. 

 Delete Application - Click to delete the web application definition. A confirmation 
window appears. 
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Documents Page Reference 

Documents Menu Reference 

 Upload Document 
 View/Edit Document Records 
 Delete Document Records 

View/Edit Documents List Reference 

 Document ID 
 File Name 
 File Type 
 File Size 
 Description 
 Server Name 
 Date Uploaded 
 Uploaded By 

Page Commands 

 Excel, CSV, PDF - Export the list to a spreadsheet, comma-separated file, or PDF. 

View/Edit Document Reference 

 File Name 
 File Length 
 Upload Date 
 Uploaded By 
 User Document ID 
 Description 

Page Commands 

 Done 

Alert Status Page Reference 
Use the Alert Status page to monitor the status of alerts and date notifications. 

 

Note: The Alert and Date Notification Status reports are custom reports. For detailed information about these reports, 
see Monitoring Alert & Notification Status. For information about creating and editing custom reports, see Using 
Custom Reports and Alerts.  
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User Roles Page Reference 

 In the left frame, click the Users link to view a list of all ZENworks Asset Management 
users. 

 In the left frame, click a User Role link to view a list of users in that role in the right 
frame. 

 In the left frame, click Logged In Users to view a list of users current logged in to 
ZENworks Asset Management. 

 In the left frame, click a user to view and edit details for the selected user in the right 
frame. 

 In the right frame, click New User to add a ZENworks Asset Management user. 
 In the right frame, click Excel to export the current list to an Excel spreadsheet. 
 In the right frame, click PDF to export the current list to a PDF file. 
 In the right frame, click CSV to export the current list to a comma-delimited text file. 

User List 

 In the right frame, click a column heading to sort by that column. Click the column 
heading again to reverse the sort order. 

 In the right frame, click a user name to edit the details for the user. 

User Details 

Use the User Details page, available in the right frame, to edit details about the selected user. 

 User Role - Choose a user role from the drop-down menu. 
 Scope - Click this button to open the Report Scope window, to specify the domains in 

which the user can view reports. 
 Reports Tab - Select or clear check boxes to control the user's access to Standard or 

Custom Inventory Reports. Clear the Tab Access check box to disable the user's access 
to the Reports tab. 

 Network Discovery Tab- Select or clear check boxes to control the user's access to 
Standard or Custom Network Discovery Reports. (Does not appear for all user roles.) 
Clear the Tab Access check box to disable the user's access to the Network Discovery 
tab. 

 Software Management Tab - Select or clear check boxes to control the user's access to 
Standard or Custom Software Compliance reports. Clear the Tab Access check box to 
disable the user's access to the Software Management tab. 

 Admin Tab - Select or clear check boxes to control the user's access to Local Products 
or Users. Clear the Tab Access check box to disable the user's access to the Admin tab. 

 Update User Details - Click this link to save changes to the User Details page. The 
changes are saved. 

 Change Password - Click this link to change a user's password. A new Change Password 
window opens. 

 Delete User - Click this link to delete a user. A new Delete User confirmation window 
opens. 

 New User - Click this link to add a new user. A New User window opens. 
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New User Window 

Use the New User window to enter login information about a user. 

 

 User Name - Enter the user's login name. 
 Password - Enter the user's login password. 
 Password Again - Enter the user's login password again, to make sure it is correct. 
 User Role - Choose a user role from the drop-down menu. For more information on user 

roles, see Security and Access. 
 Submit - Click this button to save the new user's information. 

Change Password Window 

 Enter New Password - Enter a new login password for the selected user. 
 Enter New Password Again - Enter the new password again to make sure it is correct. 
 Submit - Click this button to save the new password. 

Delete User Window 

 Delete - Click this button to delete the selected user. 
 Cancel - Click this button if you do not want to delete the user. 

 



 

197 

Glossary 

A 
Active product: An "active" product is one that has had the workstation's focus, or was "in the foreground”, during 

a specified period. 

Adjusted Licenses: The number of licenses associated with the purchase of a catalog product after upgrades to 
that software version have been taken into account. 

Ancillary Application File: A file found during a software file scan whose file and path properties indicate a direct 
relationship with an application that is currently in the ZENworks Asset Management Knowledgebase. 

C 
Catalog Product: A software product in the Product Catalog. 

Component: An installed copy of a software product 

Component-Day: Total number of Usage days for a component. 

D 
Discovered Products: Products from your ZENworks Asset Management inventory filtered through the Novell 

License Knowledgebase. 

Drill-down: Click links in a report or list to display a greater level of detail about something. 

H 
header: The part of a purchase record containing information about the transaction, such as the Order Date, PO 

Number, Reseller, who the products are for, etc. 

Hours Active: The total number of hours that the product was active during the reporting period.The sum of 
active hours for all installed copies of the product, rounded tonearest whole number. 

I 
Inventory: software inventory data collected through the ZENworks Asset Management inventory process. 

L 
Lic/Pkg: The total number of licenses to which you are entitled associated with a specific Catalog Product. 

License Knowledgebase: A product database developed and maintained by Novell used to filter ZENworks Asset 
Management inventory data for use in determining software compliance. 

License Qty: The total number of licenses to which you are entitled. It is cumulative quantity of all purchases of a 
catalog product linked to a license record. 

License Record: A data record used as the "connector" between one or more Purchased and one or more 
Discovered Products. The Software Management Report shows a list of License Records, calculating the 
compliance figures for all associated products and their upgrades. 

Licenses Per Package: The total number of licenses to which you are entitled associated with a specific Catalog 
Product. 

O 
Original Licenses: The number of licenses associated with the purchase of a catalog product before adjusting for 

upgrades. 
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Other File: Includes any file that does not match the criteria for System Files or Ancillary Application Files. 

Over-licensed: A compliance status in which you have installed fewer copies of a particular product than you have 
purchased. (You are in compliance for this product.) 

P 
Pre-defined Report: A custom report included with an installation of ZENworks Asset Management. 

Product Catalog: A database of Catalog Products. You might purchase a single license, a 10-pack, or a 100-pack. 
Each of these becomes an entry in the Product Catalog, or a Catalog Product, and represents one or more 
Software Licenses. Use the Product Catalog menu to add, view and edit Catalog Products, and to assign those 
products to a particular Software License. 

Purchase Qty: The number of units of a specific Catalog Product purchased. 

Purchase Record: A record entered into the Software Management system corresponding to an invoice or 
purchase order used to purchase software products. A purchase record may contain one or more software 
products from the Product Catalog. 

Purchased Product: A software product for which you have documentation of purchases. A purchased product 
may represent one or more licenses. 

R 
Reconcile: To connect or associate one or more Catalog Products or Discovered Product to a License Record 

S 
Software Files: Files collected as part of a Software File Scan. Any files found that are not in the ZENworks Asset 

Management Product Knowledgebase (PRU) or associated with those products are collected as Software Files. 

Software Standards: User-defined categories you can use to group Discovered Products that are meaningful to 
your organization. A common use of Software Standards is to track installed products as they conform to your 
organizations policies and standards for software installations. 

Standard Report: A report installed with ZENworks Asset Management, found in a page's Reports folder. Unlike 
Custom Reports, standard reports cannot be edited. 

SVG: Scalable Vector Graphics 

System File: A file found during a software file scan whose file and path properties indicate a direct relationship 
to the workstation's operating system. 

U 
Under-licensed: A compliance status in which you have installed more copies of a particular product than you 

have purchased. (You are not in compliance for the product.) 

Usage Day: A day on which a component saw some usage. 

V 
VRB: Version Resource Block - information within an application file that may contain useful information about 

the product version. 
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